
Encom Discover PA 2013 User Guide

Pitney Bowes Software Inc. is a wholly-owned subsidiary of Pitney Bowes 

Inc. Pitney Bowes, the Corporate logo is a [registered] trademark of Pitney 

Bowes Inc. or a subsidiary. All other trademarks are the property of their 

respective owners. © 2013 Pitney Bowes Software Inc. All rights reserved.

Encom Discover PA
TM

 2013 User Guide



Pitney Bowes Software Inc. is a wholly-owned subsidiary of Pitney Bowes 

Inc. Pitney Bowes, the Corporate logo is a [registered] trademark of Pitney 

Bowes Inc. or a subsidiary. All other trademarks are the property of their 

respective owners. © 2013 Pitney Bowes Software Inc. All rights reserved.

Encom Discover PA
TM

 2013 User Guide

Encom Discover PA is developed and supported by 
Pitney Bowes Software Pty Ltd

ASIA PACIFIC / AUSTRALIA 
Level 7, 1 Elizabeth Plaza 
 North Sydney NSW 2060 Australia 

SUPPORT 
T: +61.2.9437.6255

pbbi.support@pb.com 
www.pbencom.com

ENCOM DISCOVER PA RELEASE HISTORY

BHP Gemex Initial Release 
v1.0 February 2000

Commercial Release 
v2.0 February 2001 v7.0 August 2007 
v3.0 November 2001 v8.0 April 2008 
v3.1 July 2002 v9.0 March 2009 
v3.2 December 2002 v10.0 February 2010 
v4.0 July 2003 v11.0 May 2011 
v5.0 May 2004 v12.0 February 2012 
v5.5 August 2004 2013 February 2013 
v6.0 October 2005



Table of Contents i

1 Introduction ............................................................................................. 1

Overview ................................................................................................... 1
Encom Discover PA Structure................................................................... 3
Development History ................................................................................. 6
Supported Data Methods .......................................................................... 7
Exploration and Engineering Applications................................................. 8
Template Applications............................................................................... 9
Using this Guide...................................................................................... 10

2 Getting Help........................................................................................... 11

User Documentation................................................................................ 11
Technical Support and Updates.............................................................. 12

3 Installing ................................................................................................ 15

Computer Hardware Requirements......................................................... 15
Windows Operating Systems ............................................................. 15
CPU.................................................................................................... 16
Graphics Monitor................................................................................ 16
Disk Space ......................................................................................... 16
Adobe Reader .................................................................................... 16

Installing Encom Discover PA ................................................................. 16
Installing from DVD-ROM................................................................... 17
Installing from the Web ...................................................................... 17
Installation Folders ............................................................................. 18

Licensing Encom Discover PA ................................................................ 19
Licensing Procedures......................................................................... 19
Installing a New Hard-Disk Licence ................................................... 20
Upgrading an Existing Licence........................................................... 22
Transferring a Hard-Disk Licence ...................................................... 23
Displaying Licence Information .......................................................... 27
Troubleshooting ................................................................................. 27

4 Getting Started ...................................................................................... 29

Introduction and Guidelines .................................................................... 29
Starting and Closing Encom Discover PA............................................... 31
Understanding the Interface.................................................................... 32

Main Menu ......................................................................................... 33
File Menu ...................................................................................... 35
Edit Menu...................................................................................... 37

Table of Contents



ii Encom Discover PA User Guide

View Menu.................................................................................... 38
Insert Menu................................................................................... 39
Features Menu ............................................................................. 40
Tools Menu................................................................................... 40
Database Menu ............................................................................ 40
Grid Menu..................................................................................... 40
Voxel Menu................................................................................... 40
Vector Menu ................................................................................. 41
Window Menu............................................................................... 41
Help Menu .................................................................................... 42

Toolbars............................................................................................. 42
Toolbar Shortcut Menu ................................................................. 45
Using Toolbars ............................................................................. 46
Available Tools ............................................................................. 46

Display Window Area......................................................................... 54
Status Bar .......................................................................................... 54
The Workspace Tree ......................................................................... 54

Controlling the Tree Content ........................................................ 56
Hiding and Showing Branches ..................................................... 56
Renaming Branches ..................................................................... 57
Expanding and Collapsing Branches............................................ 57
Branch Controls ............................................................................ 58
Working with the Workspace Tree................................................ 58
Branch (Object) Properties ........................................................... 60

Data Manager .................................................................................... 61
Hiding and Showing the Data Manager ........................................ 62
Information Displayed by the Data Manager ................................ 63
Coordinate System Information .................................................... 64
Adding Objects to Displays........................................................... 67

Explorer and Data Windows .............................................................. 67
Explorer Window .......................................................................... 68
Data Window ................................................................................ 69

Managing Windows ........................................................................... 70
Controlling the Display ............................................................................ 70

View Modes ....................................................................................... 70
Page and Data Zoom Modes............................................................. 71
Data Zooming, Panning and Frame Data Linking.............................. 72
Map and Profile Zoom Relationships................................................. 73
Reset Data Limits .............................................................................. 74
Data Zoom to Extents ........................................................................ 74

Accessing Data....................................................................................... 74
Defining the Z-Channel...................................................................... 76
Project Directory Specification........................................................... 76

Working with Graphical Objects.............................................................. 77
Frames............................................................................................... 78
Components ...................................................................................... 80
Frame and Plot Axis Control.............................................................. 81



Table of Contents iii

Snap Operation .................................................................................. 83
Size Units ........................................................................................... 84
File Drag-and-Drop ............................................................................ 84
Line Navigation .................................................................................. 86

Line Iterator Tool ........................................................................... 86
Using Wizards ......................................................................................... 91

New Document Creation Wizard........................................................ 92

5 Display Formats .................................................................................... 95

About Display Formats ............................................................................ 95
What Can Encom Discover PA Display?................................................. 96
Creating a New Display........................................................................... 97
Display Types.......................................................................................... 97

Profiles ............................................................................................... 98
Graphs ............................................................................................. 100
Spreadsheets ................................................................................... 100
2-Dimensional Maps ........................................................................ 101
Map Mosaics .................................................................................... 101
Points ............................................................................................... 102
3-Dimensional Displays.................................................................... 103
Drillholes .......................................................................................... 105
Decay Curves................................................................................... 105
Graphs and Scattergrams ................................................................ 106
Vertical Log Graphs ......................................................................... 107
Stacked Profiles ............................................................................... 108
Voxels .............................................................................................. 108
TrackMaps ....................................................................................... 110
Combination Displays ...................................................................... 111

Examples of Displays ............................................................................ 114
Example: Two Separate Profile Tracks............................................ 116
Example: Two Profiles from the Same Track................................... 117
Example: Filling Profile Areas .......................................................... 120
Example: Highlighting Major Channels ............................................ 121
Example: Modulated Data Tracks .................................................... 121
Example: Multiple Fixed Scaling Profiles ......................................... 123
Example: Adding a Depth Section to a Profile ................................. 124
Example: Flight and Image Maps..................................................... 129
Example: Graph and Scattergram Presentations............................. 130
Example: 3D Grid Surface with Flight Path...................................... 131
Example: 3D Grid Surface with Image Drape .................................. 133
Example: 3D Grid Surface with Contours Overlain .......................... 134
Example: Flight Path over a Grid Surface........................................ 136
Example: Adding 3D Axes to a Display............................................ 137
Example: Displaying 3D Located Images ........................................ 139
Example: Use of Transparency........................................................ 142



iv Encom Discover PA User Guide

Example: Colouring a Surface with Another Surface....................... 143
Example: Texture Mapping.............................................................. 144
Example: Multiple Surfaces ............................................................. 146
Example: Merged Texture Surfaces ................................................ 147

6 Printing and Graphical Output........................................................... 149

Graphical Output................................................................................... 149
Saving as an Image ......................................................................... 149
Saving as an RGB Raster Image..................................................... 150
Saving as a Located Image ............................................................. 151

Printing.................................................................................................. 153
Print Scaling..................................................................................... 154
Profile Scaling.................................................................................. 155
Map Scaling ..................................................................................... 155
Page Margins................................................................................... 157
Batch Printing Wizard ...................................................................... 158
Batch Printing to PDF ...................................................................... 162
Print Preview.................................................................................... 164

7 Managing Session Files ..................................................................... 167

Session Files ........................................................................................ 167
Restoring a Session......................................................................... 168
Recent Sessions.............................................................................. 169
File Recovery................................................................................... 169

Packaging Datasets.............................................................................. 169
Templates ............................................................................................. 171

Application Templates ..................................................................... 172
How Does a Template Work?.......................................................... 173

8 Working with Data............................................................................... 175

Accessing Data with Encom Discover PA............................................. 175
Supported Databases ........................................................................... 177

Geosoft Oasis montaj ...................................................................... 177
Intrepid............................................................................................. 179
MapInfo TAB File ............................................................................. 180

Importing ASCII Data Files ................................................................... 181
ASCII File Formats .......................................................................... 183
Importing an ASCII File.................................................................... 184
Treatment of Null Values ................................................................. 186
DMS Format .................................................................................... 187
Saving and Reloading a Layout....................................................... 187
Pre-set File Formats ........................................................................ 187



Table of Contents v

Text Import Options.......................................................................... 188
Text Import Procedures.................................................................... 188

Fixed-Width Data ........................................................................ 189
Delimited Data ............................................................................ 191
Data with Interspersed Line Numbers......................................... 192
Point Data ................................................................................... 192
File Headers Containing Field Names ........................................ 194
Multi-banded Fields..................................................................... 195

Importing Data from Grids ..................................................................... 197
Converting to MapInfo TAB................................................................... 198

Import ASCII Data to MapInfo TAB .................................................. 198
Geosoft GDB to MapInfo TAB.......................................................... 198

Converting to Geosoft GDB................................................................... 199
MapInfo TAB to Geosoft GDB.......................................................... 199
Seismic SEG2 Data to Geosoft GDB ............................................... 199
ASCII Data to Geosoft GDB............................................................. 201
ASEG-GDF2 to Geosoft GDB .......................................................... 201

Operation of ASEG-GDF2 Import Tool ....................................... 201
UBC 2D Model to Geosoft GDB....................................................... 203
UBC 3D Model to Geosoft GDB....................................................... 205

Two Dimensional Profile Display of Slices .................................. 207
Making Slices Transparent.......................................................... 208

Exporting Data ...................................................................................... 209
When a Database Fails to Open ........................................................... 211
Selecting Channels and Tables............................................................. 212
Ancilliary Data ....................................................................................... 213
Closing a Database Link ....................................................................... 213
Preferred Directory Access ................................................................... 214

9 Page Layouts ....................................................................................... 215

About Page Layouts .............................................................................. 215
Document Window Properties............................................................... 216
Adding Frames to a Document.............................................................. 216

Adding Frames Without Alignment................................................... 217
Adding Frames With Alignment........................................................ 217

Adding Objects to a Page ..................................................................... 219
Adding Text ...................................................................................... 219
Adding a Picture............................................................................... 221
Scale Bar.......................................................................................... 222

Changing the Scale of Scale Bars .............................................. 224
North Arrow ...................................................................................... 225
Floating Colour Bar .......................................................................... 226

Floating Colour Bar Properties.................................................... 228
Editing Documents ................................................................................ 229

Copy, Delete, Cut and Paste............................................................ 230



vi Encom Discover PA User Guide

Split and Merge Frames .................................................................. 230
Embed and Float ............................................................................. 232

10 Display Properties .............................................................................. 233

Documents, Frames, and Objects ........................................................ 233
Document Properties ............................................................................ 234
Profile Frame Properties ....................................................................... 234

Axes Tab.......................................................................................... 235
Options Tab ..................................................................................... 238
Appearance Tab .............................................................................. 239
X Scale Tab ..................................................................................... 240

2D Map Frame Properties..................................................................... 241
Axes Tab .................................................................................... 242

3D Map Frame Properties .................................................................... 243
Profile Properties .................................................................................. 244

Data Tab .......................................................................................... 245
Axes Tab.......................................................................................... 246
Title Tab........................................................................................... 247

Variable Substitutes.................................................................... 247
Title Positioning .......................................................................... 248

Appearance Tab .............................................................................. 248
Arrangement Tab............................................................................. 250
Y Scale Tab ..................................................................................... 251
Colour Scale Tab ............................................................................. 253
Colour Table Tab ............................................................................. 254
Size Scale Tab................................................................................. 256

Axis Properties...................................................................................... 256
Data Tab .......................................................................................... 257
Appearance Tab .............................................................................. 259
Title Tab........................................................................................... 260
Divisions Tab ................................................................................... 260
Ticks Tab ......................................................................................... 261
Internal Axes and Annotation........................................................... 262

Internal Annotation Tab .............................................................. 264
Ticks Tab .................................................................................... 265
Local Tab.................................................................................... 266
Geodetic Tab .............................................................................. 266
Map Projections.......................................................................... 268

Label Properties.................................................................................... 271
Curve Properties................................................................................... 272

Data Tab .......................................................................................... 272
Fields Tab ........................................................................................ 274
Line Style Tab.................................................................................. 275
Symbols Tab.................................................................................... 276

Displaying Line Stations ............................................................. 278



Table of Contents vii

Label Tab ......................................................................................... 279
Transform Tab.................................................................................. 280
Decimation Tab ................................................................................ 282
Data Specification ............................................................................ 282
Modulating Data ............................................................................... 285

11 Spreadsheets....................................................................................... 287

Displaying Numerical Data .................................................................... 287
Database Structure ............................................................................... 287
Using the Encom Discover PA Spreadsheet......................................... 288

Display Type .................................................................................... 290
Rate Filter......................................................................................... 291
Database Operations ....................................................................... 291

Close a Database ....................................................................... 292
Export Dataset ............................................................................ 292
Modify Dataset XYZ .................................................................... 292
Statistics Explorer ....................................................................... 293
Editing Data ................................................................................ 294

Spreadsheet/Profile Display Data Linking........................................ 295

12 Profiles ................................................................................................. 297

About Profile Analysis ........................................................................... 297
Introduction to Profiles .......................................................................... 298
The Profile Frame.................................................................................. 299
Profile Horizontal Scale ......................................................................... 299
Flight Line Positioning and Scales ........................................................ 301
Annotation of the Horizontal Axis .......................................................... 302
Creating a Document for a Profile ......................................................... 303
Axes and Annotations ........................................................................... 304
Displaying Other Objects in Profiles...................................................... 305

Adding Sections ............................................................................... 307
Section Structure and Layers...................................................... 308
Upper and Lower Boundary Layers ............................................ 308
Point Depths and Property Values.............................................. 309
Creating Sections........................................................................ 311
Section Properties....................................................................... 312
Topography and Offset Field ...................................................... 315

Adding Drillholes .............................................................................. 316
Adding Features............................................................................... 316
Adding Section Grids ....................................................................... 316

Section Grid Data Properties ...................................................... 318
Iterating Section Grids ................................................................ 318
Creating Section Grid Files ......................................................... 319
IP Data Display ........................................................................... 319



viii Encom Discover PA User Guide

Adding Located Images ................................................................... 320
Adding TrackMaps........................................................................... 322

13 Two-Dimensional Maps...................................................................... 323

About Two-Dimensional Maps.............................................................. 323
Drag-and-Drop Maps ............................................................................ 324
Map Workspace Tree............................................................................ 325
Creating a 2D Grid Map........................................................................ 325

Adding Grids .................................................................................... 327
Querying Grids................................................................................. 328
Display Order and Visibility.............................................................. 328
Supported Grid Formats .................................................................. 328
Located Image and ER Mapper Support ......................................... 328
ECW Image Support........................................................................ 331
Vector Contours............................................................................... 332
Grids Properties............................................................................... 333

Transparency and Colour-Intensity Balance............................... 335
Pseudocolour Layer Controls ..................................................... 340
Controlling a Colour Layer .......................................................... 341
Grid Information .......................................................................... 346
Automatic Colour Scaling ........................................................... 347
Controlling an Intensity Layer ..................................................... 348
RGB Image Properties ............................................................... 349
Contours Properties.................................................................... 351

Creating a 2D Flight Path Map.............................................................. 357
Flight Path Map Properties .............................................................. 360

Lines Tab.................................................................................... 361
Fields Tab................................................................................... 362
Appearance Tab ......................................................................... 363

Displaying Lines.................................................................................... 367
Displaying Points .................................................................................. 368
Stacked Profiles.................................................................................... 369
Displaying Vector Objects..................................................................... 372
Save Map Extents as Vector File.......................................................... 374

14 Three-Dimensional Displays.............................................................. 377

About Three-Dimensional Displays....................................................... 378
Drag-and-Drop 3D Displays.................................................................. 378
3D Display Workspace Tree ................................................................. 379
3D Map Properties................................................................................ 380

Title Tab........................................................................................... 380
Variable Substitutes.................................................................... 381
Title Positioning .......................................................................... 382

Appearance Tab .............................................................................. 382



Table of Contents ix

Lighting Tab .................................................................................... 384
Scale Tab ......................................................................................... 385

Creating 3D Displays............................................................................. 386
View Surface Images in 3D Displays .................................................... 389

Scaling 3D Surfaces......................................................................... 392
Surface Compression....................................................................... 393
Fill and Lines of Surfaces................................................................. 395
Applying Offset to 3D Surfaces ........................................................ 396
Surface Colour ................................................................................. 397
Texture Mapping .............................................................................. 397
Export to Google Earth (.KML)......................................................... 398
3D Grid Flipper................................................................................. 400

View 3D Flight Paths............................................................................. 402
View Line Data in 3D Displays .............................................................. 403

Controlling the Appearance of 3D Lines .......................................... 405
Symbols ...................................................................................... 405

View Point Data in 3D Displays............................................................. 409
Controlling the Appearance of 3D Points ......................................... 410

3D Vector Displays................................................................................ 413
Mode ................................................................................................ 414
Data Source ..................................................................................... 414
Line Selection................................................................................... 416
Vector Origin Specification............................................................... 416
XYZ Components............................................................................. 417
Length .............................................................................................. 419
Tail ................................................................................................... 420
Head................................................................................................. 421
Colour............................................................................................... 423

Located Images in 3D Displays............................................................. 424
Adding a Located Image to 3D Display............................................ 426

Drillholes in 3D ...................................................................................... 427
2D Vector Objects in 3D........................................................................ 428
3D Vector Objects in 3D........................................................................ 430

Loading 3D Objects.......................................................................... 431
3D Vector File Properties ................................................................. 433

Section Profiles in 3D Displays ............................................................. 435
Adding Sections to 3D Displays ....................................................... 435
Section Profile Properties in 3D Displays......................................... 438

Voxel Models in 3D ............................................................................... 439
Feature Objects in 3D ........................................................................... 439
Animation of 3D Displays ...................................................................... 441

15 3D Navigation and Animation ............................................................ 443

3D Toolbar Controls .............................................................................. 443
3D View Manager.................................................................................. 445



x Encom Discover PA User Guide

Navigating in 3D ................................................................................... 445
3D Navigation Modes ...................................................................... 446
3D Navigation Controls.................................................................... 446
Using the 3DConnexion SpaceNavigator™..................................... 450

3D Display Modes................................................................................. 451
Normal View Mode .......................................................................... 452
Page Layout Mode........................................................................... 452
Full Screen Mode............................................................................. 452

3D Cursor Plane ................................................................................... 453
Controlling the Cursor Plane Display............................................... 454
Controlling the Cursor Plane Position and Orientation .................... 454
Navigating on the Cursor Plane....................................................... 455
Changing Cursor Plane Properties .................................................. 456

Plane .......................................................................................... 457
Appearance ................................................................................ 459

Creating and Editing Features Objects Using the Cursor Plane...... 459
3D Animation and Fly-Through............................................................. 461

How Fly-Through Animation Works ................................................. 463
The Fly-Through Creation Wizard ................................................... 464

Static View Mode........................................................................ 475
Codecs and Movie File Format........................................................ 476
Playing an Existing Fly-Through File ............................................... 478

16 Located Images................................................................................... 479

About Located Images.......................................................................... 479
Applications of Located Images............................................................ 480
Creating Located Images...................................................................... 482

Located Images Direct From 2D Displays ....................................... 482
Using Located Images .......................................................................... 484
Located Image Properties..................................................................... 487

Group Controls ................................................................................ 488
Display Tab...................................................................................... 489
Surface Tab ..................................................................................... 491
DTM Tab.......................................................................................... 494
Object Controls ................................................................................ 494
Transparency Tab............................................................................ 495
Transform Tab ................................................................................. 495
Mesh Controls.................................................................................. 496
Image Tab........................................................................................ 496
Grid Tab........................................................................................... 497

17 Features............................................................................................... 499

About Features ..................................................................................... 499
Managing Features............................................................................... 500



Table of Contents xi

Features Menu ...................................................................................... 501
Feature Databases................................................................................ 502

Opening an Existing Feature Database ........................................... 503
Interacting with Features.................................................................. 504
Creating a New Feature Database................................................... 505

Feature Database Creation Wizard............................................. 506
Adding a New Feature Set to a Database........................................ 509

Feature Calculator................................................................................. 510
Calculator Syntax ............................................................................. 512
Logical Operators............................................................................. 512

AND Operator ............................................................................. 512
NOT Operator ............................................................................. 513
OR Operator ............................................................................... 513
XOR Operator ............................................................................. 514
IF Operator.................................................................................. 515

Arithmetic Operators ........................................................................ 516
Anti-Log Functions ........................................................................... 516
Comparison Operators..................................................................... 516
Boolean Operators ........................................................................... 517
Trignometric Operators .................................................................... 517
Deleting a Feature Set ..................................................................... 518

Importing Data Into a Feature Database............................................... 518
Importing Data from Vector or Grid Files ......................................... 518
Importing Features from ASCII Files................................................ 523

Exporting Feature Sets ......................................................................... 525
Feature Object Properties ..................................................................... 527

Feature Appearance ........................................................................ 528
Labelling Features............................................................................ 529

Working with Features........................................................................... 532
Selecting Feature Objects................................................................ 532
Querying Feature Attributes ............................................................. 533
Creating Objects .............................................................................. 535
Editing Objects ................................................................................. 541

Three-Point-Range Feature Editing ............................................ 542
Editing an Entire Object .............................................................. 542
Editing Individual Nodes ............................................................. 544
Other Feature Tools .................................................................... 545

Advanced Editing Functions............................................................. 546
Triangulate .................................................................................. 547
Combine...................................................................................... 548
Intersect ...................................................................................... 549
Cut .............................................................................................. 550
Aggregate ................................................................................... 553
Disaggregate............................................................................... 554
Break Mode................................................................................. 554
Consolidate ................................................................................. 557

Feature Object Attributes ...................................................................... 557



xii Encom Discover PA User Guide

Data Tab .......................................................................................... 557
Feature Spreadsheet ....................................................................... 558
Attribute Editing ............................................................................... 559
Node Editing .................................................................................... 560

Feature Options .................................................................................... 562
Picking Features .............................................................................. 562
Line Association............................................................................... 563
Defaults............................................................................................ 563
Line Association Wizard .................................................................. 563

Batch Printing Features ........................................................................ 566
Specifying Variable Text for Printing................................................ 567

Features Database Structure and Links ............................................... 569
Linking a Feature Database to MapInfo Professional...................... 569

18 Scattergrams....................................................................................... 577

About Scattergrams .............................................................................. 577
Scattergram Properties......................................................................... 578

Symbol Modulation .......................................................................... 579
Using Scattergrams .............................................................................. 580
Three-Dimensional Scattergrams ......................................................... 580

19 Graphs ................................................................................................. 583

About Graphs........................................................................................ 583
Creating a Graph Document ................................................................. 584
Graph Properties .................................................................................. 585
Vertical Graphs ..................................................................................... 587

Creating a Vertical Graph ................................................................ 587
Creating 3D Graphs.............................................................................. 589

20 Drillholes ............................................................................................. 591

Displaying Drillholes in Encom Discover PA......................................... 591
Drillhole Data Formats .......................................................................... 593
Importing Drillhole Data ........................................................................ 593

ASCII Drillhole Data......................................................................... 595
Files with Collar and Downhole Survey Data.............................. 595
Files with XYZ Drillhole Data ...................................................... 597
Import Drillholes Wizard.............................................................. 599

Encom Discover Drillhole Data ........................................................ 604
Geosoft WHOLEPLOT Data ............................................................ 605
acQuire Drillhole Data...................................................................... 607

Desurvey Methods................................................................................ 609
Drillholes in Profile Sections ................................................................. 611



Table of Contents xiii

Drillhole Selection ............................................................................ 612
Data Compression ........................................................................... 613
Colour Modulation ............................................................................ 614
Trace Style ....................................................................................... 615
Labelling........................................................................................... 616
Symbols ........................................................................................... 618
Off-Section Clipping ......................................................................... 618

Adding Drillholes to a 2D Map............................................................... 619
Adding Drillholes to a 3D Map............................................................... 620
Drillhole Properties ................................................................................ 620

Holes Tab......................................................................................... 622
Fields Tab ........................................................................................ 623
Colour Tab ....................................................................................... 624

Drillhole Colour Legends............................................................. 625
Appearance Tab............................................................................... 625

Trace Style .................................................................................. 626
Thickness Modulation ................................................................. 628

Symbols Tab .................................................................................... 630
Labelling...................................................................................... 633

Plotting Data Beside Drillholes .............................................................. 635
Display Downhole Logs......................................................................... 636

21 Voxel Models ....................................................................................... 643

What are Voxel Models? ....................................................................... 643
Supported Voxel Model Formats........................................................... 644
Creating a Voxel Model Display ............................................................ 645
Importing a Voxel Model........................................................................ 647
Exporting a Voxel Model ....................................................................... 649

Isosurface to 3D vector file Using the Export Model Wizard......... 650
Voxel Model Information........................................................................ 652
Voxel Model Properties ......................................................................... 652

Appearance Tab............................................................................... 653
Clipping Tab ..................................................................................... 655
Chair Clipping Tab ........................................................................... 658
Colour Tab ....................................................................................... 660

Colour Table ............................................................................... 661
Colour Mapping........................................................................... 662
Transparency Table .................................................................... 665
Transparency Mapping ............................................................... 666

Lithology Tab.................................................................................... 666
Threshold Tab .................................................................................. 667

Lithology Mode............................................................................ 667
Interactive Mode ......................................................................... 669

Isosurface Tab ................................................................................. 671
Lithology Mode............................................................................ 672



xiv Encom Discover PA User Guide

Interactive Mode ......................................................................... 673
Using Wireframes ....................................................................... 674

Slices Tab ........................................................................................ 675
Offset Tab ........................................................................................ 676
Voxel Model Display Properties....................................................... 677

Voxel Model Properties in a Curve Profile Display ..................... 678
Voxel Model Properties in a 2D Map Display ............................. 679

Additional Voxel Display Features ........................................................ 680
Multiple Voxel Model Displays ......................................................... 680
Integrating Voxel Models With Other Objects.................................. 681
Voxel Model Legends ...................................................................... 682

Voxel Display and Processing Tools..................................................... 684

22 TrackMaps ........................................................................................... 685

About TrackMaps.................................................................................. 685
Creating a TrackMap ............................................................................ 686

Creating a Raster Image.................................................................. 687
Adding a TrackMap Display............................................................. 687

Rotated Raster Images......................................................................... 689

23 EM Decay Curves................................................................................ 693

The Decay Tool .................................................................................... 693
Banded Data......................................................................................... 695
Frame Properties .................................................................................. 695
Decay Curve Properties........................................................................ 695

Data Tab .......................................................................................... 696
Decay Tab ....................................................................................... 697
Line Style Tab.................................................................................. 697
Symbols and Label Tab ................................................................... 698

Curve Fitting ......................................................................................... 698
Decay Display....................................................................................... 699
Decay Legend....................................................................................... 699
Line Navigation in Decays .................................................................... 701

24 Display Utilities ................................................................................... 703

Options ................................................................................................. 703
Line Orientation ............................................................................... 705
Page Setup ...................................................................................... 706
Templates ........................................................................................ 706
Size Settings.................................................................................... 707
View ................................................................................................. 709
Database ......................................................................................... 710



Table of Contents xv

Files Locations ................................................................................. 711
Setting the Global and Project Directories ....................................... 711

Image Registration Wizard .................................................................... 712
Georeferenced Image Export ................................................................ 716

Image Plane Definitions ................................................................... 717
3D View Options .............................................................................. 717
Raster Image.................................................................................... 718
Georeferenced File .......................................................................... 718

Grid Flipper ........................................................................................... 720
3D View Manager.................................................................................. 721
3D Animation and Fly-Through ............................................................. 721
Drillhole Planner .................................................................................... 721

Planning Drillholes in 3D .................................................................. 722
RL or Z Value Assignment ............................................................... 724
Drillhole Types ................................................................................. 725
Targeting Example ........................................................................... 727
Drillhole Planner Projects................................................................. 729

Seismic Depth ....................................................................................... 730
Seismic Workflow............................................................................. 730
Seismic Project Files........................................................................ 736

Coordinates................................................................................. 738
Digitizing Horizons ........................................................................... 739
Viewing Profiles................................................................................ 740
Dialog Help....................................................................................... 740

Project Settings Dialog Box......................................................... 741
Section Properties Dialog Box .................................................... 742
Plan View Dialog Box.................................................................. 744
Generate 3D Dialog Box ............................................................. 745

Section to Map Utility............................................................................. 746
Prepare the Destination 2D Map...................................................... 747
Prepare the Source Sections or Profiles .......................................... 747
Batch Print to Located Image (.EGB) File ........................................ 750
Run the Section To Map Utility......................................................... 754
Add Processed Located Images to the Map .................................... 757
Trouble-shooting .............................................................................. 759

Coordinate Reprojection........................................................................ 760
Interactive Conversion ..................................................................... 760
Text File Conversion ........................................................................ 762
Longitude to UTM Zone Converter................................................... 763

Colour Table and Legend Editors.......................................................... 763
Colour Table Editor .......................................................................... 765

Create Colour Table.................................................................... 767
Legend Editor................................................................................... 768

Creating a New Legend .............................................................. 770
Modifying Legends...................................................................... 772
Additional Legend Modification Tools ......................................... 773

Tube Shape Manager ........................................................................... 774



xvi Encom Discover PA User Guide

25 Database Utilities................................................................................ 777

Database Maintenance......................................................................... 778
Advanced Options ........................................................................... 782

Build Array Field ................................................................................... 783
Depth Interpolation ............................................................................... 784

What Does the Interpolator Do? ...................................................... 786
Interpolation Processing .................................................................. 787

Database Coordinates Reprojection..................................................... 787
Geosoft Database Merging................................................................... 789
Line Utility ............................................................................................. 790

Spatial Sort Database Along Line.................................................... 791
Decimate by Station Rate ................................................................ 791
Subset a Database by Lines............................................................ 791
Clip a Database to the Area Within a Polygon or Rectangle ........... 791
Compute IGRF Parameters ............................................................. 792

Line Calculator ...................................................................................... 792
Reserved Channel Names............................................................... 795
Special Line Calculator Operations ................................................. 795
Array Operations.............................................................................. 796

Line Filtering ......................................................................................... 796
Convolution Filters ...................................................................... 799
FFT Filtering .............................................................................. 800
Other Filters ................................................................................ 803

TEM Tau Calculator .............................................................................. 807
EM Channel Times Specification..................................................... 808
Tau Computation ............................................................................. 808
Tau Calculation Methods ................................................................. 811
Output and Displaying the Results .................................................. 812

Flight Path Simulator ............................................................................ 813
Data Inputs ...................................................................................... 814
Run Flight Path Simulator................................................................ 815
Using the Simulator Dialog .............................................................. 816

Input Files ................................................................................... 817
Creating an Artificial DTM Grid ................................................... 818
Survey Polygon Parameters ....................................................... 818
Flight line parameters ................................................................. 819
Aircraft Selection ........................................................................ 819
The Aircraft Database................................................................. 821
Description of the Algorithm........................................................ 822
Data Outputs .............................................................................. 823

Airborne Quality Control Tool................................................................ 824
Introduction ...................................................................................... 824
Quality Control Checks .................................................................... 824

Check station spacing ................................................................ 825
Check line deviation ................................................................... 825
Check values for field ................................................................. 826



Table of Contents xvii

Check normal line spacing.......................................................... 826
Report survey lines which are approximately co-linear............... 827
Report on normal/tie-line intersections........................................ 827
Output options............................................................................. 827

Diurnal Correction Tool ......................................................................... 829
Flight Lines to Vector File...................................................................... 831
3D Symbol Generator............................................................................ 833

Symbol Generator Controls.............................................................. 834
Operating the Symbol Generator ..................................................... 835

Stacked Profiles Tool ............................................................................ 836
Creating Stacked Profiles................................................................. 838
Displaying a Stacked Profile in a 2D Map ........................................ 840

26 Gridding Utilities ................................................................................. 843

Interactive 2D Gridding.......................................................................... 844
Using the Interactive Gridding Tool.................................................. 845
Previewing the Grid.......................................................................... 846
Input Tab .......................................................................................... 848

Breaklines ................................................................................... 849
Coincident Points ........................................................................ 850
Statistics Explorer ....................................................................... 850
Data Conditioning ....................................................................... 851

Method Tab ...................................................................................... 853
Save, Restore, and Apply Gridding Parameters ......................... 854

Minimum Curvature Tab................................................................... 855
Kriging Tab....................................................................................... 856
Inverse Distance Tab ....................................................................... 858

Weighting Model ......................................................................... 859
Weighting Options....................................................................... 861

Search Tab....................................................................................... 862
Searching.................................................................................... 863
Anisotropy ................................................................................... 864
Sample Selection ........................................................................ 864
Gridding Rule .............................................................................. 865

Triangulation Tab ............................................................................. 865
Spatial Neighbour Tab ..................................................................... 866
Bi-Directional Spline Method............................................................ 867
Density Gridding Tab ....................................................................... 868
Distance Gridding Tab ..................................................................... 870
Geometry Tab .................................................................................. 872
Output Tab ....................................................................................... 873

Large and Multi-file Gridding ................................................................. 875
When to Use Large and Multi-file Gridding ...................................... 877
Using the Large and Multi-file Gridding Tool.................................... 877

Running the Gridding Tool .......................................................... 877



xviii Encom Discover PA User Guide

Re-running the Gridding .................................................................. 879
Input Data Files................................................................................ 880
Gridding Workflows.......................................................................... 882

Triangulation............................................................................... 882
Inverse Distance Weighting........................................................ 883
Minimum Curvature (Full) ........................................................... 884
Minimum Curvature (Stamped)................................................... 885
Data Density ............................................................................... 886
Data Point Separation (Distance) ............................................... 886
Stamp Only ................................................................................. 887

Interpolation Settings ....................................................................... 888
Data Conditioning ....................................................................... 888
Gridding Properties..................................................................... 888
Options ....................................................................................... 890

Gridding Methods ............................................................................ 892
Triangulation............................................................................... 892
Inverse Distance Weighting........................................................ 894
Minimum Curvature (Stamped)................................................... 896
Minimum Curvature (Full) ........................................................... 898
Full minimum curvature vs stamped minimum curvature methods...
899
Data Density ............................................................................... 900

Output Grid ...................................................................................... 902
Section Gridding ................................................................................... 903

Display of IP Data ............................................................................ 907
Grid Calculator ...................................................................................... 909

Using Multi-banded Grid Inputs ....................................................... 912
Grid Filter .............................................................................................. 913

Using the Grid Filter Tool................................................................. 916
Preview WIndows ............................................................................ 916
Filter Operations .............................................................................. 918
Order of Operations ......................................................................... 920
Grid Information ............................................................................... 920
Grid Filter Settings ........................................................................... 921
Fill Holes .......................................................................................... 922

Grid Utility ............................................................................................. 922
Classify ............................................................................................ 926
Grid to Grid Clip ............................................................................... 928
Clip................................................................................................... 928
Convert ............................................................................................ 929
Create RGB ..................................................................................... 930
Curvature ......................................................................................... 930
Cut/Fill.............................................................................................. 931
Edit................................................................................................... 933
Fill Holes .......................................................................................... 933
Flip ................................................................................................... 934
Merge............................................................................................... 934



Table of Contents xix

Outline.............................................................................................. 935
Overlay............................................................................................. 935
Replace ............................................................................................ 936
Reproject.......................................................................................... 936
Resample ......................................................................................... 937
Rotate............................................................................................... 939
Shift .................................................................................................. 939
Slope ................................................................................................ 940
Split .................................................................................................. 941
Statistics........................................................................................... 941
Surface Area .................................................................................... 943
Vectorise .......................................................................................... 944

Viewshed .................................................................................... 946
Volume ............................................................................................. 949

Assign Grid Value to Dataset ................................................................ 950
Grid Tiler ............................................................................................... 952

Tile Layout........................................................................................ 953
Tile Naming ...................................................................................... 953

Vector File to Grid Utility........................................................................ 954
SRTM HGT to ERMapper ERS............................................................. 957

27 Voxel Utilities....................................................................................... 959

Array Data 3D Gridding ......................................................................... 959
Gridding Operation........................................................................... 962

Voxel Toolkit.......................................................................................... 963
Voxel Toolkit Settings....................................................................... 965

Gridding Settings ........................................................................ 965
Calculator Settings...................................................................... 967

Gridding............................................................................................ 968
3D Gridding Methods ....................................................................... 971

Continuously Variable ................................................................. 972
Gridding Data Specification......................................................... 981
Conditioning Data Prior to Gridding ............................................ 983
Specifying the Grid Size.............................................................. 990
Defining the Grid Control Parameters ......................................... 992
Preview Window.......................................................................... 997
Weighting of Points ..................................................................... 997
Advanced Properties................................................................. 1000
Discretised Gridding.................................................................. 1001
Distance Gridding ..................................................................... 1004
Density Gridding ....................................................................... 1006

3D Grid Convolution Filtering ......................................................... 1008
Voxel Utilities.................................................................................. 1009

Assign Values to Features ........................................................ 1010
Clip to Surface .......................................................................... 1012



xx Encom Discover PA User Guide

Clip to Vector Volume............................................................... 1014
Convert Nulls ............................................................................ 1015
Convert Vector to Voxel............................................................ 1015
Create Mesh ............................................................................. 1016
Merge ....................................................................................... 1017
Resample ................................................................................. 1017

3D Grid Calculator ......................................................................... 1021
3D Display Assistant...................................................................... 1023
Grid Management .......................................................................... 1024
ASCII Import of 3D Data ................................................................ 1025

28 Vector Utilities................................................................................... 1029

3D Solid Generator ............................................................................. 1029
Creating Boundaries ..................................................................... 1030

3D Digitized Boundaries ........................................................... 1031
Create 3D Solid ............................................................................. 1032

Tie Lines ................................................................................... 1035
Output Options ......................................................................... 1040
Algorithm Options ..................................................................... 1041
Structure Analysis..................................................................... 1042
Shape Matching........................................................................ 1043
Compression ............................................................................ 1044

3D Extrusion Tool ............................................................................... 1046
Using the Extrusion Wizard ........................................................... 1047

DXF/TKM Vector File Output .................................................... 1055
Feature Dataset Output ............................................................ 1056
Generating a Report ................................................................. 1057

Topology Checker............................................................................... 1058
Using the Topology Checker ......................................................... 1058
Topology Checker Controls ........................................................... 1060
Surface Options ............................................................................. 1061
Global Options ............................................................................... 1061
Rendering Options......................................................................... 1062
3D View Controls ........................................................................... 1062

Transform Vector File ......................................................................... 1063
Combine DXF Files............................................................................. 1067
MapInfo TAB  to Geosoft GDB ........................................................... 1067
Geosoft GDB to MapInfo TAB ............................................................ 1069
DXF to ModelVision TKM.................................................................... 1070
MapInfo TAB to Vulcan Archive.......................................................... 1071
Vulcan Archive to MapInfo TAB.......................................................... 1072
EM Plate Importer ............................................................................... 1073

3D EM Plate Model Display ...................................................... 1078
2D Map EM Plate Model Display .............................................. 1078
Section Profile EM Plate Model Display ................................... 1083



Table of Contents xxi

MapInfo MIF/TAB to ArcView SHP...................................................... 1088
Gemcom BT2 to MapInfo TAB ............................................................ 1088

29 Customising Encom Discover PA .................................................. 1091

Create and Customise Toolbars.......................................................... 1091
Keyboard Shortcuts............................................................................. 1093

Appendices........................................................................................ 1095

A Encom Discover Integration............................................................. 1097

Integrating with Encom Discover......................................................... 1097
2D Map Displays ................................................................................. 1098
Encom Discover Drillhole Data............................................................ 1098
Displaying Sections From Discover in Encom Discover PA................ 1099

B Data File Specifications.................................................................... 1105

ASEG-GDF2 Format Data................................................................... 1106
ASCII XYZ Voxel Models .................................................................... 1106
Datamine Block Model File.................................................................. 1107
CEMI Model Format ............................................................................ 1108
CSV (Comma Separated Variable) Files............................................. 1110
Decay Curve Ancilliary Data Files ....................................................... 1111
EGB Files – Located Image Descriptor Files ...................................... 1113
ER Mapper Look-Up Files ................................................................... 1128
ETS Encom Tube Shape File Formats................................................ 1129
Gemcom Block Model ......................................................................... 1131
Geosoft Oasis montaj Input Template................................................. 1134
GoCad TSURF Surfaces Definition..................................................... 1135
Intrepid DDF Format............................................................................ 1137
Intrepid SuveyInfo File ........................................................................ 1139
Micromine Block Model File ................................................................ 1140
Noddy Model Format........................................................................... 1141
SEG-2 Data Format............................................................................. 1143
Surfer Look-Up Tables ........................................................................ 1144
Surpac Block Model File Format ......................................................... 1144
UBC Model File Formats ..................................................................... 1147

C Grid Filters ......................................................................................... 1151

The Convolution Filtering Process ...................................................... 1151
Convolution Filter Descriptions............................................................ 1152



xxii Encom Discover PA User Guide

Smoothing Filters........................................................................... 1152
Averaging Filters....................................................................... 1153
Gaussian Filters........................................................................ 1153

Enhancement Filters...................................................................... 1154
Sharpening Filters .................................................................... 1154
Line and Edge Enhance Filters ................................................ 1155
Laplacian Filter ......................................................................... 1155
Laplacian of Gaussian .............................................................. 1155
Sobel Filters.............................................................................. 1156
Sun Angle Filters ...................................................................... 1156
Custom User-Defined Filters .................................................... 1157

One Dimensional FFT Line Filter Descriptions ................................... 1157
The General Linear Filter............................................................... 1158
The 1D FFT Vertical Continuation Filter ........................................ 1158
General Expression for the 1D FFT Directional Derivative Filter... 1159
The 1D FFT Vertical Derivative Filters........................................... 1159
The 1D FFT Horizontal Derivative Filters ...................................... 1160
The General 1D Phase Transformation Filter................................ 1160
The BT(k) to BH(k) Transformation Filter ...................................... 1160
The BT(k) to Bz(k) Transformation Filter ....................................... 1161
The 1D FFT Reduction to the North Magnetic Pole Filter.............. 1161
The 1D FFT Reduction to the Magnetic Equator Filter .................. 1162
The 1D FFT Pseudogravity Filter .................................................. 1163
The 1D FFT Pseudomagnetic Filter............................................... 1163
The 1D FFT Low-Pass and High-Pass Butterworth Filters............ 1163

Two Dimensional FFT Filter Descriptions ........................................... 1164
The FFT Derivative Filters .................................................................. 1165

Derivative Filter of nth Order (Advanced) ...................................... 1165
The General Expression for FFT Directional Derivative Filters ..... 1166
The FFT Vertical Derivative Filters ................................................ 1166
The FFT Horizontal Derivative Filter.............................................. 1167
The FFT TMI Reduction to the Pole Filter ..................................... 1167
The FFT TMI Reduction to the Equator Filter ................................ 1168
The FFT Pseudo-gravity Transform Filter...................................... 1169
The 2D FFT Pseudo-magnetic Transform Filter ............................ 1170

FFT Magnetic Component or Phase Transformation Filters............... 1171
The TMI General Phase Transformation Filter .............................. 1171
The BT(k) to Bx(k)Transformation Filter ........................................ 1172
The BT(k) to By(k)Transformation Filter ........................................ 1172
The BT(k) to Bz(k)Transformation Filter ........................................ 1172
The FFT Vertical Continuation Filter.............................................. 1173
The 2D FFT Low-Pass and High-Pass Butterworth Filters............ 1173
The FFT Band-Pass and Band-Reject Directional Cosine Filters.. 1174
The First Order Magnetic Moment Transformation........................ 1174
FFT TMI Reduction to the Pole (Low Latitude) Processing ........... 1176
Low Latitude Processing Theory ................................................... 1177
Aspects of Numerical Computation ............................................... 1180



Table of Contents xxiii

Computation of the Magnetic Moments ......................................... 1182
Low Pass Filter............................................................................... 1183
High Pass Filter.............................................................................. 1183
Band Pass Filter............................................................................. 1183

Encom GeoFilters................................................................................ 1183
About Encom GeoFilters ................................................................ 1183
Edge Filters .................................................................................... 1184
Block Filters.................................................................................... 1186
Applying GeoFilters........................................................................ 1189

Bibliography ........................................................................................ 1191

D Fonts .................................................................................................. 1193

Encom Discover PA Basic Font .......................................................... 1193
Geological Font ................................................................................... 1194

E Supported File Formats.................................................................... 1199

Supported Grid Formats...................................................................... 1199
Supported Located Image Formats..................................................... 1200
Supported 2D Vector Formats............................................................. 1202
Supported 3D Vector Formats............................................................. 1203
Supported Databases ......................................................................... 1203
Supported Image Formats................................................................... 1203
Supported Lookup Table Formats....................................................... 1204
Supported Drillhole Formats................................................................ 1204
Supported Voxel Model Formats......................................................... 1204

F Statistics Explorer............................................................................. 1205

Spreadsheet ........................................................................................ 1206
Zoom, Selection and Display Controls ................................................ 1208

Zoom controls ................................................................................ 1208
Selection Tools............................................................................... 1208

Display Modulation .............................................................................. 1209
Subsetting ........................................................................................... 1209
Univariate ............................................................................................ 1209
Bivariate .............................................................................................. 1213
Spatial ................................................................................................. 1215
Variogram............................................................................................ 1217

Model Variograms .......................................................................... 1219



xxiv Encom Discover PA User Guide

G Field Data Conditioning.................................................................... 1225

H 3D Cursor Keyboard Shortcuts ....................................................... 1233

Index .................................................................................................. 1235



1 Introduction 1

1 Introduction
Encom Discover PA is an interactive interpreter’s tool for analysis of data in 
profile, map and 3D display formats. The information that can be analysed by this 
software includes single or multi-channel data acquired from airborne or ground 
surveys, including electromagnetics (AEM), potential field (gravity or magnetic) 
data or a combination of data types. Encom Discover PA accesses data directly 
from advanced processing systems and industry-standard databases. This 
approach significantly increases the speed of data access and assists in data 
management. The use of database technology makes Encom Discover PA 
especially applicable to large datasets that are typical of modern airborne 
geophysical techniques.

Encom Discover PA provides a method of accumulating geophysical knowledge 
by using databases to store details of interpreted features. Access to the 
geophysical knowledge can be made directly in Geographic Information Systems 
(GIS) such as MapInfo™, Encom Discover and ArcView™.

Encom Discover PA also provides advanced visualisation using both 2 and 3 
dimensional displays. 3-dimensional presentations of images, sections, graphs, 
flight paths and data objects provides interactive display manipulation with 
zooming, pan and fly-through techniques.

Templates allow fast creation of application-specific displays for magnetic, 
gravity, EM and spectrometer data. A number of templates are supplied with the 
software, along with the ability to modify or create your own. The template 
capability of Encom Discover PA enables combinations of various display types. 
For example, you can easily combine profiles, sections, maps and graphs 
together for high quality printed output. The routine production of maps, sections 
and profiles is simple when templates are used.

Overview

Encom Discover PA is designed for rapid and convenient visualisation of 
exploration data stored in industry standard databases. Currently supported 
databases include Geosoft Oasis montaj™, MapInfo Professional or DFA 
Intrepid™. Other database formats such as Microsoft Access are used for feature 
storage. 

A range of display formats including profiles, image maps and graphs are 
supported and can be simply combined to form scaled or report quality output. 
Templates are used to save and retrieve display formats used routinely. Direct 
importation of ER Mapper grids (including ECW) and algorithms can produce 
quick image hardcopies.
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Applicable databases contain input line data, ancillary metadata and any created 
features and interpretive information. A number of databases can be opened 
consecutively.

Schematic of Encom Discover PA architecture

Encom Discover PA can be used as a profile analysis tool with interaction and 
rapid navigation between lines with data linking to 2D maps. Real time analysis 
of data is also available through facilities such as the optional decay curve tool.

Encom Discover PA provides a means of communication with external 
processing or modelling modules. These programs form options that you may be 
interested in for specific exploration applications. Visualisation of both the 
observed and computed results can be undertaken in Encom Discover PA.

Pitney Bowes Software can supply airborne processing modules (such as EM 
Flow) or potential field modelling programs (such as ModelVision Pro) that can be 
connected to the Encom Discover PA software.

Batch processes and feature generation modules can interface to Encom Discover PA
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External batch processing operations interface to the Database API. The 
processes can read data from the databases and return data that can be viewed 
in the map or profile modules. Importantly, information derived from modelling or 
picking of features can be transferred to a feature database that can be visualised 
with data or passed to external programs such as Microsoft Excel or Access.

Encom Discover PA operates under Microsoft Windows XP Professional and 
Windows 7.

Encom Discover PA Structure

Encom Discover PA consists of three packages designed to simplify the choice 
of available modules.

Encom Discover PA Viewer – A freely distributable version of Encom Discover 
PA, allowing all PA session files to be viewed and printed without a licence 
installation, with the limitation of not allowing changes to the properties of any 
views. This is available as a separate installation which can be downloaded from 
the Pitney Bowes Software - Natural Resources web site (www.pbencom.com)

Encom Discover PA Explorer – Contains all visualisation methods (in curve 
profiles, section profiles, 2D maps and 3D displays), data linking, import utilities 
and basic processing, conversion and display utilities.  

Encom Discover PA Professional – Includes all modules available in PA 
Explorer plus a number of additional utilities for extending the interpretation 
functionality of Encom Discover PA, such as digitizing features in 1D, 2D and 3D.

When you run Encom Discover PA, the software begins a new session. A session 
is made up of various graphical windows that collectively can form:

• A session, which can open one or more Geosoft montaj™ or Intrepid 
databases. A session can also consist of one or more documents. 
Sessions can be saved to file (.EGS) and if transported between 
machines may require re-linking to local data.

• A document, which is contained within a window and holds a page 
definition as well as one or more graphical components. The position, 
layout and appearance of a document can be saved or recalled with a 
Template.

• A template, which is a description of all the graphical components in a 
document. A template can be saved to a file. It does not contain the data 
that the components display consequently a template is transportable 
across machines and can be linked to different data sources. 

http://www.pbencom.com
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• A component, which is a graphical object that can be selected and 
manipulated by the user. A component can be saved to a file. As certain 
types of components may contain other components, inserting 
components into a document from a file can provide a flexible and 
powerful mechanism to construct complex documents built from a number 
of different components.

• A frame, is a container designed to contain graphical objects. It can also 
contain other types of objects such as:

text

pictures

scale bars

north arrows

floating axes (colour bar)

Encom Discover PA produces a number of different types of plot objects. These 
objects are contained within a Frame, within a Document. Objects include:

• Graph (2D and 3D) – A graph presents data by joining the data value 
points with a line. A graph has no restrictions on the number of axes it can 
contain. There are few restrictions on the type of data objects a graph can 
have.

• Scattergram (2D and 3D) – A scattergram is used to display relationships 
between different data fields on 2 (2D) or 3 (3D) axes. Symbols are 
primarily used to locate the data points and their values. A scattergram is 
essentially a graph but with data points marked by a symbol rather than 
joined by a line.

• Profile (2D Only) – A profile is a subset of a graph but uses a horizontal 
axis derived from accumulated distance rather than a specific data 
channel. In addition, it can display layer data (e.g. CDI sections) since it is 
usually related to distance. It can only contain data from a single line, 
although the line data can be sourced from multiple databases.

• Map (2D and 3D) – A map contains X and Y axes (plus Z for 3D maps). 
There are few restrictions on the type of data objects a map document can 
contain.

• Decay Curve (2D Only) – A specialised graph designed to display EM 
decay curves. Display of decay curves is an optional module.
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A data object requires a link to external data that may be stored in a database, 
raster grid file, vector file etc. Encom Discover PA can display the following types 
of data objects.

• Curve or Lines (2D and 3D) – A multi-banded curve (e.g. flight line data). 
Curves can be displayed as lines, filled lines and symbols. Curve and 
symbol attributes, including labels, can be modulated by data in a number 
of ways. Lines are simply multiple collections of Curves.

• Section or Section Group (2D and 3D) – A multi-banded layer (e.g. CDI 
data). Layers are derived from line data as either top, bottom and property 
or depth and property. They are displayed as filled colour sections. 
Section Groups are simply multiple collections of Sections.

• Drillholes (2D and 3D) – Specific drillhole databases contain depth and 
sample readings that can be displayed in profile sections, Vertical Graphs 
(log plots), maps or in 3D below surface. Drillhole traces can be modified 
by downhole reading, assay or lithology values.

• Feature (2D and 3D) – Displays feature data as symbols, lines or 
polygons. Symbol attributes can be modulated by data to assist in their 
interpretation.

• Flight Path (2D and 3D) – Displays the flight path or data location for a 
specified database.

• Grid Image (2D and 3D) – Displays raster data and in 3D, depth surfaces 
are also used. An image can contain multiple grid surfaces, each of which 
is derived from one or more raster grids. Surfaces can be Pseudocolour 
images, RGB images, ER Mapper Algorithms or Contours. 

• Vector File (2D) – Imports a vector file in a variety of formats for display in 
a 2D or 3D map.

• Vector File (3D) – Supports import of 3D DXF files into a 3D graph or 
map.

• Voxel Models – Displays 3 dimensional voxel (volume element) models 
derived from modeling programs that output solid 3D volume models (eg 
UBC or CEMI).

• TrackMaps – These tracks are designed to be used with profiles and 
relate the path of a data line over an image such as a scanned map or 
raster image.

• EMGui Database (3D) – Displays models and system objects from an 
EMGui database.
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Development History

Encom Discover PA commenced its development from the commercial software 
product known as GEMeX. GEMeX evolved over time to meet the exploration 
needs for airborne geophysical display and processing within BHP Pty Ltd. During 
1999, BHP made the decision to commercialise their internally developed 
program called GEMeX to ensure ongoing support and development without 
ongoing internal costs. Through a consultative and tendering process, Pitney 
Bowes Software (formerly Encom Technology) was granted the rights to develop 
and commercialise the software. The term Profile Analyst was coined by Pitney 
Bowes Software to refer to the display and visualisation functions of GEMeX.

Within BHP, GEMeX was initially developed to operate on Silicon Graphics 
computers and make use of the powerful processing and visualisation capabilities 
of this hardware. The program was initially called TEMPER (Monks and Asten, 
1993). More recently, the program was converted to operate on Windows 95 and 
NT/2000 environments plus Unix hardware with visualisation provided by AVS 
and AVS/Express.

Commercialisation of GEMeX by Pitney Bowes Software required a rewrite of the 
package with the initial emphasis on maintaining functionality and speed. Unix 
support was not required by BHP since the majority of their internal operations 
were now (during 1999) on PC Windows-based platforms. It was also considered 
that ongoing development could best be managed external to BHP without having 
to maintain internal support. The initial implementation of the GEMeX software by 
Pitney Bowes Software involved a major rewrite of the visualisation. This rewrite 
resulted in the GEMeX software which in turn became the commercial Profile 
Analyst software.

During 2006, it was decided to alter the commercial name of Profile Analyst to 
Encom Discover PA since the software functionality had grown to do much more 
than merely analyse profile data. With the introduction of a new name a 
restructuring of the available expert modules was implemented to provide clients 
with a more supportive package that allows access to greater features. The 
restructure provided the choice between three products.

• Encom Discover PA Viewer

• Encom Discover PA Explorer

• Encom Discover PA Professional
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Supported Data Methods

Encom Discover PA supports a wide range of exploration data. These methods 
include:

Electromagnetic surveys

• Interactive feature analysis

• Presentation of processed results

• Manual feature tagging updated in database

• Conductivity depth image (CDI) display 

• Composite display of data, CDI and features

• Decay Curve analysis

Magnetic surveys

• Variable area scaling of magnetic fields

• Display of filtered processing

• Vector data visualisation

• Interactive feature tagging updating in database

Gamma Ray Spectrometry

• Simultaneous KUT and Total Count displays

• Variable scaling for direct data comparison

• Analysis results

• Feature tagging

• Spectra displays

Gravity – Line Data

• Variable scaling of gravity profiles

• Visualisation of filter processes
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• Display of vector gradiometer data

• Interactive feature tagging

Geochemistry – Line Data

• Combined simultaneous displays with other data types

• Statistical analysis display

• Interactive feature tagging

• Image display flipping for pattern convolution

Exploration and Engineering Applications

Numerous practical exploration and engineering applications can be undertaken 
with Encom Discover PA. Some of these include:

• Massive sulphide exploration with multi-channel EM, magnetics, 
geochemical and radiometric surveys.

• Regolith studies using multi-channel EM surveys, magnetics and 
spectrometry surveys.

• Geological mapping using multi-channel EM, radiometrics, geochemistry 
and magnetics.

• Combine geochemical and geophysical data for drill hole targeting.

• Diamond exploration using detailed magnetic analyses combined with EM 
and radiometric analysis.

• Uranium exploration using detailed analysis of gamma ray spectrometry 
data. Combine magnetics and EM data to visualise these methods in 
context across lines.

• Detailed image analysis applied to geological mapping using multi-band 
images, contour and vector data displays.

• Salinity studies of frequency and time domain EM data. Combine 
magnetics and radiometric data to complement these studies.

• Environmental studies merging specialised EM data with remote sensing 
methods such as Landsat TM imagery.
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Template Applications

One of the most powerful and effective uses of Encom Discover PA comes from 
its template availability. Complex displays can be configured to present profiles, 
images and many combinations of display formats.

The configuring of the most effective displays for various exploration applications 
can be time consuming. It is not difficult, but it requires a good understanding of 
Encom Discover PA to achieve the desired result when complex presentations 
are required.

Consequently, to quickly provide powerful, application-oriented displays, a 
number of templates have been designed specifically for various applications. 
The templates are installed in the Template Gallery folder during installation. 
Some template applications include:

• Map Outlines

• Potential Field Templates

• Uranium Search

• Diamond Search

• Time Domain Method

• Frequency Domain Method

• Geochemistry Templates

To assist in the selection of templates, when the selection dialog is displayed, a 
small image of an example of the template is provided, plus a text description.
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Template selection dialog with preview and text description

Using this Guide

Pitney Bowes Software has taken care to ensure that the information presented 
in this guide is accurate at the time the software was released. From time to time, 
both major and minor releases of Encom Discover PA are made. Changes in the 
program are not necessarily synchronised with the release of a new version of this 
manual.

This guide is available in printed and electronic formats. The electronic versions 
of this guide are supplied on the Encom Discover PA DVD in Microsoft Windows 
Help (CHM) and Adobe portable document file (PDF) formats. The PDF version 
is also available from the Pitney Bowes Software - Natural Resources web site 
(www.pbencom.com). Tutorials, available as PDF files, also provide a hands-on 
introduction to Encom Discover PA.

For information on the types of documentation available, see Getting Help.

http://www.pbencom.com
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2 Getting Help
Should difficulties or questions arise while operating Encom Discover PA, there 
are several sources of help available.

In this section:

• User Documentation

• Technical Support and Updates

User Documentation

User Guide

This comprehensive user guide provides all the required information for the 
operation of Encom Discover PA and associated modelling. The user guide is 
supplied as a PDF electronic document, which can be displayed from the Help 
menu. 

You need Adobe Reader to view the PDF. Although supplied with the Encom 
Discover PA software, Adobe Reader is also available (at no cost) from the Adobe 
web site www.adobe.com.

Help

The user guide is also available in the form of interactive Help, which can be 
displayed at any time by:

• From the Help menu, selecting Help Topics.

• Selecting the Help button on most dialogs. This displays the relevant help 
topic.

• While a graphic or dialog is displayed, press the keyboard F1 key. This 
displays the relevant help topic.

Online Knowledge Base

The PBEncom Online Knowledge Base contains useful information that is 
regularly updated, including how-to articles, tips and tricks, error messages and 
their resolutions, video tutorials, and such. You can access the knowledge base 
by visiting http://encomkb.encom.com.au.

http://encomkb.encom.com.au
http://www.adobe.com
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Encom Discover PA Tutorials

To assist with learning how to use Encom Discover PA, a set of tutorials is 
installed with the software. The tutorials provide step-by-step instructions on how 
to perform common taks in Encom Discover PA. The data files that are used in 
the tutorial exercises are also installed. All tutorials are based on real exploration 
situations in which Encom Discover PA can be used to display, enhance and 
visualise data. The tutorial is available as a PDF document, which can be 
displayed from the Help menu.

Technical Support and Updates

You can obtain product support for Encom Discover PA by e-mail or from your 
PBS reseller.

Contact details for Encom Discover PA support are:

Telephone +61 2 9437 6255

Fax +61 2 9439 1773

E-mail pbbi.support@pb.com

Web www.pbencom.com

mailto:pbbi.support@pb.com
http://www.pbencom.com
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3 Installing
This section describes the installation and operation of the software under the 
Microsoft Windows XP and Windows 7 operating systems. 

• Computer Hardware Requirements

• Installing Encom Discover PA

• Licensing Encom Discover PA

Computer Hardware Requirements

The computer hardware and software requirements to install and operate Encom 
Discover PA are described below:

• Windows Operating Systems

• CPU

• Graphics Monitor

• Disk Space

• Adobe Reader

Windows Operating Systems

Encom Discover PA 2013 will run under the following operating systems:

32-bit operating systems

• Windows XP Professional (Service Pack 3)

• Windows 7

64-bit operating systems

• Windows 7
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CPU

It is recommended that Encom Discover PA is operated on a Pentium 4 series 
700 MHz (2 GHz recommended) PC. Extended memory also assists the 
operation of this and other Windows application software. A minimum of 512 
megabytes (2 GB recommended) of RAM is required to operate Encom Discover 
PA.

Graphics Monitor

A high-quality graphics monitor of at least SVGA capability (1024 x 768 pixel 
screen display) is recommended for Encom Discover PA. Higher screen 
resolutions and a well configured, high memory graphics card will improve the 
appearance and ease of use of Encom Discover PA. A 64 MB graphics card is 
required as a minimum, but a 256 MB video card is strongly recommended. 

Disk Space

Encom Discover PA requires approximately 650 MB of available disk space to 
store the executable, library files, and data files supplied with the software.

Adobe Reader

Adobe Reader version 6 or later is required to view PDF files supplied with the 
software.

Installing Encom Discover PA

The software can be supplied on either a DVD-ROM that includes installation, 
documentation, tutorials, slideshows etc. or you can download the software and 
selected items of documentation from the Pitney Bowes Software - Natural 
Resources web site www.pbencom.com.

Note If the computer is running an NVIDIA graphics card it is recommended that the 
NVIDIA Desktop manager is not enabled as it is known to cause conflict with 
Encom Discover PA.

http://www.pbencom.com
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Software installation is a two-stage process:

Stage 1: Install the software

For instructions, see either:

• Installing from DVD-ROM, or

• Installing from the Web

Stage 2: License the software

For instructions on how to perform different types of licensing procedures, see:

• Licensing Procedures

Installing from DVD-ROM

Place the supplied Encom Discover PA software DVD in the DVD-ROM drive and 
wait a few seconds. The DVD-ROM should register with your computer 
automatically and display an installation menu list. From this menu you can select 
the components you wish to install. When selected, the install program will run 
automatically.

The install program guides you through the installation procedure.

When installed, Encom Discover PA can be started from the Encom Discover PA 
icon on the Desktop, or by starting the program from the Windows Start button. 
Initially, Encom Discover PA is not licensed and, when you first run the program, 
it requests you license the software.

Installing from the Web

To download Encom Discover PA, visit www.encom.com.au and select the 
Download page. Encom Discover PA components are documented and their size 
indicates the time it will take to download. A separate installation for Encom 
Discover PA Viewer is available from the Pitney Bowes Software – Natural 
Resources web site and is a much smaller.

Note If the DVD-ROM does not autoload, from Windows Explorer, double-click 
AUTOPTN.EXE in the \AUTOPTN folder or double-click SETUP.EXE in the 
\Software folder.

http://www.encom.com.au
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When you have completed downloading the installation file, from Windows 
Explorer, double-click the file name to initiate the installation procedure. Licensing 
procedures are identical for both a Web installation or a DVD-ROM installation.

Installation Folders

We recommend that you install this Encom Discover PA application in the default 
Encom installation folder under the Program Files folder on your local drive.

Example of the folder tree in which Encom Discover PA is installed.

The Encom folder may be placed under another folder by changing the default 
installation drive and folder name in the Encom Discover PA Installation Folder 
option when Encom Discover PA is installed.

Other folders may be created during the installation of Encom Discover PA. 
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Licensing Encom Discover PA

Encom Discover PA is protected under international copyright law. Pitney Bowes 
Software licensing systems are designed to protect against unlawful copying and 
use of the software. Encom Discover PA is supplied with a hard-disk licence 
system (see Licensing Procedures). Otherwise, if you are using a USB dongle or 
network licence, contact PBS Technical Support for assistance.

Licensing Procedures

When installing an Encom Discover PA licence, choose from the following 
licensing procedures:

Display information about Encom software installed

• Displaying Licence Information

Re-installing Encom Discover PA

If Encom Discover PA is installed on the computer with a valid hard-disk licence, 
the software does not need to be re-licensed when you re-install the software.

Encom Discover PA has not been previously licensed on the computer

If you installing the software for the first time, see:

• Installing a New Hard-Disk Licence

The licence is being transferred from another computer

You can transfer a licence from one computer to another without contacting 
Pitney Bowes Software. For detailed instructions, see:

• Transferring a Hard-Disk Licence

A later version of the software has been installed

If you are upgrading an installation with a valid licence to a later version of the 
software, see:

• Upgrading an Existing Licence
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Installing a New Hard-Disk Licence 

If your Encom Discover PA licence was delivered without a USB dongle, the 
following licensing procedure should be followed:

Start Encom Discover PA

1. Start Encom Discover PA from either the Windows Start button, or from 
the icon on the Desktop.

A message is displayed indicating no licence was found.

Encom Discover PA Viewer can be run without a licence.

2. Click License Encom Discover PA.

Create a new licence

3. The Create Licence File dialog is displayed. Type the company name 
and click OK.

The Encom Licence Manager is displayed, which lists all Encom 
programs installed on this computer.

Request an activation code

4. Select the Activate Software tab.

5. In the Program box, select Encom Discover PA.

6. In the Customer no. box, type the 7-digit customer code supplied with the 
software.

7. In the Serial # box, type the 10-digit serial number supplied with the 
software.

8. Type your contact details in the corresponding boxes.



3 Installing 21

Encom Licence Manager

9. Click the E-mail button or, to generate a report that can be faxed to Pitney 
Bowes Software, click the Print/Fax button. The Pitney Bowes Software 
fax number is printed on the report. 

Wait for Pitney Bowes Software to send the activation code

10. When your request and Hardware ID have been validated by Pitney 
Bowes Software, an Activation Code will be emailed or faxed to you.

Activate the licence

11. If necessary, restart Encom Discover PA and display the Licence Manager 
as described in steps 1 through 3.

12. Select the Activate Software tab.

13. In the Activation code box, type the activation code supplied by Pitney 
Bowes Software. Upper or lower case characters can be used, but no 
blank spaces. 

14. Click the Activate button. The displayed modules, expiry date and version 
number are updated. 

Note If you are submitting your Activation Code request by e-mail, the automatic 
Pitney Bowes Software tracking system should respond within 30 minutes.
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Confirm details

15. Select the Current Installation tab and confirm the licence details.

16. Click the Close button.

Encom Discover PA is now ready to use.

Upgrading an Existing Licence

After installing Encom Discover PA, if a licence for an earlier version exists, you 
will be asked for an upgrade activation code when you run the software.

To upgrade the licence to the new version:

1. Start Encom Discover PA.

2. A message is displayed indicating that a valid licence was not found. Click 
License Encom Discover PA.

3. From the Encom Licence Manager, select the Current Installation tab.

4. In the Licence File box, select the type of licence.

5. In the Encom Software Currently Installed box, select Encom Discover 
PA and confirm that a licence for a previous version of the software exists, 
and then continue to step 6. If Encom Discover PA has not been 
previously licensed on this computer, select the appropriate licensing 
procedure for a new licence, as described in Licensing Procedures.

6. Select the Activate Software tab.

7. In the Activation code box, type the upgrade activation code supplied by 
Pitney Bowes Software. Upper or lower case characters can be used, but 
no blank spaces. 

8. Click the Activate button. The displayed modules, expiry date and version 
number are updated. 

9. Select the Current Installation tab and confirm the licence details.

10. Click the Close button.

Encom Discover PA is now ready to use.
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Transferring a Hard-Disk Licence

If a hard disk licence is operating effectively on one computer (the source), you 
can transfer the licence to a second computer (the destination). The process of 
transferring the licence does not require contact with Pitney Bowes Software for 
an Activation Code. Follow the steps below to transfer a valid licence from one 
computer to another.

Install the software on the destination computer

1. Install Encom Discover PA on the second, destination computer. The 
version of the software on the source and destination computers must be 
identical.

Start Encom Discover PA on the destination computer

2. On the destination computer, start Encom Discover PA from either the 
Windows Start button, or from the icon on the Desktop.

A message is displayed indicating no licence was found.

Encom Discover PA Viewer can be run without a licence.

3. Click License Encom Discover PA.

Create a new licence

4. The Create Licence File dialog is displayed. Type the company name 
and click OK.

The Encom Licence Manager is displayed, which lists all Encom 
programs installed on this computer.

Obtain the hardware ID of the destination computer

5. Select the Activate Software tab.

6. Write down the 7-digit code in the Hardware ID box.
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Display the Transfer Licence tab on the source computer

7. On the source computer, start Encom Discover PA.

8. From the File menu, choose Licensing.

9. From the Encom Licence Manager, select the Current Installation tab.

10. In the Licence File box, select Disk-based licensing.

11. In the Encom Software Currently Installed box, select Encom Discover 
PA.

The Transfer Licence tab is added to the dialog.

Encom Licence Manager on the source computer

Transfer the licence from the source computer

12. Select the Transfer Licence tab.
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Transfer Licence tab on the source computer

13. Under Step 1: Enter code, in the H/w ID box, type the Hardware ID code 
from the destination computer.

14. Under Step 2: Select program, select Encom Discover PA.

15. Under Step 3: Transfer, click the Transfer button.

A confirmation dialog is displayed.

Confirmation of the destination Hardware ID

16. In the Destination hardware ID box, type the Hardware ID that you 
obtained from the destination computer, and which you previously entered 
in step 13. 

Important The licence transfer will disable the licence on the source machine. The source 
computer licence cannot be reactivated unless the licence is transferred back 
from the destination computer or a new Activation Code is obtained from Pitney 
Bowes Software.

Important Take care that you enter the correct Hardware ID.
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17. Click the Transfer button.

The Activation Code for the destination computer is displayed.

Activation Code for the destination computer

18. Click the Copy Activation Code to the Clipboard button and then paste 
the code into a Notepad or Word document, which you can either print or 
copy to the destination computer.

Activate the licence on the destination computer

19. If necessary, restart Encom Discover PA on the destination computer and 
display the Licence Manager as described is steps 2 through 4.

20. Select the Activate Software tab.

21. In the Activation code box, type or paste the activation code that you 
obtained from the source computer. Upper or lower case characters can 
be used, but no blank spaces. 

22. Click the Activate button. The displayed modules, expiry date and version 
number are updated. 

Confirm details

23. Select the Current Installation tab and confirm the licence details.

24. Click the Close button.

Encom Discover PA is now ready to use.

Important The licence on the source computer is now disabled.
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Displaying Licence Information

After you have installed and licensed the software, to display information about 
the Encom licences installed on the computer, from the File menu, choose 
Licensing. The Encom Licence Manager is displayed from which you can:

• Examine Encom applications installed on your computer

• Examine various modules, dates, and version settings that are licensed 
for your computer

• Install licensing for Encom Discover PA or other Encom applications

• Transfer an Encom application licence from one machine to another. 
When this is done, the operational licence on the source computer is 
disabled.

Troubleshooting

If you believe Encom Discover PA licensing and dongle (if used) are correctly 
installed but are unable to correctly operate Encom Discover PA, you should 
contact Pitney Bowes Software. Pitney Bowes Software will respond with a 
solution to your problem or with a request for further information.
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4 Getting Started
In this section:

• Introduction and Guidelines

• Starting and Closing Encom Discover PA

• Understanding the Interface

• Controlling the Display

• Accessing Data

• Working with Graphical Objects

• Using Wizards

Introduction and Guidelines

Encom Discover PA is a simple but powerful program to operate and use for data 
visualisation and analysis. The following guidelines will assist you with the 
operation of the software.

Display the same data in multiple windows

Data can be displayed in a number of windows at any time. One of them (with the 
highlighted banner at the top) is current and active. To make a window current, 
move the cursor to it and click the left mouse button.

Use the Workspace Tree to select and manage objects

Selection and navigation of graphical objects and displays is best dealt with from 
the Workspace tree displayed by default on the left of the main window. Selecting 
the appropriate branch of the tree and clicking the right mouse button displays a 
pop-up menu with options relevant to the item selected. Additional information 
describing this can be found in The Workspace Tree.

Use the Properties dialogs to control the appearance of objects

The appearance of an object is controlled by a object property dialog, which can 
be displayed from the Workspace Tree or by double-clicking the object in any 
view. For information on using properties dialogs, see Branch (Object) Properties.



30 Encom Discover PA User Guide

Choose between two graphical modes

Encom Discover PA operates graphical displays in one of two modes - on-screen 
(Normal) usage and print preview (Layout) mode. Either mode is interchangeable, 
but the Layout mode is usually used to design on-paper displays prior printing. 
The on-screen mode is used primarily for interactive interpretation and graphical 
access to your data. For more information, see Controlling the Display.

Use standard Windows keyboard shortcuts

Standard Microsoft Windows keyboard usage applies for dialog list controls. This 
means that the SHIFT key in combination with the left mouse button can be used 
to select multiple list items. The CTRL key can also be used in combination with 
the left mouse button when selecting non-consecutive items in a list.

Use the Data Manager to control which objects are displayed

A Data Manager tree provides easy visualisation of active data in the current 
session and is a good source for the drag-and-drop facility for addition to new and 
current window displays. The active data is grouped into seven Data Object 
folders with additional pop-up menus available from either the folders or the data 
files displayed as trees beneath these folders. Additional information describing 
this can be found in Data Manager.

Flexible data display

Encom Discover PA uses different display windows to present data, graphs and 
maps. These presentation windows may contain a number of graphical objects 
(such as profile traces, layers, legends, bitmaps, metafiles etc). You can mix 
different graphics objects with other objects in the same window for display 
purposes. Such objects can be made updateable in real time so a change in one 
object may affect another. For example, a line number change may be reflected 
in a linked profile). All displays have the same format which means that they can 
all be copied and pasted to any other. Each of the displays can be presented in 
either on-screen mode or layout mode for hard copy preview.

Use wizards to quickly perform complex tasks

The New Document Creation wizard simplifies the task of creating basic 2D and 
3D displays of any data that you have established access to.
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Starting and Closing Encom Discover PA

To start Encom Discover PA:

To exit Encom Discover PA:

You can start Encom Discover PA in several ways:

1. Double-click the Desktop Encom Discover PA button. This icon is added 
to the Windows Desktop when the program is installed.

2. From the Windows Start button, choose All Programs>Encom 
Programs>Encom Discover PA.

3. Other methods of creating shortcuts to executables are available in the 
Windows environment. Refer to Windows Help for additional information.

• From the File menu, choose Exit (see Main Menu). Because projects and 
data contained in Encom Discover PA use database technology to store 
and retrieve information when you exit Encom Discover PA, any changes, 
processing or data alterations etc are automatically saved in the database.
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Understanding the Interface

When Encom Discover PA starts, the main screen is displayed, which is divided 
into seven areas.

The main screen items of Encom Discover PA

• The Main Menu contains operational pull-down menu controls.

• Toolbars are available for controlling selected functions (e.g decay curves, 
features, etc.). These toolbars can be removed from view and restored 
using the Toolbars option in the View menu. Toolbars can be dragged into 
the window or docked at the perimeter of the main window. Tools on the 
toolbars may not always be available because their operation may depend 
on a specific task being performed.

• A Display Window Area that initially contains a grey background. This 
area is used to display windows and dialogs.

• A Status Bar at the base of the screen to indicate processing and display 
events, progress bar and other useful progress information.
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• The Workspace Tree on the left of the display window. This toolbar 
provides a hierarchy view of all objects, data sources and controls of the 
various displays. Its contents alter when a dataset is accessed or a 
window is highlighted. The Workspace tree can be removed from view 
and restored using the option in the toolbars pop-up menu.

• The Data Manager window by default appears beneath the Workspace 
tree and is a tool to display and manage data objects open in a session 
file. The Data Manager can be removed from view and restored using the 
option in the toolbars pop-up menu.

• The Explorer and Data Windows may appear as a tabbed window or they 
can be placed or docked where convenient. The Data window displays the 
location, values, and field information when the cursor is located and 
moved in various display windows. The Explorer window provides a quick 
link to Windows Explorer for dragging and dropping data files. These 
windows can be removed from view and restored using the display tools 
on the toolbars.

Main Menu

The Main menu includes these general menus:

• File Menu – File handling for project sessions, display templates, and 
access to external databases and other file types are controlled using the 
options on this menu item. Packaging datasets, setting of licensing, 
printing and exiting are also available.

• Edit Menu – Standard Windows editing functions.

• View Menu – Options to display the various display types, toolbars and 
control dialogs, status bar and property dialogs.

• Insert Menu – Permits graphical objects and documents to be inserted into 
existing document displays. 

• Window Menu – Control of the position and selection of windows.

• Help Menu – Online help and reference facility.

Plus a number of utility menus:

• Features – Controls the Feature module, options and Feature 
Spreadsheet. See Features.
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• Tools – Provides options and access to editing default settings. Also 
contains some plug-in utilities that create various display objects from data 
opened inside Encom Discover PA. See Display Utilities.

• Database– Contains plug-in utilities that allow data to be processed 
(including line filtering) from within Encom Discover PA. See Database 
Utilities.

• Grid – Gridding line data and filtering gridded data plus other utilities for 
processing gridded data. See Gridding Utilities. The Geofilter module is 
also accessed from this menu through theGrid Filter option. 

• Voxel – Options for 3D gridding and preparing data for 3D gridding. See 
Voxel Utilities.

• Vector – Options for converting and transforming 2D and 3D vector files. 
See Vector Utilities. 

• Display Utilities – Provides access to plug-in utilities that create various 
display objects from data opened inside Encom Discover PA. See Display 
Utilities.
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File Menu

File menu

The options available from the File menu allow you to:

• Open and close point, line, and drillhole databases such as Intrepid, 
Geosoft montaj™, and MapInfo Discover (see Working with Data).
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• Import ASCII data files, such as .TXT, .CSV, ASEG GDF, Crone, and 
SEG2 data (see Importing ASCII Data Files)

• Export Geosoft .GDB databases to ASCII files (see Exporting Data).

• Create, maintain and restore Encom Discover PA project session files 
(see Managing Session Files).

• Create new display documents of all formats or from templates (see Page 
Layouts and Display Properties).

• Create or restore templates to control the appearance of display windows 
(see Templates).

• Create a packaged dataset for archive or transmission to work associates 
(see Packaging Datasets).

• Save an image of a displayed window (see Graphical Output).

• Print, batch print, preview and access printer setup controls (see Printing).

• Restore the last few project session files (see Session Files).

• Modify the location data channels of a loaded dataset (Working with 
Data).

• Access the licensing management (see Licensing Encom Discover PA).

• Exit Encom Discover PA (see Starting and Closing Encom Discover PA).

These functions are described in the corresponding sections of this guide.
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Edit Menu

Edit menu

The Edit menu is used to undo, copy, delete, paste and insert various graphical 
items in the displays. The Edit menu options include:

Undo

A limited number of undo steps are available in Encom Discover PA. The number 
of available steps is defined in the Tools>Options item. Note that for large, 
complex datasets and with a large number of undo steps, computer memory is 
used and performance may suffer. 

Redo

Only enabled once an Undo operation has been performed, the redo option will 
reinstate the operation that was undone.

Cut

Copy a selected graphical item to the clipboard and remove it from display.

Copy

Copy a selected graphical item to the clipboard but do not remove it from display.

Paste

Insert a captured item from the clipboard and place it in the display at the location 
defined by the cursor.
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Copy View

Selection of the Edit>Copy View option saves the contents of the active window 
to the Windows clipboard as a metafile. This capture can then be imported directly 
into other applications such as Microsoft Word or Excel etc.

Delete

Remove a graphical or selected item from the display or table entry. This is a 
permanent deletion and the item is then lost.

View Menu

The Encom Discover PA View option enables different data views and display 
control dialogs to be presented. The View menu also controls the placement and 
visibility of the floating Toolbars.

View menu

Fit to Page

Reshapes a display at the Frame level to fit the page format.
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Normal and Page Layout

Applies only to individual and selected windows. Consequently, it is possible to 
have some windows in Normal display mode while others are in Page Layout 
mode. See View Modes for additional information.

Actual Size

The Actual Size option uses Page Layout Mode but zooms the display to a level 
on-screen that matches a hard copy print when scaling and range setting limits 
are specified.

Frame Design Mode

Two modes of display are available: Normal and Design. Design mode makes cell 
boundaries and linework visible. To view the final output, switch to Layout mode 
where final linework is not visible. To make this switch, use the Grid Design or 
Page Layout button.

Frame Layout Mode

This is the mode opposite to the Design mode (see above).

Appearance

Controls the appearance of the interface including windows, toolbars and menus 
based upon selected applications style.

Toolbars

A variety of toolbars can be used in Encom Discover PA. For more information, 
see Toolbars.

Status Bar

Displays a range of status items relating to processing, data access, coordinates 
and data queries.

Insert Menu

The Insert menu provides you with options to add Map, Profile, and Graph display 
frames, OLE objects (for example, Microsoft Word documents), components 
(combinations of drawing objects), and data objects, such as text, bitmaps, and 
other graphics objects.
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Insert menu

Features Menu

See Features.

Tools Menu

See Display Utilities.

Database Menu

See Database Utilities.

Grid Menu

See Gridding Utilities.

Voxel Menu

See Voxel Utilities.



4 Getting Started 41

Vector Menu

See Vector Utilities.

Window Menu

The Windows menu controls the various window displays that may be presented 
on the screen at any time. The menu appears as below:

Windows menu

Options contained in the Windows menu include:

New Window

Creates a new document window.

Cascade

Windows are arranged on the screen with uniform size and with overlap from the 
top left corner of the Encom Discover PA display area.

Tile

Windows are arranged with equal area and no overlap in the Encom Discover PA 
display area.

Arrange Icons

Arranges minimised window icons at the base of the Encom Discover PA display 
area.

Split

Enables a display such as a Spreadsheet to be split and resized.
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Window list

Encom Discover PA displays a list of all the available windows, included those 
that have been minimised. You can use the cursor to point to one of these 
windows to activate it (bring to the front of overlapping displays). The name used 
in the Window list is that shown in the window’s title bar.

Help Menu

The help option enables access to on-line help and information.

Help menu

Help Topics

Access on-line help. Refer to Getting Help for further detail.

About Encom Discover PA

Displays developer, version and history information.

Other menu options providing access to electronic manuals and documentation 
are also provided.

Toolbars

Toolbars are a convenient way to utilise the functions available in Encom 
Discover PA. The buttons on a toolbar are grouped by similar or associated 
function. See Available Tools for descriptions of the function of the available 
toolbar buttons. For information on using toolbars, see Using Toolbars.

To hide and show toolbars, choose the toolbar from the Toolbars option on the 
View menu:
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Toolbars on the View menu

Main toolbar – Used for data access, operational modes, printing, display, help 
and data selection.
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Documents toolbar is used for creation of initial displays including profiles, flight 
path maps, spreadsheets, graphs, decays and multiple grid presentations. 
Templates are also accessed from this toolbar. Buttons on this bar allow creation 
of 2D and 3D displays.

Objects toolbar enables the addition and control of graphical objects to a display 
window. This toolbar allows frames, maps, decay legends, bitmaps, OLE objects, 
text and components such as title blocks to be added.

Data Objects toolbar provides single, push-button addition of the various display 
objects into the active window.

Zoom Controls toolbar provides access to window or real data zooming and 
panning control in both 2 and 3 dimensions. 

Line Iterator toolbar enables line navigation.

Features toolbar is used to select and assign properties to created features 
derived from interpretations.
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Feature Editing toolbar provides all the tools required for advanced editing for 
Feature Objects.

Decay Curves toolbar is used for displaying a display curve profile and reading 
the decay across time channels. It is therefore only fully active when a multi-
banded, time-related EM dataset is displayed in a profile display and selected 
using the cursor in select mode.

Cursor Plane toolbar provides button controls for locating and creating 3D 
features in three dimensional displays. A 2D plane is used to constrain a cross-
hair cursor that can accurately be located to determine a position in three 
dimensions. Additionally, the plane can be used to slice objects.

Toolbar Shortcut Menu

Other window components can be shown and hidden from the Toolbar shortcut 
menu, which is displayed when you right-click anywhere inside the main toolbar 
area of window:

• Workspace – This is the main object tree tool used to show the hierarchy 
of items being displayed.

• Data Manager –. Use this window to visualise what data files are open in 
the current session. Pop-up menu also allow additional operations for 
each file.

• Data – The data window will show data representing the display object 
that is selected by the cursor at the time. 

• Explorer – This is a shortcut to Windows Explorer which can be used to 
drag and drop data files into the display windows. 
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Using Toolbars

To assist in understanding the function of each button, a message (called a Tool 
Tip) is displayed when the cursor is placed over a button for a short period of time. 
Descriptions of the available tools can also be found at Available Tools.

Toolbars can be moved so that they float in the screen or docked into the 
perimeter of the main window.

To move a toolbar:

• If the toolbar is docked, place the cursor over the three dots at the end (left 
or top, depending on the orientation) of the toolbar until the cursor 
changes to a four-way arrow. Then click and drag, holding down the left 
mouse button, until the toolbar is in the desired position, and then release 
the mouse button.

• If the toolbar is floating, position the cursor over the toolbar title bar. Then 
click and drag, holding down the left mouse button, until the toolbar is in 
the desired position or docked at the top of the window.

To save, restore, or reset your toolbar arrangement:

• From the View menu, under Toolbars, choose either Reset 
Arrangement, Save Arrangement or Restore Arrangement.

Available Tools

The tools available on the Encom Discover PA toolbars are described below:

Tool Description

Open Geosoft database

Open Intrepid database
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Open Discover drillhole database

Import ASCII data – this will open the Import ASCII data dialog

Open session

Save session

Cut the highlighted object

Copy the highlighted object

Paste a copied/cut object into the highlighted object

Undo last action

Redo last action

Normal View/Page Layout View toggle

Frame Design Mode/Layout Mode toggle

Page Setup – allows specification of page size, orientation, etc.

Print – Print a document

Distance/Bearing Measurement tool

Paste Into – this allows the insertion of a cut/copied object into a specified area 
of a document

Insert Component into a document. This will open the Insert Component Preview 
dialog

Tool Description
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Insert an Object into a document, e.g. MS Word document, MS Excel 
spreadsheet.

Wizard dialog to insert a Map Frame into a document. Use the black down arrow 
button to display menu options for quick insertion of a map display type.

Wizard dialog to insert a Profile Frame into a document. Use the black down 
arrow button to display menu options for quick insertion of a profile display type.

Wizard dialog to insert a Graph Frame into a document. Use the black down 
arrow button to display menu options for quick insertion of a Graph/Scattergram 
display type.

Insert a Frame into a document

Insert a Text Object into a document

Insert a Picture into a document

Insert a Scalebar into a document

Insert a North Arrow into a document

Insert a Floating Colour Bar into a document

Line Iterator: Select an Active Line from a loaded database

Line Iterator: Moves a Graph or Profile display backwards one line in a loaded 
database

Line Iterator: Moves a Graph or Profile display forwards one line in a loaded 
database

Line Iterator: Reverses the direction of the line shown in a Graph or Profile 
display

Line Iterator: Displays the Line Iterator Properties dialog

Tool Description
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Line Iterator: Displays the Line Iterator Line Report dialog

New Document Wizard dialog

Open from Template

Open Blank Document

Open new Map display wizard

Open new Profile display wizard

Open new Graph/Scattergram display wizard

Open Spreadsheet display

Add a curve to the current display (Profiles, Graphs and 3D displays only)

Add a Points series to the current display (2D maps and 3D displays only)

Add a Lines series to the current display (2D maps and 3D displays only)

Add a Drillhole group to the current display

Add Stacked Profile series to the current display

Add a Flight Path series to the current display (2D maps and 3D displays only)

Add a Directional Vector series to the current display (2D maps and 3D displays 
only)

Add a Grid to the current display (2D maps and 3D displays only)

Tool Description
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Add a Grid Contour to the current display (2D maps and 3D displays only)

Add a Voxel Model to the current display (3D displays only)

Add a Feature Set to the current display

Add a Located Image to the current display

Add a Vector file to the current display (2D maps and 3D displays only)

Add a Section to the current display (Profile, Graphs and 3D displays only)

Add a Section Grid to the current display (Profile displays only)

Add an Axis (XY or XYZ) series to the current display

Select an object

Zoom Page in Place

Zoom In to Page

Zoom Out from Page

Pan around the Page

Fit window to page extents

Data Zoom In

Data Zoom Out

Tool Description
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Pan around in the Data area (Profiles, Graphs and 2D maps only)

Fit data to frame extents (Profiles, Graphs and 2D maps only)

Navigate in 3D (3D displays only)

3D Zoom In (3D displays only)

3D Zoom Out (3D displays only)

Reset 3D View (3D displays only)

3D View Manager (3D displays only)

Activate Fast View (3D displays only)

Select the viewing direction for a 3D display from pre-set directions.

Toggle between Perspective and Orthographic view (3D displays only)

Confirm Feature Creation prompt

Select feature(s) with polygonal frame

Create a Point Feature

Create a Polyline Feature

Create a Polygonal Feature

Create a 3-Point-Range Feature (Profile and Graph displays only)

Tool Description
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Feature Information spreadsheet

Activate SnapTo when digitising feature objects

Batch print feature objects

Centre view on selected feature object

Select previous feature object and centre view on it

Select next feature object and centre view on it

Toggle Reshape feature mode

Activate Elasticity for when editing feature objects

Add mode

Delete mode

Break mode

Combine selected feature objects

Intersect the selected features

Cut selected features from the target

Triangulate - converts a selected polygon to a surface or ensures a selected 
surface contains only triangular faces

Aggregate - group multiple selected features into a single feature and preserve 
all

Tool Description
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Disaggregate - ungroup aggregate features into individual features

Open a new Decay Curve display

Insert a Decay Curve display into a document

Insert a Decay Curve Legend into a document

Move Decay Curve backwards to previous line

Move Decay Curve forwards to next line

Display Cursor Plane (3D displays only)

Lock the cursor plane at current orientation while editing feature (3D displays 
only)

Change the Orientation of the Cursor Plane (3D displays only)

Bond cursor plane to data or image (3D displays only)

Clip a 3D display with the Cursor Plane (3D displays only)

Clip the display with current cursor plane orientation and move the cursor plane 
(3D displays only)

Orient the view to be perpendicular to the Cursor plane

Shrink the size of the 3D Focus box (3D displays only)

Enlarge the size of the 3D Focus box (3D displays only)

Fit the Focus box to the 3D display extents

Tool Description
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Display Window Area

The display area is the main screen for graphic presentations. The area is also 
used for dialogs, spreadsheets and layouts containing print preview displays. 
Descriptions of each of the display formats are provided in the Graph and Map 
Display sections.

Status Bar

The Status Bar is located at the base of the Encom Discover PA window. A range 
of items are displayed in the status bar including:

• Messages to inform you of processing or data access

• Progress bars to advise of data processing status

• Information relating to the readiness state of Encom Discover PA

On the right end of the bar are specific information areas that display the setting 
of particular functions (for example, modelling enabled etc) or location 
information.

The Workspace Tree

The Workspace tree is the main means of control used in Encom Discover PA. It 
operates by listing all entities used in a display. These entities may be graphical 
objects, profiles, axes, annotations etc. Each object displayed is represented by 
a branch on the Workspace tree. The relationships between the branched objects 
are shown in the Workspace tree as a hierarchy. 

For example, in the simplest case, a document may contain a frame of one or 
more profiles. Each profile uses an X axis for its distance plotting (using the 
ProjectedDistance channel). The vertical scaling of data is controlled by a Y axis 
plus a Y axis control for annotation. The profile may also have an associated 
vertical colour bar (called a Colour-Axis). The data source is controlled by a Curve 
(of which there may be several in a banded dataset). Each data field can also 
have its own colour, symbol and rotation controls presented under the Curve 
branch in the hierarchy shown.

Display the Cursor Plane Properties dialog

Tool Description
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From this simple illustration you can see there can be a complex interaction of the 
components of a simple profile. Encom Discover PA permits these and many 
other complex interactions. The Workspace tree displays these interactions and 
provides controls for each of them. 

The structure of the example is logical and provides immediate access to every 
branch of the plot for property control.

The hierarchical structure of the tree has distinct advantages over more 
conventional graphing techniques:

• Each item can be selected for property control with no ambiguity.

• Operations such as Cut, Paste, Delete and Clone are made available by 
selection.

• Even sophisticated profiling relationships are no more complex than those 
shown above.

• Data object branches of the tree can be dragged to another position in the 
tree.

Other displays such as maps, images, 3D plots etc. can all be positioned as a 
hierarchy in a display. In each case the relationship is presented in the 
workspace.

For more information about using the Workspace tree, see:

• Controlling the Tree Content

• Hiding and Showing Branches

• Renaming Branches

• Expanding and Collapsing Branches

• Branch Controls

• Working with the Workspace Tree

• Branch (Object) Properties
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Controlling the Tree Content

The Workspace tree grows incrementally as various objects and their branches 
are added or changed. Because the size of the tree is limited by screen space, 
and complex designs can entirely fill the available area, you may need to adjust 
the window display to find and view the details you need:

• Use the scrollbars on the right and bottom margins that appear when the 
entries become too long to fit horizontally or there are too many entries to 
fit vertically.

• Change the Tree Content setting to expand or collapse the various 
elements of the tree. To change the Tree Content setting, position the 
cursor in a vacant area of the window and right-click to display the Tree 
Content shortcut menu.

Each option reveals a different level of detail in the tree. The options are:

• Concise – Only a minimum number of branches are shown. For 
most operations this is adequate.

• Minimised – An increased number of branches are shown but not 
individual channels or rarely accessed items.

• Verbose – All branched items used in the display are shown.

However, the lowest branch of the tree (the individual data fields or bands) 
is not affected by this setting and is controlled only by the expand (  ) or 
collapse (  ) button on the branch.

Hiding and Showing Branches

Beside each displayed object branch is a check box. Click this box to hide (no tick) 
and show (ticked) this object branch. Hiding a branch will also hide all dependent 
sub-branches. 
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Renaming Branches

The branches of the Workspace tree can be renamed. This can be helpful in 
complex tree designs. To rename a branch, position the cursor over the branch 
label, click once and the text appears selected. You can then type in a new label 
or edit the current label. Click outside the label box to save your changes.

Expanding and Collapsing Branches

To the left of each subordinate branch is a small button, which appears as either 
 or . These boxes indicate that lower levels exist in the branch. By clicking on 

these boxes you can expand or collapse the sub-branches.
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Branch Controls

To the right of many branches are three controls.

Working with the Workspace Tree

A wide range of functions and tasks are performed from the Workspace tree. The 
functions available from shortcut menus, which are displayed by right-clicking 
different types of branches.

Editability – enables objects to be added or edited in the selected feature 
database. Only one Feature database can be editable at a time. Making a 
feature database editable will automatically turn on the Cursor Plane, ready for 
feature object digitization.

Selectability – enables objects within the selected dataset to be selected. For 
instance, when multiple image branches are open, this is a useful way of limiting 
which branches (or images) the Cursor Plane can be bonded to. Selectability 
can also be used to control which feature databases can be interrogated when 
multiple complex databases are open.

Browsable – attribute information for a Selectable dataset can be dynamically 
viewed in the Data tab of the Data tab. This only applies to datasets such as 
those used for 3D Points, 3D Lines, and Drillholes.

Zoom Extents – zoom the view to the extents of the selected data object, or

Zoom All – zoom the data view to the extents of all data within a frame.
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Right-click on To display the shortcut menu For this branch type

Document Branch
Apply some of the commonly used 
cursor controls such as Pointer (2 and 
3D), Page and Data Zoom options (see 
Toolbars). Access to the Properties of 
the display is also provided.

Specify the Page Setup for a specific 
printer or plotter. The Default Layout 
option reverts a display to the current 
Page Setup setting.

Frame Branch
Add a new display to the document 
frame (relevant to that Frame type). You 
can Cut, Copy and Delete or Save the 
objects as a Component. 

If cell edge selection is used, the cell can 
be Split or the adjacent cells can be 
Merged.

Data Object Branch
Properties, adding axes and/or additional 
data objects (profiles, sections, images, 
models, vectors and features) or axes. If 
features are to be displayed with these 
objects, they must be added as an 
additional object type.

Cut, Copy and Delete selected items or 
make a Clone copy of a selected object. 
An object can be positioned Up, Down, 
Left or Right and Forward/Back if 
overlapping. Displays contained in a 
window can be saved as a raster.
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Branch (Object) Properties

The properties of every object are controlled from the Workspace tree. To display 
the properties of a branch either:

• Right-click the branch and choose Properties from the shortcut menu, or

• Double-click the branch.

All axes relating to X, 
Y, Colour and Size 

axes (see Axes)

Axis Branches
This menu deals with the labels, 
positions and other properties related to 
axes and their annotations. Display the 
Property dialog of the axis. Make a Clone 
copy, Cut, Copy or Delete annotation. 

You can position the annotation axis up 
or down if required and hide or show it. 

Relates to all Data 
Objects except the 

Map Document.

Data Source Branch
This menu relates to the data being 
presented in the data object. You can 
display the Property dialog and Copy, 
Cut, Delete or Clone the data object.

You can position the annotation axis up 
or down if required and hide or show it. 

Field/Band/Layer Branch
Display the Property dialog. Select All 
bands for displaying or scaling. Delete All 
bands from display.

Right-click on To display the shortcut menu For this branch type
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In most cases, the Properties dialog contains several tabs, and each tab controls 
a group of related properties.

The Profile Properties dialog and assorted tab controls

For information on how to use the properties dialogs, refer to the relevant topic in 
this guide.

Data Manager

The Data Manager is an optional window, similar to the Workspace Tree, that can 
can be toggled on and off, moved, and docked. The purpose of the Data Manager 
is to control the visualization of data files loaded into a session of Encom Discover 
PA.

• Hiding and Showing the Data Manager

• Information Displayed by the Data Manager

• Adding Objects to Displays

You can keep the Properties dialog open by clicking the pin symbol on the title 
bar. The dialog will update automatically with each object selection.

Changes to properties are not made until you click Apply or OK. If you make a 
mistake when entering changes, select the Restore button to return the control 
settings to their previous state. Clicking the OK button also dismisses the dialog.
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Hiding and Showing the Data Manager

If the Data Manager window is not visible when Encom Discover PA starts, right-
click in the toolbar area below the Main menu and select it from the Toolbar 
shortcut menu.
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Information Displayed by the Data Manager

When a new session is first opened in Encom Discover PA, the Data Manager will 
display seven empty folders, one for each of the object types that can be loaded 
in Encom Discover PA:

An empty Data Manager window

When a file for one of these object types is loaded, the file name is listed below 
the object folder for that category. A Feature Database will be displayed under the 
Features folder, located under the Datasets folder, and any associated Feature 
Sets for this database will be displayed as branches beneath the feature 
database entry.

The Data Manager also has shortcut menus options for each folder, from where 
you can open and close data files (instead of using the File menu), and display 
information about the current files:

View Reference Count – If this option is enabled then a number is displayed in 
a column located to the right of a loaded file. This indicates the number of times 
this file is being used in all display windows of the current session.

View In-use Flag  - If this option is enabled then a green tick located to the right 
of a loaded file indicates that the file is in use in a display window.

View Long Names  - This option will show the file location as well as the file 
name in the Data Manager window.

View Short Names and By default this option is enabled. This will show only the 
object file name in the Data Manager window.
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Example of a populated Data Manager window

Coordinate System Information

Once a data file is open in Encom Discover PA and is visible in the Data Manager 
window, it is possible to view the coordinate system associated with the data by 
hovering the mouse over the title in the Data Manager window and a temporary 
window will appear showing this information."
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If no coordinate system is associated with the data file, "Projection: Not defined..." 
will be displayed.

To associate a coordinate system with the data file, right-click on the file name in 
the Data Manager and select Modify dataset properties from the pop-up menu 
that appears. 
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In the Modify Dataset Properties dialog press the Choose Projection button in 
the Projection section and nominate a Category and Category Member for the 
Coordinate System. Press OK and then Apply. 
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Alternatively if the coordinate system has already been used within Encom 
Discover PA, select this from the drop-down list in the Modify Dataset Properties 
dialog.

Check the Data Manager again to ensure that the coordinate system definition 
has been updated. 

Adding Objects to Displays

You can drag-and-drop objects from the Data Manager into a new or existing 
display window. 

To display objects in a new frame:

1. In the Data Manager, select the files you want to display, and drag it into 
the grey display window area. Multiple files can be drag-and-dropped in 
one action using the CTRL key.

2. From the Drag and Drop dialog, select a display window type.

Drag and Drop prompt for loading a data object into a new display window

To add objects to an existing frame:

• In the Data Manager, select the files you want to add to a display, and 
drag into the display frame.

Explorer and Data Windows

The Explorer and Data windows can be positioned and docked where convenient. 
By default, these windows are docked to the right margin.

• Explorer Window – provides a quick link to Windows Explorer for the drag-
and-drop operation of data files. 
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• Data Window – displays data location, values and field information when a 
cursor is located and moved in various display windows

Each of the window tabs can be removed from view and restored using the Data 
or Explorer options in the Toolbars shortcut menu.

Explorer Window

The Explorer window operates similarly to Microsoft Explorer and allows you to 
access, list and report on files within any of the drives available to the computer. 
You can use the Explorer in the same manner as Microsoft Explorer such that the 
pop-up menu (from a right mouse click) can be used to alter the view, the folder, 
paste/copy and examine file properties.

Explorer tab used for navigating and accessing files

The Explorer view also saves its last 10 user selected directories and reloads 
these into the address bar on the next run of the application. The Explorer view 
initialises to the last used directory from this saved list.
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To prevent opening of the Explorer tab at startup:

1. From the Tools menu, choose Options.

2. Select the View tab.

3. Clear the Create Explorer View at startup option. 

Data Window

The Information window Data tab can be used to interrogate data values 
displayed in profiles, graphs and maps. With one of these displays present, by 
placing the cursor in the window, the relevant data values for the objects are 
shown in the Data tab. As the cursor is moved within the display window, the data 
values update. This feature can be used in multi-banded data such as EM or 
multi-tracked data such as elevation, altimeter and topographic profiles.

An example of using the Data tab is shown below:

Data displayed in the Data tab from the cursor located in a multi-band profile

Warning When the Explorer tab is used, it interrogates all available drives to the 
computer. This will include mapped network drives, if connected, and as a 
consequence, it may slow down Encom Discover PA operation.
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Managing Windows

In the top right corner of the Workspace Tree, Data Manager, Explorer, and Data 
windows there are options for controlling the visibility. 

Controlling the Display

• View Modes

• Page and Data Zoom Modes

• Data Zooming, Panning and Frame Data Linking

• Map and Profile Zoom Relationships

View Modes

Encom Discover PA display windows (whether profiles, maps, spreadsheets or 
decay plots) vary in appearance depending on the View mode. Two view modes 
make efficient use of available screen space and account for the fact that the 
requirements of on-screen interpretational work are frequently different to those 
of printing. The two modes are:

The Pin button allows the user to auto hide the window when it is not in use. 
When auto-hidden the window can be accessed from the vertical bar to the right 
of the PA interface.

The Close button will remove the window from view. To display again the option 
needs to be accessed from the pop-up menu by right mouse clicking on the 
main toolbar area.

Normal View Mode – This is the default viewing mode. In normal mode, Encom 
Discover PA displays profiles, maps and other objects using all available area of 
the display window and provides the most efficient view of data.

Layout Mode – In Layout mode you can see how objects are positioned on the 
printed page. This mode partially replicates a paper view although a more 
accurate preview before printing is achieved from the File>Print Preview option. 
This view is also useful for editing borders, margins and the placement of objects 
prior to printing. The size and orientation of the page is defined by printer 
settings specified in the File>Print Setup option (see Printing).

You may switch between Normal and Layout views quickly by using the Page 
Layout button or from the Window menu option.
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Page and Data Zoom Modes

As well as two viewing modes, two data display modes are also available. These 
modes dictate the data content displayed in the various document windows. The 
two modes are:

When zooming in Data mode, a greyed rectangle over the zoomed area is drawn 
to provide an indication of the area to be zoomed. Resultant zooming does not 
affect the size of annotation or line thicknesses but acts only to increase the level 
of data seen in a display. Smooth scrolling of data in profiles is available to allow 
panning and roaming of data, especially in profiles (see below).

Note To see a plot as it will be printed use File >Print Preview.

Page Mode – This mode uses the button group and controls zooming out/in, 
panning and fitting data in normal or default operation. For a description of each 
button’s operation, see Available Tools.

Page mode zooming increases the zoomed area as if magnifying the paper on 
which it is presented. This means that text, data, line thickness etc are all 
increased in size.

Data Mode – This mode controls the data content displayed in a window, rather 
than the view. The data content can be zoomed, roamed and fitted similarly to 
Page Mode, but the content is displayed with axes etc for relative assessment. 
The Data Mode uses the set of buttons. 
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A third group of buttons available from the Zoom Controls toolbar are used 
exclusively for 3D window navigation. The buttons are described in 3D Toolbar 
Controls.

Data Zooming, Panning and Frame Data Linking

Encom Discover PA distinguishes between two types of Zoom and Pan 
operations. 

• Page Zoom – This modifies your view of a displayed document. Page 
Zoom enlarges annotation text, axes and the paper view of a window.

• Data Zoom – This form of zoom allows you to zoom and pan the data 
range within a plot object. A defined Data Zoom area is used to fill the 
available display window. Annotation text etc adjusts its data coverage 
values but not its font size or style.

When you Data Zoom in a plot object, it is likely that other plot objects in the frame 
will also respond and modify their data range. This happens because the axes of 
frames can be linked using a global setting. In a map, the X and Y ranges are 
usually global. The frame linking facility can be disabled by setting the data 
ranges to be not global if required.

Smooth scrolling of profiles and maps uses the third button or depressed scroll 
wheel of recent mouse device types. To initiate the smooth scrolling of a map or 
profile, zoom to a portion of the profile or map window using the Data Zoom 
button.

With the profile in Data Pan mode (click button), press the third button (or scroll 
wheel) on the mouse and move the cursor horizontally in the window. The map 
or profile then moves smoothly left or right. 

You may notice that as a profile scrolls, it automatically adjusts the vertical 
scaling to accommodate the changing data range. To have fixed scaling, display 
the properties of the Profile dialog, select the Y Axis Properties Tab and set the 
Y Axis Range and Scaling to be Fixed. The velocity of panning is proportional 
to the distance from the initial mouse placement. 
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The mechanism to keep data ranges linked from one frame to another can 
operate in the same, or different, documents. A typical operation is to have map 
frames data linked or to have a profile frame linked to a map data range. In the 
latter case, when you Data Zoom or pan in a map, it broadcasts its data range to 
the profile which then zooms to show only that portion of the profile that is within 
the map data range. If a profile data range is completely outside the data range 
of the map then the profile may displays no content. 

To enable this option, ensure that the frame you wish to use as the data range 
source is a Broadcaster and that the frame you wish to have respond to these 
data range changes is set to Listener. Furthermore, you need to specify whether 
the listening frame should respond to broadcasting frames in the same document 
only, or in other documents, or both. To initiate the first link you need to modify 
the data range in the broadcasting frame.

These settings are made from the Options tab of the frame properties. Additional 
information on this topic is available in Map and Profile Zoom Relationships.

Map and Profile Zoom Relationships

Frequently data is zoomed and panned in maps and profiles. In particular, the 
flight path map is a powerful means of controlling which data lines are selected 
and displayed in accompanying profiles. In these circumstances, if a map is 
zoomed in so that only a small portion of the overall line length is viewable, it is 
desirable that only the same length of (zoomed) profile is displayed.

This relationship of having the zoom level in a map controlling what is displayed 
in a profile is a powerful feature. Encom Discover PA also updates a profile 
display in such a way that if the controlling map is panned or re-zoomed, the 
profile coverage is automatically updated.

To achieve the linked zooming relationship between a map and a profile, select 
the Map Frame branch of the Workspace tree and display the Options tab. From 
this tab, the map must Broadcast its globally zoomed limits to other responding 
windows. Consequently, from the zoom control window, enable the Broadcast 
option. From the Frame level of the responding window’s property dialog, again 
select the Options tab and enable Respond to Global in both X and Y.

When you zoom or pan using the Data mode (only), the portion of the line 
displayed in the map matches that displayed in the profile.



74 Encom Discover PA User Guide

Reset Data Limits

From the Frame and Object (Profile, Map, Graph and Scattergram) branches of 
the Workspace tree, a right mouse click is used to display the controlling pop-up 
menu. This menu contains an option called Reset Data Limits. When selected, 
this action re-assigns the data range in all subordinate graphs or axes and 
redraws. The result is a data zoom to extents that resets all axis restrictions. 

Data Zoom to Extents

Accessing Data

Encom Discover PA is designed to access data directly from industry standard 
databases. Unlike other geophysical packages, Encom Discover PA can use 
existing import and raw data reading facilities of external packages to provide 
processing and access to the data. Encom Discover PA also has the capability of 
reading data from external, non-database files (such as located data and ASCII 
files of various formats). It does this by external processing and import modules 
supplied with the software which read the specified data and then place it into a 
database format.

The use of databases and the ability to use the import capabilities of other 
software has a number of advantages:

At certain branches of the Workspace tree, a variation of the above option is 
provided in the context menu. This item Data Zoom to Extents, causes any 
zoomed view of a map to be displayed as a Zoom Fit. This option operates 
identically to the Data Zoom Fit button. 
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• A wide variety of data formats, data sources and file formats are catered 
for by other packages and are not required to be supported by Encom 
Discover PA.

• The manipulation and editing of data obtained from a database provides 
greater power and increased flexibility.

• Reading of data from a binary database is much faster than from raw 
(text) data files and does not have the overhead of checking record or 
data validity.

• Navigation of data from one point (or traverse line) to another can take 
advantage of search and indexing techniques to increase speed and 
simplicity.

Encom Discover PA is designed to act as an interface between external data and 
databases (containing data), to display and provide interpreter interaction 
(through accessory processing or interpretation modules). The data links are 
transparent to the user as Encom Discover PA detects the type of database 
present in a folder and builds the required links automatically.

When Encom Discover PA opens a database, editing or changing the attributes 
of the data entries is not currently possible. However, external processes such as 
batch procedures, can create and add new data to the database. Additional utility 
modules allow you to rename, delete or merge data into array fields.

After starting Encom Discover PA, to access a valid database, you initially need 
to know where and what type of database is to be accessed. The location is the 
path, in a root folder, and the type is either:

• Geosoft Oasis montaj™

• Intrepid

• MapInfo Professional

Note ASCII data can be loaded directly into Encom Discover PA. This operates by 
transferring the ASCII data into a Geosoft database and then directly loading the 
database (see Importing ASCII Data Files).
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Defining the Z-Channel

Since Encom Discover PA can display data in three dimensions, it uses a specific 
data channel (termed Z) for the third dimension. If you load a database that does 
not have a Z-data channel, the program asks if you wish to define a Z-channel. If 
you are unlikely to use 3-dimensional displays, you may opt not to select a Z-
channel. The dialog displayed below makes this clear.

Dialog to nominate an X, Y or  Z channel

Project Directory Specification

Encom Discover PA can use one of two concepts to access data files. These are:

• Specify a project directory to assist with navigation and access to data. 
Typically, when working on a project, a specific folder is created and 
various data components created or used for that project are placed in 
sub-folders beneath the main, project directory.

Note If you select the OK button without defining a Z data field, Encom Discover PA 
can open the dataset, but no three dimensional display is available.
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The menu command File>Set Project Directory displays a dialog 
allowing you to specify a folder location. If using this method of data 
navigation it is recommended that you specify the project root directory 
location rather than a sub-folder of the project. Note that when a session 
(of a project) is restored, the path of the session is assumed to be the 
Project Directory. The Project Directory as specified is displayed in the 
Status Bar.

The Project Directory is also used when project specific files are created. 
For example, if you create a colour look-up table or legends which relate 
only to that project, they can be stored into the project folder and be 
available only while the Project Directory setting is set to that path.

• A second useful facility for file navigation is the concept of a Global 
Directory. This setting (set from the Tools>Options>File Locations tab) 
stores the last accessed path when any data type is saved or loaded. This 
means that if you for example, navigate to a project grid file, when you 
next again search for a grid, the software path is initially returned to the 
same location as the previously accessed grid. This approach is data type 
specific so a path for a grid will be different for a database etc. The Use 
Global Directory for all file location dialogs option enables this location 
for all data object that are opened and is activated by default.

Specifying which of the two data navigation methods is used is determined by a 
setting on the Tools>Options>File Location tab. Set the desired method by 
enabling the option as required.

Working with Graphical Objects

Encom Discover PA uses containers (called Frames) to hold graphical objects in 
position on a page. Different frame types exist for each of the object types that 
can be displayed. All displays have frames in the Workspace tree directly beneath 
the document type. Although they are referred to as Profile frame or Map frame, 
their manipulation and operation for each frame type is identical.

• Frames

• Components

• Frame and Plot Axis Control

• Snap Operation

• Size Units

• File Drag-and-Drop

• Line Navigation
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Frames

Frames or containers are used to hold graphical objects in position on a page. 
These frames can have any number of rows and columns to form cells, similar to 
a table in word processing software. Each cell can contain one or more graphical 
objects. Using cells enables objects to have alignment as well as easily 
controlling their edit operations such as cutting/pasting etc. As an alternative to 
positioning items in frames, refer also to Snap Operation.

Each frame has its own properties to control the appearance of the cells 
irrespective of the display objects it contains. The property dialog for frames in all 
cases has an Appearance tab. Controls on this tab position the Frame within a 
Border and each contained cell has Margin controls. Boundary lines surround 
each of a frame’s cells.

The components of a document display

Frame borders, cell lines and margins can have individual line styles and these 
can be made visible or invisible. Two modes of display are available to assist 
with frame and cell design and positioning – Layout and Design. The purpose of 
these modes is to provide one setting that makes the cell boundaries and 
linework visible (in Design mode), but to quickly preview the final output by 
switching to Layout mode where the non-drawing frame and cell linework is not 
visible. To make this switch, use the Frame Design/Layout Mode button.

When initially creating a frame, the Frame properties dialog allows control over 
the number of Columns and Rows.
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The Frame property dialog allows the dimensions (Columns and Rows) of a frame to be 
specified

The offset of a frame’s Margins, Lines and Borders is defined by properties 
specified in the frame’s Appearance tab. These are discussed for each frame 
type in the relevant sections. An example is shown below:

Appearance controls to view the Line Style and Cell properties

A background colour (other than the white default) can also be used in profiles 
and graphs by setting a Cell Colour and disabling the Transparent option.
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The offset of Margins and Lines from each other and their Border is defined by 
properties specified in a document’s Appearance property. These are discussed 
for each document type in the relevant sections. An example of the Property 
dialog is shown below:

Appearance controls to view the Grid Cell properties

Components

Encom Discover PA can create larger applications used for interpretation or final 
interpretative products. Usually such applications consist of individual 
components that have various available displays (eg profiles, maps, images etc). 
Components can be saved and re-used in Encom Discover PA. Components may 
consist of a single item (such as a graph, profile, logo or scalebar etc), or may be 
composed of combined objects such as title blocks with text, logos, grids, maps 
etc. By combining various components it is easy to create larger, more complex 
presentations that would, by themselves, take a much longer time to create.

Components are saved from the Save Component item found on most pop-up 
menus and the saved Component file has the file extension of .EGC. 

Components are restored from the Insert>Component menu item or the Insert 
Component button. When you want to insert a component, a selection dialog 
presents a preview of the available items.
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Component selection dialog for restoring a component

Browse, History, and Favourites

Buttons allow fast search and retrieval of frequently used components. These 
options operate similarly to the Windows Internet Explorer utility.

Once you select a component, position the drawing cursor on the active page to 
contain the component and drag a rectangle with the left mouse button pressed. 

Frame and Plot Axis Control

Plot objects are contained in the cell of a frame. Plot objects cannot be floated out 
of the frame in which they are contained although objects can be copied and 
pasted into other frames. Frames assume a critical role in the control of the plot 
objects they contain.

The Axes property page of the frame enables you to modify settings that are 
applied to the plot objects in the frame. 

1. You can specify that the range of axes is global to the frame. In this case 
the data range of the axes automatically fits all the data in all of the plot 
objects in the frame.
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2. You can specify that the data range be derived from the current clipped 
data range or from the entire unclipped data range. This is the Zoom 
Global option and is primarily used with profiles. As you pan or zoom data 
along a line, the axes fit to the range of the data displayed unless Zoom 
Global is set in which case the range is always derived from the entire 
line.

3. You can specify that axis annotations be global (when the axis range is 
global). This allows you to set annotation properties for all axes (of a 
particular type) in all plot objects in the frame in one place.

4. You can specify that the X and/or Y axes are scaled and specify the 
scaling factor.

5. You can make all plot objects in the frame isotropic. When set, Encom 
Discover PA automatically adjusts the data ranges on the axes to ensure 
that the plot objects are isotropic. For example, a map has this option set 
by default.

6. You can specify that Encom Discover PA should modify the data ranges to 
ensure that the plot objects all fully occupy the frame cells in which they 
are held (option Data zoom to fit grid cell). This option is usually combined 
with the isotropic setting. It can affect a scaled plot object and if not set, 
the plot object may be smaller or larger than the frame cell. When 
enabled, the plot object always fits the cell.

Every plot object contains an Axis property page that is exactly the same as the 
frame property page described above. If a setting is defined at the frame level 
then it is set and not editable at the plot object level. In other words, if a property 
is not controlled by the frame, it can be controlled on an individual basis by the 
plot objects in the frame. The properties set in the plot object are then applied to 
every axis in the plot object. For example, the Y range for all Y axes in a plot object 
can be controlled by setting the Range Global at the plot object level of the 
Workspace tree. This structured concept continues down the controlling 
Workspace Tree to individual axes where properties can be modified if they are 
not controlled by the plot object or by the frame.

Axes in a plot object have an ordered structure starting at X then Y, Z, Colour, 
Size. This means for example, that you can add a Y axis to an X axis, but you 
cannot add an X axis to a Y axis. This structure defines data domains in the plot 
object within which you can display data objects. When combined with the plot 
object and frame global options, Encom Discover PA provides a flexible data 
graphing capability that can display your data almost any way you want.
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Snap Operation

Encom Discover PA provides the ability of graphics objects to be snapped. This 
means that an invisible grid (of a definable size in millimetres) is present in a 
display and this can be used to move or resize objects (including Frames) so they 
align or overlay each other precisely.

The Snap control is turned on or off from the Document Properties dialog. The 
size of the snap movement is also specified.

Document properties and Snap Operations

Operation of Snap is best used when dragging or resizing a graphics object. 
Select the item graphically or from the Workspace tree and the object’s handles 
should appear. As you move the cursor to the edge of the surrounding border 
highlighted by the handles, the cursor changes to a move-style cursor. This can 
then be used to shift the object and snap can be used to align it accurately with 
other objects.

Moving an object and snapping
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Size Units

Throughout Encom Discover PA the properties of displayed objects are 
accessible. In many cases the position of these objects is made relative to a 
defined point (such as an anchor, a boundary or a margin). Where distances from 
that point are controllable, the units of distance may be:

Millimetres

Millimetres as used in a final, paper layout plot (not on-screen)

Page Points

A point is a printing measurement whereby 32 points equals one inch on printed 
paper. This unit applies to printed output. 

Screen Points

One pixel of screen resolution equals one screen point of distance. This distance 
format is used for on-screen presentation and retains plot size across computer 
monitors of different resolutions.

Percentage

If a measurement is made in percentages, it refers to the available distance being 
divided into units of 100 and the object is placed at the relative percentage 
location. For example a 50% distance positions the object at half the available 
distance.

File Drag-and-Drop

Files (of supported types) can be dragged and dropped from either the Explorer 
tab or Microsoft Explorer and displayed without having to create a display window 
for them. The process of dragging and dropping is to select individual or multiple 
suitable files, and with the left mouse button depressed, move the cursor to the 
display area of Encom Discover PA and release the left mouse button.

The following actions can be performed:

• Drag a suitable file and drop it into the open display area of Encom 
Discover PA. An appropriate window opens and displays the file contents.

• Drag a suitable file and drop it onto an existing, open window. If the 
window type can accommodate the dropped file, it displays it. For 
example, if an image grid were dropped into a 2D map already displaying 
say a raster image, the additional image would also be displayed.
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• If a dropped file can be displayed in either 2D or 3D, a message and 
choice is displayed.

• If multiple files suitable for display in a map are selected and dropped, a 
message is displayed providing a choice of the number and orientation of 
frames to display in the window.

Choice of 2D or 3D single or tiled map for multiple files dropped for display

• If a database is dragged and dropped, it is opened and available for 
access rather than displayed.

Example file types that can be dragged and dropped are as follows:

Type Action

.SHP Opened as a vector file object

.TAB Opened as a vector file object

.MIF Opened as a vector file object

.DXF Opened as a vector file object

.GSF Opened as a vector file object

.FDB Opened as a feature database

.EGA Opened as a feature database

.GDB Opened as a dataset

.EGB Opened as an Image object

.ERS Opened as a Surface object
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Line Navigation

Encom Discover PA is a data processing and display system that uses traverse 
lines as the basis for analysis and presentation. Data lines contained in an open 
database can be selected for display or processing in a variety of ways.

• Individual navigation tools, such as drop-down line lists are available from 
properties dialogs and the Line Iterator toolbar.

• The Line Iterator toolbar can be used to select lines specifically or 
sequentially.

• The Flight Path Map displays traverse lines that can be selected 
graphically. Profiling displays such as Profile Document windows or Decay 
Tools can use this selection procedure.

Line Iterator Tool

The Line Iterator is a floating toolbar that can be moved around the Encom 
Discover PA screen or docked with the main Encom Discover PA screen. If this 
toolbar is not visible select the Line Iterator option from the pop up menu that 
appears when the main toolbar area is clicked on with the right mouse button. 

The Line Iterator toolbar

.GRD Opened as a Surface object

.TAR Opened as a Surface object

.DEM Opened as a Surface object

.BMP Opened as a Picture object

.JPG Opened as a Picture object

.GIF Opened as a Picture object

.PNG Opened as a Picture object

.TIF Opened as a Picture object

.FLY Opened as a Fly-Through script file

Type Action
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The pull-down line list on the toolbar shows all lines compatible with the datasets 
in the current display. This may not be all lines in the database. In certain 
circumstances (such as for tie lines and traverse lines with approximately 
perpendicular direction azimuths), it is inappropriate to display these in the one 
graph, with the same base axis.

Line Selection list on the Line Iterator toolbar

Selecting a line moves all graphs to the selected line or with their appropriate 
line offset. Moving lines by clicking the buttons of the Line Iterator toolbar, moves 
all lines in the plot forward or back in the iterator line list.

The sense of a display for a profile of data can be reversed (flipped), by using 
the Reverse Line Direction button. The display reversal applies to all profiles 
contained within a document (even if contained in different frames).

The operation of the Line Iterator is controlled by the properties available from 
the Line Iterator Properties button which will display the Property dialog. This 
same dialog can also be accessed from the Tools>Options menu item using 
the View tab. 
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Line Iterator Properties dialog

Properties that can be adjusted from the Line Iterator Properties dialog are:

Line to Line Azimuth Range Tolerance (degrees)

Encom Discover PA displays profile data by projecting lines onto a common 
baseline. Encom Discover PA only displays lines that have an azimuth within +/- 
the azimuth tolerance of the baseline azimuth. For more information see Axis 
Properties. This variable determines whether two lines are azimuth compatible - 
defined as when the difference between the line bearings is less than twice the 
specified tolerance. The default tolerance is 5 degrees.

Always Optimise Projection Azimuth

Encom Discover PA adjusts the baseline azimuth for any group of lines selected 
so that it lies within the centre of the range of line azimuths. When enabled (the 
default), the azimuth of the lines are examined each time the data content in a 
frame changes and an optimal azimuth for the projected distance computation is 
calculated.

Iterator Type

The Line Iterator toolbar uses one of three modes – Standard, Spatial or 
Sequential for the ordering of survey lines.

• Standard - lists lines in the order they are stored in the database. 
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• Spatial - re-orders the line list spatially such that moving from one line to 
the next is spatially meaningful and according to line azimuth criteria 
described in Profile Horizontal Axis. Only valid lines (that is lines that meet 
the line azimuth criteria are displayed in the Spatial line list.

• Sequential – this mode iterates through lines similarly to the Standard line 
iterator except that it forces a movement to the next/previous line even 
when the line azimuth rules would normally prevent it. It can be used in 
more complicated survey line situations or in cases where multiple survey 
databases have overlapping flight path tracks.

Action – Change Line

• Accept invalid selection - When moving forward or back through the 
Line Iterator, the next lines may not meet the specified display criteria (e.g. 
a line exceeding the azimuth tolerance). This option allows the user to 
click on a flight path (or set the line through property pages) and change 
the line even when such action invalidates the azimuth compatibility rule. 
One or more graphs will usually be invalidated.

• Warn before modifying - If an invalid line combination is about to be 
displayed, a warning is displayed. It warns the user that a selection is 
invalid and allows the user to cancel the operation.

• Prevent pile up - If you iterate to the end of the available line list, no 
further iteration is allowed if this option is enabled. If not enabled, the 
Iterator moves the selection to the last available line.

• Maintain Line Spread - If a specific combination of multiple lines is 
chosen for a profile display, this combination is maintained, even if a flight 
map is used for line selection.

• Jump First Line - If this option is OFF, if the selected line is prior to the 
lines in the frame then the rear line in the frame is moved back to the new 
line. If the selected line is in advance of the lines in the frame, then the 
leading line in the frame is moved forward to the new line. When the 
selected line is within the frame line group then nothing happens. If this 
option is ON the rear line in the frame is always moved to the selected line

• Highlight all in flight path
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Action – Clone Graph

• Use Selected Line – When a new profile is created as a copy of an 
existing one, the same line is used if this option is enabled.

• Use Next Valid Line - When a new profile is created as a copy of an 
existing graph, the next line in the Line Iterator tool is used. When you 
clone a graph it can use either the line of the graph you are cloning or use 
the next line along. As you usually want the next line, it is the default. Note 
that it uses the next VALID line. This is the next line in the spatial order 
that is azimuth-compatible with the lines currently being displayed. It may 
not be the nearest line in the spatial order.

Action – Forward/Reverse Line Movement

• Move to Next Line Always - If enabled (the default), this option forces a 
move to the next line in the Iterator order. This option may invalidate the 
line selection. This option relaxes the Use Next Valid Line restriction. The 
option permits a move to the next valid combination of lines.

• Move to next valid line - The Line Iterator list only displays lines that are 
valid for the current baseline azimuth. This is the default.

• Show only Valid lines - Displays the list of only azimuth-valid lines. This 
setting is the usual default.

• Apply to entire workspace - Applies the Line Iterator selection to all 
available windows. This is not the default

If you can always move to the next line in the spatial order then you can iterate 
through an entire dataset. You can move between incompatible lines (eg flight 
and tie lines) at will. The spatial order preserved and rules followed, it will just 
allow you to move to a line that is incompatible with the current lines. 

If you can only move to the next valid line, you can never shift between tie and 
flight lines as they are incompatible. The only way to display a tie line is to 
manually change the line in the graph property page or interactively select the line 
from a flight map. When you iterate forward/back with Next Line Always the 
program moves one line at a time. With Next Valid Line it may jump many lines 
each move and searches for the next azimuth-compatible line. If you enable 
Show Only Valid Lines, the drop down list on the Iterator toolbar only displays 
the lines that are azimuth-compatible with the current line selection. Apply to 
Entire Workspace applies a Line Iterator movement to all views in the 
workspace.
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Using Wizards

Wizard with a choice of 2 or 3D map and example illustrations

Various operations within Encom Discover PA use wizards to simplify tasks that 
otherwise are complex to a user (for instance association of features to line 
databases). Other wizards are used for performing simple operations but for new 
users, such procedures may seem difficult (for example, displaying a 2 
dimensional map). Wizards can be initiated from the Wizard button or in other 
cases, within the menu items.

Wizards consist of a series of logical steps to arrive at the desired outcome. The 
various dialogs describe each step and contain explanatory text to make your 
choices simple. In many cases, you may need to make decisions about options 
but if you make a mistake, you can back up or advance by using the Back and 
Next buttons. If you wish to skip intermediate steps of a wizard, often you can 
proceed directly to the Finish button and thereby accept only the defaults 
specified by the wizard. Generally the defaults would be as you would have 
chosen anyway. If you decide not to use the wizard at all, select the Cancel 
button.

In the example below, some choices are provided, with examples of the option 
output.
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New Document Creation Wizard

Step 1: Task Description

The first screen is descriptive only and describes the task you are about to 
perform.

Step 2: Frame Type Selection

Choose which of three basic display types you want:

• Profile frame

• Map frame

• Graph frame

The New Document Creation wizard is a fast method of producing a range of 
different displays by responding to questions asked in a number of wizard 
screens. Before using the wizard, ensure that the databases and files you wish 
to use are available (see Accessing Data).

Initiate the wizard from the button on the Document toolbar. A series of screens 
are displayed, which will guide you through the options for displaying data. You 
can navigate backwards and forwards between screens using the Back and 
Next buttons.

When you have completed your selections, click the Finish button, and the 
program will then create the view.
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Step 3: Set Dimensionality

The next screen asks whether you want a 2- or 3-dimensional display. This will 
create either a map (2 dimensions, see Two-Dimensional Maps) or a display 
volume (3 dimensions, see Three-Dimensional Displays).

Note The term “frame” is used to describe the display container and it provides 
flexibility in being able to specify scale, resizing, editing and display control (see 
Profile Frame Properties).
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Step 4: Select Data Objects

The final wizard screen asks you to choose which data objects you want to 
display. Only available objects are presented. 

   

When you have selected the display objects, click the Finish button, and the 
wizard will create the display with the available data. In some cases (for example, 
requests for external files such as grid, vector or bitmaps), the wizard may ask you 
to select additional files.

To modify a display created by the wizard, you will need to use the normal editing 
and control functions available in Encom Discover PA.
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5 Display Formats
In this section:

• About Display Formats

• What Can Encom Discover PA Display?

• Display Types

• Creating a New Display

• Examples of Displays

About Display Formats

Encom Discover PA is an interactive software package for one (profiles), two 
(maps) and three dimensional display of geoscience data. Geophysical 
information that can be analysed includes single or multi-channel data acquired 
from airborne or ground surveys such as electro-magnetics (AEM), geochemistry, 
potential field (gravity or magnetic) data or a combination. Encom Discover PA 
accesses data from industry-standard databases which allows high speeds of 
data transfer and assists in the management of data. The speed and usage of 
database technologies make Encom Discover PA especially applicable for large 
datasets as are typically derived from airborne geophysical techniques.

Encom Discover PA serves many roles through its design. Its function is not 
purely to display geophysical data, but to provide interpretation links to other 
software packages (such as MapInfo Professional and ER Mapper) as well as 
maintaining a feature database for recording and documenting interpretation. 

Encom Discover PA acts as an interface to numerous processing algorithms. 
Depending on the geophysical technique being used, processing tools that are 
usually operated as batch processes are available. Encom Discover PA has also 
been designed to accommodate growth in processing algorithms and data types. 

The main design principles used in Encom Discover PA are to:

• Interface to other commercial software (for example, Geosoft’s Oasis 
montaj and DFA’s Intrepid) wherever possible. This interface provides 
direct data communication to and from supported databases.

• Ensure Encom Discover PA is operational on the most commonly 
available computing platforms. These environments include Windows XP, 
WIndows Vista, and WIndows 7 systems.
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• Divorce the data from the processing procedures such that Encom 
Discover PA can present all supported data types and interface to tailored 
processing algorithms.

What Can Encom Discover PA Display?

Available display formats provided within Encom Discover PA include:

• 2D and 3D curve profiles of line-based data

• Layered sections within profile tracks

• 2D and 3D graphs with any data channels used to specify the graph axes

• Flight and traverse path maps

• 2D and 3D images and raster presentations

• Scattergrams  

• Spreadsheets of data

• 3D representations of objects such as drillholes and volume models.
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Creating a New Display

Use the File>New menu or the corresponding toolbar tool to create a new display.

New display documents for all formats can be created by selecting the 
appropriate item, or documents can be created using a predefined format and 
layout via a template (see Templates) . 

The New menu item can also be used to display a Decay Curve or Database 
Spreadsheet.

Display Types

• Profiles

• Graphs

• Spreadsheets

• 2-Dimensional Maps

• Map Mosaics

• Points
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• 3-Dimensional Displays

• Drillholes

• Decay Curves

• Graphs and Scattergrams

• Vertical Log Graphs

• Stacked Profiles

• Voxels

• TrackMaps

• Combination Displays

Profiles

A primary tool used to examine data in Encom Discover PA is the profile. A profile 
is defined as the display of one or a number of data fields with a common 
horizontal distance axis. A document or window page displaying profiles may also 
include other display types such as maps, graphs and other objects to provide a 
direct comparison of data or for preparation to printing. An example of a combined 
document is shown below.

Two data lines with magnetics, elevation, EM data, inversion results, titling and flight map 
within a layout mode Profile Document
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All documents are created in a plot window:

• Multiple plot windows can be defined containing multiple display objects

• Each graphed area in a Profile document may contain multiple profiles

• The horizontal axis of a profile is scaled according to a distance channel 
called ProjectedDistance. This computed channel (based on the chord or 
straight line length and position of the relevant line(s)) allows direct 
comparison from one line to another.

• Although the ProjectedDistance channel is used for plotting and scaling 
the horizontal axis of profiles, other channels may be used to annotate the 
X-axis (such as easting, fiducial etc).

• Each profile may contain many Y-axes, where each Y-axis is used to 
control data fields with their own units or physical properties. For example, 
XChannel and ZChannel could be on one Y-axis, Diurnal and Residual 
Magnetics in a second Y-axis etc.

• Each Y-axis may contain many channels or data bands. A band is the 
lowest hierarchy component of a profile. For example, one band may 
display Magnetics, another may display multiple channels such as in EM 
data. Each band may have its own independent attributes of colour and 
style.

• The data fields used to display profiles in a document may not be derived 
from the same database but must be common to the one line if separate 
fields for one line are to be combined.

A new profile is added below the bottom profile in an active plot window but it can 
be moved, cut or pasted. All profiles automatically re-size when you add a new 
profile, or when you change the aspect ratio of the profile window. The relative 
size of a profile in a document window can be controlled but its horizontal scaling. 
X-axis plotting is controlled by a computed distance channel called 
ProjectedDistance.

For more information, see Profiles.
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Graphs

The Graph object is essentially identical to a Profile except the horizontal, scaling 
axis is defined. A Graph uses horizontal scaling you define according to a data 
field and does not use the ProjectedDistance or chord length channel as used in 
a Profile horizontal axis. All other channel or line combinations, as described in 
Profiles apply to Graphs.

For more information, see Graphs.

Spreadsheets

To provide a numerical display of the content of a database, Encom Discover PA 
provides a data spreadsheet facility. The spreadsheet can present the numeric 
contents of a database, statistics or data ranges. Other functionality includes the 
ability to export the database content or subset.

Databases accessed by Encom Discover PA typically contain flight information, 
lines and various data channels of sensor information. This display format is 
useful for quickly examining statistics of a database or contained data fields.

A spreadsheet with flight, line and channel information available

For more information, see Spreadsheets..
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2-Dimensional Maps

A 2D Map is used to contain flight path maps, images, contours and other two 
dimensional displays. Encom Discover PA can use most industry-standard grid 
formats (including but not limted to ER Mapper, Geosoft, Geopak, Vertical 
Mapper, Surfer, ASEG GXF, Landmark and USGS).

A Map with annotated flight lines, image, contours and annotations

For more information, see Two-Dimensional Maps.

Map Mosaics

It is possible to create a series of map displays whereby each map is 
geographically linked to the others when contained within a single Map Frame.  

The map mosaic can be created from a single 2D Map display and choosing the 
Clone>Graph option from the pop-up menu displayed when the Map branch of 
the Workspace Tree is selected with the right mouse button.  Alternatively the 
map mosaic can be created by selecting multiple surface files in Windows 
Explorer and using the Drag-and-Drop facility available in Encom Discover PA. 
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A map mosaic representing multiple data files loaded into Encom Discover PA using the 
“drag and drop” facility

Points

Encom Discover PA can display data points that have easting and northing 
locations specified. The data can be accessed from a Geosoft montajTM or a 
MapInfo Professional .TAB data file. Often the individual data points may be 
clustered into lines but this is not mandatory. Encom Discover PA can use its line 
support capability (such as the Line Iterator) to navigate point datasets, but if each 
data record represents a single point, this can be displayed quite satisfactorily.
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Example point display with size modulated points

For more inforamtion, see Displaying Points.

3-Dimensional Displays

Maps, graphs, flight paths and other display objects can be presented both in two 
and three dimensions. Complex displays and data with elevation or depth 
information can be viewed more clearly in three dimensions. Views can be 
zoomed, panned and even fly-through is available for impressive visual display of 
data.

Layered sections of Conductivity Images derived from EM Flow software
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Three dimensional displays are effective in the display of surface grids as well as 
display objects requiring 3D volumes (such as drillholes, voxel and 3D .DXF 
vector files). Many combinations of surfaces can be displayed such that:

• Single or multiple surfaces can be displayed one above the other

• Where one surface overlaps another (or other data), a transparency can 
be applied to allow the lower surface to be viewed through the obscuring 
surface

• The colour rendering of a surface can be supplied by one grid onto a 
second shown as the viewed elevation. For example, a radiometric grid 
could be displayed but coloured by magnetics to note any detection 
correlation.

• One surface (such as topography) can have another (such as an air 
photograph or satellite image) overlaid to provide a topographic relief 
presentation.

Aerial photograph draped over a topographic grid surface

For more information, see Three-Dimensional Displays.
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Drillholes

Encom Discover PA can import and display drillhole locations and downhole data 
in a variety of formats. The displays can be coupled with three dimensional 
bitmaps to indicate geological sections or derived sections from depth-
conductivity analysis. Three dimensional navigation with interactive zooming, 
roaming and fly-through capability make volume and 3D visualisation simple.

Display of multiple drillholes in a 3D display with assay and geological section information

For more information, see Drillholes.

Decay Curves

Encom Discover PA contains an interactive display tool for the presentation and 
analysis of multi-banded data. Typical use of the Decay Tool is with time domain 
EM geophysical data. The Decay Tool is enabled from the File>New>Decay 
Curve  or the Decay Curve button on the Decay Curve toolbar.
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Decay tool with an interactive profile for updating the decay plot

For additional information, see EM Decay Curves.

Graphs and Scattergrams

For displaying the relationship of one data field with another, Scattergrams and 
Graphs can be used. This display format is useful in comparisons of data such as 
radiometric analysis (Total Count to say Potassium) or for elevation versus raw 
magnetic data. The plot can use symbols to indicate the population distribution, 
lines or both. The Scattergram and Graph displays are similar in that they provide 
individual data field control of both the vertical (Y) and horizontal (X) axes. The 
Scattergram by default presents data as symbols while the Graph display uses 
lines to join the data values at their required location.

An example of a Scattergram
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For more information, see Graphs and Scattergrams.

Vertical Log Graphs

In some instances (such as downhole logs), it is advantageous to rotate the 
standard, horizontally-oriented graph such that axes and cursor movement are 
oriented vertically. The Vertical Graph operates exactly like its horizontal 
equivalent where individual data field control of both the vertical (Y) and horizontal 
(X) axes is available.

When created, these objects have the standard zoom, pan and cursor movement 
vertically oriented to allow data analysis up and down. An example of this format 
is shown with drillhole EM data below: 

 
An example of a Vertical Graph document

For more information, see Vertical Graphs.
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Stacked Profiles

A Stacked Profile display produces a 2D vector file (.DXF or .GSF file format) 
representing a plan view of survey lines from a database with amplitude 
representing a field within the database.

Example stacked profile map

For more information, see Stacked Profiles.

Voxels

The following functions are provided for displaying Voxel Models:

• Import and interpret three-dimensional model structures as created by 
research projects managed by UBC (University of British Columbia) and 
CEMI (Consortium of Electromagnetic Modelling and Inversion – 
University of Utah). Other 3D objects such as Gemcom .BT2, DataMine 
and Surpac are also supported.

• Display three-dimensional model volumes as voxel (cell-based) entities 
that can be visualised interactively and combined with other 3D object 
types (surfaces, drillholes, vector files and other models)

• Allow real-time interactive voxel display control through look-up table 
manipulation, visual navigation and slice or block presentation
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• A range of display formats including row, column or cell slicing, multiple 
slicing (to create a chair view), attribute thresholding and wireframing

• Creation of isosurfaces whereby model attributes of similar value are 
three-dimensionally displayed as a surface

• Specific look-up tables can be created to simulate lithological analogies 
and so present voxels of a colour that matches a particular property range.

• Multiple voxel models can be added for display with independent attribute 
controls to compare property distributions. For example, magnetics 
models could be displayed at the same time as gravity inversion model 
results.

Various display formats of the Voxel Modeller

For more information, see Voxel Models and Voxel Utilities.
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TrackMaps

TrackMap displays can be used as shown in the example below:

TrackMap example showing the flight path location over a scanned image and over a map 
of the magnetic response

A TrackMap display has the following functionality:

• The traverse of a selected profile (shown in the top two tracks) can be 
configured to show in the bottom two tracks

• Tracks can have different background images

• The track can be combined with other profiles or sections. The TrackMap 
track has all the display attributes of a normal profile. It can be sized 
vertically and scaled horizontally for hard copy purposes

• The background displayed in a TrackMap uses an RGB raster image file 
(such as ER Mapper)

• TrackMap track display is isotropically displayed. That is, the vertical and 
horizontal scaling is identical such that no distortion to the image is 
introduced.
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• The orientation of the traverses of a TrackMap are irrelevant. The 
TrackMap module automatically re-samples the background image as 
required to position the traverse and display the image. If the image or 
traverse are rotated, the program extracts and rotates only the required 
swath of image necessary to display the selected track.

• Positioning a cursor in a track indicates the location of the point in 
adjacent tracks (including the TrackMap tracks) plus any linked maps

• Data zooming of any of the profiles causes all tracks to zoom and pan or 
smooth scroll

For more information, see TrackMaps.

Combination Displays

Display formats that combine the various presentation objects of Encom Discover 
PA are powerful and useful for data interpretation applications. Some examples 
of these are shown below where combinations of maps, profiles, axes etc are 
placed into a document. The use of templates and components make these types 
of complex presentations simple to create (refer to Templates and Components 
supplied as a separate document with Encom Discover PA).

Examples of complex displays are included below. In each case the required 
templates or components to create displays of this type are supplied with your 
installation of Encom Discover PA.

Combined image maps (including satellite imagery) with profile data and complete 
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annotation

   
Variation of the display above with different components added

Profiles with EM data, section and maps for location of the data line



5 Display Formats 113

Multiple images of different resistivity slice images plus a profile and 3D section display

Drillhole log plots with 3 dimensional surface location view and map
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Drillhole log plot woth locations, terrain, magnetics and scattergram of assay results

For more information, see Page Layouts.

Examples of Displays

Encom Discover PA is capable of displaying complex data presentations that are 
tailored to your requirements. In this section are examples of many of the display 
format types PLUS descriptions of how the display was created. Combination 
plots (for example, profiles plus layers etc) are not described in this section. Such 
combined plots are merely copied and pasted from other documents. This 
flexibility to combine different displays together is a powerful asset of Encom 
Discover PA. For all examples, the associated Workspace tree is provided to 
assist in reproducing the results shown.

• Example: Two Separate Profile Tracks

• Example: Two Profiles from the Same Track

• Example: Filling Profile Areas

• Example: Highlighting Major Channels

• Example: Modulated Data Tracks

• Example: Multiple Fixed Scaling Profiles

• Example: Adding a Depth Section to a Profile
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• Example: Flight and Image Maps

• Example: Graph and Scattergram Presentations

• Example: 3D Grid Surface with Flight Path

• Example: 3D Grid Surface with Image Drape

• Example: 3D Grid Surface with Contours Overlain

• Example: Flight Path over a Grid Surface

• Example: Adding 3D Axes to a Display

• Example: Displaying 3D Located Images

• Example: Use of Transparency

• Example: Colouring a Surface with Another Surface

• Example: Texture Mapping

• Example: Multiple Surfaces

• Example: Merged Texture Surfaces
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Example: Two Separate Profile Tracks

This example has two tracks of different data fields created from a time domain 
EM database. The top track contains magnetics data while the bottom track is 
derived from EM multi-band data. Each EM data band has been presented with 
different colours.

A profile display consisting of two individual curve profiles, FMag and EM.

Using a new Curve Profile display (accessed from the File>New>Profile>Curve 
Profile menu item) view the Profile Properties dialog by double left mouse 
clicking on the Profile 1 branch of the Workspace Tree. View the Data tab dialog 
and choose the first line of the Swamp_MagEM database. Click the Apply button 
to update the display. Then View the Fields tab dialog of the same Profile 
Properties and choose the FMag field from the drop-down list available. Display 
the properties dialog from the Curve branch and in the Line Style tab dialog turn 
off Modulate Line Colour and edit the Default Line Style. The upper track should 
now be completed.

The next step is to highlight the Profile 1 branch, and Copy it using the pop-up 
menu from a right mouse click. Select the Profile Frame branch and again use a 
right click to Paste the copied track. A second track now displays beneath the first. 

View the Profile Properties dialog for the 2nd profile and select the Fields tab 
dialog field to nominate the EM field. To select individual bands of this multi-
channel field select the Y-Bands button to the right of this field drop-down list and 
select/deselect the appropriate bands.To make the EM data channels have 
different colours, select the Line Style tab from the Curve option and enable Cycle 
unique colours. Symbols can also be enabled from the Symbols tab if desired. 
Different scaling (Logarithmic) can be controlled from the Profile branch 
properties dialog in the Y Scale tab. 
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Example: Two Profiles from the Same Track

Comparison of two or more data fields can be done within one data track. Usually 
the data ranges and sampling interval of the various data fields are not 
compatible. Following is an example of data fields with different data ranges. In 
this case, diurnal data is approximately 400 nT greater than the final and raw 
magnetic profiles. In addition, the altimeter data ranges from 110 to 130 metres. 

Magnetics comparative data (final, raw and diurnal)

Display a new Curve Profile and in the Profile Properties dialog ensure that the 
Swamp_MagEM database is chosen in the Data tab and then choose the Fields 
tab to nominate the FMag field from the drop-down list available. In the Curve 
branch Properties dialog deselect the Modulate Line Colour option and choose 
any colour from the Default Line Style button.  Repeat this operation for the Colour 
branch but deselect the Band 1 entry. The upper track should now be completed 
and can be displayed in whatever colour or symbol pattern is required. 
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Example 2 - Multiple Profiles in a Single Track

Since the second profile is to be added to the same graph (but with a new Y Axis), 
select the Profile 1 branch of the workspace tree and display the pop-up menu. 
Choose the Add Axis Scale>Y Scale option. This adds a new Y Scale branch to 
the Profile. The next step is to add a Curve branch to the Y Scale. This can be 
done with a cut and paste operation from the existing Curve branch. Alternatively, 
select the Y Scale from the pop-up menu and choose Add>Curve or press the 
Add Curve button on the Data Objects toolbar. The new curve can then be re-
configured from the available data fields. This time add the Diurnal field. Some 
adjustment to the Y Scale properties may be required to position the axes. Axis 
scales can be changed manually from the Y Scale tab of the Y Scale branch using 
the Fix Y Range option.
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Since the second profile is to be added to the same graph (but with a new Y Axis), 
select the Profile 1 branch of the workspace tree and display the pop-up menu. 
Choose the Add Axis Scale>Y Scale option. This adds a new Y Scale branch to 
the Profile. The next step is to add a Curve branch to the Y Scale. This can be 
done with a cut and paste operation from the existing Curve branch. Alternatively, 
select the Y Scale from the pop-up menu and choose Add>Curve or press the 
Add Curve button on the Data Objects toolbar. The new curve can then be re-
configured from the available data fields. This time add the Diurnal field. Some 
adjustment to the Y Scale properties may be required to position the axes. Axis 
scales can be changed manually from the Y Scale tab of the Y Scale branch using 
the Fix Y Range option. 
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Example: Filling Profile Areas

Particular line styles can be used to enhance the appearance of profile 
presentations. To fill above or below in a profile can highlight certain trends or 
anomalies in data. Below is an example of a colour-filled profile.

Example of colour-filled profile

The fill properties are controlled by the Line Style tab of the Curve branch 
properties dialog. This dialog enables filling from a specified level determined by 
a variety of means (average, mode, median, minima etc). The dialog permits 
colour filling both above and below the profile trace with different colours.

Curve properties dialog to fill above and below a defined level

In one profile, the fill above is set to a colour of red, while the second has filled 
below with a green fill colour.
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Example: Highlighting Major Channels

Particular line styles can be used to enhance the appearance of profile 
presentations.

A second example presents multi-banded data where major and minor data 
traces have different styles. The Line Style tab of the Curve branch properties 
dialog is used to control this style.

Use of the Line Style tab to control major and minor data traces

The Apply Major Interval Style option controls the cycle interval. Minor traces 
assume the default line style, while the Major Line Style control is the major trace 
style.

This form of control is often used in time domain EM geophysical survey data 
displays.

Example: Modulated Data Tracks

Individual data tracks of a profile can be altered in their appearance by colour, 
symbol size, symbol rotation. This process is called modulation. 

An example of symbol modulation of the Diurnal data is shown in the following 
example. In this example, the line trace has been turned off and the arrow symbol 
is modulated by rotation, length and colour.

Symbol attributes such as colour and size are controlled by data fields. The 
symbol controls are activated by selecting the Show Symbols option in the 
Symbols dialog tab of the Curve branch properties dialog.
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Many applications can make use of modulation. Examples include geochemical 
data presentations, amplitudes of geophysical data, relative rotational information 
such as EM components or drillhole information.

Modulation of the diurnal data for colour, size and rotation

Scaling of symbol sizes, colour ranges, units and increments of rotation etc can 
all be controlled from the properties dialogs. The Workspace tree for the 
modulated trace is shown below:

The modulation controls (that is, data fields that are used to change the 
appearance of another data set) are specified as data fields (in this case, all 
modulation is by the Final Magnetics data (MAG)). 

Modulation of the appearance of symbols is achieved by assigning data fields to 
the Colour, Size, Angle or Label branch of the Workspace tree. Initially these 
branches (except Colour) are not visible. They become visible when the Show 
Symbols item in the Symbols tab of the Curve properties dialog is enabled.
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Profiles may have Depth Sections associated with them. Sections contain layers 
derived from external processing results. Data is supplied either by defining layer 
depth tops and bottoms OR by point depths with associated physical properties 
such as conductivities (to produce CDIs (Conductivity Depth Images)) or 
magnetic susceptibility sections etc.

Many applications can make use of modulation. Geochemical presentations, 
amplitudes of geophysical data, relative rotational information such as EM 
components or downhole information.

Example: Multiple Fixed Scaling Profiles

The majority of geophysical data is collected along lines and quickly converted to 
grids for subsequent image analysis. Subtle targets may go undetected when we 
rely on imagery alone. Profile analysis allows an interpreter to derive additional 
information that cannot be resolved in images. Examples include simultaneous 
visualisation of more than 3 channels of data, subtle shape information in curves, 
comparison of unrelated data types, and fine detail that may be lost during 
gridding. Until the arrival of Encom Discover PA, the detailed analysis of profile 
data from large surveys was slow and image analysis provided the only practical 
method for analyzing large quantities of survey data. 

A frequently used and powerful technique for examining complex interactions of 
data within large surveys is to display adjacent tracks with combinations of 
displays and then sequentially cycle through the survey, noting features as you 
progress. An example of this form of sequential line presentation is shown below.

Important in the display style shown is the fixing of vertical scales. This means 
that amplitudes of tracks can be related between traverse lines in absolute terms. 
This feature is controlled by the Fix Y Range option of the Y Scale tab of the 
Profile branch property dialog. Other relevant features are the dismissing of X 
axis labels, annotation and expansion of the profile height to fill the available track 
space. This track height effect is controlled by disabling the X Axis title and 
division labelling plus reducing the size of the Outer and Inner Margin sizes in the 
Appearance tab of each Profile branch.



124 Encom Discover PA User Guide

Example of multiple profiles presented sequentially to highlight uranium features

Example: Adding a Depth Section to a Profile

Some external processing procedures allow for data channels to be available that 
have a depth associated with a property (such as magnetic susceptibility, 
conductivity, or a solution result (from an inversion process). Encom Discover PA 
permits such data to be presented as a section. A section can be imagined as a 
slice of earth directly beneath a particular survey line.

Profiles may therefore have Depth Sections associated with them. Data is 
supplied either by defining layer depth tops and bottoms OR by point depths with 
associated physical properties such as conductivities (to produce CDIs 
(Conductivity Depth Images)) or magnetic susceptibility sections etc.

Depth and property data can be provided in two ways:

• Physical properties that are defined at discrete depth values. An example 
of this would be conductivity depth images derived from EM Flow.

• Layers with constant properties. In this case, layers require a top and a 
bottom boundary and the material between is assigned the physical 
property. Layer inversion programs such as AIRBEO produces data 
output in this form.



5 Display Formats 125

The example below represents an EM array data profile over a CDI (Conductivity 
Depth Image) and illustrates the example of conductivity properties defined at 
discrete depths.

Two profiles with sections derived from two different external processing modules

To create a section in a new profile frame, select the Add Section button on the 
Data Objects toolbar or alternatively select the Profile button on the Documents 
toolbar and select the Section option. To add a section to an already created 
profile frame, click the right mouse button on the Profile Frame branch and 
choose Add>Section Profile. This action appends a Section Profile to the Profile 
Frame in addition to the original Curve Profile. 

Profiles can be created in the normal way (see Example: Two Separate Profile 
Tracks). A number of methods can be used to include layer results. The layer data 
must be contained in the source database as:

The Workspace tree indicates the Section sub-branch beneath the Profile. 
Associated with the Profile are Axis branches and these operate identically to 
those of a normal profile or graph axes.

Tops Multi-band for Layers 1, 2 and 3

Bottoms Multi-band for Layers 1, 2 and 3

Property Multi-band for Layers 1, 2 and 3
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The Section branch and the data definition sub-branches beneath it control the 
source fields of the Top, Bottom and Colour attribute that is assigned to the layers 
for each reading and their physical properties to be displayed. Usually this is 
colour modulated. You can assign each of the required data fields for each of 
these layer requirements to display the section.

Assign the Depth field (as shown in the dialog below) to a multi-banded 
incrementing depth field and a multi-banded field for the property (such as 
resistivity or conductivity) to the Colour Field. 

Note Two Section layer construction types are supported. These using either a Depth 
field or Upper/Lower Field data structures. See Section Structure and Layers for 
additional information. 
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Section Properties for a database that uses a Depth and Property field classification.

Section Properties for a database that uses a Upper and Lower and Property field 
classification.

If topography is to be placed along the top surface, this can be done by allocating 
a data field to the Offset branch. The effect of this is to move all the top and bottom 
data values for each reading up and down as defined by the amount of individual 
reading values within the specified Offset data field.

When displaying sections, each layer of each reading of the sections is separately 
drawn. These displays therefore are graphically intensive to draw and can be 
slow. Faster drawing methods can be used to create sections. These include:
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• Using the Located Image facility of the Batch Printing Wizard that creates 
a located image of each section which can then be used in profiles or 3D 
displays (see Adding Located Images).

• Gridding the section so that standard grid formats can be used to display 
the section. These formats offer the advantage of allowing shading and 
contouring of layered sections. See Adding Section Grids.

Profiles can also have Section Grids added. These items are created as grids 
(using a Section Grid utility from the Gridding menu) and can be used instead of 
layer sections (CDIs). Section Grids have advantages over Sections in that they 
are faster to display, plus they can have real-time shading and labelled 
contouring. 

IP pseudo-sections can be displayed using Geosoft IP databases as input to 
gridding. The displayed sections retain the usual pseudosection style and can be 
used for resistivity, chargeability and metal factor plots in conjunction with other 
conventional data stored in the databases. Section Grids can also be used in 3D 
maps.

Like section profiles to display Section Grids in 3D displays they must first be converted to 
located images..
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Example: Flight and Image Maps

Flight path and image maps are a valuable method of displaying data. The flight 
path map also has significant additional value in being used to navigate through 
a dataset with direct links to displayed profiles.

An example of a flight path map with a pseudocolour image of magnetics

Review the Display an Image Map item to review the controls of images with 
instructions for inserting and specifying images.

Initially, a Flight Path map is created. This is best done from the 2D Flight Path 
Map pull-down button or from the File>New>Map>2D Flight Path Map menu 
item. Initially a flight path traverse map is displayed as derived from the initially 
accessed database. You can control the database to use from the Dataset tab of 
the Map properties or the Flight Path tab from the properties of the Flight Path 
branch. Configuring of the map can be done from the properties of the Flight 
Path branch of the Workspace tree. 

To add an image to the map, highlight the Map branch of the tree and click the 
right mouse button. Select the Add Data>Grid menu item. A new Grids branch 
is added to the tree. From the properties of the Grid Group branch, you can 
specify Pseudocolour, RGB or contour layers and then add image layers from 
multiple grids or from individual bands within multi-band grid datasets. Even 
image enhancements derived from ER Mapper are supported and can be used 
by Encom Discover PA as ER Mapper algorithms.
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Example: Graph and Scattergram Presentations

Graph documents are similar to profiles except the horizontal axis has additional 
control to allow data fields with no spatial (distance) properties to be used. 
Examples of graph use could be for the plotting of airborne data profiles using 
time or fiducial as the horizontal axis. Another advantage of the graph style of 
display is the ease with which you can display multiple curves in a single track 
with each curve having different vertical scales.

An example of a Scattergram document

This form of display can be done in the profile document but it is not as easy due 
to the inherent spatial dependency of the horizontal axis. The Workspace tree for 
the display above is shown below.
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Workspace Tree of a 2D Graph with multiple Y axis scales applied

Some re-scaling of the Y-Scale levels may be required to apply any offset or 
positioning of the second track. This is from the Y Scale tab of the properties.

Example: 3D Grid Surface with Flight Path

The initial graph is created from the pull-down button (and choosing the 2D 
Graph option) or the File>New>Graph>2D Graph menu item. Initially a blank 
display is presented but the tree has field definition levels for both X and Y axes. 
You can individually specify these as desired using the Field selection tab dialog.

Once a single curve is created in the document, a second can be added from the 
pop-up menu (from the Graph branch) and selecting the Add Axis Scale>Y 
Scale option. With a new Y scale, create a new Curve by selecting the new Y 
Scale, display the pop-up menu and choose the Add Data>Curve option. The X 
and Y data fields for the second curve can then be specified to be different from 
the first curve.

To display an image surface with a flight path above it, select the 
File>New>Map>3D Grid Map or select the pull-down button and choose the 
3D Grid Map option. From the Grid properties dialog a grid surface is specified 
and displayed. The vertical exaggeration (scaling) and offset of the surface can 
be applied if required from the Surface tab dialog of the Grid Properties dialog.
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Grid properties dialog for 3D surface showing the Scaling and Compression parameters.

Typically, there needs to be some adjustment between the vertical scaling and 
offset of surfaces to best suit other surfaces or flight paths etc.

The resultant display appears as below. Note that navigation of the three 
dimensional view is described in 3D Navigation. 

To add a flight path to the image, select the Map Frame and click the right button 
to display the pop up menu. Choose the Add Data>Flight Path. The resultant 
Workspace tree appears as:
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Three dimensional surface with flight path of airborne survey superimposed

Example: 3D Grid Surface with Image Drape

Combinations of two image surfaces can be used with one image creating the 
colour surface while a second is used for the elevation. In the case shown below, 
a Red:Green;Blue scanned image (Topo) is used to present the image surface 
and a second (magnetics) grid is used to apply the elevation effect. The entire 
display is derived from a single 3D Map layer in the Workspace tree created from 
the File>New>Map>3D Grid Map or select the pull-down button and choose 
the 3D Grid Map option. When this is done the Workspace tree appears as 
shown.

In the Grid Properties dialog, the Grid Group tree should show a 3D Surface of a 
grid (e.g. DTM or magnetics) with a Red:Green:Blue surface located on top of 
this showing another image file (e.g. Surface Geology or Topography).
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In the example three dimensional display below the Surface branch of the tree 
uses the magnetics grid for elevation of the image while the Red:Green:Blue 
references the scanned Topography image to render the coloured surface.

Two image surfaces, one used to control elevation and one the colour surface

Example: 3D Grid Surface with Contours Overlain

Contours (as vectors) can be added to a surface but a method must be used to 
do this that is not initially obvious. When a surface has any other entity above it, 
it reverts to a texture mapped surface. When texture mapped, it has no colour 
property and so when contours are added to a surface, initially the surface 
displays as grey. To make the surface coloured, a Pseudocolour must also be 
added.
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To display contours on a surface:

1. Create a 3D map and nominate a surface image (either Pseudocolour, 
RGB or Located Bitmap Surface). See previous example.

2. Duplicate the Surface twice and make the middle layer Pseudocolour and 
the top layer a Vector-Contour. This is done by using the Duplicate button 
and then clicking right on the Surface branch to alter it to Pseudocolour 
and Contours.

The Grid Group tree should now appear as shown below:

3. Ensure each layer is accessing the image required by pathing to the 
relevant grid.

4. Scale or vertically apply exaggeration as required:

Contours displayed over coloured surface
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Example: Flight Path over a Grid Surface

Frequently for quality control of a magnetic or geophysical survey it is useful to 
visualise the aircraft track over a surface such as a digital terrain model or grid of 
the recorded sensor (magnetic) surface. It is a simple matter of creating a Curve 
Profile display above a surface to illustrate this form of display.

To create a flight path over a grid:

1. Create a 3D map and nominate a surface image. See examples above.

2. Select the 3D Map branch of the tree and click right to display the pop-up 
menu. Choose the Add Data item and Lines. From the Fields tab 
nominate a data channel to provide vertical offset of the display trace.

3. Select the Line Style tab and control the method of colour modulation or 
the colour itself. Initially only the first data line is displayed with the image 
surface. You may need to adjust the vertical offset between the surface 
and the lines. This is done from the Fields tab of the Lines property dialog 
and setting an Offset entry.

4. With the setting of a single line specified, you can then select the Lines 
tab and specify which lines are to be displayed with the surface.

An example of a ground clearance colour modulated flight (Line Series) over part of a 
topographical surface
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Example: Adding 3D Axes to a Display

Three dimensional displays are powerful tools in assisting the understanding of 
the positions of such things as drillholes, sections, geological features etc but they 
require a clear understanding of their location both in easting/northing and depth. 
Encom Discover PA allows you to add axis annotation in 3D displays to locate 
such features.

3D Internal Axes

To determine the location of features in a 3D display, add axes. With the 3D Map 
item highlighted in the Workspace tree, click the right mouse to display the pop-
up menu and select Add Axis>3D Axis. With this done, the primary axes (East 
– X, North –Y and Depth – Z) are drawn into the display. 
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A 3D grid surface display with Internal 3D axis and associated Workspace Tree and Axis 
Properties dialog.

The 3D Axis dialog can be displayed from the properties of the tree level. This 
dialog allows you to control all aspects of the displayed axes. You have control 
for:

• Axis location (Left/Right/Centre), (Top/Back/Centre) or (Top/Bottom/
Centre)

• Axis labelling, font and frequency
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• Axis line and increment style (major and minor linework)

• Axis origins (as related to axis locations).

Bounding Box

In a standard 3D display, you can add a bounding box from the Appearance Tab 
of the 3D Map branch of the Workspace tree. Enable the Bounding Box check 
Show 3D Bound Box in the Appearance tab. The colour, line style and other 
attributes of the display can also be defined.

Bounding Box enabled in a 3D display

Example: Displaying 3D Located Images

If a bitmap is to be used in a three dimensional display, the bitmap is required to 
be accompanied by an Encom Georeferenced Image file (EGB). This file defines 
the image source file by name, its type and its corner locations. 

Externally created images of seismic sections, IP sections, geological 
interpretations etc can be located and placed within a 3D display. 

In this example, a magnetic surface is viewed with a series of parallel geological 
interpretation sections. These sections have been derived from drillhole 
interpretation in a GIS package. As for all the 3D views the display can be 
manipulated and moved to see the view from the best location. You can fly-
through the surface and sections and obtain a perception of the relationship 
between the geology and geophysics readily.
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Located images can be displayed within a 3D view by using the Located Image 
data option in the Workspace tree. Located images are positioned by using an 
ancilliary file called an .EGB file.

Creating a 3D Located Image Display

To create 3D displays with bitmaps it is initially required they be created within a 
map. Either a 2D or 3D image or flight path map display can be used. In this 
example a 3D Flight Path Map display is described.

To create a 3D located image display:

1. Create a 3D Flight Path Map or 3D Grid Map using the 
File>New>Map>3D Grid Map or 3D Flight Path Map menu option (or 
from the appropriate pull-down buttons).

2. With a Map created, select the Map branch of the Workspace tree and 
click the right mouse button. From the Add Data menu item, select Grids. 
Specify a raster surface and then manipulate the surface as required with 
suitable vertical exaggeration and offset. Note that the data values of the 
displayed grid determine the vertical position of your display and this is 
important when displaying located images with a different vertical position.

For example, if you wish to display a magnetic grid (with average data 
values of say, 55,000nT) combined with geological sections (with vertical 
reference of say 1-200 metres) as shown above, then an offset is required 
to bring the two data objects into a similar vertical reference frame. 
Typically therefore, you would need to reduce the vertical location of the 
magnetic grid down by about 55,000. The steps following describe this 
procedure.

3. You will have needed to prepare the necessary images before display and 
these require associated EGB descriptor files (see Appendix B: Data File 
Specifications).

4. Select the 3D Map branch of the Workspace tree and click right. Select 
the Add Data>Located Image option. An Images branch will be added to 
the tree associated with the 3D Map.

5. Display the properties dialog of the Located Images branch. Initially 
specify the path and EGB file. You can use the Browse button to navigate 
to the required EGB file.
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Located Bitmap properties dialog to specify the EGB file and display options

6. If the displayed map surface and bitmap are widely separated, their 
vertical offset may require adjustment. This can be done either by editing 
the vertical location in the EGB file (to offset the located image), or by 
interactively setting an offset amount in the surface display control. To do 
this, display the Grid Group properties dialog and highlight the Surface 
branch of the Grid Group tree. At the base of the dialog are controls to 
scale and offset the grid surface. Set this to an appropriate value by using 
the slider and increment entries.

Multiple bitmaps displayed with a 3D magnetic surface
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Example: Use of Transparency

Transparency is useful for 3D surfaces as it allows one layer to be seen through 
to view detail from a lower surface while still seeing information from the upper 
surface.

The Transparency control is located on the main Surface level of each Plot in the 
image tree. The control progressively reveals surfaces underlying a top surface.

Transparent magnetics grid over elevation grid

Note that each surface can be individually scaled vertically and offset, but also, 
from the Map level of the Workspace tree, the Z Axis tab can be used to impose 
a vertical exaggeration over each surface equally.
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Example: Colouring a Surface with Another Surface

The colouring used for a surface need not come from the surface itself but from 
other surfaces. For example, if the effects of topography were to be investigated 
on magnetic response, the magnetic grid could be displayed (as the Depth layer) 
with the colour layer specified from the topography image.

Magnetics surface with colouring derived from topography

This style of display is especially appropriate for air photography or satellite 
imagery where elevation data is available. An example of this is shown below:

3D aerial photograph draped over a topographic surface
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Example: Texture Mapping

Note that displays of the type above use texture mapping. Any surfaces above a 
depth surface (in the Grid Properties dialog) are rendered as texture onto the 
depth surface. Importantly, the stack of texture mappings is capped when it hits 
another depth surface. 

As an example, in a case with two depth surfaces, both mapped and offset, the 
bottom is a magnetics surface with the top having contours draped by texture 
mapping onto an EM image of the same area. The image properties dialog 
appears below:

Grids Properties dialog with two 3D surfaces and 2 draped pseudocolour surfaces plus 
contours.

The resulting image shows the two surfaces with contours draped over the upper 
surface.
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Two depth surfaces with contours draped over the bottom surface
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Example: Multiple Surfaces

Multiple surfaces can also be displayed. This facility is especially useful for 
comparison of anomalous areas with different data content. Below is an example 
of a magnetics surface overlain by radiometrics (total count on one surface and 
uranium on a second).

Multiple image surfaces to allow correlation of features
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Example: Merged Texture Surfaces

Combinations of merged texture surfaces can be used where different surfaces 
can be displayed to correlate information. Below is an example of a magnetics 
surface offset above an aerial photograph merged with topography.

Merged and texture mapped surfaces of magnetic above an aerial photograph draped on 
topography
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6 Printing and Graphical Output
In this section:

• Graphical Output

• Printing

Graphical Output

You can save the selected display in a variety of image formats:

• Saving as an Image

• Saving as an RGB Raster Image

• Saving as a Located Image

Saving as an Image

Any Encom Discover PA display and all its contents can be saved as an image. 
The supported image formats are listed in Appendix E: Supported File Formats. 
The output bitmaps can then used in external display software or reports.

Use the File>Save View As menu option to save the view as an image file. When 
selected, you are requested to define the output style of the saved image. This 
can be specified in image resolution (in pixels). Resolution of the bitmap being 
created is available in a range of pixels. Be aware that high resolution bitmaps can 
create large output data files. 

Specify the required bitmap size or resolution

You are then requested to specify a file location, name and bitmap format 
supported (available from a pull-down list at the base of the File Save dialog). 
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Saving as an RGB Raster Image

Encom Discover PA can create an external raster file in ER Mapper or GeoTiff 
formats. This option can only be used from a 2D image map. 

Saving a raster image of a displayed grid to ER Mapper output format

Output from this feature is to an ER Mapper .ERS file and associated image raster 
file or GeoTiff format. You can select the ouput resolution similarly to that 
described above in Saving as an Image. Note that any input grid format supported 
by Encom Discover PA can be output as a raster image using this feature (see 
Appendix E: Supported File Formats). 

To initiate this option, from a Grid Map, position the cursor within the window and 
click the right mouse button to display a pop-up menu. (Ensure the cursor is in 
Select/Navigate mode initially. Click the Select/Navigate button if not.) From 
the shortcut menu select the Save As RGB Raster option.
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Saving as a Located Image

Encom Discover PA can save a display as a located image. Located images have 
a header file associated with the image file that is used by Encom Discover PA to 
geographically position the image when displayed. This form of presentation is 
fast and can be used as a convenient method of quickly presenting large amounts 
of data without required access to the data.

Dialog to save a located bitmap EGB file for a display

Located images can have different resolutions and formats. Resolutions range 
from 256 to 32768 dpi. The available image formats supported are listed in 
Appendix E: Supported File Formats.

Located images can also have three different types of geometries depending on 
their intended use. These geometries are:

To initiate this option, from a 2D Map (or profile or section etc), position the 
cursor within the window and click the right mouse button to display a pop-up 
menu. Alternatively right mouse click on the Map 1 or Profile 1 branch in the 
workspace tree to view the same pop-up menu. (Ensure the cursor is in Select/
Navigate mode. Click the Select/Navigate button if not.) From the menu select 
the Save As georeferenced image option. 
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Quad

This geometry is used for display in 2D profiles and graphs and has an entry in 
the associated .EGB header that references the Line number from which the 
Located Image is created. This means that when this type of Located Image is 
used with profiles and graphs, the Line Iterator can be used to update and 
navigate through the bitmap displays.

Quad Strip

This type of Located Image also adds Line Number references in the associated 
.EGB header but also specifies the XYZ corner points of the bitmap such that it 
can be displayed in both profile/graphs AND in 3D line displays. To assist in fast 
3D display, a Compression can be applied to these bitmaps. The higher the 
compression applied, the faster the 3D display can be redrawn but with a 
reduction in resolution.

Surface

This Located Image geometry places a grid surface specification in the 
associated .EGB header. When displayed in a 3D Map, the grid surface is then 
applied to the captured bitmap to simulate an undulating surface with the 
associated raster grids shape. An example of this is shown below where a 
scanned Located Image has a topography raster grid used to define its displayed 
shape.

3D display of Located Image as a Surface geometry using a topographic raster grid
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The located image produced from this dialog is not automatically loaded into 
Encom Discover PA. To view the located image in Encom Discover PA use the 
drag and drop functionality. Open Windows Explorer or use the Explorer floating 
window in the Information sheet and navigate to the location of the located image 
file. Select the located image (.EGB) file and holding the mouse button down drag 
the file to the display area of Encom Discover PA. Then release the mouse button 
to drop the file into the software. 

To display the located image in a new display window position the cursor over the 
dark grey area of the display area before dropping the file. A Drag and Drop 
prompt dialog will appear in order to specify that the image is to be displayed in 
either a 2D or 3D window. If you wish to add the located image to a display 
window already open in Encom Discover PA position the cursor over the active 
window before releasing the mouse button and dropping the image into it.

Printing

The File>Print option enables Encom Discover PA to create hard copy output to 
a printer or plotter. Selection of the Print option automatically outputs a copy of 
the active window to a printer or to a print file (depending on your computer’s print 
settings). The printing function operates on the active (highlighted) display 
window only. The output can be scaled or simply made to fit a predefined page 
size. Output destination is controlled by the File>Page Setup options but a 
default printer setting can be defined in the File>Print Setup dialog. When 
invoked, the Print command determines the printer settings, device/paper size 
and window size for both Profile and Map displays. From these parameters, 
Encom Discover PA estimates a suitable scale to fit the print.

Note Encom Discover PA can use standard Windows drivers directly for printing or it 
can use a rasterising option to speed up and produce higher quality printed 
output. The rasterise option is included on the Print Setup dialog and is 
recommended for routine use in printing. It is recommended that a rasterising 
level of between 150 and 200 dpi is optimal for speed and quality.



154 Encom Discover PA User Guide

 
Printer and Rasterise options

For more information, see:

• Print Scaling

• Profile Scaling

• Map Scaling

• Page Margins

• Batch Printing Wizard

• Batch Printing to PDF

• Print Preview

Print Scaling

Hard copy prints can be sized to a user defined scale. Scaled output is limited in 
size by the physical size of the hard copy media being used. For example, it is not 
possible to print a complete, large scale map on a single A4 piece of paper if the 
scaling definition is too small. Encom Discover PA takes the size of the requested 
paper and scales the output accordingly. If the document being printed does not 
fit the paper (see Page Margins), a warning is presented. If the user requests to 
print anyway, the printing is performed with clipping.



6 Printing and Graphical Output 155

Scaling control is slightly different between the two display types of maps and 
profiles. 

Profile Scaling

Profiles are scalable in both the horizontal and vertical directions. It is possible to 
scale the height of a plot but it is not feasible to scale individual tracks since 
numerous tracks, channels and individual ranges can be used in profile displays. 
The height of individual tracks can be adjusted by dialog control or graphically by 
positioning the cursor above the separation line of a profile track, clicking the left 
button and dragging the line to the desired location. Note that to manually adjust 
the track size this way, the Workspace tree must have the Profile Frame level 
highlighted.

To create a profile of a specific horizontal scale, display the profile Property 
Frame dialog and select the X Scale tab. A specific scale entry can be entered as 
required.

Profile frame properties dialog

With the scale specified, select the File>Print menu item to print the profile.

Map Scaling

Map scaling usually uses (although does not have to use) the same scale in both 
a vertical and horizontal direction. To create a map on a specific scale, display the 
Map Frame Property dialog and select the X axis and Y axis tabs to specify the 
scales.
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To print the map, select the File>Print option. Printer setup and connection to 
hardcopy devices is controlled by the File>Print Setup item (or from the menu 
activated by a right mouse click within a display window). This item enables 
access to various printer types, the orientation, paper size and destination of the 
print. For a more detailed explanation of the Page Setup utility, refer to the 
Microsoft Windows Users’ Guide.

The File>Page Setup option displays a window similar to: 

Page Setup dialog to specify the printer, orientation, page size and margins

The Page Setup dialog enables you to define:

• Paper size (including custom page sizes)

• The source of the paper suited to the printer available

• The orientation of the paper

Note A wide range of printer types are supported. Output can also be directed to 
plotters, ink jet and thermal printing devices for which Windows drivers are 
available from the manufacturer. Output for a particular hard copy device can 
also be directed to a file. This situation is often necessary on networked 
installations or where the printer is not physically connected to the operating 
computer.
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• Margins (in millimetres). See Page Margins.

• Printer or plotter from the Printer button.

If you select the Printer button the standard Windows printer definition and 
selection dialog is displayed.

Specific printers can be selected by using this dialog. Depending on the printer 
type, the Options or Properties button displays various controls that can be set 
through subsequent menus. Different printers have different configuration 
controls.

Printing using a defined scale is a desirable feature, but occasionally a print scale 
might be selected too small for the size of allocated paper. In this case, the print 
process can either clip the output to the first page and print what it can, or the 
software can print on the first page, clip the remainder and continue printing on 
the second, third and subsequent pages. 

The File>Print option clips output to the first page. Any remaining output due to 
selection of an inappropriate scale is clipped. 

Page Margins

The printable area of a page varies with different printers and plotters. It is 
important to know where this area is to ensure your print is contained within the 
margins. The margins themselves can also be specified in the Page Setup dialog 
if you wish to change them. The margin is displayed in Encom Discover PA when 
the display is in Page Layout mode and with the Grid Design Mode (see View 
Menu) enabled.

Page margin displayed in Grid Design Mode indicating the outer print margin

The page margin is shown as a dotted line around the perimeter of the displayed 
paper.
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Batch Printing Wizard

The Batch Harcopy Wizard feature (initiated from the File>Batch Hard copy 
Wizard item on the main menu) allows the printing of multiple plots of selected 
profiles to a printer, images or Located Images (see Located Images). Each 
chosen line of data prints to a separate piece of paper in print mode, or to a 
different file in image mode. 

The Batch Printing Wizard allows you to control the output, format, line selection 
and resolution. The Wizard does not specify scale or printer setup. These must 
be determined prior to using the wizard.

Five wizard screens are displayed to allow various choices. These are:

Step 1

Descriptive only with no choice available.

Note Printing to a defined scale is a desirable feature, but occasionally a print scale is 
selected that is too small for the size of the chosen paper. In this case, the print 
process outputs what can fit on the first page and clips the remainder (as shown 
in the Print Preview). You must ensure that the scale and selected paper/printer 
selection is appropriate for your largest line hard copy output.
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Step 2

Allows selection of output to a printer, output images or Located Image files. 
Located Image files can be written with a single .EGB or separate .EGB header 
files for each Located Image. 

If the Printer option is chosen, you can output your images as hardcopy to an 
installed print driver or PDF document. 

If the print as Image option is chosen, you can nominate the image resolution 
(512, 1024, 2048, 4096, 6144, or 8192), the supported image format, output 
location and appended default image name. The default file name appends the 
line number of output to the specified prefix (eg. IMAGE10200.BMP, 
IMAGE10300.BMP etc). 
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If the print as Located Image option is chosen you can nominate the image 
resolution (512, 1024, 2048, 4096, 6144, or 8192), the supported image format 
(including ECW), output location and appended default image name. With this 
option an Encom Georeferenced Bitmap (.EGB) header file is also created which 
contains all georeferencing information for each image that is printed. Additional 
parameters to apply include:

• The option to include all of the outer graph annotations, including labels, 
titles, etc.

• The option to include the internal annotations and internal ticks.

• The option to improve the appearance of text by enabling/disabling 
smooth font edges. 
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Print wizard screens for located image selection

Step 3

This final screen is common to both printer, image and located image outputs and 
allows line selection. Two methods of line selection are available:

• Line Iterator: This method uses the automatic line selection specification 
as defined by the Line Iterator settings. Note that any of the Spatial, 
Standard or Sequential settings can be used.

• Line Selection Table: By manually building a line list in the Selected 
column, you define the data lines that are to be output in the batch 
process.
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You can use the Left/Right and Group selection buttons to move lines back and 
forth from the available and selected lists. You can also use the SHIFT and CTRL 
keys to specify multiple lines.

Batch Printing to PDF

When batch printing to PDF files the default operation is to print each page to 
individual PDF documents where each file name is manually entered after each 
iteration.

The PDF printing process in Encom Discover PA can however be streamlined by 
specifying the print driver to pdfFactory or pdfFactory Pro (for further information 
on this print driver please refer to http://www.fineprint.com)

To print documents to PDF using an automated process whereby the prefix 
output file name is preset and there exists the option to print all pages to the one 
PDF document the following process should be followed:

Warning While Encom Discover PA is batch printing and the required output has 
georeferenced images included, if you make the window redraw – for example 
by passing another window over the top of it – you get no output from that 
moment even though Encom Discover PA reports everything printed correctly. 
The printing of images takes the content of the screen display and therefore if it 
is interrupted, the print procedure will fail. It is therefore recommended that you 
do not touch your screen display until the batch printing has finished.

http://www.fineprint.com
http://www.fineprint.com
http://www.fineprint.com
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Step 1

Before printing access Tools>Options and view the Page Setup tab dialog. 
Check the status of the Enable pdfFactory batch print to named files option: 

• To print all documents as individual PDF files make sure that this check 
box is selected.

• To print all documents to the one PDF file ensure that this check box is 
deselected. 

The Options dialog with “enable pdfFactory batch print to named files” option enabled.  

Click OK to return to Encom Discover PA.

Step 2

Go to File>Page Setup and choose pdfFactory or pdfFactory Pro as the default 
printer in the Page Setup properties.

Step 3

Choose File>Batch Hardcopy Wizard and proceed through the wizard to select 
the output to “Printer”, and choose the lines you wish to print.
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Step 4

Click on Finish and if you selected the Enable pdfFactory batch print to named 
files option in the Options>Page Setup dialog (in Step 1 above), the Print dialog 
for pdfFactory or pdfFactory Pro will appear. Enter the file prefix and file 
destination into the dialog. Click OK to print and the status dialog will appear 
indicating that the document is printing. 

The print dialog for entering a PDF file prefix name and location.

Otherwise you will not be prompted to enter a file prefix or destination. Instead the 
file is by default called “Encom Discover PA1” or similar and will need to be 
changed at a later date if you prefer a different file name. The output file will be 
saved to the default location that can be changed by going into the Properties in 
the File>Page Setup dialog and specifying the AutoSave location in the Settings 
tab dialog.

The output of this process will consist of one PDF file which will be displayed as 
soon as the first line has been printed but the additional pages will get added to 
this as the batch printing proceeds.

Print Preview

Before printing, you can preview your document from the File>Print Preview 
menu item. From Print Preview, you can print directly using the Print button or 
zoom in or out of the print. 
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Print Preview window
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7 Managing Session Files
In this section:

• Session Files

• Packaging Datasets

• Templates

Session Files

Sessions and project management is controlled from the File menu with the 
Open, Save and Save Session As commands.

Encom Discover PA uses binary session files to save and restore projects. Within 
the session files the following information is stored:

• Paths to the necessary database source information

• Paths to any used template files for profile configuration

• Paths to feature databases

• Configuration data for open windows and components, their attributes and 
properties

Session files are usually saved with the file extension .EGS.

The session files do not contain data or feature information. Consequently, if a 
session is opened but the database access is not available, the software will not 
be able to restore the session. A message (see When a Database Fails to Open) 
is displayed in this circumstance. 

Error message displayed typically when a dataset is open in another application.
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Restoring a Session

When session files are restored, Encom Discover PA attempts to access and 
open as many of the individual files, images, grids etc it possibly can. Note that 
data, image and grid files are not stored in sessions – only the pathing, names 
and necessary information to access them.

As the session files attempt to restore and display the saved data, there will be 
instances when some files have been moved, deleted or renamed. When this 
occurs, you are provided with the opportunity to browse for the missing file, or you 
can click Cancel and skip this file.

Encom Discover PA provides the opportunity to find a missing file

At the conclusion of a session restoration where some files have not been 
located, a report is provided that describes the files successfully and 
unsuccessfully loaded plus what has occurred to them.

Session or template recovery report

This report can be used to determine which files have not been located, which 
were rejected and which were loaded automatically.



7 Managing Session Files 169

Recent Sessions

The names of the last five session files saved while using Encom Discover PA are 
displayed in the File menu list. These files can be individually selected to quickly 
access previously saved sessions.

File Recovery

Session file restoration has a lost file recovery mechanism. If Encom Discover PA 
cannot locate a database or other necessary files, it alerts you and offers the 
option of browsing for them. This applies to:

• Geosoft databases

• Intrepid databases (by a browse operation to a folder)

• MapInfo .TAB files

• Drillhole databases (acQuire, Geosoft WHOLEPLOT databases (either 
single or split) plus Encom Discover)

• Grid files

• Feature databases

• Vector files

• Located image files (if unavailable, a red cross is shown at the location of 
the image).

Packaging Datasets

To allow you to archive data or to send a complete data package to a client or 
work associate, Encom Discover PA offers a data packaging facility. This function 
takes all data, display objects and databases and places them separately in a 
folder with a session file to allow restoration.

The folder used to store the data and objects can be placed in a new folder that 
can be burnt to a CD or sent to an associate. To restore the complete project with 
all information required, only the session has to be restored.
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Follow these steps to package a dataset:

Step 1

Display the data, windows, displays as you want them restored.

Step 2

Use the File>Save To Package option.

Step 3

Specify a folder to store the package of data and data objects. You may need to 
use the Create Folder button of the Open File dialog when presented. Note that 
a session is required to restore the data package. If one has not already been 
created or associated with the data, you will be prompted to create one with a 
Session Open dialog.

Step 4

When OK is clicked in the above dialogs, the data packaging process 
commences the process of storing all the objects, databases and display 
information.

Data Packaging dialog and saving to a specified folder

At the conclusion of the packaging operation, Encom Discover PA opens and 
exercises the session file to ensure the storing process is completed correctly.
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Templates

All aspects of a profile and the displayed trace properties can be stored in 
templates. Consequently, applying a template from the profile of one dataset, to 
the profile of a second dataset may cause a channel mapping problem if the same 
channel naming conventions are not used etc. Encom Discover PA has a number 
of logical search rules it applies when a template is used with different datasets. 
For example, if the dataset used to create the template has a channel with 14 
bands of data, but the second dataset has only 10 bands, Encom Discover PA 
applies the template display attributes as closely as it can, but it might halt when 
the options are exhausted.

Dialog to alter the channel mapping of a database to suit a reused template

If different data field naming conventions are used for a second dataset where a 
template is to be applied, Encom Discover PA asks you which field and bands to 
use.

Encom Discover PA enables the style, properties and display attributes of all 
windows to be stored in a template. Templates are useful when graphs or maps 
with similar appearances need to be reproduced. This makes comparison of 
results or hard copy output to be done simple and quick. Templates can be 
saved using File>Save As Template or restored with the File>New>Open from 
Template option. Alternatively, use the template button.

A wide range of templates and components are provided with Encom Discover 
PA. Refer to the Encom Discover PA Templates and Components document.
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Where grid surfaces are required for a template to load, but the required grid file 
is not available (through a change or absence of the required folder or file), then 
the loading procedure requests you to either find the file or to substitute a different 
grid. The message displayed appears below:

Error in locating a grid file

Application Templates

To assist you in displaying various presentations, Encom Discover PA comes with 
a set of application templates. Templates are simple scripts that are used to 
reproduce previously displayed presentations. Further information on templates 
is provided in Templates.

Each template has its own description and is accompanied by a small preview of 
its content. Templates are stored in a folder called Template Gallery. Also within 
this folder are sub-directories that are for advanced template use. These 
directories contain templates that are tailored for specific applications such as:

• Potential Field Methods

• EM Methods

• Uranium Search

• Diamond Search

• Map Outlines

To use the templates for creating immediate displays, access the 
File>New>Open From Template menu option or alternatively click on the Open 
from Template button in the Documents toolbar. You can also browse the 
Template Gallery folder or alternatively individual folder names are listed in 
square or <> brackets. You can click on these folder names to allow navigation 
to them.
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Template selection with folder navigation, template preview and description

At the base of the selected template are details of the printer, page size and 
orientation as set when the template was saved. A description of the template 
content can also be saved. This description can be entered when saving a 
template from the property dialog of the Document.

Browse, History, Favourites and Add to Favourites buttons allow fast search and 
retrieval of frequently used templates. These options operate similarly to the 
Windows Internet Explorer utility.

With a template selected, click the OK button. Encom Discover PA then uses the 
content of the template to reproduce the presentation as previewed.

How Does a Template Work?

A template operates by storing the contents and properties of the Workspace tree 
not by storing details of the original window display. The tree contains all the 
relevant components and properties of a particular display. The tree can become 
complex with displays within displays etc. and hence the need to store and quickly 
reproduce the style of the original display.

Templates can operate from the available databases (not the databases used 
when originally saved) and therefore some data fields or components of the 
original data may not be present for the template to operate exactly.
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For example, if a data field is not present in the accessed database, the template 
cannot use it for the display. In these cases, Encom Discover PA attempts to 
locate items but if they are not available it displays the dialog (shown above) and 
allows you to select replacement items:

The details of the printer, page size and page orientation are also saved in a 
template. This information is used when a template is transferred from one 
machine to another and the template re-applied. The correct application of these 
settings however can only be applied to the template if the same printer is 
available to the second machine. If it is not, the default printer settings of the 
machine are used. When a template is accessed through the Template Selection 
dialog (see above), the printer information is displayed.

Note In the case of grids, these are not part of a loaded database and as such may be 
available as specified in the template, even though a different, unrelated 
database may be used. For these situations you need to re-specify the 
replacement grid location (from the Grid Group properties) and if in a different 
geographic area, select the Data Zoom button after the new grids have been 
defined. This action re-coordinates the location of the dataset and the incoming 
grids.
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8 Working with Data
In this section:

• Accessing Data with Encom Discover PA

• Supported Databases

• Importing ASCII Data Files

• Importing Data from Grids

• Converting to MapInfo TAB

• Converting to Geosoft GDB

• Exporting Data

• When a Database Fails to Open

• Selecting Channels and Tables

• Ancilliary Data

• Closing a Database Link

• Preferred Directory Access

Accessing Data with Encom Discover PA

Encom Discover PA is designed to access data directly from industry standard 
databases. Unlike other geophysical packages, Encom Discover PA uses 
existing import and raw data reading facilities of external packages to provide 
access to the data. This approach has a number of advantages such as:

• A wide variety of data formats, data sources and file formats are catered 
for by other packages and can therefore be supported by Encom Discover 
PA.

• The manipulation and editing of data when obtained from a database 
provides access speed, power and increased flexibility.

• Reading of data from a binary database is much faster than from raw 
(text) data files and does not have the overhead of checking record or 
data validity.
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• Navigation of data from one point (or traverse line) to another can take 
advantage of search and indexing techniques to increase speed and 
simplicity.

Encom Discover PA is designed to act as an interface between external 
databases (containing data), to display and provide interpreter interaction 
(through accessory processing or interpretation modules). Data links are 
transparent to the user as Encom Discover PA detects the type of database 
present in a folder and builds the link automatically.

When Encom Discover PA accesses a database, editing or changing the 
attributes of the data entries is possible through certain operations. These 
operations may involve data channels being renamed or new data fields being 
created by mathematical manipulation or operations such as filtering.

Encom Discover PA directly reads data from industry standard databases or uses 
external modules to create databases and import them. For list of the supported 
databases, see Supported Databases. Additional information about supported file 
formats can also be found in Appendix B: Data File Specifications (file 
specifications) and Appendix E: Supported File Formats (supported file formats). 
Access to a database from the File>Open option displays a folder access dialog 
that is used to navigate to the relevant folder containing the data. The folder rather 
than a specific file path requires specification.

When the OK button is clicked an opportunity to access other databases is 
provided and then Encom Discover PA interrogates the specified directories and 
ensures it can read the necessary files and ancilliary data. If the database is 
satisfactorily opened the Encom Discover PA buttons and access to the data are 
enabled. A message indicating a successfully opened database also appears in 
the Status Bar. 

To close access to databases, select the File>Close All option. The link between 
Encom Discover PA and all selected open databases is broken and data 
contained in memory is lost. Note that after the Close All option is selected, you 
can re-open another database.

For more information, see:

• Supported Databases

• Importing ASCII Data Files

• When a Database Fails to Open

• Selecting Channels and Tables

• Ancilliary Data
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• Closing a Database Link

• Preferred Directory Access

Supported Databases

Current industry databases supported are:

• Geosoft Oasis montaj 

Geosoft Inc., Toronto, Canada www.geosoft.com.

• Intrepid

Des Fitzgerald and Associates, Melbourne, Australia, www.intrepid-
geophysics.com.

• MapInfo TAB File

Pitney Bowes Software, Troy, New York, www.pbinsight.com.

When data is linked to Encom Discover PA, certain additional data fields become 
available that are not in the database initially. Data fields such as 
CHORDLENGTH and PROJECTEDDISTANCE are required by Encom Discover 
PA for line distance and plotting control.

• A wide variety of ASCII file formats can also be imported from other 
sources. See Importing an ASCII File.

Geosoft Oasis montaj

If you wish to access a Geosoft Oasis database (usually with file extension 
.GDB) you can individually open a single .GDB database file, or you can open 
multiple .GDB files. To open a single Oasis database file, select the GDB button 
(or File>Open>Geosoft Oasis montaj) and specify which .GDB database file is 
required. As an alternative, if you wish to access multiple .GDB files, use the 
SHIFT or CTRL keys and position the cursor over the selected files. Highlight them 
and click the Open button to provide access to these databases.

Warning Geosoft databases cannot be accessed by more than one application at a time. 
This means that if Encom Discover PA is accessing a database, Oasis montaj 
cannot read or display the same database at the same time. Similarly, if Oasis 
montaj is being used to view a database, Encom Discover PA cannot gain 
access to the same database. 

http://www.geosoft.com
http://www.intrepid-geophysics.com
http://www.intrepid-geophysics.com
http://www.pbinsight.com
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Preparing a Geosoft Oasis montaj database for use with Encom Discover PA 
requires:

• Importing data into the dataset as a line or points dataset. Data may be 
imported in the customary fashion by creating an import template (.I3) and 
using the Geosoft Import Tool. An alternative to this is to use an external 
utility such as the ASCII Import tool (see Importing ASCII Data Files).

• Ensuring that multi-channel data (such as EM data) are imported as an 
array

• Easting and northing channels MUST be created using channel names of 
X and Y respectively. 

See Appendix B: Data File Specifications for examples of import control files for 
use with Encom Discover PA and Geosoft Oasis. Additionally the Geosoft 
documentation describes the import of data and the necessary procedures. If you 
wish to access an Oasis database (usually with file extension .GDB) you can 
individually open a single .GDB database file, or you can open multiple .GDB files 
from multiple directories. To open an Oasis database file, select the Geosoft 
button and specify which .GDB database file(s) are required. Use the SHIFT or 
CTRL keys and position the cursor over the selected filenames to multiply select. 
Highlight them and click the Open button to provide access to these databases.

 
Select the desired GDB databases to be opened



8 Working with Data 179

Intrepid

Preparing an Intrepid dataset for use with Encom Discover PA consists of:

• Importing data into Intrepid as a line dataset. Data may be imported in the 
customary fashion by creating a Data Definition File (.DDF) and using the 
Intrepid Import Tool. You must ensure that multi-channel data (such as 
Geotem) is imported as banded.

• Ensuring the SurveyInfo file is complete. This file is found in the data 
folder and has all channel aliases assigned. The file can be edited in a text 
editor or by highlighting the imported line data folder in Intrepid and using 
the File>Edit SurveyInfo option in the Intrepid processing window.

• Essential data channels that must be present in an Intrepid dataset (or 
using the SurveyInfo alias file) are X (Easting), Y (Northing), Fiducial, 
FlightNumber and LineNumber.

See Appendix B: Data File Specifications for examples of import control files for 
use with Encom Discover PA and Intrepid. Additionally the Intrepid 
documentation describes the import of data and the necessary procedures.

If additional databases are to be opened after initially opening one or more in 
one folder, you can repeat the database opening procedure by selecting the 
Geosoft Open button navigate to the additional database(s), select and again 
click the Open button. Alternatively use the drag and drop operation from 
Windows Explorer for faster loading of data. 

The nature of Intrepid databases is such that no one file specifies the database. 
Instead, they are stored as multiple files within a root folder. To access an 
Intrepid database, select the Intrepid button and specify the root folder 
containing the database. 
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Specify the folder holding the required database(s)

Select the Open button.

MapInfo TAB File

An Open Folder dialog is displayed from the Browse button. Navigate the path to 
locate the required folder containing one or more .TAB files.

Once Encom Discover PA accesses the file, it may display a dialog to permit you 
to specify the Easting, Northing (mandatory) and optionally, the Z (elevation) and 
Line data fields. To access this dialog again at any time during the operation of 
Encom Discover PA select the File>Modify Dataset Properties menu option.

MapInfo .TAB file formats can be imported directly into Encom Discover PA but 
only if they contain data columns that record the location (Easting and Northing 
data fields). These two data fields are mandatory. Elevation data is optionally 
required if the imported data is to be displayed in 3D. Line information is also 
optional but required if the data are to be navigated using the line navigation 
facilities. The menu option File>Open>MapInfo TAB allows import of .TAB files. 
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Dialog to specify the required and optional .TAB data fields as required

With a MapInfo Professional .TAB file accessed, Encom Discover PA can display 
the data using its available display objects that support the data available. For 
example, a .TAB file that does not have a Line definition could not be displayed 
in a profile display. However, if the .TAB data had located (X, Y) readings 
representing say a geochemical or gravity survey, they could be displayed as a 
Point display (see Displaying Points).

Importing ASCII Data Files

• Comma delimited or CSV format (see Delimited Data)

• XYZ ASCII line-based data formats (see ASCII File Formats)

• Drillhole collar and downhole data formats (see ASCII Drillhole Data)

• Point data provided in column-oriented ASCII files (see Point Data).

If a database of data is not available, one can be constructed using the ASCII 
Import option (from File>Open>Text Import or the ASCII Import button. This 
facility can read a wide range of ASCII text format files including:
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The Import text tool is designed to read external multi-column ASCII data files, 
create a Geosoft database and then automatically have Encom Discover PA 
access the new database. Encom Discover PA can import and open the new 
database at any time during a session (similar to opening a database directly from 
the menu commands). In this case the new database is accessed and appended 
to any existing database links already established.

Other features of the text import tool include:

• Flexible import format definition that can accommodate any number of 
ASCII data columns and up to 32,000 characters per record

• Read ASCII files with either fixed width (defined by column size) or 
delimited by characters you choose

• In-built intelligence to interrogate a specified file and classify it as one of a 
range of types. A number of interpretations based on these types is then 
attempted to assist the decoding and recognition of the file.

• Easy interface for column naming can use a header line or interactive 
dialogs. Unwanted header records can be skipped during the import.

• Comment lines are accommodated as are various data formats such as 
real, and scientific notation.

• Data specification can include multi-channel, banded data (for example, 
with EM data) that is used extensively in Encom Discover PA

• Use or save Geosoft templates to describe the data format for re-use. 
Comments, headers and nulls are all handled in the templates. 

After data is imported, it is automatically opened by Encom Discover PA.

For information about the types of data you can import and the features of the text 
import tool, see:

• ASCII File Formats

• Importing an ASCII File

• Treatment of Null Values

• DMS Format

• Saving and Reloading a Layout

• Pre-set File Formats
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• Text Import Options

• Text Import Procedures

ASCII File Formats

The Text Import facility can load a wide range of ASCII multi-column formats. 
Typically the formats fall into the following classes:

No header or comments, multi-columns of constant width

Sample data:

1600  300200.0  6253800.000  56481.027     -0.010
1600  300220.0  6253810.000  56479.535     -999999
1600  300240.0  6253820.000  56478.371     -0.003
1600  300260.0  6253830.000  56477.547     -0.001
1600  300280.0  6253840.000  56477.035     -0.000
1600  300300.0  6253850.000  56476.781     -0.000
1600  300320.0  6253860.000  56476.707     -0.001
1600  300340.0  6253870.000  56476.723     -0.003
1600  300360.0  6253880.000  56476.734     -0.005
1600  300380.0  6253890.000  56476.660     -0.008

Header lines and comments with multi-columns of constant width

Sample data:

LINEEASTNORTHMAGGRAV
\ This is a comment line used for information
1600  300200.0  6253800.000  56481.027     -0.010
1600  300220.0  6253810.000  56479.535     -999999
1600  300240.0  6253820.000  56478.371     -0.003
1600  300260.0  6253830.000  56477.547     -0.001
1600  300280.0  6253840.000  56477.035     -0.000
1600  300300.0  6253850.000  56476.781     -0.000
1600  300320.0  6253860.000  56476.707     -0.001
1600  300340.0  6253870.000  56476.723     -0.003
1600  300360.0  6253880.000  56476.734     -0.005
1600  300380.0  6253890.000  56476.660     -0.008

Geosoft-style data files having line numbers embedded as standard XYZ file

Sample data:

Line 1600
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300200.0  6253800.000  56481.027     -0.010
300220.0  6253810.000  56479.535          *
300240.0  6253820.000  56478.371     -0.003
300260.0  6253830.000  56477.547     -0.001
300280.0  6253840.000  56477.035     -0.000
300300.0  6253850.000  56476.781     -0.000
300320.0  6253860.000  56476.707     -0.001
300340.0  6253870.000  56476.723     -0.003
Line 1700
300660.0  6243880.000  56476.734     -0.005
300680.0  6243890.000  56476.660     -0.008

Delimited data with inconsistent column widths with or without headers

In this example are CSV files (from Excel etc), comma, tab or other character 
delimited.

Sample data:

1600,300200,6253800,56481,-0.01
1600,300220,6253810,56479.5,-1.00E+30
1600,300240,6253820,56478.4,-0.003
1600,300260,6253830,56477.5,-0.001
1600,300280,6253840,56477.0,0.005
1600,300300,6253850,56476.8,0.034
1600,300320,6253860,56476.7,-0.001
1600,300340,6253870,56476.7,-0.003
1600,300360,6253880,56476.7,-0.005

Importing an ASCII File

Once a file is specified it can be altered from the initial dialog. The path and file 
name are echoed in the top left corner but you can search or alter the input 
filename if necessary.

Once the ASCII file to import is selected, the ASCII Data Import dialog screen is 
displayed. In the example that follows, a fixed width ASCII file with no headers, in 
multi-column format is used. If the data is not suited for loading (such as a binary 
file, or an inappropriate text file), a warning message is displayed. If no data is 
loaded, a message is displayed in the data preview area.

To import a text file or multiple text files in the same ASCII format, select the 
menu item File>Open>Text Import or the ASCII Import button.
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To import multiple ASCII files ensure that they are all selected at once in the 
browse operation. When multiple ASCII files are being imported in the one 
operation a preview of the first ASCII only will appear and the parameters 
specified in the import dialog for the first ASCII file will be applied to all 
subsequent ASCII files also being imported. After the Import button is selected 
the user will be prompted to enter a Geosoft database file name for each ASCII 
file being imported. 

Text Import dialog for previewing data and defining the format, headers and column names
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The dialog is divided into a series of controls with a data preview area at the 
bottom. In the preview area, the first 100 data records of the selected file are 
displayed. By default, the Text Import tool initially interrogates the file and 
determines if it is a Fixed Width or Delimited format. It then computes the 
column widths and displays these with vertical separator lines in the preview area. 
The dialog and its controls allow modification of the program’s initial review of the 
import file.

Once column widths and format are determined, the second purpose of the dialog 
is to assign column names to each required column. This can be done 
automatically (using a header record), or manually by naming each column.

Treatment of Null Values

Input data fields containing an asterisk, a solitary minus sign, or just white space 
are automatically treated as null values and when imported are written out to the 
Geosoft database as the Geosoft null value (–1.0E32).

If you have input data fields that contain a different null specifier string, (e.g. 
–999.99), then you must enter this string in the Nulls area of the Field Properties 
dialog. To open this dialog, just double-click on the column/field label.

Properties dialog and the entry for nulls

If you wish to apply the same null string to all input fields, click the Apply to all 
fields button on the field properties dialog.
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DMS Format

A DMS data format is automatically detected. This format is DDMMSS.SSC or 
DDDMMSS.SSC where C is a compass direction (N,S,E, or W) and the fractional 
seconds part (.SS) is optional and can be arbitrarily long if present.

Saving and Reloading a Layout

If you need to import a number of files with the same data layouts it may be useful 
to save your layout template for later use. To do this, simply click the Save 
Format button and you are prompted for a filename. Be sure to do this before you 
start importing the data, otherwise your layout information is lost.

When you want to import another data file with an identical layout, just reload your 
template using the Load Format button and all your field names, field properties, 
delimiters, column widths, etc are restored.

Note that the format used by Text Import for the format specification is the same 
as for a Geosoft database import template. Where used with Geosoft, your same 
files can be used with Text Import. 

Pre-set File Formats

The Text Import has been designed to assist with formats of data files by 
automatically recognising certain file types. If a file type and structure are 
recognised, the format should automatically be decoded and presented for you. 
The available automatically decoded format types include:

• ER Mapper ASCII files

• AMIRA time domain .TEM files

• Datamine ASCII files

• GEMSys (GEM Systems) magnetometer raw data files

• Geosoft XYZ files

• LAS (Log ASCII Format) data files

• ModelVision Pro located data files

• SRG (Station Referencing) data files.
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The above list shows a variety of standard industry data formats that are 
supported. An example of this is the Station Referencing format (.SRG) that 
allows the station field to determine where a new line starts. The station field must 
increment within a line. If the station field value decreases, this also indicates the 
start of a new line.

An example of this format is:

X,Y,Z,Station
100,200,50,1   // Line with 4 stations
105,200,50,2
110,200,50,3
115,200,50,4
100,205,50,1   // Line with 3 stations
105,205,50,2
110,205,50,3
100,210,50,1   // Line with 1 station
100,215,50,1   // Line with 1 station

In this case, set the field named Station to be a station field using the right-click 
menu. The SRG Classifier then interprets the remaining fields.

Text Import Options

To display the complete set of options on the ASCII Import dialog, click the 
Expand button.

There are three buttons in the Columns area of the Text Import dialog.

• Reset Column widths. is rarely needed as the column widths are usually 
automatically updated as the result of changes you make to other entry 
fields on the dialog. If you manually drag and add columns, then clicking 
this button resets your changes.

• Clear names button resets the names of all unnamed columns/fields back 
to Skip. Columns with this name are not imported.

• Auto-name button provides a quick way to select all fields for import. It 
names all columns with a prefix that you choose and the column number 
for a suffix (e.g. Field1, Field2, etc.)

Text Import Procedures

For details of how to import specific formats, see:
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• Fixed-Width Data

• Delimited Data

• Data with Interspersed Line Numbers

• Point Data

• File Headers Containing Field Names

• Multi-banded Fields

Fixed-Width Data

A fixed-width data file is one where each column is confined to fixed character 
positions on each line of the file. To import a simple fixed-width file, follow these 
steps:

1. Choose an input file using the file dialog. 

2. Check the Fixed width box in the column format area. 

3. Ensure that the correct number of header lines are selected. Header lines 
are displayed in the data preview area in green and are separated from 
the data by a horizontal line. 

4. In most cases, the Text Import tool automatically determines the column 
widths. If there are fields that are not separated by any white space, you 
may have to add and/or drag your own column lines in the data preview 
area. To do this, click in the data area to add a column break or double 
click to delete a column break. If you hold the button down you can select 
a column separator and drag it to a preferred position. If you hold the CTRL 
key plus move the mouse, it drags all columns to the right of the current 
column.

5. Choose a Line field by right clicking on a column label. This field should 
contain a value that is constant for each station along a line, but changes 
for each separate survey line or flight line in the data. If you do not choose 
a line field, when you click the Import button, you are asked if you wish to 
import point data.
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Right mouse click pop-up window to set channel properties or assign a name

6. If required, choose an X (Easting)  and Y (Northing)  by right clicking on 
the appropriate column labels. 

7. Name all the other fields that you wish to import. The simplest way to do 
this is to left click on the column label, type a name, and then press the 
TAB key to move to the next column. An alternative way is to double-click 
on the column label to bring up its Properties dialog. Fields named Skip 
are not imported.
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8. Click the Import button in the top-right corner of the dialog. You are then 
prompted to select the name of the Geosoft database that is created to 
contain the imported data.

Delimited Data

A delimited data file is one where each column is separated from the others by 
some delimiter character or characters. Delimiters can be spaces, tabs, commas, 
or any other characters you enter in the Other field. To import a simple delimited 
file, follow these steps:

1. Choose an input file using the file dialog. 

2. Check the Delimited or Comma Delimited item in the Columns format 
area. 

3. Ensure that the correct number of header lines is specified. Header lines 
are displayed in the data preview area in green and are separated from 
the data by a horizontal line. 

4. Choose the appropriate delimiter characters for your data. By default, 
space and tab characters are already selected, but if needed, you can 
enter other delimiter characters. 

5. Choose a Line field by right clicking on a column label. This field should 
contain a value that is constant for each station along a line, but changes 
for each separate survey line or flight line in the data. 

6. If required, choose an X (Easting) and Y (Northing) by right clicking on the 
appropriate column labels. 
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7. Name all the other fields that you wish to import. The simplest way to do 
this is to left click on the column label, type a name and then press the TAB 
key to move to the next column. An alternative way is to double-click on 
the column label to bring up its properties dialog. Fields named Skip are 
not imported. 

8. Click the Import button in the top-right corner of the dialog. You are then 
prompted to select the name of the Geosoft database that is created to 
hold your imported data. 

Data with Interspersed Line Numbers

In some cases, there is not a line field in your survey data. Instead, the file 
contains lines that specify the start of a new survey line. The simplest example of 
this is for the line simply to contain the string Line x, where x is a survey line name 
e.g. 1020.

To import data from files with such interspersed line numbers, simply check the 
box that says Has interspersed line numbers and select an appropriate line 
number marker string from the drop down list. If you need a string that is not in 
this drop-down list, type one in.

When the Has interspersed line numbers option is enabled, there is no need to 
select a field to be the line field.

Point Data

By definition, point data has no line-related column. Instead each record 
represents a point usually with some sample data acquired at an Easting and 
Northing position but randomly distributed.

An example of point data:

POINT   X         Y         Elev  ObsGrav  FreeAir  Boug2.67
601293  286861.3  6557450.5  287  9793745.0   29.3  -291.9
601298  285206.5  6565350.0  225  9793608.0   11.5  -240.5
601303  285111.2  6563139.5  243  9793674.0   29.4  -241.6
601308  285976.0  6553271.5  312  9793608.0   -3.5  -353.0
601313  286368.0  6567701.5  320  9793491.0  -37.6  -395.6
601318  286959.1  6569595.0  330  9793355.0  -107.0  -476.3
601323  287311.8  6571065.0  376  9793209.0  -62.8  -484.2
601328  287002.8  6572854.0  431  9793255.0  182.0  -301.2
601333  286495.7  6574801.0  680  9792787.0  490.1  -271.6 



8 Working with Data 193

Note that each point has its own station number identifier (column Point), but this 
is not essential. Only the XYZ and measurement columns are necessary. When 
the file is accessed by the Text Import tool you are required to ensure each data 
column to be imported is displayed in the Column headers. You can use the 
software to do this or you can define them interactively as described in Fixed-
Width Data.

When the column headers and nulls are specified, select the Import button. The 
Text Importer recognises that a Line column has not been specified. It therefore 
displays a message asking if the data is point data and do you wish to continue. 
This message is shown in the dialog below:

Text Import dialog with message displayed if point data is being imported

If you respond that the data is point data, the software creates a database in the 
conventional way and then opens it within Encom Discover PA. 
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Point data would not normally be displayed in line profiles or graphs since this 
would usually not be meaningful. Points can however be shown in maps or 
scattergrams. An example of a point display with modulated colour and size 
(dependent on a nominated data field) is shown below using a Curve with Line 
Styles disabled and Symbols enabled.

Example display of point data within a map as modulated symbols

File Headers Containing Field Names

In some data files, the names of the fields are contained in a comment line in the 
file header. If you wish to use these field names without re-typing them, ensure 
that the appropriate number of header lines are selected, and check the Field 
names are in header box. Next, choose which line of the header contains the field 
names. Finally, click the Get field names button. Note that only field names 
starting with alphabetic characters or underscores are allowed.

In rare cases, you may need to offset the character position of the start of the field 
names, using the Starting at char entry field.
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Multi-banded Fields

Multi-banded fields are extremely useful for data import when requiring data of 
like information. That is, if the import data contains multiple data columns of 
information derived from a similar source, we can use a banded-array import 
specification. Examples of such data include time delay measurements of EM or 
depths from a geophysical inversion. With these multiple data channels contained 
within a single data field, it makes their manipulation much simpler.

Multiply defined column data can be presented in import files:

Horizontally

This style of data definition is more common than vertically defined. Each 
individual reading is recorded by one line in the dataset. An example using Depth 
and Conductivity is shown below. Note that the record length can be long in these 
datasets. In this case Conductivity data is recorded to the right in the records.

Line   East      Nrth       Fid  Dpt1 Dpt2  Dpt3
10010  302500.2  5682568.5  6237  100  110  120
10010  302500.4  5682579.6  6238  100  110  120 etc

Vertically

If the Vertical bands option is selected, it means that one station’s data is spanned 
over multiple input text lines. If your input data is vertically banded, you must 
select the vertical bands option for every field which changes within a station. 
Other fields which have the same value for each text line within a station must not 
have the vertical bands option selected.

Below is an example space delimited file which illustrates this. This example 
contains multi-banded data for 3 stations.

X       Y       Depth  Density
1000.0  5000.0    0.0  3.0
1000.0  5000.0  -10.0  3.2
1000.0  5000.0  -20.0  3.3
1000.0  5000.0  -30.0  3.2
1000.0  5000.0  -40.0  3.1
1015.0  5000.0    0.0  3.2
1015.0  5000.0  -10.0  3.3
1015.0  5000.0  -20.0  3.4
1015.0  5000.0  -30.0  3.5
1019.0  5005.0    0.0  3.1
1019.0  5005.0  -10.0  3.2
1019.0  5005.0  -20.0  3.3
1019.0  5005.0  -30.0  3.3
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To import this file select the vertical bands option for only the Depth and Density 
fields. Note that there is no requirement for each station to contain the same 
number of text lines. The Text Import tool determines the maximum number of 
bands required and pads the data for any stations which have less bands than 
this with nulls.

Properties dialog for entry of multiple-channels using either horizontal or vertical bands

To set a field to have multiple bands (for data such as EM channels), double-click 
on the first column/field label and choose the number of bands in the field 
properties dialog. Specify if the banded format of the data is Horizontal or 
Vertical (see above). Also enter the number of bands that are in the channels of 
the file to be imported as a banded array data field.

Once defined, multi-banded fields are displayed in the Text Import column 
headers with square brackets after their names. The number in the square 
brackets contains the index of each band. Only the first band of each multi-
banded field is then selectable.
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Importing Data from Grids

If a database of data is not available, one can be constructed using the 
File>Open>Grid database menu option. This option can read a wide range of 
industry-standard grid formats which include:

• Arc ASCII grid files (.ASC)

• Arc Binary grid files (.ACF)

• Arc Gridfloat Grids (.FLT)

• ASEG GXF (.GXF)

• BIL files (.BIL)

• Encom grids (.GRD)

• ER Mapper (.ERS)

• Intrepid (.ERS)

• Geopak grid (.GRD compressed and uncompressed)

• Geosoft Oasis montaj (compressed and uncompressed) (.GRD)

• GeoTIFF georeferenced TIFF files with file header (.TIF, .TIFF)

• Landmark Seismic grid format (.GRD)

• MapInfo grid files (.MIG)

• Minex grid files (.XYZ)

• Surfer ASCII grid files (.GRD)

• Surfer binary grid (.GRD)

• USGS grids (.USG)

• USGS DEM grid file (.DEM)

• USGS SDTS grids (.TAR)

• Vertical Mapper grid files (.GRD, .GRC)
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When loaded in Encom Discover PA the data appears in a spreadsheet window 
and each row in the grid is converted to a survey 'line', referenced by the Northing 
coordinate.

Once loaded and displayed in a spreadsheet window Encom Discover PA allows 
grid data, including multi-banded gridded data to be displayed using the various 
data plotting series including curve profiles, points, lines and as directional 
vectors. 

It also allows you to examine grid data via the Statistics Explorer and to export 
grid data from the spreadsheet to an ASCII file as located stations.

For information about these display types, see:

• Profiles

• 2D Flight Path Maps – see Creating a 2D Grid Map

• 2D Lines – see Displaying Lines 

• 2D Points – see Displaying Points

• Stacked Profiles

• Directional Vectors – see 3D Vector Displays

Converting to MapInfo TAB

• Import ASCII Data to MapInfo TAB

• Geosoft GDB to MapInfo TAB

Import ASCII Data to MapInfo TAB

This menu option initiates the same Text Import utility used for converting ASCII 
data to a Geosoft database (.GDB) but the ASCII data is converted into a MapInfo 
.TAB file instead. This is useful in the cases where a need exists for labelling a 
line or point with information existing in a field consisting of only text. e.g. 
description tab of a rock unit.

Geosoft GDB to MapInfo TAB

Available from the Vector menu. See Geosoft GDB to MapInfo TAB in Vector 
Utilties.
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Converting to Geosoft GDB

• MapInfo TAB to Geosoft GDB

• Seismic SEG2 Data to Geosoft GDB

• ASCII Data to Geosoft GDB

• ASEG-GDF2 to Geosoft GDB

• UBC 2D Model to Geosoft GDB

• UBC 3D Model to Geosoft GDB

MapInfo TAB to Geosoft GDB

Available from the Vector menu. See MapInfo TAB to Geosoft GDB in Vector 
Utilties.

Seismic SEG2 Data to Geosoft GDB

It is possible to import SEG2 format data files into Encom Discover PA for display. 
The SEG2 data format is typically used in the acquisition of Ground Penetrating 
Radar (GPR). 

Refer to the Appendix B: Data File Specifications for additional information on the 
SEG data format. 

Access the Seismic SEG2 plugin utility from the Database menu to display the 
Import SEG-2 dialog and specify a SEG2 format data file (usually these files have 
a file extension of .SG2). If you wish to process multiple data files and lines 
consecutively, select these .SG2 files while holding down the SHIFT key.
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The Import SEG2 utility dialog 

The time can be scaled if necessary to account for non-standard recording 
intervals. By default the time scale is 108 seconds. The import procedure 
produces a Geosoft database which requires naming. Encom Discover PA 
automatically accesses this file after creation.

To display a Section Profile of imported SEG2 results:

1. After the SEG2 Geosoft database has been created, open a Section 
Profile (refer to Adding Sections)

2. Select the Fields tab and assign the Depth entry in units of time (usually 
either seconds or microseconds) and the Colour entry to the Data or 
amplitude field in the pull-down channel list. Also assign any Offset to 
account for elevation if this information is available.

Section Properties to assign the correct data channels and the resultant Section 
Profile



8 Working with Data 201

3. Click the Apply button and the Section Profile should display the resultant 
SEG2 results. Typically the amount of data is significant and so the redraw 
time may be quite long.

You may need to alter the colour look-up table to be a greyscale. Additionally, 
since the Y Axis of the display is required to increase numerically upwards, you 
may need to Reverse the vertical scaling. These two controls are available from 
the Colour Table and the Y Axis tabs of the Profile Properties respectively.

ASCII Data to Geosoft GDB

This menu option is an alternative to the File>Open>Text Import menu option for 
importing ASCII data into Encom Discover PA. The imported ASCII file is 
converted to a Geosoft database (.GDB) file. Please refer to Importing an ASCII 
File for more information on using this utility.

ASEG-GDF2 to Geosoft GDB

This tool reads ASCII data files in the ASEG-GDF2 standard format. 

The ASEG-GDF2 format is defined and approved by the Society of Exploration 
Geophysicists (SEG) and the Australian Society of Exploration Geophysicists 
(ASEG). Refer to Appendix A  for a description of the ASEG-GDF2 Format. A 
definition file (.DFN) accompanies a data file and this provides a self-defining 
format that the utility interprets and imports to a Geosoft database. The database 
is then automatically opened by Encom Discover PA. 

Operation of ASEG-GDF2 Import Tool

When executing ASEG-GDF2 import the software initially requires you to specify 
a definition (.DFN) filename. When identified, it requests you also identify the file 
containing the associated data. By default it uses the .DFN filename and appends 
the file extension .DAT but other filenames can be used. 

Once specified, the program interrogates the .DFN and data files and displays a 
dialog to confirm what it has interpreted plus some information about the data.

Tip The data volume being created in a seismic section (using the Section Profile 
facility) is very large. Consequently, it is more efficient for faster displays to use 
the Batch Display Wizard after having created the Section Profile. The Wizard 
can capture the requested lines of data as bitmaps and these can then be used 
for rapid display (refer to Located Images).
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PAgdf2Read dialog and confirmation of data channels and lines

At the top of the dialog are the definition and data file names and line number field. 
The association of field names to the main channel requirements of X, Y, Z, 
Clearance, Fiducial and Terrain can be individually specified from their respective 
pull-down lists.

At the base of the dialog you can nominate which data lines and data fields to 
import into the Geosoft database. Use the left and right arrow buttons to select 
individual lines or the entire dataset.

At the bottom of the dialog is some information relating to the number of records, 
channels and data values found in the file. Items such as nulls are automatically 
defined in the DFN file.

Select the OK button to initiate the import. You are then prompted to select the 
name of the Geosoft database that is created to hold your imported data. 
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UBC 2D Model to Geosoft GDB

The University of British Columbia (UBC) have produced a range of modelling 
and inversion programs (eg DCIP2D and DCINV2D) for two dimensional analysis. 
The output data files from this processing can be displayed by Encom Discover 
PA in Section Profile format displays.

The output data files comprise a geometry mesh file (with file name extension 
.MSH) plus one or more property files (for conductivity, resistivity or 
chargeability). The file format for these files is different from the three dimensional 
UBC format described in UBC File Formats. A detailed description of these file 
formats is provided in:

www.geop.ubc.ca/ubcgif/documentation/dcipdocs/fdmesh.html

www.geop.ubc.ca/ubcgif/documentation/dcipdocs/model.html

When initiated the UBC 2D Mesh dialog is displayed. You can define one or more 
.MSH files (on the left side of the dialog) and various property files to be used. The 
import procedure creates a Geosoft database with Upper and Lower layer 
thickness definitions that can be used in Section Profile displays. For additional 
information on this, refer to Section Structure and Layers and Upper and Lower 
Boundary Layers.

Import a UBC 2D Model file dialog

When the Import button is selected, the specified files are read and a datasheet 
displayed with the data. 

http://www.geop.ubc.ca/ubcgif/documentation/dcipdocs/fdmesh.html
http://www.geop.ubc.ca/ubcgif/documentation/dcipdocs/model.html
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To display a Section Profile of imported UBC results:

1. After the UBC Geosoft database has been created, open a Section Profile 
(refer to Adding Sections).

2. Display the Section Profile properties tab and select the Options tab. 
Enable the Build from Upper and Lower Boundaries and Layer 
Property item.

3. Select the Fields tab and assign the appropriate Upper and Lower data 
fields in the pull-down channel list. Also assign the correct properties 
channel to the Colour entry.

Section Properties to assign the correct data channels

4. Click the Apply button and the Section Profile should display the resultant 
UBC model results. You may need to alter the colour distribution to be 
logarithmic as by default, a linear colour stretch is applied. This can be 
altered from the Colour Scale tab of the Profile properties dialog.

The resultant UBC profile would appear similar to the section below:
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Example Section Profile derived from a UBC 2D inversion

UBC 3D Model to Geosoft GDB

The conversion of a UBC 3D model to a Geosoft .GDB database is a utility tool 
designed to use a UBC format model and create two Geosoft Oasis montajTM 
databases. These can then be used for slice or section displays in Encom 
Discover PA. The slices are formed along the row and columns of the original 
UBC model but cannot be created transverse or cutting across the primary 
row:column directions. As a consequence, the orientation of the slices is usually 
described as being East-West and North-South.

Slices created and stored in two separate Geosoft databases (East-West and 
North-South) are displayed in Encom Discover PA using the Section Group 
display formats. The sections can be defined using either the Upper:Lower 
boundary layer style or the Depth:Value style (refer to Layer Styles of Sections).

The UBC 3D model to Geosoft database interface appears as:

Slice Generator module interface
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Referred to as a Voxel Slice Generator, this utility requires you to specify a UBC 
model. These model formats have an ASCII header file plus a second data file 
describing the properties of the various voxel cells (refer to Appendix E: 
Supported File Formats for a specification of the File Format). These file names 
are entered into the Mesh and Model entry fields of the dialog. You can use the 
Browse button to navigate to the relevant files.

The output of the Slice Generator is two Geosoft databases corresponding to the 
East-West and North-South directions. The UBC model is composed of rows and 
columns within specific layers, as shown below:

North-South and East-West slices of a UBC model

After Slice Generation, the Geosoft databases contain arrayed data 
corresponding to the following data channels derived from the model:

• Depth – the centre point depth of each layer (with n-depths for n-layers)

• Upper – the upper depth for each bounded layer (with n-Upper values for 
n-layers)

• Lower – the lower depth for each bounded layer (with n-lower values for 
n-layers)

• Output – the property value associated with the layer, defined by its depth 
or its Upper-Lower bounds.

• X, Y and Z – the locations of the top centre of the various voxels.

Geosoft databases in the East-West and the North-South orientation are created 
and their names are as specified in the Slice Generator dialog.
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To create the databases with a UBC model specified, click the Generate button.

Two Dimensional Profile Display of Slices

To create a 2D Profile of a sliced voxel model, the process is identical to 
conventional section displays (refer to Profiles).

1. Open the East-West and/or the North-South sliced voxel model data. 

2. Create a Section Profile from the New>Profile>Section Profile menu 
item or the Section Profile pull-down item on the Documents toolbar.

3. Either the Layer Boundary or the Depth:Property layer style of section 
creation can be used (see Adding Sections).  

In this example the Depth:Property specification is used, but by altering 
the Section branch Options tab setting, either is available. In the 
Workspace tree select the Depth item and set the data source to the 
Depth item of the required database. You can use every layer or you can 
use a subset of layers to speed up the display.

  
Selection of Depth bands for the slice display

4. Repeat the band selection but for the Colour branch of the Section. 
Ensure that the same bands are selected for the Colour branch to match 
the bands chosen for the Depth branch. 
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5. Once both the Depth and Colour bands are applied, a section should be 
displayed. You may need to offset the upper surface (using the Offset level 
of the tree) to compensate for topography.

6. The Line Iterator can be used to cycle through the slices from the source 
database. Note that the slice line numbers are annotated by numbers that 
increment in accord with their east-west or north-south location.

In addition to using the Line Iterator you may wish to modify the look-up 
table of the colour rendering of the cells displayed. Use the Profile Colour 
Axis tab to do this.

Example of a slice displayed as a 2D Profile section

Making Slices Transparent

It is possible to apply specific colour-look up tables to make slices appear 
transparent. This allows you to view anomalous zones of a slice without them 
being obscured by the background layers of slices.

To do this, select the Section Group branch of the Workspace tree and from its 
property dialog choose the Appearance tab. Using the two slider bars available, 
specify the upper and lower data ranges required to be displayed. The sliders are 
interactive and update the display when the Auto-Apply option is enabled.
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Display of slices with thresholding of the data values between specific ranges

Exporting Data

It is often useful to export a selection of line and channel data in a loaded 
database to a predetermined ASCII format file. The Line Exporter utility will 
perform this requirement and can be accessed from the File>Export data menu 
option. 

The output file format can be any of:

• ASCII format with space delimited, comma separated (.CSV) or fixed 
width

• CSV format with or without line numbers

• Geosoft XYZ format with line numbers and line prefixes

• ESRI Shape file format (.shp)

• ASEG GDF2 format (.DFN and .DAT) with line numbers and line prefixes

The dialog to control the export is:
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Line Export utility for the ASCII output of databases

On the left of the dialog, you can nominate the data lines to be exported. On the 
right, the required data channels are specified. Various settings permit:

• Format - to be Space Delimited, Comma delimited or Fixed Width

• Line Numbers – can be appended in the first column, on a Separate line 
(such as Geosoft XYZ format) or with No line numbers.

• Include a header line

• Include field names derived from the channels of the input database

• Define a Null string if required

• Specify Point or Polyline objects to be exported

• Fixed width format enables the Column Width and Decimal places

• Line number field can be specifically named with a prefix if required

Once the various parameters are specified, click the Export button. Name the 
output ASCII data file in the Save As dialog and click the Save button.
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When a Database Fails to Open

There are several reasons why a database may not open. The most common are:

• The database is already open in another application.

• The file you are attempting to open is not a valid database.

• The database file cannot be found at the specified folder location.

Error message displayed when a dataset is open in another application.

If an error message similar to the one above is displayed, do the following:

1. Check that the database is contained in the specified folder.

2. Ensure the database is not opened by another application.

3. Close Encom Discover PA and open the database using its native 
application.

4. If the database can be opened successfully in its native program, check 
that the following data fields exist – Linenumber, X, Y, Fiducial (mandatory 
fields) and Flightnumber (for Intrepid databases, refer to the SurveyInfo 
File). Note that Flightnumber is an optional field.

After performing these checks, if you are still unable to open a database, do the 
following:

• Try to open one of the sample databases supplied with the installation.

If you are still unable to resolve the problem, then contact Encom support.
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Selecting Channels and Tables

Once data is accessed by Encom Discover PA it can be selected at a number of 
levels. Usually the databases are structured such that they contain discreet 
traverse lines along which data fields are found. In turn, each data field may have 
a single or multiple set of data bands. Each band of the data has the individual 
data readings corresponding to the data sensor used to acquire the original data.

Both Oasis and Intrepid databases are capable of storing data using this 
database structure. In some cases, a Geosoft database may contain points or 
drillholes rather than lines. For these datasets, Encom Discover PA reads the 
individual data points and drillholes as if they existed on a single line. 

Selection of the required data within Encom Discover PA is controlled by a single 
dialog type that is common throughout the software and enables data selection  
to the band level. 

Data channel/field selection dialog



8 Working with Data 213

Ancilliary Data

In Encom Discover PA, banded data and especially banded geophysical EM data 
can be displayed and analysed. For time domain EM, this form of data has 
channels in the various bands that are representative of time delay windows. 
Each channel represents a period of time in which received data is recorded from 
an EM sensing receiver. As Encom Discover PA has some operations that can 
make use of the time information for analysis operations (for example, the decay 
analysis tool), a file called ATEM.TXT is used to define the time channels.

The format of an ATEM.TXT file is provided in Appendix B: Data File 
Specifications

Closing a Database Link

To selectively close databases, from the File menu, choose Close Datasets and 
nominate which files to close. To close all databases, choose Close All.

Closing selected datasets

For a selected database/line/field combination, the bands of a multi-band 
dataset can be individually nominated using the individually selected band 
buttons to select and to deselect or alternatively, you can select or deselect all 
bands using the select or deselect buttons. You can highlight selected bands 
using the SHIFT or CTRL keys.
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Preferred Directory Access

Encom Discover PA uses a Global Directory to access data. The Global Directory 
determines the folder that is automatically navigated to when a file of any type is 
opened.

By default, this location is updated to be the location of all subsequent file 
locations until it is changed by:

• Opening any data file in a different folder with the Use Global Directory 
for all file locations option enabled,

• Selecting the Global Directory in the File Locations tab of the 
Tools>Options menu item and clicking the Modify button, or

• Selecting a File>Set Project Folder option and specifying a particular 
directory path.

For additional information, see Setting the Global and Project Directories:

Note If you wish to specify a project directory for use but sometimes want to access 
files from different locations, define the Global Directory but disable the Use 
Global Directory for all file locations option. This allows the Global Directory 
to always remain at the defined folder but does not prevent you accessing files at 
different locations.
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9 Page Layouts
In this section:

• About Page Layouts

• Document Window Properties

• Adding Frames to a Document

• Adding Objects to a Page

• Editing Documents

About Page Layouts

The Page Layout display is used to combine various display frames for on-screen 
viewing and a preview of hard copy. Any frame can be copied into a layout. The 
Page Layout provides a WYSIWYG (what-you-see-is-what-you-get) view. Initially 
after a new document (or any display window) is requested a blank window is 
displayed with a page of paper corresponding to the File>Page Setup paper size. 
The other document views, title blocks and objects are then added to the paper if 
a finished layout is required.

Use the File>New>Empty Document or the button to create an empty 
document. Any already displayed frames in existing documents can be 
appended to the layout using Copy/Paste operations. An example of this using 
map, image, profile, layer and title block components is shown below:
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Composite graphics objects in a Layout Window with maps, images, layers Profiles and 
title block

Document Window Properties

A Document in layout mode inherently has no properties but inherits the 
properties from the frame objects added to it. The Workspace tree expands to 
reflect whatever frames are added and the various properties are derived from 
these frames. Refer to the various frame property descriptions for information on 
controlling property dialogs.

Adding Frames to a Document

Two methods are available to add existing frames to a new, empty or partially 
occupied document. The methods available relate to the alignment required in the 
end product. No Alignment and With Alignment are available. The copying 
procedure is identical in both methods.

• Adding Frames Without Alignment

• Adding Frames With Alignment
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Adding Frames Without Alignment

To add existing frames to another document, configure the source window display 
as required. Any frame can be used (profile, map, scattergram or graph). Follow 
the steps below to copy and paste a frame:

1. Highlight and select the required frame (e.g. Map Frame, Profile Frame 
etc).

2. Click the right mouse button and from the pop-up menu select the Copy 
item. This operation places the frame on the Windows clipboard.

4. Re-size and position the pasted object as required.

You can repeat the above operation and align objects manually as necessary. 
Any combination of frames can be copied using this approach, including saved 
components such as title blocks.

A disadvantage of this method is that the positioning of objects is by graphical 
alignment and not by a program controlled manner. Note that the frames are 
positioned according to the Snap control for the document (see Snap Operation), 
but alignment can still be inaccurate. A more accurate method of aligning objects 
is to use frame cells and frames. This method is detailed in Adding Frames With 
Alignment.

Adding Frames With Alignment

You can add frames to a document such that they are automatically aligned and 
involves creating an empty, container frame in the target document before 
inserting the frame items. While this method provides good alignment of the 
objects it restricts flexibility in sizing of objects within the container frame cells.

3. Select the target document to receive the copied frame. Ensure its paper 
size has the required dimensions (using the Page Setup option). Using 
either the Edit>Paste menu item or the Paste button, position the cursor 
into the new document and either click the left mouse or position the 
cursor and with the left mouse button pressed drag out a rectangle to hold 
the copied object.

Note Certain pasting operations are not permitted by Encom Discover PA. For 
example, it is inappropriate to paste and then embed a Map Frame into a Profile 
Frame. Encom Discover PA prevents you doing these types of operations by not 
displaying the Embed option.
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To align objects using container cells in a Document:

1. Initially create a Document ensuring the Page Size is as required (using 
the Page Setup option for the document).

 

3. Highlight the various configured document frames that are to be 
transferred to the layout. From the Workspace tree (or by right mouse 
clicking in the active document window) select the Copy option. This 
copies the frame contents of the active document to the Windows 
clipboard.

4. Select the target document and position the cursor over the container cell 
to contain the copied object. Click the right mouse button and select the 
Paste item from the pop-up menu. The contents of the Clipboard are 
pasted into the selected cell and sized to fill the entire cell area.

You may need to adjust the positioning of the various objects by moving the cell 
boundaries or adding/subtracting margins to the object in the property of the 
relevant layer.

2. Insert an empty frame using the Frame tool. You can use the 
Insert>Frame menu option or the Insert Frame button (see Frames and 
Split and Merge Frames). Display the Properties dialog of the Frame and 
specify the rows or columns as required and click the Apply button. 
Configure the cells by row and column as necessary to hold the various 
objects. The Properties dialog of the created frame allows you to specify 
the number of rows and columns required. Alternatively, hold the cursor 
over a horizontal (for rows) or vertical (for columns) and click the right 
button. Select the Split option to create additional cells or Merge to 
remove cells.

Tip To make cells within cells, use a second empty frame and insert this into an 
existing cell and manipulate the number of rows:columns in the same way.
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Adding Objects to a Page

To any display document, Encom Discover PA can add a wide range of ancilliary 
objects. These can be:

• Text – Completely configurable for font, colour, size and content. See 
Adding Text.

• Images –  Loaded from a file or drawn in the document display. See 
Adding a Picture.

• Preformed Components – Title blocks, legends etc that are supplied 
externally or composed by you.

• Graphical Objects – Scale Bar, North Arrow, Floating Colour Bar, etc.

• OLE Objects – Created by the applications that support OLE (Object 
Linking and Embedding) technology - such as MapInfo Professional 
maps, pictures, MS Word documents, MS Excel spreadsheets etc.

Individual objects are placed within a display document from the Object Palette 
toolbar.

Adding Text

A default text string is displayed. A Text branch (with the first few characters of 
the text string) appears in the Workspace tree. Display the Text Property dialog 
to access the following controls:

Text can be added to a display as a title, interpretation, legends and for any 
instance where character strings are required. To add text, select the button of 
the Object Palette toolbar or from the Insert>Text menu item. Position the 
cursor over the active window area required and either click the left mouse 
button or drag a rectangle out by holding the left mouse button down while 
dragging.
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Text Properties dialog for content, font and justification control.

• Text Content – Single or multiple line text entry is supported. To make the 
text wrap onto a new line, press the CTRL+ENTER key combination.

• Font Control – Invoked from the Set Font button, it allows selection of a 
font from those currently installed on the system, specify the style (bold, 
italic or underline) , size and colour.

• Wrap Text – Text that is longer than can be displayed in the assigned 
(graphically controlled area of the display will wrap to the next line. This is 
especially useful for formatting legends or blocks of text.

• Angle Control – The text angle can be entered to make text to appear 
rotated. Increasing positive angles are anti-clockwise.
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• Alignment – Both vertical and horizontal alignment (within the drawn 
bounding rectangle as initially defined) is provided.

A push button arrow on the right of the text dialog allows a drop down list of 
Variable Substitutes. Selecting one of these items will substitute the variable 
selected. The syntax of the substitute variable is embedded between two % 
characters (eg %LINE%.).

Adding a Picture

Picture Properties dialog

If a picture is not accessible or the filename has been changed etc, Encom 
Discover PA displays it as a red crossed area. This should be remembered if 
pictures are used in templates but files are changed when the template is re-used.

Note When adding new text, holding down the SHIFT key when inserting will not 
automatically embed it into the encapsulating frame. It will stay floating until you 
embed it.

Pictures (company logos, clip art etc) can be added to any display document. 
Supported picture formats are listed in Appendix E: Supported File Formats. 
Windows metafiles (.WMF and .EMF) are also supported. To add a picture, 
select the Insert>Picture menu item or the button. Drag out a rectangle or pick 
the location of the picture in the document.  Once the picture is placed, the 
Property dialog allows you to navigate to a picture file.

You can size the picture within a defined area and fit to the area initially defined 
or maintain the aspect ratio
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Scale Bar

Scale bar Properties dialog

The scale used in the drawing of a scale bar is automatically determined by the 
object into which it is inserted. This scale can be overridden in the Scale Bar 
Links tab (refer to Changing the Scale of Scale Bars). 

To edit the scale from the Scale Bar Properties dialog press the Set... button to 
view the Set map scale dialog. Alternatively you can set a map scale via the Map 
Frame Properties. Refer to Profile Frame Properties for more information on this. 
The Map Frame scale and the Scale Bar should show the same value.

Note When adding a new picture, holding down the SHIFT key when inserting will not 
automatically embed it into the encapsulating frame. It will stay floating until you 
embed it.

Scale bars are useful to complete a map or indicate the output scales of a profile 
or a map. Automatically sized and scaled scale bar objects are available from 
the Objects toolbar (using the button). Once the button is clicked, position the 
cursor at the desired location and either click the left mouse button (to draw a 
default scale bar), or drag and size a rectangle area. Scale properties are 
available from the Workspace tree.

Note When adding a new scale bar, holding down the SHIFT key when inserting will 
not automatically embed it into the encapsulating frame. It will stay floating until 
you embed it.
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Set map scale dialog.

The appearance of scale bars is controlled by font, label and available types 
(Solid, Alternate and Mixed Alternate breaks). Labelling and intervals of text 
along with length and thickness controls are available including both metric and 
imperial (feet) measurements.

To set the scale a statement of equivalency is used. For example ‘One inch is to 
10 miles’ or ‘One metre is to 100,000 metres’. In the latter example, the text 
substitution for this, which can be added to the scale bar Title in multi-line format, 
is:

And the resultant display for this in the scale bar is:

There are three measures of units:

• from

• to

• data

The ‘from’ and ’to’ units refer to the statement of equivalency and the user can set 
them to whatever they want.
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The data units are the units of the actual data in the plot. If possible, this is 
obtained from the frame coordinate system. This can also be manually set in the 
Set map scale dialog.

The scale bar will be rendered using the ‘to’ units. 

To help with all this there are a number of text substitution codes. By default the 
scale bar title shows the representative fraction and the statement of equivalency 
below it.

Changing the Scale of Scale Bars

Although the scale of a scale bar by default is determined by the data object 
associated with it, the Scale Bar Links tab allows you to change this so that the 
scale bar can control the scale of associated grid objects.
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Scale Bar Properties to control the scale linking to frames.

Of the two options provided, the first one forces the scale bar to obtain its scale 
from the nearest displayed object. Since an Encom Discover PA document may 
have numerous objects contained (each with their own scale), this is an important 
method of operation. The second option forces all contained objects to have the 
scale of the scale bar.

North Arrow

The properties of a North Arrow allow for the presentation of arrows of different 
types:

• Grid North – Used as the reference north direction (from which all other 
north angles are measured). Grid North is typically used for local grid 
directions and projections.

• True North – Used for deviation from Grid North but usually is the same. 
True North is used typically in relation to Magnetic North.

The north arrow is used in many map displays to orient the data and complete a 
layout presentation. The North Arrow button on the Object toolbar can be 
selected and a north arrow location can be placed within any document.
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• Magnetic North – Indicates the direction of a magnetic compass with 
measured declination of the Earth’s magnetic field.

• Local North – Indicative of a local grid and any deviation in direction for 
local surveying from Grid North.

North Arrow properties dialog and controls

Floating Colour Bar

Note When adding a new North Arrow, holding down the SHIFT key when inserting will 
not automatically embed it into the encapsulating frame. It will stay floating until 
you embed it.

For images, graphs, maps, voxel models and colour presentations where no 
colour axis is automatically created, a Floating Colour Bar can be added to a 
display. The object acts similarly to a text or north arrow item in that it can be 
positioned and sized anywhere within a display. The axis can be connected and 
so obtain its colour from a grid image or graph. An example of a Floating Colour 
Bar is:
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Example of Floating Colour Bar with colour bars derived from two image displays

Note from the Workspace tree that a Colour-Legend branch is associated with 
each vertical colour bar of the axis. The connection of the bar can display colours 
or sizes and connect to different axes or layers individually. This connection is 
specified from the Content tab.

Controlling the Content of the Floating Axis

Controls of the size, title, centreing etc of the colour or size bar are specified in 
the Appearance, Title and Arrangement tabs. Their operation is identical to axis 
controls described in Axes and Annotations.
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Individual control for colour and size bars is controlled from the properties of the 
various Colour-Legend branches of the Workspace tree beneath the Floating 
Colour Bar (see the tree above). Refer to Floating Colour Bar Properties for 
further information.

Floating Colour Bar Properties

Control of the individual colour or size axes of the Floating Colour Bar is derived 
from selecting the properties dialog of the Colour-Legend branch of the 
Workspace tree associated with the Floating Colour Bar.

Control dialog of Floating Colour Bar Colour layer

Using the Connection tab (which displays a tree of the available imagery), 
nominate which image layer (or graph in the case of a size axis) is required for 
the Floating Colour Bar. When you click the Apply button, the axis updates the 
display.

You can Stretch the distribution of the colour display as well as control the 
Colour Scale and Colour Table. If an alternative colour table is to be used or the 
LUT is to be edited, you can access the table using the LUT Editor. Annotation of 
the displayed colour legend can be controlled for Ticks, Division and Title. 
Controls of the position, title, divisions and ticks are described in Axis Properties. 

If multiple floating colour bars are to be used (as shown in an example in Floating 
Colour Bar), select the Floating Colour Bar layer of the Workspace tree and click 
the right mouse button. From the pop-up layer, select the Add>Annotation item.
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Adding additional Colour Bar annotation

Editing Documents

Document within Encom Discover PA can be selected, copied, pasted, cut and 
deleted from the Workspace tree. Considerable control in moving a document 
from one location to another is available while retaining all the attributes and 
properties of the object.

Certain editing controls are available from specific layers that are not available 
from other layers. This relates to the object type and its edit properties. 

The Edit menu options

For more information, see:

• Copy, Delete, Cut and Paste

• Split and Merge Frames

• Embed and Float
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Copy, Delete, Cut and Paste

Split and Merge Frames

The Spilt and Merge menu commands are used in combination with frames. The 
pop-up menu displayed with a selected frame can display a grid’s properties but 
also allows you to insert columns or rows. When these are added to a grid you 
can position them by placing the cursor over the cell boundary and dragging it 
while the left mouse button is clicked.

Alternatively, you can specify the number of Rows and Columns to be contained 
within a Frame from the Frame Properties dialog.

In most instances the Edit menu items have the Copy, Paste, Cut and Delete 
options enabled. Also on most occasions the pop-up menu appearing on right 
mouse button click on a layer has the Copy, Cut and Delete options. Paste may 
not be applicable since it may require a specific cursor action. In these cases the 
Paste option is available from the Edit menu or the button of the Objects toolbar.  

If a group of sub cells (cells within a cell) is required, you can insert a new 
container frame (using the Insert Frame button or the Insert>Frame menu 
item). To do this, click the Add Frame button, place the cursor in the cell to have 
the sub-grid and then click the left mouse button.
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Enter the number of Rows and Columns required in a frame

If you need to remove a cell row or column, use the Merge menu item. Similarly, 
a fast method of adding a new cell is to Split a cell.

 

When objects are to be placed in grid cells, you need only point to the relevant 
cell and Paste the contents of the Windows clipboard. When the object is pasted, 
it assumes the outer size of the containing cell and is locked to the cell size. It is 
possible to unlock the object by breaking the cell-object link. This is done by the 
Float menu item (refer to Embed and Float).
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Embed and Float

Another menu option that is available from the pop-up frame menu allows objects 
inserted in a cell to be moved and re-sized. A link is created between an object 
(such as a document or text etc) when it is inserted in a cell. This link can be 
broken by floating the object. To float an object, activate it (use the CTRL and left 
mouse button if required) and then select the Float item from the pop-up menu. 
Once floated, an object is free to be moved to any new location.

To re-insert the object into a grid cell, it can be moved and dropped to a new cell 
position. To re-establish a link it to the new cell location the pop-up menu Embed 
instruction can be used. The Embed command locks the relocated object to the 
new cell and re-scales it accordingly.

Note When adding new objects such as text, floating colour bars, pictures, scale bars 
etc. holding down the SHIFT key when inserting will not automatically embed the 
object into the encapsulating frame. It will stay floating until you embed it.

Note Certain pasting operations are not permitted by Encom Discover PA. For 
example, it is inappropriate to paste and then Embed a Map Frame into a Profile 
Frame. Encom Discover PA prevents you doing these types of operations by not 
displaying the Embed option.
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10 Display Properties
In this section:

• Documents, Frames, and Objects

• Document Properties

• Profile Frame Properties

• 2D Map Frame Properties

• 3D Map Frame Properties 

• Profile Properties

• Axis Properties

• Label Properties

• Curve Properties

Documents, Frames, and Objects

This section describes the properties of documents, frames, and graph objects. 
In Encom Discover PA, all profiles and graphs are based on the same 
fundamental graph object. Consequently, the property page and dialog 
descriptions for a profile are equally applicable to all graphs - including those 
created in map, profile, scattergram, decay curve and graph displays. 

A profile is a graph object, except that the X axis range is scaled according to a 
cumulative distance channel automatically computed by Encom Discover PA 
(called ProjectedDistance). This channel is computed individually for each line of 
a survey database. This range and scale is shared with all profile graphs 
contained in a common profile frame. The user is not given the opportunity to 
select an X data channel for horizontal scaling but he is given control over 
annotation of the X axis (eg Fiducial, Easting etc). A profile can only display data 
from a single traverse line in a single track. Multiple tracks can be added to display 
data from multiple lines.

Encom Discover PA uses the multi-branched Workspace tree to control profiles. 
Each branch of the tree has its own properties. Note that if the tree is displayed 
as concise or minimised, then it is possible that not all components of the 
document are displayed. In this case, the properties of hidden components may 
be accessible higher in the tree – often at the Profile branch.
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Properties dialogs are available for each level of the Workspace hierarchy used 
for a Document that contains a Profile. Property dialogs have been designed to 
have similar size, appearance and common features. Various tabs at the top of 
each dialog allow you to select the property required.

In the Workspace, if the full document tree is exposed (click right and select Tree 
Content Verbose), the following expanded structure is displayed.

Profile verbose tree structure showing relationship of all axes

See Working with the Workspace Tree and Branch (Object) Properties for 
information on how to display the property dialogs.

Document Properties

The Default Layout returns a display to fill the available default page size defined 
by the printer setup.

Profile Frame Properties

The Profile Frame allows multiple profiles to be contained in their own frame cells 
or tracks within the display. The Profile Frame Properties dialog has four tabs:

The Document is the highest level of the Workspace and provides only the 
options of Page Setup and Default Layout. The Page setup option duplicates 
the File>Page Setup menu item or the button.
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• Axes Tab

• Options Tab

• Appearance Tab

• X Scale Tab

Axes Tab

Axes tab for Profile Frame Properties

The Axes tab of a Profile Frame is identical to the Axes Tab of a profile graph 
object but is designed to override the axis settings in all profiles in the frame 
because of its level in the Workspace hierarchy. This provides you with an easy 
way to control the axis settings in all profiles in a frame. The Axes tab is used to 
control the range and scaling of the X, Y, Z, Colour and Size axes. It also enables 
you to control axis annotations for all profiles in a frame and to specify advanced 
graph properties like anisotropy and data range fitting. Note that for some types 
of frames and graphs some of these options may be read only, that is, not user 
modifiable. There are five major control groups in this tab.

The first, under Axis Data Range allows you to specify that the axis data ranges 
are global. When enabled for an axis (either X, Y, Z, Colour or Size) this implies 
that the limits of that axis will be set to the minimum and maximum of all data in 
all graphs in the frame. Note that when these global options are set the axis 
property pages refer to all axes of the same type. Also the location of the property 
page shifts from the graph properties to the frame properties. 
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Also under Axis Data Range, are the controls for rescaling of axes. If the zoom 
fixed option is specified for an axis, then the minimum and maximum limits of the 
axis will not be modified when you data zoom in a graph. The normal behaviour 
when this option is disabled is for the axis range to be reset to the range of the 
data within the zoom window whenever you data zoom or pan. 

The options under Axis Annotations, allows you to control all axis annotation 
styles for all graphs in a frame. If an axis range is global, then it is possible to 
specify that the axis annotations are also global for that axis. When annotations 
are global, the axis in the workspace tree will appear underneath the frame rather 
than underneath the graph. Now, you can control the appearance of all axes in all 
graphs by editing the properties of one global axis.

The options under Axis Scaling, enables you to set the X and Y scale for all 
graphs in the frame. You can scale one or both axes independently. Note that 
when a document is being viewed in Normal mode scaling will be switched off – 
you need to switch to Page Layout mode to have your scale setting applied.

Axis Scaling also enables you to set advanced anisotropy and data fit properties 
in all graphs in the frame. When the XY(Z) Axes Isotropic option is switched on, 
the ratio of the axis ranges in X,Y (and Z) will be equal to one. For example, a 2D 
map is isotropic by default so that objects in maps do not appear stretched or 
distorted. By contrast, a profile is almost always anisotropic as the range of the Y 
axis is usually not of the same order as the X axis. A 3D graph is isotropic in X, Y 
and Z by default. Note that when the isotropic option is set then it is only 
necessary to specify the X scale as the Y scale will match it by default.

The scaling and isotopic options can affect the physical size of a graph on the 
page. Usually, a graph is as big as the frame in which it is embedded. If it is scaled 
or isotropic then its size is determined by the range of the axes and the scaling - 
the frame no longer controls the physical size of the graph. The Data zoom to fit 
cell option, when switched on, allows the software to modify the axis ranges so 
that the graph exactly fits the frame. For example, a 2D map with an image in it 
may be scaled at 1:50,000. With Data zoom to fit cell switched off the image may 
be larger than the frame in which the map is embedded and it may overlap other 
objects on the page. When Data zoom to fit cell is switched on the scale of the 
image does not change but the XY limits of the map is modified so that the map 
displays the image centred about the requested coordinates but clipped so that it 
does not overlap the frame.

Group Option Description

Axis Data Range X Range Global Range of all X axes is fixed to the minimum and 
maximum of all X axes in all graphs in the frame.
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Y Range Global Range of all Y axes is fixed to the minimum and 
maximum of all Y axes in all graphs in the frame.

Z Zoom Global Range of all Z axes is fixed to the minimum and 
maximum of all Z axes in all graphs in the frame.

Colour Range Global Range of all Colour axes is fixed to the minimum and 
maximum of all Colour axes in all graphs in the frame.

Size Range Global Range of all Size axes is fixed to the minimum and 
maximum of all Size axes in all graphs in the frame.

Axis Data Range X Zoom Fixed Fixes the X axis limits so that data zooming does not 
rescale the axis.

Y Zoom Fixed Fixes the Y axis limits so that data zooming does not 
rescale the axis.

Z Zoom Fixed Fixes the Z axis limits so that data zooming does not 
rescale the axis.

Colour Zoom Fixed Fixes the Colour axis limits so that data zooming does 
not rescale the axis.

Axis Annotations X Annotation Global When the X axis range is global, allows properties of 
all X axis annotations in the frame to be set in one 
place.

Y Annotation Global When the Y axis range is global, allows properties of 
all Y axis annotations in the frame to be set in one 
place.

Colour Annotation 
Global

When the Colour axis range is global, allows 
properties of all Colour axis annotations in the frame to 
be set in one place.

Axis Scaling X Scaled Define a specific scale in the horizontal direction.

Y Scaled Define a specific scale in the vertical direction.

XY(Z) Axes Isotropic Force the ratio of width to height in all graphs to be 
equal.

Data Zoom to fit grid 
cell 

Force graph data to expand or contract to exactly 
occupy a frame cell and prevent frame overlaps.

Group Option Description (Continued)
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Options Tab

The Options tab is used to control alignment of frame columns and rows as well 
as the data links that may exist with other windows. Data links control the method 
of updating related data in another display. For example, if a profile document has 
another window containing a map, if the data links exist, positioning the cursor 
and clicking in the profile document has a pointer presented in the map window 
to indicate the location of the same point.

Data range linking allows you to have graphs in different frames in the same or 
other documents in the application to respond to data zoom and pan events in an 
event source graph/grid. The Options tab is shown below:

Options tab and properties for data links

Group Option Description

Data Link Broadcaster  Axis LinksThe Broadcaster is used to transmit zoom and update 
messages to other window displays (documents). 
Either horizontal and/or vertical updates can be 
transmitted.

Respond to This View Response broadcast is to the Local, current document 
only.

Respond to Other 
Views

Broadcasts updates and communicates to all 
documents in the application.
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Appearance Tab

Control properties of frames are provided by the Appearance tab of the Profile 
Frame properties. The Appearance tab displays property controls that are used 
to view and manipulate the cells, columns and rows of a frame. A detailed 
description of the modes used for cell appearance and their meanings is provided 
in Cell Normal and Design Modes.

Profile Frame Appearance properties tab dialog

The Appearance tab is used repeatedly wherever a frame is used. Controls 
available include:

Group Option Description

Line Style Normal/Design mode These modes define the presentation style of the 
border, lines and margins of cells of a frame. See View 
Menu.

Cell Colour Transparent The background colour of a graph can be specified 
(using the Browse button. If Transparent is off, the 
graph uses the colour setting specified.

Cell Margins Top, Left, Right and 
Bottom

Used for offsetting the cell margin from the outer 
border by the amount specified. Units are millimetres.
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X Scale Tab

The X Scale tab properties for a profile frame are identical to the Y Scale 
properties if a Y Scale tab is available.

X Scale dialog tab properties

The axis properties control the scaling of the axis both in on-screen (Normal) and 
Layout modes. In particular the setting for scaling the axis is important for printing 
output at a specific scale. The options provided include:

• Fix Axis Range – Define a specific range over which the data is 
displayed. This range can be used in combination with the scale to 
produce an output of a specified size using a predefined range.

Resizing Mode Columns/Rows Size the columns and rows according to a Fixed 
amount, a data controlled amount (By Content) or 
freely for dynamic sizing.

Uniform Cell Width/
Height

If cells of a grid are to be kept equi-spaced either 
vertically or horizontally, select the Uniform Cell 
dimension.

Group Option Description (Continued)
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• Logarithmic – Scale the axis data logarithmically. Since it is not possible 
to have the Log of zero, a linear portion of the logarithmic scale is used in 
the transition of positive to negative values. The linear section can be 
specified as a power raised by base 10. Therefore, a power entry of 0 has 
a linear section from +/- 1.0. The drawn height of the linear section is set 
equal to one decade of logarithmic height.

• Scale the Axis – If enabled, displays the Layout display at the specified 
scale. This option has no effect if in Normal mode. If an inappropriate 
scale is used (that is, too small for the Page Setup), the graph display is 
extended off the page and indicates the printed join margin of multiple 
sheets of paper that are used for the required plot.

• 3D Exaggeration – If the profile is displayed 3 dimensionally, the vertical 
scale can be specified by the data entry or the slider bar.

• Horizontal Extent – The minimum and maximum values represent 
percentages of the space to be used for the plot within the internal 
boundaries of the plot area (see below).

2D Map Frame Properties

The Map Frame in a 2D Map display allows multiple maps to be contained in their 
own frame cells within the display. The Map Frame Properties dialog for a 2D 
Map display has three tabs:

• Axes Tab

• Options Tab (see Profile Frame Properties)

• Appearance Tab (see Profile Frame Properties)
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Axes Tab

The Axes tab of a Map Frame is designed to override the axis settings in all maps 
in the frame because of its level in the Workspace hierarchy. This provides you 
with an easy way to control the axis settings in all maps in a frame. The Axes tab 
is used to control the range and scaling of the X and Y axes. It also enables you 
to control axis annotations for all maps in a frame. Note that for some types of 
frames and graphs some of these options may be read only, that is, not user 
modifiable. There are three major control groups in this tab.

Axes tab for 2D Map Frame Properties.

The first, under X and Y Axes allows you to specify whether or not the axis data 
ranges are global, the axis annotations are global, the coordinate projection for 
the data contained within the Map Frame and the X and Y map scale. 

To define the coordinate projection of the map frame, enable the Coord Sys 
option and then either choose a projection previously used in Encom Discover PA 
from the drop-down list available or else press the Set Projection button to select 
the coordinate projection system from the list of available projections as shown 
below.
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Select a coordinate projection system from the available list.

Under the X Axis section you can define a specific X (Easting) range over which 
the data is displayed. This range can be used in combination with the scale (set 
at the top of the property dialog) to produce an output of a specified size using a 
predefined range.

X Axis Percentage Extent – The minimum and maximum values represent 
percentages of the space to be used for the horizontal plot within the internal 
boundaries of the plot area.

Under the Y Axis section you can define a specific Y (Northing) range over which 
the data in all maps within the Map Frame is displayed. This range can be used 
in combination with the scale (set at the top of the property dialog) to produce an 
output of a specified size using a predefined range.\

Y Axis Percentage Extent – The minimum and maximum values represent 
percentages of the space to be used for the vertical plot within the internal 
boundaries of the plot area.

3D Map Frame Properties 

The Map Frame in a 3D display allows multiple 3D Map displays to be contained 
in their own frame cells within the document window. The Map Frame Properties 
for a 3D display has only one tab dialog:

• Appearance Tab (see Profile Frame Properties)
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Appearance tab for 3D Map Frame Properties.

See also:
...Creating 3D Displays
... 3D Map Properties
...Profile Frame Properties

Profile Properties

Data, axes, title, graph appearance, axis arrangement and selection properties 
are available within a profile. In addition to these six property pages, the Y axis, 
Colour axis and Size axis properties are often available from this branch.

• Data Tab

• Axes Tab

• Title Tab

• Appearance Tab

• Arrangement Tab

• Y Scale Tab

The Profile branch of the Workspace toolbar represents the graph within a 
frame of a document. The tree item shows the line being used (in this case line 
3721). It also indicates the number of the graph in the frame. 
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• Colour Scale Tab

• Colour Table Tab

• Size Scale Tab

Data Tab

Data source tab dialog for profiles

The Data tab provides a method of setting the line and dataset source for all 
components of the profile. See Accessing Data with Encom Discover PA for 
information on accessing different data sources. The Dataset specification refers 
to the source database. Encom Discover PA can access any number of 
databases and is able to display data fields from multiple datasets within a profile 
or profile frame. Selection of the dataset is via a pull-down list. Datasets may not 
always share common lines. If the selected line for the profile is not found in a 
dataset, that dataset is marked with a red cross. Otherwise it is marked with a blue 
tick. If the profile contains data from datasets that do not share the specified line, 
the profile becomes invalid and no data content is displayed.

.
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The Line setting can also be specified from a pull-down list. It displays all lines in 
the selected dataset. The nominated line is used as the source for all data, 
scaling, annotation etc.

Axes Tab

The Axes tab used by the Profile level of the Workspace hierarchy is almost 
identical to the Profile Frame Axes Tab. Generally, if an option is set in the profile 
frame axes tab, then the equivalent option is set and read-only in the profile axes 
tab. In other words, if an option is set for the frame, then it is set for all graphs in 
the frame. If an option is set for a graph, it is set for all applicable axes in the 
graph. If it has not been set in this way, the option is available to the user in each 
individual axis property page.

From this property page you can set the following axis options:

• Axis range can be global – All axes in the profile are forced to have the 
same range. Usually, this range is the global range of all data plotted 
against the axes.

• Axis zoom can be global – When switched on, the data zoom range is 
calculated from the whole line regardless of the user specified data zoom. 
So, when the user data zooms to a portion of the line, the axis range 
remains fixed to the range of the whole line.

• Axes can be global to the graph – If set, the annotations for the 
specified axes become children (at a lowevel of the hierarchy) of the 
profile in the Workspace tree. It is a time saver option that enables you to 
set axis properties only once when you have multiple axes to annotate. It 
is only available if the axis range is set to global for the specified axis type.

• Scaling – X and Y axis scaling can be individually specified.

• Isotropic X and Y axes – Ensures that one unit in X equals one unit in Y 
on the page.

• Data zoom to fit cell – When enabled, the profile range is modified to 
ensure that the graph fills the cell in which it is embedded. If not enabled, 
the profile shrinks and stretches to fit the data zoom and scaling.
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Title Tab

The Title tab allows control over the positioning, style and content of a single 
graph title. You can show or hide the title (Show Graph Title), select a text style 
and colour (Font button) and set the title content. The title can be located where 
desired. The title text can be directly typed or you can request Encom Discover 
PA to enter text strings as Variable Substitutes. A wide range of variable strings 
can be used and these are substituted for logical text (if available) at the time of 
drawing. A preview of the final title text is displayed beneath the coded title string 
as shown:

Variable Substitutes

Variable Substitution assists you to label graphs by substituting text items that 
may be variable in nature. For example, the line name for a profile may need to 
be altered for each update of the profile. 

Substitution strings are automatically created for you if you use the Add button to 
append a variable. The substitute name is enclosed in % characters. The case is 
not important. Many other substitution variables are also available. 

Variable Description

NAME Data field name. NAME is the field name as reported 
in the name channel in the spreadsheet.

PROPNAME Data field name derived from properties specifiers. It is 
the field name recorded in the properties file.

ALIASNAME Some data channels can have aliases and these can 
be used to name the data presented.

DBASENAME The database file name. the true field name stored in 
the database.

FULLNAME The full field name contained in the source database. It 
is a constructed name combining the database name 
and the field.

UNITS Units of the data channel if available. UNITS is a string 
derived from information in the properties file.
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Title Positioning

The title can be positioned anywhere in a profile area. It can be automatically 
positioned using the Offset switches, justification flags and text anchor. When the 
Offset switches are enabled, the title is positioned relative to the data plotting 
area. Otherwise, it is relative to the edges of the profile. For final adjustment, a 
manual page offset setting is available which moves the title X and Y millimetres 
from the specified plotting position.

Graph title position

Appearance Tab

Each profile graph exists within a profile container (or frame). It occupies one cell 
of this frame (see Working with Graphical Objects). A frame cell has an inner 
margin specified in millimetres, that can be set in the Appearance property dialog 
of the Profile Frame. By default, this inner margin is set to zero. 

Surrounding the profile frame is its own outer and inner borders. The outer border 
is used for registration with the enclosing cell and the inner border forms the 
enclosing extent of the data limits (see the diagram below). If the frame cell inner 
margins are zero then the plot outer border plots coincident with the frame border. 
For this reason, the plot outer border is not shown by default.

LINE The line name of the source profile.

BANDNAME Data channel used as the source for the profile.

DATASET The name of the database source.

GRAPHNUMBER The incremental number used for each profile graph.

ANNXNAME X axis assigned name.

ANNYNAME Y axis assigned name.

ANNCNAME Chordlength axis assigned name.

Variable Description (Continued)
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Cell boundaries relative to profile inner and outer boundaries

The appearance of the frame borders, background and margins within its frame 
cell are controlled by the Appearance property page. 

The Profile Appearance tab dialog

You can show or hide the inner and outer plot borders of the frame and alter the 
line styles of these borders. If Show Background is enabled, the profile has 
background colour. By definition this means the profile is no longer transparent 
and over-plots underlying objects. You can specify the colour of the inner plot 
area and outer plot margins separately.



250 Encom Discover PA User Guide

The size of the outer plot margin (specified in millimetres) is generally determined 
by what axis annotations are displayed in the margin. However, you can specify 
the minimum size of the outer margins from this property page. The inner plot 
margin is a redundant feature that allows you to define a margin within the plot 
data area. These offsets can be used in combination with the Grid Cell margins 
that are definable in the Appearance tab.

For 3 dimensional displays (other than profiles) you can also have a 3D box 
surrounding the area of the presentation.

Arrangement Tab

The profile Arrangement property page defines what rules are used to position 
axis annotations when those annotations are automatically positioned by Encom 
Discover PA.

Profile axis Arrangement tab dialog

A description of the various axes used in Encom Discover PA is provided in Axes 
Tab.

Each axis type (X, Y Colour and Size) is assigned a Padding value, specified in 
millimetres. This is the amount of page space that is automatically be assigned 
for this axis. Encom Discover PA will adjust the profile outer margins appropriately 
to make room for this axis.
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Each axis can be positioned according to the rule specified in the Anchor setting. 
The possible settings are top, bottom, left, right and alternate. If top or bottom 
options are specified for an X axis then all X annotations are placed in the 
specified position relative to the plot area. If there are multiple axes then they are 
stacked from the inside out. Similar rules apply for the Y, Colour and Size axis 
annotations except that these annotations are all vertical and can therefore be 
placed at the left or right. If alternate is selected then annotation will be placed on 
the top and bottom, or left and right, alternately.

If the Pin to Edge setting is enabled for an axis type, then annotations will be 
pinned to the outer plot border rather than the inner plot data border. 

Padding between labels and axes can also be controlled from the Shrink 
padding options.

Y Scale Tab

The Y Scale Properties tab is similar to the X Scale tab that is generally 
accessible from the Profile Frame object. Typically, this tab is used to specify a 
fixed data range for the Y axis or to set the axis to linear or logarithmic mode.

Y Scale profile properties tab

Other items available are equivalent to options available on the Scales tab of the 
profile or profile frame. Global Range from Unclipped Data is equivalent to Y 
Zoom Global and if enabled ensures the data range of the axis spans the entire 
data range of the traverse line displayed in the profile, regardless of any data 
zoom.
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The axis can also be scaled, however usually it is set at a more global level either 
in the profile or the profile frame. Note that only one axis is used for scaling and 
it is the last axis in the profile for which scaling is enabled. Logarithmic scaling is 
also available. Since it is not possible to have the Log of zero, a linear portion of 
the logarithmic scale is used in the transition of positive to negative values. The 
linear section can be specified as a power raised by base 10. Therefore, a power 
entry of 0 has a linear section from +/- 1.0. The drawn height of the linear section 
is set equal to one decade of logarithmic height.

The Y Axis Vertical Extent is specified as a percentage of the plot data area. 
Usually, it covers 0 – 100 % of the data range and extends over the entire plot 
area. However, you can set the upper and lower extents to restrict the size of the 
Y axis. All annotations of this axis also have a restricted extent. Use this option to 
spatially separate multiple Y axes in a profile. Note that the same option is 
available for X axes but for Colour and Size axes the option is set for Colour and 
Size Scales individually.

The axis can be Reversed such that the minimum and maximum ends of the 
drawn axes are swapped. The axis can also be made Isotropic in conjunction 
with its parent X axis. This option is not used often with profile displays since an 
isotropic setting forces equal horizontal and vertical scaling. This is a useful 
feature where the vertical:horizontal exaggeration needs be unity for cases such 
as drillhole targeting with distance versus depth graphs. Again, only one axis can 
be isotropic in a profile and the axis used is the last axis found to have the option 
enabled. 
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Colour Scale Tab

The Colour Scale tab is used to control the colour data range within a profile. 
Typically, this tab is used to specify a fixed data range for the Colour axis or to set 
the axis to linear or logarithmic mode.

Colour Axis scaling tab

Options available include:

• Fix Axis Range – Define minimum and maximum colour limits.

• Zoom Fixed – Allows data zooming of the profile but does not alter the 
colour range.

• Logarithmic – Display the assigned colour range logarithmically with a 
linear portion around zero.
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Colour Table Tab

The Colour Table tab is used to modulate the actual colours displayed in a profile. 

Colour Scale control dialog tab

The colour scale uses three methods of colour definition across a definable 
number of colours (defined in the Total Colours item).

• RGB Interpolation – Uses the hexadecimal Red:Green:Blue specification 
of colour. 

• HSL Interpolation – The Hue:Saturation:Luminosity colour model is 
used.

In both colour mapping schemes a predefined colour palette is available. 
This palette can be reset by clicking the Set Default Colours button. You 
can control the upper and lower colours of the colour scale by selecting 
the Colour Browse buttons at the top or bottom of the displayed colour 
bar. This option displays a standard Windows colour selection dialog.
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Windows colour selection palette

• Legend/Look-up Tables – The third method of assigning colours is to 
use predefined look-up tables OR, as is used in certain circumstances, 
patterns and colours. Such circumstances include assigning legend 
patterns and colours to drillholes, drawn polygons (features) or legends.

To maintain colour look-up and legend tables, two editors are provided 
with Encom Discover PA. Descriptions of these are in the Colour Table 
Editor and Legend Editor. Access to the Colour Editor is from the Edit LUT 
button.

• Look-Up Tables – Supported LUT formats include ER Mapper, 
Geosoft montaj, MapInfo and Surfer. The file formats are listed in 
Appendix E: Supported File Formats and described in Appendix B: 
Data File Specifications.

• Legend Tables – These tables use a combination of line styles, 
colors and patterns. A range of legend files are provided when 
Encom Discover PA is installed, but you can modify, create or 
manage your own. Modification of legend files is done using the 
Legend Editor (see Legend Editor).

Colours can be limited in the Colour Mapping entry to any number 
supported by the selected Look-Up Table. Additionally if you wish to 
Reverse the Colour Table, this has the effect of re-assigning colours and 
their data values in reverse order. This option is useful if data values are to 
be displayed in a reverse sense, for example if resistivity is to be 
displayed as conductivity. 

It is useful to also import and export LUT tables. This can be done with the 
Colour Editor or the Export LUT Map options.
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Size Scale Tab

The use of the Size Scale is described in Axis Properties. The Size Scale is used 
to control the size of modulated data symbols. The properties associated with the 
Size Scale are similar to those of the X Scale Tab and Y Scale Tab.

Size Scale tab dialog

You can define the Size Range of all symbols plotted against this size scale and 
also the units of the symbol size. Available units include Millimetres, Page Points, 
Screen Points and Percentage (see Size Units).

Axis Properties

Axes can be global to the profile or to the profile frame to simplify specification of 
axis properties across multiple axes or multiple graphs.

Note Look Up Tables and Legend Tables are installed into the folder \PROGRAM 
FILES\ENCOM\ENCOM\COMMON\LUT. If patterns are used with the Legend 
Tables, these are also stored in a common folder called \PROGRAM 
FILES\ENCOM\ENCOM\COMMON\PATTERNS.

Each axis in a profile can be graphically visualised by adding one or more 
appropriate axis objects. They appear in the Workspace tree as lower branches 
of the associated axes.
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The properties associated with each axis type are essentially identical. There are 
five property pages:

• Data Tab

• Appearance Tab

• Title Tab

• Divisions Tab

• Ticks Tab

The Axes tabs control the style, position and title of the axis as well as tick 
divisions, labels and tick style.

There are four basic types of axes – X, Y axes, Colour axis and Size axis.

A fifth type of axis is an X Y internal axis. These axes are used to draw internal 
ticks or lines in a graph and can be used to display geographic and local grid axes. 
It can be added to a graph from a Y axis (or visible Y axis parent if the Workspace 
tree is concise). The Internal Annotation option is described in Internal Axes and 
Annotation.

Data Tab

The Axis Data tab (accessed from either the X-Axis or Y-Axis levels of the 
Workspace tree) specifies the source of the data used for axis annotation. The 
annotated data field can be automatically chosen by the software, or can be 
explicitly specified. This balance of user and software control is specified by the 
options on the style property page. 

• The Simple setting uses the X channel for both the data positioning and 
label annotation. For some axes and graphs the data used may be system 
defined. For example, in a profile the X data is always Projected Distance. 
In a map the database X channel (Easting) is always used.

• The Data Dependent setting allows the user or the software to assign a 
channel for axis annotations (such as Fiducial, Easting or Northing). If this 
is selected and the modification applied, up to two new objects will appear 
in the workspace tree under the Axis object – Range and Value data 
objects. Ticks will be drawn according to Range posted according to 
Value.
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• The Select Value setting allows the system to choose appropriate Range 
and Value channels from the database. For example, it may choose 
EASTING as the Value channel in a profile displaying a line that is 
approximately east-west.

X-Axis Data dialog tab

If a specific Data Dependent channel is to be used for axis labelling and plotting 
(such as Fiducial), deselect the Select Value option (so Encom Discover PA does 
not choose it for you) and then choose the Field you wish to use for axis 
annotation. Note that this option is only visible when the Data Dependent item is 
selected. Also note that the specified field is shown in the properties of the X-Axis 
level of the Workspace tree.

Using this control it is also possible to have multiple horizontal axes for the one 
profile. For example, along a profile track may be a location axis (eg Easting) and 
a second axis that indicates Fiducial or timing.
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Combined axes for one profile showing Easting and Fiducial annotations.

Appearance Tab

The Axis Position controls the location and style of the axis. These controls are 
identical for all axis types. 

• Axis Position – This can be automatically defined by the program, or if 
you wish, an anchor position with an associated offset can be used. The 
anchor is relative to the profile boundary and can have a percentage offset 
(see Size Units).

The Axis Position tab dialog

• Axis Style – This controls the appearance of the axis bar. All axes are 
comprised of a bar, ticks, and tick labelling. The bar may be a line or have 
finite thickness. Colour, style, width and thickness units can all be 
controlled. You can also control the vertical extents of Colour and Size 
axes from here.
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Title Tab

The title of an axis is controlled by the Title tab. By default, Encom Discover PA 
uses the data field name of the displayed data using a Variable Substitute. A 
description of the use of titles is provided in Title Tab.

The position of the title text relative to the axis is available from the options in the 
Axis Title Position entries.

Axis Title Positions of the Title Tab

Divisions Tab

An axis has ticks and tick labels. The tick marks are subdivided into major and 
minor types. The Division tab specifies the interval used for both Major and Minor 
intervals. These intervals control both the labelling interval (if enabled) and the 
tick interval (if enabled using the Ticks Tab).

The Axis Division tab
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The property page specifies both Major and Minor divisions. Specific major 
division interval can be specified or use the optimised suggestions provided by 
Encom Discover PA. Minor divisions are specified as divisions per major division.

Ticks Tab

The Axis Ticks tab is used to control major and minor tick style as well as grids 
and labels. An example of each of these is shown. 

Ticks can be drawn Across, Inward or Outward (from the data) and have a 
specific length. The line style can also be chosen.

Grids extend across the plot area and can have styles similar to ticks. Labelling 
for both major and minor divisions has a format dialog (as shown). 

X-Axis Ticks tab dialog and label format dialog

Axis bar

Axis label

Ticks

Grid lines
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The control enables labels to be written as required using formatting and position 
control. The label orientation and style (Format button – see Label Tab) can also 
be specified. The Font button allows specification of the text style.

The location of the labels relative to the axis allows combinations of centre or end, 
Inward or Outward from the plot area, and horizontal or vertical text strings. The 
option, Show at Axis Limits, forces annotation values to be displayed at the top 
and bottom of the axes.

Internal Axes and Annotation

Any supported Encom Discover PA display can have internal axes. Usually this 
takes the form of tick marks.

Two example profile displays with internal tick mark annotations of ticks (top) and lines 
(bottom).

The tick marks for internal axes can be controlled and local or geodetic 
projections applied. The ticks can be also annotated. Internal ticks or lines can 
also be used in profiles, graphs or scattergrams. In these cases, geodetic 
projection is available but generally is not applicable.
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For any of the display types, internal axes can be added by:

1. In the Workspace tree, highlight the Map, Profile, Graph or Scattergram 
item and while selected, press the right mouse button.

2. From the pop-up menu, select the Add Axis>XY Internal Axis option.

3. A new XY Internal Axis level is added to the Axis (see tree diagram)

From the highlighted XY Internal Axis branch, the properties dialog can be 
displayed. Four tabs are provided and these are:

• Internal Annotation Tab – Controls data conversion between graph 
coordinates and tick coordinates.

• Ticks Tab – Defines the tick and line format, divisions, style and 
annotations.

• Local Tab – Defines a transformation from graph coordinates to a local 
coordinate system or vice-versa.

• Geodetic Tab – Allows specification of a projection and a spheroid to 
define a transform from graph coordinates to geodetic coordinates or vice-
versa.
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Internal Annotation Tab

This property page specifies what type of data conversion between graph 
coordinates and tick coordinates is to be applied prior to plotting the ticks. For 
example, maps usually have an Easting/Northing axis range that can be 
presented and displayed as Latitude/Longitude once converted to a relevant 
projection and spheroid.

Internal Annotation tick control dialog

The option you select depends on the type of data in the X and Y fields of the 
graph (eg Eastings/Northings, Latitude/Longitude, Local Grid) and the coordinate 
system you want the ticks to be plotted in. The options include:

• Use unmodified axis coordinates – This option uses the X and Y data 
retrieved directly from the selected database. No location transformation 
is performed.

• Convert axis coordinates to Local Grid – This option uses the X and Y 
data retrieved directly from the selected database and then applies local 
grid transformation defined by the data in the Local Tab.

• Convert axis Easting/Northing to Latitude/Longitude – This option 
uses the X and Y data retrieved directly from the selected database and 
then applies a transformation defined by the data specified in the Geodetic 
Tab.
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• Convert axis Latitude/Longitude to Easting/Northing – This option 
uses the X and Y data which must be in a geodetic coordinate system 
within the selected database and then applies a transformation to a grid 
coordinate system using the data specified in the Geodetic Tab.

Ticks Tab

Control the appearance of Internal Annotations from this property page.

Tick control tab for Internal Annotations

• Tick Style – Either ticks or lines can be displayed. Lines are often used in 
profile, graph or scattergram displays. The size of the ticks (in millimetres) 
and linestyle can also be specified.

• Divisions – Major, minor or specific divisions with a definable increment 
can be chosen. Note that if a Latitude/Longitude output is expected the 
format must be in dd mm ss format (e.g 147o 58’ 21” entered as 147 58 
21).

• Annotation – The annotation text can be located at the Bottom/Left, Top/
Right, both or neither. Text style can be modified by clicking the Font 
button.
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Local Tab

Internal annotations can be plotted after a transformation from axis coordinates 
to a local grid. Axis coordinates are transformed to Local grid coordinates by 
translating the axis coordinate origin to the local grid origin and then rotating 
anticlockwise by the defined azimuth angle (in degrees).

The property page for the Local grid transformation is shown below:

Local coordinate and offset of Internal Annotation ticks

Geodetic Tab

Encom Discover PA can display maps using most projections of the Earth. 
Geodetic projections are used to control the axes of map displays. The Geodetic 
options are available on the Geodetic property page. Here they can be set for 
each axis individually. In addition, there are default geodetic coordinate system 
settings which can be accessed via the Tools>Options menu. It displays the 
following property tab.
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Options tab (in Tools>Options menu item) that is identical to the Geodetic tab of Internal 
Axes

The operation of the Geodetic tab is to convert the source data coordinates and 
display the output in an alternative, Target coordinate system. Use the Change 
button to define the Projection (Category) and Datum (Category Members) 
required from the available lists. 

Set the Category member information for the required Projection

See Map Projections for additional information. Using the geodetic options with 
map internal axes is described in Internal Axes.
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Map Projections

Encom Discover PA has built-in Map Projection information that supports a wide 
range of projections in use across the Earth. To fully specify a Map Projection, 
both the PROJECTION (called a Category) and DATUM (Category member) for 
a map must be specified. Grid Groups that have the same Map Projection (that 
is, the same Projection and Datum) can be automatically registered if they are 
derived from an ER Mapper algorithm.

Note too that a utility is available to transform data from one projection to another, 
which is described in Database Coordinates Reprojection.

Projections support is provided in Encom Discover PA from an ASCII file (called 
ENCOM.PRJ stored in the folder \PROGRAM FILES\ENCOM\ 
COMMON\PROJECTIONS).

You can add your own coordinate system definitions to the end of this file. 
Categories must begin with the string "--- Name ---" where Name is the name of 
the category. Each member within the category is a single line with the following 
format:

"Name",projection_code,datum_code[,units_code][,origin_lon]
[,origin_lat][,std_parallel_1][,std_parallel_2][,azimuth]
[, scale_factor][,false_easting][,false_northing][,range ]

The parameters following the projection code are specified in the following table:

Code Name D U O L 1 2 A S E N R

1 Longitude/Latitude • · · · · · · · · · ·

3 Lambert Conformal Conic • • • • • • · · • • ·

4 Lambert Azimuthal 
Equal·Area (polar aspect 
only)

• • • • · · · · · · •

6 Equidistant Conic (also 
known as Simple Conic)

• • • • • • · · • • ·

8 Transverse Mercator (also 
known as Gauss-Kruger)

• • • • · · · • • • ·

9 Albers Equal-Area Conic • • • • • • · · • • ·

10 Mercator • • • · · · · · · · ·
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Where:

11 Miller Cylindrical • • • · · · · · · · ·

12 Robinson • • • · · · · · · · ·

13 Mollweide • • • · · · · · · · ·

14 Eckert IV • • • · · · · · · · ·

15 Eckert VI • • • · · · · · · · ·

17 Gall • • • · · · · · · · ·

18 New Zealand Map Grid • • • • · · · · • • ·

20 Stereographic • • • • · · · • • • ·

24 Transverse Mercator 
(modified for Finnish KKJ)

• • • • · · · • • • ·

25 Swiss Oblique Mercator • • • • · · · · • • ·

26 Regional Mercator • • • · • · · · · · ·

27 Polyconic • • • • · · · · • • ·

29 Lambert Azimuthal-
Equal·Area

• • • • · · · · · · •

30 Cassini-Soldner • • • • · · · · • • ·

Projection codes
D = Datum
U = Units
O = Origin of Longitude
L = Origin of Latitude
1 = Standard Parallel 1
2 = Standard Parallel 2
A = Azimuth
S = Scale Factor
E = False Easting
N = False Northing
R = Range

Unit codes:
0  = Miles
1  = Kilometres
2  = Inches
3  = Feet
4  = Yards
5  = Millimetres
6  = Centimetres
7  = Metres
8  = Us Survey Feet
9  = Nautical Miles
30 = Links
31 = Chains
32 = Units_Rods

Code Name D U O L 1 2 A S E N R
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Predefined datum codes and ellipsoid codes are as defined in the MapInfo 
Professional documentation. 

User-Defined Datums

If you wish to define your own projection, spheroid and datum coordinate system 
the following applies:

• If datum_code = 999 then it is a user-defined datum and these 
parameters must follow it:

ellipsoid_code, dX, dY, dZ

• If datum_code = 9999 then it is a user-defined datum and these 
parameters must follow it:

ellipsoid_code, dX, dY, dZ, Ex, Ey, Ez, m, 
prime_meridian

• If datum_code = 99999 then it is a user-defined datum and these 
parameters must follow it:

ellipsoid_A, ellipsoid_InvF, dX, dY, dZ, Ex, Ey, Ez, m, 
prime_meridian

Examples of User-Defined Datums

"AMG Zone 55 (AGD 66) 3-param datum shift", 8, 999, 2,  -133, -48,  
148, 7, 147, 0, 0.9996, 500000, 10000000

"AMG Zone 55 (AGD 66) 7-param datum shift", 8, 9999, 2,  -117.808, -
51.536, 137.784, -0.303, -0.446, -0.234, -0.290, 0, 7, 147, 0, 0.9996, 
500000, 10000000

"AMG Zone 55 (AGD 66) 7-param datum shift", 8, 99999, 6378160.0, 
298.25,  -117.808, -51.536, 137.784, -0.303, -0.446, -0.234, -0.290, 
0, 7, 147, 0, 0.9996, 500000, 10000000
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Label Properties

Common to many dialogs, it is possible to format the appearance and style of text 
labels. These labels are used for automatically assigning the presentation style of 
number labels in locations with axes, titles and line numbers etc. Usually the label 
style dialog is displayed from a Format button. The dialog appears as below:

Number and text label format specification

The dialog gives control for the Numeric Formatting to be:

• General – Catering for most numeric values (both negative and positive)

• Scientific – For example, 1.2345679877e+006

• Automatic – Creating the best suited available number representation

• DMS (Decimal) – For example, -34.2756 latitude

• DMS (Latitude) – For example, -34:27:53.2

• DMS (Longitude) – For example 143 56 16.8

The number of Decimal Places can be specified and a comma can be used 
(instead of the full stop) as a 1000 Separator.

A Prefix and Suffix (for example, nT, dd:mm:ss, Feet) could be added to the 
numbers. A preview example in the dialog provides a sample of the output format.
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Curve Properties

A graph can contain as many Curve objects as required. The Curve properties 
dialog contains property pages, which control data source (globally), line styles, 
symbols styles, symbol rotation and symbol labels.

• Data Tab

• Fields Tab

• Line Style Tab

• Symbols Tab

• Label Tab

• Transform Tab

• Decimation Tab

For additional information on defining curve objects, see:

• Data Specification

• Modulating Data

Data Tab

The Data tab allows the user to select the dataset and line for all data fields in the 
Curve. Note that an identical Data source is available in the Profile properties (see 
Data Tab). The difference between the tabs is one of scope – the profile Data tab 
applies it settings to all objects in the profile whilst the Curve data tab applies it 
settings only to the Curve. Note that in a Profile there can be only one line and so 
changing the line at any level changes the line for the profile globally. See 
Accessing Data with Encom Discover PA for information on accessing different 
data sources. 

A Curve branch can display multiple curves from a multi-banded data source. It 
can display the data as a colour modulated line, filled above or below a specified 
level. It can also display symbols at each data point. The symbols can be colour, 
rotation and size modulated. Symbols can display a label that can also be data 
modulated and rotated. The curves can be added to a reference data channel to 
allow for topographic offset.
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Data source dialog tab for Curve properties

The Data tab provides a method of setting the line and dataset source for all 
components of the Curve. See Accessing Data with Encom Discover PA for 
information on accessing different data sources. Also see Fields Tab for channels 
specification of data. The Dataset specification refers to the source database. 
Encom Discover PA can access any number of databases and is able to display 
data fields from multiple datasets within a profile or profile frame. Selection of the 
dataset is via a pull -down list. Datasets may not always share common lines. If 
the selected line for the profile is not found in a dataset, that dataset is marked 
with a red cross. Otherwise it is marked with a blue tick. If the profile contains data 
from datasets that do not share the specified line, then the profile will become 
invalid and no data content is displayed.

The Line setting can also be specified from a pull-down list. It displays all lines in 
the selected dataset. The nominated line is used as the source for all data, 
scaling, annotation etc.
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Fields Tab

When a database is accessed, it usually contains a number of data fields 
(channels) that can be used for display. These channels can be specified from 
either the Fields tab or the Y data band specification described in Data 
Specification. Both data specifications do the same thing but the Y data band 
specification allows additional control in multiple channel situations.

Specification of a data channel in the Fields tab

Where appropriate, additional data fields (such as Offset) can also be specified 
from the Fields tab. Note too that any changes to the data channel specification 
update the Curve immediately if the AutoApply option is enabled.

You can select the relevant data channel field from a required database. In 
circumstances where you have more than one database open, you may need to 
use the Data tab to select a different database before having access to the 
correct data field. In the case of multiple bands within a data field, you can use 
the Browse button to select the required channel range (see Data Specification). 



10 Display Properties 275

Line Style Tab

The Line Style tab controls the appearance of all curves in the Curve profile. 
Curves can have different colours, style, thicknesses and modulated colour. 

Data profiles can be filled by colour. The fill can be above and/or below a specified 
level. The level to control a fill can be specifically defined, data minima, maxima, 
median, mode or average. 

An additional control of this dialog (Apply Major Interval Style ) provides the 
ability to automatically divide multiple band datasets into major and minor line 
styles at a controlled interval (see example above). This means that one line style 
can be used for major data traces, but say, every 4th trace in the selected bands 
has a different style. 

Line styles can be specified with a thickness, pattern and colour. Use the 
Default Line Style button of the Line Style dialog to specify the required colour. 
The line patterns include Solid, Dashed and Dotted.
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Curve profile Default Line Style controls

Rather than individually select each band to have a specific colour, the software 
can be used to automatically Cycle unique colours if required. Alternatively, the 
colour data channel used for the data display can Modulate line colour of the data 
line. If appropriate, different colours (using the Lookup Table/Legend selection) 
can also be used to vary curve types. Colours can also be edited to adopt a 
specific look-up table modulation. See Colour Table Editor for additional 
information.

Symbols Tab

The representation of the data source (see Data Tab) by symbols can often be 
used to advantage. 

The Symbols tab enables each (or a sub-sample of) data points along the profile 
curve to have a symbol displayed. Available controls include:

• Selection of a single symbol type from the available fonts installed.

• Cycle the available symbols (if displaying multi-banded data curves).

• Define the size of the symbols using one of the various supported Units.

• Cycle the colour of symbols automatically.

• Skip a number of readings to locate symbols are displayed. This is 
especially useful for densely sampled datasets.
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• Use an external data field to control the appearance of the symbols (for 
colour, size, rotation and labelling). This is described in Modulating Data.

Symbol control dialog tab

To access this dialog ensure the Show Symbols option is ticked. 

Symbol Selector dialog

To customise the symbol display, click in the Symbol box. This opens the Symbol 
Selector dialog. A range of symbol libraries is available from the pull down list at 
the top of this dialog, with the selected symbol previewed to the right. The symbol 
colour and size can also be altered here. 
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To Modulate Colour activate the tick box, select the data field from the drop-down 
list to use for the modulation and a colour look-up table or legend to use. See 
Colour Table Editor for more information.

To Modulate Size activate the tick box, select the data field to use for the 
modulation from the drop-down list and enter a range for the minimum and 
maximum modulation size. 

To Modulate Rotation select the data field to use for the modulation and enter 
the angle and scale. The rotation of modulated symbols can use either radians or 
degrees anti-clockwise.  

If the data channel specification is left blank, an un-modulated rotation is applied. 
In this case all symbols are rotated by an equal amount as specified. If Modulated 
rotation is used, it is necessary to specify the data field to use for modulation. This 
is done by clicking the Browse button or from the pull-down list. The rotation of 
modulated symbols can use either radians or degrees anti-clockwise.

Displaying Line Stations

From the Symbols tab enable the Show Symbols tick box to add Station Points  
to a Profile display. This option is used when data points are to be displayed in a 
Profile or Graph. Symbols Tab has many of the properties available for the Line 
Style tab, such as Modulate Colour, modulate Size and some additional 
parameters such as applying a Rotation angle and skip factor. To display only 
station points without the joining line of the curve profile  disable the Show Line 
tick box in the Line Style tab dialog of the Curve Properties.

Use this option when data is randomly distributed or needs to be shown with only 
symbols displayed by default.

The symbol colour and border can also be changed using the Line Colour (for 
Built-In symbols) and Fill Colour buttons in the Symbol Selector dialog, 
accessed by clicking on the Symbol button shown to the left. The Skip value 
entered determines what interval of point data samples is displayed in the curve. 
For example, to display every 5th point data sample enter a Skip value of 5. 
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Label Tab

Labelling data points in a graph is useful in applications where actual data values 
are significant. The data source used for labels is specified in the properties 
dialog. If no symbol is desired, an empty symbol is available for selection. The 
dialog provides control for the labels to be formatted, applied with a skip interval, 
anchored relative to the plotted data point or offset from this. Rotation of the label 
text is also possible.

The dialog used for the Label properties is shown below. If modulating of labels 
by another data field is required (see Modulating Data), select the data channel 
from the pull-down list after enabling the Show Labels item. 

Label control and formatting properties dialog
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The format of the posted labels can be specified from the Format button. See 
Label Tab for information on specifying number formats. 

The format of the data value (selected from the Set Data button) can be Decimal 
(of a set number of characters) or Compact. Compact formatting allows the 
software to choose the most appropriate format (such as scientific notation) if the 
allowable text size causes excessive over posting.

Transform Tab

The Transform tab of the Curve dialog allows you to apply a single data offset 
(additive) or multiplicative factor or real-time filtering and transformation. This 
function can be of use to scale data before it is displayed or to match other data 
channels without having to apply different scaling.

To enable the Transform operation, select it and then apply one or both of the 
Scale (S) and Translate (T) values. Ensure the Apply Transform setting is Scale 
and Transform. The transformation is applied using the formula:

X’ = X*S + T

Note the transform can apply to multiple bands of a data channel.

Transform dialog allowing the specification of an offset and transform factor
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Additional transformation types include Progressive and Reverse Progressive 
Transforms. These transformations are especially useful where an offset is used 
to better display data across multiple data channels. For example, where profile 
traces overlap or have different scaling, you can apply a Progressive 
Transformation and this will add an offset to the data. If, for example, a Reverse 
Progressive Transformation was used with say 10 data channels in an arrayed 
field with a Translation factor of 1000, then:

Channel 10 would have zero added to it

Channel  9  would have 1000 added to it

Channel  8 would have 2000 added

...

Channel 1 would have 10,000 added to it.

The opposite order would be true for a Progressive Transformation. An example 
of using a Reverse Progressive Transformation used with EM data and a 
Transformation factor of 1,000 is shown below.

The same profile with untransformed, original data plus transformed data below

Note The vertical axis of a transformed display becomes affected by the transform 
applied and as such, may be meaningless when used to directly scale data 
values.
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Real-time filtering can also be applied to specified data. You can select Moving 
Average Smoothing, or Gaussian Smoothing. In both cases, a filter width is 
required to specify over how many data samples the operator is applied. Filtered 
displays can be useful when displayed as two graphs superimposed so the 
filtered and unfiltered results can be directly compared.  

Decimation Tab

A range of decimation schemes are available to compress the amount of data 
displayed in a curve. This option allows high resolution data to be displayed 
without every readings used in the plotting. By default, no decimation is applied 
but a fixed rate of decimation or an arithmetic compression factor can be applied. 

Decimation tab of the Curve Properties

Data Specification

In general it is possible to specify X, Y, Colour, Size, Rotation, Label and Offset 
multi-banded data fields for a Curve. However, depending on what type of graph 
the Curve is embedded in, some of these fields may not be available for selection. 
In a Profile, the X field is not selectable. In a Map, the X and Y fields are not 
selectable. In these cases the system chooses the data field.
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The data displayed in a profile is controlled by the Y branch entry of the Curve. 
The data field used to specify the data used in the profile uses a property dialog 
as described in Data Tab. If colour modulation is required, the colour data field 
must also be defined. By default, it uses the first available data field and is initially 
identical to that of the Y data specification.

If a multiple band field is selected for the data input to the Curve, each individual 
band can be controlled by expanding the Y field. 

The properties of each band can be individually controlled if required. This is not 
usually necessary since sufficient controls are available at higher levels of the 
Workspace tree to preclude this.

Properties dialog for individual bands of a multi-band data field

Note that the specified data can also have a Transform (including real-time 
filtering) applied. See Transform Tab.
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If you wish to individually control the properties however, data source, line, 
symbol and label styles can each be defined for each individual data band. 

Properties dialog for individual bands of a multi-band data field

Note that the properties tab dialogs for each of Line Style, Symbols, Rotation and 
Labels are all identical in function and description to those referenced earlier in 
this chapter. 



10 Display Properties 285

Modulating Data

With no symbols displayed, a Curve in a Profile only shows Y, Colour and Offset 
data sub-branches. When the Symbol option is enabled, the Rotation, Size and 
Label modulation sub-branches are added beneath the Curve branch of the 
Workspace tree. 

Each additional branch has a property dialog that permits selection of a database 
data field and associated bands. These branches can be accessed through short-
cut buttons – Browse on the Symbols page and Field Selection on the Rotation 
and Label tabs. An example of a multi-banded data selection dialog is shown 
below.

Band selection from a database channel
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Operation of line, database, channel and band selection is described in Selecting 
Channels and Tables.

Controlling the appearance of symbols, lines and labels is a powerful feature of 
Encom Discover PA. Any compatible data field in the source database may be 
used to control the selected property of Colour, Size, Rotation or Labelling. 
Individual bands of a multi-banded data field may be used.
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11 Spreadsheets
In this section:

• Displaying Numerical Data

• Database Structure

• Using the Encom Discover PA Spreadsheet

Displaying Numerical Data

Encom Discover PA uses a variety of presentation formats to display data 
contained in databases (see Accessing Data with Encom Discover PA). Graphical 
displays such as profile windows and maps are used to present data on-screen 
or for hard copy plots. To provide a numerical display of the content of a database, 
Encom Discover PA provides a data spreadsheet facility. The spreadsheet can 
present the numeric content of a database, statistics or data ranges. The 
databases accessed by Encom Discover PA typically contain flight information, 
lines and the various data channels of sensor information. The spreadsheet can 
also be used to export data or close a database.

Database Structure

The structure of a survey database is assumed to have certain components: 

• Survey – This is a reference to the entire database and is assigned a 
name, usually reflecting the data content or project.

• Datasets – A dataset name is associated with a survey. Usually, this 
name is the content name of the opened database.

• Flight – Survey flights subdivide a survey and correspond to individual 
acquisition periods. In the case of an airborne geophysical survey, flights 
refer to individual aircraft recording sorties usually within a defined time 
frame. For ground surveys, flights may be comprised of equivalent 
divisions of a survey corresponding to, for example, a day by day 
acquisition period.

• Line – A traverse, of any orientation, collected within a flight. Lines have a 
finite start and end location and must have corresponding navigational or 
positional information. Any number of lines that are of any length can be 
accommodated by Encom Discover PA.
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• Field – Fields comprise the various data values associated with readings 
made along lines. An alternative term frequently used for field is channel. 
Data fields are derived from geophysical sensors such as magnetometers, 
induction coils, radar altimeters etc. making measurements in a recording 
platform as it moves along a survey line. These measurements form 
individual data channels (fields) of the survey database.

• Bands – It is convenient to keep multiple readings of similar type for a 
given field together. An example of this is a series of decay measurements 
for an airborne electromagnetic survey. Rather than have EM1, EM2, 
EM3… fields it is more convenient to have an EM_Data field that is 
comprised of the individual reading bands. Some databases, such as 
Intrepid, can create band-oriented data fields on import.

Using the Encom Discover PA Spreadsheet

Initial spreadsheet view after opening

The Encom Discover PA spreadsheet is designed to provide flexibility and fast 
access to all aspects of the data in a database. After initial access links are 
created between Encom Discover PA and selected databases, the spreadsheet 
is displayed to indicate which files and data are available. At other times, to 
access and display an Encom Discover PA data spreadsheet, select the 
File>New>Database Spreadsheet option or use the spreadsheet button. When 
selected, the spreadsheet presents two open areas plus pull-down list items in a 
control bar at the top of the window.
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The left portion of the spreadsheet view is used to select a hierarchy of the 
database components, as described in Database Structure. The right area of the 
spreadsheet displays the results of the selected components and the method of 
viewing the data.

Right clicking on the row header of a selected record header displays a pop-up 
menu. Options in the menu allow automatic heading and/or data spacing 
operations. Note these spacings can also be made manually by selecting and 
moving the header column widths.

You can select a row, column or group of cells by positioning the cursor over a 
cell, depressing the left button and dragging the mouse (as you would in other 
applications, such as Microsoft Excel). Once a block of cells has been selected, 
you can copy the highlighted rows of data or the highlighted cells of data to the 
clipboard and then paste the copied data into other spreadsheet or text based 
programs, e.g. Microsoft Excel..

Data presentation is controlled by the settings of the drop-down lists contained in 
the Display Type and Rate Filter options. 

• Display Type

• Rate Filter

• Database Operations

• Spreadsheet/Profile Display Data Linking
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Display Type

The choices available in the Display Type to control the spreadsheet data are:

No Data – Shows no information from the database.

Structural Data – Presents information on the structure of the selected data 
component. For example (see below), for a selected Dataset, the data displayed 
for the open database is path, name, flight, line, field and Total Survey Length. To 
view this information ensure that the branch containing the database name is 
highlighted in the left hand margin of the Spreadsheet window. 

Alternatively, if a Line is nominated, the same Structural Data selection displays 
information detailing the number and content of fields. 

Statistical Data – Summary information of data ranges is useful for assessing 
data quality and possible database problems. In particular, when selecting 
individual fields, data range information can be useful. The total number of data 
points, minimum, maximum, mean, median and null values are shown.

Field Data – This selection provides the capability of examining individual 
readings within a database. Note also that for Field settings, the contents of 
individual bands are presented.
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Rate Filter

The Rate Filter is designed to control the data that is passed to the spreadsheet 
for processing. Fields in a database are defined at a rate that can be Survey, 
Flight, Line or Station. The Rate Filter modifies how many records are stored in 
the field. The spreadsheet displays fields of the selected rate only. Options 
available from the Rate Filter include:

• All Rates – All components of data presented and used in statistics 
calculations.

• Survey Rate – A single record is displayed for each survey. 

• Flight Rate – A single record for each flight.

• Line Rate – A single record for each line.

• Station Rate – A single record for each station. This is the smallest and 
the most common data rate.

Database Operations

Some operations can be performed directly from the spreadsheet. By highlighting 
a particular database in the spreadsheet and clicking the right mouse button, a 
pop-up menu allows you to Close, Export or Modify the default X,Y or Z data 
assignments:

• Close a Database

Note The Field Data selection provides the capability of examining individual readings 
of a database. As a consequence, display of data using this option can take 
excessive time for large databases.

If the interrogation of a database (for statistics or other reasons) is attempted but 
the response is taking too long (as indicated by a progress bar within the 
spreadsheet), press the Esc key. After a short time, the processing halts and 
return control to you.
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• Export Dataset

• Modify Dataset XYZ

Pop-up menu allows operations on a selected database

Close a Database

Individual databases can be closed using the spreadsheet Close Dataset option. 
This command is identical to the File>Close Datasets menu item. Individually 
closing a database affects only the selected dataset and leaves the remaining 
databases open for use in Encom Discover PA.

Export Dataset

Database content can be exported as ASCII CSV format files. The entire 
database or a subset, based on selected lines can be exported. Both Geosoft and 
Intrepid databases can be exported in this manner.

Modify Dataset XYZ

The Modify XYZ option is identical to the File>Modify Dataset XYZ menu item. 
This option allows you to specify the data channels of a database to use for data 
position. You can modify the easting (X), northing (Y) or vertical (Z) data 
channels. In particular, the vertical (Z) channel determines how a dataset is 
presented in three dimensional displays. If you need to alter this setting, select 
the option and change the Z data channel in the dialog displayed.
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Alter any of the X, Y or Z data assignments from the pull-down list

Statistics Explorer

The Statistics Explorer can be accessed in the Spreadsheet view by right mouse 
clicking on any field listed under the Field sub-folder for a loaded database. This 
pop-up menu option will execute the complete Statistics Explorer utility. See 
Appendix F: Statistics Explorer for more information on using this utility.

  



294 Encom Discover PA User Guide

The Statistics Explorer can be accessed from the spreadsheet view or a database 
field listed.

Editing Data

It is possible to edit line data from Geosoft and Intrepid databases displayed in 
the spreadsheet view of Encom Discover PA. For data editing to be possible the 
Rate Filter drop down option located above the right portion of the spreadsheet 
must be set to either Station Rate or All Rates and a specific line must be 
highlighted from a survey database listed in the left portion of the spreadsheet 
view showing the database heirarchy.

A spreadsheet view showing a cell value ready for editing

Any fields in the database that are not station rate or are protected in the database 
will be displayed with a grey cell background indicating they cannot be edited. 
However, to make a protected column editable right mouse click on the column 
header and choose Unprotect field from the pop-up menu that appears.

To edit a data value double-click on the cell in the spreadsheet to display a 
flashing cursor. Then either highlight and overwrite or press the BACKSPACE or 
DELETE key to edit the value. Press ENTER or click outside the cell to confirm the 
new value. 

If data is modified via the spreadsheet then the Update Views button will 
become active in the spreadsheet view. Clicking Update Views will redraw any 
window open containing that database with the new data values. An update of 
the views will also automatically happen when the user closes the spreadsheet 
view if they have modified some data. 
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Spreadsheet/Profile Display Data Linking

It is possible in Encom Discover PA to link a cell in a Spreadsheet window (while 
in Field Data display view) with the position of that station in an opened Profile 
Display. Clicking anywhere on a row of a particular station will automatically 
display a vertical cursor in the corresponding profile. This data linking also works 
when a station reading is highlighted in a Profile Display while the Spreadsheet 
window is open. In this case the Spreadsheet display will update to highlight the 
row of the selected station. 

When a station is selected in a profile display or a spreadsheet display the position of this 
station is highlighted in the related display (spreadsheet or profile) window.

To select a range of stations in the profile display or a range of rows in the 
spreadsheet window, view the context menu of the window by right-clicking on the 
window and choose the Select Range menu option.



12 Profiles 297

12 Profiles
In this section:

• About Profile Analysis

• Introduction to Profiles

• The Profile Frame

• Profile Horizontal Scale

• Flight Line Positioning and Scales

• Annotation of the Horizontal Axis

• Creating a Document for a Profile

• Axes and Annotations

• Displaying Other Objects in Profiles

About Profile Analysis

The majority of geophysical data is collected along lines and quickly converted to 
grids for subsequent image analysis. Subtle targets may go undetected when we 
rely on imagery alone. Profile analysis allows an interpreter to derive additional 
information that cannot be resolved in images. Examples include simultaneous 
visualisation of more than 3 channels of data, subtle shape information in curves, 
comparison of unrelated data types, and fine detail that may be lost during 
gridding. Until the arrival of Encom Discover PA, the detailed analysis of profile 
data from large surveys was slow and image analysis provided the only practical 
method for analysing large quantities of data. 

Encom Discover PA uses a variety of presentation formats to display data 
contained in externally accessed databases (see Accessing Data with Encom 
Discover PA) and the most important of these is the Profile. For these displays, 
the most common drawing attributes such as line colour, thickness, axes, titles 
etc. can be individually controlled. Additionally, Encom Discover PA is designed 
with a number of intelligent processes to make logical decisions when you add 
graphs, change scales or add channels to profiles with different scales etc. The 
in-built intelligence of Encom Discover PA, especially in graph manipulation, 
makes it extremely powerful and versatile.
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When the various display attributes have been specified and edited, Encom 
Discover PA uses templates or session files to save the presentation you have 
designed. Templates can be re-loaded and used for other datasets and projects. 
A range of templates for various applications are provided for your use without 
having to enter or modify the display properties.

To start using profiles, refer to the topics in this section. For more detailed 
information about changing the appearance of profiles, see Display Properties.

Introduction to Profiles

The Profile display format is displayed in a Encom Discover PA Plot window. The 
Profile is a specialised form of a Graph document. It is different from a graph 
because the horizontal axis of a profile is scaled by distance (and plotted using a 
computed data channel called ProjectedDistance). This is why when a Profile or 
Curve entry is seen in the Workspace tree, only the Y axis data entry is required 
– The X axis is ProjectedDistance. This difference between profiles and graphs 
however is fundamental in that multiple lines of a dataset can be compared 
directly in the same window and therefore important feature and interpretation 
benefits are gained through correlation of responses across lines. In all other 
respects Profile controls are identical to Graphs.

Profiles are the primary method of displaying line-based data in Encom Discover 
PA. Since this display format is so important to the operation of Encom Discover 
PA, extensive user control and flexibility have been provided. A document with 
profiles is a plot with a number of graph traces or layers superimposed on it. 
Consequently, the properties of a document with a profile are not solely to control 
the graph presentation format, but also those of a plot when output to hard copy.

When describing profiles and graphs, reference is frequently made to scales and 
axes:

• The Scale is a graphical setting that determines how large the object is 
drawn.

• The Axis is a graphical object that indicates the drawing scale.

Some of the options available for documents with profiles are:

• Multiple Profile windows may be open together or in combination with 
minimised profile windows.

• Any Plot window with Profiles may contain multiple graphs.
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• Each individual graph track contained in a Profile may contain multiple Y-
axes where each axis has its own scale to control the vertical plotting of 
each data trace. 

• Each Y scale may contain many data channels. For example, a singe 
track may display magnetics with diurnal and gravity responses. Each 
channel can be individually scaled and have its own display attributes.

• Each graph track can be used to display trace information (a single 
channel value at a single reading location), or layers that provide a filled 
colour area between a top and bottom boundary.

• Each document with a Profile can cycle through the display of multiple 
lines and consequently a single horizontal scaling is used for all graph 
traces contained in the window. The use of a single, common horizontal X-
scale is fundamental to all documents containing Profiles. See Profile 
Horizontal Scale.

The Profile Frame

An Encom Discover PA document is similar to a document in, for example, 
Microsoft Word. It represents a piece of paper on which you can place a number 
of graphical displays. In the case of profiles, the graphical displays are contained 
in tracks (with their own axes, annotations, data traces etc). Tracks and their 
contained profiles are enclosed in a Profile Frame.

Profile Frames can have one or many profiles. The frame has its own set of 
properties (see Profile Frame Properties). Properties specified in the frame have 
overall control of track margins, borders, size, data source etc. Individual controls 
over specific Profiles are then modified by the controls of the contained Profile 
levels.

Profile Horizontal Scale

Encom Discover PA has the capability of displaying multiple lines in single or 
multiple graphs of one document. Each line must therefore have a common X-
Scale. This scale is calculated by applying a number of rules to create a common 
projected distance baseline. The rules are based on the azimuth of the selected 
lines and the chosen scale to be used for the X-Axis.
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In the diagram, a group of three flight lines, each with different average azimuths 
are chosen for plotting. The azimuth is computed from north using the first and 
last point of the relevant line. From the computed azimuths, an average baseline, 
is calculated. The plotting of each flight line is individually projected to the average 
baseline by a perpendicular translation for each reading. The average baseline 
with the projected readings are then used to create a chord length (the cumulative 
distance from the origin of the baseline), to form a horizontal (X-axis) for the 
plotted graph.

This procedure, used for projected plotting means that in some instances, a flight 
line does not fill the entire graph area available, whereas other displayed lines do. 
Encom Discover PA is designed to maximise the display for the longest line such 
that shorter lines appear with a blank area. The benefit of this style of plotting 
however is a common horizontal scaling that has uniform annotation that can 
accommodate multiple flight lines with comparative scale and position. The 
interpretational advantage means that correlation of features from one line to the 
next or previous is simple.

Certain azimuth tolerance controls are available in the Line Iterator to provide 
specific rejection criteria of lines. Further information on this is available from the 
Line Iterator Tool and Line Navigation.



12 Profiles 301

Flight Line Positioning and Scales

Under certain circumstances, the axes displayed in profiles may have what 
appears to be aberrant behaviour if flightlines are not straight or near-straight. 
This diagram is of a small part of the flight path track of a map where the X axis 
to be plotted for the profile is at an angle paralleling the flight path.

Note that the distances between the coordinates on the X-axis are not equal.  The 
flight line track is quite "wavy". In this case the northings are being plotted on the 
X axis of the profile and the spacing between ticks is variable. This is a correct 
consequence of the wavy flight line.

The X axis ticks are equi-spaced in northing coordinates. The point where the 
flight line intersects the Y value is projected onto an ideal flight line. The 
coordinate of this projected point is in ProjectedDistance data channel 
coordinates as computed by Encom Discover PA. As the diagram illustrates, the 
spacing of the ticks on the X axis will only at ideal increments if the flight line is 
always aligned at the same angle to the ideal flight line.
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Annotation of the Horizontal Axis

The horizontal axis and scale of a profile uses a common distance. The distance 
used is derived from a Encom Discover PA computation to derive two channels 
called ChordLength and ProjectedDistance. By default, profiles use the 
ProjectedDistance channel (as described in Profile Horizontal Scale) for plotting 
the position of individual reading values. The X-axis annotation text can be 
automatically chosen by the software, or can be specified from another channel. 
Which of these two options is used is determined by a Simple or a Data 
Dependent setting in the Line Style tab of the Axis Property dialog.

• The Simple setting uses the ProjectedDistance channel for both the data 
plotting and the axes. These axes are displayed linearly.

• The Data Dependent setting uses an assigned channel for axis 
annotations (such as Fiducial, Easting or Northing) and may not be linear.

A third option available for X-axis annotation is to allow the software to choose 
which channel is most appropriate to be used for labelling. The line channel is 
used for this selection and easting or northing is generally selected.

The X Axis property dialog controls labelling of the X-Axis.  

Annotation style control of the horizontal X-axis
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If a specific Data Dependent channel is to be used for axis labelling and plotting 
(such as Fiducial), deselect the Select Value option (so Encom Discover PA does 
not choose it for you) and then choose the Field you wish to use for the axis. Note 
that this option is only visible when the Date Dependent item is selected. Also 
note that the specified field is shown in the properties of the X-Axis branch of the 
Workspace tree.

Using this control it is also possible to have multiple horizontal axes for the one 
profile. For example, along a profile track may be a location axis (eg. Easting) and 
a second axis that indicates Fiducial or timing.

Combined axes for one profile showing Easting and Fiducial annotations

Creating a Document for a Profile

To create a new document containing a profile, either:

• Choose File>New>Profile>Curve Profile, or 

The default document with a profile selects the first line and data field information 
of the first open database. Often the content is not initially appropriate and 
requires re-configuring.

The displayed profile uses data from the initially opened database, first line, first 
data channel. Associated with the profile is the basic hierarchy of the profile 
displayed in the Workspace toolbar. By default, the Property dialog for the 
displayed channel is also displayed (see Document Properties).

• Click the Curve Profile pull-down button from the Documents toolbar.
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Default Encom Discover PA Document window with Profile

The Workspace toolbar describes the content of the Document. The tree contains 
a Profile Frame, a Profile and three associated axes (colour, vertical (Y Axis) and 
horizontal (X Axis)). Beneath the Profile branch is also a sub-branch called Curve. 
This tree level controls the data trace  derived from a data field scaled vertically 
by the Y axis. By default, Encom Discover PA colours the data by itself but this 
can be controlled.

To change any of the profile contents, position the cursor in the Workspace tree 
and click the right mouse button. A pop-up menu appears with different options 
depending on which item is highlighted (see Working with the Workspace Tree).

Axes and Annotations

All presentations in Encom Discover PA have axes associated with them. The 
axes serve the purpose of providing scale and absolute referencing of data values 
plotted. Within Encom Discover PA it is important to understand the structure of 
axes.

There are five types of axes:

• X-Axis – Used for horizontal scaling, axis and reference

• Y-Axis – Used for vertical scaling, axis and reference

• Colour Axis – Usually hidden, this axis is used for colour modulation and 
reference to a data channel
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• Size Axis – Usually hidden, this axis is used for symbol point modulation 
and scaling. It exists in the hierarchy of a profile above the data input 
(Curve). See below for further detail on the Size Axis.

• Internal – This is a form of axis display rather than an axis itself. Internal 
axes are used to create cross marks within the boundary of a map (or 
other display document).

The Size Scale is used for modulating the size of symbols used in a profile. The 
Size Scale can be displayed (as shown) controlling the symbol size and in this 
example, the Colour Scale modulates the symbol (and line) colour as well.

Displaying Other Objects in Profiles

Encom Discover PA can display items within Profile tracks, other than Curves. 
These items use the same horizontal scaling controls and are usually also related 
to the various lines of a survey. Example of these include:

• Sections derived from multi-banded layers

• Section grids that are gridded equivalents of sections

• Images associated with lines that may contain scanned or bitmap files

• Trackmaps that are derived from a 2D raster coverage of a survey

• Drillhole data

• Features that may plot anomalies and zones of interest.
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Documents containing profiles suitable for displaying the above items can be 
created by:

Once the Document containing a Profile Frame and Profile is available in the 
Workspace tree, the required item can be added by either:

• Highlighting the window and using the appropriate button on the Data 
Objects toolbar or

• Highlight the Profile branch in the Workspace tree and click the right 
mouse button. From the pop-up menu, select Add Data and the item 
required.

Select one of the items to add to an existing Profile branch of the Workspace tree.

For more information , see:

• Using the File>New>Profile>Curve Profile or Section Profile 
menu option

• Using the Profile pull-down button and select Curve or Section 
Profile.

• Use the wizard button and select a 2D Profile or Section.

• Any pre-existing document that has a Profile Frame available.
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• Adding Sections

• Adding Drillholes

• Adding Features

• Adding Section Grids

• Adding Located Images

• Adding TrackMaps

Adding Sections

Section displays can be added to Profiles or they can have their own data track 
(using the Add Data>Section option). Section displays are used to present data 
that has property values associated with depth. Examples of this type of 
information are:

• Depths and seismic velocities

• Depths combined with EM inversion results

• Depths associated with models of some type

An example of sections and CDI (Conductivity Depth Image) presentations are 
shown below. Sections can be displayed in either one (profiles etc) or three 
dimensions.

 
Section profile displayed beneath a profile of EM data and in multiple 3D displays
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Sections can be displayed individually (as Sections) or multiply in three 
dimensions (as Located Images). When displayed individually, each section can 
have individual properties. When using Located Images of the sections in 3D 
views, the properties (such as look-up colour and scaling etc) are applied to the 
original section profiles prior to creating the located images. For more information 
on creating located images see Located Images in 3D Displays.

• Section Structure and Layers

• Creating Sections

• Section Properties

• Topography and Offset Field

Section Structure and Layers

Data to be displayed as sections are derived from fields within a database that 
relate a property (such as conductivity or magnetic susceptibility) with depth. 
Different software packages provide layered/depth interpretation results in 
different ways. Two fundamental methods of defining layers of sections are 
supported by Encom Discover PA. These are:

1. Where a layer can be specified by a top and a bottom depth boundary and 
filled with material having a specific property. See Upper and Lower 
Boundary Layers.

2. Where a layer has a specific depth value and an associated property 
value. See Point Depths and Property Values.

Upper and Lower Boundary Layers

The presentation of layers using upper and lower boundaries requires data values 
to define the top and bottom layer depth. Within the depth limits is an assigned 
property value. The value may relate to a measured or derived quantity such as 
conductivity, resistivity or magnetic susceptibility. This value is scaled by a colour 
look-up table and then presented in the appropriate colour.

 

For each station, sections are specified by three primary components. These are:
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1. An upper layer depth relative to a surface reading of zero (0) metres depth.

2. A bottom, or lower depth relative to the top surface depth (0 metres).

3. The property to be colour scaled.

With this section definition type, each reading requires three fields within the 
database to hold the required components to specify the layer. Each of these 
fields must be multi-banded with each band representing the data for a single 
layer. Note that depth is actually height – for correct display it is necessary that 
depth increases upwards.

Note that this method of layer definition is inefficient since the bottom depth value 
of a layer is usually exactly equal to the top boundary depth of the layer beneath it. 

Point Depths and Property Values

In the second type of section definition type, the data is provided for each reading 
as a depth-property pair. Note that for each reading, two possibilities of this data 
type are possible. 

• In the first type, each reading can have a constant depth with associated 
properties such as:

The Upper layer data field specification. This branch specifies the multi-banded 
field that contains the upper layer boundaries. Note that the number of bands in 
the field determines the number of layers displayed.

The Lower layer data field specification. This branch specifies the multi-banded 
field that contains the lower layer boundaries. Note that the SAME number of 
bands should exist in the Upper and Lower fields.

The property multi-band data field is specified by this branch. The same number 
of bands as for the Upper and Lower levels should be included in this field.
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Band DepthBand Property
Reading 1Reading 2Reading 3Reading 4
0 3.16 4.324.72
-102.453.163.46
-202.182.893.12
etc

and all readings have constant depth with varying properties.

• In the second case, for each reading the depth can vary with the property:

Band Depth:Property
Reading 1Reading 2
0, 3.160, 4.32
-10, 2.45-11, 3.16
-20, 2.18-18, 2.89

Encom Discover PA creates the point depth:property plot by simulating and 
artificially creating layer tops and bottoms similar to the case above.

The following diagram illustrates the plotting procedure:

 

An additional variation on the point depth:property method of specifying sections 
is that each depth (beneath each reading) can be located either as a node (corner 
of the drawn layer cell), or the centre of the drawn layer cell. This specification is 
important as it makes a difference in the plotted depth of cells (by half the 
resolution of the data). 
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In the Workspace tree, specifying depth:property sections uses only two required 
multi-arrayed channels. These are the Depth branch and the Colour branch since 
the colour displays the property being displayed. The Offset branch is used for 
topographic corrections (see Topography and Offset Field).

Creating Sections

Two methods are available to create layer sections.. Their use depends on 
whether the sections are to be presented as two dimensional or three dimensional 
displays. 

• Two dimensional displays use profile sections

• Three dimensional displays use Located Images of profile sections. 

Both of these methods require the section to be displayed initially in a section 
profile.

Section Profile Option

For section profile displays, the Section Profile option is available (from the 
File>New>Profile>Section Profile option or its associated toolbar equivalent). 
In this case, a single data line is selected and as for other profiles the Line Iterator 
and individual line controls are provided. For property specification of a section 
profile see Section Properties.

Located Image of Section Profiles Option

For 3 dimensional displays, the display section profile data must be set up as for 
the Section Option and then converted to a located image data object type before 
display in 3D. 
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The Located Images form of section creation allows individual or multiple traverse 
lines to be specified for display in 3D. It also means that a single line section or 
multiple line sections can be presented without any loss in speed efficiency.. For 
further information on this display type see Section Profiles in 3D Displays.

Example of the Located Image section display format

Section Properties

To access the properties of a Section, right click on the Section object in the tree 
and select Properties or double click the Section branch in the Workspace tree. 

The Section property dialog has a Data tab that operates identically to the Curve 
Properties Data Tab. 

Selection of data bands is from the Fields tab described in Selecting Channels 
and Tables or from the band selection tabs of the Upper/Lower or Depth and 
Colour layers of the Workspace tree. An example of the dialog for selecting 
Conductivity bands is shown below. Note band selection is from the buttons on 
the right side of the dialog.
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Depth and Property Layer definition field specification in the Fields tab.

Upper boundary, Lower Boundary and Property Layer definition field specification in the 
Fields tab.

Section Options Tab

The Options tab in the Section Properties dialog controls which layer structure is 
used (see Section Structure and Layers) and alters the Workspace tree to 
accommodate the specified format.
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Options tab of the Section properties

The Layer Construction specification defines whether layers are provided from 
the database as Upper, Lower and Property style or having Depths with discrete 
Properties. Depending on the mode, the tree displays Upper, Lower, Colour and 
Offset multi-banded objects or Depth, Colour and Offset multi-banded objects. In 
both cases Colour refers to the layer property. From the property pages of these 
objects, choose the appropriate multi-banded fields that contain the depth and 
property information.

Depth/Property style layers almost always are displayed using a node centred 
rendering approach (see Point Depths and Property Values). This approach 
assumes the property value has been computed at the depth value that is the 
centre of the layer. 

If a property is node centred it can be smoothed. If depth varies from station to 
station, this will result in a more accurate rendering of the data.

Section Appearance Tab

The Section Appearance tab allows breaks between upper and lower boundaries 
of layers to be displayed. The breaks have a line (of a specified Line Style) drawn 
between the layers.
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Dialog to control the Section boundaries

Initially the section is displayed so that it is opaque. This is sometimes a problem 
if particular trends or zones are to be viewed from one section line to another. To 
overcome this, you can alter the transparency of section values between a lower 
and upper limit. The number of bands for depth and property can sometimes be 
slow due to the volume of data. A level of compression can therefore be specified 
to assist the redraw speed.

Topography and Offset Field

A branch provided in the Workspace tree for Sections to be adjusted for 
topography is Offset . This branch is used to define a data field that, for every 
individual reading is added to the depths of the displayed section. The data value 
thereby offsets the position of the readings layers relative to each other and 
adjusts the displayed depths to account for topography, elevation or required 
offset to a reference level.

Tip If the offset of a data channel is in the wrong sense (that is, shifts the data up 
instead of down, use the Transform tab to reverse this by multiplying by -1.0)
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The Offset level is usually selected to be an altitude, digital terrain model or barometer/
GPS field

Adding Drillholes

Drillholes can be added to a section within a buffer zone on either side of the 
associated survey line. See Displaying Drillholes in Encom Discover PA.

Adding Features

Features (points, polylines or polygons) can be added to a profile to mark 
locations or zones of interest. Adding Features is routinely used within sections 
or profiles for interpretation.

For a detailed description of using Features with Profiles and Sections, see 
Managing Features.

Adding Section Grids

Encom Discover PA can display gridded data in profiles. These items are referred 
to as Section Grids which are designed to display grids (in ERMapper or Geosoft 
format) as images. Section Grids can be used with their line association such that 
the Line Iterator can be used to cycle through survey data.

The Section Grid Groups can be added to documents containing either Profiles 
or 2D Graphs via the normal menu Add Data>Section Grid method. An example 
of a Section Grid Group is shown below:
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Example of Grid Section Group with conventional section of the same data line

By displaying the grids as images, the advantages of image controls can be 
supported. These include shading, contouring, annotation of contours, advanced 
colour look-up table control etc. The property pages for the series are exactly the 
same as those for a standard image Grid Group with the following exceptions:

• You cannot display an ERMapper algorithm. This capability is disabled for 
this display format.

• You can only load special, extended ERMapper or Geosoft grid files that 
have line number associations – other grid formats are not supported

• In any one pseudo-colour or RGB surface you can only use one grid as a 
data source, although you can use different bands from that grid for each 
of the layers.

For more information about creating section grids and their properties, see:

• Section Grid Data Properties

• Iterating Section Grids

• Creating Section Grid Files

• IP Data Display
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Section Grid Data Properties

The Section Grid also has a Data property page not seen in the conventional 
image dialog that displays the dataset and line number for the group. A Section 
Grid must be associated with a dataset/line just like any other line-based dataset 
in a profile. Note that you can only source data from a single line in a profile.

Data tab of the Section Grid property dialog

Iterating Section Grids

A Section Grid responds to the Line Iterator assuming the correct line definitions 
are specified in the extended ERMapper ERS file header. An extended header 
contains an information block similar to the one shown below: 

SectionInfo Begin
CompressedLineTrace = TRUE
SectionXDefined = TRUE
SectionYDefined = TRUE
SectionZDefined = FALSE
SectionDataset = "Swamp_EMFlow.gdb"
SectionFilePrefix = "EMFlow_Cond"
SectionFileSuffix = ".ers"
LineTraceCoordinate = 0, 525178.88, 6313464, 0
LineTraceCoordinate = 878.8970996, 524300.38, 6313441.5,0
LineTraceCoordinate = 1431.946369, 523747.41, 6313437,0
LineTraceCoordinate = 1958.351257, 523221.19, 6313427.5,0
LineTraceCoordinate = 3014.05899, 522165.81, 6313446,0
LineTraceCoordinate = 3828.409337, 521351.69, 6313433.5,0
LineTraceCoordinate = 16771.95194, 508411.69, 6313446,0

SectionInfo End
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This information block defines the Chordlength position, XY and Z coordinates of 
the line upon which the grid was created. It also records the source dataset and 
the grid file name. The grid file name is constructed from the prefix plus the line 
name plus the suffix (eg EMFlow_L10200.ERS, EMFlow_L10210.ERS etc).

When a section grid is iterated, it constructs a new grid name from this information 
and attempts to open that grid file from the appropriate directory. If it succeeds, 
the current grid file is replaced with the new. Image processing parameters and 
contouring parameters are retained although the colour stretch and first/last 
contours may be modified to reflect the data range of the updated grid.

Creating Section Grid Files

The special grids and associated .ERS header file can be generated using a 
gridding tool that is accessed from the Grid menu option (Grid>Section Gridding 
option). See the Section Gridding in the Gridding Utilities section for details on 
creating Section Grids.

IP Data Display

Induced Polarisation data can be displayed in Encom Discover PA using the Grid 
Section utility. Standard Geosoft IP databases can be used. These datasets 
routinely have a multi-banded data field for IP, but multiple records for each data 
location corresponding to a different n-spacing (or receiver dipole pair). 

An example of the output gridded and contoured result is shown below:

Examples of IP pseudosections with Chargeability and Resistivity
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Adding Located Images

Located Images are used frequently in Encom Discover PA and these can be 
added to Profiles. These items are bitmaps of a particular display but with an 
associated file that is used to locate the image in real-data coordinates. 

Located Images can be created in a number of ways:

• From a pop-up menu option when a map or profile is displayed

• From the File>Batch Hard Copy Wizard menu option when multiple, line-
oriented Located Images are required (see Batch Printing Wizard)

• Using the Tools>Image Registration Wizard (see Image Registration 
Wizard).

Detail of creating Located Images can be found in the relevant sections.

With a Located Image available, it can be added to a Profile using the Add 
Data>Located Image method. Alternatively, from a highlighted Profile branch in 
the Workspace tree, the Data Objects toolbar can be used with the Add Image 
button.

The Located Image can be used as a backdrop to data (usually using a separate 
vertical (Y) scale), or within an adjacent track.
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An example of a separate track Located Image plus a curve plotted within the 
same track is shown below. Note that in the case of the data and the bitmap within 
the same track, the vertical scale of the Located Image is using the section 
vertical data range (as defined by the Located Image corner points, but the data 
channel presented as a profile, uses a separate vertical Y axis. The Wokspace 
tree to produce this display is shown. 

Example of a Located Image within a Profile with additional line data plus overlain data
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Adding TrackMaps

A TrackMap is similar to the use of a Located Image, but it is created 
automatically from a 2D raster image. Details of the use and creating TrackMaps 
are described in TrackMaps.

TrackMap example showing the flight path location over a scanned image and over a map 
of the magnetic response 
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13 Two-Dimensional Maps
In this section:

• About Two-Dimensional Maps

• Drag-and-Drop Maps

• Map Workspace Tree

• Creating a 2D Grid Map

• Creating a 2D Flight Path Map

• Displaying Lines

• Displaying Points

• Stacked Profiles

• Displaying Vector Objects

• Save Map Extents as Vector File

About Two-Dimensional Maps

Encom Discover PA can display two dimensional maps that can be used to:

• Display flight path information for traverse lines of a database including 
line numbers and direction of data acquisition.

• Indicate the location of selected or displayed lines.

• Select lines for display in other windows (such as a profile window).

• Present gridded information in conjunction with the flight path maps. The 
grids can be displayed as shaded or unshaded images, with and without 
contouring.

• Display colour and symbol modulated curves and stacked profiles.

• Locate features and present their associated information for interpretation.

• Allow surfaces to be created for use in three dimensional displays.



324 Encom Discover PA User Guide

• Interact with the user for map and profile navigation.

Drag-and-Drop Maps

A large number of file formats are available to be loaded into Encom Discover PA 
using the drag-and-drop facility. Wiith Windows Explorer open (or with the 
Explorer tab displayed in the Encom Discover PA Information Sheet) navigate to 
the appropriate file locations and either individually or multiply select the files. 
Then hold the left mouse button down and drag them into the Encom Discover PA 
interface window, before releasing the mouse button to drop the files into the 
application. 

If a document window is already displayed in Encom Discover PA the files will be 
added to this window. If no document window is displayed an option dialog will 
appear allowing you to choose how to display these files. In the example of 
multiple grid files being loaded using the drag-and-drop facility the Drag and Drop 
dialog will appear:

The Drag and Drop dialog for displaying multiple grid files in a map mosaic window.

The following options are available from this dialog:

• To display a map mosaic of these grids, select the 2D Tiled map option 
and specify the desired number of Columns and Rows. 

• To display all grids in one 2D Map window select the 2D Single map 
option. This option is desirable for producing a stacked grid display with 
the option of applying transparency to the upper grid layers or for using 
the Grid Flipper tool to alternate between the current upper grid layer.

• To display all grids in one 3D Map window select the 3D Map option. The 
latter option will produce a 3D map window with multiple Surface branches 
in the Workspace Tree each with a single grid file allocated.
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Map Workspace Tree

When a Document containing a two dimensional Map is initially created, a simple 
Workspace tree is displayed. Beneath the Document is a Map Frame similar to 
profiles. 

The Map Frame has properties including Options (see Options Tab) and 
Appearance (see Appearance Tab). The generic dialogs used to control the same 
features of frames in other display documents are described in Display 
Properties.

Below the Map Frame branch of the Workspace is the Map. Nearly all the 
properties of the Map are identical to profiles. Refer to the Display Properties for 
a description of these properties.

The properties of axes sub-branches of the tree are identical to those of profiles 
and are described in Axes Tab. Note that typically a map has four axis 
annotations – two for the X axis on the top and bottom and two for the Y axis on 
the left and right.

Creating a 2D Grid Map

The Grids Map format is used to display gridded or raster data derived from 
supported grid formats that can be displayed as images (pseudocolour or RGB) 
or as vectors (contours). ER Mapper algorithms (including compressed wavelet – 
ECW files) that access raster or grid data can also be used as sources for images.

Note The drag-and-drop facility is also available for importing Geosoft .GDB 
databases, located images, 2D and 3D vector objects and other data files.
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To create a Grids Map you can use the File>New>Map>2D Grid Map menu 
option or the map button on the Documents toolbar. Once created, the displayed 
Workspace tree is used to configure and access the required image data.

An example of an image map (combined with a flight path map) is shown below:

A Map Document with annotated flight lines, image, contours and annotations

There are four types of surface and each has one or more layers. These types 
include:

• Pseudocolour with Colour and Intensity layers

• RGB surface has Red, Green, Blue and Intensity layers

• ERMapper surface contains a layer that is assigned an ER Mapper 
algorithm
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• Contour surface with a Vector layer.

For more information, see:

• Adding Grids

• Querying Grids

• Display Order and Visibility

• Supported Grid Formats

• Located Image and ER Mapper Support

• ECW Image Support

• Vector Contours

• Grids Properties

Adding Grids

Example of flight path map with grid image and contouring 

 
To display raster or grid images in a two dimensional map, choose the Add Data 
pop-up menu to add a new Grid branch to a 2D Map (by right clicking the Map 
branch of the Workspace tree). When this is done a new Grids branch is added 
to the tree.
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Querying Grids

Grid extents and coordinate projection information for opened grids can be 
viewed in the Grid Information dialog of Encom Discover PA. Please refer to Grid 
Information in Grids Properties for further information on this. 

Display Order and Visibility

A plot is rendered by drawing all surfaces from the bottom level of the tree 
upwards. Surfaces at the top of the tree obscure surfaces lower down the tree 
(although the transparency control can modify this).

Surfaces can be moved up or down the tree in the plot order from the Grids 
Properties dialog. Individual surfaces and layers can be switched on or off from 
the tree item pop-up menu.

Supported Grid Formats

A wide range of industry-standard grid formats are supported and can be 
imported for use in Encom Discover PA. The grid formats supported by Encom 
Discover PA are listed in Appendix E: Supported File Formats.

Encom Discover PA loads the requested grid band(s) into memory to display 
images and contours of a grid. Consequently, the ability to view very large grids 
is restricted by your available system memory. As an alternative, to allow the 
viewing of very large grids, Encom Discover PA decimates the grid at load time 
to ensure the number of rows and columns in the grid does not exceed a user 
specified limit. You can set this limit in the Options dialog, accessible via the 
Tools>Options menu item. On the General tab you can set the Grid Loading 
column and row limit. It is set to 2000 by default.

Located Image and ER Mapper Support

The Located Image option allows display of a variety of positioned raster data 
formats. The raster formats supported by Encom Discover PA are listed in 
Appendix E: Supported File Formats.

Note Control changes made in the Grids properties dialog can be invoked immediately 
they are changed if the Auto Apply option (at the base of the dialog) is enabled. 
This option allows real time manipulation of imagery enhancement such as 
shading, colour changes etc. 
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Encom Discover PA makes use of an ER Mapper software plug-in that displays 
ER Mapper algorithms and imaging including ER Mapper Compressed Wavelet 
(.ECW) imagery that can be accessed across the internet. Also provided with the 
ER Mapper software support are a wide range of look-up tables that can be used 
in colouring images in Encom Discover PA.

The main benefit of ER Mapper support is to provide direct interpretation of ER 
Mapper algorithms. This means the complex image processing techniques made 
available from ER Mapper can be read and correctly displayed within Encom 
Discover PA as map images.

Note that:

• ER Mapper images support Projection and Datum referencing and this is 
specified in the ASCII .ERS file accompanying the image data file. Within 
the header file, if the DATUM or PROJECTION is RAW and the 
COORDINATETYPE is LL or EN.

• No datum or projections are written if the COORDINATETYPE 
parameter is not LL. In this case a UNITS parameter is written).

• If coordinate type is LL the registration cell coordinate is written as 
Latitude, Longitude. If coordinate type is EN the registration cell 
coordinate is written as Eastings, Northings.

• Registration cell coordinate is always 0,0. If the NULL value is infinite, 
Encom Discover PA always records a NULL value of -5e75.

To use the Located Bitmap option and ER Mapper plug-in for algorithm 
presentation:

1. Create a Grids branch in the Map of the Workspace tree. Do this by 
highlighting the Map item of the tree, click the right mouse button and 
select the Add Data>Grids from the pop-up menu.

2. Highlight the created Grids branch and display the Properties.

• ER Mapper .ALG algorithm files

3. Initially a PseudoColour layer is appended by default. Select the Grids 
branch in the tree and click the right mouse button to reveal a pop-up 
menu. Select the New Surface>Located Bitmap Surface option. 
Alternatively, click the Add Located Bitmap Surface button and a new 
Located Bitmap Surface branch is added to the Grid Group tree.

4. Click the Browse button and from the Files of type pull-down entry 
choose the file to be used. The formats provided in this display allow:
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• ECW compressed wavelet format files (.ECW). See ECW Image 
Support.

• Encom Located Bitmap files (.EGB)

• ESRI triangulation files (.TIN)

• MapInfo Professional raster files (.TAB)

• GeoTIFF format files (.TIF).

5. For an ER Mapper algorithm file, select the .ALG algorithm file as shown 
below:

Algorithm selection and preview of the image

Once an algorithm or ECW file has been loaded a preview of the surface is 
displayed. Click the Apply button to redraw the Map.

Note that an ER Mapper algorithm cannot be modified. You cannot change the 
histogram, colour look-up tables or data content. However, you can zoom, roam 
and pan in the same manner as other displayed images and maps.
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ECW Image Support

Encom Discover PA imaging can display ECW (ERMapper Compressed 
Wavelet) algorithms and files. ECW support can use an algorithm that specifies 
an .ECW file or alternatively, you can specify an .ECW file directly. ECW files can 
contain extremely large raster datasets and can provide access across the 
Internet from a wide range of sources. The images can be accessed from local 
websites with appropriate .ALG algorithm files and through Image Web Server 
(ER Mapper). 

Some example ECW algorithm files are provided in the 
\TEMPLATE_GALLERY\ECW folder of your Encom Discover PA installation. To 
create your own ECW algorithms for use in Encom Discover PA, you need to 
obtain the URL of an ECW image. Some examples of URLs and freely available 
imagery are available at www.earthetc.com.

For example, you can add an ECW file definition in the Open dialog using an ECW 
URL such as:

ecwp://www.earthetc.com/mages/world/esg_world_color.ecw 

Ensure you initially alter the Files of Type entry to be ERMapper ECW Files 
(*.ECW). This is shown in the example shown below:

Specify the ECW file URL address in the Open file dialog

An example of using a supplied ECW algorithm is with an image of the USA and 
Mexico that can be zoomed to use a resolution of 25 metres. The ECW algorithm 
for this image is:

ecwp://www.earthetc.com/images/geodetic/world/landsat742.ecw

http://www.earthetc.com
http://www.earthetc.com
http://www.earthetc.com
ecwp://www.earthetc.com/stmages/world…sg_world_color.ecw
ecwp://www.earthetc.com/images/geodetic/world/landsat742.ecw
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Landsat satellite image of the USA and Mexico with a spatial resolution of 25m The image 
is accessed in Encom Discover PA via the internet You can zoom and pan to any part of 
this image

 

Vector Contours

Grid files can be displayed as contour vector layers in Encom Discover PA. 
Contours can be displayed in conjunction with images. 

Note That is not the ECW SDK which, although temporarily withdrawn for legal 
reasons, will continue to be available in the future.

 Warning The support for the ERMapper algorithm image processing SDK has been 
withdrawn by ERMapper and as a consequence of this Encom Discover PA will 
continue to include the ERMapper data functionality but the algorithm support is 
no longer available by Encom or ERMapper. The ECW SDK is however not 
affected by this change and will continue to be available in the future.
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Note that Transparency and Colour-Intensity Balance slider controls are not 
available for contour surfaces.

To create a Vector Contour layer:

5. Once a grid is specified, select the Contour layer underneath the Vector 
branch in the tree of the grids Properties dialog to display the properties of 
the contours..As contours can take some time to generate, ensure that the 
Auto Apply tick box for this dialog is turned off.

For information on controlling the appearance of contours, see Contours 
Properties.

Grids Properties

The properties dialog of the Grids branch in the Workspace tree is obtained from 
the Properties pop-up menu item or double clicking the Grids branch item. It is 
unlike other property dialogs in Encom Discover PA because it can provide 
previews of images before they are presented in the Map.  Two modes of 
operation are available for this dialog, which is controlled by the Compact/
Expand button:

Vector layers (such as contours) and image layers are treated separately 
because an image occupies all pixels of its display area and therefore it can hide 
any vector layers drawn below it. Consequently, the drawing order of images 
and contours is important and to ensure vectors are visible, they should lie 
above images in the plot tree. The Move Up and Move Down buttons (or pop-up 
menu options) should be used to ensure the correct order is created.

1. Create a Grid object in the Map of the Workspace tree. Do this by 
highlighting the Map item of the tree, click the right mouse button and 
select the Add Data>Grids from the pop-up menu. An alternative is to 
select the Add Surface button in the Data Objects toolbar.

2. Highlight the new Grids branch and display the Grids Properties dialog.

3. Create a new Contour surface using the Add Contour Surface button. 
Change the surface to a Vector – Contour surface via the pop-up menu for 
the surface. Alternatively, click the Add Contours button on the Data 
Objects toolbar.

4. Highlight the Vector branch in the tree of the Grids Properties dialog and 
click the Load New Grid button to choose the required grid file to be 
loaded to view the contours of (see Supported Grid Formats). 
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• Expand – The expanded view dialog is divided into an image tree, control 
and preview area. Although providing greater control over the displayed 
imagery, the dialog in this format occupies a larger area on the screen and 
therefore may obscure underlying imagery or workspace.

Expanded view of the Grids properties dialog

• Compact – The same dialog can be compressed to only display the 
controls and smaller image tree area. No preview area is displayed. 

Compacted view of the Grids Properties dialog
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A grid map consists of a variable number of surfaces that constitute a plot. The 
structure of the plot is shown in the tree view of the dialog. By selecting on any 
item in the tree, the displayed controls change to show the properties of the 
selected item.

For more information, see:

• Transparency and Colour-Intensity Balance

• Pseudocolour Layer Controls

• Controlling a Colour Layer

• Grid Information

• Automatic Colour Scaling

• Controlling an Intensity Layer

• RGB Image Properties

• Contours Properties

Transparency and Colour-Intensity Balance

On the PseudoColour property page there are transparency and Colour–Intensity 
balance slider controls. Transparency is not available for contour surfaces. 
Colour-Intensity balance is not available for ER Mapper algorithm surfaces and 
contour surfaces.

Each surface is combined with the underlying surfaces using a Transparency 
transform that allows underlying surfaces to be seen through overlying surfaces. 
To ensure a surface completely obscures underlying surfaces, set the 
transparency value to minimum (opaque). Conversely, to reveal underlying 
surfaces and hide the selected surface, set the transparency value to maximum 
(invisible). An intermediate value combines the selected surface with the 
underlying surfaces to the specified degree.

Pseudocolour and RGB surfaces have colour-intensity balance slider controls on 
the surface property page. This allows you to easily adjust the balance the 
contributions of the colour and intensity layers to the final image. When set to 
minimum, colour and intensity are in balance. As the Colour Balance level is 
increased the intensity is progressively washed out and the colour saturation 
increases. 
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Grids Properties dialog used for control, access and previewing images

Grid image selection dialog.

Select the button to add a Pseudocolour surface. By default, a pseudocolour 
surface is already present in the plot tree of a Grids. Note that Colour and 
Intensity sub-branches appear beneath the Pseudocolour branch.

 
 Access to external grids is provided by the Browse button that appears in the 
centre of the dialog beside a file entry field. Click this button to access a file 
selection window and specify any necessary path and grid surface. Loading a 
grid into a surface using this technique loads the grid into each Pseudocolour 
item. If required, grids can also be loaded into layers (Colour and/or Intensity) on 
an individual basis.
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Note in the above dialog that access to a range of different grid formats is possible 
from the Files of type pull-down item. Once a grid file is specified and the Open 
button is clicked, a preview of the image is displayed in the right of the expanded 
mode dialog.

A range of buttons at the top of the dialog allow the following actions:

Note that in the case of ECW algorithms, images can be accessed across an 
internet web link.

Other buttons in the control area provide the following functions:

For interactive control of the various image levels, select a branch in the Image 
tree and click the right mouse button. A pop-up dialog allows you to directly add 
one of the supported display types or to adjust its position (for display 
superimposition), duplicate or remove a branch. 

Similar to the Workspace tree, the image tree provides access to properties of the 
various levels of image plots. If you select the Pseudocolour layer and right click 
a pop-up menu is presented as shown. 

Adds a new pseudocolour branch to the image tree.

Adds a grid branch which is displayed as contours 

Adds a new Red:Green:Blue branch to the image tree.

Adds a Located Bitmap Surface file to the image tree and displays it. The 
supported file formats for this object type are listed in Appendix E: Supported 
File Formats

Adds a new grid to a plot.

Delete the selected grid branch.

Duplicate the selected grid branch.

Move the selected surface up or down.

Display information (location, extent, projection and row/column details) about 
the selected grid.
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Options provided by the pop-up menu are:

Item Description

Turn On
Turn Off

A selected plot, surface or layer can be switched on or off. 
If switched off, it will not be rendered.

Move Up
Move Down

These options duplicate the functionality of the buttons. 
Move surfaces up to ensure they overdraw surfaces lower 
down. Contours should generally be at the top of the tree.

Duplicate Surface Duplicates a surface. Duplication of a surface copies all 
the attributes of the original surface and layers.

Delete Surface Deletes the selected surface - identical to the button.

Located Bitmap 
Surface

Change the surface type to a located bitmap surface such 
as an ER Mapper Algorithm. 

Pseudocolour Change the surface type to Pseudocolour.

The Pseudocolour image representation uses a look-up 
table coupled with a colour and intensity controlling layers 
to render an image. This form of image display is the 
default style. Refer to Pseudocolour Layer Controls.
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Red:Green:Blue Change the surface type to RGB.

This form of display uses multi-band grid files (or multiple 
grid files) to present images. Examples of this form of 
display include satellite or digital photography. Refer to 
RGB Image Properties.

Vectors – Contours Change the surface type to Contour.

Contours can be added to image maps to enhance 
displays. Refer to Vector Contours for additional details.

Item Description
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Pseudocolour Layer Controls

A pseudocolour surface consists of one or both of:

• A Colour layer in which a predefined RGB or HSL colour table is used to 
render the data from a single banded grid or a single band of a multi-
banded grid. Colours can be assigned from user specified RGB or HSL 
colour space stretches or from colour look-up tables which can display 
any colour combinations including greyscales.

• An Intensity layer that introduces a greyscale shading scheme based on 
an artificial sun azimuth and inclination. This feature is a powerful method 
of introducing colour gradients to an image to highlight trends and patterns 
in the data. Usually the grid used as a data source for the intensity layer 
will match the colour layer, but a different grid or grid band may be used if 
required. Note that with the Auto-Apply option enabled, real time sun 
shading is available in the displayed image plot as well as the preview.

To create a Pseudocolour image:

1. Create a Grids branch in the Map of the Workspace tree. Do this by 
highlighting the Map item of the tree, click the right mouse button and 
select the Add Data>Grids from the pop-up menu. An alternative is to 
select the Add Surface button in the Data Objects toolbar.

2. Highlight the created Grids branch and access the Properties of the 
image.

3. If required, click the button to create a new Pseudocolour surface. Select 
the Pseudocolour branch in the image tree and click the Load New Grid 
button to specify a grid for both the colour and intensity layers (see 
Appendix E: Supported File Formats).

4. Once a grid is specified, a Pseudocolour preview image appears in the 
right side of the Properties dialog (ensure the Preview checkbox is 
enabled).

5. A second (and faster method), is to simply select the Pseudocolour 
button. This automatically adds a colour level to the image tree.
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Controlling a Colour Layer

Select the Colour sub-branch in the image tree to show the properties. 

Colour layer controls for the Pseudocolour image

The properties available include:

• Colour – There are three methods of colour table specification 

• Specify the upper and lower colours and interpolate a specified 
number of colours in RGB colour space.

• Specify the upper and lower colours and interpolate a specified 
number of colours in HSL colour space. This is the default method.

• Load a colour look-up table that defines the RGB colours. The 
number of colours in the table is defined by the number of colour 
entries in the LUT file.

• Data Source – You can select and load a grid using the Load button. In 
most cases it is sufficient to load a grid from the Pseudocolour surface 
property page which loads the same grid into the colour and intensity 
layers. If the grid has multiple bands, the required band can be selected.

You can select a colour look-up table from the drop-down list in the Colour 
section. By default, no table will be selected. If there are no colour tables in the 
list, Encom Discover PA has failed to identify any LUT files on your system. To 
change to RGB or HSL interpolation or to manually specify the number of 
colours in the table, click the shown button.
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A histogram of the data distribution is displayed. The histogram shows the 
frequency of data values in the grid as well as the colour of the data values. The 
cumulative value of the histogram is also shown as a black line on the histogram 
graph. The transform from data to colour space is defined by the transform line 
that is not shown on the histogram. By modifying the transform you can change 
the colour distribution across the image. Three options are available to do this.

If you select the Band Pass Mapping button, you can also apply a Histogram 
mapping by again clicking the Histogram icon after setting the Band Pass limits. 
The histogram equalisation is computed only within the bandpass limits.

Note You can use the LUT Editor to maintain, edit and create colour look-up tables. 
Refer to the LUT Editor for additional information.

• Linear Colour Mapping – Click the button to enable linear colour 
mapping. The transform linearly distributes colour between the minimum 
to the maximum data values.

• Band Pass Mapping – Click the button to apply a bandpass filter to the 
transform. The percentage values of the bandpass range are specified 
below the bandpass button. All data values outside the specified range will 
be assigned the minimum or maximum colour value and the colour stretch 
will then be restricted to the data within the bandpass. Bandpass mapping 
replaces a linear transform, but can be combined with a histogram colour 
mapping (as described below).

• Histogram Colour Mapping – Click the button to apply a histogram 
equalised colour transform. This transform produces an image with an 
equal amount of colour area across an image.

More advanced data transform controls are accessed via the Advanced Colour 
Mapping button. This opens the Colour Mapping dialog, which can also be 
opened by double-clicking in the histogram preview area.
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The Colour Mapping dialog configured for an increasing linear data transform, with 
bandpass cut-off limits set in data values

This dialog presents a preview screen of the data distribution, with the Cumulative 
histogram displayed as a green line, and the applied data transform a red line 
(which are also replicated in the main Surface Properties dialog preview screen), 
as well as the bandpass cut-off limits (dashed lines). 

The colour distribution for the specified data transform is also displayed around 
the preview edges as colour bars. A spreadsheet displays transform inflexion 
points as a series of coordinates, where X is the data value and Y is frequency. 
The preview screen can be controlled using the buttons at the bottom left (Zoom, 
Pan, Fit view to data).

The following transform options are available in this dialog from the pull-down list:

• Linear (increasing or decreasing) – the transform linearly distributes 
colour between the minimum and the maximum data values. 

• Log (increasing or decreasing) – colour is distributed logarithmically 
between the minimum and the maximum data values.
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More advanced data transform controls are also accessed by the Data Tranform 
drop-down list. These include: 

• Histogram - this transform produces an image with an equal amount of 
colour area across an image.

• User-defined – having set one of the above transforms (with or without a 
bandpass cut-off), choosing this option allows you to customise the 
transform curve. A series of inflexion points are displayed as black icons 
along the curve; additional control points can be added by placing the 
cursor over the transform and clicking when it changes to the Add Point 
cursor. Control points can be edited via the following methods:

• Clicking on a control point in the graph and moving it moves all 
control points in an elastic motion. This move is reversible; moving 
a control point and then returning it to its original position will return 
all other control points to their original positions. The editing mode 
compresses control points in front of the selected point and 
expands them behind the selected point. This mode allows quick 
modification of the shape of the transform curve whilst retaining the 
flavour of the original curve.

• Clicking on a control point with the CTRL key held down and moving 
it moves the selected control point only. Points cannot be moved 
horizontally beyond the two adjacent control points. Directly editing 
a control point in the spreadsheet applies the same rules. This 
mode allows control over the exact coordinates of individual control 
points.

• Clicking on a control point with the SHIFT key held down and moving 
it. This editing mode compresses control points in front of the 
selected point but does not modify control points behind the 
selected point. The same effect can be achieved by moving a 
control point in one of the colour bars.

• Moving a control point horizontally is equivalent to moving a 
selected colour to a new data value. Moving a control point 
vertically is equivalent to moving a selected data value to a new 
colour.

• Clicking between two control points in a colour bar and dragging 
moves the control points to the left and right of the cursor. The 
distance between these two points will not be modified but control 
points in front of the leading point will be compressed. Control 
points behind the trailing point will not be modified.
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• Moving a segment horizontally is equivalent to moving the selected 
colour range to a new data range. Moving a segment vertically is 
equivalent to moving the selected data range to a new colour range.

The Colour Mapping dialog configured for an user-defined data transform.

For each of these options (except User-defined), a Bandpass cut-off can be 
applied either as percentage or data values. All data values outside the specified 
range will be assigned the minimum or maximum colour value and the colour 
stretch will then be restricted to the data within the bandpass.

If you have modified the colour look-up table using the colour mapping controls, 
you can then export the table (LUT) for use in other software or re-use in Encom 
Discover PA.
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Grid Information

Grid information from selecting the button on the grid display dialog

This information is accessed from the Grids Properties dialog for a 2D map 
display, the section Grids Properties dialog for Profile displays or the Surface 
Properties dialog for a 3D display.

Grid formats supported by this query tool are:

• ER Mapper (.ERS)

• MapInfo-Vertical Mapper (.GRD) 

• Geosoft (.GRD) when a .GI header file is present

It is often useful to obtain information about a grid prior its use in a display. The 
Grid Information button can be used to obtain statistics that detail the location, 
projection and grid attributes.
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Automatic Colour Scaling

A powerful feature available in Encom Discover PA allows the colour look-up 
table to be dynamically scaled (using a dynamic histogram equalisation) within a 
data zoomed area of an image window. The dynamic colour scaling is 
demonstrated as you roam the image since the colours applied to features are re-
scaled as the image is panned around in and therefore different amplitude levels 
of data move into and out of the window. This is especially useful when 
investigating subtle features within an image that has a data range that would 
otherwise make a feature hardly visible (such as diamond exploration).

The Automatic colour scaling is enabled from the Grids level of the image tree. 
Highlight this level and check the feature on.

To enable the dynamic colour stretching, highlight the Grid Group branch onf the 
tree in the grids Properties dialog (or select the grids tab). The check box to Adjust 
colour scale dynamically to data limits then needs to be enabled for the feature to 
operate.

The dialog to enable dynamic colour stretch to a zoomed portion of an image
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Controlling an Intensity Layer

The Intensity layer of a Pseudocolour image is used for applying shading to the 
display. The shading applies a greyscale colour modulation to the pseudocolour 
surface.

Pseudocolour Intensity layer control dialog.

Properties available include:

• Intensity – The shading control of an intensity layer is interactive. A red 
cross displayed in a mapped shade ball is used to control the graphic 
location of azimuth and altitude of a virtual sun. These two angles control 
the sun shading process. Specific angles can be entered in the 
appropriate fields beneath the shade ball. Specific angles can be entered 
in the appropriate fields beneath the ‘shade ball’ To graphically operate, 
select the red cross with the cursor and with the left mouse button pressed 
move the cross to an azimuth/altitude combination that best enhances the 
features required. The image displayed in the Preview window updates in 
real-time. If the Auto Apply option is enabled, the main display window is 
updated in real-time similarly to the Preview area.

• Data Source -You can select and load a grid using the button. In most 
cases it is sufficient to load a grid from the Pseudocolour surface property 
page which loads the same grid into the colour and intensity layers. If the 
grid has multiple bands, the required band can be selected.
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• Show Highlight (wet look) - In addition to the red cross in the shade ball 
is a yellow cross. The position of this cross determines the illumination of 
specular highlights (changes in image gradient) to produce a wet look 
image. You can position the yellow cross by entering specific Highlight 
Azimuth or Altitude values, or alternatively you can graphically be 
positioned by placing the cursor over the yellow cross, pressing the right 
mouse button and moving the mouse to position the cross. When the 
cross is re-positioned, the intensity image alters to indicate the new 
highlighted gradients.

The intensity of the shadow can be enhanced using the Shadow Depth slider bar 
and the Enhance setting. The shadow depth option can increase or decrease the 
intensity of the shadows and the result is displayed after you move the slider 
control. For a large grid, this update may take a few seconds. The Enhance 
setting can improve the shadow intensity of grids that have a very high dynamic 
range – for example derivatives of magnetic data. Generally, this setting is not 
required.

RGB Image Properties

Red-blue-green (RGB) imagery surfaces are used when more than one band of 
data is to be used in the image display. RGB colour mode uses the fact that Red, 
Green, Blue and Intensity colour receptors are used to display up to four separate 
bands or layers of data at the same time. Thus, areas in an RGB image that 
appear predominantly red would have high values in the red layer of data and low 
values in the other layers and similarly for the other colours. Interpretation 
becomes more difficult when there are high values in two or more layers of data 
at the same time because composite colours are created that are not intuitive to 
understand. If the same image is loaded into each of the Red, Green and Blue 
layers the resulting image appears as shades of grey.

The RGB image format is especially useful for presentation of multi-band 
datasets such as Landsat or Spot satellite imagery or for geophysical 
interpretation, the multi-band data of radiometrics (Potassium, Uranium and 
Thorium) can be mapped to the various colours.

Note If the Auto-Apply option is enabled, adjustments to the shading intensity can be 
viewed in real-time. As you move the cursor and the sun azimuth and altitude 
are adjusted, so the image will alter.
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To create an RGB image:

The Red:Green:Blue layers have Red, Green, Blue and Intensity layers 
associated with it. By default, the Intensity layer is switched off.

Example of the Green Layer controls of a Red:Green:Blue image

1. Create a Grids layer in the Map of the Workspace tree. Do this by 
highlighting the Map item of the tree, click the right mouse button and 
select the Add Data>Grids from the pop-up menu. An alternative is to 
select the Add Surface button in the Data Objects toolbar.

2. Highlight the created Grids branch and display the Properties.

3. Select the Add Red Green Blue Surface button and highlight the 
Pseudcolour default branch. Right mouse click in this branch and from the 
pop-up menu select Delete Surface.

4. Click the Load New Grid button to choose the required input multi-band 
grid (see Appendix E: Supported File Formats). Encom Discover PA 
assigns grid bands to the Red, Green and Blue layers by default.

5. Once a grid is specified, select the Red, Green, and Blue layers to display 
the properties of the relevant layer. A preview image appears in the right 
side of the Properties dialog (ensure the Show Preview checkbox is 
enabled).

• Data Source -You can select and load a grid using the Load button. In 
most cases it is sufficient to load a grid from the RGB surface property 
page that loads a multi-banded grid and assigns grid bands to the red, 
green, blue and intensity layers. If the grid has multiple bands, the 
required band can be selected.
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• Branches – Each of the Red, Green and Blue layers need to have their 
individual colour distributions adjusted according to a Linear, Band Pass 
or Histogram Equalisation process. Refer to Controlling a Colour Layer for 
details on this. In each case the look-up table appropriate to the colour 
layer is fixed.

Contours Properties

A large range of controls for contours is available. You can have them in 
monochrome or coloured (according to a colour mapping scheme) and the 
contour interval and dropout can be specified.

Contour control dialog with property buttons.

Note You can only preview the combined RGBI surface from the RGB surface 
property page (or the main plot window if Auto Apply is enabled). 
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Contour control dialog and specifications for a colour look-up table.

Available controls include:

Select the distribution, contour levels or save/restore from a file

• Data Source -You can select and load a grid using the button. It is 
convenient to load a grid from the Contour surface property page. If the 
grid has multiple bands, the required band can be selected.

• Contour Levels -You can specify contour intervals, levels and their 
distribution from the dialog displayed when this button is selected.
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Contours can be distributed linearly, logarithmically or via an external file defining 
the contour levels (a .LVL file). Contour levels can also be limited to a range of 
data specified in the First and Last contour values. 

 
Appearance of labels of contours and line style dialog.

The line styles of major and minor contours can be defined and their smoothness 
determined by one of three types of contour Line Smoothing (No Smoothing, 
Akima Spline or Bezier Spline). The Major and/or Minor Labels drawn along 
contours can be made to have specific styles and to be either straight text or to 
follow the curve of the contour (Follow baseline option). By default, contour 
labels are created relative to the gradient of the slope they represent, however if 
you would rather they all be drawn such that the text is read from the base of a 
map, the Keep text vertical option can be used.

The density of contour labels within a map area and/or along contour lines is 
controlled by slide bars.

Contour Appearance – Control of the contour appearance and labelling is 
provided in a dialog when the appearance button is clicked.

Contour Dropout – Options are accessed by clicking the button. When contour 
dropout is applied, contours are not drawn in areas of high data gradient to 
improve the look of the final contour map. The dialog used to control dropout is 
shown here.
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Control dialog for contour dropout and grid decimation

Parameters that can be specified from this dialog include:

• Dropout Threshold – Specifies the maximum number of contours that is 
rendered in a centimetre on the page. A setting of 20 is the default that 
allows each contour line half a millimetre of page space. Decrease the 
setting to dropout contours more frequently and increase it to dropout 
contours less frequently.

• Dropout Frequency – Specifies how contours are dropped. The default is 
a setting of two (2). If Encom Discover PA decides dropout should occur it 
will dropout every second contour, then three in four, then seven in eight, 
15 in 16 etc until sufficient dropout has been achieved. A setting of 10 
would dropout every 9 in 10, then every 99 in 100 etc.

• Decimation can be used to enhance redraw and refresh performance on 
large grids. It operates by using only every 2nd, 3rd etc cell/row of an 
image when drawing. The Decimation entry is always a compromise 
between speed of redrawing and image honouring.

If variable contour colour (dependent on grid values) is required, enable the Use 
Colour tick box and choose a colour scale look-up table from the pull-down list 
or via the Advanced Colour Properties dialog (shown left). A colour histogram 
graph is then displayed and full control of the colour tables and colour transform 
is available. The colour controls are exactly the same as for a Pseudocolour 
image – see the Controlling a Colour Layer section.
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Look-up Table – If this option is enabled, it forces the colours of the contours to 
be mapped by the LUT table specified rather than any histogram or band-pass 
settings.

 

The Colour Scale dialog is displayed when the Advanced Colour Properties 
button is selected.

Mask – Above the Preview window is the Mask check box. It is disabled by 
default. When enabled, a contour surface will erase the grid image area before it 
renders the contours. Consequently, when multiple contour surfaces are overlain, 
the contour lines from overlapping grids do not overdraw each other. It is purely 
a cosmetic feature. However, when enabled, any contour surface obliterates 
underlying surfaces of all types and so this option generally cannot be used in 
conjunction with colour grid images.

Note In 3D imagery where contours have been added as a Grids workspace layer, 
steep gradients can cause poor rendering effects on contours. These effects are 
due to the drawn vector contour representing a single data value, passing 
through grid cells that may vertically span a strong gradient. 
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Once one of these format files are saved, they can then be used (from a Vector 
File layer in the Map Frame) to display clean attributed contours on the 3D 
display. An example of this is shown below:

Contours added from a vector contour layer and from a saved vector file

A way around this is to use the Export Contour button on the Surface 
Properties Contour dialog. Using this option can export contours created in 
Encom Discover PA to any of the following vector formats:

• ARCView ESRI .SHP files

• ARC ESRI .TIN files

• AutoCAD DXF format files

• MapInfo Professional .TAB or .MIF files.
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Creating a 2D Flight Path Map

To create a map (a 2 dimensional object), select either the File>New>Map>2D 
Flight Path Map or the Flight Path button. Maps can also be inserted into an 
existing document from the Insert>Flight Map menu item. A new window is 
displayed with the map and traverse lines drawnTraverse lines are initially drawn 
in black (by default). Line numbers and the direction of acquisition of a line can be 
optionally added as is indicated by a small arrow placed at the start and/or end of 
the line.

Surrounding the map are axes showing easting and northing annotations (see 
Axes and Annotations). Also note that lines selected for display in graphs or 
profiles from the same area covered by the map can be seen as a red, selected 
traverse, in the map. These selected lines are used for interactive linking of 
profiles and maps (refer to Line Navigation).



358 Encom Discover PA User Guide

Flight map with two displayed lines

You can use the Zoom, Pan and Fit (or their data mode equivalents) to change 
the view of the map (see Available Tools for information on these functions).

Flight maps can also be inserted into other graphical objects. For example, a 
profile can be displayed and to indicate its location in a survey, a flight path map 
can be added to the display.

Two data lines with magnetics, elevation, EM data, inversion results, title block and flight 
map within a layout mode document

Alternatively, the map could be made the main focus of a display and profiles 
added.
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Example of Layout document with the map associated with selected profiles

If you wished to add fiducial points along the flight path, this can simply be done 
by adding an extra branch called Points to the Workspace tree. Use the Add 
Points button on the Data Objects toolbar or else choose Add Data>Points from 
the pop-up menu when the Map 1 branch in the workspace tree is clicked on with 
the right mouse button. This branch can be used to add symbols and fiducial 
labels with annotation at say every 50th data point (using the Skip Factor 
control).

Example of Flight Path with fiducial values using the Points data object.
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The only difference between an image map and a flight path map is the data 
content of the map and both flight paths and images can be freely added to any 
map regardless of how it was originally created. Choose the Add Data pop-up 
menu to add new data to a map.

The two dimensional Flight Path and Grids branches of the Workspace tree have 
properties that are unique and not shared by other display documents.

Flight Path Map Properties

To display the Flight Path Properties dialog, right-click the Flight Path in the 
Workspace tree, and choose Properties. The property dialog has three tabs:

• Lines Tab

• Fields Tab

• Appearance Tab



13 Two-Dimensional Maps 361

Lines Tab

Use this property dialog to select individual lines from a nominated database 
currently open in Encom Discover PA. This is useful for excluding tie lines or other 
unnecessary flight lines from the display.

The Lines tab in the Flight Path properties dialog.
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Fields Tab

Shows the fields in the database being used for X, Y and Z coordinates. Note you 
cannot change these in this dialog – they must be changed using the Modify 
Dataset Properties, accessed from the File menu. 

The Fields tab in the Flight Path properties dialog.

The Fields tab also allows the specification of station selection for stations along 
the lines. Station selection options include:

• No Decimation – No decimation will be applied to the station data along 
each line.

• Fixed rate decimation – A decimation of a fixed rate specified in the “Use 
every ‘nth’ station” box will be applied to each line.

• Compressed – Stations will be decimated by the specified compression 
factor using the slide bar or the entry in the value box.

• First station only – Only the first station in each line will be displayed. 

• Last station only – Only the last station in each line will be displayed.
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Appearance Tab

Use this dialog to control the appearance of the active flight lines, nominated in 
the Lines tab. 

The Appearance tab in the Flight Path Properties dialog.

Appearance parameters include:

Style

• Show flight lines – tick box for showing or hiding the active lines within 
the nominated database, chosen from the Lines tab.

• Line style button – click on this button to specify of the line style 
appearance, including colour, weight (thickness) and pattern.
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The Line Style dialog accessed from the Appearance tab properties dialog.

Current Lines

• Show current lines only – use this option to display only the lines that 
are presented in a profile or graph window. Other lines specified in the 
Lines tab for the Flight Path Properties are not displayed until they are 
displayed in a profile or graph window.

• Highlight current lines – use this option for showing or hiding the 
highlight for the current lines being presented in a profile or graph window.

• Current Line Colour – use this button to display the Colour dialog to 
specify the line colour of highlighted current lines.
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The Current line colour dialog accessed from the Appearance tab properties dialog.

Labels

• Labels Start/Labels End – this option places the line name that identifies 
the traverse at either the start and/or end of the traverse. 

• Text Style – Use this button to display the Font dialog to control the font, 
colour and font style (bold, italic etc) of the line labels.
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The Font dialog for line labels Text Style accessed from the Appearance tab properties 
dialog.

• Display every “n-th” label – When working with large datasets in Encom 
Discover PA it can be difficult to view clearly a flight path map of the 
survey lines with labels and flight direction symbols. The option to display 
every “n-th” label provides a manual drop-out of labels. 

Symbols

• Symbols Start/Symbols End - By default a filled triangle symbol is used 
to indicate the direction of acquisition for a traverse. Activate the Symbols 
Start and/or Symbols End tick boxes to display these.

• Symbol size – enter the font size (in millimetres) of the symbol used for 
showing the start and end of the lines.

The parameters for showing line start and end Symbols dialog in the Appearance dialog.
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Displaying Lines

A variation of the Flight Path map is to add a Lines data object to a map. Using 
this display object it is possible to specify the lines required and so a subset of 
traverse lines can be displayed. It is useful also if, for example only tie lines or 
traverse lines are to be displayed.

A Lines display can also be used for presentation of data along lines. The line 
control has the same controls as profiles for line style, symbols, rotation and 
labelling. Refer to these controls for details.

An example of a Lines display is below where the Lines branch in the Workspace 
tree has specific line styles defined to be modulated by another data channel (for 
example, magnetics or altimeter). 
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Lines display using specific presentation applied to traverse lines

Displaying Points

Data points can be added to a map display. Points can be randomly distributed 
across a map area and need not be clustered into a line relationship even though 
they can be for ease of manipulating groups of points. 

Point data can be sourced from Geosoft montaj or MapInfo Professional .TAB 
datasets. Once available, follow the steps below to add points to a map:

Step 1

Ensure a suitable dataset to be used for a points display is available.

Step 2

Step 3

Display the Properties dialog of the Points branch. From this dialog ensure the 
correct data is selected from the Fields tab. You may need to select or deselect 
individual point items as required. Click the Apply button.

Select the map to have points displayed. Click, the Points button from the Data 
Object toolbar or use the Insert>Data Object>Points. A Points branch will be 
created in the Workspace tree.
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Step 4

Configure the points as necessary using the Symbols tab. Note that you can 
modulate the colour and size of displayed points according to values defined by 
a data channel. Different controls are available for the colour look-up, upper and 
lower sizes of displayed points and the units of their size.

An example of a points display with Synbols tab Points Properties dialog.

Stacked Profiles

A stacked profile is a graph of a nominated channel displayed along a traverse 
base line. Stacked profile presentations of line oriented data are frequently used 
in geophysical data analysis.

Advantages offered by stacked profiles include:

• Anomaly positions can be made to lie in their correct location.

• Subtle trends and anomaly correlation from line-to-line can be extremely 
sensitive and often more so than as presented using contouring or 
imagery.

• Various filter operators can be applied to line data and optimally presented 
in stacked profile form.

• Stacked profiling is independent of traverse line leveling problems.
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Stacked profiles created within Encom Discover PA offer the following features:

• Control over clipping (high and low) thresholds.

• Filling of profile above or below a definable baseline (a variable area 
presentation).

• Linear or logarithmic scaling.

• Clipping of upper and lower thresholds of data.

Example stacked profile map

Stacked Profiles can be displayed in Encom Discover PA using two different 
methods.

1. The Stacked Profile tool, accessed from the Display Utilities menu. 
This tool creates a vector file of a nominated channel from a database 
displayed along a traverse base line. Refer to Stacked Profiles Tool.

2. Within a 2D Map display, with a database open in Encom Discover PA, 
add a Stacked Profile data object. 

Stacked Profiles created within a 2D Map Display can be sourced from Geosoft 
montaj or MapInfo Professional .TAB datasets. Once available, follow the steps 
below to add Stacked Profiles to a map:
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Step 1

Ensure a suitable dataset containing line data to be used for a stacked profile 
display is available. 

Step 2

Select the 2D map to have stacked profiles displayed. Click, the Stacked Profiles 
button  from the Data Object toolbar or use the Insert>Data Object>Stacked 
Profile. A Stacked Profile branch will be created in the Workspace tree for the 2D 
map.

Step 3

Display the Properties dialog of the Stacked Profiles branch. From this dialog 
ensure the correct data is selected from the Fields tab. You may need to select 
or deselect individual lines from the Lines tab as required. Click the Apply button. 

Step 4

Configure the stacked profiles as necessary using the Colour, Appearance and 
Fill tabs. Note that you can modulate the colour and thickness of displayed lines 
according to values defined by a data channel. 

An example of a stacked profiles display overlaying a grid image.
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Displaying Vector Objects

Vector files can be displayed within a 2D display as a flat, planar drawing and 
combined with other 2D data objects, such as grids, stacked profiles and flight 
path lines. To display a vector file in 2D:

Step 1

Open a 2D Map display in which the Vector file is to be added.

Step 2

From the 2D Map branch of the Workspace tree, click the right mouse button to 
display the pop-up menu. Select the Add Data>2D Vector File option. Note that 
you cannot use the Add Vectors button of the Data Objects toolbar since, by 
default, it adds a 2D Vector branch.

Step 3

From the Properties dialog of the 2D Vector branch, display the Vector File tab 
and navigate to the folder containing the required file. The supported 2D vector 
formats are listed in Appendix E: Supported File Formats:

If necessary, you may need to apply a transformation of the data for vector files 
created using a different projection from that of Encom Discover PA. Select the 
Transform Parameters tab and set the required parameters in the Transform 
parameters tab.

Specify the 2D Vector file and any required Transform parameters

If a coordinate system transfer is required, click the Change buttons on both the 
source and target coordinate systems.
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Step 4

Once the 2D Vector file is specified, aspects of its appearance can be altered from 
the Colour tab. Control is provided over any displayed text, line colour, fill colour 
and background fill colour.

Control over the colours contained in the 2D vector file are available

Step 5

Control of the location of the 2D Vector file relative to other objects is done from 
the Z tab. This tab allows you to add or subtract a vertical offset to align the 
displayed 2D Vector file location as required, but in addition, the location of the 
2D vectors can be made to drape over a defined grid surface. Note that the 
gridded surface does not have to be one already used in the display.
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Multiple 2D vector files in a 2D map display consisting of surface geology, structural data 
and culture.

Save Map Extents as Vector File

It is often useful to be able to create a vector file consisting of a rectangular region 
representing a project area or an area of interest. The pop-up menu option for 
Save Map Extents as a Vector File allows a vector file of the current 2D map 
extents to be created. This menu option is accessed when the Map 1 branch in 
the Workspace Tree is clicked on with the right mouse button.
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The Save Map Extents as a Vector File option is accessed from the Map 1 pop-up menu. 

This will open the export dialog as shown below. The Map Extents values for 
minimum and maximum X and Y coordinates are automatically populated from 
the zoom level in the 2D map window.  

The output vector file can be created in one of the following file formats:

• ESRI Shape file (.SHP)

• AutoCAD DXF file (.DXF)

• MapInfo .TAB file (.TAB)
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• MapInfo Interchange MIF file (.MIF)

• GOCAD vector file (.TS, .PL, .VS)

• Encom located image (.EGB)

Other options include the specification of the Coordinate Projection system that 
the output vector file is saved in and the line colour, pattern and thickness of the 
rectangular polygon representing the region of the map extents.

This vector file can then be loaded into one of the display window types in Encom 
Discover PA, namely 2D maps and 3D displays.

Example 2D map mosaic of various data objects with the map extents vector file shown in 
each map. 
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14 Three-Dimensional Displays
In this section:

• About Three-Dimensional Displays

• Drag-and-Drop 3D Displays

• 3D Display Workspace Tree

• 3D Map Properties

• Creating 3D Displays

• View Surface Images in 3D Displays

• View 3D Flight Paths

• View Line Data in 3D Displays

• View Point Data in 3D Displays

• 3D Vector Displays

• Located Images in 3D Displays

• Drillholes in 3D

• 2D Vector Objects in 3D

• 3D Vector Objects in 3D

• Section Profiles in 3D Displays

• Voxel Models in 3D

• Feature Objects in 3D

• Animation of 3D Displays
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About Three-Dimensional Displays

Encom Discover PA can display a wide variety of objects in 3D displays. Each 3D 
display is placed in a 3D Map within a Map Frame. Objects that can be displayed 
in a 3D Map include the following:

• Surfaces and multiple surfaces (grid groups).

• Flight paths

• Georeferenced located images

• Drillholes

• Voxel models

• 3D objects such as DXF vector files

• Point displays

• Multiline or single curves

• Sections and multiple sections (section groups)

• Features

Drag-and-Drop 3D Displays

A large number of file formats are available to be loaded into Encom Discover PA 
using the “drag and drop” facility. Wiith Windows Explorer open (or with the 
Explorer tab displayed in the Encom Discover PA Information Sheet) navigate to 
the appropriate file locations and either individually or multiply select the files. 
Then hold the left mouse button down and drag them into the Encom Discover PA 
interface window, before releasing the mouse button to “drop” the files into the 
application. 

If a 3D document window is already displayed in Encom Discover PA the files will 
be added to this window. If no document window is displayed an option dialog will 
appear allowing you to choose how to display these files. In the example of 
multiple grid files being loaded into a 3D Map Window using the drag and drop 
facility the below Drag and Drop dialog will appear:

Note Controlling the 3D Map display requires special commands and operation since 
three directions and axis are used. For details of 3D Navigation and use of the 
various 3D tools (e.g. 3D cursor operation), see 3D Navigation and Animation.
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The Drag and Drop dialog for displaying a grid file in a 3D map window.

To display the selected grid(s) in one 3D Map window select the 3D Map option. 
This will produce a 3D map window with a Grids branch in the Workspace Tree 
with the grid file displayed within it. If multiple grid files are selected in the one 
drag and drop operation then a Grids branch for each grid file will be added to the 
Workspace Tree.

Chapter 14 - Three Dimensional Displays> (after Drag And Drop 3D Displays)

3D Display Workspace Tree

When a Document containing a three dimensional Map is initially created, a 
simple Workspace tree is displayed. Beneath the Document is a Map Frame 
similar to 2D Maps and Profiles.

The 3D Map Frame has properties relating to Appearance (see Appearance Tab). 
The generic dialogs used to control the same features of frames in other display 
documents are described in Display Properties

Note The drag and drop facility is also available for importing Geosoft .GDB 
databases, located images, 2D and 3D vector objects and other data files.
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3D Map Properties

Below the 3D Map Frame branch of the Workspace is the 3D Map branch. The 
options specified in the 3D Map Properties dialog control the title, appearance, 
lighting, coordinate projection and scaling of the 3D Display Window. The 3D Map 
Properties has four tab dialogs:

• Title Tab

• Appearance Tab

• Lighting Tab 

• Scale Tab

Title Tab

3D Map Properties Title Tab dialog

The Title tab allows control over the positioning, style and content of a single 
graph title. You can show or hide the title (Show Title), select a text style and 
colour (Font button) and set the title content. The title can be located where 
desired. The title text can be directly typed or you can request Encom Discover 
PA to enter text strings as Variable Substitutes. A wide range of variable strings 
can be used and these are substituted for logical text (if available) at the time of 
drawing. A preview of the final title text is displayed beneath the coded title string 
as shown:
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Variable Substitutes

Variable Substitution assists you to label graphs by substituting text items that 
may be variable in nature. For example, the line name for a profile may need to 
be altered for each update of the profile.

Substitution strings are automatically created for you if you use the Add button to 
append a variable. The substitute name is enclosed in % characters. The case is 
not important. Many other substitution variables are also available.

Variable Description

NAME Data field name as reported in the name channel in 
the spreadsheet.

PROPNAME Data field name derived from properties specifiers. 
It is the field name recorded in the properties file.

ALIASNAME Some data channels can have aliases and these 
can be used to name the data presented.

DBASENAME The database file name. the true field name stored 
in the database.

FULLNAME The full field name contained in the source 
database. It is a constructed name combining the 
database name and the field.

UNITS Units of the data channel if available—a string 
derived from information in the properties file.

LINE The line name of the source profile.

BANDNAME Data channel used as the source for the profile.

DATASET The name of the database source.

GRAPHNUMBER The incremental number used for each profile 
graph.

ANNXNAME X axis assigned name.

ANNYNAME Y axis assigned name.

ANNCNAME Chord length axis assigned name.
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Title Positioning

The title can be positioned anywhere in a profile area. It can be automatically 
positioned using the Offset switches, justification flags and text anchor. When the 
Offset switches are enabled, the title is positioned relative to the data plotting 
area. Otherwise, it is relative to the edges of the profile. For final adjustment, a 
manual page offset setting is available which moves the title X and Y millimetres 
from the specified plotting position.

Graph title position

Appearance Tab

Each 3D Map exists within a 3D Map container (or frame). It occupies one cell of 
this frame (see Working with Graphical Objects). A frame cell has an inner margin 
specified in millimetres, that can be set in the Appearance property dialog of the 
3D Map Frame. By default, this inner margin is set to zero.

Surrounding the 3D Map frame is its own outer and inner borders. The outer 
border is used for registration with the enclosing cell and the inner border forms 
the enclosing extent of the data limits. If the frame cell inner margins are zero then 
the plot outer border plots coincident with the frame border. For this reason, the 
plot outer border is not shown by default.

The appearance of the frame borders, background and margins within its frame 
cell are controlled by the Appearance property page.
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The 3D Map Appearance tab dialog

You can show or hide the inner and outer plot borders of the frame and alter the 
line styles of these borders. If Show Background is enabled, the 3D map has 
background colour. By definition this means the 3D Map is no longer transparent 
and over-plots underlying objects. You can specify the colour of the inner plot 
area and outer plot margins separately.

The size of the outer plot margin (specified in millimetres) is generally determined 
by what axis annotations are displayed in the margin. However, you can specify 
the minimum size of the outer margins from this property page. The inner plot 
margin is a redundant feature that allows you to define a margin within the plot 
data area. These offsets can be used in combination with the Grid Cell margins 
that are definable in the Appearance tab.

For 3 dimensional displays you can also have a 3D box surrounding the area of 
the presentation. 
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Lighting Tab 

3D Map Properties Lighting Tab dialog

The Lighting tab of the 3D Map Properties dialog controls the lighting displays 
for the 3D Display Window. Two light modes exist, Directional and Global 
Ambient.

Directional lighting enables a choice of three lighting modes. Directional light 
enables the casting of shadows and can give the 3D display the appearance of 
depth, and highlight variability in terrain.

Ambient: Select a colour for the general light or illumination of objects displayed 
in the 3D Display Window. For example, if white is selected the objects in 3D will 
appear very bright and illuminated; if black is selected objects in 3D will appear 
dark with a low brightness level, independent of the light direction.

• Diffuse: Select a colour which will be used to cast shadow effects on 
undulating objects or topography. Generally, shades of grey produce the 
best effects. Diffuse light gives the appearance of a unidirectional light 
source.

• Specular: Select a colour to be used for highlights in the 3D Display 
Window. Highlights are objects or surface facets perpendicular to the 
lighting direction.

Note The 3D window mode is toggled from the View>Normal or View>Page Layout 
menus.
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The Light Position Angles control contains a dynamic ellipse to define the 
Horizontal and Vertical positions of the directional light. The light source direction 
can be modified by pressing and holding down the left mouse cursor over the red 
cross on the ellipse and moving to an appropriate position; or by manually 
adjusting the Horizontal and Vertical values.

The Fixed direction option will fix the light source direction as specified on the 
ellipse independent of the position of the 3D Display Window axes. If the option 
is not selected the light position is defined by the axes position in the 3D Display 
Window.

Global Ambient lighting enables one lighting mode, and refers to the general 
light conditions. Global ambient light doesn't allow the generation of shadows or 
highlights.

• Ambient: Select a colour for the general light or illumination of objects 
displayed in the 3D Display Window. For example if white is selected the 
objects in 3D will appear very bright and illuminated; if black is selected 
objects in 3D will appear dark with a low brightness level.

Scale Tab

3D Map Properties Scale Tab dialog

The Scale tab of the 3D Map Properties dialog allows the X, Y and Z axes along 
with the 3D objects to be scaled independently along each axis. This can be 
achieved by manually entering a scale factor or by adjusting the slider bar.
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The Datum scale correction should be selected when using Latitude/Longitude 
datasets to equilibrate the X, Y & Z axis units. A datum scale correction is 
normally required with Latitude/Longitude datasets as the X and Y values are 
located in decimal degree units whist the Z values are located in metre units. This 
unit difference can make the dataset appear distorted. This can be disabled, 
allowing manually scaling via the Z axis control.

The Scale tab is also the location for defining the coordinate projection of the 3D 
display. To define the coordinate system, enable the Coord Sys option and then 
either choose a projection previously used in Encom Discover PA from the drop-
down list available or else press the Set Projection button to select the 
coordinate projection system from the list of available projections as shown 
below.

Select a coordinate projection system from the available list.

Creating 3D Displays

3D displays are created by:

Note The scaling factors will apply to all datasets within the 3D data window. To scale 
a dataset independent of the global scaling, use the appropriate scale options 
within specified object property dialog.
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• Using the File>New>Map>3D Grid Map menu item, or

• From the New Document Wizard and selecting a 3D Map Frame with the 
items required.

When a 3D Map display is initially created the Workspace tree appears similar to 
the one shown. By definition, the 3D Map has a Grid or a Flight Path branch in the 
tree (depending on which option you choose above).

• Clicking from the Documents pull-down toolbar item for maps, or
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Once the 3D Map is available in the tree, you can configure the objects within it. 
Alternatively you can add any of the various supported 3D display types. A list of 
the available types is obtained from a pull-down menu that is presented when the 
3D Map branch is highlighted and the right mouse is pressed.

As you select any of the menu items, they are added to the 3D Map Workspace 
tree and are ready to be configured.

An alternative method of adding objects to the 3D Map is to highlight it and then 
click one of the object types displayed in the Data Objects toolbar. 

Other 3D displays operate in fundamentally the same way. For example, a 3D 
Graph (created from the File>New>Map>3D Graph option) or 3D Graph button   
creates a Workspace tree similar to the 3D Map, but it will be called a 3D Graph 
branch. A 3D Scattergram is identical and in both these cases, other objects 
such as Curves and Points etc can be added. The choice of objects for these 
object types is not as wide as for a 3D Map.
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In a 3D Graph there is no restriction on the use of axes to plot 3D data within 3D 
space. In a 3D map there is no option to control the location axes and the defined 
X, Y and Z data fields are used to locate the objects refer to the Modify X, Y Z 
option if you need to change these fields).

Within the displayed 3D windows you can zoom in and out, roam, pan and fly-
through. Intersected surfaces can be travelled through and treated as if a volume 
were being intersected. See 3D Navigation for information on controlling views.

View Surface Images in 3D Displays

To control a surface in a 3D Map, initially a Surface branch must be present in the 
Workspace tree (as described above). The Surface object has the following 
property dialog.

Grids properties dialog for a 3D surface display

Two modes of operation are available for this dialog:

• Expanded View – The Expanded View dialog is divided into an image 
tree, control and preview area. Although providing greater control over the 
displayed imagery, the dialog in this format occupies a larger area on the 
screen and therefore may obscure underlying imagery or workspace.
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Expanded view of the Surface Properties dialog

• Compressed View – The same dialog can be compressed to only display 
the controls and smaller image tree area. No preview area is displayed. 

Compressed view of the 3D Surface Properties dialog

The dialog mode is controlled by the Compact/Expand button in the lower left 
corner of the dialog.
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Initially the surface is shown from one end and with low vertical exaggeration.

Initial view of a 3D magnetics surface

To orient the view, you may use one of two methods described in 3D Image 
Navigation. A look-at point crosshair in 3D views is seen when navigating. The 
centre look-at point and the cross-hairs are both removed as the proximity of the 
eye to the point reduces.

Note Control changes made in the Surface Properties dialog can be invoked 
immediately they are changed if the Auto Apply option (at the base of the 
dialog) is enabled. This option allows real time manipulation of imagery 
enhancement such as shading, colour changes etc.

The property dialog shows a new type of surface from a 2D dialog – the 3D 
Surface branch of the Grid Group tree. Specify a grid as for a 3D display into the 
surface using the wizard button. Click Apply and the surface is displayed. Note 
that a depth surface has both Colour and Surface sub-branches. The Colour 
branch is the source of colour data for the surface facets. The Surface branch is 
used for the surface shape and location. You can load different grids into the 
Colour and Surface layers. The Colour layer is controlled in exactly the same 
way as a pseudocolour algorithm layer.
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Scaling 3D Surfaces

You may wish to exaggerate the surface vertical scale by changing the scale for 
the Z axis. This can be done on the Surface tab dialog by entering a Z Scale and 
Z Offset to position the image vertically. Alternatively, you can use a Z Scale 
slider bar. Note that when adjusting a Z Scale, this applies only to the 3D Surface 
of that surface layer. Note too that a value entered to the right of the slider bar is 
the actual factor used for Scale or Offset, but it also serves as a multiplier when 
used by the slider bar.

Surface dialog controls for scaling, offset and compression

If you want to adjust the Z scaling of all surfaces in a view, this can be done from 
the Z Scale control box or slider bar of the 3D Map Properties Scale tab dialog.
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Adjusting the Z Scaling control in the 3D Map Properties Scale tab dialog

Surface Compression

Another control on the Surface tab allows compression of grid surfaces. This 
feature permits Encom Discover PA to display and manipulate even large, 
complex surfaces quickly with little loss of surface detail. When Encom Discover 
PA displays surfaces, it applies a display algorithm that by default allows the 
presentation to be exceptionally fast but also accurate in its representation of a 
surface. By default, the Variable compression mode is used. If you wish to turn 
compression off, select the None option.

Options available for compression include:

• Variable - The current default which uses tomek grid compression. You 
can set the compression level using a slider bar. There are some options 
for switching off clipping if the algorithm fails.

• Constant - The grid is decimated. This as the default setting where the 
grid is decimated in three ways based on the decimation mode. .

• None - No compression is performed and the grid is displayed at full 
resolution. Care using this option is advised as this option allows no limit 
to memory usage.
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Variable Compression

You can select the degree of Variable compression and access properties via the 
Properties button. 

Surface compression properties controls on the Surface branch of the Surface Properties 
dialog.

The Clip modes are provided in an attempt to handle situations where holes or 
complex grid layouts can cause the variable compression to fail. Turning off the 
clipping entirely will resolve most circumstances.

Constant Compression

The Constant compression approach uses a simple algorithm to decimate the 
number of rows and columns of a grid used in a display. This approach allows fast 
display of the grid but may not reveal the best texturing and show all data 
contained. 

Constant Compression dialog to specify the required algorithm
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The Decimation mode options available to Constant compression are:

• System size - The grid is decimated until it is smaller than the system 
settings. These settings are defined in the options property sheet.

• User size - The grid is decimated until it is smaller than the user size 
setting.

• User decimation – You can set the skip factor in X and Y, that is, it 
displays every nth point. By default this parameter is set to 1 for both the X 
and Y directions.

Fill and Lines of Surfaces

The 3D Surface properties dialog has three options for Fill, Fill + Lines and 
Lines. These options relate to displaying the surface as a filled surface, surface 
with lines or with only the triangulated lines. By displaying the Lines option only, 
you can make a judgement about the level of grid compression being used by the 
Compression mode option (see above). The grid display compression tends to 
have few triangular facets in a presentation in low gradient areas and a high 
number in steep gradient areas. An example of Line display with constant 
compression is shown below:

Lines displayed instead of the filled surface to assess the grid compression
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Applying Offset to 3D Surfaces

The position of a grid surface in space depends on the data values assigned to 
the Z field of that surface. For example, the effective elevation of a topographic 
surface may be, say 300 metres. However, it may be desirable to place a 
magnetics surface above the topographic surface and the amplitude or Z values 
of the magnetics surface may be say, 57,000 nT. 

You can control the Z offset of surfaces by applying a specific offset amount or 
offsetting automatically by having the software adjust the amount of offset to be 
the grid surface minimum, maximum or average value. A slider bar is also 
available for interactively raising or lowering the surface. 

Once an offset is determined it can be locked such that introducing other objects 
(like lines, other surfaces or graphical objects) do not readjust the offset.

Using the Stack, Scale and Reset buttons of the Grids image dialog

You can use a 2D image map to zoom and pan around the same grid in a linked 
view in three dimensions. You can also use local colour stretches in the 3D 
display using the same technique (that is, specify the 2D data range by data 
zooming and panning in a linked 2D map).

Note To automatically allow these surfaces to be brought together and stacked for 
viewing, select the Grid Group branch of the image tree and click the Stack 
button followed by the Apply button. Similarly, to present the surfaces with 
suitable scaling for the display window chosen, you can click the Scale button. 
The Reset button returns the surfaces to their initial default scalings and offsets.
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The Stack button operation effectively adjusts the surface offsets to force them 
to lie within the display area. If you need to slightly move the surfaces up or down 
from their recomputed positions, use the Z Offset controls (see above).

The Scale button operation adjusts the vertical exaggeration of the surfaces to 
optimally suit the 3D display. If adjustments to the exaggeration are still required, 
use the Z Scale slider controls (see above).

Surface Colour

The control for surface colour is identical in operation to that of the 2D surface 
controls. Refer to Controlling a Colour Layer for details.

Texture Mapping

Within Encom Discover PA a computer display method called texture mapping is 
used to quickly render images that drape over a surface. A compromise is made 
between the quality (resolution) of the drawn image and the speed of drawing. An 
upper limit on the resolution that can be physically supported is imposed.

This limit is imposed by graphics card drivers, not by the software or its OpenGL 
display system. An upper display limit (not data limit) of 1024 x 1024 was found 
to be the maximum reliable texture size several years ago. Limits imposed by 
modern graphics cards are now higher.

Two options within Encom Discover PA are provided to control texture map size. 

• One method uses a simple Texture Quality setting in the properties 
dialog of the 3D Surface. This allows Low/Medium/High Quality settings.

• The second method provides greater control and is available from 
Tools>Options>Size. 
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Size tab of the Options menu for Texture sizing

The Texture Size options allow entries for the maximum size of textures that are 
tailored to suit your graphics card.

On some graphics cards, texture sizes above 1024 are supported (up to 4096), 
but only if a texture interpolation method (called MIPMAP) is provided by the card. 
By default in Encom Discover PA, grids use this mode but controls on the Size 
tab allows it to be set explicitly. MIPMAP is the highest quality display mode. 
Located Image files generally use this mode anyway, but you should be aware 
that if this mode is not supported but enabled, your image may not be visible.

Specifying a maximum tile size does not guarantee that tile size is used in a 
Located Image file. When an image exceeds 1024x1024 pixels in size the 
software conserves memory and re-samples it to a power of 1024. It then 
determines a tile size that results in an integer number of tiles. Therefore to make 
best use of graphics memory, design the original image carefully. Make it a power 
of 2 and make it perfectly divisible by the maximum tile size (if you want an image 
that is that large).

Export to Google Earth (.KML)

It is possible to export a draped 3D surface to a geo-located image for use within 
Encom Discover PA or Discover 3D or Google Earth. This is possible using the 
Export to Located Image pop-up menu option, which is accessed when the 3D 
Surface branch in the Grid Group Tree is clicked with the right mouse button.
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The export to located image option is accessed from the 3D Surface pop-up menu.

The two available output file formats are:

• Encom located image file (.EGB)

• Google Earth file (.KML)

Output Image  

Use the parameters in the Output Image section to specify the image resolution 
and image file format. Choose from the following file formats:

• Portable Network Graphics (.PNG)

• JPEG Image file (.JPG)

• Tagged Image file (.TIF)

• Windows bitmap file (.BMP)
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The Export to Located Image dialog.

When working with a compressed grid (see Surface Compression) you can elect 
to store the current compressed grid in the located image .EGB header file as a 
triangle mesh. The located image file will not be dependent on the grid. By default 
the located image file just records the grid file name and current compression 
parameters. To enable this option select the Use compressed grid triangle 
mesh option.

3D Grid Flipper

Within the 3D Map window, the Grid Flipper allows the view to be rapidly switched 
between any open grid surfaces (similar in operation to the Grid Flipper of a 2D 
Map). This tool can be accessed via right-clicking on the Grids branch in the 
Workspace Tree and choosing Open Grid Flipper or from the Tools>Grid 
Flipper menu command. 

 In order for the Grid Flipper to operate in 3D displays multiple 3D surfaces need 
to be available from the Grid Group tree in the grids properties dialog such as 
shown in the example below:
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Example Grid Group tree for 3D surfaces.

Grid selection is either via Previous and Advance buttons, or through the pull-
down list. Clicking the Deactivate button will return grid display control to the 
Surface Properties dialog (in which grid display is controlled via the Turn On/
Turn Off options in the pop-up menu, detailed in Creating a 2D Grid Map).

  
Grid Flipper dialog in manual (left) and automatic (right) mode
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View 3D Flight Paths

A three-dimensional equivalent to the 2D view of a flight path can be displayed 
using either the menu option File>New>Map>3D Flight Path Map or the pull 
down menu item as shown.

The 3D view displays the flight path of the selected dataset and has an elevation 
equal to the Z value defined by the Z data field in the database.

Example of a 3D flight path map

Properties of the flight path display are identical to those of a two dimensional 
presentation. Note also that additional layers (images, bitmaps, models etc) can 
be added to the flight path display. In addition 3D internal axes can be added to 
assist in locating within the display.

Conventional 3D cursor navigation is available in the display. In particular also 
review the Example: Flight Path over a Grid Surface.
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If you wish to have the Flight Path displays modulated by another data channels 
(such as Altimeter), refer to View Line Data in 3D Displays.

View Line Data in 3D Displays

Data derived from lines stored in an available database can be shown in 3D 
displays. The data lines can be enhanced in the display by:

• Offsetting vertically by a nominated data field.

• Colouring to a specific colour or colour modulated by a nominated data 
field.

• Colouring above or below a preset data value (average, minimum, 
maximum etc).

• Symbols with size and colour modulation can be added.

• Labelling of data values can be applied.

• Data displayed can be transformed.

Follow these steps to add a line display to a 3D Map:

Step 1

Create the 3D Map as described in Creating 3D Displays. 

Step 2

Highlight the 3D Map branch of the Workspace tree and click the right mouse to 
display the pop-up menu to Add Data. Choose either a Curve (for a single data 
line) or Lines (for multiple and selectable line displays). When selected, a new 
Curve or Lines branch is added to the 3D Map. A faster method of adding a 
Curve or Lines branch to the tree is to select either the Curve or Lines button  
from the Data Objects toolbar after the 3D Map is selected.

Note The following steps apply to both the Curve or Lines branch items. The only 
difference between the two is that the Curve item controls only a single traverse 
whereas the Lines item can control many data traverses.
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Step 3

Display the Lines Properties dialog. Select the Fields tab and specify the Z and 
Offset data fields. These fields define the elevation position (Z) and the data field 
to use for scaling the data (Offset). 

Specify the Z (elevation) and the Offset (scale data) fields

Step 4

With the data line(s) displayed, you can then modify the properties to add or 
control the colour, line style, symbols, labels and any additional transformation.
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Controlling the Appearance of 3D Lines

The appearance of the lines is described in Curve Properties. 

To display lines as tubes, select the 3D Line Style tab from the Line Properties 
dialog, and tick the 3D Tube option. A number of tube shapes are available. 
Select one from the list, and enter a Thickness for the tube. 3D Tube Styles can 
be created using the TubeShape Manager. Refer to Tube Shape Manager.

Use the Line Style tab to adjust the tube colour or modulation

Symbols

The Symbols tab of the Curve Properties dialog enables the following 
modifications to be made to the vertices of point data:

• Change the point symbol type 

• Display points as 3D symbols based on True Type fonts, with controls over 
symbol orientation, extrusion and positioning

• Change the size and colour of the point symbol

• Display every point sample or a specify sample interval to display

• Modulate point data colour, symbol size or symbol rotation using values 
from other fields in the table and colour tables and legends.
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Symbol control dialog tab

To access this dialog ensure the Show Symbols option is ticked. To quickly 
display point data using the default square symbol check the Fast Symbol option. 
This is a memory-efficient display method, and recommended when using very 
large datasets. 

Symbol Selector dialog

To customise the symbol display, ensure the Fast Symbol option is deselected 
and click in the Symbol box. This opens the Symbol Selector dialog. A range of 
symbol libraries is available from the pull down list at the top of this dialog, with 
the selected symbol previewed to the right. The symbol colour and size can also 
be altered here. Three Orientation options are available at the bottom of this 
dialog:
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• None – Symbols are displayed in the X/Y plane

• Keep text in the view plane – Symbols are aligned parallel to the 
viewing/screen plane

• Optimum Orientation – Symbols are placed in the principal plane (XY, 
YZ or XZ) closest to the viewing/screen plane.

Advanced Symbol Style Options dialog

The Advanced button opens the Advanced Symbol Style Options dialog, 
which provides further symbol controls. These include:

• The symbol format, including Polygons (default), Line Segments and 
Bitmaps. Note that Bitmaps do not have Orientation control.

• Extrusion control, expressed as a percentage of the symbol’s size. The 
symbol is extruded perpendicular to its display plane, that is if a polygon 
symbol is displayed in the XY plane (Orientation None), it is extruded in 
the Z direction. To display a flat symbol, set the Extrusion to 0%.

• Constraint options for plane selection when using Optimum Orientation

• X, Y & Z Alignment and Offset Position Controls
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• Size Controls, allowing specification of view size limits.

The symbol colour and border can also be changed using the Line Colour and 
Fill Colour buttons in the Symbols tab dialog. The Skip value determines what 
interval of point data samples is displayed in the 3D map window. For example, 
to display every 5th point data sample enter a Skip value of 5. 

To Modulate Colour select the data field to use for the modulation and a colour 
look-up table or legend to use. See Colour Table Editor for more information.

To Modulate Size select the data field to use for the modulation and enter a range 
for the minimum and maximum modulation size. The size may be specified in 
millimetres, page points, screen points or percentage.

To Modulate Rotation select the data field to use for the modulation enter the 
angle and scale. The rotation of modulated symbols can use either radians or 
degrees anti-clockwise. An example of a 3D display with symbols and the Fast 
Symbols enabled is shown below:

Multiline display of magnetics in a three dimensional display with symbols

Note Displaying points as 3D Symbols requires extensive computer memory 
resources; it is recommended to minimise dataset size if doing so.
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View Point Data in 3D Displays

Data derived from observed points stored in an available database can be shown 
in 3D displays. The data points represent sample locations in a survey that can 
be randomly placed (such as a gravity or geochemical survey). The points may 
not tend to be acquired along regular linear trends (or the Lines display format 
could be used) however, data displayed using 3D points can also be connected 
by lines if required. Point displays can be enhanced in a 3D display by:

• Offsetting vertically by a nominated data field

• Colouring to a specific colour or colour modulated by a nominated data 
field

• Symbols with size and colour modulation can be added

• Labelling of data values can be applied

• Data displayed can be transformed.

Follow these steps to add a Point display to a 3D Map:

Step 1

Create the 3D Map as described in Creating 3D Displays. 

Step 2

Highlight the 3D Map branch of the Workspace tree and click the right mouse to 
display the pop-up menu to Add Data. Choose the Points menu item. When 
selected a new Points branch is added to the 3D Map. A faster method of adding 
a Points group is to select the Points button   from the Data Objects toolbar once 
the 3D Map is selected.

Step 3

Highlight the 3D Map branch of the Workspace tree and click the right mouse to 
display the pop-up menu to Add Data. Choose the Points menu item. When 
selected a new Points branch is added to the 3D Map. A faster method of 
adding a Points group is to select the Points button from the Data Objects 
toolbar once the 3D Map is selected.
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Step 4

Display the Points Properties dialog. Select the Fields tab and specify the Z and 
Offset data fields. These fields define the elevation position (Z) and the data field 
to use for scaling the data (Offset).Specify the Z (elevation) and the Offset (scale 
data) fields.

With the data points displayed, you can modify the properties to add or control the 
colour, symbols, labels and any additional transformation. Adjustment to data 
values can be applied by the Transform tab or compression and data skipping can 
be applied from the Decimation tab.

Controlling the Appearance of 3D Points

The appearance of the points is described in Curve Properties. 

To customise the symbols displayed, ensure the Fast Symbol option is 
deselected and click in the Symbol box of the Symbols tab. This opens the 
Symbol Selector dialog. A range of symbol libraries is available from the pull down 
list at the top of this dialog, with the selected symbol previewed to the right. The 
symbol colour and size can also be altered here. Fast Symbols are provided as 
this is a memory-efficient display method, and recommended when using very 
large datasets. Refer to Symbols Tab for further information.

An example of a 3D display with symbols and Fast Symbols enabled is shown.
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Points display of magnetics in a three dimensional display with symbols

Labelling of 3D points is controlled from the Label tab. 

Label and font controls
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The Advanced button provides extensive control over the text style of the labels 
for:

• Font

• Size 

• Orientation in the 3D view

• Position (in X, Y and Z directions)

• Alignment and Offset

The dialog used to control these features is shown below:

• The Font format, including Polygons (default), Line Segments and 
Bitmaps. Note that Bitmaps do not have Orientation control.

• Extrusion control, expressed as a percentage of the text size. The text is 
extruded perpendicular to its display plane, i.e. if a polygon symbol is 
displayed in the XY plane (Orientation None), it is extruded in the Z 
direction. To display a flat symbol, set the Extrusion to 0%.

• Constraint options for plane selection when using Optimum Orientation.

• X, Y & Z Alignment and Offset Position controls allow offset of the text 
labels from the associated point data location.

Dialog to control the appearance of labels
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3D Vector Displays

A Vector Series data object type is available in Encom Discover PA , which is 
designed to display vector and tensor data in 2D and 3D graphs and maps.

A 3D vector is defined by its origin and the x,y,z components or an origin with 
amplitude, dip and azimuth. The first is used to visualise vector magnetometer 
data and the second for dip and strike style measurements. 

A tensor on the other hand can be thought of as a collection of three vectors all 
located at the same origin.

Encom Discover PA uses a database to provide the X, Y, Z coordinates and 
component fields. The direction of the vector can be defined by rotation angles 
(origin and rotations), requiring two angles – a Y-axis rotation and a Z-axis 
rotation. In 2D however this just requires a single Z-axis rotation.

An example of 3D Vector series with modulated colour and size applied.

Note Displaying points with 3D text requires extensive computer memory resources. It 
is recommended to minimise dataset size if doing so.
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Mode

Select either vector rendering or tensor rendering. When rendering vectors you 
will need to define the origin coordinate and the components. The components 
can be sourced from different fields. When rendering tensors you will need to 
define the origin coordinate and up to three sets of components (one for each 
vector in the tensor). The components for each vector in the tensor must be 
sourced from a single field. It follows that field needs to be multi-banded.

Data Source

Specify how the vectors are defined. A vector can be defined by two points in 
space (origin and head positions). In this case the ‘components’ specify an 
additional point in space. It can be defined by vector components (origin and 
components) where each component specifies the displacement of the head from 
the origin in a certain dimension. Finally, the direction of the vector can be defined 
by rotation angles (origin and rotations). In 3D this requires two angles – a Y axis 
rotation and a Z axis rotation. In 2D this just requires a single Z axis rotation.

In the first two cases the length of the vector is defined by the specification of the 
origin and components. In the last case the length remains undefined and will 
initially be assigned a unit length.

Centre the vectors on the origin position

Moves the origin and head positions after the vector has been defined so that the 
vector is centred on the origin position. This is useful when displaying tensors and 
will result in the familiar tensor ‘hedgehog’ display.

Reverse the head and tail positions

As a final processing step, reverses the head and tail positions so that the head 
is rendered at the origin.
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The Vector tab dialog specifying the mode and data source.

Apply global axis scales to the vectors

Generally we want to see vectors displayed in isotropic space. If this option is ‘off‘ 
then regardless of the scaling of the X, Y or Z axes, the vectors will always be 
displayed in isotopic space. If turned on the vectors will be scaled along with the 
space.



416 Encom Discover PA User Guide

Line Selection

All the source data for the vectors must be derived from fields in a single database 
which is selected via the ‘Lines’ property page. You can select multiple lines as 
the source for the vector data. This can be done via the line lists or via the 
graphical selection dialog.

The Lines tab for specifying active lines for vector display.

Vector Origin Specification

The source data for the origin of the vector or tensor as well as the station 
selection are defined on the Origin tab dialog for the Directional vectors 
Properties.  Specify the X, Y and Z fields if these have not been automatically 
selected for you. Although the fields may be multi-banded you can only select one 
band from each field.

The optional offset field defines an additional offset which is applied to the Z 
coordinate by simple addition. If the vector components are defined as an 
additional coordinate then this offset will be added to the Z coordinate of the 
component data as well.
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The Origin tab for the allocation of the spatial fields and station decimation.

For all origin fields data conditioning is available. The data conditioning dialog 
allows you to apply on the fly processing to the input data to clean up data errors 
or otherwise improve the data prior to display. The statistics explorer is accessible 
for the field data via the data conditioning dialog.

You can display every station or only a selection of stations from each line by 
either decimation or compression. Decimation allows you to display only the first 
or last station, or every ‘Nth’ station. Compression examines the X, Y and Z fields 
and compresses the stations so that the geometry of the line is preserved to a 
specified level of compression. A compression level of zero will result in no 
compression. The compression level can be set to between 0 and 100. Note that 
this only provides a hint to the compression algorithm. It does not imply that a 
level of compression of between 0 and 100% will be achieved.

XYZ Components

The Components property dialog allows you to define the data source for up to 
three vector components or the data source for up to three vectors of a tensor. 
The screen shot above shows all the available options on the components 
property page but depending on the mode and data source chosen some of these 
fields and buttons will be grayed or removed or additional buttons may be 
available.

When rendering a vector select the field/band combination for each of the 
components. These are defined in X Y Z order. If specifying rotations the X field 
buttons will be grayed out. The components can be sourced from different fields 
or from different bands in a single field.
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When rendering tensors you can specify the components for up to three vectors 
which comprise the tensor. In this case, the components must be sourced from 
multiple bands of a single field. The order of the bands cannot be specified so the 
bands must contain X, Y and Z data in that order.

The Components tab dialog for specifying the Z, Y and Z components of the vectors.

For all component fields data conditioning is available. The data conditioning 
dialog allows you to apply on the fly processing to the input data to clean up data 
errors or otherwise improve the data prior to display. When rendering a tensor the 
same data conditioning rules are applied to each component of the tensor vector 
whereas when rendering a vector each component has individual data 
conditioning rules. 
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When specifying rotation components (by specifying a Data Source in the Vector 
tab dialog of Origin and rotations) you can specify additional rules that modify the 
rotational data. These include:

• Scaling

• Scaling factor of a negative (e.g. -1) to be used to reverse the sense of the 
rotation (clockwise or anti-clockwise). 

• Units of the source data (degrees or radians) 

• Offset (specified in degrees). 

Length

The length of the vector or tensor will be determined by the choice of components 
or set to a unit length if the components are defined by angles. For display 
purposes this is usually inappropriate and so the length of the vector can be set, 
scaled and modulated in a variety of ways. 

• If you select Fixed value you can define the length as well as a scaling 
factor. The length of all vectors and tensors will be equal to the product of 
these two values.

• If you select Defined by component data then the length varies for each 
vector. A scaling factor can be specified to scale up or down the length of 
all vectors.

• If you select Defined by field then you must select a database field that 
describes the vector or tensor length. If you are displaying tensors then 
this field can be multi-banded to allow the length of each vector in the 
tensor to be specified. Data conditioning can be applied to this field. A 
scaling factor can be specified to scale up or down the length of all 
vectors.

• If you select Modulated by field you must select a database field that 
describes the vector or tensor length. However, the field value is not used 
unmodified – it is mapped to a specific length range which you also 
specify (‘From’ and ‘To’) via a mapping transform which you specify. A 
variety of pre-defined transforms are available as well as user-defined 
transforms. The process of defining a mapping transform is exactly the 
same as for colour modulation. Data conditioning can be applied to this 
field. A scaling factor can be specified to scale up or down the length of all 
vectors.
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Tail

The Tail tab dialog allows you to define whether the vector or tensor tail ought to 
be rendered and, if so, what style and thickness it will have.

Tails can be rendered as either colour lines (with a number of patterns) or as 
coloured tubes (using a number of cross sectional tube shapes). By default the 
Tube_Low shape is used which gives an adequately smooth tube with low 
graphics rendering overhead.

The Tail tab dialog allows control over the style and thickness of a vector/tensor.

The Tube Style dialog can be accessed from the Tail tab dialog for specifying the tube 
shape of the vector/tensor.
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The Tube Style button allows you to set the default colour of the vector/tensor 
tails. A default grey colour is specified and is also used for the default colour of 
the head of a vector/tensor. 

If you are rendering a tensor then there will be three buttons allowing you to set 
the colours of each vector in the tensor individually. This is useful when rendering 
tensor ‘hedgehogs’ as the X, Y and Y vectors can be rendered using a different 
colour or style. 

The thickness of the tail can either be a fixed value or it can be proportional to the 
length of the tail. In this case you must specify the minimum and maximum 
thickness values. Thickness modulation is only available when rendering the tails 
as tubes.

Head

The Head tab dialog showing parameters for editing the appearance of the vector’s head.

The Head tab dialog allows you to show or hide the heads of the vectors/tensors 
and to specify both the size and the rendering style of the head.

There are two rendering styles: 

• Display at tip - the most common style where the head symbol will be 
rendered at the tip of the vector. 

• Display tail to tip - the tail of the vector is not displayed and the head is 
rendered at the origin position and stretched over the length of the vector. 
You can use this option to create a ‘solid’ vector display.



422 Encom Discover PA User Guide

When activated the Anchor at head tip check box option will ensure the tip of the 
head coincides with the head of the vector, hence the head symbol will not 
“lengthen” the vector. If this option is turned off the symbol is rendered beyond the 
end of the vector. 

The head can be rendered using a variety of symbols listed below. Some of these 
symbols are simple line-work, others are flat filled polygons and others are 3D 
shapes. Only the 3D shapes use lighting.

The Vector head symbol style options list.

If you are displaying tensors and you choose the Tail to tip style option then only 
the Diamond 3D symbol option is available from the list. In this case a diamond is 
constructed from the three vectors of the tensor. The diamond is centred on the 
origin in this case. 

The head size can either be a fixed size, proportional to the tail length and thus 
varying linearly between two sizes you specify, or modulated by a database field. 
In the latter case you must specify the range of the head size and a mapping 
transform must be defined.

Data conditioning can be applied to the field data by clicking on the Field Data 
Conditioning button available.
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Colour

The Colour tab dialog of Directional Vector Properties.

The Colour property page allows you to define the colour modulation setting for 
both the tail and the head individually.

Colouring options for the Vector/Tensor Tail and Head include: 

• None - the element (either tail or head) will be rendered using the line 
style properties defined in the Tail tab dialog. You can construct a colour 
table by RGB or HSL interpolation or select any available colour table or 
legend. Note that only support for the foreground colour of legends is 
provided.

• By Length - the colour of the head or tail is modulated by the length of the 
vector. Data mapping can be applied but note that the mapping dialog will 
only be able to display statistics of the data in this case if the vectors have 
already been displayed. Prior to this no length information is available.

• By Field - choose any field in the loaded database to colour modulate the 
tails and heads by. Data conditioning can be applied to the field and a data 
transform and mapping must be specified. 
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The Colour Mapping dialog allowing the specification of a data transform.

Located Images in 3D Displays

If a Located Image is to be added to a three dimensional display, the image is 
required to be accompanied by an Encom Georeferenced Bitmap file (.EGB -  
refer to Appendix B: Data File Specifications for additional information). This file 
defines the image source file by name, its type and its corner co-ordinates. 

Externally created images of scanned data, seismic sections, IP sections, 
geological interpretations etc. can be located and placed within a 3D display. An 
example is shown below:
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3D Map containing numerous geological section bitmaps with a DTM grid surface

In this example, a magnetic surface is viewed with a series of parallel geological 
interpretation sections. These sections are derived from drillhole interpretations 
from the GIS package Encom Discover (refer to Integration With Encom 
Discover). As for all 3D views, the display can be manipulated and moved to see 
the view from the best location. You can fly-through the surface and sections and 
readily obtain a perception of the relationship between the geology and 
geophysics.

Located Images can be displayed within a 3D view by using the Images data 
option in the workspace tree (see below). Images are located by using an 
ancilliary file called an EGB file. The EGB file can be created with an ASCII editor 
or by using an image registration wizard (refer to Image Registration Wizard).
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Adding a Located Image to 3D Display

3D displays of Located Images are usually added to a 3D Map although they can 
also be added to a 3D Graph, 2D maps, profiles and sections. The steps required 
are:

Step 1

Create a 3D Map or 3D Flight Path Map using the File>New>Map>3D Grid Map 
or 3D Flight Path Map menu option (or from the appropriate buttons).

Step 2

With a 3D Map branch created in the Workspace tree, select the 3D Map item and 
click the right mouse button. From the Add Data menu item, choose Grids. This 
option creates a 3D map display as described in the Creating 3D Displays. 
Manipulate the surface as required with suitable vertical exaggeration and offset. 
Note that the data values of the displayed grid determine the vertical position of 
your display and this is important when displaying bitmaps with a different vertical 
position.
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For example, if you wish to display a magnetic grid (with average data values of 
say, 55,000nT) combined with geological sections (with vertical reference of say 
1-200 metres) as shown above, then an offset is required to bring the two data 
objects into a similar vertical reference frame. Typically therefore, you would need 
to reduce the vertical location of the magnetic grid down by about 55,000. Refer 
to Applying Offset to 3D Surfaces.

Step 3

You need to have prepared the necessary Located Image before display and 
these require associated .EGB descriptor files. Refer to Saving as a Located 
Image and Appendix B: Data File Specifications.

Step 4

Step 5

Display the properties dialog of the Located Image branch. Specify the path and 
.EGB file. You can use the Browse button to navigate to the required .EGB file.

Step 6

If the displayed map surface and image are widely separated, their vertical offset 
may require adjustment. This can be done either by editing the vertical location in 
the Offset tab of the Located Image properties dialog, or by interactively setting 
an offset amount in the surface display control. To do this, display the Grid Group 
properties dialog and highlight the Surface branch of the Grid Group tree. At the 
base of the dialog are controls to scale and offset the grid surface. Set this to an 
appropriate value by using the slider and increment entries. For information on 
editing Located Image Properties refer to Located Image Properties.

Drillholes in 3D

Drillhole traces, collars and recorded downhole information is ideal for display in 
three dimensional displays since their presentation by definition extends into the 
vertical direction. Encom Discover PA uses the 3D display format to present 
drillhole location and information in a variety of ways. Information can include 
assays or geological lithology.

For details of displaying drillholes and data in three dimensional displays, please 
refer to Adding Drillholes to a 3D Map. 

Select the 3D Map branch of the Workspace tree and click right. Select the Add 
Data>Located Image option. An Images item is added to the tree associated 
with the 3D Map. An alternative to this is to click the Add Image button from the 
Data Objects toolbar.
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2D Vector Objects in 3D

Two dimensional vector files can be displayed within a 3D display either as a flat, 
planar drawing or draped over a predetermined surface. To do this:

Step 1

Open a 3D Map display in which the 2D Vector file is to be added.

Step 2

From the 3D Map branch of the Workspace tree, click the right mouse button to 
display the pop-up menu. Select the Add Data>2D Vector File option. Note that 
you cannot use the Add Vectors button of the Data Objects toolbar since, by 
default, it adds a 3D Vector branch.

Step 3

From the Properties dialog of the 2D Vector branch, display the Vector File tab 
and navigate to the folder containing the required file. The supported 2D vector 
formats are listed in Appendix E: Supported File Formats.

If necessary, you may need to apply a transformation of the data for vector files 
created using a different projection from that of Encom Discover PA. Select the 
Transform Parameters tab and set the required parameters in the Transform 
parameters tab.

Specify the 2D Vector file and any required Transform parameters

If a coordinate system transfer is required, click the Change buttons on both the 
source and target coordinate systems.
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Step 4

Once the 2D Vector file is specified, aspects of its appearance can be altered from 
the Colour tab. Control is provided over any displayed text, line colour, fill colour 
and background fill colour.

Control over the colours contained in the 2D vector file are available

Step 5

Control of the location of the 2D Vector file relative to other objects is done from 
the Z tab. This tab allows you to add or subtract a vertical offset to align the 
displayed 2D Vector file location as required, but in addition, the location of the 
2D vectors can be made to drape over a defined grid surface. Note that the 
gridded surface does not have to be one already used in the display.
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Display of a 2D Vector file draped over a surface with grid and offset definition

3D Vector Objects in 3D

Encom Discover PA can display a range of three dimensional objects. Supported 
3D file format objects are listed in Appendix E: Supported File Formats.

An example of two 3D .DXF models imported into a 3D space is shown below and 
illustrates the use of 3D vector files with other data types (drillholes, located 
bitmaps, etc).

Note Additional vector file formats can be imported and converted using the 
Transform Vector File utility.
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DXF and GoCad files are loaded and their appearance is controlled from the 3D Vector 
properties dialog

Loading 3D Objects

When opening 3D files from Encom Discover PA a new, empty Vectors branch is 
added to the Workspace Tree. Display the Property dialog of this layer and use 
the Browse button to specify a 3D file after navigating to the appropriate folder. 
Note that the choice of file type (AutoCad .DXF, GoCAD TSurf or Gemcom .TB2) 
is made from the Open file dialog.

Select the 3D file format from the Files of Type pull-down option

Encom Discover PA can access supported 3D format files directly by selecting 
the Add Vector button  from the Data Object toolbar, or the Insert>Data 
Object>Vectors    menu option.



432 Encom Discover PA User Guide

Click the Open and then the Apply buttons after file selection and the object is 
displayed in Encom Discover PA. 

Display of an orebody and development DXF files with surface
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3D Vector File Properties

Encom Discover PA provides a number of controls to improve or alter the 
appearance of displayed 3D vector files. 

Vectors Properties tab dialogs for used for controlling and defining the appearance of a 3D 
vector file

The File tab has the following options:

• Apply a Smooth Surface of the object if the surface is faceted. The 
smoothing can be applied to facet angles sharper than a defined angle 
(sharp angle is in degrees).

• Reverse Facing - The defining facets can be reversed to allow the 
internal surface of the 3D file to be viewed. 

• Cull Back - To improve the speed of rendering, the back (away from the 
display), can be culled.

A 3D vector file can be composed of multiple layers, the display attributes of which 
can be controlled via the Surface tab. For each layer, the following options are 
available:

• Override Fill and Line - Specification of the colour of the 3D file fill and 
line drawing boundaries can individually be specified. Click the colour 
button to display the colour selection dialog. 
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• Show Wireframe- - Display the wireframing of the 3D vector surface 
faceted shape as well as having the 3D surface displayed.

• Show Text

The Transparency Tab enables:

• The transparency of a vector object to be altered via a slider bar or 
manual entry of a transparency percentage

• No Self See-Through – In complex shapes, this option prevents the entry 
of one enclosing surface to see the same but further back surface.

3D Vector File tab dialogs for defining the transparency and transform.

The Transform tab allows Scaling and Translation parameters to be assigned 
individually to the X, Y and Z axes. A Reset button allows these values to be 
restored to their original (untransformed) values.
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Section Profiles in 3D Displays

Sections that display individual layered sections such as Conductivity Depth 
Images can be presented in 3D displays. The method of display of sections and 
the data they present is often substantial and consequently section displays 
whether in tracked profiles or in 3D displays are slow to view and manipulate 
(refer to section chapter Introduction). Although sections can be displayed in their 
layered-depth format, an alternative method to present them that is much faster 
to draw is also available. This second method involves creating Located Image 
captures of the required sections and displaying these in the 3D display instead. 
The resultant display is extremely fast and allows real-time navigation not 
possible if the actual section data were displayed.

These two methods of displaying sections are discussed separately below.

• Adding Sections to 3D Displays

• Section Profile Properties in 3D Displays

Adding Sections to 3D Displays

To display section profiles in 3D a located image (.EGB file) of the 2D sections 
must be first created and then displayed in 3D. 

To create section(s) in a 3D display:

Step 1

Create a Section Profile as described in Creating Sections. 

Step 2

Adjust the Colour Scale and Colour Table options if required for the section profile 
display and right mouse click on the Profile 1 branch of the Workspace tree to 
display the pop-up menu. Choose the View in 3D menu option and the below 
dialog will appear.
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The Section export to 3D dialog.

Step 3

Section_CDI.egb (located image header file)

Section_CDI_L20100.png

Section_CDI_L20200.png

Section_CDI_L20300.png

Section_CDI_L20400.png

Step 4

Define the image resolution by either:

• Image fixed file – specifying a fixed size for X and Y dimensions (in 
pixels) for an image; or

In the Section export to 3D dialog select the Browse button to enter a file 
location of the output .EGB (located image header) file and then specify an 
output name prefix for the file and associated image files. The output file format 
is .PNG (Portable Network Graphic) so that an example of the total output files 
produced by entering a prefix of “Section_CDI” for 4 survey lines (L20100-
L20400) is:
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• Image variable length – specify the number of pixels between station 
locations and the number of pixels for X or Y dimensions (in pixels) will 
vary based on this length. 

Step 5

Line selection dialog for Section export to 3D process.

Step 6

Click on the Finish button to begin the export process. The status of the export 
procedure can be monitored in the bottom left hand corner of the PA interface in 
the status bar section.

Once this procedure is complete a 3D display window will appear with the located 
image data object containing the section profiles displayed. An example of a 3D 
display of a section profile located image is shown below:

Click on the Line Selection button and nominate which lines in the loaded 
database to use in the export to 3D process. Click OK.
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Example of a located image of conductivity-depth image section profiles shown in 3D.

To edit the display properties refer to Located Image Properties.

Section Profile Properties in 3D Displays

When displaying section profiles in 3D as a located image it is best to be aware 
of the following disadvantages:

• There is no interactive control over the colour table or scaling used.

• The images must be pre-prepared before they can be displayed. This 
need happen only once but it is necessary whenever a colour change or 
alteration of resolution is required.

• The display of an image of a section is not as accurate in its 
representation as the original data in the image. Image creation provides 
control over the resolution used, but usually a reduced quality image 
results.
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Voxel Models in 3D

Displaying voxel models in 3D is described in detail in the Voxel Models. Voxel 
models are well suited to displaying in 3D format. An example of these displays 
is shown below:

Examples of voxel displays using 3D format

Feature Objects in 3D

Interpreted or created features from a feature database can be displayed in 3D 
displays. This can be useful when interpreted two dimensional areas are available 
or, where interpretations are mad on sections of data (such as CDI or geological 
sections) and then the interpreted features can be displayed in 3D. See Working 
with Features for a description of creating 3D features.

Feature displays in 3D can be:

• Any of the Feature sets (point, polyline, polygon or 3-point picks). It is 
essential that an appropriate Z (elevation) data field is available to 
correctly position the features.

• Standard colour attributes can be applied to features on a Set basis.

• Multiple feature datasets can be used to layer the interpretations made.

Follow these steps to add a Feature Set to a 3D Map:
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Step 1

Create the 3D Map as described in Creating 3D Displays.

Step 2

Step 3

Highlight the 3D Map branch of the Workspace tree and click the right mouse to 
display the pop-up menu to Add Data. Choose the Feature Set menu item. When 
selected a new Feature branch is added to the 3D Map. A faster method of 
adding a Features branch  is to select the Add Feature button from the Data 
Objects toolbar once the 3D Map is selected. Alternatively drag-and-drop the 
Feature Set displayed in the Data Manager window into the active display 
window.

Step 4

To control the appearance of features within the 3D display, refer to Feature 
Object Properties.

An example of features displayed in a 3D display is shown below:

Features displayed in a multi-section 3D display to assist with interpretation

Open or Create a Feature Database using the Features menu or Data Manager 
window. For information on this, refer to Features.
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Animation of 3D Displays

Encom Discover PA allows different 3D views to be captured for replay as an 
animated movie. An automatic transition between view positions allows the 
playback to be smooth and provide the visual appearance of a movie. The fly-
through effect can follow a predetermined track or a series of joined view points 
with gradual transition between each.

Creation of a 3D animation is controlled by a wizard that generates a script. Within 
the script are a series of 3D location points that view the display with different 
angles and elevations. Smoothly moving from one position to the next creates the 
animation. Once a script is created, an .AVI movie can be generated using a 
movie codec of your choice.

At certain points, you can enter audio identification. These sound effects are then 
heard while a script is being replayed through the computer sound system. Sound 
cues such as “Note the high gold grade in drillhole DDH-121…” can be a useful 
adjunct to seeing the 3D display replayed.

Details of creating and operating the Fly-Through wizard are described in 3D 
Animation and Fly-Through.
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15 3D Navigation and Animation
In this section:

• 3D Toolbar Controls

• 3D View Manager

• Navigating in 3D

• 3D Display Modes

• 3D Cursor Plane

• 3D Animation and Fly-Through

3D Toolbar Controls

The Zoom Controls Toolbar controls navigation, zooming and custom view 
management in the 3D Display Window. 

Select/Navigate - Select/Navigate is used as the primary control for selecting 
and navigating in the 3D environment. Holding the left mouse button down and 
moving the mouse cursor will pivot the view are the central display axes. 

When a Workspace Tree object select option is enabled the Select/Navigate 
control can be used to display attribute information in the Information 
Windows.

3D Navigation - The 3D Navigation control is primarily used to navigate around 
the 3D Display Window. Holding the left mouse button down and moving the 
mouse cursor will pivot the view are the central display axes. Holding the right 
mouse button down and moving the mouse cursor will either zoom in or out from 
the central display axis. Refer to Navigating in 3D for more detailed operations.

Zoom in, Zoom out, Pan - The zoom controls either zoom in or out in the 3D 
Display Window, holding the Shift key will perform the opposite zoom function.  
With either the Zoom in or Zoom out control activated, when the left mouse 
button is held down and the mouse cursor is dragged, the Display Window will 
zoom in or out to the specified zoom field. The Pan control enables panning in 
the Display Window.
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• Perspective – Objects that are further away from the viewer are scaled so 
they appear smaller than closer objects. Perspective view provides more 
information about depth and is often easier to work with because it 
simulates the real life view.

• Orthographic – A form of parallel projection (also known as an isometric 
or axonometric projection) where identically sized objects are displayed 
with the same size regardless of the distance they are positioned from the 
viewer. Orthographic view is best used when it is important to be able to 
judge proportion and size, such as, when digitizing or drawing features, 
and is particularly useful for measuring distances.

Reset View - Reset 3D View restores the 3D Display Window so objects are 
centred and displayed within the window.

View Manager - The 3D View Manager allows the user to save custom views 
within the 3D Display Window. See 3D View Manager.

Change View Direction - Rotate view direction of the 3D Display Window to the 
specified direction (North, South, East, West, Up and Down). For example, 
selecting Look North orientates the view to be looking to the north.

Fit to Page - Only available in Page Layout view; automatically resizes the 
page to fit to the extents of the view.

Perspective/Orthographic - 3D display modes
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3D View Manager

3D View Manager dialog

Navigating in 3D

• 3D Navigation Modes

• 3D Navigation Controls

Add new 3D view to the 3D View Manager.

Delete the selected 3D view from the 3D View Manager.

Display the selected 3D view from the 3D View Manager.

Display the selected 3D view from the 3D View Manager and restore the 3D 
data window to the select view extents and dimensions.

Rename the selected 3D view from the 3D View Manager.
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• Using the 3DConnexion SpaceNavigator™

• 3D Display Modes

3D Navigation Modes

There are two navigation modes, which can be selected from the Zoom Controls 
toolbar:

3D Navigation Controls

To navigate in 3D, click the  3D Navigation button on the Zoom Controls 
toolbar.

3D Navigate—This is the primary navigation control and provides the most 
precise control in 3D. When selected, the 3D Navigation tool is displayed in the 
top-right corner of the Display Window. See 3D Navigation Controls for details.

Select/Navigate—Use this mode to create, edit and interrogate objects in the 
3D environment. When selected, position the cursor inside the Display Window, 
then hold the left mouse button down and drag the cursor to rotate pivot the view 
about the centre of the display. You can use the other controls on the Cursor 
Plane toolbar (Zoom In, Zoom Out, Pan, Change View Direction, and such) in 
conjunction with the Select/Navigate tool.
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All 3D navigation is orientated about the view point. The view point is the black 
cube at the intersection of the XYZ axis lines that appears when clicking in the 
Display Window.

The 3D navigation view point

The 3D Navigation tool is displayed in the top-right corner of the Display Window. 
This tool fades when there is no movement after approximately 5 seconds. To 
redisplay, move the cursor into the top-right corner. This tool controls the eye 
position and the view point (the rotation point). Similar (and some additional) 
functions can also be performed by combinations of mouse button and keyboard 
keys, as described below.

The 3D navigation tool is displayed in 3D Navigation mode.

The X, Y and Z coordinates of the view point and the bearing and inclination of 
the view direction (from the eye position) are displayed in the Status Bar.
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Movement Using the 
3D Navigation Tool

Using the 
Mouse/Keyboard

Zoom
in and out

Zoom: Zooms in and out from 
the view point.

Zoom: Hold down the right 
mouse button with the cursor 
positioned above (to zoom 
in) or below (to zoom out) the 
view point. Alternatively, roll 
the mouse wheel.

Rotate 
around view 

point

Z-rotate: Rotates around the 
Z-axis.

Free rotate around view 
point: Hold down the left 
mouse button. The view will 
rotate freely as if you are 
pressing on a basketball: 
whichever side of the view 
point you click, the view will 
rotate away in that direction.

Rotate 
around eye 

point

Free rotate around eye 
point: Hold down the CTRL 
key and the left mouse 
button. The view rotates in 
the direction of the cursor 
about the current eye 
position. 
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The Reset 3D View, View Manager and Change View Direction on the Zoom 
Controls toolbar can also be used when in 3D Navigation mode.

Vertical
pan

Z-pan: Moves the view point 
vertically (in the Z-direction)

Z-pan: Hold down the SHIFT 
key and the left mouse 
button. The view point moves 
along the vertical axis in the 
screen plane in the direction 
of the cursor.

Horizontal
pan

XY-pan: Moves the view point 
horizontally (in the XY-plane)

XY-pan: Hold down both the 
left and right buttons. The 
view point moves within the 
XY-plane in the direction of 
the cursor.

Speed/
sensitivity

Sensitivity: Use the slider 
control to adjust the speed of 
rotation, zooming, and 
movement. Clicking the bar 
selects that setting. Clicking 
the snail or rabbit changes the 
setting by one increment in 
either direction.

Speed: Speed is controlled 
by the distance of the cursor 
location from the view point: 
the further this distance, the 
faster the movement.

Sensitivity: The numeric 
keys (1-0) can be used for 
more precise speed control: 
1 is the slowest speed and 9 
and 0 are fastest.

Refer to 3D Cursor Keyboard 
Shortcutsfor a complete list 
of mouse/keyboard controls.

Movement Using the 
3D Navigation Tool

Using the 
Mouse/Keyboard
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Using the 3DConnexion SpaceNavigator™

Discover PA 3D Viewer supports navigation using the 3DConnexion 
SpaceNavigator™ device. With this device, both the eye position and view point 
can be moved simultaneously. This results in easy and intuitive “fly-though” style 
movement.

To use a SpaceNavigator device:

1. Install the 3D Connexion driver software, and upgrade to the latest 
version.

2. Connect the device via a USB port.

3. Start Discover PA 3D Viewer window. Select the Tools>Options menu 
option, and go to the View tab. Select the Enable 3D Connexion devices 
option.

4. Close and restart the 3D window.

The following SpaceNavigator™ controls are supported within Discover PA 3D 
Viewer:

Action Device Movement

Push/Pull Move eye and view 
points forwards and 
backwards.
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3D Display Modes

The 3D Display Window in Encom Discover PA can be configured to operate 
using several view modes. The following view modes are available:

• Normal View Mode

Slide Move eye and view 
points to the left and 
right.

Tip Rotate eye point 
downwards and 
upwards.

Spin Rotate eye point around 
static view point.

CTRL + Push/Pull Zoom in and out (move 
the eye point closer to 
and farther from the 
view point.

SHIFT + Spin Rotate the eye position

Reset LEFT Press the left button to 
reset the 3D view.

Settings RIGHT Press the right button to 
display the device 
settings

Action Device Movement
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• Page Layout Mode

• Full Screen Mode

Normal View Mode

View>Normal 

In normal mode, the 3D Display Window is maximised to fill the extents of the 
view area and provide optimal display of 3D objects. 

Page Layout Mode

View>Page Layout

Page Layout mode enables you to see how objects are positioned on a printed 
page. This view can be used to modify the size and positioning of the 3D frame 
border, page margins and colour legend objects prior to printing. The size and 
orientation of the default page is defined by the printer settings specified under 
the File>Page Setup option.

Full Screen Mode

Discover PA 3D can be switched into full screen mode such that the entire monitor 
screen will display only the content of the main 3D Display Window. The menus, 
toolbars, status bar, information windows and workspace tree will be hidden when 
operating in full screen mode. 

Switching to full screen mode is conducted with the Select/Navigate tool 
enabled, right-click in the main 3D window and select the Fullscreen View menu 
item. 

To exit full screen mode, press the ESC key on the keyboard.

In Full screen mode, the 3D Navigation control is automatically enabled. Full 
screen window display parameters, such as Resolution, Colour Depth and 
Display Frequency can be modified on the Tools>Options>Fullscreen dialog.
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3D Cursor Plane

The Cursor plane is a user controllable and customizable plane in the 3D view, 
which has two main functions:

Digitizing

The Cursor plane operates as a drawing plane upon which Feature Objects are 
digitized in the 3D environment. Making a Feature Dataset editable automatically 
enables the Cursor Plane. For example, geological boundaries could be digitized 
from cross sections and subsequently formed in a solid object using the 3D Solid 
Generator.

Clipping

The Cursor plane can be used as a clipping plane to hide or obscure object data. 
This can be useful in complex datasets where a mass of drillholes obscures the 
data of interest. Alternatively, only a user-specified envelope or slice of data about 
the plane can be displayed; this is very useful when digitizing along sections, 
ensuring that only data within the specified envelope used in the interpretation.

Cursor plane (red outline) with bounding box (green box) and, 3D Cursor crosshairs (light 
red).

For more information on controlling and using the cursor plane, see:

• Controlling the Cursor Plane Display
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• Controlling the Cursor Plane Position and Orientation

• Navigating on the Cursor Plane

• Changing Cursor Plane Properties

Controlling the Cursor Plane Display

The Cursor plane toolbar contains tools required for the operation of the Cursor 
plane. 

Controlling the Cursor Plane Position and Orientation

Press the Show Cursor Plane button to display the default Cursor Plane 
location surrounded by a bounding Focus Box.

Press the Cursor Plane Properties button to modify the appearance of the 
Cursor Plane. For more information, see Appearance section of the Cursor 
Plane Properties dialog.

Press the Plane clipping button to hide all 3D data objects in front of the Cursor 
plane. This is useful when a slice view is required of the 3D datasets when 
digitizing. 

Press the Defined clipping button to enable the supplementary clipping of a 3D 
dataset as defined by the current position of the Cursor plane. This option 
enables the current position of the Cursor plane to temporarily clip the 3D 
dataset whilst being able to move the Cursor plane to another position. This is 
useful when digitizing through a complex geometric object, or to reveal obscured 
features.

Press the Bond button to bond the Cursor plane to a selected georeferenced 
image or dataset (e.g. drillholes) in the Workspace Tree. This feature is useful 
for aligning the Cursor plane with images georeferenced in 3D for digitizing. It is 
also auto-enabled when selecting data in Spreadsheet mode—for interrogating 
drillholes dynamically, for example.

Press the Cursor Plane Properties button to modify the position and orientation 
of the Cursor Plane. For more information, see Plane section of the Cursor Plane 
Properties dialog.
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Navigating on the Cursor Plane

Press the Lock Cursor plane button to disable all Cursor plane movement 
controlled by the keyboard shortcuts, preventing the Cursor plane from being 
accidentally moved during digitization. This feature locks the Cursor plane origin 
X, Y and Z coordinate.

Press the Cursor plane orientation button to toggle the Cursor plane 
orientation around the X, Y and Z axes.

Press the Perpendicular button to orientate the view direction perpendicular to 
the Cursor plane. This is very useful when digitizing interpretations on adjacent 
sections, particular when used in tandem with the Orthographic View mode and 
Envelope or Slice clipping mode.

Press the Shrink, Enlarge and Fit Cursor plane button to Shrink, Enlarge and 
Fit Cursor plane controls resize.

3D navigation and selection on the Cursor plane can be achieved using the 
Select/Navigate control. When this control is enabled a set of crosshairs will 
appear on the Cursor plane, the crosshairs assist in the precise selection and 
digitisation on the Cursor plane. X, Y & Z coordinates for the crosshair position 
displayed are on the Status Bar.

The up and down keyboard arrow keys control the inclination of the Cursor 
plane. This can change the X, Y and Z coordinates of the plane, as the rotation is 
applied about the centre of the bounding box, not the current centre point of the 
plane.

The left and right keyboard arrow keys control the bearing of the Cursor plane. 
This can change the X, Y and Z coordinates of the plane, as the rotation is 
applied about the centre of the bounding box, not the current centre point of the 
plane.

The page up and page down keyboard keys move the Cursor plane laterally. 
The Cursor plane is kept parallel to but shifted left or right (up or down) from the 
current position, maintaining a fixed inclination and bearing. 

Shrink

Enlarge

Fit

Up
Down

Left
Right

Pg Up
Pg Dn
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Changing Cursor Plane Properties

Cursor Plane Properties dialog.

The Cursor plane properties dialog is divided into two sections:

• Plane

• Appearance
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Plane

The 3D position of the Cursor plane can be set manually via the Origin, 
Inclination and Bearing options.

The cursor plane Step Distance option controls the distance it is shifted with each 
PAGE UP and PAGE DOWN key press. This is an excellent way to ensure feature 
object digitization occurs at a uniform spacing (e.g. 100m intervals).

The Clip option refines the operation of the Plane clipping tool. Clipping is 
dynamic: if the cursor is moved (e.g. dip and azimuth, or lateral movement), the 
clipping region will follow. 

Six clipping modes are available:

• None - No clipping is applied, replicates having the Plane clipping option 
disabled.

• Nearest - Hides all data in front of the Cursor plane, applies the clip 
dynamically when the Display Window is rotated.

• Positive - Hides all data in front of the Cursor plane from the current view 
point. Data clip is maintained even when rotating the Display Window.

• Negative - Hides all data behind the Cursor plane from the current view 
point. Data clip is maintained even when rotating the Display Window.

• Envelope - Displays data within a defined clip envelope from the Cursor 
plane. For example, setting a a +/-25 m envelope width will display a 50 m 
thick envelope (total) of data centred on the Cursor plane or 25 m either 
side of the Cursor plane..

• Slice - Displays data within a defined clip width behind the Cursor plane. 
For example, setting a 25m slice will display data up to 25m behind the 
Cursor plane.
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A skarn model (vector) and drillhole dataset before (left) and after application of a 40m wide 
clipping envelope centred on an inclined Cursor plane.

Dynamic clipping by using the Page Up/Down keys to shift the Cursor plane laterally whilst 
a clipping envelope is enabled.
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Appearance

The Appearance section provides a range of cosmetic controls for the Cursor 
plane, cross hair and focus box colouring, size, style and transparency.

The Grid option (highlighted in the above image) allows the user to visualise a 
continuous square grid across the cursor plane surface, with a line spacing as set 
next next to the Manual option (dialog below has 50 map units set). This can be 
a powerful aid when interpreting/digitising to help visualise distances/sizes.

Disabling the Align/Attach to a series by mouse click option prevents the 
Cursor plane bonding to an image. This is useful when digitizing if a background 
image is behind an intended feature node. 

The Lock Bearing and Inclination Control options are provided to prevent the 
user inadvertently altering these parameters via the keyboard arrows during 
feature digitization. When a lock is enabled, the appropriate buttons will have no 
effect until the lock is disabled.

The Keyboard Tips and Click Tips tabs under the Cursor Plane Properties 
dialog provide a listing a keyboard shortcuts and mouse button combinations for 
Cursor plane control and feature editing. Refer to 3D Cursor Keyboard Shortcuts 
for a complete list of shortcuts.

Creating and Editing Features Objects Using the Cursor Plane

Another use of the Cursor Plane is to create features object in a 3D window using 
the Bond To Image button, and a displayed surface (Located Image only) as a 
location reference. The features available are the same as those for conventional 
feature objects (refer to Features) excluding the 3-Point-Pick feature.
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The steps required to create features in a 3D Map are:

Step 1

Have a Located Image displayed in a 3D Map window. This image is used to 
create and edit features in 3D. The Located Image can be flat or superimposed 
over an undulating surface such as topography (refer to Creating Located 
Images).

Step 2

Open or create a feature database and add an associated Feature Set to the 
Workspace tree of the 3D Map window. Ensure the feature Set to be written to is 
made editable in the workspace tree.

Step 3

Step 4

Step 5

Step 6

Repeat drawing features as necessary. You may need to alter the view or to 
change the Feature Set. To check the entries, display the Features Spreadsheet.

Making the feature set editable should also activate the 3D Cursor plane in the 
3D display as well as associated toolbars.If not the select the 3D Cursor button 
of the 3D Cursor toolbar.Configure the display and the Edit Plane as desired 
using the Frame size control buttons and Cursor Properties button.

Orient the Cursor Plane with the same axes plane as the Located Image to be 
used for drawing features. Typically this will be horizontal so the XY plane is 
required. Use the Plane Orientation button to modify the orientation. Link 
(bond) the Edit Plane to the Located Image using the Bond Image button.

To activate the 3D Cursor on the Edit Plane, click the Attach Cursor button (or 
the Pointer button). When this is done, positioning the cursor over the Edit Plane 
draws the 3D Cursor crosshairs.

You can now start creating features on the Cursor Plane using the Feature Tools 
on the Features toolbar. Specify if you wish to create a Symbol, Line or Polygon. 
Note that to accurately draw 3D objects, it is best to orient the view from a 
position perpendicular to the Located Image and Cursor Plane. This can be done 
using the Direction toolbar buttons.
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3D Animation and Fly-Through

Creation of a 3D Fly-Through Animation is controlled by a wizard that generates 
a script. Within the script are a series of 3D location points that view the display 
with different angles and elevations. Smoothly moving from one position to the 
next creates the animation. 

The 3D Fly-Through Animation track can be specified by:

• MapInfo Professional® .TAB file.

• Flight path specified from data open in Encom Discover PA 3D.

• Manually specifying various predefined views.

• Edit an existing Fly-Through (.FLY) file.

Other features of the 3D Fly-Through Animation feature include:

• Ability to repeat operation or reverse to replay backwards.

• Smooth view along predefined track using a Bezier curve approximation.

• Control frame rate, flight speed, view pause, view rotate and point 
examination.

• Create 3D DXF file of a created flight track including definable points to 
mark view points.

• Capture fly-through as an Video movie for later viewing. Selection of video 
compression (CODEC) provided.

• Audio identification at set points. These sound effects are heard while a 
script is being replayed through the computer sound system. Sound cues 
such as “Note the surface anomalism coincident with this drilling…” can 
be a useful adjunct to seeing the 3D display replayed. Note that when 
recorded to an Video movie file, the sound is not transferred.

Encom Discover PA allows different 3D views to be captured for replay using a 
fly-through wizard. An automatic transition between view positions allows the 
playback to be smooth and provide the visual appearance of a movie. The fly-
through effect can follow a predetermined track or a series of joined view points 
with gradual transition between each. The fly-through tool is available from the 
Tools>Fly Through Animator menu option.
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To create a simple 3D animation

1. Ensure the required datasets are open and visible in the 3D window

2. Select the Tools>Fly Through Animator menu option

3. In the Fly Through Creation Wizard dialog that opens (Step 1) select the 
Manually from the current Encom Discover PA 3D view option. Press 
Next

4. In the Step 3 dialog, ensure that the Loop Style is set to None, and 
Bezier Smoothing is enabled with a Low Tension. Press Next.

6. Use the 3D nVideogation controls to move to the next view point and 
again use the Camera Capture button to capture this location. In this view 
point’s row entry, specify the Duration in seconds the animation will take to 
travel between the previous (start) point and this location. 

7. Repeat step 6 until all required view points have been captured and 
durations entered.

9. Edit the animation by adding, inserting, modifying or deleting the 
necessary view points. These controls and additional are discussed fully 
in The Fly-Through Creation Wizard section below. 

10. If the overall speed of the animation is too fast, rather than respecifying 
each individual duration, use the Back button to go to the Step 3 – 
Options dialog, and alter the Playback Speed accordingly (e.g. reduce it 
from 1 to 0.5 to double the time taken between each view point).

11. When satisfied with the flight path and durations, press Next to open the 
final Step 5 dialog.

12. Specify an Output FLY file using the adjacent Save button (this file will 
allow you to come back and modify your flight path, add new datasets, 
etc). Also specify the name of an output Video file.

5. In Step 5, use the 3D navigation controls (see Navigating in 3D) to 
orientate the 3D view at the starting view for your animation. Press the 
Camera Capture button to capture this – a new row will be added to the 
dialog with this point’s details.

 
8. Play the animation in the 3D window by pressing the Play button. A 

selected number of view points can be previewed using the Preview 
button to the right of the Play button.
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13. Press the Compressor button, and select the compression CODEC to 
use for your output movie (see Step 5 - Output Formats below for further 
details). Once selected, press the Create Video button to generate an 
.Video movie file. The quality of the output movie can be altered by 
adjusting the Frame Rate (i.e. frames per second) in the Step 3 – 
Options dialog.

How Fly-Through Animation Works

A fly-through animation operates by positioning an Eye Point, (also called a 
Capture Point or Position) and directing the view to a Look At point. When 
played back, the view is defined from each Eye Point towards the Look At point 
and then a gradual change of view to the next successive Eye Point to the next 
Look At point. Both point types require an X, Y and Z specification as shown in 
the diagram below:

Flight path of ‘joined’ Capture Points as they direct their view to Look At points

Each Eye Point can be recorded from a manually positioned location in the 3D 
map display or at interpolated locations from a predefined flight path defined from 
a database or MapInfo Professional TAB file. The Eye Points look directly to their 
associated Look At point and then gradually move and update with the next Eye 
and Look At points during the animation. The movement from one Eye point to 
the next can be smoothed or direct (determined by the Smoothing and Tension 
settings). The speed at which the fly-through travels is dependent on the 
Playback Speed and Flight Speed (see Step 3 - General Playback Options).
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Each Eye Point (Capture Point) can have a number of events and properties 
associated with it. An event may be a pause, sound, change of display property 
(eg transparency, application of a different LUT, etc) or a rotation of the view 
about an Eye Point or Look At point.

The individual Eye Points and their associated Look At point, including any 
associated events, are saved to a script file called a FLY file. These files, created 
for a given project area, provide the mechanism to replay the fly-through 
animation as desired.

The Fly-Through Creation Wizard

The following sections describe in detail the controls available within this tool.

Step 1 - Select Input Type

The Fly-Through Wizard can be accessed from the Utilities menu. The Fly-
through Creation Wizard: Step 1 – Input Type dialog is displayed:

Fly-Through Wizard dialog and options to create a flight path script

A fly-through operates by different views being displayed along a predetermined 
path. The positions of the views are recorded in a script file (FLY file extension).  
The flight path may be specified by one of the four following methods: 

• From a TAB file – MapInfo table that contains XYZ coordinates 
representing the flight path course.
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• From Encom Discover PA 3D Dataset – XYZ coordinates for flight path 
based on values in fields in a Encom Discover PA 3D dataset.

• Manually from current 3D view – Specify a number of 3D map window 
views to use as Eye and Look At points which are linked together to form 
the flight path.

• Edit Existing Fly-through file – Modify a previously created fly-through 
script file (FLY).

Depending on the flight path generation option selected, a different series of 
dialogs may be displayed.

Step 2 - Input Parameters

MapInfo TAB File

Select the From a TAB file option and click the Next button. In the Fly-through 
Creation Wizard: Step 2 dialog use the Browse button to locate the appropriate 
MapInfo TAB file. This TAB file must be mappable and contain points, polyline or 
polygon map objects which represent the course the fly-through will follow. The X 
and Y coordinates do not need to be attributes in the browser but if Z values are 
to be used for individual locations there must be appropriate Z field in the flight 
path table.

Select MapInfo table and Z values
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Select the Z Field in the table that contains the height or elevation to use in the 
fly-through path. The Z field must be of numeric datatype. A constant value can 
be added to the existing Z values i.e. to convert local RLs to AHD. If there is no Z 
field in the table or all the Eye and Look At points are to viewed from the same 
elevation, check the Flat Height box and manually enter a Z value.

Encom Discover PA 3D Dataset

Fly-through animations can be created from point or line data open in Discover 
3D. Select the From Discover 3D Dataset option and click the Next button. In 
the Fly-through Creation Wizard: Step 2 dialog use the Dataset pull-down list 
to locate the appropriate 3D dataset and assign the X and Y fields. 

The Z values may be selected from a Z Field in the dataset or by checking the 
Flat Height box and entering in a constant Z value for all lines.  A constant value 
can be added to the existing Z values i.e. to convert local RLs to AHD.

Select 3D dataset and assign XYZ fields

Manually from Current 3D View

This Fly-Through Wizard option is the simplest to use as the flight-path is 
compiled from a list of Capture Points (Eye and Look At points) which are 
specified by rotating and zooming to different views in the current Encom 
Discover PA 3D map window. The Capture Points are then displayed in the 
capture order to simulate the flight-path. There are no additional setup 
parameters for this option.
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Edit Existing Fly-Through File

To load an existing fly-through file (FLY) into the Fly-through Wizard select the 
Edit Existing Fly-Through File option. In the Fly-Through Creation Wizard: 
Step 2 dialog browse to an existing (FLY) script file. 

The (FLY) script file specifies the flight path and the general playback and 
recording options including capture point information. 

Step 3 - General Playback Options

General playback and flight path options dialog

These options relate to the recording Mode, Playback controls and Flight Path 
Creation.

Mode

The default capture behVideoour of this tool is dynamic mode, allowing 
movement within 3D space.

Note If you use a script file with flight path capture points which are for a region that is 
not in the same area as the displayed in the 3D map window, when you play 
back the script, no image animation will be seen.
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Static view mode is designed solely for capturing the movement of the cursor  
clipping plane through your 3D dataset (e.g. clipping into a complex dataset over 
a period of time to highlight core area). In this mode, movement of either the eye 
or look-at positions in 3D is not possible. Enabling this option will disable many 
functions of the wizard.

Playback

The following Playback controls are available:

• The Loop Style options control the way a script is re-played. Use the pull-
down list to select the desired option. A script can be set to:

• Repeat - the fly-through script is played and then repeated from the start 
continuously,

• Repeat Reverse - replay the script continuously but in reverse, or

• Repeat Reverse Look - replay the script continuously and in reverse but 
from the view looking back to the capture point.

• Smoothing – As each capture point is a location in three dimensional 
space, the flight path joining these points can be a smoothed line (Bezier) 
or straight line (None) between each point. If smoothing is selected, a 
Bezier smoothing algorithm with Tension is applied. The higher the degree 
of tension, the more closely the replayed flight path will be to the direct 
path between capture points.

• Playback Speed – Actual speed the playback is performed. For example, 
a playback speed of 1 is normal, a value of 0.5 would take twice as long as 
normal, a value of 2 would play twice as quickly as normal, etc. If a script 
takes 10 seconds playback then changing the Playback Speed to 0.5 
would change the playback to 20 seconds. Similarly, if a value of 2 were 
assigned, the playback time would be 5 seconds.

• Frame Rate – Number of display captures in one second. The higher the 
Frame Rate, the smoother the animation. Note the smoother the 
animation, the greater the amount of storage required, especially if 
outputting to an Video movie.

Flight Path Creation

• Flight Speed – Time taken to move between two capture points. Speed is 
expressed in units per second (normally in metres per second). If you find 
that the time being calculated for movements is too large then increasing 
the flight speed shortens the movement times. All replay times get 
recalculated with new values when this property is altered. 
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The speed of the replay is set in Playback Speed. 

• Create Eye and Look Path DXF Files – The flight path and capture 
points of a script can be saved to 3D DXF files. Two DXF files get created, 
one for the Eye points and one for the Look At points. The DXF filenames 
are dependent on the name given to the fly-through file. The DXF files are 
created in the same directory as the fly-through file. For example, if the 
output fly-though file path is: C:\DATA\FLY1.FLY, then the DXF files 
created would be called:

C:\DATA\FLY1_EYE.DXF and C:\DATA\FLY1_LOOK.DXF

• Point Symbol Size – This parameter defines the size of a symbol to 
represent the Eye and Look At points in the created DXF files.

Step 4 - Capture Points and Event Details

The Fly-Through Creation Wizard: Step 4 – Path dialog is made up of three 
components:

• Capture Point List – The details and properties of the various capture 
points are listed with replay duration and icons to indicate events. If you 
select any of the capture point records by clicking on the corresponding 
row number, the Encom Discover PA 3D map updates to that view.

• Capture Point Events – Controls to capture a point view, pause 
playback, rotate view, preview fly-through and stop a playback.

• Event Details – Control parameters for position and time specification, 
plus any audio accompaniment to a 3D Fly-Through Animation.
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Specifying and assigning events to the capture points of a fly-through script

Capture Point List

If a flight path is specified from a MapInfo TAB or MIF file, Encom Discover PA 3D 
dataset or existing fly-through file (FLY), the capture point details are 
automatically added to the Capture Point List. New points can be added or 
existing points modified in this list. If the Manually from 3D view input option was 
selected in Fly-through Creation Wizard: Step 1 – Input dialog, new capture 
points must be created. See Capturing Point Events for more information.

The Capture Points are listed incrementally with Duration, Event, Audio and 
Property field for each view.

• Duration – The time in seconds that it takes to move from one Capture 
Point record to the next.

• Event – The type of capture point is indicated by one of four Events:  
Capture Point, Pause, Rotate Eye and Rotate Look At. See Capture 
Point Events for more information.
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Capturing Point Events

• Audio – If an audio entry is to be used at a Capture Point, an audio 
symbol is displayed. Enter some text in the Audio entry line or specify a 
pre-recorded sound file in WAV format. If you type an entry, such as “The 
value at this location is high”, when the animation script is replayed, the 
computer will repeat the text through voice recognition processing and the 
text is spoken from the computer. Alternatively, if a WAV file is selected the 
content of this file is played.

The Camera button adds a new Capture Point to the Capture Point List. Each 
entry in the list represents a point along the flight path that is saved in the (FLY) 
script file. The script replays the capture points in sequential order (forward or 
reverse depending on the Loop Style). 

To create a new capture point use the 3D nVideogation tools (see Navigating in 
3D) in the 3D view to rotate and zoom to the next view point:

To insert a new capture point view between two existing views, check the Insert 
Mode box and click the Camera button to insert the current 3D view immediately 
after the highlighted record in the Capture Point List.

This button causes the replay script to Pause for a specified duration of time. By 
default, the time is 1 second, but using the Duration entry field, you can modify 
this time. Note that a record of this type in the list uses the last Capture Point 
and then pauses for the required time with no movement.

The Rotate View button causes the replay script to halt at the last used Eye 
position (determined by the previous capture point record) and then rotate the 
display by an amount determined by an Azimuth and Inclination (looking from 
the top down). The time to complete the rotation is specified by the Duration.

The Rotate Around button causes the replay to rotate the 3D view around the 
last Look At position (determined by the previous capture point record).The time 
taken to complete a rotation (as defined by the Azimuth and Inclination 
settings) is defined by the Duration.
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Event Details

The Event Details controls are concerned with the Capture Point attributes. 
Depending on the Capture Point record selected, the content of the Event 
Details may differ. 

The three buttons included under Event Details are: 

The Properties for the current event can be captured using this button. This will 
save any changes made to any data objects in the Workspace Tree since the 
previous event (e.g. visibility/transparency/legends/object thickness or size/etc). 
To refresh this, select the point event, make the necessary changes in the 
Workspace Tree, and press the Properties button. 

This allows, for example, different datasets to turned on and off throughout your 
animation, e.g. a large scale satellite image could be displayed at the start (while 
you are zoomed out), then turned off, and a small scale image made visible 
when zoomed into the prospect scale.

Note Properties applied to a Capture Point Event are also applied to all successive 
Events, unless a following Properties entry alters this.

• Delete the selected Capture Point from the flight path. 

• Update the Eye and Look Positions for the current event with the current 
3D view.

• Displays the Properties of all 3D objects for the selected event, including 
display, transparency, lighting, line and fill colours, etc. To modify this, 
make the appropriate changes in the necessary items of the Workspace 
tree, then press the Properties Capture button (see Capturing Point 
Events above).
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The attributes of each Capture Point Event are displayed here and can be 
manually edited: 

• Look Position – The X, Y and Z location of the Look At point in Relative 
or Absolute coordinates. 

• Eye Position – The X, Y and Z location of the Eye point in Relative or 
Absolute coordinates. 

• Duration – The time in seconds that it takes to move from one Capture 
Point record to the next.

• Audio – Either a text entry or specification of a pre-recorded WAV file.

Each entry in the Capture Point List contains two pairs of position points (the 
Eye Position and the Look At point which determines the direction the fly-through 
path will follow). The points can be in either Relative or Absolute coordinates.

Absolute values are used to display a capture point view in real world 
coordinates. Relative values are used to display a capture point view relative to 
the previous capture view coordinates. For example, if a point capture view has a 
relative coordinate of (10, 10, 10) then the view will be moved 10 units in the X, 
10 units in the Y and 10 units in Z direction from the previous capture position. 
Units are map distance units  e.g. metres. If the previous capture position is in 
Absolute values the new view will move in world coordinates by 10 m in the X, Y 
and Z directions.

To get around this problem:

1. Add an appropriate offset to the flight path to re-locate the flight path 
height to the new surface values.

2. Display the surface in the Encom Discover PA 3D map window and in the 
Enhanced Layer Control highlight the Surface branch. Choose 
Properties from the right-mouse shortcut menu. In the Vertical Scaling 
and Offset controls select either the Offset to grid maximum or Offset 
to grid average. This operation relocates the grid surface automatically to 
a level that should be approximately zero. 

Note The flight path created using one of the various options should optimally be 
above or close to the 3D objects in the Encom Discover PA 3D map window. For 
example, a flight path created over a topographic surface would not be 
appropriate to use in a fly-through of a non-topographic gridded surface 
representing assays for the same area as the Z values will be quite different.
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Previewing your 3D Fly-Through

Once a Fly-Through file has been saved, it can be played back via a number of 
options within Encom Discover PA: see Playing an Existing Fly-Through File 
below.

Step 5 - Output Formats

Two output formats are available in the Fly-through Creation Wizard: Step 5 – 
Output dialog:

• Save the Capture Points and settings of the fly-through script by 
assigning a file name and location in an Output File. The settings are 
saved as a FLY file and can be restored for later use with the same 
project dataset. A FLY file can be activated via the Display Fly-through 
option on the Encom Discover PA 3D map window right-mouse click 
shortcut menu.

• Save the fly-through as an Video Output movie file. Movie files allow 
replay of a fly-through animation completely separated from Encom 
Discover PA and are therefore useful for management and overview of a 
project. For more information, see Codecs and Movie File Format.

When more than one Capture Point record is present, you can Replay or 
preview the fly-through script. Click the Play button to activate the fly-through. 
The replay uses the Capture Points according to the Loop Style setting and the 
various speed and event controls (see Step 3 - General Playback Options). 

To halt the replay, use the Stop button.

To display selected capture points in the fly-through replay use the button shown 
left. Only the capture points highlighted in the list will be included in the replay. 
This is useful for editing a long fly-through without hVideong to view the entire 
flight path every time.
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Retain the fly-through script and create a movie of the replay

Static View Mode

The Fly Through Creation Wizard can also capture the movement of the cursor 
clipping plane over a period of time, for instance gradually clipping into a voxel 
model to incrementally expose slices of the interior cells values.

1. To activate this, enable the Static view mode option in the Step 3 dialog. 

2. In 3D, align the view to the desired position. 

3. Enable the cursor plane and position it at the desired start location. Setup 
the required clipping options (Envelope or Slice width, Near, plane 
Appearance etc) in the Cursor Plane Properties dialog. It is also 
recommended to set the Move by user defined step value to a useful 
value (for instance, if the cursor clip plane will be moving 500 m, try a 
value of 20-50 m).

4. In the Step 4 Path dialog, capture the initial point location (recommend 
unclipped, with or without the cursor plane enabled). 
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Notes

• Once the initial view point is set (step 4 above), the view orientation 
cannot be moved in any successive view capture

• The orientation and position of the cursor clipping plane can be modified 
throughout the process

• Datasets can be modified throughout the process (visibility, transparency, 
etc)

• If a static clipping move is required as part of a normal dynamic movie, it 
will need to be merged with the separate dynamic movie using a movie 
editing package such Camtasia Studio or similar. It is recommended to 
save the initial view position using the 3D View Manager, to ensure view 
continuity in the final product.

Codecs and Movie File Format

When creating a movie file, Encom Discover PA 3D will display a list of any 
Codecs installed on your operating system, whether installed by the operating 
system or downloaded from a  third-party vendor.

To create an video movie:

1. Specify an Video path and file name. 

5. Then enable the cursor plane, and move to the final clipping position (i.e. 
in the depths of the data). Capture this point. Set an appropriate duration 
for the cursor clip plane to move from the start point to this location (e.g. 4 
seconds)

6. Preview the result.

Important Encom Discover PA 3D does not install any codecs.

Note Most default codecs included with Windows will return an error message, 
because they are Decodes only, and do not support encoding or creating your 
own movies. It is recommended to download and use a codec pack which 
includes the open source FFDShow standard encoders, such as the CCCP pack 
(http://www.cccp-project.net/).

http://www.cccp-project.net
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2. Specify the desired width and height for the movie. By default the pixel 
size is 512 x 512; increasing this will increase the quality of the output 
movie, but also increase both the output file size and processing time 
required to create the movie.

3. Leave the Capture Mode at normal. If you experience problems such as 
corrupted output or it is taking along time, you can adjust this to 
Advanced and lastly, Expert levels to troubleshoot. This reduce the 
amount of memory required and the complexity of the recording process. 
Note that you will need to leave the Encom Discover PA 3D window front 
most ontop of other applications when using these modes.

4. Select the Compressor button. Choose the Codec to use in the Video 
Compression dialog from the Compressor pull-down list. (see Codecs 
and Movie File Format for more information). A slider bar controlling the 
Compression Quality is also displayed. While an Video is being created, 
it can be halted by clicking the Cancel button.

Selection of a codec for Video movie creation

It is recommended that an ffdshow codec is selected (if available) as this 
codec generally offers the best video compression.

5. Adjust the quality, file size, and speed of the output file under the Codec 
configuration by clicking Configure. The most important parameter is the 
bit-rate, which determines how much information is stored for each 
second of playback.

6. Select the Create Video button. A progress bar should commence being 
written as the frames of the movie are created. The rotation and display of 
the Encom Discover PA 3D map window will also update as the movie 
scenes are captured. When the movie is completed, you can see the 
movie by clicking the View Video button.
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7. When the Video file is created, you can display this movie file using a wide 
range of free movie players. Such players include the GOM Player (http://
www.gomlab.com/eng/GMP_download.html):

Playing an Existing Fly-Through File

There are three ways of replaying a fly-through (*.FLY) file created using the Fly-
Through Creation Wizard:

• Open the file using the Fly-Through Creation Wizard, by selecting the Edit 
Existing Fly-Through File option. This allows the file to be edited as well 
as played.

• Using the File>Open menu option, and setting the Files of Type to “All 
supported Fly-Through Files”. Browse for the required .fly file and click 
Open.

• Right-clicking on the 3D Map branch in the Workspace Tree, and selecting 
Display Fly-through.

The second and third options will display a Flight Control bar upon opening the 
Fly-Through file, allowing playback control.

Note If you receive an ERROR message after selecting a codec and clicking the OK 
and Create Video buttons it is likely that the Codec you have selected is for 
decoding rather than encoding (i.e. for the playback of an Video movie rather 
than the creation/writing of an Video file). Select another codec and try again.

http://www.gomlab.com/eng/GMP_download.html
http://www.gomlab.com/eng/GMP_download.html
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16 Located Images
In this section:

• About Located Images

• Applications of Located Images

• Creating Located Images

• Using Located Images

• Located Image Properties

About Located Images

Encom Discover PA makes use of a powerful feature to display a wide range of 
data and objects in 2D and 3D effectively, quickly and simply. Significant speed 
advantages, especially when using 3D displays can be obtained with this feature. 
In this documentation, these files are called Located Images.

The capabilities and applications of Located Images allow the display of 3D 
objects. In addition, a large number of file types are now directly supported and 
can be used as the geometry source for 3D surfaces and objects. A Located 
Image therefore consists of two types of source data – bitmaps (images) and 3D 
surfaces or objects. 

The bitmaps can be simply created from sources such as:

• Maps, profiles, sections and graphs in PA

• Raster images (all common formats supported)

• Located images (eg GeoTIFF)

• Digital photography (eg aerial photos, trees, cars and everyday objects)

• Vectors (when added to a planar surface bitmap)

• Scanned data (eg sections, seismic, drawings etc).

3D surface and object geometry data can be imported from sources such as:

• Raster grids (eg ERMapper or Geosoft)
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• Triangulations (eg ESRI TIN files)

• 3D Vector data (eg TKM, DXF, GoCAD or GEMCOM files)

• User designed surfaces (via EGB files)

In many cases each Located Image is comprised of data from multiple sources 
and may therefore require some metadata to tie the source data together. The 
metadata is stored in an additional, small ASCII header file with the file extension 
.EGB (Encom Georeferenced Bitmap). 

EGB files have the following general capabilities: 

• They can render one or more geo-located images in 2D or 3D. Images 
can be located on simple, single faceted surfaces or complex surfaces 
comprising many millions of facets.

• They can render one or more three dimensional objects. The objects may 
be arbitrarily complex.

• Maintain detailed ancillary information tables for objects at multiple levels 
of scope that can be queried or used to modulate the appearance of 
objects.

In practice this means that use of .EGB files can display almost any kind of 
geographical content ranging from large multi-faceted textured surfaces to 
thousands of geo-located objects. You can record and store information with 
these objects and recall that data via graphical selection of objects on-screen.

You can also display objects that do not have an associated Located Image. For 
example, a surface can be rendered using flat or smoothly interpolated colour. 
The colour can be modulated in a wide variety of ways. This ability makes it 
possible to directly support raster grids and TIN files with .EGBs.

Further, Located Images through .EGBs provide support for structured objects 
constructed from sub-objects and linked together with a series of cascading 
transformations. A large number of objects can be rendered efficiently and the 
user can graphically interact with the objects. This extension allows users to build 
life-like worlds and in the future will enable support for animation of 3D objects.

Applications of Located Images

There are many applications for Located Images. Often, there is more than one 
way to achieve a particular display and there is functionality overlap between the 
Located Images and other display types in Encom Discover PA. However, the 
Located Images can provide certain advantages.
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In 2D you might use EGB series in these scenarios:

• Rendering CDI sections in profiles and section graphs. Sections require a  
huge amount of information to be displayed and it can take quite a long 
time to render a CDI section. To display multiple sections in a view may 
reduce interactivity due to long render and update times. An effective 
solution is to use the Batch Hard Copy Wizard to generate a located 
image for each section. This can then be used instead of the Section 
display and can improve render times by several orders of magnitude. 
Another similar application might be rendering seismic sections.

• Rendering Located Images (such as GeoTIFF files) in 2D maps. This can 
also be achieved via the Grid Group series but using Located Images is 
faster, more memory efficient and does not involve any reinterpolation of 
the image data.

In 3D you might use the EGB series in these scenarios:

• Displaying CDI sections in 3D. The same EGB file that was generated for 
viewing the sections in 2D can be displayed in 3D. One advantage of this 
is a simplified graph that does not require a complex 3D Section. The 
Located Image with its .EGB also provides better control over the 
transparency of sections and allows you to view sections at higher 
resolution.

• Rendering 3D grids. You can display a 3D grid using the Grid Group but 
the Located Image also loads a grid (in any of the large number of 
supported formats) natively. The Located Image allows you to control the 
colour modulation of the grid more precisely plus it allows you to display 
much higher resolution images of the surfaces.

• Rendering 3D vector files (eg DXF). Located Images of 3D vector files 
can also be used to display these formats but the Located Images retain 
ancillary data acquired from the source file that you can view after 
graphically selecting objects.

• Rendering 3D TIN surfaces. These can also be viewed using the 3D 
vector series but the visualisation and colour modulation options of the 
Located Image approach is far more powerful. TIN files can be loaded 
natively into Located Images.

The file types supported as Located Images are listed in Appendix E: Supported 
File Formats.
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Creating Located Images

Located images can be created from any 2D map, profile, section or graph display 
in Encom Discover PA either by direct export or via the batch hard copy 
mechanism. They can also be exported from grid groups and CDI section groups 
displayed in 3D. You can use a supplied wizard to create Located Images. Finally, 
you can use a text editor to build simple .EGB files based on the examples 
provided with the software.

Located Images Direct From 2D Displays

Use the Save as Georeferenced Image option available from graphs, profiles, 
sections and 2D map displays.

Pop-up menu selection for saving a Located Image from a display or the Workspace tree

From a Grid object in a 2D Map (or profile or section etc), position the cursor 
within the window and click the right mouse button to display a pop-up menu 
(Ensure the cursor is in Pointer mode. Click the Pointer button if not or click the 
left mouse cursor while the cursor is in the display window). From the menu 
select the Save As Georeferenced Image option (as shown below). 
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An alternative to this method is to select the required Map in the Workspace tree, 
click right and select the Save As Georeferenced Image option from the pop-up 
menu. See Appendix E: Supported File Formats for supported formats.

Dialog to save a located image (.EGB) file for a display.

Located images can also have three different types of geometries depending on 
their intended use. These geometries are:

• Quad – This geometry is used for display in 2D profiles and graphs and 
has an entry in the associated .EGB header that references the Line 
number from which the Located Image is created. This means that when 
this type of Located Image is used with profiles and graphs, the Line 
Iterator can be used to update and navigate through the bitmap displays.

Note Located Images comprise the captured bitmap plus a locational header file (the 
.EGB) and so resolutions can be specified in the range from 256 to 32768 dpi. 
The higher the resolution, the better the quality of the original data 
representation, but the larger the file required to store the information.
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• Quad Strip – This type of Located Image also adds Line Number 
references in the associated .EGB header but also specifies the XYZ 
corner points of the bitmap such that it can be displayed in both profile/
graphs AND in 3D line displays. To assist in fast 3D display, a 
Compression can be applied to these bitmaps. The higher the 
compression applied, the faster the 3D display can be redrawn but with a 
reduction in resolution.

• Surface – This Located Image geometry places a grid surface 
specification in the associated .EGB header. When displayed in a 3D Map, 
the grid surface is then applied to the captured bitmap to simulate an 
undulating surface with the associated raster grids shape. An example of 
this is shown below where a scanned Located Image has a topography 
raster grid used to define its displayed shape.

Located Images can be exported directly from a 3D surface (Grid Group). The 
result will be a Located Image that exactly replicates the surface (including 
surface compression and display properties such as lighting). The advantage of 
using a Located Image to display this data is the high resolution of the image that 
can be rendered on the surface.

Located Images can be exported directly from a 3D Section Group via the Export 
option on the Options property page. All sections currently displayed will be 
exported using the current colour and transparency options. Using a Located 
Image removes the need to access the CDI database and improves performance. 

Using Located Images

Located Images can be used in profiles, sections, 2D and 3D displays. These 
objects are especially powerful in 3D displays as they can be grouped and many 
hundreds of objects can be used with optimised display performance.

3D displays of Located Images are usually added to a 3D Map although they can 
also be added to 3D Graphs, 2D maps, profiles and sections. In the description 
below, Located Images are added to a 3D display but the steps required to add 
Located Images to the other display types are essentially identical. The required 
procedure is:

Step 1

Create a 3D Map or 3D Flight Path Map using the File>New>Map>3D Grid Map 
or 3D Flight Path Map menu option (or from the appropriate buttons).
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Step 2

As described in Creating Located Images, you need to have prepared the 
necessary Located Image before display and these require associated .EGB 
descriptor files. Refer to Image Registration Wizard and Appendix B: Data File 
Specifications for Encom Georeferenced Bitmap Format.

Step 3

With a 3D Map branch created in the Workspace tree, select the 3D Map item 
and click the right mouse button. From the Add Data menu item, choose 
Located Image. An alternative to this is to click the Add Located Image button 
from the Objects toolbar.

Display the properties dialog of the Located Image branch. Initially specify the 
path and .EGB file. You can use the Browse button to navigate to the required 
.EGB file or the Wizard button to access the Located Image Registration Wizard.
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Located Image properties dialog to specify the EGB file and display options

Refer to Located Image Properties for details on the various control settings.

An example of a display using Located Images is shown below. 

Multiple images displayed with a 3D elevation grid surface
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Located Image Properties

When a Georeferenced Image is displayed in Encom Discover PA an Images 
branch appears in the Workspace Tree. To display the properties dialog of the 
image, select the Images branch and either double click with the left mouse 
button or highlight and click right. From the displayed shortcut menu, select the 
Properties item.

The Images Properties dialog is a dynamic dialog; the property tabs displayed will 
vary depending on the data types incorporated into the EGB file. The following 
screenshot illustrates the full range of property tabs available when an EGB 
created by combining images of geological sections georeferenced using the 
Image Registration Wizard is selected:

Images Properties dialog to specify the EGB file and display options

Configuring and making use of the powerful features of Located Images requires 
use of the Properties dialog. Note that all the properties of a Located Image can 
be specified within the .EGB file (if used) and these properties will be used by 
default. The property pages can be used to override those defaults. Controls for 
Located Image display is divided into:

• Group – To control the collection of objects that may exist in the definition 
of .EGBs. For example, a collection of tree objects may form a forest 
group.

 

The image source path and file is listed under the Source File section. If you 
need to display an alternative geo-referenced image, use the Browse button 
(shown left). The Image Registration Wizard is also available from this dialog 
(button shown left). 
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• Object – Individual entity control. Individual objects may be the trees of a 
forest.

• Mesh – Each object is built from one or more meshes, each of which can 
be textured with an image. These form the lowest level of Located Image 
control. For example, a tree object will be displayed with a textured group 
of surfaces forming the 3D representation of a tree.

Meshes can be of three types depending on their end-use:

• Quad – A simple bitmap that has four corners located in space. These 
corners need not be planar. 

• Quad_Strip – A group of joined Quad meshes in either a vertical or 
horizontal orientation form a Quad Strip.

• Triangle Mesh – This mesh is a collection of vertices in space joined by 
triangular facets. Each facet can be displayed with different shading and 
colour to form a surface. The mesh may be open or closed or may contain 
multiple distinct patches.  

Further definition information on meshes and the .EGB format is described in 
Appendix B: Data File Specifications.

Group Controls

 
Selection of items defined in a Group EGB with multiple groups

The Show button allows selection of the Group to be displayed:
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The Images Properties dialog provides various control tabs for image display. 
These are divided into:

• File Tab – initially displayed, allows file selection, group controls and 
image registration.

• Display Tab – provides clipping options.

• Surface Tab – provides options for image colour, modulation and  lighting.

• DTM Tab – allows the image to be offset using a digital terrain model 
(DTM).

• Transparency Tab – controls the image transparency.

• Transform Tab – provides scaling and translation controls.

• Image Tab – image stretch and interpolation controls, as well as 
transparent colour assignment.

• Grid Tab – incorporates grid compression controls.

Display Tab

The Display tab allows the image to be clipped above and/or below two user-
specified horizontal planes (i.e. Z values).

The Group Edit button allows the Surface and vertical position (DTM tab) of the 
Located Image to be configured.
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For instance, if a Clip below value of 300 was set, an airphoto draped over a DEM 
grid would have all portions of the image with Z value less than 300 hidden.

An airphoto draped over a DEM grid

The same .EGB with all portions below 5500 clipped.
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Surface Tab

The Surface tab specifies aspects of colour, modulation and lighting.

Surface tab defining colour usage and appearance of Located Images

Parameters that can be controlled include:

• Style – Controls the basic surface rendering style and allows the triangle 
meshes to be displayed using fill (colour or textured), fill with triangle 
mesh wireframes or simply as coloured wireframes.

• Fill – Controls the source of the fill colour, if used. There are three 
possible colour sources – an image, a user-defined solid colour or solid 
colour modulated by a field in any of the ancillary data tables (Object, 
Mesh, Surface, Face and Vertex). In the latter case you must select a field 
from the table and define a colour table and colour mapping. If you are 
only displaying wireframes then the settings will apply to the line colour.

• Scope – Allows you to override default settings (defined in the source 
files) or only apply the settings to those meshes for which no defaults were 
specified in the source file.

• Modulation Data Field – Lists the fields in the ancillary data table, if 
selected. Note that the system will create many fields automatically. One 
such field is the _Colour field which will contain any colour information 
recovered from the source file. 

• Lighting – Provides None, Smooth or Flat and affects the display of the 
facets of the objects.
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• Default fill and line colours – Specifies the user defined colours for solid 
fill and wireframes.

• Edit of colour modulation table – Control of the colour look-up table is 
provided.

• Edit of colour mapping – The colour mapping controls the mapping of 
the colour modulation field data to the colour table. In general this will be a 
linear transform but other options such as histogram equalisation can be 
chosen to stretch the colour table. Note that a special transform called 
None is available. This will bypass the colour table and is automatically 
used when the _Colour field is selected.

Surface tab defining colour usage and appearance of Located Images

Colour mapping applies a transform to the distribution of colours assigned by the 
specified look-up table.  The dialog is displayed from the Edit button of Colour 
mapping.
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Colour Mapping transform dialog

The Colour Mapping dialog offers band-pass cut-off of colour plus a range of 
transforms to map the colours. Band-pass operations determine the percentage 
of attribute data that is colour scaled. You can specify an upper and lower cutoff 
as required.

Available transforms include:

• None – The source data is used as an RGB colour value directly with no 
modification or reference to the colour table.

• Linear (Increasing) – Within the prescribed colour range (as determined 
by the Band-Pass Cutoff) the data (from the attributes of the voxel model) 
are linearly stretched from lowest data value to lowest mapped colour, to 
highest value mapped to highest mapped colour.

• Linear (Decreasing) – The colour values are inversely mapped to the 
Linear Increasing option.

• Log (Increasing) – The log value of the data are linearly mapped from the 
lowest ranked colour, to the highest.

• Log (Decreasing) – The converse of the Log – Increasing option.

• Histogram – An equal area histogram operation to map the display.
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• Manual – Specify the range from the settings in the colour scale. To 
enable this feature, use the specified in data values option and enter 
appropriate data values in the Lower and Upper Value entries.

DTM Tab

The DTM tab allows the objects to be vertically offset by a DTM (Digital Terrain 
Model) grid. 

The offset can be computed for each vertex of all meshes in the object or an offset 
for the centre of the object can be computed and applied equally to all vertices. 
The object can sit on top of the DTM, hang from it or be centred on the DTM. 

The DTM tab and defining a surface to alter the top surface

Object Controls

The Object Controls have object selection from the Show button similarly to 
Group selection but in this case, individual objects of a specified Group are being 
chosen.

The Object Edit button gains access to the Transparency and Transform tab 
dialogs to provide transparency control to individual objects or all in a group and 
additional scaling and translation transformations.
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Transparency Tab

The Transparency property tab to control the transparency of located images.

Transparency is controlled from the slider bar or by entering a specific percentage 
entry. An entry of 0% has no transparency while 100% displays the object with 
total transparency (invisible).

The transparency setting can be applied to a single object, all in a Group or All 
objects irrespective of the Group. For certain objects (such as a sphere, that has 
a surface behind any other point), you can remove the effect of seeing a second 
surface behind the first.

Transform Tab

The Transform tab provides image scaling and translation controls. The scaling 
is applied as the last transformation prior to the DEM offset transform. The 
translation operation is applied as the first transformation after the DEM offset 
transform. These controls are provided for convenience but more powerful 
options are available via the .EGB file. 
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The Transform property tab to control scaling and offset of located images.

Mesh Controls

Image Tab

Mesh controls for quality and transparency of a colour

The Mesh properties has an Edit  button to provide access to the Image tab 
which controls the image stretch, interpolation quality control plus the automatic 
setting of a specific colour or range of colour in which transparency is enabled.
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In many cases a colour (such as white) is set to be transparent since white 
frequently is used as the border around a captured image. The transparency 
option allows the colour to be clear when displayed. 

In other circumstances (for example if the image is derived from a scanned 
bitmap), it is helpful to have a range of colours to be made clear. A buffer of colour 
can therefore be determined to be clear up to the specified colour. For example, 
if white is selected as the default clear colour, (RGB colours of 255:255:255) and 
a buffer colour range of 5 is defined, then the colours made clear (in addition to 
white) are 250:255:255, 251:255:255….255:255:254. 

Two display options are available for the Located Image for Image Stretch and 
Texture Interpolation Modes.  

Image Stretch Mode allows for the display of specific colours plus Black and 
White or for these to be displayed in the highest possible quality. Texture 
Interpolation Modes of an image can be:

• High Quality – Displays interpolated images at suitable levels of 
resolution at all times to prevent aliasing artefacts.

• Interpolate – Applies an interpolation algorithm to smooth the display

• None – Displays the bitmap as is with no interpolation applied.

Grid Tab

The Grid tab is only displayed when a grid surface is incorporated into the EGB 
file, e.g. when a map window had been draped over a grid surface.

The range of grid compression options available allow Discover PA 3D to display 
and manipulate large, complex surfaces quickly with little loss of surface detail. 
Grid compression reduces the complexity of a grid, thereby improving display 
redraw speeds and navigation efficiency.



498 Encom Discover PA User Guide

The Grid Compression tab

The Compression Mode pull-down list provides five compression options:

• None - No compression is performed and the grid is displayed at full 
resolution.

• Decimate to System size - The grid is decimated to the System size set 
via the Discover PA 3D>Options menu option, under the System tab.

• Decimate to User size - The grid is decimated to the X and Y Size values 
assigned by the user within this dialog

• Decimate to User Factor - The grid is decimated according to the X Skip 
and Y Skip values assigned by the user.

• Variable Compression - Attempts to retain the boundary of the grid, 
including internal holes. The compression level is adjusted via the slider 
bar. Three clipping levels are available:

• Complete - the grid boundary and holes are preserved, 

• Partial - the grid boundary and holes may not be perfectly 
preserved, or 

• None - the grid is rendered as a convex hull with no holes 
preserved.
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17 Features
In this section:

• About Features

• Managing Features

• Features Menu

• Feature Databases

• Importing Data Into a Feature Database

• Exporting Feature Sets

• Feature Object Properties

• Working with Features

• Feature Object Attributes

• Feature Options

• Batch Printing Features

• Features Database Structure and Links

About Features

The Encom Discover PA Features menu provides access to a powerful set of 
utilities for creation, storage, manipulation and display of feature objects 
(anomalies). 

A Feature Object is a three dimensional geometric entity represent simple 
geometric entities such as points and lines, or more complex 3D objects such as 
polylines, polygons, open surfaces and closed surfaces (i.e. polyhedrons). 
Feature objects can be easily used to represent real world entities such as 
geological boundaries, orebody grade shells, structural/fault surfaces and 
intersections or any other general three dimensional feature of interest. Feature 
Objects can be created from directly within Encom Discover PA. 

Note All options within the Features menu (except Open Existing FDB) are only 
accessible with a PA Professional licence.
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These Feature Objects are grouped together into Feature Sets and stored within 
these sets in a Feature Database, which is a standard Microsoft Access database 
format with a .FDB file extension. Encom Discover PA Professional has the ability 
to open and maintain many feature databases concurrently. Accompanying 
attribute information is stored in the Feature Database for each feature object and 
the database can be queried based on these attributes.

Aside from viewing in Encom Discover PA Feature Objects can be used with the 
3D Solid Generator utility. The 3D Solid Generator joins a number of Feature 
Objects together to produce a three-dimensional enclosed or planar surface; i.e. 
a solid body to represent an ore body zone or fault plane. Volumes can be 
calculated for enclosed 3D Solid bodies. Feature objects can also be used with 
the 3D Extrusion Tool to create 3D solid bodies from digitised polygons. The 
Extrusion Wizard can use polygonal objects from a Feature Set as a primary 
surface which can be extruded between another surface, defined by a grid 
surface, a constant Z value or a field contained within a database. With both of 
these utilities volumes can be calculated for the generated enclosed 3D Solid 
bodies.  For more information on these utilities please refer to their corresponding 
sections in Display Utilities.

Managing Features

Features are stored and maintained in a database controlled by Encom Discover 
PA. The feature management system:

• Can open and maintain many feature databases concurrently.

• Can have a database containing multiple Feature Sets within which 
feature objects can be grouped.

• Can contain a Feature Set class of features used to categorise feature 
objects with some aspect in common (for example, features derived from 
deep conductors, cultural sources, detected dykes etc).   Feature objects 
within a Feature Set have the same display symbol attributes although 
these can be modulated for size, colour and rotation depending on 
selected data fields.

• Allows each Feature Set to be associated with data fields derived from the 
originally used data source. This is especially useful for feature analysis 
since later evaluation of the feature may depend on re-examining the 
initial criteria for selecting the feature methods. Such as EM decay curve 
analysis use this approach.
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Features Menu

The Features menu options

The Features menu contains the following functionality:

• Open: allows an existing Feature Database to be opened into the current 
session (see Opening an Existing Feature Database)

• Create: creates a new empty Feature Database, including any custom 
attribute fields specified by the user (see Creating a New Feature 
Database).

• Create Query: allows attributed Feature Databases to be queried using a 
simple SQL syntax (see Querying Feature Attributes)

• Close: closes selected open Feature Databases.

• Import from Vector File: allows a range of vector file formats to be  
imported into either an existing Feature Database or new Feature 
Database (see Importing Data from Vector or Grid Files).

• Import from ASCII File: allows a range of ascii file formats to be imported 
into either an existing Feature Database or new Feature Database (see 
Importing Features from ASCII Files). 
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• Export to Vector File: exports feature objects from a Feature Set from an 
open Feature Database to a range of industry standard vector file formats 
(see Exporting Feature Sets) Some example include AutoCAD .DXF 
MapInfo .TAB, Gemcom .BT2 and ESRI .SHP. Feature objects can also be 
exported to MapInfo .TAB files which are directly compatible with a 
Discover Drillhole Section Boundary file.

• Export to .GDB File: exports feature objects from a Feature Set from an 
open Feature Database to a Geosoft Database (.gdb) file (see Exporting 
Feature Sets).

• Feature Spreadsheet: displays a spreadsheet view of feature objects 
listed according to their ID number and associated fields (see Feature 
Spreadsheet).

• Edit – allows the user to Combine, Intersect, Erase, Set Target, Clear 
Target, Resize, Delete, Cut, Copy and Paste feature objects (see Editing 
Objects).

• Feature Options: contains controls for setting the default polygon fill, 
selection and query highlight colours (see Feature Options).

• Feature-Line Associate Wizard: allows feature objects to be associated 
with line numbers from a loaded Geosoft or Intrepid survey database (see 
Line Association Wizard).

Feature Databases

In this section:

• Opening an Existing Feature Database

• Interacting with Features

• Creating a New Feature Database

• Adding a New Feature Set to a Database

• Feature Calculator – provides the ability to create new fields in a feature 
database based upon user-defined calculator expressions.

• Deleting a Feature Set
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Opening an Existing Feature Database

Feature Objects are stored and maintained in a Feature Database. A Feature 
Database is a relational database that supports complex objects and associated 
attributes. A Feature database can be identified by its .fdb file extension. Encom 
Discover PA has the ability to open and maintain multiple feature databases 
concurrently.

Use the Browse window to locate an existing feature database 

Browse to the location of an existing Feature database and click Open. A new 
Feature Database will be added to the Data Manager window under the Features 
folder and all associated Feature Sets belonging to the database will be listed 
beneath it. 

To open a pre-existing Feature Database select the Features>Open…  menu 
option. The Open dialog is will be displayed.
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A loaded Feature Database will be shown in the Data Manager window

If you want to close multiple open feature databases click with the right mouse 
button on the Feature Sets folder of the Data Manager and select the Close All 
Unused pop-up menu option.

Interacting with Features

The display, selection and editing properties of a Feature database are 
configured using the Workspace tree.

The icons to the left and right of each Feature Database item in the Workspace 
Tree control the following properties:

To close a Feature Database in an Encom Discover PA session select the 
Features>Close menu option. In the Close Feature Databases dialog that 
appears select the database(s) to close and click the Close button. An 
alternative to close a feature database is to click with the right mouse button in 
the Data Manager window on the Feature Database branch that you wish to 
close and select Close Database from the pop-up menu.

Visability - toggles the visibility of the Feature Objects in the 3D window on and 
off.

Editability – enables editing for the selected Feature database. With editing 
mode enabled new objects can be added to the database and existing objects 
can be edited or deleted from the Feature database. Only one Feature database 
at a time can be made editable.
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Creating a New Feature Database

A new Feature Database can be created by any of the following methods:

• Features>Create menu option – creates a new empty Feature Database 
using the Feature Database Creation Wizard.

• Features>Import menu options - Imports a variety of supported vector 
and grid file formats from external third party software programs into a 
new Feature Database (see Importing Data Into a Feature Database).

• 3D Solid Generator – 3D polyline or polygon objects can be  triangulated 
to produce open surfaces (e.g. fault planes) or closed  surfaces (e.g. solid 
closed meshes) using the 3D Solid Generator. These triangulated objects 
can be output directly to an existing or new Feature database.

• 3D Extrusion Tool - various 2D or 3D objects, including points, lines, 
polylines and polygons can be extruded into triangulated 3D mesh objects 
using the Extrusion Wizard. The output objects from the Extrusion Wizard 
can be directed into a new or an existing Feature database.

Selectability – enables objects within a selected Feature Dataset to be 
interactively selected using the mouse. Selectability can be used to limit which 
Feature database(s) can be interrogated when multiple complex feature 
databases are open in the 3D view.

Zoom Extents – zoom the 3D view extents of the extents of the objects in the 
selected Feature database.

Closes a selected Feature Database. The Features>Close menu option 
displays the Close Feature Databases dialog which provides the ability to select 
individual feature databases to close when the Close button is clicked (shown 
left).
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Feature Database Creation Wizard

The Feature Database Creation Wizard creates a new empty Feature Database.

Step 1: Database name and location

Step 1 of the Feature Database Creation Wizard – Feature Database naming and location

Step 2: Feature set name

• Enter a name for the first Feature Set belonging to the database. If 
required also enter a description for this Feature Set, such the 
characteristic that will be used to group the how feature objects together. 
Additional Feature Sets can be created for this database once the wizard 
process has been completed. 

1. To start the wizard, select the Features>Create menu option.

2. Complete the options displayed at each step of the wizard.

• Use the Browse button (shown left) to navigate to a folder to save the file 
and enter a name for the new Feature database. Click Next once the 
database is defined. 
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Step 2 of the Feature Database Creation Wizard  - Feature Set naming

Step 3: Define Fields

• Boolean – can contain binary information only (i.e. Yes/No).

• Byte – can contain byte values, such as

Short Integer – can contain small integer values ranging in value 
from -32768 to 32767.

Long Integer – can contain large integer values ranging in value 
from -2,147,483,648 to 2,147,438,647 .

Currency – can contain numeric data in currency format to enable 
accurate fixed-point calculations to be performed where fractional 
accuracy is important.

Each new feature database is created with the following set of default fields : ID, 
X, Y Z, Value and Description. All Feature databases must contain these default 
fields so their name and type properties cannot be modified. You can nominate 
additional fields of your own choice, or add automatic fields that are linked to a 
field in the survey database. Data in these fields are automatically piped from the 
survey database into the feature database when you create a feature object. 

1. To add new fields click on the Add New Field button (shown left) in this 
dialog. Doing so opens a dialog that allows you to name the new field and 
select the data type from a standard list that includes:
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Single Precision Float – can contain numeric values in single 
precision 32-bit floating point format ranging in value from - 
3.402823E38 to 3.402823E38.

Double Precision Float – can contain numeric values in  double 
precision 64-bit floating point format ranging in value from 
approximately -1.797E308 to -4.940E324 (negative), from 4.94E- 
324 to 1.797E308 (positive), and zero.

• Date – can contain date information .

• Text – can contain text to a maximum of 255 characters.

• Memo – can contain text to a maximum of 65,535 characters.

Step 3: Associating survey database fields with Feature Sets

When specified, the data fields are displayed in the Fields tab. Note that 
these automatic fields are created by Encom Discover PA and you cannot 
modify the name or data type.

If a text or memo data type is selected enter an appropriate size: this 
property relates to the maximum number of characters that can be stored 
by the field. Click OK to create the new field.

Other fields, such as Ranking and Memo are also added to the Feature 
Set. These are character type fields that allow you to better organise your 
features.
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2. Click Finish to create the new Feature Database. A new Features item is 
added to the Data Manager window.

See Creating Objects for information on how to add features to a database.

Adding a New Feature Set to a Database

To add a new Feature Set to an existing Feature Database, highlight the database 
branch in the Data Manager window and click the right mouse button to display a 
pop-up menu. Select the Add New Feature Set option from the pop-up menu as 
illustrated below: 

   
Add a new Feature Set using the Data Manager window

The Add New Feature Set dialog.
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The Add New Feature Set dialog will appear. Enter a name for the new Feature 
Set and if required a description as well. To add additional data fields to the new 
Feature Set, select the Fields tab in this dialog and add additional fields as 
explained in the previous chapter. Click the OK button and a new Feature Set 
branch will be added to the Data Manager underneath the feature database 
branch. 

If additional fields are required to be added to this Feature Set after the dialog has 
been closed, return to this dialog by highlighting the Feature Set branch in the 
Data Manager and clicking on the right mouse button to display a pop-up menu. 
Select the Feature Set Properties pop up menu option and the same dialog will 
appear again.

Add additional fields to a Feature Set using the Feature Set Properties pop up menu option

Feature Calculator

The Feature Calculator can apply arithmetic operations to data fields of a Feature 
database. You can initiate the Feature Calculator from the Utilities menu. 

The Feature Calculator interface appears similar to the Line Calculator and its 
operations in general are similar. The interface for the Feature Calculator is: 

Note Encom Discover PA Professional is required to operate this tool. If you wish to 
purchase or evaluate this module, please contact Pitney Bowes Software.
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Feature Calculator dialog with feature computation formula

The Feature Calculator requires a formula to be specified in the command line at 
the top of the dialog. Available data fields appear in the scrollable list from the 
nominated Feature database. Complex data field operations such Boolean, 
comparative, logical and decision functions can also be applied. These 
operations are described in Calculator Syntax.

Clicking individual operation buttons causes their display to be automatically 
placed in the command line. You can either enter formula directly into the 
command line by typing from the keyboard, or by selecting the appropriate fields 
and buttons. Note in all cases that a correct arithmetic formula must be written. If 
the calculator detects errors in the command entered, a message indicating an 
invalid expression is displayed.
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Buttons along the base of the dialog allow you to Select a field (after highlighting), 
Load or Save a formula, or Compute the displayed formula. The formula 
specification is as for normal algebraic operation. 

The Insert Function button allows you to construct complex formulae. A wide 
range of arithmetic, logic and comparative operations are available with the Line 
Calculator. A subset of the formulae are provided by the pull-down list that 
provides the various operators and an example of their use. Refer to Special Line 
Calculator Operations for a list of the operators available.

Calculator Syntax

For the Line, Grid and Feature Calculators, a series of advanced Boolean and 
algebraic operators are available to allow data merging, decision logic and 
complex arithmetic operations. The operators are implemented by applying a 
specified syntax that describes the input, output and required operation.

Below are described a series of operators that, when used with calculators, will 
perform various operations. Note that in the case of the Line and Feature 
Calculators, the output (referred to as the parameter Out) may be a newly written 
database channel. In the case of the Grid Calculator, the output is a supported 
grid.

• Logical Operators

• Arithmetic Operators

• Anti-Log Functions

• Comparison Operators

• Boolean Operators

• Trignometric Operators

Logical Operators

AND Operator

Returns TRUE if both its arguments are TRUE; returns FALSE if one or both 
arguments are FALSE.

Syntax

AND(logical1,logical2)
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Logical1 and logical2 are conditions you want to test that can be either 
TRUE or FALSE. The arguments must evaluate to logical values such as TRUE 
or FALSE. An alternative to the AND function is the operator ‘&’ . ‘&&’ is 
interpreted as ‘&’

Example 1

Out = IF(AND(A>5, B<=10), 1, 2)

The output Out is set to 1 both A>5 and B<=10 otherwise it is set to 2

Example 2

Out = IF(A>5 & B<=10), 1, 2)
Out = IF(A>5 && B<=10), 1, 2)

This is an alternative syntax. These examples produce the same output as 
example 1.

NOT Operator

Reverses the value of the argument. Use NOT when you want to make sure a 
value is not equal to one particular value.

Syntax

NOT(logical)

logical is a value or expression that can be evaluated to TRUE or FALSE. If 
logical is FALSE, NOT returns TRUE; if logical is TRUE, NOT returns 
FALSE.

Example 1

Out = IF( NOT(A<100), A, 100)

The output Out is set to A if A is greater than 100 and is set to 100 otherwise. This 
is a trivial example which could be replaced with the >= operator

OR Operator

Returns TRUE if either argument is TRUE; returns FALSE if both arguments are 
FALSE.
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Syntax

OR(logical1,logical2)

Logical1 and logical2 are conditions you want to test that can be either 
TRUE or FALSE. 

The arguments must evaluate to logical values such as TRUE or FALSE. The | 
operator is an alternate to the OR function. || is an alternative to |.

Example 1

Out = IF( OR(A<100, B<100), C, D)

This examples sets the output Out to C if either A or B is less than 100. The output 
is set to D otherwise.

Example 2

Out = IF( A<100 | B<100), C, D)
Out = IF( A<100 || B<100), C, D)

This is an alternative syntax where these examples produce the same output as 
example 1.

XOR Operator

Returns TRUE if only 1 argument is TRUE; returns FALSE if both arguments are 
FALSE or both are TRUE.

Syntax

XOR(logical1,logical2)

Logical1 and logical2 are conditions you want to test that can be either 
TRUE or FALSE.  The arguments must evaluate to logical values such as TRUE 
or FALSE

Example

Out = IF( XOR(A<100, B<100), C, D)

This examples sets the output Out to C if one and only one of A and B is less than 
100. The output is set to D otherwise.
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IF Operator

Returns one value if a condition you specify evaluates to TRUE and another value 
if it evaluates to FALSE.

Use IF to conduct conditional tests on values and formulas.

Syntax

IF(logical_test,value_if_true,value_if_false)

Logical_test is any value or expression that can be evaluated to TRUE or 
FALSE. For example, A=100 is a logical expression; if the value in A is equal to 
100, the expression evaluates to TRUE. Otherwise, the expression evaluates to 
FALSE. This argument can use any comparison calculator operator.

Value_if_true is the value that is returned if logical_test is TRUE. For 
example, if this argument B and the logical_test argument evaluates to 
TRUE, then the IF function returns the value stored in B. 

Value_if_false is the value that is returned if logical_test is FALSE. For 
example, if this argument is C and the logical_test argument evaluates to 
FALSE, then the IF function returns the value stored in B.

Up to seven IF functions can be nested as value_if_true and 
value_if_false arguments to construct more elaborate tests. See the last of 
the following examples. When the value_if_true and value_if_false 
arguments are evaluated, IF returns the value returned by those statements. 

Example 1

Out = IF( A<100, A, 100 )

This example will set the output to A when A is less than 100 and set it to 100 
otherwise.

Example 2

Out = IF( A<100, IF( B>A, B+100, A+100), IF(C>0, C, A) )

This example shows how the two output expressions of the first IF can 
themselves be IF functions.
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Arithmetic Operators

To perform basic mathematical operations such as addition, subtraction, or 
multiplication; and produce numeric results, use the following arithmetic 
operators.

Anti-Log Functions

To perform antilog operations (opposite in operation to logarithmic function 
equivalents) the following are available:

Syntax

aln(x) – Anti-logarithm (base e) of x.  That is e^x

alog(x) – Anti-logarithm (base 10) of x. that is 10^x 

Comparison Operators

You can compare two values with the following operators. When two values are 
compared by using these operators, the result is a logical value either TRUE or 
FALSE.

Function Operator Example

addition + plus sign A+B

subtraction – minus sign A–B

multiplication * asterisk A*B

division / forward slash A/B

exponentation ^ caret A^B

Function Operator Example

equal to = A=B

greater than > A>B

less than < A<B

greater than or equal to >= A>=B
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Null support is also provided in the calculators. 

Boolean Operators

Note that the following Boolean logic operators apply only to the Grid Calculator. 
Some examples:

OUT = IF(A>0, A, B)

OUT = IF(A>0 & B<(C/2), D, E+F)

OUT = IF(AND(A>0, B<(C/2)), D, E+F)

OUT = IF(A<100, Null, A)

OUT = IF(A=Null, B, C)

Note that the second and third examples above are identical, the first using the & 
operator and the second using the AND function.

Trignometric Operators

The following trigonometric operators are available for both Line and Grid 
Calculators.

DEGTORAD(degree_value) – Conversion of degree values to radians.

RADTODEG(radian_value) – Conversion of radian values to degrees

SINH(a) – Hyperbolic sine of an argument in radians (Y = sinh(x))

COSH(a) – Hyperbolic cosine of an argument in radians (Y = cosh(x))

TANH(a) – Hyperbolic tangent of an argument in radians (Y = tanh(x))

Note that standard geometric operations such as SIN, COS and TAN are 
available from the Line and Grid Calculator standard interfaces. 

less than or equal to <= A<=B

not equal to <> A<>B

minimum MIN(value1, value2) MIN(A,B)

maximum MAX(value1, value2) MAX(A,B)
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Deleting a Feature Set

A Feature Set can be deleted from a Feature Database provided that the Set 
being deleted is not active in any display windows of Encom Discover PA. An 
easy way to check this is by referring to the Data Manager window. A record of 
how many entries of each Feature Set is being used in display windows is 
recorded in a column located to the right of each Feature Set branch.

If you wish to continue deleting the Feature Set click OK. The Feature Set will be 
permanently removed from the Data Manager hierarchy tree.

Importing Data Into a Feature Database

• Importing Data from Vector or Grid Files

• Importing Features from ASCII Files

Importing Data from Vector or Grid Files

The Import File Wizard allows a range of Vector file formats and Grid file formats 
to be imported into either an existing or new Feature Database. This wizard is 
accessed via the Features>Import From Vector file or Features>Import from 
Grid file menu option.

To delete a Feature Set from a database highlight the Set in the Data Manager 
window and click on the right mouse button to display a pop-up menu. Select the 
Delete Feature Set menu option and a confirmation message is displayed.
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Step1: Select file type

The Import File to Feature Database Wizard

Select the type of files to import. Two options are provided:

• The Vector files option supports common industry file formats including 
DXF, MapInfo .TAB, ESRI .SHP, Gemcom .BT2. You can import any 
contained layers into separate features.

• The Grid files option supports importing Grid files, such as ER Mapper, 
Surfer, Geosoft etc into a triangulated irregular network surface (TIN).

Press Next after the required format is selected.

Step 2: Select source and destination files

Vector files

• Click the Browse button to select a single source file.

• Multiple files can be imported simultaneously by selecting them 
consecutively with the Add Files button.
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Importing a DXF file into a new feature database called ‘Conductive Body’

Click Next to advance the wizard.

• If multiple attributed Vector files are being imported, only one file  can be 
used to define any extra custom fields. Highlight this file in the import list, 
and click the Attribute button; the selected file will be moved to the top of 
the list.

If importing a Vector file, you can import any contained layers into 
separate features by enabling this option

• Individual vector files can be removed from the Import list by highlighting 
them and selecting the Delete Files button.

• The imported files can either be: 

• Appended to an existing open feature database by enabling this 
option and selecting the target database from the pull-down list or 

• Created in a new feature database (or existing feature database 
can be overwritten) using the Browse button adjacent to the 
Feature Database option.
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Grid files

Importing a grid file into a new feature database called ‘Surfaces’

Click Next to advance the wizard.

• Click the Browse button to select a single source file.

• Multiple files can be imported simultaneously by selecting them 
consecutively with the Add Files button.

• Individual grid files can be removed from the Import list by highlighting 
them and selecting the Delete Files button.

• A number of Compression Modes are available to facilitate efficient 
importing and handling of larger grids. See the Surface Compression 
section for a full explanation of the available options.

• The imported files can either be: 

• Appended to an existing open feature database by enabling this 
option and selecting the target database from the pull-down list or 

• Created in a new feature database (or existing feature database 
can be overwritten) using the Browse button adjacent to the 
Feature Database option.
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Step 3: Assign the Z field

The final dialog of the Import wizard, controlling the Z value assignment.

The final dialog of the wizard (Step 3) allows the Z field handling to be controlled. 
Generally this is best left as the default option (auto initialise the Z field), capturing 
this information automatically from the input file.  However, you can instead 
specify either an attribute field or constant value to use for Z information.

Click Finish to start the import process. If a new feature database was created, it 
will be added to the workspace tree. 

If importing a vector file composed of 3D facets (e.g. planar or volume solids), 
Encom Discover PA will automatically perform a check of each surface, 
examining whether all facets are closed, and whether the order of vertices needs 
to be reversed. If any issues are found, the user will be presented with the Import 
Warning Report dialog. The user can either:

• Continue the import – all surfaces will be displayed in Encom Discover 
PA, but using some of the Feature Object editing tools (see Editing 
Objects), such as Combine, Intersect, Erase, etc., on any surfaces with 
unclosed facets will result in errors.

• Cancel the Import. Then use the Topology Checker utility (in the Utilities 
menu) to export from the source vector file only the surfaces whose facets 
are closed, and reverse the order of vertices as necessary. Import this 
new vector file using the Feature Import tool.
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Importing Features from ASCII Files

The Feature utility can also import ASCII file data in .CSV format only. The format 
of these files is described in Appendix B: Data File Specifications.

ASCII data can only be imported into a pre-existing feature database that is 
loaded into Encom Discover PA. Refer to Creating a new Feature Database for 
more information on creating a feature database.

To import feature data in ASCII format into a loaded feature database:

1. Select the Features>Import from ASCII file menu option.

The ‘Import from Ascii file’ menu option.

2. An existing Feature Database and associated Feature Set must be 
selected from the first dialog that appears. This will be the file that the 
objects in the ascii file will be imported to.
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3. The Ascii data import dialog will then appear. Click on the Browse button 
to open a .CSV file.  When a CSV file is selected, the column names 
embedded are used by the import facility and automatically loaded. The 
import dialog appears as below after the file has been read:

Dialog of import tool after a CSV file with column headers has been read

Note If the dialog appears in a condensed format click on the Expand button in the top 
right hand corner to view all parameters.
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Alter the Data type of alphanumeric fields to be String

Also note that you may have to specify null values in the various fields if 
applicable.

4. When the data format, null specification and columns names etc. are 
correct, click the Import button of the dialog. The contents of the selected 
file are then converted to a feature database with a resultant summary 
dialog detailing the imported data.

Summary dialog for importing features from an ASCII file

Exporting Feature Sets

The individual records of a Feature database can be exported to a range of output 
file types. 

Note If a column in the ASCII file has alphanumeric fields (eg a column with values of 
1A, 2A etc) this must be specified as Strings rather than the default Float data 
type. To change this data type to String click on the column header with the right 
mouse button and select the Properties pop-up menu option. In the Properties 
dialog change the data type to String.
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The export facilty can create output of the specified Feature database, and 
Feature Set. The utility reports the number of records of the selected Feature Set 
in the database. When you specify the output data file, the pull-down entry allows 
selection of the file type:

The Feature Exporter allows a selected feature Set to be exported as one of the 
following formats:

• Geosoft .GDB

• ArcView .SHP file

• AutoCAD .DXF file

• MapInfo Professional.TAB

• MapInfo Professional .MIF

• ASCII .CSV file



17 Features 527

To export a feature set:

1. Choose the Features>Export menu option.

2. Specify the Feature Database and Set plus the output filename and 
format type. 

Note at the base of the Save As dialog, you can specify the required 
export format for the objects in the Save as Type option. 

3. Click the Export button when the required output is specified. The vertices 
for each feature are listed according to their unique ID number assigned 
by the software.

Feature Object Properties

The display style and labelling options of all objects in a Feature Set can be 
modified in the Feature Properties dialog (double click on the appropriate Feature 
item in the Workspace tree to open, or right click on the feature layer and choose 
the Properties menu option).

This dialog is almost identical for all types of feature objects and regardless of 
what type of display they are within. However, in the case of a Profile display, a 
VerticalPosition field is used to specify the Y value of the features (i.e when the 
feature was created in profile view the value of the Y-axis is specified as the 
VerticalPosition).

Feature Properties dialog for a profile display
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If features are to be plotted within a section and with a reference to a specified 
depth, you can select the data field (for the Vertical) of Value. This field of the 
database is retained when the features have been created from a depth-related 
section profile. An example of this is below:

Features positioned vertically and across the displayed section using the Value field

Within the Properties dialog you can also specify Colour, Size, Rotation, 
Symbol and Label modulation of the feature objects from the data page. In all 
cases it is necessary to select a field from the feature database. If a required data 
field is not available in those specified, return to the Fields tab of the Feature Set 
Properties (accessed from the Data Manager pop-up menu) and add the required 
field.

Feature Appearance

The Appearance tab of the Feature Properties dialog provides controls for point, 
polyline and polygon style control, including 

• Symbol type, size and colour 

• Fill colour and transparency

• Line colour, weight and pattern. 

Any style applied will affect all objects in the database. Polygon colour fill can be 
disabled by deselecting the Fill tick box. Once the Fill option is deselected, the 
Line colour will automatically become the colour of the Fill colour.

Alternatively, all objects in the database can be colour modulated:

1. Specify numeric field to colour modulate the objects by using the Colour 
control under the Data tab.
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The Appearance tab dialog for Feature Properties

Labelling Features

Feature object Labels can be displayed by specifying an appropriate data field in 
the Data tab of the Feature Properties dialog. A Label Skip Factor can also be 
set under the Appearance tab. The Advanced Arrangement dialog (accessed 
via the Appearance button under the Appearance tab) provides powerful 
controls for modifying and controlling labels.

2. Use the Colour Table Edit button under the Appearance tab to either set 
a Look-Up Table or custom Legend, or customise and apply a RBG or 
HSL interpolation. See the Colour Table section in Voxel Models for a 
detailed description of this dialog.

3. Use the Colour Mapping Edit button to apply a Data Transform  
(predefined or custom). See the Colour Mapping section in Voxel Models 
for a detailed description of this dialog.

4. Click Apply (or enable the Auto Apply option) to display the changes.
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The Advanced Arrangement dialog for 3D feature labels

The Number Format dialog for feature labels

The Format button provides numeric formatting options (scientific, various DMS 
formats, general, etc), decimal place allocation as well as suffix and prefix 
specification 
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• Facing Viewer (default) – Labels are aligned parallel to the viewing/
screen plane, so that they always face the viewer. 

• Fixed 3D – Labels are fixed in the 3D environment. The pull-down list in 
the Rotation panel at the bottom of the dialog controls the initial 
orientation: Flat (the XY plane) or Upright (XZ plane).

• Fast 3D – identical to the Fixed 3D except that no Style controls are 
available; this is a very fast and memory-efficient labelling option.

A range of Size Controls are available. For the Fast 3D orientation option, only 
the Font Size control is available (in points). Enabling the Constant checkbox 
(for the other orientation options) will keep the labels at the specified size (relative 
to the screen) regardless of zoom level. If the Constant option is disabled, Lower 
and Upper Limits can instead be set:

• Block: labels will disappear when the applied zoom level takes the label 
past the specified limit 

• Clamp: labels will locked to the specified limit  when the applied zoom 
level takes the label past the specified limit. 

The label position relative to the data (collar) location can be altered using the 
Alignment controls (either preset or manual positioning). The first row of controls 
concern label positioning in the label plane (i.e. the relative XY components), 
whilst the second row controls the vertical height of the label with respect to its 
initial plane (i.e. the relative Z component).

The angle of the labels can also be set by moving the red-tipped arrow on the 
compass in the Rotation panel at the bottom of the dialog. The Fixed and Fast 
3D labelling options also provide a Dip control (half-compass) in this panel.

Standard Font controls are provided, as well as the following range of 
orientation options in the adjacent pull-down list:

The Style button is only available for the Facing Viewer and Fixed 3D 
orientation options. It enables labels to be extruded either as filled Polygons or 
Line Segments (wireframe) using the Format pull-down list. The depth of the 
label is set using the Extrusion control, expressed as a percentage of the label 
size. To display a flat label, set the Extrusion to 0%. The label is extruded 
perpendicular to its display plane. 

Note Rendering labels as extrusions is memory intensive and will affect 3D 
performance. It is not recommended for large numbers of labels.
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Working with Features

• Selecting Feature Objects

• Querying Feature Attributes

• Creating Objects

• Editing Objects

• Advanced Editing Functions

Selecting Feature Objects

A number of object selection methods are available:

Alternatively, one or more objects can be selected from the Feature Spreadsheet 
display, a floating window located at the bottom of the screen when Encom 
Discover PA is first opened. If this display is closed at any time it can be opened 
again by right mouse clicking anywhere on the toolbar area of Encom Discover 
PA and selecting the Feature Data pop-up menu option.

Editing Objects and Attribute Query both require one or more Feature Objects 
to be selected. A Feature Set must be Selectable before objects within it can 
be selected; this is enabled in the Workspace Tree and is typically 
automatically enabled with the Editable icon, unless multiple Feature 
Databases are being used. This control is useful when multiple dense 
databases exist in the same area; you can disable the electability of all 
databases except the target database.

• Enable the Select button on the Zoom Controls Toolbar, and click on 
the object to edit. When selected, an object will be highlighted in red 
(unselected objects are displayed in a default blue colour). The Cursor 
Plane will automatically be enabled and the plane will snap to the 
object’s plane. To select multiple objects, hold down the CTRL key whilst 
using the Select button; the Cursor Plane will snap to the last selected 
object.

• The Polygonal Selection button allows you to draw a selection region 
in the display window; all Feature Objects that lie entirely within this 
region will be selected. The selection region is independent of the 
Cursor Plane; it is actually drawn within the screen plane, and selects 
all objects behind this plane, regardless of object orientation.
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Feature Spreadsheet display with feature object selected

Querying Feature Attributes

The output of a query is a new Feature Set as specified in the Name option of the 
dialog. This is a useful way to separate a multi-attributed database (e.g. that 
pictured under the Feature Spreadsheet section) into a number of databases 
each populated with objects of a single attribute. The new Feature Set will be 
automatically added to the list for that specific Feature Database in the Data 
Manager window.

The pull-down Field and Operator selection lists to the right of the Expression 
pane allow SQL syntax creation for the feature query.

The Create Feature Database Query dialog (accessed via the 
Features>Create Query menu option. Feature objects within an open Feature 
Database are able to be queried using basic SQL syntax. 
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The Create Feature Set Query dialog

The Verify buttons for the query expression and query name (i.e. the output 
Feature Set name) allow the user to check that these entries are correctly 
formatted before proceeding.

The Verify buttons for the Query SQL Statement and Query Name will check 
the validity of the entries before creating the query

Once the Create Query button is selected the dialog is closed and the query is 
generated. A new Feature Set for this query will be added to the Feature 
Database tree in the Data Manager window. A Feature Set produced by a Feature 
Query has a different icon to a normal feature with a green “Q” replacing one of 
the blue circles in the icon.

When displayed in a Feature Spreadsheet window the success of the query can 
be observed with all feature objects listed having an attribute similar to that 
queried.
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 Observe the new Feature Set created by a query in a spreadsheet display

Creating Objects

To add a Feature Set to a display (and the associated workspace tree): 

1. Highlight the Profile 1, Map 1 or 3D Map 1 branch, click on the right mouse 
button and selecting  the Add Data>Feature Set pop-up menu option.

3. Select the Feature Set from the Data Manager window and drag and 
dropping this object into the display window where you want it added.

Creation of Feature Objects in Profile, Map or 3D displays requires a user-
created or imported feature database to be present in the workspace tree. 

2. Highlight the Profile 1, Map 1 or 3D Map 1 branch then select the Add 
Feature button  from the Data Objects toolbar.
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Feature Set being added to a display in the Workspace Tree

Multiple Feature Set branches can be added to a tree and each entry can control 
the display attributes of a different Set and Type. The Feature branches that are 
present in a tree each have individual properties controlled by a Properties dialog 
(See Feature Object Properties for more information on this).

To toggle a Feature Set on or off, use the Show/Hide checkbox adjacent to the 
Feature branch in the Workspace tree.
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Once the Feature Set is added to the workspace tree it must also be made 
Editable (via the pencil icon in the Workspace Tree) before any objects can be 
created.

When a feature database is made editable, the Features toolbar will become 
active and if working in 3D the Cursor Plane will be displayed. The Cursor Plane 
is used as a drawing plane onto which Feature Objects are digitized: for detailed 
information on controlling the Cursor Plane, see the 3D Cursor Plane section.

The icons to the right of each Feature Set branch in the Workspace Tree are as 
follows:

The Features toolbar

The Features Toolbar provides the tools for the creation, selection and editing of 
Feature Objects, including Points, Polylines, Polygons and Three-Point-Range.

To draw objects point, polyline or polygon objects in 3D:

1. Make the target feature database editable.

2. If creating feature objects in 3D use the Cursor Plane controls to position 
and orientate the Cursor Plane in the required location. Otherwise position 
the Profile or 2D Map display to where you wish to digitise.

3. Select the appropriate object button from the Feature Toolbar (point, 
polyline, polygon or 3-Point-Range), and click on the point location or 
polyline/polygon start point.

Editability – enables objects to be added or edited in the selected Feature Set. 
Only one Feature Set can be editable at one time. To create Feature Objects 
this icon must be active for the Feature Set that the features are to be added to.

Selectability – enables objects within a Feature Set to be selected. For instance, 
when multiple image branches are open, this is a useful way of limiting which 
branches (or images) the Cursor Plane can be bonded to.  Selectability can also 
be used to control which Feature Set(s) can be interrogated when multiple 
complex databases are open.

Zoom Extents – zoom the view to the extents of the selected Feature Set feature 
objects.
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4. For polylines/polygons, click on consecutive points to outline the object, or 
hold down the left mouse key whilst moving the cursor to create a 
continuous series of nodes.

5. Press the ESC keyboard button at anytime to cancel the object creation. 

6. Press the BACKSPACE keyboard button at anytime to delete the last added 
node.

To pick a single point feature, enable the New Point Feature button. A 
single point feature can be placed in either a profile, map or 3D window 
using this tool. After enabling and moving the cursor to the required 
window, locate the required position and left mouse click. The location is 
stored in the specified Feature Set in the database.

This tool is used to create a New Line Feature and can be used either in 
a profile, map or 3D window. The tool can be used to create specific 
vertices along a polyline (by positioning the cursor and clicking the left 
mouse at each vertex position). Double click to end the polyline. 

Alternatively, to create a freehand polyline, position the cursor at the 
starting location, hold the left mouse button down and draw. The polyline 
and vertex locations are stored in the database.

This tool is used to create a New Polygon Feature. It can be used in 
either a profile, map or 3D window. To operate, make the required Feature 
Set branch editable by enabling the pencil icon in the Workspace tree. The 
tool can be used to create specific vertices around a polygon (by 
positioning the cursor and clicking the left mouse at each new vertex 
location). Double click to end the polyline. 

Alternatively, to create a freehand polygon, position the cursor at the 
starting location, hold the left mouse button down and draw. The polygon 
vertices and location is stored in the database.

The Three-Point-Range tool is primarily designed for use with profiles 
although it can be used in map windows. The three-point pick feature 
marks a zone of a feature with a double-headed arrow and a centre, 
anomalous point.

The Three-Point-Range feature is created by selecting the New Three-
Point-Range Feature button, positioning the cursor at the start location 
and clicking the left mouse button. Move the cursor to the centre part of 
the anomaly, click again and then repeat at the end, marking the width of 
the feature.
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7. Complete the polyline/polygon object by double-clicking; polylines will end 
at the double-click point, whilst polygons will close back to the start point 

Confirm Feature Creation dialog for entering comments on created features

9. Upon completion of an object, it is highlighted in red as the current 
selected object (see Selecting Feature Objects), allowing editing (see 
Editing Objects).

For information on using the other tools available on the Features toolbar, see 
Editing Objects.

8. Enabling the Confirm Pick button prior to object creation will display a 
Confirm Feature Description dialog. This allows the object’s default 
fields (and custom fields if any) to be attributed with either text or values. 
For instance, the Description field could be attributed with the object’s 
geology, e.g. south_fault, supergene or zone_1, allowing a single Feature 
Database to hold multiple geological objects. 

When a feature is created in a profile or data is associated, the values 
stored in the Feature Database are also displayed. These can be edited in 
the features spreadsheet or graphically (refer to Feature Editing).

The Ruler tool on the Main Toolbar can be a useful guide for distances, bearings 
and dip angles between objects on the cursor plane.
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Snapping a node to existing data:

Snap to 3D Point/Line or Drillhole data – feature object nodes can be snapped 
to data displayed in these formats:

1. Make the relevant item (Lines, Points or Drillholes) in the Workspace Tree 
Selectable. 

2. Enable the Bond to Image button on the Cursor Plane Toolbar. 

3. Move the cursor over a point in the Points or Lines dataset, or over a 
drillhole interval: the red crosshairs in the drawing plane will snap to that 
location. 

4. This is particularly powerful for 3D interpretation of downhole data; for 
instance, digitizing a series of polylines or polygons outlining 
mineralization or geological features for use in the 3D Solid Generator.

Digitizing tips:

Some digitization tips which are controlled via the Cursor Plane tab of the Cursor 
Plane Properties dialog:

• Use the keyboard PGUP and PGDN keys to offset the Cursor Plane 
perpendicularly from its existing position, in order to keep digitized 
features parallel. Use the User-defined step option to set the distance the 
PageUp/Down buttons move the Cursor Plane.

• The exact location of the Cursor Plane can be set via the Origin (X, Y and 
Z), Inclination and Azimuth controls.

Snap to feature object node – Allows the current object’s node (new object or 
editing an existing object) to be snapped to an existing object’s node. Upon 
activation, the cursor will change to a circle in the middle of the cross-hairs.  
When the cursor is close to an existing node, it will change to the standard cross-
hair: left-click to snap to this node.

To the right of the Snap toolbar button is a pull-down options dialog. This allows 
the Pixel Tolerance to be set (i.e. how close the cursor needs to be to an 
existing node before it can be snapped to that node). A high-pitched audible 
Beep can also be enabled for when the cursor is within the set pixel tolerance: 
when the cursor moves outside the tolerance, a low pitched Beep will sound. 
The Duration of these beeps can be set in milliseconds.
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• To limit the amount of existing data visible either side of the Cursor Plane 
(i.e. simulate a 2D section envelope), enable either the Envelope or Slice 
Clipping options. These enable only a user-defined Slice Width of data 
to be viewed either side (envelope) or behind (slice) the Cursor Plane. 
This is an excellent way to ensure that interpreted boundaries are based 
only on data within, for example, 50m of the Cursor Plane.

• If digitizing onto georeferenced images (e.g. geophysical profiles), use the 
Bond to Image option on the Cursor Plane Toolbar

Editing Objects

Feature Objects can be duplicated, repositioned, resized and deleted. Individual 
or multiple nodes within an object can be added, moved or deleted. Object 
attributes can also be edited.

To enable editing of an object or its nodes:

Polygon feature in edit node mode

1. Object editing requires one or more objects to be selected in an Editable 
feature database (ensure the Editable icon shown left is enabled in the 
Workspace Tree). 

2. Enable the Edit mode button on the Feature Toolbar; all nodes/vertices 
on the selected objects will be displayed. Double clicking on a editable 
object will also enable the Edit mode for the object:
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Use the Features toolbar to perform these editing tasks:

• Three-Point-Range Feature Editing

• Editing an Entire Object

• Editing Individual Nodes

• Other Feature Tools

Three-Point-Range Feature Editing

With a 3-Point-Range feature object selected, three nodes are highlighted. If you 
need to widen the feature, select one of the end nodes, click the left mouse button 
and drag its extent to the left or right. If the central node is to be moved, position 
the cursor over it and select with a left mouse click and then drag within the 
distance of the two end nodes.

If the entire three point pick is to be moved, select the feature nodes and 
reposition as required. Delete a selected three point pick by pressing the DEL key 
or if editing, click the right mouse button and select the Delete item from the pop-
up menu.

Editing an Entire Object

Moving a 3D Object Within the Cursor Plane

Hold down the keyboard SHIFT key whilst dragging the object to its new location. 
The object will be moved within the Cursor Plane. If more than one object is 
selected, all objects will be moved parallel to the plane of the last selected object 
(i.e. the object to which the Cursor Plane has snapped).

Offsetting a 3D Object from the Cursor Plane

Hold down the keyboard CTRL and SHIFT keys whilst dragging the object to its new 
location. The object will be positioned and remain parallel to its initial orientation, 
i.e. it will be offset. If multiple objects are selected, they will be offset to the plane 
of the last selected object.

When depressed, this button allows selection of features within a polygonal 
frame and immediate editing (moving, deletion, vertex movement and 
insertion).

The following Editing functionality is available with the Select button enabled:
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Resizing an Object

The Resize Feature dialog.

The Resize Feature dialog provides both a slider bar and manual entry to specify 
the new object size, as a percentage of its current size. Press Apply to visualise 
the new size (this can be dynamic if the Auto Apply option is enabled). The 
original object size can be restored (if the dialog has not been closed) by pressing 
the Restore button. A number of statistics and parameters can be examined by 
selecting the Expand button.

Deleting an Object

With or without the Edit mode enabled, press the keyboard DELETE key to remove 
an object. Alternatively, right click on the object (not a node) and select the Delete 
option from the shortcut menu. 

Object Cut, Copy, Paste and Delete commands are also available from the 
Features Menu.

With a single object selected and editable, select the Resize command from 
the Features>Edit menu.
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Editing Individual Nodes

Delete a node – select a node by clicking on it (the Cursor Plane cross-hairs will 
converge on the selected node) and press the keyboard DELETE key.

Alternatively, right click on the node and choose the Delete option from the 
shortcut menu.

Repositioning a node – placing the cursor over a node will change the cursor 
to the Move cursor (shown left). Click and drag the node to its new location 
within the Cursor Plane.

Add a node – placing the cursor over a polyline/polygon segment will change 
to cursor to an Add Node cursor. Click to add a node at this location; this node 
can then be repositioned as above. Alternatively, right-click when the cursor is 
over the segment, and choose Insert Node from the shortcut menu. 

Elastic movement of nodes – Moving a node whilst the Activate Elasticity 
button (shown left) is enabled will move its neighbouring nodes.

The Radius of this option’s effect is set via the arrow 
button adjacent to the Elasticity button. This dialog also 
contains options controlling how the affected nodes are 
moved: this effect is represented graphically next to each 
option (Gaussian, Square, etc).

Snap to feature object node – Allows the current object’s node (new object or 
editing an existing object) to be snapped to an existing object’s node. Upon 
activation, the cursor will change to a circle in the middle of the cross-hairs.  
When the cursor is close to an existing node, it will change to the standard cross-
hair: left-click to snap to this node. 

To the right of the Snap toolbar button is a pull-down 
options dialog. This allows the Pixel Tolerance to be set 
(i.e. how close the cursor needs to be to an existing node 
before it can be snapped to that node). A high-pitched 
audible Beep can also be enabled for when the cursor is 

within the set pixel tolerance: when the cursor moves outside the tolerance, a 
low-pitched Beep will sound. The Duration of these beeps can be set in 
milliseconds.
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Editing node XYZ coordinates manually - The node coordinates can be edited 
within the Information Sheet>Data tab. Select the object to edit, and in the 
spreadsheet, right click on it and select Start Edit from the pop-up menu. Select 
the node to edit either from the spreadsheet list or graphically, and alter the X, Y 
or Z coordinates as desired. Note that as feature polygons and polylines must be 
planar, there is a tolerance limit on how far nodes can be moved via this method: 
Encom Discover PA will perform a check to ensure that the new node position 
retains the objects planar state. If it does not, the newly entered value will be 
ignored

Other Feature Tools

Object creation tools are described in Creating Objects. The remaining buttons of 
the Feature toolbar have the following functionality:

Point Feature Objects over a grid surface and flight line map

The Ruler tool on the Main Toolbar can be a useful guide for distances, 
bearings and dip angles between objects on the cursor plane.

The Print Feature(s) button allows batch printing of selected feature objects in a 
display. This item is useful for producing report output for group selected 
anomalies or features.

Using the Centre View button moves the displayed coverage to centre on any 
selected feature. This is a useful option when examining features such as 
sampling locations or geochemical locations on a map with many features 
(anomalies) displayed.

Within a database Set, you can move sequentially forward or backward through 
the record entries, selecting individual features each time the Next Feature or 
Previous Feature button is clicked.
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Advanced Editing Functions

A range of powerful multiple feature processing tools are available on the 
Features Editing toolbar, allowing intersecting feature objects to be manipulated.

By combining these advanced feature manipulations with Encom Discover PA's 
fast automated triangulation (using the 3D Solid Generator) and extrusion (using 
the 3D Extrusion Tool) capabilities you can easily experiment with creating 
multiple, complex geological interpretations to test your theories or evaluate your 
information in as much, or  as little, detail as you need.

This following advanced editing and processing tools are available:

• Triangulate — internally triangulates selected polygons to form TIN 
surfaces.

• Combine — combines or fuse multiple selected features into a single 
feature; the original features' geometries are lost.

• Intersect — outputs the intersection of any selected features (except 
points).

• Cut — cuts the first selected feature along the intersections with any other 
selected features.

• Aggregate — combines multiple selected features into one feature, but 
preserves each source feature's spatial geometry.

• Disaggregate — ungroup or explode aggregated features into individual 
features. Also detects any disconnected parts of an feature (created using 
the Break tool) and creates individual feature objects for each part.

• Break Mode — breaks a polyline into multiple parts at the selected node, 
as well as select multiple edges along a surface to preform a cut 
operation. 

• Consolidate — recombines features that have been broken into multiple 
parts with the Break tool.
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Triangulate

Triangulate is primarily used to convert selected polygons into triangulated 
surfaces. This allows converted polygons to:

• Insert internal nodes.

• Move internal and external nodes perpendicular to the polygon plane.

And so, the converted polygon can be completely reshaped into an undulating/
non-planar feature surface (e.g. using the elasticity tool to mould regions of 
internal nodes).

One prime example of the use of this function is the 3D modification of imported 
drillhole section boundary polygons from a 2D drillhole project. These polygon 
features cannot be modified outside of the polygon plane, but the geoscientist 
may wish to snap these to the actual drillhole locations in 3D.

Converting these polygons using the triangulate tool allows the user to start 
accurately snapping not only the edge nodes to drillhole intervals, but also to add 
internal nodes and snap these to drillholes. Both node snapping operations can 
be performed elastically allowing a specified region around each node to be very 
easily and realistically shaped to conform to the new node position.

 

a)
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A feature polygon (a) triangulated into a feature surface (b); Individual nodes or even 
regions of the feature surface can then be moved outside the original polygons plane (c), 
using the vertex/node editing tools and/or the elasticity controls.

Combine

Combine will combine any selected features (points, polylines, polygons, 
surfaces and volumes) into a single feature. This is a useful for managing more 
complex feature databases e.g. combining features with the same attributes into 
a single feature, allowing easy graphical selection of a particular attribute type.

This function fuses the selected features so that overlapping boundaries and 
regions are lost; and the original features' spatial geometries are lost.

To combine features:

1. Make the feature database containing the features editable.

2. Using the Select tool, select the first feature.

b)

c)
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3. While pressing the keyboard CTRL key, select the additional features.

4. Press the Combine button.

5. In the Operation Options dialog, select the output feature database to 
create the single combined feature in. Ensure that the Delete original 
features option is disabled if you want to preserve the input features. 
Press OK.

Intersect

Intersect creates new features representing the shared (or common) areas of the 
selected features. This can be the intersection of any selected feature 
polyhedrons (surfaces and volumes) or polygons. Some examples of use: 

• The portion of a fault plane that intersects an orebody.

• The lineation intersection of a quartz vein with a fault surface.

• The surface trace of a fault plane (interpreted from drilling) with a 
topographic surface (a DEM grid imported into a feature database, see 
Importing Data Into a Feature Database).

To display the intersection of one TIN feature surface with another:

1. Make the feature database containing the intersecting features editable

2. Using the Select tool, select the first feature.

3. While pressing the keyboard CTRL key, select the additional features.

4. Press the Intersect button.

5. 5. In the Operation Options dialog, select the output feature database to 
create the intersection feature in. Ensure that the Delete original features 
option is disabled if you want to preserve the input features. Press OK.

It is recommended that any bodies being intersected are enclosed bodies (i.e. if 
created with the 3D Solid Generator (see Modelling Triangulated Surfaces and 
Solids), ensure an end capping is applied such as ‘flat’). This will result in the 
output intersection being displayed as a triangulated surface, rather than a closed 
polyline.
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An example of an Intersection operation. The resulting intersection surface (b) represents 
the tabular bodies where they intersected the topographic surface shown in (a). 

Cut

Cuts the first selected feature along intersections with any other selected 
features. All feature types except points are supported. Cut can be used for any 
of the following operations.

Selected features in the same plane:

• Cut (or remove) part of a polygon feature where it overlaps with other 
polygon feature(s) 

• Cut a polygon feature along the intersection with other polyline feature(s) 

Selected features in different planes:

a)

b)
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• Cut a polygon feature along intersections with other polygon feature(s) 

• Cut a TIN surface along intersections with other TIN surface(s)

Some examples of the powerful modelling uses of this function:

• Viewing the portion of an orebody volume solid (created with the 
Modelling Triangulated Surfaces and Solids) above a proposed open cut 
surface (a DEM grid of the open cut imported into a feature database, see 
Importing Data into a Feature Database).

• Viewing the portion of an orebody volume solid between two fault planes, 
then calculating the volume of this region.

• Cutting a older fault plane with a more recent fault plane (e.g. extruded 
from surface traces using the Extruding Models from Points, Lines and 
Polygons).

Result of cutting the blue solid with the pink solid.
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To cut one feature with another:

1. Make the feature database containing the features editable (the features 
must all be in the same feature database).

2. Using the Select tool, select the target feature to be cut. 

3. While pressing the keyboard CTRL key, select the second feature (i.e. the 
cutting surface). 

4. Press the Cut button.

5. In the Operation Options dialog, choose the Feature Set that the 
resultant feature object is to be saved into and ensure that the Delete 
original features option is disabled if you want to preserve the input 
features.

6. Press OK.

The output feature database will likely have two or more features (the target 
feature cut into sub-portions). Select and Delete the unwanted features.

It is recommended that any bodies being cut are enclosed bodies (i.e. if created 
with the 3D Solid Generator, ensure an end capping is applied such as ‘flat’). This 
will result in the output body being displayed as a closed volume, rather than a 
open/hollow surface; a volume can then be calculated for a closed volume using 
the Topology  Checker.

Aggregate

Aggregate groups multiple selected features into a single feature, whilst 
preserving the spatial geometry of all the original features.

To aggregate multiple features:

1. Make the feature database containing the features editable.

2. Using the Select tool, select the first object.

3. While pressing the keyboard CTRL key, select the additional features.

4. Press the Aggregate button.
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5. In the Operation Options dialog, select the output feature database to 
create the single resulting feature in. Ensure that the Delete original 
features option is disabled if you want to preserve the input objects. Press 
OK.

Disaggregate

Disaggregate ungroup or explode aggregated features into individual features. 
Also detects any disconnected parts of an feature (created using the Break tool) 
and creates individual feature objects for each part.

To disaggregate a feature:

1. Make the feature database containing the target features editable.

2. Using the Select tool, select the target feature.

3. While pressing the keyboard CTRL key, select any additional features if 
desired.

4. Press the Disaggregate button.

5. In the Operation Options dialog, select the output feature database to 
create the resulting multiple features in. Ensure that the Delete original 
features option is disabled if you want to preserve the input objects. Press 
K.

Break Mode

There are two modes of operation:

• Break a polyline into multiple parts at the selected node

• Manually cut a triangulated feature surface along multiple contiguous 
selected edges/segments.

To break a feature polyline:

1. Make the feature database containing the feature polyline editable.

2. Using the Select tool, select the target feature and make it Reshapable.

3. Hover the cursor over the node at which you wish to break the polyline: if 
no node exists, first insert a node. The cursor will change to a knife symbol 
when over a node. Click the mouse. This can be repeated for multiple 
nodes if desired
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4. Select the Disaggregate button.

5. In the Operation Options dialog, select the output feature set to create 
the resulting multiple feature polylines in. Ensure that the Delete original 
features option is disabled if you want to preserve the input objects. Press 
OK.

To break a triangulated feature surface:

1. Make the feature database containing the feature surface editable.

2. Using the Select tool, select the target feature and make it Reshapable.

3. Enable the Break mode on the Feature Editing toolbar.

4. Hover the cursor over the first interior edge delineating the desired cut 
line; the cursor will change to a knife symbol. Click. The edge will be 
bolded to indicate its selection.

5. Repeat step for each additional interior edge until a continuous line from 
one side of the surface to another has been traced, or an internal region 
outlined (see example below). 

6. Select the Disaggregate button.

7. In the Operation Options dialog, select the output feature database to 
create the resulting multiple feature polylines in. Ensure that the Delete 
original features option is disabled if you want to preserve the input 
objects. Press OK.

Optional step:

• If necessary, delete any unrequired/surplus feature polygons/surfaces
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Example of a triangulated surface having an internal region clipped using the Break 
function
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Consolidate

Consolidate is primarily used to recombine features that have been broken into 
multiple parts with the Break tool.

To recombine a multi-part feature:

1. Make the feature database containing the feature editable.

2. Using the Select tool, select the multi-part feature (as created in Break 
Mode).

3. Select the Consolidate option from the Features>Edit menu

It is recommended that any bodies being intersected are enclosed bodies (i.e. if 
created with the 3D Solid Generator, ensure an end capping is applied such as 
‘flat’). This will result in the output intersection being displayed as a triangulated 
surface, rather than a closed polyline.

Feature Object Attributes

Feature object attributes can be examined via either the Feature or Data tabs 
within the Explorer and Data Windows; attributes can also be edited in the 
Feature tab. Open the Information Sheet window using the button at the right end 
of the Main Toolbar or via the Insert menu option.

• Data Tab

• Feature Spreadsheet

• Attribute Editing

• Node Editing

Data Tab

The Data tab displays the attributes of only the selected feature object (the 
Feature Database must therefore be Selectable in the Workspace Tree; if the 
database is Editable, multiple features can be selected and displayed). It does not 
require you to choose the database within the tab to display; therefore multiple 
databases can be made selectable and can be easily and rapidly interrogated. 
However it does not allow attribute editing.
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Feature Spreadsheet

The Feature Spreadsheet displays all the retained information about the feature 
objects contained in the specified Feature Set and is used to review and edit the 
contents of the opened Feature Database Sets. 

When Encom Discover PA is first started, the Feature Database floating window 
appears towards the bottom of the screen. If this window is closed it can be 
opened again by right mouse clicking on the toolbar area of Encom Discover PA 
and selecting Feature Data from the pop-up menu that appears. While the 
Feature Spreadsheet display is floating it can be positioned anywhere including 
outside of the Encom Discover PA application. 

To dock the feature spreadsheet display hold the left mouse down on the titlebar 
area of the display and drag it to one of the guides that appear on the screen.

The Feature Spreadsheet display allows selection and editing of feature attributes

Alternatively the Feature Information button (on the Features Toolbar) can be 
used to select objects regardless of whether their database is selectable or not. 

The Feature Spreadsheet displays a table view of the attributes of every object 
in a Feature Database. By default these features are ordered by their ID number. 
This allows multiple object attributes to be examined and edited after creation; 
alternatively, individual objects can be attributed during creation by enabling the 
Confirm Pick button on the Features Toolbar.
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The Show selected features only button on the Feature Data Spreadsheet 
display will condense the list of feature objects in the currently "editable" feature 
set down to show only the feature objects that are highlighted, i.e. selected.

To change the order of the field columns in the feature spreadsheet click the 
Customise button on the Feature data Spreadsheet display. The Customise 
Fields dialog will appear allowing the fields columns to be rearranged or to be 
hidden from the spreadsheet.

Attribute Editing

The Customise Fields dialog from the Feature Data Spreadsheet display allows fields in a 
Feature Set to be rearranged or hidden.

Individual attributes of an Editable Feature Database can be edited directly within 
Feature Spreadsheet cells (including the X, Y and Z values). Right clicking within 
the attribute spreadsheet displays a pop-up menu, providing options for automatic 
heading and/or data spacing operations: note that these spacings can also be set 
manually by selecting and moving the header column and row widths. Right-
clicking on a column header provides additional ascending or descending sort 
operations for the selected column. 

Selected rows can be deleted by either pressing the DELETE key, or by right-
clicking on the row header and choosing the Delete Selection option. This pop-
up menu also contains options to Cut, Copy and Paste the current selection, 
allowing object duplication (duplicated objects could then be offset using the 
controls discussed in Editing Objects).
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Node Editing

The X,Y & Z values in the attribute spreadsheet only represent the centroid 
locations for polyline and polygon objects: to edit individual node co-ordinates, 
right click within a selected row, and select the Start Edit option from the pop-up 
menu. An editable list of the coordinates for every node comprising the Feature 
Object will be displayed: selecting a row entry will snap the crosshairs in the 3D 
display to corresponding node. Conversely, selecting a node within the 3D display 
will highlight the corresponding row entry. Right-clicking within this mode will 
display a pop-up menu with three mode-specific options (see image below):

• Insert Node: inserts a new node below the currently selected node, 
populated with the currently selected node’s coordinates.

• Delete Point: deletes the selected node.

• Stop Edit: finishes node editing and returns the view to the attribute 
spreadsheet.

Features in the spreadsheet can be selected by clicking on the spreadsheet row 
header (at the left of the sheet). Multiple features can be chosen using the SHIFT 
and CTRL keys. Note that selected features are highlighted (whether selected 
graphically from a map or profile or from the spreadsheet). Highlighting of 
selected features both in displays and in the spreadsheet is done immediately the 
selection has occurred. 

Right-clicking on the row header of a selected feature displays a pop-up menu. 
Options in the menu allow automatic heading and/or data spacing operations, 
plus ascending or descending sort operations for the selected column. Note these 
spacings can also be made manually by selecting and moving the header column 
widths. Other options available from the pop-up menu include deleting the 
selected feature row or all selected features.
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Select Start Edit from the pop-up menu for a highlighted polygon feature object to edit node 
locations

The node coordinates will then be displayed in the spreadsheet. 

Certain fields of the open spreadsheet can be edited (such as the Ranking or 
Memo fields). User-defined fields can also be edited. To perform an edit, the 
feature set must be made editable in a display window and then you can position 
the cursor in the cell required in the spreadsheet display. When the cell is double 
clicked on with the left mouse button the cursor alters shape to a “|” and permits 
keyboard text entry.

You can select a row, column or group of cells by positioning the cursor over a 
cell, depressing the left button and dragging the mouse (as you would in other 
applications, such as Microsoft Excel). Once a block of cells has been selected, 
you can copy (CTRL+C keyboard sequence) and paste the cell contents into other 
spreadsheet or text-based programs (eg Notepad). It is not possible to cut a block 
of cells from the database.
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Feature Options

Feature Options dialog

The Features>Features Options menu item enables the following default 
options to be set:

• Picking Features

• Line Association

• Defaults

Picking Features

Turn on/off the feature pick confirmation dialog which is displayed at the end of 
the creation of each feature object. This dialog enables the entry of data into the 
default Description field and any other user-defined fields in the Feature 
Database. This is identical to the Confirm Pick button in the Features Toolbar.
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Line Association

The line association option allows feature objects to be more intuitively integrated 
with other line data by selecting the following options when using the Line 
Association Wizard. Refer to Line Association Wizard for more information on 
this utility.

The following options are available to set for line association:

• Automatically select associated line when panning to the selected line in a 
section view to a particular feature plus populating the feature database 
with the associated line entry when a feature is selected. 

• Automatically generate associated line when that line is not defined in the 
database. 

• Always check associated lines and correct invalid associations when 
panning to the selected feature. 

• The distance (in metres) envelope for applying valid associations.

Defaults

Set the default colour for: 

• Feature Fill Colour - Set default colour for the Fill of a feature polygon.

• Feature Selected Colour – Set default colour for highlighting a selected 
feature object. This colour must be set before creating feature objects.

• Query Fill Colour - Set default colour for Queried feature objects.

Line Association Wizard

Features can be created graphically by picking in a profile or CDI display etc. In 
these cases, the feature location is directly associated with the line on which it 
was picked from the related line database. If features are imported (for example 
from a geochemistry dataset), or are picked graphically from a map, then no 
automatic line association occurs. 

It is often important to combine feature location with profile information (even 
though the feature may not lie directly under a traverse line). For example, you 
cannot easily display features, maps and profiles in a related manner where the 
method of feature detection is not related to a line.  
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As a consequence, Encom Discover PA has a method that uses a wizard to allow 
features to be related to traverse lines. It operates by choosing features within a 
buffer zone surrounding the path of the line. Access to the wizard is from the 
Features>Feature-Line Association Wizard menu item.

The first two wizard screens for the Line Association Wizard of feature databases

Screens presented with the Line Association Wizard are:

Step 1

Introductory screen only, see above.

Step 2

Specify the Feature Database, Feature Set. You can process all the loaded 
feature datasets if required or you can specifically select the Feature Set to be line 
associated.
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Steps 3 and 4 of the Line Associate Wizard

Step 3

Select which line databases to associate the Feature Set as defined in Step 2. 

Step 4

Options to control the line association include:

• For features with no line association, a data value flag of –1 is usually 
used. If a valid line association is created for features, the –1 value is 
substituted by the associated line number.  The first option enables the 
substitution of the flag value with the new line value.

• If a feature database has already existing line relationships, but the line 
numbers do not relate to the specified line database, these line values can 
be overwritten via the second option.

• A buffer zone is required around a line to locate and build a line 
association with a feature. If more than one line is associated with a 
feature within the defined buffer distance, the closest is used.
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After clicking the Finish button processing of the feature object is performed, and 
a summary dialog will be shown to indicate the number of features processed and 
associated with the lines of the line database. If you wish to check the results 
more exactly, you can display the Feature Spreadsheet and examine the 
LineNumber values related to specific features.

Summary information describing the number of features with successful and unsuccessful 
line associations

Batch Printing Features

Often large numbers of features can be created within databases. To individually 
present these using a manually specified display format for a report would be very 
time consuming. Encom Discover PA provides an alternative batch printing facility 
to accommodate this requirement.

You may wish to create a display that contains a map, profile and description of 
features and use this as a template for successive features. Such templates can 
be used to produce printed reports of selected features. An example of such a 
report containing displays of the feature location associated with map displays of 
magnetics, geochemistry and profiles is shown below. A title block defines the 
feature name, location and specific characteristics.
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Example feature template with magnetics and radiometrics maps, profiles plus title block 
and text information

Specifying Variable Text for Printing

For text to be automatically updated by the value contained in the Feature 
Database, you must define a Variable Text substitution string. Initially, create your 
title block or legend (as described in Title Box). For individual text items (such as 
Feature ID or location), insert the variable by choosing the arrow on the right side 
of the text box properties. A list of available feature database items is shown.

This template (or any other you prefer) can be used for batch printing of multiple 
feature hard copies. For example, using the template above, if you have 
selected only those features of a particular Feature Set, select the Feature 
Centre button to position the feature in the middle of the map and to produce 
hard copy output of all the selected features, then choose the Feature Batch 
Printing button on the feature toolbar. Note that for each print produced, the text 
in the title block with Feature ID, location and geochemistry results would be 
updated automatically.
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Text Properties dialog with pull-down list of available database items for variable 
substitution

When inserted into text, the variables have the syntax of %string%, such as 
%Feature.X%. 
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Features Database Structure and Links

Encom Discover PA uses Microsoft Access to store all feature databases. This 
has a number of advantages since full ODBC (Object Data Base Compression) 
and DBMS (DataBase Management Systems) can be used to provide direct 
access and updateable links to external software packages such as MapInfo, 
Access, Excel and ArcInfo. 

The database format provides live access. A live access table is a table that can 
be accessed from a remote application. It is called live because there is no local 
copy of the data in the third party software. All operations against the data go 
directly to the server. This differs from linked tables that download a snapshot 
from the remote database into a native third party table. A linked table is a table 
that is downloaded from a remote database and retains links to its remote 
database table. The remote database table is known as a DBMS table.

Using a linked database it is possible to create and maintain a feature database 
and have the features added and data transferred to other software systems such 
as MapInfo Professional (see Linking a Feature Database to MapInfo 
Professional). 

Linking a Feature Database to MapInfo Professional

Features derived from a geophysical data interpretation in Encom Discover PA 
can be displayed and updated in real-time with other software packages such as 
MapInfo Professional. To create a directly linked database accessible from 
MapInfo Pro, follow the following steps:

Step 1

Ensure both Encom Discover PA and MapInfo Professional are available on the 
one machine and operating. Also ensure that within Encom Discover PA a feature 
database has been created and contains at least one Feature Sets.

Note When MapInfo Professional was initially installed, ODBC and DBMS support 
was also installed. Also note that ODBC and DBMS support libraries were 
provided only with MapInfo Professional releases later than Version 5.0. The 
example uses MapInfo Professional Version 9.0.
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Step 2

Before you can access a DBMS table, you must initially create a link to the 
specific Encom Discover PA data source where the data to be linked resides. To 
manage this, MapInfo Professional requires a Map Catalog file be present. This 
file is necessary to maintain the data link but also to allow the incoming data table 
to be mappable in MapInfo Professional.

A MapBasic program (called MIODBCAT.MBX) is executed to create the Map 
catalog. Within MapInfo Professional, access the File>Run MapBasic 
Application option and path to the MAPINFO\TOOLS folder to specify the 
MIODBCAT.MBX program.

Step 3

From the MapInfo Professional Tools menu option, select the DBMS Catalog 
>DBMS Catalog option. A four button toolbar is displayed. Select the Create 
Catalog button.

The DBMS Catalog dialog.

Step 4

From the Field Data Source tab select the New button of the Data Source Name 
(DSN) entry field. This option defines the control to be used in building the link to 
the Encom Discover PA feature database. In this case the DSN name to select is 
Microsoft Access (see figure below).

Warning A problem to be aware of within the MapInfo Professional link to Encom Discover 
PA is a limitation on the path length supported in creating .TAB table files. An 
upper limit of 60 characters is provided by MapInfo Professional. If this number 
of path characters is exceeded while the linked file is creating the .TAB file, 
MapInfo Professional will fail. Encom Discover PA remains unaffected.
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Specify the DSN name (Microsoft Access) for the database link

Step 5

Select the Next button from the MapInfo Professional wizard and Browse for the 
location of the Encom Discover PA feature database. Create a new .DSN file to 
associate with the feature database that will be associated with it.

Specification of the data source linked database

From the final MapInfo Professional wizard dialog entitled Create New Data 
Source, select the Finish button. 
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The Create New Data Source dialog.

Step 6

Within the ODBC Microsoft Access Setup dialog, click the Select button. 
Navigate and explicitly select the Encom Discover PA database in the displayed 
dialog. In this case, because the default data source type is Microsoft Access, a 
file extension of MDB is used as the default. The database from Encom Discover 
PA has the extension FDB.

Selection of the specific database table assuming the Access link is established
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Step 7

Once the database has been specified, click OK (from Select Database), click OK 
(from ODBC Access Setup), and OK from Select Data Source dialog. MapInfo 
Professional should then report that the MAPINFO_CATALOG has been created. 
This phase of the link has instructed MapInfo Professional that the Microsoft 
Access protocol is to be used for the link, the link has been established and the 
specific database has been defined.

Select Cancel from the DBMS DBA Functions toolbar.

Step 8

The next phase is to make the Encom Discover PA table mappable within 
MapInfo Professional. Select the Table>Maintenance>Make DBMS Table 
Mappable menu option. (from the displayed dialog can be opened).  All the 
individual feature tables contained within the accessed feature database. 

Note that only one feature table can be open at a time. Multiple MapInfo 
Professional TAB files can however be accessed and for each database table, a 
separate TAB file will be created. Consequently, although this step must be 
repeated for each individual Feature Set, each set can be displayed in MapInfo 
Professional concurrently.

Selection of the feature within the opened Encom Discover PA database

After selecting the appropriate table, select OK.
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Step 9

To complete the phase of making the DBMS table mappable, you must specify 
the Symbol to be used in MapInfo Professional for the selected table, plus the 
Projection. It is wise to use the same symbol for a Feature Set in Encom 
Discover PA as for MapInfo Professional to avoid confusion.

Select the symbol type and Projection for the features

While selecting the options with this dialog, ensure the Index Type is XY 
Coordinates (and not MapInfo Professional), and that the X Coordinates are X 
(Easting) and Y Coordinates are Y (Northing). When the OK button is clicked, 
MapInfo Professional completes the Table Now Mappable operation.

Step 10

The only step remaining to display the data in MapInfo Professional linked to 
Encom Discover PA is to open the mappable table. With the link in place, select 
File>Open DBMS Table. You can again select the required Feature Set table 
and any data fields that are required to be transferred during the table access. 

You can specifically nominate required data channels or alternatively, by default, 
MapInfo Professional transfers all data fields with the asterisk (*) character.

Step 11

The final step is to verify the feature database to be accessed and the 
presentation display required. You can select a Browser window, a Map or No 
view. Ensure too that a suitable name is assigned to the TAB file that is to be 
created.
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Once the new TAB file is written, it can be opened and re-opened without having 
to set up the data links between MapInfo Professional and Encom Discover PA.

Displaying a linked table in a MapInfo Professional map uses the selected 
symbols for the available features. If other tables (such as geology, topography 
or cadastral maps) are also displayed, the features with this backdrop information 
can be viewed as well.

Note that when new features, or changes to the existing features are made in 
Encom Discover PA, you need to select the DBMS Refresh button to update the 
database link and redisplay the new features in the MapInfo Professional map. 

Feature display within a MapInfo Professional map but updated and derived from Encom 
Discover PA.
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18 Scattergrams
In this section:

• About Scattergrams

• Scattergram Properties

• Using Scattergrams

• Three-Dimensional Scattergrams

About Scattergrams

The Scattergram display is used to compare and determine if any relationships 
exist between data fields in a database. Scattergrams can represent two data 
fields (in a 2D Scattergram) or relationships between three data fields if using 3D 
Scattergrams.

Any data fields can be selected for display with one being chosen for the 
horizontal (X) axis and the second the vertical (Y) axis in a 2D scattergram. A third 
data field for the vertical (Z) axis is required for a 3D scattergram. Each data point 
is represented in the Scattergram as a symbol. In addition to the two selected data 
fields, the symbol representation for each data point can be modulated by colour, 
size or rotation derived from other data fields. No distance criteria is used in the 
drawing of the graph. 

The Scattergram is initially created by selecting the button or the 
File>New>Scattergram menu item. A Scattergram can be inserted into other 
layout or frames using the Insert>Scattergram item. An example of a 
scattergram plot is shown below: 
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Scattergram of two data fields derived from radiometric and magnetic channels and 
modulated by colour, angle and size

Scattergram Properties

As for all displays in Encom Discover PA the Workspace tree shows the 
relationship of the various branches of the Scattergram display. The properties of 
the Scattergram Frame, Scattergram and Axis branches are identical to those of 
the Profile and Map Documents Displays. See Display Properties for descriptions 
of the various property tab dialogs. 
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In particular, the Symbols tab controls the appearance of the Scattergam points 
and a high degree of control for these is available, especially for a 3D Scattergram 
(refer to Symbols Tab).

An example of the Workspace tree is shown below. The data sources (X) and (Y) 
are the layers that provide definition of the dataset fields. Colour modulation is 
enabled by default when a Scattergram is initially created and its data field can be 
nominated as for X and Y layers.

Display the property dialog to nominate a data field for each of the layers required.

 
Field selection dialog using the pull-down field list to nominate the data source

Symbol Modulation

By default, each data band displayed uses a new colour and symbol designated 
by the system. If you wish to enable colour modulation, switch off Cycle Colour 
on the Symbols property page and switch Mod Colour on. Symbol size, rotation 
and label modulation can also be enabled in the same fashion as for a multi-
curve.
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Using Scattergrams

Scattergrams can be incorporated in other plot documents by inserting or copying 
and pasting. 

 
A Scattergram incorporated into a Layout with profiles and title block

They provide a fast and powerful method of determining and illustrating the 
relationship of one or more data fields to one another.

Three-Dimensional Scattergrams

Scattergrams are not restricted to being only 2 dimensional in Encom Discover 
PA. They can be created in 3D displays and as such are powerful tools for display 
of such things as:

• Geochemical assay results

• Quality control for comparison of flight data
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• Analysis of radiometric data channels.

To create a 3D scattergram you can: use the menu option File>New>Graph>3D 
Scattergram or the pull down menu item as shown.

Once a 3D Scattergram window is displayed, highlight the X, Y and Z data fields 
in the Workspace tree and assign these to the required data channels.

The size, colour and symbol types can be selected and modulated as required 
using the various standard tree layer controls (Colour, Size etc). An example of a 
3D Scattergram is shown below:

 
Example of a 3D scattergram with radiometrics geochemical data (K, U, and Th) and colour 
modulated by magnetics.
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19 Graphs
In this section:

• About Graphs

• Creating a Graph Document

• Graph Properties

• Vertical Graphs

• Creating 3D Graphs

About Graphs

The Graph option creates a Graph display containing a single Graph Frame. This 
is the most basic type of graph, graph frame and graph document in Encom 
Discover PA. A Graph can have any two data fields chosen for scaling the 
horizontal and vertical axes in a 2 dimensional graph. For a 3D Graph, a third, 
vertically oriented data field is also required.

As for all other documents, the graph document structure is hierarchical. It 
contains objects like graph frames that can contain child frames and objects. The 
document structure is revealed in the Workspace Tree. A Graph Frame can have 
multiple rows and columns. Each cell can contain a single graph or other object. 
Each graph is shown in the tree as a child of the graph frame and they can be 
moved around the cells of the frame using options from the pop-up menus.

At the top of the Workspace tree for a graph object you can control the 
appearance of the plot area, plot title etc. A graph can contain one or more X 
axes. An X axis can be shown graphically by adding one or more X axis. A few 
important points concerning graphs are:
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• An X axis can own one or more Y axes. A Y axis can be shown 
graphically by adding one or more Y axes. A Y axis can also own XY 
Internal Annotations (refer to XY Internal Axis).

• A Y axis can own one or more Colour Axes. A Colour axis can be shown 
graphically by adding one or more Colour axes.

• A Colour Axis can own one or more Size Axes. A Size axis can be shown 
graphically by adding one or more Size Axes.

• A Size axis can own one or more Data Series. A data series may be, for 
example, an image or flight path in a map, a multi-curve or multi-layer or a 
feature curve.

So, in principle, to add a new Curve to a graph, you need to find the Size axis and 
add the curve to this object. or, to add a new Y axis to a graph you have to find 
an X axis and add the Y axis to this object. In practice, to simplify the appearance 
of the Workspace tree the axes are not displayed unless they are non-unique. 
Consequently, options applicable to axes are wound back up the tree as far as 
possible to a parent object. In a simple graph this might often be the graph object 
itself. To familiarise yourself with the structure of a graph, you can show all object 
levels by setting the Workspace Tree content to Verbose (refer to The 
Workspace Tree). 

Creating a Graph Document

A Graph is initially created by selecting the button on the toolbar or the 
File>New>Graph>2D Graph menu item. A Graph can also be inserted into 
another layout or frame using the Insert>Graph menu item. Either 2 or 3 D 
graphs can be created. Two examples of Graph plots are shown below:
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Comparative plots of Radar Altimeter and GPS within a graph

Graph of data derived from two fields with extremely different data ranges

Note in the example here that the data ranges of the two nominated fields have 
different data ranges. With the Graph properties you can display the axes such 
that different vertical scales and data ranges are accommodated.

Graph Properties

As for all displays in Encom Discover PA the Workspace tree shows the 
relationship of the various branchs of the document. The properties of the Graph 
Document, Frame, Graph and Axis branches are identical to those of the Profile 
and Map Documents. Refer to Display Properties for descriptions of the various 
Property tab dialogs. 
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Generally, a graph is used to display Curves. Unlike the Profile, a graph places 
no restriction on the number of X axes created or the data field used as X in a 
Curve. Consequently, you need to select data for the X and Y channels, and can 
optionally also specify colour, size, rotation and label modulation channels. As 
usual, Y values of the curve can also be offset by an Offset (usually topography) 
branch.

Field selection dialog using the pull-down field list to nominate the data source

An example of the Graph Workspace tree is shown here. The data sources (X) 
and (Y) are the branches that provide definition of the dataset fields. Colour 
modulation is enabled by default when a Graph is initially created and its data field 
can be nominated as for X and Y layers.

Note that a transformation can be applied to the data channels if required. Refer 
to Data Transformation for additional information.
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Vertical Graphs

Vertical Graphs are useful in many instances (such as for wireline downhole 
logs). This form of graph can rotate the standard, horizontally oriented graph 
document such that axes and cursor movement are oriented vertically. The 
Vertical Graph document operates exactly like its horizontal equivalent where 
individual data field control of both the vertical (Y) and horizontal (X) axes is 
available.

When created, these documents have the standrad zoom, pan and cursor 
movement vertically oriented to allow data analysis up and down. An example of 
this format is shown below with drillhole EM data and a density log:

An example of a Vertical Graph display showing Ag assay concentrations at drillhole depth 
and colour filled above data average.

Creating a Vertical Graph

One method to display a vertically oriented graph is:
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1. Open the required database or import the necessary data

2. From the document toolbar pull down the Graphs and Scattergrams item. 
Select the 2D Graph (Vertical Log) menu item. 

3. Assign data channels to the X (horizontal) and Y (vertical) axes. Note that 
typically (as for example in a drillhole, the vertical axis (Y) would be 
assigned to a distance field such as depth. Apply the channels.

4. You may need to reverse the vertical axis (and consequently, the data) to 
ensure the top of the graph truly represents the correct, higher portion of 
data. This is done from the Y axis control tab of the Axis branch of the 
Workspace tree.

Y Axis control tab of the axis controls and note Reverse is enabled for Depth 
positive downwards.

From the Y Axis control tab of the axis controls ensure the Reverse option 
is enabled.
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Alternative methods of creating a Vertical Graph are also available by using the 
Add option of a pop-up menu (from a Graph Frame) and select the 2D Graph 
(Vertical Log) or from the Insert>Graph menu item.

Creating 3D Graphs

Three-dimensional graphs can be displayed in Encom Discover PA where any 
three data fields are plotted against one another. For example, you may wish to 
plot the relationship between easting and northing and elevation. This form of plot 
could be used for quality control when draped across a terrain surface. An 
example is shown below:

 
Display of 3D graph representing flight lines modulated by magnetic response

Other uses of the 3D graph application include analysis of EM decays and 
radiometric response modulating flight paths.

Note that once in a 3D display, other surfaces, models, bitmaps, drillholes etc can 
be added. The control of a 3D Graph is identical to that of a 3D Map display. For 
further information refer to Three Dimensional Displays. The conventional 3D 
cursor navigation is available as is the Internal Axes for positioning while roaming 
and zooming the view. 

To create a 3D graph you can:

• Use the menu option File>New>Graph>3D Graph or

• Use the pull-down menu item as shown. 
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Use the Documents toolbar to select the 3D Graph display option.
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20 Drillholes
In this section:

• Displaying Drillholes in Encom Discover PA

• Drillhole Data Formats

• Importing Drillhole Data

• Desurvey Methods

• Drillholes in Profile Sections

• Adding Drillholes to a 2D Map

• Adding Drillholes to a 3D Map

• Drillhole Properties

• Plotting Data Beside Drillholes

• Display Downhole Logs

Displaying Drillholes in Encom Discover PA

Encom Discover PA allows drillholes and their associated downhole datasets to 
be quickly and easily displayed, allowing you to view your drilling in ‘real-space’.

Combining this with gridded surfaces, raster images, voxel models and point/line 
data allows the user to view their exploration projects in a complete and coherent 
3D environment. This allows the user to start assessing and interpreting their 
drillhole project’s downhole information in an integrated world only previously 
accessible in high-end mining packages.
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Example 3D drillholes display showing drillholes as tubes, colour and thickness modulated 
by Cu assay concentrations and droped vertical log plots.

Once drillhole data is displayed in Encom Discover PA, there is an extensive 
range of display controls available for both the drillholes and the data that may be 
associated with them. For example:

• Trace Style - trace paths can be displayed to show the accurate location of 
the drillholes.

• Labeling - drillholes can be labeled with information such as hole names, 
EOH depths, downhole depths, etc.

• Colour Modulation - drillhole traces can be colour modulated (including 
patterns) using downhole attribute (e.g. geology) or numeric (e.g. mag 
sus) information.

• Thickness Modulation - drillhole traces can be thickness modulated using 
one or more downhole numeric fields, such as assay or geophysical 
measurements.

• Display Drillhole Logs Images - 2D cross-sections and vertical logs can be 
quickly displayed as georeferenced images in 3D.

• Drillholes with trace thickness control and assay modulation
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Drillhole Data Formats

Typically drillholes and associated data require the following information:

• Collar positions in X, Y and vertically (Z) referenced elevation. Names of 
the drillholes are also associated with drillhole collars. Usually the total 
distance along the hole axis from the collar to the base of the hole is 
included in this file but it may also include dip and azimuth.

• Downhole Survey data must be associated with each Hole_ID to define 
the location of points down the hole. This data defines the shape of the 
hole and is usually derived from a survey undertaken in the field using a 
downhole camera and survey software. The data requires a distance 
down the hole axis, a dip and a compass azimuth reading at the measured 
survey point.

A minimum number of two points can be used to survey a hole. For a 
straight hole, only a single entry is required as the azimuth and dip at the 
collar is assumed to the base of the hole. Note that the survey describes 
the shape of the drillhole, not the points at which assays or data readings 
or samples are made.

• Downhole Data such as assay samples, readings or analyses can be 
done at measured depths of the hole. These readings may be geophysical 
(eg magnetic susceptibility, density, gamma etc) or they may be geological 
(eg lithological, assay or geochemical). Readings can be taken at a 
specific distance point down the axis of the hole, or over an interval that is 
using from-to terminology (for example, lithology between 50.0 and 50.5 
metres distance the hole intersected mudstone).

Importing Drillhole Data

The drillhole data import capabilities of Encom Discover PA include:

With Encom Discover PA running, you can access drillhole data from the 
File>Open>Downhole menu option. Drillhole data can be imported from these 
sources:

• ASCII Drillhole Data including collar, survey, downhole and desurveyed 
data in a wide range of tabulated and delimited formats.

Note Encom Discover PA handles dip direction with the convention that a downward 
hole dip has a positive (0-90) angle. If negative dips are encountered, a 
message is displayed to reflect this negative dip.
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• Encom Discover Drillhole Data - Encom Discover drillhole data can be 
read into Encom Discover PA directly using the Discover Drillhole Project. 
Collar, survey and data .TAB files are used and can be displayed with 
assay and lithology data. 

• Geosoft WHOLEPLOT Data - Geosoft WHOLEPLOT databases can be 
combined or read as separate database files containing Collar, Survey 
and downhole recorded data. Two types of Wholeplot databases are 
supported directly from the File>Open>Downhole menu option (as 
determined by the version of Geosoft WHOLEPLOT being used). Both 
point and from-to data can be accessed and displayed.

• acQuire Drillhole Data - Support for acQuire databases is provided. Using 
this support, acQuire data can be read from Microsoft Excel, FoxPro 
dBase, Microsoft Access and VisualFoxPro databases. 

Encom Discover PA allows subsurface information derived from drilling to be 
displayed in 3D. These displays can be shown with additional information such as 
surface data, raster images, survey results and other subsurface objects such as 
structural models, drillhole logs or interpreted sections.

The drillhole data can be opened from two sources:

• By clicking with the right mouse button on the Datasets folder in the Data 
Manager and selecting Open Downhole from the displayed pop-up 
menu, or

Choose the drillhole database format from the datasets pop-up menu in the Data 
Manager window.

• By selecting the File>Open>Downhole menu option and selecting the 
data format type. The data format options are Discover Downhole, 
Geosoft WHOLEPLOT, acQuire Downhole or the Import ASCII Downhole 
data option.
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Choose the drillhole database format from the File>Open>Downhole menu option

ASCII Drillhole Data

A facility to import drillhole survey data is provided which converts the recorded 
distance, dip and azimuth data of drillholes into de-surveyed XYZ information as 
it is imported. You can import either:

• Files with Collar and Downhole Survey Data

• Files with XYZ Drillhole Data

A import wizard (Import Drillholes Wizard) is provided to assist you with selecting 
the formats.

Files with Collar and Downhole Survey Data

This import facility can operate on either a collar file containing hole orientation 
data (straight holes only), or a collar file with a separate downhole survey file.

• Collar file only

• Collar and survey file

• Downhole samples and log files
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Collar file only

A collar file only which defines the collar XYZ location, distance to the end-of-hole 
(EOH) plus a dip and azimuth. An example of a Collar file of this type is:

HOLE_ID RL X Y EOH DIP AZIMUTH
ASN213  317.9  3867256.2  6542983.2  201.8  -78.2  275.6
ASN216  320.7  3867372.4  6543961.9  186.9  -83.2  263.9
ASN217  321.3  2867386.4  6543978.3  196.4  -83.4  269.3

Sample collars file with hole depth, dip and azimuth fields

Note that this drillhole data definition can only define straight holes.

Collar and survey file

A Collar file accompanied by a Survey file that accurately defines the hole shape 
by recording downhole survey information using a drillhole sensor or camera. 
Examples of Collar and Survey files are:

HOLE_ID  RL  X  Y
AN3410  647.45  516166.2  6310431
AN3409  622.7   516025.6  6310278
AN3408  621.51  516132.1  6310196
AN3407  621.4   516113    6310208
AN3406  622.28  516090.2  6310224
AN3405  622.57  516074.4  6310236

HOLE_ID  DISTANCE  DIP  AZIMUTH
AN3410  5      -88.5   215
AN3410  22.5   -88.5   215
AN3410  51     -87.75  215
AN3410  70.5   -87.5   200
AN3410  100.4  -87.25  203
AN3410  122.8  -87.25  213
AN3410  153.5  -87.5   253
AN3410  178    -85.5   254
AN3410  202    -85.25  253
AN3409  0      -88.5   88.5
AN3409  25.6   -88     88.5
AN3409  51.5   -88     88.5
AN4209  125.3  -84     80.7

Sample collars file with separate survey file
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Downhole samples and log files

Additional data files that can store geochemistry or lithology (in From-To 
measurements) or geophysical logging (measured at distance points) can also be 
read in.

Files with XYZ Drillhole Data

A line of readings that can be specified at positions in a drillhole can be defined 
in an ASCII XYZ file. In this format, each reading has its own record 
corresponding to a location in the horizontal plane (X and Y) and in the vertical 
plane (depth or Z). For inclined holes, the X and Y positions both change. Sensor 
readings such as downhole magnetometry, susceptibility readings or other 
logging measurement methods can have readings associated as extra data fields 
in each record. From-To type data (eg lithology interval samples) cannot be 
specified using the data type.

This type of data can only be created by a post-surveying step called de-
surveying. In de-surveying, a software program uses the relative recorded 
positions of distance down the hole axis, dip and azimuth to convert to absolute 
locations of Easting, Northing and Vertical depth. Survey data in this form can be 
imported into Encom Discover PA as described in Importing ASCII Data Files.

An example of a downhole XYZ file with some geochemical assay data is shown 
below:

ID  X  Y  Z  Ag  Au  Cu  Pb  Zn
MS1  641906.7  8141585  202.855  26  0.005  656  100  800
MS1  641905.4  8141586  200.083  31  0.005  206  800  1100
MS1  641902.5  8141587  194.454  80  0.005  150  700  1100
MS1  641900.6  8141588  190.644  17  0.005  624  1500 2300
MS1  641900.1  8141589  189.518  53  0.005  743  500  800
MS1  641897.6  8141590  184.668  65  0.005  799  400  1600
MS1  641895.5  8141591  180.338  14  0.005  580  300  1000
MS2  641604.6  8141592  178.642  70  0.005  891  200  500
MS2  641603.7  8141593  176.946  68  0.005  681  200  300
MS2  641601.8  8141594  175.253  80  0.005  693  300  300
MS2  641599.0  8141594  173.554  30  0.005  665  100  100

Sample XYZ data file
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ASCII Import tool dialog with an XYZ file specified

Note in the above dialog that the XYZ (from the example file supplied) is defined. 
The field names for each column have been determined from the column 
headings in record 1 (using the Get field names button). 

If the column headings need to be reset, you can position the cursor over the 
column heading, click the right mouse button and select from the available 
headings in the pull-down list, or choose Properties and manually configure the 
heading (see dialog below). 

Note The above data file is supplied with Encom Discover PA and is located in the 
\DRILL EXAMPLE folder as Assays_NT_3D.XYZ. The data example above 
specifies a Hole ID column. In fact, when imported into Encom Discover PA, 
each drillhole is specified as a Line rather than a drillhole. This is related to the 
fact that the import facility is generic and can load both XYZ and line data. To 
display as drillhole data however this makes no difference.

To import an XYZ data file into Encom Discover PA, use the ASCII Import tool 
(refer to Importing ASCII Data Files) from the File>Text Import or from the 
ASCII Import button. Navigate to the file to import and select it.
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Modify the HoleID column to be recognised as a Line by Encom Discover PA

Click the Import button to create a database (you need to specify a database 
name) and have the data automatically accessed by Encom Discover PA. The 
import process displays a message to advise you that the Hole_ID column may 
have non-numeric data (that is MS1, MS2 etc). Select the OK button and the 
import of the drillholes are numbered sequentially as they are read.

Import Drillholes Wizard

Select File>Open>Downhole>Import ASCII Downhole Data to display a wizard 
for loading either Collar, Survey, From-To Data or Point Data files as shown 
below:
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Wizard dialog to select the type of data to be loaded

Follow these steps to import ASCII drillhole data:

Step 1

Step 2

The import tool allows you to name the columns of data required. By positioning 
the cursor over the column headings and clicking the right mouse button, a pop-
up list of relevant channels are displayed as shown below for a Collars file. The 
drillholes HoleID field should be highlighted in blue. The Easting (X) and Northing 
(Y) fields should be highlighted in red and green. If these are not automatically 
detected and highlighted you can specify these from the pop-up list. For additional 
information on using the ASCII Import tool, please refer to Importing ASCII Data 
Files.

To load a drillhole file, select the Collar drillhole data file type from the drop-down 
list and then the ASCII Import button. A File Open dialog displays allowing the 
input data file to be specified. The file can be of any ASCII format suitable for 
import as specified in the Importing ASCII Data Files and includes ASCII 
column-based or CSV formats as shown in the examples above.
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Pull-down menu list for a Collars file specification

Once OK is selected the Import Drillholes wizard dialog re-displays, reporting that 
the Collars .TAB file has been created and the next dialog in the wizard asks you 
to identify the drillhole fields. The fields in the drop-down boxes are those 
available in the imported Collars ASCII file and these need to be matched with 
those specified to the left of each drop-down list. If no Azimuth, Dip or Distance 
fields exist in this file leave the selection as the default -NONE-.

Once all columns in the preview have been defined, click the Import button. You 
are requested to specify a path and name the output .TAB file to save the output 
of the Collars data. When this is done, the Drillhole Importer wizard asks if you 
would like to specify an output coordinate projection for the collars. If No is 
selected then the collars XY coordinates are placed in Non-Earth projection. If 
Yes is selected then the Choose Projection dialog will appear and you will need 
to specify a Category and a Category Member from the two drop-down lists. 
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Assign the data channels as required to their appropriate matching data

Step 3

The final process of the Import Drillholes wizard asks if you have any additional 
drillhole files to import. If you have a Survey or Downhole Data (lithology or 
assays) file to add click on Yes and you will be redirected back to Step 1 to choose 
this drillhole file type.

If you have Survey and Downhole Data files available you will need to repeat the 
above procedure for each of these files. Click the Yes button to load additional 
data and then go back to Step 1 above. Repeat this process until all files are 
imported. Mixing From-To data with Point data files for import is provided so 
drillhole information such as assays can be displayed with logging point data (eg 
specific density).

Step 4

When you have imported all the drillhole files required, select No when prompted 
about additional files for import. When this is done the following dialog is 
displayed:
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Final wizard drillhole import completion dialog

The paths and filename for all individual drillhole files are displayed. Two 
additional options available include:

• The direction of the drillholes relative to the horizontal plane is important 
for correctly displaying the drillhole axes. If the dips are negative down 
from the horizontal plane ensure the Down Dip is negative option is 
checked on.

• The data can be automatically loaded into Encom Discover PA if you 
enable the Open imported drillhole files option. This loads the imported 
and listed files and displays a spreadsheet of the data. 

If not loaded automatically (see option above), to import the drillhole data into 
Encom Discover PA, select the File>Open>Downhole>Discover Downhole 
menu item and navigate to the folder containing the imported files. Select the 
Collar, Survey (if it exists) and any required data tables all together as shown 
below. 
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Multi-select the required .TAB files of the drillhole project

When imported into Encom Discover PA, the project drillholes can be seen in the 
data spreadsheet and can be displayed in two or three dimensional maps or 
sections. Refer to the relevant display section of this guide for more information.

Encom Discover Drillhole Data

You can access drillhole data for display in Encom Discover PA created in Encom 
Discover. For additional information on MapInfo Professional .TAB files the data 
files and Discover drillhole projects, refer to the Encom Discover User Guide. Also 
refer to Integration with Encom Discover in this manual.

Usually, the Drillhole Project consists of three or more MapInfo Professional .TAB 
files similar to: 

• COLLARS.TAB – defines the Hole_ID, collar location (XYZ) and depth of 
holes.

• SURVEY.TAB – specifies the survey points down the various holes.  This 
file defines the shape of the drillholes.

• DATA.TAB – typically these files contain assay or lithological data.

Once a drillhole project has been established in Encom Discover, select the 
File>Open>Downhole>Discover Downhole menu option or the Open 
Discover Drillholes toolbar button. Navigate to a valid downhole dataset. To 
import all drillhole information from the collars, survey and downhole data files 
the four .TAB files must be selected and imported in one operation 
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When imported into Encom Discover PA, the project drillholes can be seen in the 
spreadsheet window and can be displayed in two, three dimensional maps or 
sections. Refer to the relevant display section of the User Guide for information 
on this.

Geosoft WHOLEPLOT Data

Geosoft drillhole databases are created by the WHOLEPLOT option of Oasis 
montaj and usually have a .GDB name extension. Depending on the version of 
montaj used to create the database, the collar, survey and data content may be 
a single .GDB file or multiple .GDB files.

Two Geosoft WHOLEPLOT formats have evolved with differing versions of the 
Geosoft montaj WHOLEPLOT software. Prior to version 4.2, WHOLEPLOT 
databases stored collar, survey and acquired data within a single .GDB database 
file. After the release of version 4.2, separate databases containing the collar, 
survey and reading data were provided. Both single and multiple .GDB datasets 
are supported by different menu options in Encom Discover PA. 

Select File>Open>Downhole>Geosoft Downhole menu option to access an 
Open File dialog. Navigate to the drillhole folder, choose the geosoft database 
and click Open. The Geosoft .GDB database files will be either suited for Geosoft 
OASIS version pre 4.2 (in which a single database file is input) or after OASIS 
version 4.2 in which case, multiple database files need to be selected as shown 
below):

Note When using a Discover Downhole dataset Encom Discover PA provides the 
facility of converting downhole data from one depth unit to another. A Define 
Dataset Properties dialog allowing this conversion is displayed when the data 
files are specified.
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Multiple GDB Geosoft databases for input of a WHOLEPLOT dataset

Geosoft drillhole databases generally define downward dipping drillholes as 
negative values so Encom Discover PA  assumes the Geosoft database adheres 
to this format. If this needs to be reversed, the File>Modify Database Properties 
dialog provides an option to do so for any Geosoft drillhole database loaded. 

 
The Define Dataset Properties dialog

Note For the above changes to take effect any existing drillhole branch containing the 
Geosoft drillhole project must be deleted first and a new branch opened.
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When imported into Encom Discover PA, the project drillholes can be seen in the 
spreadsheet window and can be displayed in two, three dimensional maps or 
sections. Refer to the relevant display section of the User Guide for information 
on this.

For additional information on this data format, please refer to the Geosoft 
WHOLEPLOT documentation or: 

http://www.geosoft.com/pinfo/oasismontaj/extensions/drillholeplotting.asp

acQuire Drillhole Data

The acQuire software system is widely used within the geoscience community for 
the storage and retrieval of drillhole data. The acQuire software system allows a 
wide range of data formats to be supported including:

• FoxPro .DBF

• SQL Server

• Microsoft Excel

• Microsoft Access

• text files

• VisualFoxPro Microsoft

Select the File>Open>Downhole>acQuire Downhole menu option. When 
selected a dialog as shown is displayed. 

Note To use the acQuire drillhole database software you are required to have an 
operational licence of acQuire. The necessary software to operate acQuire with 
Encom Discover PA is automatically installed with the software..

http://www.geosoft.com/pinfo/oasismontaj/extensions/drillholeplotting.asp
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Import from acquire dialog.

If you click the Select data from acQuire button an acQuire format selection 
dialog is presented. From the list you can specify the format of the drillhole data 
and then the program requests you navigate to the correct folder and select the 
input data file.

You can also ask that the data be automatically displayed once accessed through 
acQuire (using the Display in a New Document option).
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Selection of drillhole data to import using acQuire

Once the acQuire data has been opened and read, it creates a set of MapInfo 
Professional .TAB files with the requested data and data channels (geology, 
assays, survey information etc). When you need to re-access the same data, you 
can either use the acQuire import again or the File>Open>Downhole>Discover 
Downhole menu item.

Desurvey Methods

Upon loading a drillhole project into Encom Discover PA, the drillholes are 
desurveyed using the Back Calculation method (detailed below) by default, as 
this is the method used by the Drillhole module in Encom Discover.

You can however choose a different method by opening the File>Modify 
Database Properties dialog, and selecting the desired method from the pull-
down list of Desurvey Methods at the bottom of the dialog. This change will apply 
permanently to the drillhole project each time it is opened into Encom Discover 
PA, until a further change is made in this dialog. 
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The methods available are:

Minimum Curvature (recommended)

This is the most robust method and is highly recommended for use in Encom 
Discover PA. It is also known as radius of curvature and is considered the 
standard method in the oil and gas industry.

Each survey point is considered to lie at the start point on a spherical arc (or 
straight line) whose radius is defined by the change in the direction of the hole 
from the survey point to the next survey point. The dip and azimuth of the hole 
varies smoothly between survey points.

Back Calculation

This is the only method offered in the Drillhole module for Encom Discover and is 
the default method in Encom Discover 3D. Although it is a simple method it does 
produce as reasonable results as Minimum Curvature.

Each survey point is considered to lie in the middle of a drillhole segment which 
has the dip and azimuth of the survey location. The dip and azimuth of the hole 
changes automatically halfway between each survey point.

Note that in Encom Discover PA the Back Calculation method ought to be used 
in preference to segments method.

Segments

This method was used in previous versions of Encom Discover PA and Encom 
Discover 3D. It is very similar to back calculation but produces poorer results.

Each survey point is considered to be the start of a drillhole segment which has 
the dip and azimuth of the survey location. The dip and azimuth of the hole 
changes automatically at each survey point.

Akima Spline

This method is also very robust and produces very similar results to the minimum 
curvature method.

Smooth Akima spline functions are fitted to the dip and azimuth survey data for 
the length of the hole. The hole is then desurveyed using the segment method 
and a small, constant depth interval where the dip and azimuth for each segment 
is acquired from the spline functions. Akima ought to be used in preference to 
Bezier.
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Bezier Spline

This method is exactly the same as the Akima spline method except that a Bezier 
spline function is used instead of an Akima spline.

Drillholes in Profile Sections

Once drillhole data has been imported into Encom Discover PA using any of the 
methods above, the data can be displayed in 2D vertical graphs for drillhole logs, 
2D maps for collar and trace illustration and 3D tubes or rose presentation for 
advanced presentation. 

Drillhole locations, collars and modulated downhole traces can be displayed in 
Profile Sections. Initially a Section branch must be present in the Profile and its 
vertical scaling must be in suitable units to position the drillhole traces. Similarly, 
only drillholes that lie within a defined buffer zone on either side of the profile line 
can be extrapolated onto the profile section. It is rare that the exact collar location 
and trace of a drillhole will be aligned with a survey line position and so the 
drillhole trace must be extrapolated onto the section.

For more informatio, see:

• Drillhole Selection

• Data Compression

• Colour Modulation

• Trace Style

• Labelling

• Symbols

• Off-Section Clipping

After importing the drillhole dataset displays a Section Profile in the usual 
manner. Add the drillholes to the Profile 1 branch by using the Add 
Data>Drillholes pop-up menu option or the Add Drillholes button.
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Drillhole Selection

The Holes tab of the Drillholes Properties dialog allows the user to control which 
holes are displayed

Drillhole selection using the Holes tab

The Graphical Selection dialog for Drillholes.

Specify the holes to be displayed by moving the drillhole name(s) from the Hide 
to the Show list. Alternatively, you can graphically select the holes to be 
displayed from a collar map using the Graphical Selection button. 
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Drillhole collar names can be displayed in the graphical selection dialog by 
placing the cursor over a drill hole and viewing the name in the left corner of the 
status bar at the bottom of the dialog.

Drillholes displayed in a CDI section of a Profile window

Data Compression

The Decimation Scheme option in the Fields tab enables the display rendering 
performance to be improved by reducing the number of samples displayed down 
the hole. This option is generally only appropriate for larger datasets where 
geophysical data has been collected at a small scale (e.g. centimetre or 
decimetre) rather then geological data collected at a larger scale (eg metre).

Three options are available: 

• No decimation – all samples are utilised i.e. no compression applied (the 
default option).

• Fixed rate decimation – utilises 1-in-every-n samples, where n is a 
userdefined value.

• Compressed – a user-specified percentage of the downhole dataset is 
compressed.
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Colour Modulation

Drillhole traces can be colour modulated using controls provided under the 
Colour tab of the Drillholes Properties dialog. For example, colour drillholes 
based on a downhole lithology, assay, or alteration field.

The Colour tab configured to colour modulate drillhole traces using a gold (Au_ppm) assay 
field and a logarithmic colour mapping transform.

Enable the Colour tick box and set the desired data field from the adjacent 
pulldown list (available data fields are named with the following convention: 
Tablename_Fieldname). Click the first Edit button to open the Colour Scale 
dialog.

In the Colour Scale dialog, select a custom Look-up Colour Table or Legend 
Table if one has already been created using the Colour Table Editor or Legend 
Editor. Alternatively a range of standard colour interpolations (RGB & HSL) and 
Look-Up Tables (created using the Colour Table Editor) are also available.

The Field Data Conditioning button at the far right of the Colour tab is used to 
apply conditions to the selected colour field. Conditions available include data 
capping (i.e. setting upper data limits to minimise nugget effect for assay data) or 
excluding unwanted categories from the display (e.g. overburden such as soil 
and alluvials). 
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Drillhole Colour Legends

An on-screen colour legend Floating Colour Bar can be added to the  display 
which is referenced to a colour modulated drillhole project. This enables the user 
to easily visualise the relationship between different drillhole colours and the 
corresponding lithology or assay range values. See the Floating Colour Bar 
section for further information. 

Trace Style

The Appearance tab allows the trace style of drillholes to be altered. 

To alter the Trace Style, ensure the Show Line option is enabled, and select the 
Line style button. This will display the Line Style dialog allowing the selection of 
a new colour, weight and pattern for the drillhole trace. 

Note The Field Data Conditioning dialog is also an excellent way to visualise only 
the desired subset of a dataset: for instance only Quartz_Vein and Fault 
lithological intercepts, or only Au assays between 5 and 15 g/t. Once a subset is 
specified, try turning the Show Gaps option Off (under the Appearance tab), 
then add another Drillholes branch to the Workspace Tree populated with the 
entire dataset, but displayed as simple Lines.

Note Activating the Override background colour option in the Appearance Tab will 
replace any background colours applied via a Legend in the Fields tab with the 
colour specified in the Appearance tab.
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The Drillhole Properties Appearance tab dialog.

Labelling

Select the Symbols tab to activate Symbols and Labels for the drillholes and to 
apply Off-Section Clipping. 

The Symbols tab for Drillholes Properties.
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Drillhole collars and bottoms can be annotated with labels by enabling the 
appropriate tick box in the Symbols and Labels section. To change or customise 
the label display, click the adjacent Collar Label, Bottom Label or Depth Label 
button to open the Advanced Arrangement dialog.

The Advanced Arrangement dialog for applying drillhole collar and bottom labels

The Collar and Bottom Label buttons display the current label in a text box at 
the top of the dialog; to change this, highlight the entire text entry and click the 
Field Selection button (shown left). Select the desired field from the displayed list 
(populated from the drillhole collar file). Multiple fields can be displayed together 
by placing the cursor at the desired insertion point within the text window (without 
highlighting any existing text) and then selecting extra fields from the field 
selection list (without highlighting any existing text) and then selecting extra fields 
from the filed selection list.

The Depth Label button relaces the text box with a Format button; this can be 
used to set numeric formatting, prefixes and suffixes. Activating the Depth Label 
option also requires setting a Depth Interval in the Appearance tab (i.e how 
often downhole depths are displayed).
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Symbols

The collars and/or bottoms of drillholes can be annotated with a symbol by 
enabling the Collar Symbol or Bottom Symbol options in the Symbol tab. The 
adjacent buttons open the Symbol Selector dialog allowing you to choose from an 
extensive library of symbols. Choose a symbol from the list to view a preview on 
the right side of the dialog. The symbol Size and Fill Colour can also be modified.

Symbol Selector dialog

Off-Section Clipping

The Off-Section Clipping section controls the visibility of drillhole traces in a 
section based upon their distance from the section baseline. To apply a drillhole 
clipping to each section displayed select the Clip drillhole trace tick box and 
enter a Clipping distance value (in metres). For example a value of 50 will 
display all drillholes located within 50 metres of a section profile. 

Some drillhole traces will appear truncated in section profile displays. This is 
because a drillhole may intersect the section profile and disappear out the other 
side of the section. In this case it is recommended to enable the Show entering 
symbol or Show leaving symbol options which will highlight the position and 
behaviour of the drillhole trace.
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Adding Drillholes to a 2D Map

Drillhole locations, collars and modulated downhole data can be displayed in a 
two dimensional map. Rose diagram displays cannot be shown. 

Select the Add Data>Drillhole Group item from the pop-up menu

With the holes displayed in the map, configure them using the drillhole properties 
as explained in the section for 3D Displays.

Example of drillholes within a 2 dimensional map showing Au soil grid.

After importing the drillhole dataset display a 2D Grid Map in the usual manner. 
Add the drillhole locations to the Map 1 branch of the Workspace tree by using 
the Add Data>Drillhole Group pop-up menu option or the Add Drillholes 
button.
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Adding Drillholes to a 3D Map

Once drillhole data has been imported into Encom Discover PA, the data can be 
displayed in a 3D Map. Create a 3D Map display as described in Three-
Dimensional Displays or select the File>New>Map>3D Grid Map menu option or 
the toolbar option. 

A Drillhole branch is created in the Workspace tree and the first of the available 
holes is displayed as a 3D hole. See Drillhole Properties for information on how 
to change the display properties.

Drillhole Properties

Most aspects of drillhole displays can be controlled from the Properties dialog 
opened from the Drillholes branch of the Workspace tree. To display the Drillholes 
Properties dialog, either:

• Move the cursor over the Drillholes branch in The Workspace Tree and 
double click with the left mouse button, or

• Select the Drillholes branch in The Workspace Tree and click the right 
mouse button. From the resulting pop-up menu, select the Properties 
item.

Various display controls can be applied to the drillholes depending on the type of 
data available. An example of a downhole display with lithology is shown below.

With a 3D Map active, click the Add Drillhole button from the Data Object 
toolbar or choose the Add Data>Drillhole Group menu item from the pop-up 
menu of the 3D Map branch in the Workspace tree.
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Example drillholes with downhole lithology displayed

For information on using the Drillhole Properties dialog, see:

• Holes Tab

• Fields Tab

• Colour Tab

• Appearance Tab

• Symbols Tab
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Holes Tab

The Holes tab of the Drillholes Properties dialog allows you to control which holes 
are displayed. 

Drillhole selection using the Holes tab

If more than one dataset is open in Encom Discover PA make sure that the correct 
one is selected from the Dataset drop-down list. 

Drillhole graphical collar selection

Specify the holes to be displayed by moving the drillhole name(s) from the Hide 
to the Display list. Alternatively, you can graphically select the holes to be 
displayed from a collar map using the Graphical Selection button.
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Fields Tab

The Decimation Scheme option in the Fields tab enables the display rendering 
performance to be improved by reducing the number of samples displayed down 
the hole. This option is generally only appropriate for larger datasets where 
geophysical data has been collected at a small scale (e.g. centimetre or 
decimetre) rather then geological data collected at a larger scale (eg metre).

Three options are available:

• No decimation – all samples are utilised i.e. no compression applied (the 
default option).

• Fixed rate decimation – utilises 1 in every n samples, where n is a 
userdefined value.

• Compressed - a user-specified percentage of the downhole dataset is 
compressed. Use the slider bar to control the compression percentage 
applied.

Move the slider bar to increase the compression of drillhole data

Note Drillhole collar name can also be displayed by placing the cursor over a drill hole 
and viewing the name in the left corner of the status bar at the bottom of the 3D 
screen.
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Colour Tab

Drillhole traces can be colour modulated using controls provided under the 
Colour tab of the Drillholes Properties dialog. For example, colour drillholes 
based on a downhole lithology, assay, or alteration field. 

The Colour tab configured to colour modulate drillhole traces using a lithology field and a 
custom colour legend

Enable the Colour tick box and set the desired data field from the adjacent pull-
down list (available data fields are named with the following convention: 
Tablename_Fieldname). Press the Edit button to open the Colour Scale dialog. 
Select a custom Legend if one has already been created using the Legend Editor 
(either in 3D or more typically in 2D as part of Discover Drillhole Project). A range 
of standard colour interpolations (RGB & HSL) and Look-Up Tables (created 
using the Colour Table Editor) are also available. 

The Field Data Conditioning button is used to apply conditions to the selected 
colour field. Conditions available include data capping (ie. Setting upper data 
limits to minimise nugget effect for assay data) or excluding unwanted categories 
from the display (e.g. overburden such as soil and alluvials). See Appendix G: 
Field Data Conditioning for use of this tool.

Note Activating the Override background colour option in the Colour tab will replace 
any background colours applied via a Legend in the Colour tab with the colour 
specified in the Appearance tab.
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Drillhole Colour Legends

An onscreen colour legend Floating Colour Bar can be added to the 3D display 
which is referenced to a colour modulated drillhole project. This enables the user 
to easily visualise the relationship between different drillhole colours and the 
corresponding lithology or assay range values.

Example of a Floating Colour Bar linked to a drillhole project colour modulated by geology; 
a colour legend with an entry for each rock type is displayed

Appearance Tab

The Appearance tab allows the trace style of drillholes to be altered, as well as 
the application of labels and symbols.

• Trace Style

• Thickness Modulation
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Trace Style

To alter the Trace Style, ensure the Show Trace option is enabled, then choose 
one of the following styles from the adjacent pull down list:

• Line – This is the most efficient display style, and is recommended as the 
initial style when displaying large datasets. Hole traces are displayed as a 
simple line, with colour, line weight and pattern options under the Line 
Style button. Colour modulation is possible but thickness modulation is 
not.

• 3D Tube – Drillholes can be displayed as solid tubes, with a cross-section 
profile (and colour) set via the Tube Style button (default Tube_Medium 
style).  The constant Thickness of the tube can also be specified. Colour 
modulation is possible but thickness modulation is not.

• 3D Rose – This is the most memory intensive of the trace styles, allowing 
the width of the trace to be modulated based on one or more downhole 
numeric data fields (such as an assay or geophysical field); these are set 
under the Thickness Modulation. It requires specification of the Thickness 
range (minimum and maximum widths). An Initial Angle control is also 
available, controlling the initial starting angle for rose segments when 
more than one numeric field is specified. A Colour modulation can also be 
applied, or a constant colour set via the Colour button.

Appearance tab of Drillholes Properties
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Different drillhole appearances are shown here:

Examples of colour modulation of drillholes as applied to Line, 3D Tube and 3D Rose 
traces  using lithological data. The thickness modulation of the 3D Rose traces has been 
applied using an  assay field

The Show Gaps option is only available (not greyed out) when a Colour 
Modulation and/or one or more Thickness Modulation fields has been assigned. 
Deselecting this option (un-ticking it) will result in any sampling gaps not being 
plotted; ie drillhole traces will be discontinuous if sampling gaps exist.

Discrete samples are only applicable to the 3D Rose trace style. When enabled, 
each sample interval is displayed as a uniform thickness across the interval.  
Assay intervals are displayed as steps/disks of varying thicknesses. Disabling this 
option enables the hole thickness to be altered gradually/continuously across 
sample intervals. Examples of these modes are presented below.

Examples of Gradual and Discrete thickness modulated (3D Rose) downhole assay 
displays
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The Override background colour option will only have an effect when a Legend 
is applied as Colour Modulation (3D Tube or 3D Rose styles). It will replace the 
background colour of each legend entry with the colour assigned in either the 
Tube Style or Colour buttons. Foreground colours will be preserved.

Thickness Modulation

Drillholes can be thickness modulated in the Appearance tab either by:

• Single Field Modulation using the 3D Tube style, or

• Multiple Field Modulation using the 3D Rose style.

Single Field Modulation

To vary thickness of drillholes by a single numeric field (e.g. assay or geophysical 
downhole data):

1. In the Appearance tab set the hole style to 3D Tube.

2. Enable the Modulate Thickness option at the bottom left of the dialog.

3. Select the required downhole value field from the adjacent pull-down list.

4. Use the adjacent Field Data Conditioning button to remove any null 
values from the dataset, or to limit the data range to that of interest (e.g. all 
Au values above 50 ppb).

The thickness range can be applied either by:

• A default linear transform between the set From and To values. The 
transform method can be altered using the adjacent Data Mapping button 
(options include log and histogram transforms).

• A custom legend of data ranges and associated line thicknesses selected 
using the adjacent Legend selector button, created with the Legend 
Editor

Multiple Field Modulation

To vary thickness of a drillhole by multiple numeric field simultaneously (e.g. 
assay or geophysical downhole data):

1. In the Appearance tab set the hole style to 3D Rose.
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2. In the Thickness section of the tab, leave the modulation to By default, 
and set the From and To values as required (these are the minimum and 
maximum thickness values for the drillholes).

3. Press the Petals button (top right of the dialog) to open the Petal 
Channels dialog.

Specify the thickness of selected drillhole database fields for 3D Hole display

Up to 8 numeric downhole data fields can be specified by checking a Show box 
and selecting the required field to display from the adjacent pull-down lists. 
Available data fields are named with the following convention: 
Tablename_Fieldname. For each field the following options are available:

• Colour - specify a standard or customised colour to display the data in the 
selected field.

• Sharpen - this option squares the data to give greater weighting to larger 
values. This is a useful way of exaggerating the visual display of high 
grade intercepts.

• Enhance - display the value for each depth using a logarithmic expansion.

• Global -  this option scales the data in each hole with respect to the entire 
dataset (as imported into Discover 3D), rather than scaling each hole 
individually.
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The Appearance tab also contains the Thickness range, Initial angle and 
Discrete samples controls relating to this thickness modulation functionality.

Symbols Tab

The collars and/or bottoms of drillholes can be annotated with a symbol by 
enabling the Collar Symbol or Bottom Symbol options in the Symbols tab.

Symbols tab of Drillholes Properties

The adjacent buttons open the Symbol Selector dialog enabling the user to 
choose from an extensive library of symbols. Choose a symbol from the list to 
view a preview on the right side of the dialog. The symbol Size and Fill Colour 
can also be modified.

In addition each field has a Field Data Conditioning button which can be used 
to condition the source data. Type of conditions available include data capping 
(removing nugget effects), null value handling and invalid data assignment (eg. 
removal of large negative values representing BDL, SNR, etc, that affect 
thickness distribution). See Field Data Conditioning for use of this tool.

Note The colours set in the Petal Channels dialog will be overwritten if a colour 
Legend has been selected in the Colour tab. Setting multiple downhole fields to 
display using thickness modulation in this instance is not recommended as it will 
be impossible to determine the individual thickness modulation fields in the 3D 
display. 
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Symbol Selector dialog

Advanced Symbol Style Options are available via the Advanced button. 

Advanced Symbol Style Options dialog
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A range of symbol orientation options similar to those for Labels are presented in 
the pull-down list at the top right of the dialog:

• Facing Viewer (default) – symbols are aligned parallel to the viewing/
screen plane so that they always face the viewer. 

• Fixed 3D – symbols are fixed in the 3D environment. The pull-down list in 
the Rotation panel at the bottom of the dialog controls the initial 
orientation: Flat (the XY plane) or Upright (XZ plane).

• Fast 3D – identical to the Fixed 3D, except that no Style controls are 
available. This is a very fast and memory-efficient option.

The Style button is only available for the Facing Viewer and Fixed 3D orientation 
options. It allows symbols to be extruded either as filled Polygons or Line 
Segments (wireframe) using the Format pull-down list. The depth of the symbol 
is set using the Extrusion control, expressed as a percentage of the symbol size. 
To display a flat symbol, set the Extrusion to 0%. The symbol is extruded 
perpendicular to its display plane. 

A range of Size Controls are available. For the Fast 3D orientation option, only 
the Font Size control is available (in points). Enabling the Constant checkbox 
(for the other orientation options) will keep the symbols at the specified size 
(relative to the screen) regardless of zoom level. If the Constant option is 
disabled, Lower and Upper Limits can instead be set:

• Block - symbols will disappear when the applied zoom level takes the 
symbol past the specified limit 

• Clamp -  symbols will locked to the specified limit  when the applied zoom 
level takes the symbols past the specified limit 

The symbol position relative to the data location can be altered using the 
Alignment controls (either preset or manual positioning). The first row of controls 
concern symbol positioning in the symbol plane (i.e. the relative XY components), 
whilst the second row controls the vertical height of the symbol with respect to its 
initial plane (i.e. the relative Z component).

The angle of the symbols can also be set by moving the red-tipped arrow on the 
compass in the Rotation panel at the bottom of the dialog. The Fixed and Fast 
3D labelling options also provide a Dip control (half-compass) in this panel.

Note Rendering symbols as extrusions is memory intensive, and will effect 3D 
performance. It is not recommended for large numbers of symbols.
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Labelling

Drillhole collar and bottom symbols appearance and annotation can be altered by 
enabling the appropriate tick box at the bottom of the Symbols tab. To change or 
customise the label display, press the adjacent Collar Label, Bottom Label or 
Depth Label button to open the Advanced Arrangement dialog. 

The Advanced Arrangement dialog for applying drillhole collar and bottom labels

The Depth Label button replaces the text box with a Format button; this can be 
used to set numeric formatting, prefixes and suffixes. Activating the Depth Label 
option also requires setting a Depth Interval in the Appearance tab.

The Collar and Bottom Label buttons display the current label in a text box at 
the top of the dialog; to change this, highlight the entire text entry and press the 
Field Selection button (shown left).  Select the desired field from the following 
list (populated from the drillhole collar file). Multiple fields can be displayed 
together by placing the cursor at the desired insertion point within the text 
window (without highlighting any existing text) and then selecting extra fields 
from the field selection list (without highlighting any existing text) and then 
selecting extra fields from the filed selection list.
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For all label types, standard Font controls are provided, as well as the following 
range of orientation options in the adjacent pull-down list:

• Facing Viewer (default) – Labels are aligned parallel to the viewing/
screen plane so that they always face the viewer. 

• Fixed 3D – Labels are fixed in the 3D environment. The pull-down list in 
the Rotation panel at the bottom of the dialog controls the initial 
orientation: Flat (the XY plane) or Upright (XZ plane).

• Fast 3D – identical to the Fixed 3D except that no Style controls are 
available. This is a very fast and memory-efficient labelling option.

The Style button is only available for the Facing Viewer and Fixed 3D orientation 
options. It allows labels to be extruded either as filled Polygons or Line Segments 
(wireframe) using the Format pull-down list. The depth of the label is set using 
the Extrusion control, expressed as a percentage of the label size. To display a 
flat label, set the Extrusion to 0%. The label is extruded perpendicular to its 
display plane. 

A range of Size Controls are available. For the Fast 3D orientation option, only 
the Font Size control is available (in points). Enabling the Constant checkbox 
(for the other orientation options) will keep the labels at the specified size (relative 
to the screen) regardless of zoom level. If the Constant option is disabled, Lower 
and Upper Limits can instead be set:

• Block: labels will disappear when the applied zoom level takes the label 
past the specified limit 

• Clamp: labels will locked to the specified limit  when the applied zoom 
level takes the label past the specified limit 

The label position relative to the data (collar) location can be altered using the 
Alignment controls (either preset or manual positioning). The first row of controls 
concern label positioning in the label plane (i.e. the relative XY components), 
whilst the second row controls the vertical height of the label with respect to its 
initial plane (i.e. the relative Z component).

The angle of the labels can also be set by moving the red-tipped arrow on the 
compass in the Rotation panel at the bottom of the dialog. The Fixed and Fast 
3D labelling options also provide a Dip control (half-compass) in this panel.

Note Rendering labels as extrusions is memory intensive and will affect 3D 
performance. It is not recommended for large numbers of labels.
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Plotting Data Beside Drillholes

Select the data channel for plotting and configure the text for font, size and format. 
You may need to top every data value being plotted and for this, use the Skip 
Factor.

Using a Curve control to plot text values beside drillholes.

Text values for drillhole data can be displayed adjacent to a hole by using a 3D 
Points object associated with a Drillhole Group. If you display the Points 
Properties dialog, you can disable the Show Symbols attribute in the Symbol 
tab and enable the Show Label drawing (from the Labels tab). 
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Display Downhole Logs

A useful 3D display technique for drillholes is to show a downhole log of measured 
drillhole data. This can be done by adding a bitmap of a drillhole log that has 
already been created in a 2D Graph (Vertical Log) display or in Encom Discover 
to a 3D display. The Drillhole Log is created as a located image (.egb) using the 
Batch Hard Copy wizard utility and is rendered as an image curtain next to the 3D 
Drillhole.

Multiple drillhole logs displayed in Discover 3D.

Step 1

Open a drillhole dataset using the File>Open>Downhole menu option.

Step 2

Open a 2D Graph display from the toolbar button or the File>New>Graph>2D 
Graph (Vertical Log) menu option. A 2D Graph display will appear with the Curve 
Properties dialog open on the Data tab. By default the first drillhole will be 
assigned to the display. Select the Fields tab and select a log field, such as an 
assay (Au, Ag, etc) or mag susc field to be assigned for the X field and for the Y 
field select the From field. 
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Representation of Workspace tree for a drillhole log graph

Step 3

In the Line Style tab dialog activate the Modulate Line Colour option and select 
an assay or lithology field from the drop down list. If choosing to colour modulate 
by lithology select a previously created legend file (.leg) from the Lookup Table/
Legend drop down list. Refer to Legend Editor for information on how to create 
this legend file. Also in the Line Style tab dialog activate the Show Fill option in 
the Fill Settings section. Select to Fill above the base option and specify to fill 
from the Data Minimum in the drop down list.

Use the Line Style, Fill, and Colour tabs to alter the appearance of the drillhole log
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An option also exists in the Fill Settings section to display the drillhole log as a 
bar chart. Two examples of the resulting log display are illustrated below.

 
Example of line trace drillhole lo Example of bar chart drillhole log

Step 4 – Batch Printing Drillhole Logs

With a drillhole log display completed a batch printing of all drillholes can be 
performed using the File>Batch Hard Copy Wizard menu option and selecting 
to print the output to Located image files on disk (EGB).

Specify the image size, format and name, including whether or not to display 
graph annotations and which folder to save the located images to.
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Then choose which drillhole logs to plot by using the line iterator (number of plots 
in forward or reverse direction) option or else select the individual drillholes from 
the list.

Once the Finish button is selected the batch printing will be executed and the 
status of the printing will be displayed in the status bar in the bottom left hand 
corner.
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Use the pop-up menu option in the Workspace tree to create a single located image of the 
currently active drillhole log

With a 3D display active and a drillhole group added to this use the Image tab of 
the Drillholes Properties dialog to control the orientation, scale and quality of the 
view.

Note If only a small number of drillhole log displays are required to be output to 
located images, individual .EGB files can be created by clicking the right mouse 
button on the Graph 1 branch of the workspace tree and selecting the Save as 
Georeferenced Image pop-up menu option. 
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Image tab of the Drillholes Property dialog

The bitmap created by Discover is automatically listed, and the colour white is 
selected as transparent. Other colours can be chosen using the Browse button 
(shown left).  The degree of transparency can be controlled with the 
Transparency slider to allow view of items behind the log.

The log images are automatically orientated in Encom Discover PA according to 
the average azimuth of the corresponding drillhole. The Azimuth slider enables 
this initial azimuth to be modified by a constant value. Enabling the Uniform 
Azimuth option will force all images to orient along the same specified azimuth 
as set with the Azimuth slider (0o and 360o is north). The horizontal Scale can 
also be adjusted either via the Scale slider, or the Precision Scale button 
(shown left).
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Curtain width dialog enabling precise control of the image curtain scale

The Curtain Width dialog enables the width of the image curtain to be precisely 
controlled via one of three options:

• As Defined in the located bitmap header file

• Related Quantity Defined by applying a user defined Multiplier to the 
header file definition

• Undefined  the width is calculated using the formula: Width = Constant + 
Multiplier * Image_Width, with the highlighted parameters user-defined.

Additional Image tab controls include:

• Option to Centre the curtain on the drillhole trace, or having its margin lie 
along the trace

• Refine the quality of the bitmap 

• Adjust the Texture Interpolation Mode of the log. Lower quality texturing 
provides faster bitmap display and manipulation.
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21 Voxel Models
Encom Discover PA allows block or voxel models (i.e. 3D grids) to be displayed 
with a variety of options, such as slices, threshold range or isosurfaces. Voxel 
models can be imported from third-party software such as mine simulation or 
inversion packages, or created using the 3D Gridding utility in the Voxel Toolkit.

In this section:

• What are Voxel Models?

• Supported Voxel Model Formats

• Creating a Voxel Model Display

• Importing a Voxel Model

• Exporting a Voxel Model

• Voxel Model Information

• Voxel Model Properties

• Additional Voxel Display Features

What are Voxel Models?

The term voxel refers to a volume element and is the three-dimensional 
equivalent of the two-dimensional pixel. As used in geophysical modelling, voxel 
models represent volumes of the earth which are subdivided in a regular way into 
sub-volumes, or cells. Each cell, created from six sides contains an earth volume 
of uniform property attribute. Such properties as magnetic susceptibility, gravity 
density, conductivity or IP property (eg chargeability or phase) can be used. 
Certain geophysical software from inversion applications (e.g. UBC) and software 
products (such as Vulcan, Gemcom, Surpac) can create 3D voxel files.

Individual cell volumes for display by Voxel Modeller are prismatic in shape but 
voxel models need not be. For example, complex mesh designs are possible 
whereby individual cell dimensions vary for each of their 12 side lengths. Software 
such as Pitney Bowes Software’s 3D Gridding utility (see 3D Gridding) or EM Gui 
are capable of creating and displaying these types of models.
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Example of complex voxel shape

Supported Voxel Model Formats

Encom Discover PA currently has complete support for six voxel/block model 
formats. 

• UBC (University of British Columbia)

• CEMI (Consortium of Electromagnetic Modelling and Inversion – 
University of Utah) 

• Encom3D Grid

• ASCII XYZ Simple (centred and uniform mesh only).

• Noddy (developed under AMIRA grant by Dr Mark Jessell at Monash 
University)

The files used as input to the Voxel Model are the result of modelling and 
inversion simulation software programs created by the above research 
organisations. In some cases the Voxel Model can be used to display the input 
models of the research programs or, alternatively, the output inversion results of 
the programs. The supported formats for UBC, CEMI and Noddy are ASCII with 
relatively simple specifications.

Additionally, Encom Discover PA has limited support for the following voxel 
formats:

Note Encom Discover PA Voxel Toolkit and Array Data 3D Gridding can also create 
3D voxel model outputs, for example for a 3D drillhole or EM (conductivity-
depth) dataset.
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• Datamine – single precision only

• Gemcom – 16-bit integer, 32-bit integer and 32-bit floating point cell data 
types

• Geosoft voxel

• GoCAD voxel

• Micromine block model – ASCII file and single precision only. Sub-blocks 
are not supported.

• Surpac – version 3 supported, with preliminary support for versions 1 and 
2. The following Surpac cell data types are supported: 32-bit integer, 64-
bit real and string

• Vulcan – single and multi-parameter support.

For examples of these supported voxel/block model file formats, refer to 
Appendix B: Data File Specifications.

Creating a Voxel Model Display

To add a Voxel Model to Encom Discover PA, either a 3D display, curve profile 
display or 2D map display window must be active. Refer toProfiles, Two-
Dimensional Maps, andThree-Dimensional Displays for information on how to 
create one of these display windows. 

To add a Voxel Model to a display window highlight either the Profile 1, Map 1, 
or 3D Map branch of the workspace tree, click the right mouse button and select 
Add Data>Voxel Model from the pop-up menu. Alternatively click on the Add 
Voxel Model button in the Data Objects toolbar. The resultant Workspace tree is 
shown below:
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Adding a Voxel Model branch to the Workspace tree

Once the Voxel Model branch exists in the tree, double clicking it or highlighting 
it and right mouse clicking allows you to display the Properties dialog. For control 
of the Properties dialog (e.g. remaining on screen etc.), refer to Display 
Properties.

After the data for a voxel model is loaded into Encom Discover PA (see Importing 
a Voxel Model), you can add this to other displays by either using the cut/paste 
command or "drop" a voxel model into a display window by using the drag and 
drop operation from the Data Manager window.
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An example display of a voxel model shown in curve profiles, a 2D map with a grid image 
and a 3D display."

Importing a Voxel Model

The style of file specification varies depending on the format. For example, the 
UBC format requires specification of two files (a mesh and a properties data file). 
The CEMI format and the various mine simulation package options (e.g. 
Datamine) require only a single location and property definition file. 

Note that only a single model can be specified at one time for each voxel model 
branch in the workspace tree. This is listed in the File tab after being specified. If 
the Auto-Apply option (at the base of the dialog) is enabled, upon reading the 
model file, Encom Discover PA automatically displays the model.

The File tab of the Voxel Model Properties dialog contains the Load Model 
Wizard button . This wizard allows the selection of the model type and navigation 
to and selection of the relevant model file(s).
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Use the Voxel Model wizard to select the model type and relevant model files

Additional options on the File tab include Export and Information relating to a 
voxel model. Refer to Exporting a Voxel Model and Voxel Model Information for 
additional details.

Initial display of the Voxel Model with internal annotation
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Exporting a Voxel Model

Voxel Model Export Wizard

The export options are:

• Voxel model to 3D vector or ASCII file – export the thresholded model 
to either a DXF vector of individual cells, or a UBC or XYZ model format.

• Single Horizontal depth layer to surface grid – export a horizontal (Z) 
slice as a 2D surface grid

• Minimum/Maximum value depth surface grid – This option produces a 
2D band surface grid with one band representing the minimum or 
maximum value vertically in the voxel model, and the second band 
indicates the Z depth that this occurs in the voxel model.

The Data tab also allows the export of Voxel Models in the UBC format. The 
Export button (shown left) will open the Voxel Export Wizard.
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• Threshold top/bottom to surface grid – produces a 2 banded 2D 
surface grid, with a "top" and "bottom" band defining the Z value of the top 
and bottom extents of the thresholded model.

Isosurface to 3D vector file Using the Export Model Wizard

Voxel Model Export Wizard

The export options are:

• Voxel model to 3D vector or ASCII file - export the thresholded model to 
either a DXF vector of individual cells, or a UBC or XYZ model format.

• Single Horizontal depth layer to surface grid -  export a horizontal (Z) 
slice as a 2D surface grid

The Data tab also allows the export of Voxel Models in the UBC format. The 
Export button (shown left) will open the Voxel Export Wizard.
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• Minimum/Maximum value depth surface grid – This option produces a 
2D band surface grid with one band representing the minimum or 
maximum value vertically in the voxel model, and the second band 
indicates the Z depth that this occurs in the voxel model.

• Threshold top/bottom to surface grid – produces a 2 banded 2D 
surface grid, with a "top" and "bottom" band defining the Z value of the top 
and bottom extents of the thresholded model.

• Isosurface to 3D vector file – Export an Isosurface to a DXF vector.

• Isosurface slice – Export the intersection of an isosurface with defined X/
Y/Z slice planes.

• Slices to Images – Export the current slices to an 3D registered EGB 
images.

• Section Slices to vector files – Export the current Discover section 
slices to vector TAB files which are opened in the 2D Discover sections.

• Horizontal depth slices to surface grid – creates a multi-banded grid 
which has one band for each current Horizontal (Z) slice.

The Isosurface and Horizontal Depth Slice export options are only available if 
these rendering options have been applied to the voxel model. 

• Export an Isosurface to a DXF vector.

• Isosurface slice - Export the intersection of an isosurface with defined X/
Y/Z slice planes.

• Slices to Images - Export the current slices to an 3D registered EGB 
images.

• Section Slices to vector files - Export the current Discover section slices 
to vector TAB files which are opened in the 2D Discover sections.

• Horizontal depth slices to surface grid - creates a multi-banded grid 
which has one band for each current Horizontal (Z) slice.

The Isosurface and Horizontal Depth Slice export options are only available if 
these rendering options have been applied to the voxel model. 
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Voxel Model Information

Voxel Model Properties

The display of volume elements (voxels) in the Voxel Model is controlled by the 
properties of the Voxel Model branch in the workspace tree. Once a Voxel Model 
branch exists in the tree, double clicking it or highlighting it and right-clicking 
allows you to display the Properties dialog.

The property dialog for a 3D display is shown below:

Voxel Model Properties dialog

The Properties dialog uses different tabs to control various aspects of the voxel 
display. These are:

The Model Information button in the Data tab opens a text report which can be 
saved for the model geometery and properties. As well as checking to voxel 
mesh/cell size, this is also a useful tool for seeing the lithology layers included in 
the model.
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• File Tab – Used for access to the supported format models. Refer to 
Importing a Voxel Model.

• Appearance Tab – Used to enable and disable thresholding, colour fill, 
isosurfaces, slices and wireframing.

• Colour Tab – Controls the colour look-up table and the colour transform

• Lithology Tab – Specify a lithology table for colour mapping of attribute 
ranges of a voxel model.

• Clipping Tab – Control the interactive slicing of a model to view the 
internal distribution of the model’s attributes

• Chair Clipping Tab – Control the primary axis slicing to reveal internal 
attribute distribution in 3 dimensions

• Threshold Tab – Specify an upper and lower range of attribute vales that 
control which voxels are displayed

• Isosurface Tab – Nominate a data value that is used to create a 3D 
surface through the voxel model

• Offset Tab – This tab allows the entire model or just the upper surface to 
be offset to account for elevation and topography 

• Slices Tab – Controls the display, position and transparency of single or 
multiple slices.

• Voxel Model Display Properties – Properties of voxel models in curve 
profile and 2D map displays

Appearance Tab

The Appearance tab of the Voxel Model provides the following options:

• Enable thresholding of models.

• Show the look-up table for colour fill.

• Enable colour filling.

• Enable wireframing on the model.

• Enable isosurface creation with or without colour fill and wireframing.
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• Display slices at regular distances on any of the three axis directions.

Appearance tab of Voxel Model properties dialog

These controls are useful to quickly change a presentation from one style to 
another when you wish to retain various setting of the thresholding, isosurface or 
slice controls. For example, if you spend time setting the values and display of a 
threshold display (and wish to retain these), you can then switch to an isosurface 
display (by disabling the threshold display on the Appearance tab) and later return 
to the same threshold presentation (enable on the Appearance tab) without 
having to reset the control parameters. 

Examples of the above options are shown below:
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The various Voxel Model appearance settings

Clipping Tab

The Voxel Model display allows you to interactively slice the rows, columns and 
layers of the displayed volume. You can remove individual voxel slices in any of 
north-south, east-west or top-bottom directions. The clipping controls are 
available from the Clipping tab.
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Clipping tab of the Voxel Model Properties dialog

Enable the clipping process by selecting the Clip model option in the Clipping 
tab. For each of the Easting, Northing and Elevation directions, two slider bars 
are provided. So long as the Auto-Apply option is checked on, changes to any 
of the slider bars removes or makes slices of the model appear or disappear.
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Slice the mesh of the voxel model in any of the three principal coordinate directions.

The entire model is displayed if the slider bars for each direction are on opposite 
sides of their extent. Specific positions of slicing can be entered into the various 
entry fields if desired.

Clipping layers from the model reveals internal structure and intersecting drillholes.

The clipping operation either reveals or hides the various rows, columns or layers. 
No gradation of display is provided. Each row, column or layer is either displayed 
or not.
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Chair Clipping Tab

The Chair Clipping tab provided in Voxel Model properties dialog is an extension 
of the logic used for Clipping (see Clipping Tab). Chair Clipping enables clipping 
in any of the three primary coordinate directions (East, North and Vertical – X, Y 
and Z) resulting in a rectangular prism block being removed from the overall 
model shape.

The Chair Clipping showing a portion clipped in each coordinate direction

The Chair View provides a method of identifying patterns of the displayed 
attribute within the voxel model and visualising how these trends migrate through 
the volume. The various clipping in any of the three coordinate directions can be 
controlled from slider bars and updated automatically if the Auto Apply option is 
enabled in the Chair Clipping tab of the properties dialog. This dialog is shown 
below with a resultant Chair View.

Note This option is only available in 3D Displays.
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Chair Clipping of the model to reveal internal structure.

Chair Clipping can be used in combination with model clipping to further add 
interactive viewing control (see Clipping Tab).

When pressed, the Front and Back standard cuts button at the top of the Chair 
Clipping tab dialog will display the Select Chair Clip Type dialog as illustrated 
below. This dialog allows the selection of preset standard cuts in the three 
coordinate directions based upon a guiding plan of a voxel model. Use the arrow 
buttons to iterate through the standard cuts.
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Colour Tab

The Colour tab allows the colour and transparency of a voxel model to be 
modified. 

Select the data field to Colour modulate from the top pull-down list; this can either 
be a numeric field (such as a UBC Property file Maginv3D.sus) or the Lithology 
mode when handling discretised voxel models (i.e. voxel models comprising a 
number of unique lithological codes). 

If transparency modulation is required, enable the Transparency check box and 
select a data field from the adjacent pull-down list (transparency modulation is not 
available when in lithology mode).

Two tools are provided:

• A choice of Colour Table or Transparency Table 

• Transformation of the selected table with Colour Mapping or Transparency 
Mapping 

The Colour Properties tab to control the colour or opacity table and transform applied to a 
model
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Colour Table

Colour Scale dialog

Four methods of colour scale definition are available:

• RGB Interpolation interpolates between two colours in Red:Green:Blue 
colour space. 

• HSL Interpolation  interpolates between two colours in 
Hue:Saturation:Luminosity colour space.

The Colour Scale button to the right of the Tables colour bar opens the Colour 
Scale dialog which allows the creation and/or loading of colour tables.

Set the first and last colours of the colour scale by selecting the Colour 
Browse buttons at the bottom or top of the colour bar. When clicked, a 
standard Windows colour selection dialog is displayed allowing colour 
specification. These can be reset by clicking the Set Default Colours 
button.
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Windows colour selection palette

• Look Up Tables - the standard look-up table formats are supported and 
are installed as part of your Discover PA 3D installation. These can be 
created or edited using the Colour Table Editor.

• A Custom Legend created using the Legend Editor in Encom Discover 
PA or the Legend Editor in the Drillhole module of Encom Discover. This is 
of particular use for colouring Discretised voxel models created using, for 
example, a series of lithology/rock codes. 

Thresholded lithology voxels coloured by applying a custom legend table

Colour Mapping

The Colour Mapping button to the right of the Mapping colour bar opens the 
Colour Mapping dialog. This enables a range of Data Transforms to be 
applied to the previously selected colour table.
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The Colour Mapping dialog configured for an increasing logarithmic data transform, with 
bandpass cutoff limits set in data values

A preview screen of the data distribution is presented, with the Cumulative 
histogram displayed as a green line, and the applied data transform a red line. 
The colour distribution for the specified data transform is also displayed around 
the preview edges as colour bars. A spreadsheet displays transform inflexion 
points as a series of coordinates, where X is the data value and Y is frequency. 
The preview screen can be controlled using the buttons at the bottom left (Zoom, 
Pan, Fit view to data).

The following transform options are available in this dialog from the pull-down list:

• Linear (increasing or decreasing) - the transform linearly distributes 
colour between the minimum and the maximum data values.

• Log (increasing or decreasing) - colour is distributed logarithmically 
between the minimum and the maximum data values.

• Histogram - this transform produces an image with an equal amount of 
colour area across an image.
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• User Defined – having set one of the above transforms (with or without a 
bandpass cutoff), choosing this option allows the user to customise the 
transform curve. A series of inflexion points are displayed as black icons 
along the curve; additional control points can be added by placing the 
cursor over the transform and clicking when it changes to the Add Point 
cursor. Control points can be edited via the following methods:

• Clicking on a control point in the graph and moving it moves all 
control points in an elastic motion. This move is reversible; moving 
a control point and then returning it to its original position will return 
all other control points to their original positions. The editing mode 
compresses control points in front of the selected point and 
expands them behind the selected point. This mode allows quick 
modification of the shape of the transform curve whilst retaining the 
flavour of the original curve. 

• Clicking on a control point with the CTRL key held down and moving 
it moves the selected control point only. Points cannot be moved 
horizontally beyond the two adjacent control points. Directly editing 
a control point in the spreadsheet applies the same rules. This 
mode allows control over the exact coordinates of individual control 
points. 

• Clicking on a control point with the SHIFT key held down and moving 
it. This editing mode compresses control points in front of the 
selected point but does not modify control points behind the 
selected point. The same effect can be achieved by moving a 
control point in one of the colour bars.

Moving a control point horizontally is equivalent to moving a 
selected colour to a new data value. Moving a control point 
vertically is equivalent to moving a selected data value to a new 
colour. 

• Clicking between two control points in a colour bar and dragging 
moves the control points to the left and right of the cursor. The 
distance between these two points will not be modified but control 
points in front of the leading point will be compressed. Control 
points behind the trailing point will not be modified.

Moving a segment horizontally is equivalent to moving the selected 
colour range to a new data range. Moving a segment vertically is 
equivalent to moving the selected data range to a new colour range.
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Creation of a User Defined transform

For each of these options (except User Defined), a Bandpass cutoff can be 
applied either as percentage or data values. Bandpass cutoff limits are displayed 
as dashed lines in the preview screen. All data values outside the specified range 
will be assigned the minimum or maximum colour value and the colour stretch will 
then be restricted to the data within the bandpass.

Transparency Table

Note The Colour Mapping dialog is unavailable for voxel models in Lithology mode.

The Transparency Table button to the right of the Tables colour bar opens the 
Opacity Table dialog (this button is only active when the Transparency check-
box is enabled). Use this dialog to create a simple opacity table defined by one 
to four control points. A number of simple predefined tables are available which 
should cover the requirements of most users. The table is displayed graphically 
on a data Percentage vs. Opacity graph. This graph can be modified either by 
selecting and dragging the graph vertices (red crosses) in the graph, or manually 
altering the appropriate Percent and Opacity values to the right of the graph.
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Transparency Mapping

Lithology Tab

Discretised voxel models (where a series of unique attributes (e.g. rock or 
alteration codes) have been used to create the block model) can be coloured 
using an appropriate Colour Legend via the Colour Scale Selection dialog under 
the Colour tab. It is also possible to control and display individual attributed 
components via Lithology mode controls on either the Isosurface Tab or 
Threshold Tab. 

Displaying multiple lithology layers from a discretised voxel model (and drillholes)  with a 
Colour Legend applied. 

The Transparency Mapping button to the right of the Mapping colour bar 
opens the Opacity Mapping dialog (this button is only active when the 
Transparency check-box is enabled). The dialog is identical in content and 
controls to the Colour Mapping dialog above but is applied instead to the 
transparency option selected previously in the Opacity Table dialog.

In order to allow the Threshold and Isosurface tabs to display the attribute 
codes for individual layer control in Lithology mode (as pictured above), the 
appropriate Colour Legend must be loaded via the Browse button (shown left) 
under the Lithology tab. If a colour legend is not set, these dialogs will simply 
display a list of index codes (i.e. Index 1, Index 2, etc) instead of the appropriate 
rock/alteration codes.
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Colour Legend selection dialog accessed via the Lithology tab.

Threshold Tab

Thresholding of voxel models allows volume elements (voxels) to be displayed 
only if their specified attribute lies within the chosen data range. The tresholding 
feature operates in two modes:

• Lithology Mode –displays voxels with only predetermined data ranges/
unique attributes i.e. Discretised voxel models.

• Interactive Mode – Use slider bars to control the displayed voxels by 
dynamically altering the upper and lower data range.

Lithology Mode

The Lithology mode allows predetermined data ranges to be specified to named 
bands. These bands may represent rock types or attribute ranges relating to 
conductivity, magnetic susceptibility etc. When selected for display in the 
Threshold tab of the properties dialog, you can select which nominated lithology 
layers are to be displayed. All other voxels of the model remain transparent. To 
use this method of display, initially enable the checkbox labeled Threshold and 
then select Lithology from the pull-down list of items.

Note After you have selected the Colour Legend table, press the Apply button to 
ensure the changes are applied to the threshold/isosurface tabs.
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Lithology control of thresholding and viewing only those items selected

The Lithology mode allows a selected number of predetermined data ranges or 
attributes to be displayed. These may represent rock types or attribute ranges 
relating to conductivity, magnetic susceptibility etc. To effectively utilise this 
mode, ensure that an appropriate Colour Legend has been assigned in the 
Lithology tab. 

To access this mode, select the Lithology option from the top pull-down list in the 
Threshold tab, and tick the Threshold by option.

From the Lithology table listing provided, choose the lithology types to be 
displayed (and place in the right hand list area). If the Auto-Apply option is 
enabled, the items with the specified attribute ranges should immediately display.

From the Lithology table listing provided, choose the items to be displayed and 
move these into the right hand list area with the arrow buttons. If the Auto-Apply 
option is enabled, the items with the specified attribute ranges should immediately 
display.

Two Opacity modes are available:

• Normal – only the selected Lithologies are displayed; their grouped 
transparency is governed by the adjacent slider bar.

Note Using the Normal mode when applying lithology thresholds produces identical 
results to displaying lithologies as Isosurfaces. However lithological isosurfaces 
allow individual transparency control for each lithological layer and is thus the 
recommended option.
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• Cloud – the selected Lithologies are displayed opaque, whilst the 
unselected Lithologies are displayed with the level of transparency set by 
the adjacent slider bar.

Lithology control of voxel thresholding using cloud opacity

Interactive Mode

The interactive mode of thresholding allows you to dynamically specify an upper 
and lower range of data attributes and their corresponding voxels for display.

Note Applying a Colour Legend as a Colour Table is not recommended when using 
Cloud mode to display lithology thresholds, as it is very processor intensive 
(particularly colour legends incorporating patterns). Instead it is recommended to 
colour the voxel model using a standard LUT or RGB/HSL interpolation.

Note If you change from the Lithology mode to Interactive mode for the thresholding 
display, you may need to turn off the previously used mode by deselecting the 
Threshold by checkbox.



670 Encom Discover PA User Guide

To use this form of thresholding, initially enable the Threshold by checkbox and 
choose the attribute model name available in the drop-down list. When selected, 
two slider bars and two entry fields become available. With the Auto-Apply 
option on, if you move either of the upper range or lower range slider bars, the 
voxels displayed automatically vary. Operation of the slider bars also adjusts the 
upper and lower data values of the two entry fields. Conversely, you can enter 
specific values in these entry fields. 

Interactive voxel thresholding with normal opacity.

Two Opacity modes are available:

• Normal – only the Accepted Voxel Range is displayed, with its 
transparency governed by the adjacent transparency slider bar, or

• Cloud – the Accepted Voxel Range is displayed opaque, whilst the 
Rejected Voxel Range is displayed with the level of transparency set by 
the adjacent slider bar. In this mode you can ONLY adjust the rejected 
transparency – the accepted voxels are always opaque. This is why as 
soon as you reduce the rejected transparency from 100% (i.e. move the 
slider it to the left) the accepted transparency gets reset and locked to 0 
(ie opaque). An example of the Normal mode with Cloud mode is shown 
below:

.
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Normal mode thresholding plus Cloud mode to indicate the background outline of the voxel 
model

Isosurface Tab

Similar to threshold settings, the Voxel Model can be made to display a surface 
of a single attribute data value. The created isosurface positions the surface 
similarly to a contour map by examining the enclosing voxels and determining the 
correct location for each intersection point of the surface throughout the volume. 
It then triangulates these points and computes the surface. 

As for thresholding, the isosurfaces can be created using the:

• Lithology Mode – The isosurface is mapped by the data ranges of the 
lithological bands. Note that the created isosurface uses only the lower of 
the data range values.

• Interactive Mode – This mode allows a particular attribute value to be used 
to create the isosurface.

Note This option is only available in 3D Displays.

Note Ensure the Render thresholded voxel model option is disabled in the 
Appearance tab otherwise you may not be able to see the results of creating the 
isosurface as it may be buried within the thresholded or full model display.
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Lithology Mode

Displaying multiple lithology layers from a discretised voxel model as isosurfaces

You can remove a selected layer by using the Delete button. The Isosurface 
slider bar and entry field are inactive when in Lithology mode. 

To remove any satellite isosurfaces or smaller, insignificant isosurfaces click on 
the Show button and chose from the Show list of isosurfaces that are sorted by 
either Number, Surface Area, Easting, Northing, or RL.

To effectively display lithologies as individual isosurfaces, ensure that an 
appropriate Colour Legend has been assigned in the Lithology tab. Also setting 
this Colour Legend in the Colour Table button under the Colour tab allows the 
preset colours/patterns to be used. In the Isosurface tab select the ‘Lithology’ 
option from the top pull-down list and add as layer by clicking the Add button 
(shown left). To alter the layer, highlight it and select the required lithology entry 
from the Lithology pull-down in the middle of the dialog. 

Note Multiple lithology table entries can be added (as pictured beloww); the 
transparency of individual layers can be controlled via the Transparency slider 
bar.
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The isosurface Surface Selection dialog, allowing display control of individual omponents 
of an isosurface 

It is also possible to combine both Lithology and Interactive modes by adding 
layers derived from either the Lithology table or specific values of the model.

Interactive Mode

The interactive mode allows you to specify the attribute value of the isosurface. 
The created isosurface is also triangulated to produce a smooth surface of 
constant attribute value. Colouring of the surface is controlled by the property 
Colour tab.

Note Displaying lithologies (e.g. rock types) as isosurfaces is identical to displaying 
them as thresholds (see Threshold Tab), except that you can control each layers 
transparency individually as isosurfaces.

To create an Isosurface, select the required voxel model data (or properties) 
from the pull-down list. Click the Add button (shown left) and a default attribute 
value is added to the list. Additional values can be added if more than one 
isosurface is to be created. Once a layer is available, the Voxel Model displays 
a surface corresponding to the data value shown. You can use the slider bar, or 
enter a specific data value if desired. The display automatically updates if the 
Auto-Apply option is enabled. 
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Displaying multiple Property isosurfaces in Interactive mode

Using Wireframes

Occasionally it is useful to use wireframes instead of isosurfaces alone. 
Wireframing provides a means of seeing through one surface at a second (or 
other objects) that would otherwise be obscured. An example is shown below:

  
Two isosurfaces used with the outer one represented only as wireframed, the inner solid
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The wireframes also provide information about the control points used in the 
triangulation process to create the isosurfaces.

To apply wireframes to Isosurfaces, enable the Show wireframe option under the 
Isosurface rendering options of the Appearance tab.

Slices Tab

Displaying slices of the voxel model permits individual slices of voxel cells to be 
displayed. The slice locations, regularity and direction are controlled from the 
Slices tab of the Voxel Model Properties dialog.

Specifying the slices to be drawn, their direction and location.

The slices can be in the east-west, north-south or horizontal orientations. Specify 
a start, end and interval Step between each slice (in metres). The Step is 
incremented by interpolating the display colours of the intersected voxel cells. 

The Step setting determines the number of slices created in any direction. Note 
that if you set the Step value to be large (bigger than the dimensions of the 
model), only a single slice in the required direction is drawn. What this means in 
effect, is that with the Position slider located beneath each direction setting, you 
can move the slice interactively forward and back through your model. This is a 
powerful method of investigating the property distribution within a block model.

You can also specify a Transparency using the slider bar to view other 3D objects 
displayed in conjunction with the voxel model

Note This option is only available in its entirety for 3D Displays.
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To slice on any user-defined plane:

• On the Slices tab, select the Arbitrary option. This provides two methods 
for controlling the slice location/orientation:

• Cursor Plane: Enable and orientate the cursor plane to the desired 
slice orientation (see Cursor Plane). Then click Synchronize to 
capture the cursor plane parameters. Click Apply to display the 
slice.

• Manually: Use the dip, azimuth and slider controls in the Slice tab, 
or click the Configuration button. The configuration dialog allows 
more explicit definition of the arbitrary slice’s X, Y, Z, dip and 
azimuth parameters, including a dynamic preview window of the 
planes orientation.

Using the Arbitrary Slice Configuration dialog to set the location and orientation of a slice.

Offset Tab

Some voxel models have no information that determines their upper surface 
shape. Instead, they are composed of horizontal layers meaning that their top 
surface is flat. 

The Offset tab provides two options to control the offset of the voxel model.

• Add DTM offset – add Z offset values based on a specified grid, or
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• Add Constant Offset – allows constant offsets to be specified separately 
for the X, Y and Z values.

The Offset tab and defining a surface to alter the top surface

As well as offsetting the voxel model, you can also apply a scaling that can be 
used to exaggerate the vertical size of the voxel model. 

Note that the DTM offset from a grid or constant offset is only applied to the voxel 
mode AFTER the vertical (Z) scale (if activated) is applied to a Voxel Model i.e.

Z Final = Z initial scale + DTM Offset + Constant Offset

Therefore there may not be an obvious change in the final Z offset. To see a 
greater enhancement of the voxel model with respect to the DTM offset it is 
advised that you use the Scale tab options in the 3D Map Properties dialog to 
apply a Z scaling and then use the DTM offset in the Voxel Model Properties 
Offset tab dialog.

Voxel Model Display Properties

• Voxel Model Properties in a Curve Profile Display

• Voxel Model Properties in a 2D Map Display
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Voxel Model Properties in a Curve Profile Display

In a curve profile display a limited number of properties are available, although an 
additional tab dialog, called Data, is available, which is consistent with other curve 
profile data objects to allow the specification of associated dataset and line.

Voxel Model Properties available for a curve profile display.

In all curve profile displays only a voxel model slice can be displayed and the 
position of the slice is determined by the projected distance parameter of the line 
in the associated dataset specified in the Data tab dialog. The slice is limited to a 
vertical plane, centred on the line and parallel to it.

The slice can have a threshold applied to it using the Threshold tab dialog and 
can also be clipped in a X, Y or Z orientation using the Clipping tab dialog.

Example off a voxel model in a curve profile display.
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Voxel Model Properties in a 2D Map Display

In a 2D Map display a limited number of properties are available, which are suited 
to a two-dimensional display.

The offset page is retained in its entirety for compatibility with a 3D display.

You can display a single horizontal slice at a specified depth and voxel model 
clipping in the X, Y or Z plane can be applied. 

Slices tab dialog for a voxel model shown in a 2D map display.

The Threshold option allows the first occurrence of any voxels in a model that 
satisfy the threshold criteria, looking from the top downwards.

2D map display showing a voxel model threshold overlying a grid image of terrain.

The below table shows a summary of which voxel model properties are 
accessible in the three available display windows.
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Additional Voxel Display Features

Some additional features are provided for use with Voxel Models. These include:

• Multiple Voxel Model Displays

• Integrating Voxel Models With Other Objects

• Voxel Model Legends

Multiple Voxel Model Displays

In the Isosurface section (refer to Isosurfaces), multiple voxel displays showing 
the distribution of 2 or 3 voxel layers has been described. In this case, the multiple 
displays are derived from the same voxel model.

Using the Voxel Modeller within Encom Discover PA can also be used to display 
voxel displays from multiple model sources. This is useful particularly if you have 
results from different methods that need to be compared. For example, if a survey 
area has results from a gravity survey inverted and for the same area, a magnetic 
survey has been used to derive an inversion model, the model output results can 
be compared directly in the one display.

Similarly, if a model is prepared as a seed model for an inversion, this technique 
provides a method of directly comparing the seed model with the results 
computed from an inversion process using the seed model.

Property Tab 3D Display 2D Map Profile
File
Data

Appearance

Colour

Clipping

Chair Clipping

Threshold

Isosurface

Slices

Offset

Lithology
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In the section, Creating a Voxel Display it was shown how to insert a layer for a 
Voxel Model into a display window. To create additional Voxel Model layers and 
associate them with multiple models, the process is the same but extra Voxel 
Model layers are added to the Workspace tree.

The steps involved are:

1. Create the Curve Profile, 2D Map, or 3D Map and add a Voxel Model 
object to this as described in Creating a Voxel Model Display.

2. Select the appropriate model as described in Importing a Voxel Model. 

3. Repeat step 2 to add extra model levels.

Alternatively, once you have created the first Voxel Model Layer, you could select 
the Clone Voxel Model option instead of the Add option (highlight the 3D Map 
item and right mouse click to display the pop-up menu). This duplicates the same 
model that could then be reassigned to an alternative model if required.

The Workspace tree should appear similar to below:

Integrating Voxel Models With Other Objects

Once the Voxel Modeller display is used for importing and displaying models as 
described, you can commence taking advantage of the ability of Encom Discover 
PA to create powerful interpretational displays by integrating other display 
objects. Other object types supported include:

• Gridded surfaces

• Drillholes

• External 3D Graphics files such as .DXF format

• Flight path and survey locations

• Located bitmaps derived from scanned or captured imagery
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• GIS layers derived from MapInfo Professional or ArcView

• Models derived from third-party packages such as ModelVision, EM Gui 
etc.

An example of the complexity of display with integration that is possible with the 
Voxel Modeller and Encom Discover PA is shown here:

Display of drillholes, located bitmap, model and isosurface using the Voxel Model.

For information on importing and displaying any of these additional objects, refer 
to the relevant sections of this guide.

Voxel Model Legends

This object can be positioned and sized anywhere within the 3D display. The axis 
can be connected to the data and so obtain its colour from the displayed model. 
An example of a Floating Colour Bar is shown below:

A Floating Colour Bar can be added to a display window and referenced to a 
voxel model, allowing easily visualisation of the relationship between colours 
and numeric data ranges.
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Example of Floating Colour Bar with colour bar derived from a Voxel Model display

Note from the Workspace tree that a Floating Colour Bar branch is associated 
with the vertical colour bar of the axis. The connection of the bar can display 
colours or sizes and connect to different axes or layers individually. This 
connection is specified from the Content tab.

Controlling the Content of the Floating Axis

Controls of the size, title, centreing etc of the colour bar are specified in the 
Appearance, Title and Arrangement tabs. Their operation is identical to axis 
controls described in Axis Properties.
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Individual control for colour bars is controlled from the properties of the various 
Colour Axis branches of the Workspace tree beneath the Floating Colour Bar 
layer (see the tree above). Refer to Floating Colour Bar Properties for further 
information.

Voxel Display and Processing Tools

Apart from the Voxel Model display in Encom Discover PA some additional tools 
are provided to assist in creation and use of Voxel Models. These are:

• Array Builder – This utility is useful for datasets that may require arrays 
to be created from single data channel databases. Refer to the Build Array 
Field for details of its use.

• Array Data 3D Gridding – Voxel Models (in UBC format) can be created 
using this utility from databases that have survey data lines with arrayed 
data channels of depth and property (eg conductivity, resistivity etc). 
Examples of this are inverted databases from the processing software EM 
Flow. Refer to Array Data 3D Gridding for additional information.

• 3D Gridding Toolkit – This tool contains a number of gridding and 
manipulation tools. Various 3D Gridding options are available including 
discrete, continuous and distribution gridding. Other operations include 
the merging of 3D models, resampleing, convolution filtering and 
arithmetic combinations of models. Refer to Voxel Toolkit for additional 
information.

• Depth Interpolator – This module is used to provide interpolation of data 
to account for topography in situations where layered output of software 
(such as EM Flow) is affected by elevation. See Depth Interpolation.

• Voxel Slice Generator – A processing utility to create a series of located 
images from a voxel model for rapid display. Only the UBC model type can 
use this utility. See UBC 3D Model to Geosoft GDB.
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22 TrackMaps
In this section:

• About TrackMaps

• Creating a TrackMap

• Rotated Raster Images

About TrackMaps

TrackMaps are profile tracks with a located image used as a backdrop. The 
TrackMap object is identical to a 2D map displayed within a track. The difference 
between a 2D map is that the TrackMap knows about which data line is being 
used and can be updated using the line navigation tools of Encom Discover PA. 
The scaling of a TrackMap is isotropic, that is, the same in the vertical and 
horizontal directions.

An example of a TrackMap display is shown below:

TrackMap example showing the flight path location over a scanned image and over a map 
of the magnetic response

In the above example a number of valuable interpretational features about the 
TrackMap module can be shown:
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• The traverse of the selected profile (shown in the top two tracks) can be 
configured to show in the bottom two tracks

• TrackMap tracks (the bottom two in the above example), can have 
different background images

• The TrackMap track can be combined with other profiles or sections. The 
TrackMap track has all the display attributes of a normal profile. It can be 
sized vertically and scaled horizontally for hard copy purposes

• The background displayed in a TrackMap uses an RGB raster image file 
(such as ER Mapper or GeoTiff)

• TrackMap track display is isotropically displayed. That is, the vertical and 
horizontal scaling is identical such that no distortion to the image is 
introduced.

• The orientation of the traverses of a TrackMap are irrelevant. The 
TrackMap module automatically resamples the background image as 
required to position the traverse and display the image. If the image or 
traverse are rotated, the program extracts and rotates only the required 
swath of image necessary to display the selected track.

• Positioning a cursor in a track indicates the location of the point in 
adjacent tracks (including the TrackMap tracks) plus any linked maps

• Data zooming of any of the profiles causes all tracks to zoom and pan or 
smooth scroll

• Profiles used by TrackMap obey the same rules for flight line navigation as 
other profiles. For example, you can use the Line Iterator toolbar, 
graphical line selection from a flight path map or line selection from line 
lists.

Creating a TrackMap

A TrackMap uses a raster file for its backdrop image. Raster images have Red, 
Green and Blue (RGB) format as used by ER Mapper and GeoTIFF. Raster 
images result from scanning maps (geology, topography, cadastral etc) or by 
using the capture option within Encom Discover PA or other applications.

• Creating a Raster Image

• Adding a TrackMap Display
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Creating a Raster Image

Within Encom Discover PA, a map can be saved as a raster by displaying the 
pop-up menu (position the Pointer cursor in the map and select Save as RGB 
Raster menu option.

The pop-up menu for a 2D map to Save as RGB Raster image.

Any RGB image format can be used but ER Mapper multi-band format is ideally 
suited. 

The option of capturing a raster of a displayed map is especially useful since you 
can configure the map and displayed image as required with contours, 
annotations and related data simply and quickly.

Adding a TrackMap Display

The TrackMap object is created by adding it to a Profile branch in the Workspace 
tree. 

The steps required to add a TrackMap are: 
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Step 1

Access the database required for use with the TrackMap. Assume a scanned or 
raster image of the area is already available. If it is not, refer to Creating a Raster 
Image.

Step 2

Create a Profile display from the File>New>TrackMap or Document Wizard. 
Configure the profile with the required data line and with data as required.

Step 3

Highlight the Profile Frame branch of the Workspace tree and click the right 
mouse button to display the pop-up menu. Select the Add>TrackMap option. A 
new branch is added to the Profile and a new track containing a TrackMap for the 
originally displayed traverse is shown.

Step 4

Display the properties of the TrackMap. The dialog has two tabs. Ensure the 
Data tab displays the appropriate database and data line. Select the TrackMap 
tab and using the Open button, navigate and access the required raster image 
file.

Note As described above, the raster file to be accessed should be in RGB format, as 
supported by ER Mapper or GeoTiff..
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The TrackMap raster file specification dialog

The parameters of the dialog allow:

• Grid File specification – Open the RGB image file

• Flight Line – Within the TrackMap a flight line path is drawn by default. 
This can be disabled or the appearance of the trace can

Rotated Raster Images

The orientation of the traverses of a TrackMap are irrelevant. The TrackMap 
module automatically re-samples the background image as required to position 
the traverse and display the image. If the image or traverse are rotated, the 
program extracts and rotates only the required swath of image necessary to 
display the selected track. 

• RGB Bands – You can choose which bands to use for assigning the 
Red:Green:Blue colour. The Information buttons display grid coverage 
and data ranges of the selected image file.
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In some circumstances the raster image file (especially for high resolution, 
scanned images) can be very large. When this occurs, the resampled TrackMap 
result, especially for a rotated image, may be poor. This loss of quality results 
from the need to store the entire image in memory before the required portion can 
be extracted. On machines with low memory availability, the problem is worse 
due to image cell decimation. 

To restore the image to a higher resolution (even on machines with low memory), 
you can alter the default resolution used by images.

This is done from the Tools>Options menu item of Encom Discover PA. The 
dialog displays the General tab. Set the Grid Loading Columns and Rows 
thresholds that cause grid loading decimation to occur to be larger than the 
default (2,000). Usually a value of about 8,000 x 8,000 is sufficient to retain the 
TrackMap resolution.
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Dialog to modify the grid decimation threshold for loaded images.
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23 EM Decay Curves
In this section:

• The Decay Tool

• Banded Data

• Frame Properties

• Decay Curve Properties

• Curve Fitting

• Decay Display

• Decay Legend

• Line Navigation in Decays

The Decay Tool

Encom Discover PA contains an interactive display tool for the presentation and 
analysis of multi-banded data called the Decay Tool. Typical use of the Decay 
Tool is with time domain EM geophysical data. The Decay Tool is controlled by 
the Decau Curve toolbar as shown below:
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Decay Tool display in Encom Discover PA

Characteristics of a decay display are:

• The decay curve display area, by default, displays a reading decay across 
the time channels with a time axis along the base. Also displayed are the 
Exponential or Power Fits (if enabled).

• Control of the Decay area is made from the Properties dialog accessed 
from the Decay Curve branch of the Workspace tree.

Important The Decay Tool is directly related to a profile of data that contains multi-band 
time-related data fields. A decay display is only presented when a multi-banded, 
time related EM dataset is contained in a Profile within a document and a 
particular reading is selected by the Select/Navigate cursor . This selection 
informs Encom Discover PA which reading to use in the decay display. As the 
cursor is moved, the decay curve display window updates.

Movement of the cursor in the profile window updates the decay display in real-
time. If a more controlled location of readings is required, the backward and 
forward arrows located in the Decay toolbar can be used
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• The legend information has separate Properties and again is accessed 
from the Decay Legend of the Workspace tree.

Banded Data

In Encom Discover PA, banded data and especially banded geophysical EM data 
can be displayed and analysed. For time domain EM, this form of data has 
channels in the various bands that are representative of time delay windows. 
Each channel represents a period of time in which received data is recorded from 
an EM sensing receiver. As Encom Discover PA has some operations that can 
make use of the time information for analysis operations (for example, the decay 
analysis tool), a file called ATEM.TXT is used to define the time channels.

The format of an ATEM.TXT file is provided in Appendix B: Data File 
Specifications.

Frame Properties

The Decay Curve Frame Properties dialog displays standard Axis, Options, 
Appearance, X Scale and Y Scale tabs (see Profile Frame Properties). In 
particular, if scaling of axes is to be altered (as is often the case with decay tool 
analysis), the X and Y Scale tabs can be used.

Decay Curve Properties

The properties of the main Decay Curve branch of the workspace tree contains 
the following tabs:

• Data Tab

• Decay Tab

• Line Style Tab

• Symbols and Label Tab
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Data Tab

The Data tab is used to specify the Dataset, line, data field and measurement 
component (if it exists).

 
Data tab

When the appropriate data, data channels and line are specified (component is 
not mandatory), you can select the required data channels to be used in the 
display and any subsequent curve fitting.
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Decay Tab

The Decay tab is used for control of decay data and controls the presentation of 
exponential or power law data fits.

Decay tab

You can specify which data curves to display. Also displayed are the fit 
parameters derived from the decay fit over the channel range specified in the 
Data tab.

Line Style Tab

Different data curves can be displayed concurrently for each reading along a 
profile. The curves available include:

• Decay curve

• Positive decay

• Negative decay

• Exponential decay

• Power Law decay

Each of the curve types can be displayed or disabled. Use the pull-down curve list 
to select which trace is to be modified in this tab. Individually, you can also control 
the curve colour, thickness and line style (solid, dotted or dashed).
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Controlling which decay curve is to be displayed and its style

The fit parameters are also shown in the Status Bar as the selection in a profile is 
changed.

Symbols and Label Tab

Two tabs to control the symbols and labels of curves in a decay curve plot are 
provided. The operation and functions of the controls in these tabs is identical to 
that of profiles (refer to Profile Display Symbols Properties and Labels 
Properties).

Curve Fitting

Fitting of decay curves occurs over a defined channel range specified in the Data 
tab. By default, Encom Discover PA initially selects all available channels, 
including channels with values that may be negative.

Fits based on the nominated channels can be either Exponential or Power Law. 

Exponential Fits

The exponential response of electromagnetic data is given by:

 
tautkeresponselExponentia /_ −=
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where k is a computed value determined by the intercept of the least squares fit 
of the selected channels. Parameter t is the relevant delay time for each time 
window used to compute the fit. Values derived for Tau (Time constant) and Y 
axis intercept (at time zero) are displayed. Additionally, the Root Mean Square 
(RMS) is also estimated.

Power Law Fits

The power law response of electromagnetic data is given by:

 

Values derived are Power (a) and Y axis intercept (at time zero). The Root Mean 
Square (RMS) is also displayed.

Decay Display

The decay display presents the decay over the available channels for individual 
readings only. The specific reading chosen is indicated:

• By a vertical cursor in the profile window associated with the decay.

• By an updated entry in the Status Bar showing flight, line and location (see 
below).

 

Decay Legend

A decay legend can be placed anywhere in the decay display. Each entry of the 
decay legend is linked to changes made in the reading position. 

Curve toolbar available. Select the Add Legend button from the Decay Curve 
Toolbar and once clicked, move the cursor into the Decay Curve plot. Position 
the legend where you wish, click and hold the left mouse button and drag an 
area for the legend. When you release the button, the legend is populated with 
the data for the selected data reading (line, location, tau, fit etc).

aktsponsePowerLaw =Re_
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Decay Curve legend and associated annotation

Each legend text entry has individual properties that can be specified from the 
Decay Legend branch of the Workspace tree. Items that are graphic (non-text) 
have no accessible properties but are controlled by the settings of the Line Style 
tab.

To edit or examine the properties of any of the text items of the legend, position 
the cursor over the item and click it. Selection handles are placed around the text. 
Once selected, by right clicking, a Properties pop-up menu can be selected. If you 
have difficulties selecting the text item, press the CTRL key at the same time as 
clicking the left mouse button.

Text Properties dialog for the decay legend

The text content can be modified in the text entry field. Font, position, rotation and 
alignment information are detailed at the base of the dialog. You can reposition 
the text, if desired by modifying these controls.
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Line Navigation in Decays

In the Decay Tool, you can individually select the line to be displayed by:

• Using the Line pull-down list in the Data tab of the Decay Tool properties 
dialog.

• The Line Iterator (refer to the Line Iterator Tool) can be used to navigate 
individual lines

• Flight Map selection is available.

Where more than one line is displayed in a Profile window of the associated 
decay, readings displayed in the decay and legend are updated automatically if 
the cursor is moved from the graph of one line to another.



24 Display Utilities 703

24 Display Utilities
In this section:

• Options – default settings for the operation of Encom Discover PA.

• Image Registration Wizard – utility for geo-referencing an image such as a 
map or geological cross-section.

• Georeferenced Image Export – create a located image (.EGB) for a slice 
in the 3D view specified by the clipping plane.

• Grid Flipper – interpretation tool for comparing features in grids and raster 
images.

• 3D View Manager – allows the creation and use of custom viewpoints in a 
3D display.

• 3D Animation and Fly-Through – creates a movie by recording transitions 
between view positions.

• Drillhole Planner – dynamically position and plan new drillholes in a 3D 
environment.

• Seismic Depth – direct access to SEGY seismic files for velocity modelling 
and conversion into a format supported by Encom Discover PA.

• Section to Map Utility – convert a series of vertical section profiles to 
located images in plan view. 

• Coordinate Reprojection – interactively convert points between any two 
coordinate systems. 

• Colour Table and Legend Editors – utilities for creating or editing colour 
look-up tables and legend tables.

• Tube Shape Manager – manages the appearance of data lines when 
displayed in 3D as tubes.

Options

The Tools option provides access to the Options properties plus a number of 
utility programs. The Options item allows default settings for Encom Discover PA 
to be maintained.
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The default Options Property dialog

Options that can be specified include:

• Paths for data, templates, components, sessions and feature databases

• Default page size (in the absence of an installed printer)

• Grid decimation

• Preferred view options

• Specific file locations and project directory definition

• Global data directory specification

• Line iterator controls

• Line orientation preference by envelope of angle

• Default geodetic settings (projections and spheroids etc). Refer to Map 
Projections.

• Default printer page size and orientation

• System template defaults

Other applications such as Colour Table Editor, Legend Editor and Customise 
menu items are described in their relevant sections.

Specific controls available from the Options tab dialogs include:
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• Line Orientation

• Page Setup

• Templates

• Size Settings

• View

• Database

• Files Locations

• Setting the Global and Project Directories

Line Orientation

The Line Orientation tab allows control of the orientation of profile drawing in 
situations where lines are oriented such that they could be plotted in reverse-
sense when close to southwest-northeast or northwest-southeast. In these cases, 
the azimuth of the lines (close to 45 or 225 degrees) can plot such that north or 
east is to the left end of the profile. To overcome this line orientation difficulty for 
these surveys, increase the East-West angle envelope.

Line Orientation tab of the Options dialog
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Page Setup

The Page Setup tab of the Options dialog provides support for default printers 
when Encom Discover PA is connected or remote from printers or plotters. This 
default sets the automatically displayed page when a Page Layout display is 
presented. The layout may alter depending if Encom Discover PA can find the 
specified drivers for the defined printer/plotter. If these Windows drivers cannot 
be found on the machine, the Windows default printer settings are used. 

To modify the printer default setting for Online printers, select the Page Setup 
button.

Page Setup tab of the Options dialog

Templates

Encom Discover PA operates by using templates to display the various 
presentation formats. A set of default templates are provided within the software 
to this and they have reasonably universal settings to appear with maps, profiles 
etc as they do. However, you do not have to use these system defaults. You can 
define your own templates for basic maps, sections, profiles etc. This is done from 
the Default Templates tab of the Options dialog (Tools>Options).
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Options tab to default templates

To specify an alternative template, select the display item to be modified, click the 
Modify button and path to the required template of your choice. To revert to the 
system supplied default template, again select the item and click the System 
Default button.

Size Settings

The Size tab allows the default size settings for raster grids and bitmap images. 

With Raster Grid images the maximum size (in columns and rows) allowed for a 
grid file to be loaded into Encom Discover PA can be specified and then the 
decimation for 3D rendering of this image can also be specified, according to the 
user operating system. 

Loading Max Columns - Maximum number of columns in a grid which will be 
used to load the grid into system memory. If the grid exceeds the column number 
Encom Discover PA will use large grid handlers to load the grid into Encom 
Discover PA. It is recommended that only small grids e.g. <50 MB are loaded into 
system memory and large grids e.g. >50 MB employ the large grid handlers.

Loading Max Rows - Maximum number of rows in a grid which will be used to 
load the grid into system memory. If the grid exceeds the row number Encom 
Discover PA will use large grid handlers to load the grid into Encom Discover PA. 
It is recommended that only small grids e.g. <50 MB are loaded into system 
memory and large grids e.g. >50 MB employ the large grid handlers.
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Rendering Max Columns - Maximum number of columns in a grid before the grid 
will be decimated for display in Encom Discover PA Display Window. Decimation 
is employed to reduce the system overhead and speed up the refresh rate of the 
3D Display Window. The decimation will only be used when surface compression 
mode is set to Constant and the level of decimation is set to System size, refer to 
Surface Compression in the View Surface Images section of the Three-
Dimensional Displays chapter for more details on compression.

Rendering Max Rows - Maximum number of rows in a grid before the grid will be 
decimated for display in Encom Discover PA Display Window. Decimation is 
employed to reduce the system overhead and speed up the refresh rate of the 3D 
display window. The decimation will only be used when surface compression 
mode is set to Constant and the level of decimation is set to System size, refer to 
Surface Compression in the View Surface Images section of the Three-
Dimensional Displays chapter for more details on compression.

The Size tab in the Options dialog

The Texture Size refers to the default resolution setting for images created in a 
Encom Discover PA session. The maximum size specified is typically limited by 
the users installed graphics card.

Normal texture size - Pixel resolution of rendered surface in Encom Discover PA. 
When a surface file is imported into Encom Discover PA the display is actually 
composed of a bitmap image, the resolution of the bitmap image is determined by 
the normal texture size setting, a higher resolution setting the greater the detail, 
however, the slower the refresh rate of the 3D Display Window.
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Maximum texture size - Pixel threshold set for a georeferenced image imported 
into Encom Discover PA, before the image will be tiled. If a georeferenced image 
does not reach the maximum texture size a single image drape is displayed. If a 
georeferenced image imported into Encom Discover PA exceeds the maximum 
texture size a series of seamless image tiles will be created. Tiling an image is 
generally conducted due to limitations in graphics cards and allows the display of 
very high resolution images in the 3D display window. Generally, set the 
maximum texture size to 1024 as most graphics card support this texture size.

View

The View tab provides the user with control over when property dialogs and 
spreadsheet windows appear plus other data panning and zoom options. 

The View tab also controls the appearance of the 3D Compass object, the 
number of Undo operations and advanced Line Iterator Options, such as line 
movement, behaviour when cloning and changing lines the distance selection 
controls.

  
The View tab dialog with the Line Iterator properties dialog
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Database

The Database tab dialog of the Options dialog

The Database tab controls the use of GITMAP generation in a loaded Geosoft 
database. The GITMAP field usually contained in a database allows Encom 
Discover PA to recognise that lines in different databases are the same line. This 
is done by recording a “primary” line index if the same line is found multiple 
databases. When Encom Discover PA knows about this GITMAP field it allows 
the user to plot data from different datasets in profiles and sections of a single line. 

If a GITMAP field is not included in a database then the default selection in the 
Database tab of the Options dialog of “Make GITMAP” should solve this problem. 
The default option to “Make GITMAP” by using line names AND Line Geometry 
should account for the majority of databases loaded into Encom Discover PA 
however sometimes if lines of one database begin or end at a different location to 
lines in a second database, even though these are in fact the same lines then the 
“Use Line Names” option should be selected.

Some users already have the GITMAP defined in the databases and so the Use 
Defined GITMAP should be selected. Most users will not have this defined 
already so the Make GITMAP option should be selected.  

Note The GIT library only supports station rate data and does not allow for variations in 
station rate sampling so Encom Discover PA does not currently support this type 
of data.
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Files Locations

The File Locations tab permits frequently used files and directory locations to be 
defined. The dialog lists the various file types specified for frequent and specific 
use.

The Global Directory is used to open project files such as databases, surface 
grids and feature databases. Refer to Setting the Global and Project Directories 
for additional information.

File Locations tab of the Tools>Options menu item

To alter any of the specified file location pathings, select the item by highlighting 
the File Type and then click the Modify button to reset the navigation path.

Setting the Global and Project Directories

Encom Discover PA can use either a Global Directory or a Project Directory to 
access data. The Global Directory determines the folder that is automatically 
navigated to when a file of any type is opened. The Project Directory can be used 
when working on files in a specific project folder.

By default, this location is updated to be the location of all subsequent file 
locations until it is changed by:

• Opening any data file in a different folder with the Use Global Directory 
for all file locations option enabled
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• Selecting the Global Directory in the File Locations tab of the 
Tools>Options menu item and clicking the Modify button.

The dialog used to control the Global Directory is located on the File Locations 
tab of the Tools>Options menu item (see above). You can reassign the Global 
Directory or Project Directory at any time.

For additional information, refer to Preferred Directory Access.

Image Registration Wizard

The wizard is used when images (such as a scanned section or airphoto) already 
exist and require their locations to be defined for use in other displays. Note that 
single or multiple images can be used with this wizard. For example if multiple 
geological sections were scanned and need to be located, this wizard can create 
a single .EGB file to display the multiple bitmaps.

Step 1

After selecting the Tools>Image Registration Wizard option (or Wizard button), 
an introductory screen is presented. Click the Next button to progress to the 
second dialog. Select the bitmap files required to be defined as Located Images. 
The files are added to the screen as shown below:

Note If you wish to specify a project directory for use but sometimes want to access 
files from different locations, define the Global Directory but disable the Use 
Global Directory for all file locations option. This allows the Global Directory 
to always remain at the defined folder but does not prevent you accessing files at 
different locations.

The .EGB files used to locate and define associated bitmaps of Located Images 
(see Appendix B: Data File Specifications) can also be created by a wizard 
provided in the Tools>Image Registration Wizard menu option or from the 
Wizard button associated with the properties dialogs of Located Images. 
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Image Registration Wizard screens 1 and file selection screen 2

Step 2

With the image files chosen, click the Next button to access Screen 3. This screen 
allows entry of the corner points of the images. If the bitmap is rectangular in 
shape and to be displayed on a flat plane, then opposite corners have the same 
X/Y and Y/X coordinate combinations. In this case, only two corners need be 
defined (botton-left and top-right). If the bitmap is to be displayed as inclined or 
non-planar, then you need to specify each corner point easting (X), northing (Y) 
and elevation (Z). Enable the Display of coordinate entry fields to enter the four 
corner points. The elevation of the corner points relates to the absolute reference 
level that the image is displayed in the 3D display. 
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Screen 2 of the Image Registration Wizard

When you have completed specifying the first bitmap, click the Next button. This 
screen cycles through each of the included images of Screen 2. To assist in 
defining their location, the corner coordinates are retained from the previous 
image entries.

To interactively specify coordinates for an image press the associated button at 
the bottom of this dialog to view the Advanced Image Registration dialog. This 
dialog allows you to specify the coordinates for any known location within the 
image using the interactive map. Press the Add coordinate button to select a 
location on the image, which will then automatically enter pixel coordinates into 
the table above. Then manually enter the XYZ coordinate values into the cells of 
the location.
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The interactive Image Registration dialog allows you to enter coordinates for any known 
location for an image.

Step 3

Screen 3 of the Image Registration Wizard requests you specify the .EGB file 
and path name. You can use the Open File button to navigate to a suitable 
location and name the file. When completed, click the Finish button to create the 
.EGB file for the Located Image(s).
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Output the EGB file for use in a 3D display

Georeferenced Image Export

The Georeferenced Image Export tool allows the user to create a located image 
(.EGB) for a slice in a 3D Display window, which has been specified by the 
clipping plane for any arbitrary position. 

This is useful for capturing a view to be used in another 3D display, a profile 
display or simply an image capture for a report.

The Georeferenced Image Export tool is accessed from the Tools menu. When 
selected the below parameters are available.:

• Image Plane Definitions

• 3D View Options

• Raster Image

• Georeferenced File
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The Georeferenced Image Exporter utility.

Image Plane Definitions

Image Plane Definitions of the Georeferenced Image Export utility.

The Origin, Inclination, Bearing, Clip and Clip width parameters are 
automatically populated based upon the Cursor Plane properties set prior to 
opening this utility. These can however, be edited from this utility.

3D View Options

Note If there is a voxel model in the view then the cursor plane will have to be 
synchronised with the voxel model arbitrary slice feature in the Voxel Model 
Properties.

Preview – view a preview of the located image that will be generated.
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Raster Image

Raster Image options of the Georeferenced Image Export utility.

The Raster Image options allow the specification of the image resolution, the 
accompanying image file format and the DPI setting.

Georeferenced File

Georeferenced File options of the Georeferenced Image Export utility.

The georeferenced file options provide simple options for what accompaniments 
will be captured with the image from the 3D display, whether the output will be 
automatically opened into the same 3D display and the file name and location of 
the output. 

To create the output georeferenced image file press the Apply button once the 
above parameters and output file name and location have been specified.  If the 
Automatically open exported image option is enabled then the output located 
image file will be opened automatically into the current 3D display.  

Flip View – view the 3D display from "behind" the 3D model and looking back 
towards the original viewing position.

Reset – reset the orientation of the 3D Cursor Plane to be 0 inclination and 0 
bearing. 
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Original 3D display consisting of 3D drillholes and a voxel model slice. 

Resultant georeferenced image of original display viewed in 3D. 

See also:
...3D Cursor Plane
...Voxel Model Properties
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Grid Flipper

During interpretation it is often necessary to compare images from one data 
source with another. Encom Discover PA provides a method to do this quickly and 
easily. It allows any number of images to be loaded in a Grid surface and then 
cycled using a tool commands to rapidly replace one image with the next. Grid 
flipping can function for both 2D and 3D image displays.

To flip a grid:

1. Create an image layer in a map and add two or 
more surfaces to the image. Any of the ER 
Mapper, RGB or Pseudocolour algorithms can be 
used. If contours are to be used, they can (and 
should be the uppermost layer in the tree). They 
are not flipped but are always displayed.

2. You need to have the Workspace tree visible but 
you don't need the Grid Group Properties dialog 
open. 

3. From the Tools menu, select the Grid Flipper option. A small toolbar is 
displayed. The toolbar controls whether the grid images are to be cycled 
through their display from the Activate/ Deactivate button. The 
Deactivate button name must be shown for the grid flipping to be enabled. 
The name of the displayed grid is shown in the pull-down entry. Using the 
pull-down list to select an image, displays the selected image. 

The Grid Flipper dialog in Manual mode

4. To rapidly cycle through the grid displays manually, select the Manual 
Grid Flipping Mode button and click on the blue Left or Right arrow 
buttons.
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The Grid Flipper dialog in Continuous mode

The grid flipping tool is available for both two-dimensional and three-dimensional 
maps.

Encom Discover PA stores all grids in memory to provide a responsive interactive 
interpretation system. You may choose to have many grids loaded and this may 
cause you to exceed physical memory. Large grids may be decimated at load 
time to improve performance. ER Mapper algorithms can process any sized 
images supported by ER Mapper.

3D View Manager

Allows the creation and use of custom viewpoints in 3D displays. A full description 
of the operation for this tool is provided in 3D View Manager

3D Animation and Fly-Through

This tool of Encom Discover PA is a powerful means of creating animation of 3D 
displays. A full description of the operation for this tool is provided in 3D Animation 
and Fly-Through.

Drillhole Planner

Encom Discover PA provides the powerful capability to dynamically position and 
plan new drillholes directly within the 3D environment. This allows the user to 
target 3D objects such as voxel isosurface grade shells, extruded quartz veins, 
.DXF solids (such as alteration zone volumes generated from digitised section 
boundaries) or feature object interpretations.

5. To flip through the grid images automatically select the Continuous Grid 
Flipping Mode button and then choose the units for the cycle rate from 
the drop down list on the far right of the dialog. Choose between seconds 
per frame (spf) or frames per second (fps), where the latter is the faster of 
the two cycle rates. Then enter the value for this unit from the drop down 
list to the left of this.
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The Drillhole Planner is accessed from the Tools menu of Encom Discover PA. 
You need an Encom Discover PA Professional licence to use this tool.

• Planning Drillholes in 3D

• RL or Z Value Assignment

• Drillhole Types

• Targeting Example

• Drillhole Planner Projects

Planning Drillholes in 3D

1. Open all required targeting data into the 3D window (e.g. existing 
drillholes, grade shell (voxel model) isosurfaces, mineralisation solids, 
etc). 

Use the View in 3D menu option to display a grid in 3D as a located image.

2. If a topographic/DEM grid is to be used for collar positioning, display this 
in 3D as a located image; in a 2D map display open the DEM grid as a 
Grid surface, and use the pop-up menu (right mouse click) from the Map 1 
branch of the workspace tree to choose the View in 3D menu option to 
capture a view of the grid draped over itself (capture dialog pictured 
above). In 3D, alter the transparency of this image to 40 or 60%.
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3. Create a new Feature Database by selecting the Create option from the 
Features menu. When prompted to enter a name for the Feature Set 
enter DHPlanner_Collars. The collar and survey information will be 
stored in this database before the data is finally converted to MapInfo 
.TAB files for displaying as drillholes. Add the DHPlanner_Collars 
feature set to the 3D window containing the located image grid and other 
targeting data and make this set editable (select the editable “pencil” icon 
located next to the branch of the feature set in the workspace tree.

4. While still in the 3D window, open the Tools> Drillhole Planner menu 
option.

6. Set the required Dip Sense (i.e. whether down dip is negative or positive) 
and Drillhole Units (default metres)

9. The New Drillhole dialog will open, with a default Hole ID ‘DH1’ populated. 
Change this if required and press Create. The new hole will be listed in 
the Drillhole Planner dialog, with various default attributes.

5. Use the New button to create a new Drillhole Planner Project to add the 
new drillholes to. Specify a project name and location. This will eventually 
create two files: a projectname_collars.TAB and 
projectname_surveys.TAB.

 

7. If the Cursor Plane has not already been enabled click on this button in 
the Cursor Plane toolbar. If using a located image of the grid to nominate 
Z values for the collars click on the select “arrow” icon next to this located 
image branch in the workspace tree and then click on the Bond to Image 
button in the Cursor Plane toolbar.

8. Use the 3D Navigation cursor controls to orientate the view to the first 
proposed drillhole location and press the Create button in the Drillhole 
Planner dialog.
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10. The drillhole can be ppositioned either: 

• Manually by entering the Collar X & Y coordinates (and Z value if 
no grid was imported in Step 2 above). Press the Apply button to 
visualize the planned hole location (a point symbol will be added to 
the Feature Database)

11. Select the hole Type as either Straight, Constant Deviation or Variable 
Deviations. Drillhole Types are discussed fully below; this example will 
use the straight type.

12. Manually enter the desired Azimuth, Dip and Total Depth values. The 
current view direction bearing and inclination is displayed at the bottom 
right of the 3D window in the status bar; this can be used as a guide to the 
required azimuth and dip parameters.

13. Press the Apply button at the bottom of the dialog to create the drillhole. A 
new Drillholes object will be added to the workspace tree, called 
projectname_collars (i.e. the project name specified in Step 4), and 
the planned drillhole will be displayed. 

14. If any aspect of the drillhole is incorrect, modify as necessary in the 
Drillhole Planner (e.g. Total Depth/Azimuth/Dip) and press Apply again to 
recreate the hole.

15. Repeat steps 8 to 14 for each additional drillhole required.

RL or Z Value Assignment

Z or RL values can be assigned to your planned drillholes in 3 ways:

• By utilizing a topographic/DEM grid imported as an image, as detailed in 
Step 2 of the Planning Drillholes in 3D. When the Create New Point 
Feature button is used, the drillhole location is snapped to the image and 
therefore uses the images Z value (i.e. the Z value of the grid the image is 
draped over). 

• Dynamically by pressing the Create New Point feature button on 
the Drillhole Planner dialog, and clicking on the desired location in 
the 3D window with the Select/Navigate cursor (see left). If no 
topographic grid was imported (Step 2 above) the collar Z value will 
need to be manually entered. A point symbol will be added to the 
Feature Database called DHPlanner_Collars. The hole location 
can be then manually edited or dynamically repositioned again 
using the Create New Point feature button.
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• Manually by entering the required value in the Collar Z field. This also 
allows an existing Z value (e.g. one captured using a grid in first method 
above) to be modified

• By specifying an alternative grid from within the Drillhole Planner dialog 
via enabling the Use surface for collars option. This allows grids that 
have not been imported into Encom Discover PA to be utilized for the Z 
value. When using the Create New Point Feature button, Encom 
Discover PA will first determine the XY coordinates of the selected point 
on the horizontal cursor plane, and then determine the Z value for the 
selected grid for these coordinates. Therefore the most accurate way of 
dynamically capturing a point location for this method is to use the Down 
view button on the View Direction toolbar.

Drillhole Types

The Drillhole Planner allows 3 types of drillholes to be created. All types require 
a collar Azimuth and Dip value to be specified, as well as the Total Depth of the 
drillhole.

Straight

A simple straight-line drillhole from the collar location, requiring only collar 
azimuth and dip values to be specified, as well as the total depth/length of the 
hole. Examples include boreholes, vacuum drilling and possibly RAB (Rotary Air 
Blast) reconnaissance drilling.

Constant Deviation

This allows a planned hole to accommodate a constant dip and/or azimuth 
change per specified over distance (over the entire length of the drillhole). For 
example, an expected shallowing/rising hole might have a dip change of 0.8 
degrees every 25m set (based on previous drilling in the area).
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A constant deviation hole set to rise 0.8 degrees every 25m.

Variable Deviations

Individual downhole azimuths and dips can be set at specific depths for the 
planned drillhole. This allows a drillhole to mirror an existing drillholes downhole 
variations. 

Note Changes are added to the existing azimuth/dip value. For instance if the collar 
dip is -60, and a dip change of +1.1 degrees is set every 25m, at 50m downhole 
depth the dip will be -47.8.

Use the Add row button to add each required downhole survey entry, and enter 
the appropriate Distance, Azimuth and Dip values.
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A variable deviation hole with a series of downhole variations entered.

Targeting Example

The following images illustrate a simple but powerful use of the Drillhole Planner. 
They present a common situation where the geologist is using an existing drill pad 
to target mineralisation at depth. In this case the target is a 5g/t gold grade shell 
generated by exporting an isosurface from a drillhole gold distribution voxel model 
(created by 3D gridding of existing drilling).
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Image 1: Initial hole generation as a straight hole, using the standard collar dip of -60 
degrees orientated towards the target. 

Image 2: Using existing drillhole variations as a guide, the proposed hole is changed to a 
Constant Variation type, and set to rise 1.5 degrees every 25m. The hole now intersects 
the target.
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Drillhole Planner Projects

After a hole’s attributes have been specified in the dialog, pressing the Apply 
button uses the .DPP file to generate the necessary MapInfo .TAB collar and 
survey tables; these can then be used to visualize these holes in Encom Discover 
PA or MapInfo-Discover. The output .TAB names and location are displayed in 
the main dialog:

A drillhole planner project can also be created from an existing Discover Drillhole 
Project. This allows a number of existing real-world holes to be utilized as 
templates for proposed holes i.e. to mirror an existing drillholes downhole azimuth 
and dip variations for a hole planned in a proximal location. It can also be used to 
design daughter or wedge holes off an existing drillhole. 

To use existing drillholes as templates:

2. A drillhole Selection dialog will then be displayed- select only the required 
drillholes to be used as templates 

3. Specify a new .DPP file to store these templates in.

4. The selected holes will be displayed in the Drillhole Planner dialog. It is 
recommended to use the Rename button to rename these holes (to save 
confusion with the original holes (e.g. rename CHRC112 to CHRC112A)

5. Alter the holes as necessary and visualize.

The Drillhole Planner tool creates Drillhole Planner Project (.DPP) files to 
dynamically handle drillholes. These can be created and reopened using the 
New and Open buttons. 

1. Press the Import button and browse for the source collar and survey files 
(these must be part of an existing Discover drillhole project).

An open drillhole planner project can be renamed and saved as a new project. 
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Seismic Depth

The Seismic Depth tool allows you to create projects by directly opening SGY files 
(also known as SEG-Y), along with support for various navigation or velocity 
models files. Sections can be viewed as either two way travel time or a depth axis. 
You can then manually or auto-pick horizons and define velocities for each facies 
or region within the horizons. Sections can be exported as 3D geo-located images 
or a 2D Plan map of the survey lines.

Seismic Workflow

When seismic data is received, in the form of SEG-Y (.SGY, .SEG or .SEGY files), 
there is a general workflow to generate 2D plan maps or 3D depth image of this 
data.

The key steps are:

1. Create and configure a new seismic project and add SEG-Y files:

2. Assign navigation and coordinate information
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3. Visualise section data

4. Digitize horizons on a section

5. Assign velocity values to a section.

6. Generate 2D plan of the track lines

7. Generate 3D registered images of the depth sections

Create and configure a new seismic project and add SEG-Y files:

1. Select Tools>Seismic Depth

2. Start a new project with File>New Project, or open an existing project 
with the File>Open Project. When the Seismic Depth tool starts up it will 
automatically load the last project worked on.

3. Set a project name (SPR file) in the project directory, under which all the 
SGY files are located.

4. Tick the Find and add all SGY files for auto import of SGY files already in 
the project directory.

5. Set the Line Name Pattern to assist in file name matching. For example if 
your lines are ordered -

WB-401, WB-402, WB-403 etc

6. Then set the line pattern to be

AA-NNN where A=alpha and N=numeric

7. Any SGY files with suffixes after the Line name will be included in the 
line's metadata, for example -

WB-401.sgy, WB-401_part2.sgy, WB-401_part3.sgy

8. Will all be reduced to the line number WB-401 and used to match other 
files like WB-401.west and extract coordinates from a Nav text file that 
has columns containing line number (WB-401) and trace (shot) number.

Note The SGY file must begin with the line number. If you have files like “lineWB-
401.sgy” then remove the prefix.
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9. If WEST files are present, tick the Find West file per SGY so that .west 
files matching SGY files will be imported. The scanning of files by default 
will look for both <linenumber>.west and <SGYFile>.west files (i.e. 
the asterisk implies both <linenumber> and <SGYFile> names will be 
attempted).

10. You can use one Navigation (text) file for every SGY file in the project, or 
you can let the dialog scan for a file per SGY file for the available 
navigation types.  See Assign navigation and coordinate information for 
more details.

11. The scanning of per-SGY navigation files by default will look for both 
<linenumber>.west and <SGYFile>.west files (i.e. the asterisk 
implies both <linenumber> and <SGYFile> names will be attempted).

12. Click OK to create the project and add any available files from the project 
directory.

13. If new data is received, you can use File>Open Section or Section>Add 
to add SEG-Y files to your existing project (select multiple by holding the 
CTRL key).

Assign navigation and coordinate information

1. After a project is created you can review and edit the Coordinate 
information for individual Sections by selecting Section>Properties. 

2. The Coordinates formats supported per Section file are: 

• SGY: The SGY file  contains typically long integers at trace header 
bytes 73,77

• West: A supplied .west file

• Nav: A column delimited text file

Note If new SGY or metadata files are added to the project, the File>New Project 
Setup can be re-run at any time to create a new project, which will allow batch 
importing and editing of Section Properties.

Note If you wish to batch edit section coordinates settings, new the File>New Project 
Setup can be re-run at any time to create a new project, which will allow batch 
importing and editing of Section Properties. 
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• UKOOA: A UKO format file

• Ends: Manually enter the coordinates of 2 traces in the section.

3. For all coordinates types select the Config… button to configure the 
format of the source regarding the decoding of values (decimal, DMS, 
Easting/Northing). The following formats of coordinate data can be 
decoded

• Easting / Northing

• Longitude / Latitude from decimal

• Longitude / Latitude from [D]DDMMSS

• Longitude / Latitude from [D]DDMMSSF  (fraction tenths)

• Longitude / Latitude from [D]DDMMSS.FFA  A=N/S or E/W

4. For Text Files (Nav) select Config to specify the header size as Lines to 
Skip. Also specify any comments by the Comment character. Select the 
applicable Delimited characters (note not consecutive) or fixed width 
sizes between the columns (separate the sizes with commas).

5. In the Header text box, you will need to provide names for each column/
field in the file, separated by a comma. The Header column names must 
include following column names:

• LINE
The line number column (also known as Track)

• TRACE
The trace number column (also known as Shot, for example in un-
stacked data)

• X
The source of Longitude or Easting

• Y
The source of Latitude or Northing 

• SKIP
All other columns should be labelled as skip 

Visualise section data

1. Select the section file to view from the list on the toolbar.
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2. The current view style can be changed by selecting from View>Wiggle 
Trace (time axis), View>Time or View>Depth.

3. The velocity value can be visualised by selecting View>Velocity tint.

4. Zoom and pan the view by selecting the various controls from the toolbar.

5. The view can also be scrolled using the horizontal scrollbar located below 
the section.

6. A dynamic profile of individual traces can be viewed by select 
View>Profile.

Digitize horizons on a section

1. With the auto-pick tool, simply click on the event (pick) in any trace in the 
section, and the horizon will be automatically generated for this event 
across the section.

2. Alternatively you can create the polylines (horizons) manually by creating 
a series picks (points). Make sure you draw past the edges of the data or 
cut though another horizon so the horizons define enclosed velocity 
regions. You can cut lines, and you can join lines by moving the end point 
of one line onto the end point of another line.

3. You can undo any changes by selecting Edit>Undo or Edit>Redo.

Assign velocity values to a section

1. By default a section will display with a single default velocity as set under 
the project settings. Alternatively if a .WEST file is available for the 
section, this information will be displayed.
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2. Define the available velocities for the project by selecting the edit 
velocities button on the toolbar. Velocities can be given a name, as well as 
the speed and colour to display. 

3. To assign a velocity to an area in the section, enclosed by horizons and/or 
the edge of the section, select the velocity from the list and use the colour 
fill tool to click in the area.

Generate 2D plan of the track lines

1. Select View>Plan View to open a plan view of the sections navigation/
coordinate data.

2. Select the Open tick box to auto-open the output TAB file in Encom 
Discover PA.

3. Click Make TAB file to generate a MapInfo vector file for the seismic lines.

Generate 3D registered images of the depth sections

1. Select Section>Generate 3D 

2. To generate an image for the currently viewed SGY select Current. To 
generate image layers for all sections in the project select All.

3. In curtain segments, select Every 10 metres. This will generate images 
which bend every 10metres to ensure it follows the bends in the 
tracklines.

4. For the Colour, select Velocity Tint.

5. Select an output directory for the files—the located image .EGB file will be 
automatically named by the section or the project.

6. Tick Open in 3D to automatically open the image files in Encom Discover 
PA.

7. Select Generate 3D to create the image files.
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Options available for generating a 3D depth section.

Seismic Project Files

A project (.spr file) can contain many seismic lines (.sgy files), as well as 
associated files for coordinate information and velocity models.

In addition the following files may be present:

•  A source of velocity for time to depth conversion (.WEST file or manual 
velocity creation in .VEL).

•  A source of navigation coordinates (in SGY, .NAV, UKOOA or manual 
input)

• A file to store any digitized horizons, .BDY.
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• A file to save the current view, .SPV.

If your section file has a matching .west velocity file it will be loaded and the 
velocity tint displayed by default. You can change a section’s velocity and 
coordinates source using Section>Properties. If there are no velocity files you 
can create horizon boundaries and colour fill between the boundaries with a 
velocity value.

File format details of .WEST 

West navigation files do not strictly follow a standard format. In standard files the 
trace index is read from columns 5-15 (in bold):

In non-standard files the trace index is read from columns shown in bold:

For these cases with VELF data, it is consistently located as a maximum of 5 pairs 
(5 chars per value) from column 21

If neither of these are present, then often SPNT X and Y data is present instead 
of VELF. SPNT is inconsistent and so is scanned in from column 29 (in bold):

File Format details of layers

The layers are stored in the .SPR XML project file.

SPNT 72 100 0 0 
VELF 72 100 5000 600 5900 1400 … 
VELF 72 3000 9800 400010800 580011800 

CDFN 40
VELF 0 1891  212 2054  455 2289 …
VELF 1864 4211 2992 5029

VELF 216 100 5000  500 6100  800 6225 1100 6525 …
VELF 0 1921  208 2116  476 2535  627 3209 …

SPNT 119.00 631317 8057146
SPNT 72 100 0 0
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File Format details of .VEL

The .vel file is a run length encoded grid of velocity pairs following a 16 byte 
header (Intel LSB). The 16 byte header consists of 8 zero bytes then the width 
and height in 2 four byte unsigned int. The values of width and height will be much 
less than the number of traces and samples. The data follows the header as pairs 
of count (four byte integer) and value (four byte float). The data runs row by row 
downwards. 

Coordinates

The source of coordinates for a SGY line is determined by the following sources: 

• SGY: The SGY file  contains typically long integers at trace header 
bytes 73,77

• West: A supplied .WEST file

• Nav: A column delimited text file

• UKOOA: A UKO format file

• Ends: Manually enter the coordinates of 2 traces in the section.

For all coordinates types select the Config button to configure the format of the 
source regarding the decoding of values (decimal, DMS, Easting/Northing). The 
following formats of coordinate data can be decoded

• Easting / Northing

• Longitude / Latitude from decimal

• Longitude / Latitude from [D]DDMMSS

• Longitude / Latitude from [D]DDMMSSF  (fraction tenths)

• Longitude / Latitude from [D]DDMMSS.FFA  A=N/S or E/W

For Text Files (Nav) select the Config… to specify the header size as Lines to 
Skip. Also specify any comment lines by the Comment character.

Select the applicable Delimited characters (note not consecutive) or fixed 
width sizes between the columns (separate the sizes with commas).
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In the Header text box, you will need to provide names for each column/field in 
the file, separated by a comma. The Header column names must include 
following column names:

• LINE
The line number column (also known as Track)

• TRACE
The trace number column (also known as Shot, for example in unstacked 
data)

• X
The source of Longitude or Easting

• Y
The source of Latitude or Northing 

• SKIP
All other columns should be labelled SKIP 

Digitizing Horizons

You can create horizons by drawing and editing polylines with the editing tools. 
You can draw the lines manually and colour fill between them with a velocity 
value/color. Make sure horizons are drawn past the edges of the data or cut 
through another horizon so that they define an enclosed region. You can cut lines, 
and you can join lines by moving the end node (pick) of one line onto the end node 
of another line. In auto pick mode you can click on the section and have a horizon 
generated.

• Autopick: Click on a trace sample to autopick a horizon. Clean up 
autopick’s attempt by using the following tools to edit, remove, cut and join 
lines.

• Pen: Click to start drawing a horizon (polyline). Each click adds a pick to 
the section appending to the current horizon that was last clicked. Right 
click to end the current polyline.

• Starting on the end of an existing horizon appends to it.

• Ending on the end of an existing horizon joins to it.

• Erase: Click on an existing horizon to erase the entire polyline.

• Move Pick: Move a pick. Moving the end of a horizon onto the end of 
another horizon joins them as one continuous horizon.
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• Add Pick: Click on a horizon line section to insert a new point within the 
existing line.

• Remove Pick: Click on a point to remove.

• Line Break: Click on a horizon’s line section to break the horizon into two.

• Fill: Click between boundaries to colour fill the region with a velocity (as 
currently selected in the toolbar velocity combobox).

• View>Undo: Undo any edit operation above.

• View>Redo: Redo any edit operation above.

Viewing Profiles

Use the View>Profile tool to dynamically displays the wiggle trace horizontally for 
the current pointer location. Also display the point time location along the trace 
and the sample number.

Example depth section profile with wiggle trace.

Dialog Help

• Project Settings Dialog Box

• Section Properties Dialog Box

• Digitizing Horizons
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Project Settings Dialog Box

The File>Project Settings dialog contains tab to control setting that apply across 
all lines in the project. The settings are saved in the .SPR xml file. 

General Project Properties

•  Trace Width: The pixel width of a trace at 1:1 zoom (when one SEGY 
sample (receiver) is one pixel).

• Wiggle Scale: The full scale amplitude of wiggle traces at 1:1 zoom.

• Velocity Transparency: The transparency of the velocity tint over 
grayscale (0-100)

• Default Velocity: The default velocity when no velocity is supplied and no 
manual edits have been made. 

• Depth X: Is the maximum height of the depth display where: 

 (Max time) * (default velocity) * 0.5 (two-way time) * 1.5 (Depth X) = 1200m

Layer Table

The layer table is a place to make a layer cake of velocities that will be used by 
SEGY lines that don’t yet have an associated velocity file (.west) or (.vel) from 
user edits. The layer cake is a good starting point for providing velocities before 
the user starts full editing. The layer cake is better than the single default velocity.  
Specify the thickness of each layer in two way time, and assign any velocity value. 
The depth of each layer is automatically calculated. 

These are stored in the project's .SPR XML file.

Velocities

The velocity table holds the discrete velocities and their associated colors that the 
project can use to render velocity tints. All table cells are editable by clicking. The 
name cell can be edited to a geological name like “Granite”. Use the generate 
function to create a range of colors suitable to the geology of the project’s dataset. 
All velocities are interval velocities.

These are stored in the project's .spr XML file.

Auto Pick

   The auto pick settings are used to control the sensitivity of the autopick function.
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• Detect:  Snap the user’s click to the maxima or minima (note you can also 
invert the data's phase by selecting View>Invert)

• Window: The number of samples used to correlate one trace with its 
neighbors.

•  Likeness: The sensitivity of the neighbor correlation, on a range of 0 (off) 
to 100 (exactly identical). If set to 0 the autopick will continue to the end of 
the section.

• Look Ahead: The maximum number of bad traces that the autopick can 
jump over to continue.

• Trace Span:  The ideal spacing between picks on the horizon.

Section Properties Dialog Box

The Section Properties dialog controls how velocity and navigation data is 
sourced for a SEG-Y file. The velocity is needed for viewing time data with velocity 
tint and for time to depth conversion. Coordinate data is required for the 
generation of 3D view data. 
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Seismic Section Properties dialog box

Velocity

• West: The velocity is provided by a .west file. Specify whether the source 
contains Average (from surface to the bottom horizon) or Interval  (within 
the current horizons) velocities.

• Layers: Use the project’s layer cake for velocity.

• Editable: The velocity is editable and stored in a .vel file. This information 
can be changed by digitizing horizons and assigning different velocities, 
see Digitizing Horizons. When switching to Editable mode the user may 
choose how the editable data is initialized. It can be initialized from -

• Default Velocity  - the single default velocity for File>Project 
Settings>Project
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• Copy from Layer Table - the Layers defined for File>Project 
Settings>Layers

• Copy from West - the West file information defined under the 
specified West option

•  Load Edit File - the current .VEL file

Plan View Dialog Box

The plan view shows the cruise/track plan of the SEG-Y lines and you can make 
a TAB file of the plan for viewing in Encom Discover PA. You will not see any plan 
if your SGY data is not yet associated with navigation data. Use the table at the 
top of the dialog to select sections and edit them to associate navigation data. 

• View coordinates as text to help verify that coordinates are being 
decoded correctly from Navigation data. 

• Make Tab file button will generate a TAB file of the plan for viewing in 
MapInfo Professional.
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Plan view of seismic lines

Generate 3D Dialog Box

Use the toolbar button to generate 3D images and EGB files. For each SEGY line 
used in the generation a .PNG file will be created of the depth image. A located 
image .EGB file will be generated which contains the 3D registration of the PNG 
image. Encom Discover PA will use the located image to display the .PNG images 
in 3D space.

• Current: Generate 3D files for the currently viewed section. 

•  All: Generate 3D files for all sections in the project, which will consist of 
sub-layers for each section. 

• Colour:

•  Greyscale: The generated images will be grayscale.
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•  Velocity Tint: The generate images will be grayscale with velocity 
tint.

•  Lookup:  The generated images will be coloured with the lookup 
table chosen.

• Curtain Sections:

•  One Full Length:  The output SEGY line will be a straight line 
between two end points.

• Every x metres: The output SEGY line will consisted of sections 
following the navigation coordinates. The EGB file will specify break 
points (a quad strip) along the PNG image with coordinates for each 
vertex.

• Projection: The output projection of the 3D result. 

• Output directory: The directory to write the output files. Project folder is 
used by default.

• Open in 3D:  Output images will be opened automatically in Encom 
Discover PA.

Section to Map Utility

The Section To Map plug-in utility for Encom Discover PA enables users to 
display the content of 2D section profiles or graphs as geo-located images in plan 
view in a 2D map display.

The procedure is.

1. Prepare the Destination 2D Map

2. Prepare the Source Sections or Profiles

3. Batch Print to Located Image (.EGB) File

4. Run the Section To Map Utility

5. Add Processed Located Images to the Map.

Note This tool requires an Encom Discover PA Professional licence. If you wish to 
purchase or evaluate this module, please contact Pitney Bowes Software.
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If you experience problems with using this utuility, see Trouble-shooting.

Prepare the Destination 2D Map

The destination map is likely to be either a 2D map or a 2D graph but it is not 
limited to these because the resulting data can also be displayed in 3D displays. 
However the most likely target is a scaled 2D map.

The X and Y scale of the map should be determined prior to creating the section 
output. In a 2D map the X and Y scales will be equal but in a 2D graph they may 
be different. The X and Y axis scales can be set from the Map Properties dialog 
of a 2D map display. 

Specify the Axis Scaling for the destination 2D map

Prepare the Source Sections or Profiles

It is likely you will want to display data from one or more survey lines. The data 
may be CDI or IP section data, profile data or any other kind of content.

You can either build a profile/section graph or a general 2D graph. Typically you 
will use a profile/section graph but there are some instances when a 2D graph will 
be required.

Profile and section graphs convert X and Y coordinates to “projected distance” 
coordinates which are then used as the X coordinates for the graph. This is 
appropriate when the survey lines are straight or at least not highly curved. 
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If the lines are highly curved then it is possible that, when projected onto the line, 
some parts of the data may overlap other parts. If this is the case or if there is 
significant distortion because the line direction deviates from the projected line, 
you may have to use a 2D Graph. In this case you will use the Chordlength field 
as the X coordinate.

Example of a section traverse where a 2D Graph is required

Set the X scale of the section equal to the scale of the destination map. To display 
a section using scaling you need to display the document in layout mode. In 
normal mode all scaling is disabled.

With the distance known, use the following formulae to choose a valid Y scale:

1 mm at a scale of 1:X = X/1000 data units

1 data unit at a scale of 1:X = 1000/X mm

So if the lines are separated by 1000m and the scale is 1:10000 then they will be 
1000 x 1000 / 10000 = 100 millimetres apart. If the section is 250m deep then a 
vertical scale of 100 * VX/1000 = 250 => 1:2500 would fit perfectly. In practice 
increase the scale slightly to allow some space.

Now set the Y scale of the section. It is assumed  there will only be one Y axis. If 
there are multiple Y axes the procedure is more complicated. Often, it is 
appropriate to choose a Y scale that is different to the X scale. The sections will 
be displayed on the map using this Y scale as the vertical scale. You will have to 
choose a Y scale that ensures that adjacent sections on the map will not overlap. 
To do this, work out the separation distance between lines. You can do this in 
Encom Discover PA using the measure tool.
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When you scale a graph in Encom Discover PA the graph data area may change 
size so that all the data is displayed at the appropriate scale. Often, the graph will 
then overlap the boundaries of the frame it is embedded in. This can be fixed 
manually by resizing the frame. Also, select Fit frame to data on the right click 
menu for the frame to automatically fit the frame (horizontal size only). 

When you output the sections you have the option of outputting just the graph 
data area or the entire graph including titles, frames and axes. Note that this does 
not include any objects in the document that are floating over the graph. You will 
need to adjust the properties of these objects to ensure they display appropriately 
in the final destination map. As you change the section scale it is likely you will 
want to adjust font sizes, line thicknesses and other properties.

Note that the Appearance tab properties of the graph allow you to turn on or off 
the inner and outer borders and also allow you to change the margins of the data 
area. The margins are important if you want the top or bottom of the graph to align 
with the actual survey line on the map (assuming you select the hang or sit 
options in the Section to Map plug-in). If you are outputting annotations you may 
need to set the bottom or top margin to zero to ensure the data lies on the survey 
line.

Generally you will want the sections to be transparent on the map. In other words, 
you can see through the white space to the data underneath the section in the 
map. To ensure this is possible you need to set the Show background property 
in the graph Appearance property page off.
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Deselect the Show Background option in the Profile Properties Appearance dialog to make 
the background transparent

Batch Print to Located Image (.EGB) File

Once the section is prepared you can print each line you require to a located 
image .EGB file. This process generates an ASCII EGB header file which 
contains the coordinates of all the sections and an image for each line. It is 
achieved via the File>Batch Hard copy Wizard menu option. Before activating 
the wizard ensure that you are viewing the section in Page Layout mode.

When using the wizard select the Georeferenced image file on disk (EGB) as 
the hard copy destination.

It is important to select the PNG (portable network graphics) option as the image 
type. This image file format employs a lossless compression algorithm ensuring 
file sizes are small and that there is no bleeding of information in the image. This 
bleeding will cause quality issues when the sections are displayed in the map.
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Image size, format and name dialog for the Batch Hard copy Wizard

The image size is an important consideration. If the lines are all the same length 
you can set a fixed size but if the lines have variable lengths then best results will 
be obtained if the size of the image is allowed to vary according to the length of 
the line (and possibly the height of the section). 

It is important to make sure the image has a high enough resolution so that quality 
hard copy results are obtained. However, it is expensive to set the image 
resolution higher than necessary as it taxes computer and graphics resources. It 
is also necessary to set the X and Y image size appropriately so that the X and Y 
scales of the section are honoured.

Decide what resolution you want to use in the destination map. Resolution is often 
expressed in dots per inch and common figures include 150, 300 and 600 DPI. 
Your printer may report it can print to resolutions of 2400 DPI or more. In the 
Image size dialog pixels per millimetre are used instead, bearing in mind 10 px/
mm = 254 DPI.

To set these options select the Advanced button, located to the right of the 
Image Size options, access the image size dialog. The dialog will report the 
width and height of the current section in millimetres as well as the width:height 
ratio. If all lines are the same length and all sections are the same height use the 
fixed size option.
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The length and height of your section in millimetres is reported at the top of the 
dialog. Otherwise you can compute it yourself using the formulaes given 
previously. Multiply these figures by the required resolution (eg 10 px/mm) to 
acquire the number of pixels required in the X and Y dimensions. Set the X and 
Y sizes in the dialog appropriately. You will notice that one of the dimensions is 
usually greyed out and is set automatically when the other is changed. You can 
override this by freeing the X and Y extents. 

The Advanced dialog for setting Image Size

If line lengths or section heights are variable you can use the Variable size 
option. This requires you to set the formula that the system will use to determine 
the image dimensions or each output line. Firstly, set the required resolution in px/
mm. Then, if the line lengths vary turn the X Variable switch on. If the section 
heights vary turn the Y Variable switch on. The image resolution will be displayed 
in the drop edit box (and will be greyed out if variable). If one of the dimensions is 
not variable you will need to select an appropriate resolution.
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There is one final consideration regarding image size. The sections will be 
rendered using 3D texture mapping technology and for this purpose it is 
necessary that the images be a size that is a power of two, e.g. 512, 1024, 2048 
etc. Generally, images larger that 1024 pixels will be tiled to NxM 1024 pixel size 
images. So, above 1024 you can choose a power of two or an integer multiple of 
1024. Otherwise the image will be resized. This may involve re-interpolation of the 
images which can result in image detail and colour bleeding. A higher quality 
result can be obtained if no resizing is required. That is why the size edit boxes 
all offer a list of appropriate sizes. If using variable images size you can turn on 
the Rounded option to ensure the image is rounded up or down to the next 
appropriate size.

If you have decided to output the entire graph including axes, titles and 
annotations you can specify this in the batch hard copy dialog now.

If the sections will be displayed over the top of some other images – for example 
a topographic ECW or magnetic image - it is important to turn on the Disable 
smooth font edges switch. By default it will always be turned off. If not switched 
on then fonts will be anti-aliased (or smoothed) by adding grey pixels on the 
edges to make the text appear smoother. This will result in unfortunate image 
processing effects when the sections are displayed in maps and rendered 
transparently over other data. You will see light haloes around the text. If the 
sections will be rendered against an empty background then smooth fonts can be 
retained.

Output the graph as a Quad Strip. If you are outputting a profile or section there 
is no other choice. If it is a 2D graph then you will need to set this now. Also, 
ensure that line data is being exported rather than actual X coordinates which in 
the case of the 2D graph will be Chordlength. Finally, set the Line Data 
Compression (0 – 100). It can be difficult to know what level of compression is 
appropriate. You can experiment by opening a 2D map with a flight path. Choose 
the line dataset you are creating sections of. You can vary the compression level 
via the flight path properties and the effects will be instantly reflected in the flight 
path lines. Unless the line data is curved, a high level of compression of 50 – 100 
is usually appropriate.

Select the lines you want to output from the line list. Make sure you turn on the Fit 
profile to scaled data extents switch. The wizard will now generate an EGB file 
containing all the coordinate information and a bitmap (PNG format) for each line. 
Check the images to make sure they look alright. 
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Choose the lines in an active database to be printed by using either the line iterator option 
of the line list in Step 3

Run the Section To Map Utility

The task of the Section To Map plug-in is to read the EGB file and convert the 
coordinates of the sections from vertical to horizontal. The images are not 
modified at all and will be re-used by the output located image (.EGB) file.

Enter the scale of the map (and horizontal scale of the sections) and the vertical 
scale of the sections in the appropriate edit fields. These are required to correctly 
compute the coordinates.

Access the Section To Map utility from the Tools menu.  Select the .EGB file 
created by the batch hard copy wizard as the input file and set an appropriate 
output file. (Do not overwrite the input file as you may need to run the plug-in 
multiple times.)
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The Section To Map Utility dialog 

To set the position of the sections relative to the survey lines you can choose to 
Hang the sections from the survey line so that they lie underneath it, Sit them on 
top of the survey line or Straddle (centre) them on the survey line. 

You can also specify an additional offset in millimetres along the vertical axis of 
the section. The sections cannot be offset horizontally along the line. If you are 
hanging the sections and you have a top margin in the section you can align the 
data area with the survey line by setting the offset to the negative of the top 
margin size. This is usually 6 mm.
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The Section To Map utility dialog.

To accommodate survey lines which are not linear in their orientation a ‘Maximum 
angular divergence from azimuth” option has been added to the Section To Map 
tool.

This ensures that the angle of the vector for each node does not depart from the 
line azimuth by any more than the user specified angle anywhere in the line. In 
this case we have a ‘straight’ line that is locally quite divergent from the global line 
azimuth. If you set the variable to zero in this case it is quite a reasonable thing 
to do – so the whole thing will be plotted at the line azimuth rather than the local 
azimuth.
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Another option has been applied to the utility to re-compute the position of the 
baseline by projecting it onto a linear regression of the supplied survey line 
coordinates. This option is a check box called Compute baseline vector 
(regression). By selecting this option any spatial deviations caused by local line 
azimuth deviations will be eliminated.

When the sections are rendered in the map they must be rendered into the map 
using transparent bitmaps. This means that a colour ought to be defined as the 
transparent colour. Any pixels that have this colour in the bitmaps will not be 
rendered. Generally this colour is white. You may have specified a non-
transparent graph with a coloured background – if so use that colour instead. 
When colour bleeding occurs this can be partially cleaned up by specifying a 
range of colours that are transparent. You can do this by setting a range value for 
all colour components or for each colour component individually. Finally, the 
stretch mode chosen will also affect image quality. The Preserve colour data 
option produces good results in this case as it prevents colour bleeding. 

Add Processed Located Images to the Map

The easiest way to do this is to drag and drop the processed located image .EGB 
file from Windows Explorer into the 2D map document or else open it into the Data 
Manager window first before dragging the file into a 2D map window. When 
Encom Discover PA asks you whether you want to render the .EGB file using 3D 
technology click on the Yes button. Alternatively you can add a located image to 
the map and load the processed EGB file.

3D rendering option when adding processed sections to a 2D map

It can be useful to display a flight path in the map and to check that your sections 
are correctly located along the survey lines.
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CDI sections displayed in a 2D map overlying a grid image and with reference survey lines

Once displayed in the map there are some options you can modify to improve or 
change the appearance of the sections. 

1. You can move the located image series up and down in the Workspace 
Tree to ensure that is drawn on top or below other content. Encom 
Discover PA automatically categorises and sorts content to achieve good 
outcomes without user intervention. 

2. You can change the bitmap rendering options. These are not exposed as 
properties of the series but are written into the .EGB header file at the top. 
The settings can be directly edited there. Alternatively run the 
Sections2Map plug-in again and modify the Section transparency 
settings.

3. You can change the image processing options. These are accessible via 
the series properties. You can change the input and output stretching 
options. Generally it is best to use Preserve colour data as the input 
stretch and None as the output stretch. However, these may not be the 
default settings. Ensure that you apply the changes to ALL images.

The map is now ready for printing. Alternatively you can export the map content 
to a located bitmap suitable for display in other packages such as MapInfo 
Professional. In this case it is best to use a located image format that employs 
lossless image compression.
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Trouble-shooting

Most problems will be related to image processing options so it is useful to 
understand the full image processing procedure employed to get sections to 
maps. Other problems are likely to be related to scaling, image sizes and batch 
hard copy. Therefore you are advised to follow the instructions above carefully, to 
think carefully in advance about what you are trying to achieve and to check your 
work every step of the way. Likely areas where problems may occur are:

The batch hard copy wizard creates the section source image.

This process should not generate any image processing issues itself as the image 
data is created at or as a native resolution. However, if there are data series in 
the graph that render via source images themselves this may cause an issue. For 
example, the section may contain a ModelVision TKM model file displayed as a 
3D view in the section. This is rendered as a bitmap into the section. By default 
text is rendered with smoothing turned on – this generates grey pixels around the 
edges of text which may be unsightly if rendered against a dark background. Turn 
it off.

The source images are converted to texture images.

This requires the image size in X and Y to be a power of two, or a multiple of the 
texture tile size. If this is not the case the image will be stretched up or down to 
the closest valid size. The stretch mode employed is important. The modes 
available are Preserve block data, Preserve white data, Preserve colour data and 
High quality. In most cases you would choose high quality but this mode employs 
pixel colour interpolation which can cause bleeding of colour and loss of apparent 
resolution.

The textures are rendered to the source geometry in 3D.

Texture mapping always involves scaling of the image up or down and 
consequently there must be some interpolation involved. In this case the best 
results are obtained if a nearest neighbour assignment scheme is used. Any kind 
of interpolation will cause sharp boundaries to become blurred and this can cause 
unsightly effects. The None mode uses nearest neighbour colour assignment. 

The 3D viewport is grabbed and rendered into the map.

Generally speaking this will not involve any image stretching as the source 
bitmaps are usually produced at the exact resolution of the output device. 
However if the output device has a very high resolution there may be stretching 
of the source bitmap into the output device. 
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The images are usually rendered with a transparent colour so that content in the 
map can be seen through transparent areas of the sections. Colour bleeding can 
be cleaned up at this late stage by choosing a range of transparent colours. 

If thin line work is disappearing from view this may be caused by the stretching or 
the texture mapping. Change the stretch to Preserve black data in the Prepare 
the Source Sections or Profiles step. Sometimes the lines are visible at high 
resolution but not visible on the screen. Use the Page Zoom In to see if this is the 
case. They may print correctly if this is the case.

Coordinate Reprojection

This plug-in utility is a geographic point converter allowing you to interactively 
convert points between any two coordinate systems that are supported in the 
Encom projection library.

Since the Point Coordinate Transform utility uses the same projection library as 
Encom Discover PA does, it is therefore also a useful way to explore coordinate 
system problems.

• Interactive Conversion

• Text File Conversion

• Longitude to UTM Zone Converter

Interactive Conversion

After executing the Point Coordinate Transform utility from the Tools Menu a 
dialog containing two tabs will be displayed with the Interactive conversion tab 
dialog displayed by default.  Load a source coordinate system (Datum and 
Projection) by clicking on the Choose button on the left hand side of the dialog. 

A second coordinate system can then be loaded into the Target coordinate 
system section on the right hand side of the dialog by clicking on the Choose 
button for this section. 

The Output Point entry boxes for the second coordinate system, displayed on 
the right hand side of the dialog, will then be updated to display the equivalent X 
and Y location of the input point in the second coordinate system.

Differences between these two coordinate systems for a specific point location 
can then be compared by entering a value for East-West and North-South into 
the Input Point boxes on the left hand side and then clicking on the Convert 
forwards button. 
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Interactive Conversion tab dialog of the Point Coordinate Transform utility

Details of a selected coordinate system loaded into the Point Coordinate Transform utility

This same procedure can be reversed by clicking on the Convert backwards 
button on the right hand side of the dialog.

Note With a coordinate system loaded you can click on the View details button to see 
the full set of parameters for the coordinate system.
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Text File Conversion

The Point Coordinate Transform tool also allows “batch” conversion of 
coordinates in a loaded text file. This second feature is accessed from the Text 
file conversion tab dialog and utilitises the ImportAscii plugin utility with the 
appropriate source and target coordinate systems chosen by the Point 
Coordinate Transform function.

Text File Conversion tab dialog of the Point Coordinate Transform utility

Assign column header information and specify which fields are to be imported in 
the Import ASCII interface that appears and click on the Convert button. You will 
then need to save the converted file as a new ASCII file. The Easting and Northing 
fields will then be converted and updated in the newly saved ascii file and can 
then be imported into Encom Discover PA in the usual manner using the 
File>Open>Text Import menu option.

To load an ASCII file into the Point Coordinate Transform dialog click on the 
Convert text file button and browse for the text file using the navigation window 
that appears.
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Longitude to UTM Zone Converter

A simple querying tool exists in this processing utility for locating in which UTM 
zone a specific Longitude degree belongs. Click on the UTM Zones button at the 
bottom of the Point Coordinate Transform dialog and enter the degree of 
longitude into the dialog that appears.

Use the UTM Zones button to query which zone a Longitude degree is associated with

Click the OK button and a smaller dialog will appear reporting the UTM Zone 
associated with this Longitude degree.

Select the Settings button on the Point Coordinate Transform dialog to apply a 
small number of settings that can be applied to this utility. Turn on the Remember 
selected coordinate systems option to have the utility remember the loaded 
coordinate system for the next time this utility is accessed.

Colour Table and Legend Editors

Encom Discover PA has the ability to create, edit, save and restore Colour Look-
Up tables and Legends that can be applied to surface, point or line data in all 
displays to enhance their appearance.

• A Colour Look-Up Table distributes colour across the displayed objects 
according to the value of a specified data field.
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• A Legend is a different look-up table that uses textural or ranged data 
from a column in the data source table to create the legend categories. 
For example, legend categories may be displayed as solid colours or 
contain patterns that can be used to enhance a line styles, assay or 
lithologies in drillhole displays. 

To use an existing Colour Look-Up Table or Legend check the Modulate Line 
Colour box in the Colour tab of the Points or Lines Properties dialog or the Line 
Style tab of the Lines Properties dialog and select a colour or legend table from 
the pull-down list. For further information on this, refer to the appropriate display 
object type section in this guide.

Curve Properties and Points Properties dialog showing access to Colour and Legend 
Lookup tables

To create or modify a look-up colour table or legend click on the Lookup Table/
Legend button. The Colour Lookup Selection dialog is displayed.
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Colour Lookup Selection dialog

Choose the look-up table to edit from the pull-down list in the Colour Lookup 
Selection dialog. 

Look-up tables can be created, edited, deleted or imported from an external 
source via the LUT and Legend Editor dialogs.

Colour Table Editor

Colour look-up tables can be created and modified using the Colour Table Editor. 
The look-up tables are stored in

..\\Program Files\Encom\Common\LUT directory.

The format of LUT files varies depending on the saved format type. Supported 
types include:

• ER Mapper (.LUT)

• MapInfo Professional (.CLR)

• Geosoft Oasis (.TBL)

• Engage3D Legend (.LEG extension)

If the look-up table selected is a Colour Look-Up Table click the Rainbow 
button to display the Colour Table Editor.

If the look-up table selected is a Legend Table click the Aircraft button to 
display the Legend Editor. 
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In the Colour Lookup Selection dialog check the Legend/Look-Up Table control 
and select an existing Colour Look-Up Table from the pull-down list. Click on the 
Look-Up Table button to display the LUT Editor dialog.

The Colour Table Editor can also be accessed from the Tools>Colour Table 
Editor menu command.

LUT Editor dialog.

The Colour Table Editor dialog is divided into functional areas. On the left is a 
scrollable list with the available Lookup Tables. Beneath this list are New and 
Delete buttons for creating a new LUT and removing lookup tables from this list. 
For information on creating a new colour table, see Create Colour Table. In the 
centre of the dialog are the various colour settings for the number of rows 
specified in the selected LUT with descriptive comments if available. 

The lookup Table name, Description and the corresponding Filename are 
displayed at the top of the dialog. Underneath the Colour interpolation can be 
selected from RGB or HSL with an option to show the individual RGB values for 
each row. The Settings button shows the file path of the stored LUT and can be 
changed to another location such as a server directory if required. A preview of 
the selected LUT is displayed on the right of the dialog showing the entire LUT 
colour spectrum. 

To open the Colour Table Editor (LUT Editor) dialog click on the Lookup Table/
Legend button in the Points Symbols tab of the Points Properties dialog or the 
Line Style tab of the Lines Properties dialog.
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At the base of the dialog is a series of buttons used to control the distribution of 
colours in a new or existing lookup table. Once a LUT has been specified it can 
be stored using the Save button. To save an existing LUT under a different name, 
location or file format use the Save As button. The above LUT formats are 
provided as options when the Save As dialog is displayed. 

A colour lookup table can contain any number of rows. Usually, this number is 16, 
32, 64, 128, 256 etc. to enable an even colour spread. Each row can have a 
colour individually assigned or a number of rows can be selected and the colours 
graduated over the entire row range

Create Colour Table

Create new lookup table dialog

Enter a Name and the Number of entries (rows or colours) to be assigned to the 
new LUT. Check the Specify the data value corresponding to each colour box 
to precisely match data values with a colour from the table. For example, if the 
data has a range of 51,000 to 51,500, the colour look-up table can contain 500 
definable colours for each of the 500 data values. Note that if this utility is used, 
the created LUT cannot be used within ER Mapper.

When a new table is created it is added to the Look-up Tables list and a blank 
colour table is displayed in the centre of the LUT Editor dialog. Select HSL or 
RGB from the Colour Interpretation pull-down list. Left-mouse click any of the 
Colour cells of a row to select a colour from the standard colour palette. Use the 
Custom option to create additional colours.

To create a new LUT click the New button in the Colour Table Editor dialog. 
The Create new lookup table dialog is displayed
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To create a colour spread over a range of cells colour and select two end member 
cells in non-adjacent rows by holding down the SHIFT or CTRL key. Click the Interp 
Selection button to fill the intermediate blank cells with graduated colour. Use the 
Clear Cells button to remove colour from highlighted cells. To view the Red, 
Green, Blue values for each row check the Show RGB values box.

Selected cells can be all set to match the first selected cell using the Duplicate 
button. This always operates from the top-most selected cell down, irrespective 
of the order in which the cells were selected. Extra rows can be added or deleted 
using the Insert or Delete Rows buttons.

If the Specify the data value corresponding to each colour box was checked 
when the LUT was created enter the minimum and maximum data values next to 
the corresponding rows in the Data column. Click the Interp Gaps button to 
populate each intermediate row with the corresponding data value.

Any nominated LUT files in the displayed list can be deleted using the Delete 
button on the bottom left of the dialog.

Legend Editor

The Legend Editor is used to maintain legend tables where each individual 
category or numeric data range has the following display attributes:

• Foreground colour 

• Background colour

• Pattern

The Legend Editor is used to create and/or modify individual or ranged data 
legends manually or from a selected dataset field. The Legend Editor can be 
accessed from a Properties dialog by clicking first on the Colour Lookup Table 
button to open the Colour Lookup Selection dialog and then on the Legend 
Editor button, or from the Tools>Legend Editor menu command.

Colour 
Lookup 
Table

Legend 
Editor
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• Bounding line colour

• Bounding Line Style

• Bounding Line Thickness

Legend information is stored in a file with a LEG extension. Legend files are 
stored in the C:\Program Files\Encom\Common\LUT directory. In addition to 
the legend files, associated patterns are stored in the C:\Program 
Files\Encom\Common\Patterns directory. 

Use the Settings button to view the current file path for the legend and pattern 
directories. 

The Legend Editor dialog lists the available legends down the left side and the 
details of the currently highlighted Legend including colours, patterns and 
associated string entries on the right side.

Legend Editor dialog

At the top of the Legend Editor dialog the selected Legend name is displayed with 
a Description, the Filename and the legend Data Type which may be text or 
numeric. Next to these entries are buttons to save and/or Close the dialog.  The 
Save As button allows you to save a legend in a new folder and with a different 
filename if required.

For information on creating and modifying legends, see:

• Creating a New Legend

• Modifying Legends
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• Additional Legend Modification Tools

Creating a New Legend

 
New Legend dialog

1. Click New button to display the New legend dialog.

2. To use an existing field in a drillhole downhole table as the basis for the 
new legend check the Populate legend from dataset or feature 
database box. Select the downhole table from the Dataset pull-down list 
and the data attribute column from the Field pull-down list. If an existing 
field is not used to create the legend, the number of rows and data range 
will need to be selected manually.  

• To create a legend with an even colour spread, select the option 
Use histogram equalization. 

• To condition or filter data from the automatic assignment select the 
field data conditioning option. 

3. Select the legend Data Type from the following options: 
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• Text – Individual textual categories 

• Numeric – Numeric ranges whereby the upper limit of one range is 
continuous with the lower limit of the next range. Only values that are less 
than the maximum value for each range are displayed using the range 
colour. If using the Populate legend from dataset option the maximum 
value will need to be increased in order for the maximum value in the 
dataset to be coloured. 

4. Select the Number of rows to display in the legend. If a text field is 
selected as a Data source the number of rows is automatically populated 
with the number of unique data entries. 

5. Enter the Data range to use for numeric legends. The data range 
determines the minimum and maximum data values to display in the 
legend. The data range is divided by the number of rows to create the 
initial legend from and to values. If a numeric field is selected from a 
downhole table as a Data source the data range is automatically 
populated although this value can be changed manually. 

6. Enter a Legend name for the output table. If a field is selected from a 
downhole table as a Data Source the legend name is automatically 
created by concatenating the downhole table and attribute field name 
together. This name can be overwritten with a user-defined name. 

7. Click OK to display the legend in the Legend Editor dialog.

Legend Editor dialog with assigned properties, colours and patterns
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Modifying Legends

Each legend is composed of a number of properties that can be modified at any 
time. To modify a legend select the legend from the list. The existing legend 
properties will be automatically displayed in the Legend Editor window. For each 
legend entry the following legend properties are available:

• Row – incremental row number

• String – a text string to describe the item of the legend row. Double-click 
to edit.

• From (>=) – Numeric legend minimum range value. Double-click with the 
mouse in the From (>=) column to modify the entry (Only available for 
Numeric continuous Data type).

• To (<) – Numeric legend maximum range value. Double-click with the 
mouse in the To (<) column to modify the entry (Only available for Numeric 
continuous Data type).

• Fg (Foreground colour) – Colour used for solid or pattern fills. Left-
mouse click in the Fg colour box in the legend entry to display the colour 
palette. 

Select from any of the standard colours available or press Custom to 
create a new colour. In the Colour dialog select a colour from the Basic 
Colours palette. Click in the colour spectrum window or enter RGB or 
HSL values until the desired colour is created. Use the Add to Custom 
Colours button to add the colour to the Custom Colours palette. The Fg 
colour can also be set to Transparent to display data with this legend 
entry see-through.

• Bg (Background colour) – Colour displayed as solid background fill if a 
pattern is selected. Selection of background colours is identical to 
selection of foreground colours (see above
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• Pattern – Pattern displayed for a legend entry. Left-mouse click in the 
Pattern box in the legend entry to display the available patterns.  The 
pattern selected is drawn with the colour of the nominated Background 
Colour (see above). Pattern styles are stored in bitmap files located as 
specified in C:\Program Files\Encom\Common\Patterns.  

• LCol (Line Colour) – used to form a drawn line boundary around the 
specified legend row entry. Selection of Line Colours is identical to 
selection of foreground colours (see above).

• LStyle (Line style) – Line style used for trace shade or histogram 
boundaries and structure ticks. Left-mouse click in the LStyle box in the 
legend entry to display the available styles.

• LThick (Line thickness) – Line thickness used for trace shade or 
histogram boundaries and structure ticks.

• Comment – a descriptive text entry for each legend row can be stored 
with the legend if required.

Additional Legend Modification Tools

Various operations can be performed over a selected range of legend rows within 
a column. Select the 1st cell then, holding the SHIFT or CTRL keys, click on the last 
cell for the desired range. Selected cells are highlighted in the editor. The 
following operations relate to selected cells: 

• RGB Interpolation automatically interpolates Red:Green:Blue data 
values across rows of selected cells. To use this feature, select a vertical 
column of cells.

• HSL Interpolation - automatically interpolates Hue:Saturation:Lightness 
colour data across selected legend rows. Its operation is identical to the 
RGB Interpolation option.



774 Encom Discover PA User Guide

• Step Patterns - assigns patterns from the pattern list incrementally 
from the first selected pattern cell to the last selected cell.

• Duplicate Patterns copies the pattern of the first selected cell to 
the last selected cell.

• Insert row places an empty row before a selected row or cell.

• Delete rows removes single or multiply selected rows. Any cell 
selection that is highlighted is removed with this operation. A 
confirmation message is displayed before the rows are deleted.

Tube Shape Manager

3D data lines can be displayed as tubes with a user-defined cross-section. The 
cross-section can be either open or closed and any number of tube cross-
sections can be defined. Using the Lines data type in the Workspace tree, 3D 
traces of any linear data can be displayed. A description of displaying linear data 
as Lines in a 3D window is provided in View Line Data in 3D Displays.

An example of this is shown below where a cross shaped tube has been used to 
indicate a series of flight lines. A range of cross-sectional shapes can be used and 
these are created and manipulated by the Tube Shape Manager.

  
Example flight lines using a colour modulated tube shape Note the cross-sectional tube 

Warning After the legend is saved, deleted rows cannot be restored.
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shape

The manager edits and manages tube cross-section shapes that are stored in an 
.ETS file. The dialog for the Tube Shape Manager appears as:

The Tube Shape Manager and selection of cross-section shapes

You can alter the name and description of individual shapes from the Edit shape 
properties button. Cross-sectional shapes are imported from MapInfo 
Professional.TAB or .MIF files. Remove any shapes using the Delete shapes 
button.

The specification of an .ETS shape file is described in Appendix B: Data File 
Specifications. 



25 Database Utilities 777

25 Database Utilities
The Database menu provides access to the following functionality:

• Database Maintenance – performs simple maintenance on Geosoft 
databases, e.g. delete or rename lines.

• Build Array Field (Array Channel Builder) – build multi-channel data (such 
as Geotem or EM data) from imported single channel data.

• Depth Interpolation – used to make vertical adjustments due to 
topography to depth values derived from interpretation processing of EM 
data. 

• Database Coordinates Reprojection – provides the ability to reproject 
databases to different coordinate projection systems.  

• Geosoft Database Merging– merge individual Geosoft databases to 
produce a single database.

• Line Utility – selection of tools for processing or manipulating Geosoft 
survey database files.

• Line Calculator – provides the ability to create new fields in a database 
based upon user-defined calculator expressions.

• Line Filtering – performs line-based operations including padding, filtering 
(convolution, FFT, and user-defined), null filling, noise adding, and 
threshold.

• TEM Tau Calculator – computes the time constant Tau value (and 
associated error data) along lines containing EM decay readings and then 
save the results in the database.

• Flight Path Simulator – create a simulated airborne survey Geosoft 
database from a DTM grid surface.

• Airborne Quality Control Tool – check that contractual obligations have 
been met in the collection of airborne geophysical survey data

• Diurnal Correction Tool – applies diurnal corrections to magnetic values 
recorded in a database.

• Flight Lines to Vector File – create a vector file of survey lines from an 
open database.
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• 3D Symbol Generator – converts individual depth and property solutions 
into 3D objects for display in 3D.

• Stacked Profiles Tool – creates a graph in 2D of a nominated channel 
displayed along a traverse base line.

Database Maintenance

The Database Maintenance tool is accessed from the Database menu and 
allows you to remove or rename data channels of a database or to delete data 
lines.

Note The tool operates independently of Encom Discover PA and can modify Geosoft 
Oasis databases. Geosoft databases can only be accessed by one application at 
a time, so you cannot make any modification to a database that is concurrently 
being accessed by Encom Discover PA. If you have a database open in Encom 
Discover PA and wish to use this tool, you must close the relevant dataset. A 
simple way of doing this is to use the File>Close Dataset menu option and 
select the database required.

Note Databases may have protected data fields. These fields are indicated in the 
Database Maintenance tool with an *. No change can be made (e.g. from the 
Line Calculator or with a Projection Transformation) while the relevant channel is 
protected. A protected channel can be used in say, the Line Calculator, but not 
altered. You can reset the protection of a data channel using the Protect and 
Unprotect buttons.
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Specify the data channels and data lines that require renaming or deletion.

To rename a data channel:

Highlight a single field from the list in the left side of the dialog and press the 
Rename channel button. Specify a new channel name and click the OK button. 
This process alters the data channel name for all lines in the database.

To use the utility, select a single dataset using the Browse button. The dataset 
is analysed and the number of data channels and lines displayed.
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The Rename channel dialog.

To delete channels:

You can multiply select the required channel names using the mouse cursor and 
the SHIFT and CTRL keys. Once selected, press the Delete channels button. You 
are asked to confirm the removal of the nominated data channels.

To rename lines:

Highlight a single line or multiple lines from the list on the right side of the dialog 
and click the Rename line button. Specify a new line name in the dialog that 
appears and click the OK button.

Important Deleted channels cannot be restored.
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The Rename line dialog.

To change line prefixes:

Press the Rename line button and specify a new line prefix in the dialog that 
appears and click the OK button.

The Change line prefixes dialog.
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To delete lines:

You can multiply select the required line names using the mouse cursor and the 
SHIFT and CTRL keys. Once selected, press the Delete lines button. You are then 
asked to confirm the removal of the nominated lines.

Advanced Options

The Advanced button provides additional options on the maintenance of the 
loaded database. 

The Advanced Options dialog for the Database Maintenance utility.

The option to Analyse the fiducials when loading a GDB file instructs Encom 
Discover PA to analyse the fiducials of the database when it is next opened into 
the software.  

Pressing the Compact database button will produce a compact copy of the 
original database, leaving the original unchanged. Compacting will remove 
unused blocks from where channels and lines have been altered or removed and 
will reduce the size of the database accordingly. When this button is pressed a 
summary report will be displayed, reporting how much compacting the original 
database will change the database size by and prompting confirmation that this 
operation is to be performed.  

Important Deleted lines cannot be restored.
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Pressing the Enlarge database button will display the Enlarge database dialog 
as illustrated below. This dialog allows you to increase the capacity of the 
database for adding new field (channels) to it by using other Encom Discover PA 
utilities, such as the Line Calculator, Grid Interpolation, etc.

The Enlarge database dialog allows the specification of the number of new channels to be 
added.

Build Array Field

Typically, the use of Geosoft Oasis Montaj databases in Encom Discover PA 
requires that multi-channel data (such as Geotem or EM data) are imported as an 
array. The Build Array Field utility can join channels that have been imported into 
Encom Discover PA as separate data fields. These fields can then be saved as a 
new, single arrayed data field.

The Array Channel Builder can be run from the Database>Build Array Field 
menu.

The Array Channel Builder interface appears as:



784 Encom Discover PA User Guide

Array Channel Builder dialog with individual channels selected

The Array Channel Builder requires the dataset containing the individual channels 
to be specified in the Dataset field at the top of the dialog. Available channels of 
the selected database appear in the Unselected channels list on the left hand 
side of the dialog. 

Depth Interpolation

The Depth Interpolator is used to make vertical adjustments to depths derived 
from interpretation processing such as EM Flow whereby data is contained in a 
database with depth and property arrays. The depth interpolation is required in 
the processing of such data to account for offsets due to topography and original 
data elevation corrections. Refer to What Does the Interpolator Do? This option 
is used as a preconditioning process prior creation of voxel models by using the 
voxel gridding module (EM Voxel). The constant depth interpolation corrects the 
resultant voxel grid for display.

Channels from this list can be highlighted and moved to the Selected channels 
list on the right using the select channel arrow. The order in which the channels 
are displayed in this list indicates the order in which they will be presented in the 
array. These channels can be re-sorted individually using the Move channel 
arrow buttons. Alternatively, if you want the selected channels to be sorted 
numerically, click the Numeric Sort button. A third option is to sort the data 
channels alphabetically using the Alphabetic Sort button.
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The Constant Depth Interpolator can apply the interpolation operations directly to 
data fields of a Geosoft database. You can initiate the Depth Interpolation from 
the Database menu.

The Constant Depth Interpolator interface appears as:

 
Constant Depth Interpolator dialog

The parameters that can be specified on the control dialog are:

• DTM Field – Specify the Digital Terrain Model data channel to initially 
create real depth values

• Input Fields – These entries specify the required Depth and Value or 
property specification field. These data fields should be multi-arrayed.

• Dataset – This entry details the required database to be used as input and 
to be modified. The database should contain arrayed depth and property 
data fields. Within the processing you can also select which lines are to be 
interpolated using the Line Select button.
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• Output Fields – The entry names are automatically derived from the input 
data fields, but they can be altered is desired. The program appends the 
text “_interp” after the specified input data field names.

• Interpolation – The depth and conductivity data fields (in the above 
example) are interpolated using either a linear, exponential or expansion 
factor (see below).

• Output Bands – The number of output bands usually matches the 
number of input bands but if a different depth increment level is required, 
you can increase or reduce the number of required bands.

• Find min/max depth – This button computes statistically the minimum 
and maximum depth values in the database and automatically populates 
the Output Depths. The values computed can be overwritten but this 
option makes estimation of output simpler.

• Min/Max Input Depths – These values are automatically computed from 
the database when the Find Min/Max depth option is used.

• Min/Max Output Depths – You can have the program automatically enter 
these fields by adopting the result of the Find Min/Max depth option or 
the depth values can be overwritten to a different data range. In this case 
the specified input data field is used to interpolate the output property 
values.

• Specify Depth Increment – If a uniform depth increment is required to be 
created, enable this option and specify an increment in metres.

• Interpolate over nulls – Where nulls occur in the input data, the property 
data are interpolated such that no gaps appear in the output gridded data.

What Does the Interpolator Do?

To prepare layered, array data for 3D gridding (using the Array Data 3D Gridding 
utility) the Constant Depth Interpolator is used. The Constant Depth Interpolator 
performs two processes:

• It converts the depths within the inversion database to real depths. In 
applications (such as EM Flow), the depths derived from the inversion 
processing are not absolute values. The depths require adjustment due to 
topography and the height of the aircraft/sensor above the ground and so 
correction should be applied to create real depths.
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• With the real depths for each reading computed, these depths need to 
have their associated data values interpolated to flat layers such that the 
3D Gridding can create correct depth voxel models.

If the first step of the processing is required, it is achieved by specifying a DTM or 
Z Offset data channel (use the DTM field option). Once specified, real depths are 
computed. In some inversion routines where true depth layering is derived, this 
stage of processing is not required. 

The depth interpolation procedure adjusts the depths of the output data channel 
to have a constant depth with adjusted associated values for creation of the voxel 
model.

Interpolation Processing

For each reading of the specified database, a depth and property data field exist 
as arrayed readings. As the results are computed from the interpretation source 
program (for example, EM Flow), the depths may be offset vertically from one 
reading to another. Therefore, the Constant Depth Interpolator adjusts the depths 
for each reading up or down such that the final result has a value of the property 
for constant depths below a reference level.

The interpolation can be:

• Linear – An equal spacing of incremental steps between each depth value 
is computed.

• Exponential – An exponentially increasing depth between adjacent depth 
intervals is computed.

• Expansion Factor – This option increases the thickness (depth) 
increment for each property layer by a specified percentage. For example 
if the first layer were 10 metres thick and an Expansion Factor of 10% 
were used, the second layer would be 11 metres thick, the third, 12.1 
metres etc. and expanding by 10% for each successively deeper layer.

Database Coordinates Reprojection

The Coordinate Transform tool allows the location data stored in a database to be 
re-positioned. Different Projection, Spheroid and Datum information can be 
specified from that originally stored in the database location channels and new 
positions computed.
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When a transformation of position is performed, all associated data channels 
retain their original values. The database can have new easting and northing data 
channels created and added to the original database or the new positions can 
overwrite the original easting and northing values.

The options available from this tool are:

Dataset

With a database opened within Encom Discover PA, access the Project 
Coordinates tool and specify the required database.

X/Longitude and Y/Latitude Fields

By default, you are required to nominate the X/Y or Longitude/Latitude data fields 
that contain the database position information. A pull-down list allows you to 
select this.

Coordinate System

Specify the input coordinate system from the Choose button. The Category and 
the Members of the Category allow selection of a wide range of datums and 
projections.

Overwrite existing X and Y fields

The original easting and northing data fields can be optionally overwritten. 
Alternatively, name new Projected easting and northing data fields. Specify the 
required output Coordinate System to use.
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Project Coordinates dialog to nominate the database and specify new coordinate positions.

When the coordinate information is specified, click the Transform button. The 
new database position data channels are computed and replaced or are added to 
the required dataset.

Geosoft Database Merging

The GDB Merge utility is accessed from the Database menu and allows the user 
to merge individual Geosoft databases to produce a single database. 

The GDB Merge utility allows the user to select all Geosoft (.GDB) databases to 
be merged and begins by reading the field list from each database and creates a 
new field list which is the superset of these. 

The utility then reads each database in turn detecting the line names present in 
each. If two databases are found to have the same line name(s) present then the 
process will abort. 

Warning If output Easting and Northing values are named the same as the input values 
and the Overwrite existing X and Y fields option is on, the original data values 
are overwritten. In this circumstance, the new data is then re-displayed and 
reprojected to the new, transformed locations in Encom Discover PA
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The utility then creates an output Geosoft database (.GDB) with all fields merged 
into it and finally reads the lines from the first database and inserts them to the 
new Geosoft (.GDB) database, filling any fields that are in the output database, 
but not in the input Geosoft database with default/null values. 

The process is then repeated for the second Geosoft database, then the third 
database, etc.

The GDB Merge utility merges all lines and fields in multiple Geosoft databases into one 
Geosoft database.

The GDB Merge utility merges all valid fields and lines from multiple databases  
into one new database.

Line Utility

Database > Line Utility

The Line Utility contains a number of tools to process a survey (Geosoft) 
database. These contain tools for processing or manipulating database files. 
Each tool has a Properties (Settings) option dialog. There is also a description, 
and input/output file description for the selected utility.

To run a utility:

1. Select the utility.

2. Click on the Properties button.

3. Select the input file and select the options as required for the utility.

4. Click OK to close the properties dialog.

5. Click Commence to run the utility.
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To run another utility, repeat steps 1–5.

Spatial Sort Database Along Line

The spatial sort utility will sort samples/stations in each line. Three sort methods 
are available -

• Sort by selected field – stations are sorted by increasing value of the 
selected numerical field. Typically this field will be the fiducial or station/
sample order.

• Projection onto XY line – for each line, the stations are projected onto a 
best fit straight line along the line's bearing. Stations are then sorted 
according to the order along this line that they occur.

• Station proximity following – stations are sorted, starting from the first 
point in the line, it will then calculate the distance against every other point 
in the line and place the closest station second. It then iterates to the 
second station and repeats the process for each station along the line. 
This is a very slow method, and is only recommend for non-linear lines or 
lines without a ordering/fiducial field.

Decimate by Station Rate

This utility will create a smaller database containing only 1 in every Nth station/
sample point.

Subset a Database by Lines

This utility will create a smaller database containing selected lines from the input 
database. You can select the lines individually, every Nth line or by a graphical 
map selection.

Clip a Database to the Area Within a Polygon or Rectangle

The clip utility will clip a database to the stations that are within a polygon (or 
group of polygons). This requires a vector file defining the polygons. Alternatively 
a bounding rectangle can be specified to clip too.

The output lines are automatically suffixed based on the polygon that they 
intersect, and what portion of the original line they are. The suffix is in format 
LineName.A:B, where A is the "piece" of the original line, starting from 0. 
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For example, if a single line is cut into three pieces, they are 0, 1 and 2, numbered 
from the start of the line. B is the polygon code, starting from 0. If there is just one 
polygon cutting the line into multiple pieces, then they would all be ":0". But 
separate polygons will have incremented numbers.

Compute IGRF Parameters

The IGRF utility will calculate the IGRF models inclination, declination and 
Intensity. The results for each station will be appended in new fields to the input 
database.

To allow the computation of IGRF values at each station, the stations location in 
X, Y fields and the projection of the units must be defined. Also a Z field maybe 
defined, or a constant Altitude/elevation used. As the IGRF model varies over 
time, and Time field or constant date must also be set.

Line Calculator

The Line Calculator can apply arithmetic operations directly to data fields of a 
Geosoft or Intrepid database, or between data fields of a database. You can 
initiate the Line Calculator from the Database menu. 

The Line Calculator interface appears as:

Line Calculator dialog with TMI computation formula
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The Line Calculator requires a formula to be specified in the command line at the 
top of the dialog. Available data fields appear in the left scrollable list from the 
nominated Geosoft montaj or Intrepid database (GDB). Complex data field 
operations such Boolean, comparative, logical and decision functions can also be 
applied. These operations are described in Calculator Syntax.

Clicking individual operation’s buttons causes their display to be automatically 
placed in the command line. You can either enter formula directly into the 
command line by typing from the keyboard, or by selecting the appropriate fields 
and buttons. Note in all cases that a correct arithmetic formula must be written. If 
the calculator detects errors in the command entered, a message indicating an 
invalid expression is displayed.

Buttons along the base of the dialog allow you to Select a field (after highlighting), 
Load or Save a formula, or Compute the displayed formula. The formula 
specification is as for normal algebraic operation. In the above example, a new 
data field (TMI) is to be created from existing data fields (FMag added with 
Regional_Mag). A new TMI data value is calculated and written into the database 
for every data reading of the database survey.

The Insert Function button allows you to construct complex formulae. A wide 
range of arithmetic, logic and comparative operations are available with the Line 
Calculator. A subset of the formulae are provided by the pull-down list that 
provides the various operators and an example of their use. Refer to Special Line 
Calculator Operations for a list of the operators available.
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Line Calculator controls and button definitions.

Note too that the Line Calculator can be used for multi-banded, array field 
operations (refer to Special Line Calculator Operations). This means that 
arithmetic operations of arrayed data fields or between similarly arrayed multi-
banded fields can be done

• Reserved Channel Names

• Special Line Calculator Operations

• Array Operations

Note If a data field does not exist in a database, the Line Calculator creates one. 
Similarly, if you request a data field result from a formula but the field already 
exists, the existing data is lost and replaced with the recalculated data. You can 
also create a new data channel from the New Field button. When this is selected 
you can assign a new name, and if the new channel is to be multi-banded 
(arrayed), also specify the number of channels to be assigned.

Note Output channel names should be chosen with caution. The Line Calculator has a 
number of reserved words that should not be used for channel names.
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Reserved Channel Names

Special Line Calculator Operations

Some operations with the Line Calculator can be applied for specific uses using 
specific command line controls. For example, if you wish to create a new channel 
that contains the number of the channel (eg EM multi-banded data) for labelling 
each trace in a profile), there is a special operation for this.

For example, you could create a multi-banded field called Ch_No which has 10 
bands using the New Field button.

Example 1

To use a new channel for labelling traces of a multi-banded dataset, create a new 
channel using the New Field button and call it Ch_No but have it contain the same 
number of bands as the channel to be labelled. Now set an expression in the 
Command Line of the Line Calculator that says:

Ch_No=_band

This populates the Ch_No channel with the numbers 1, 2, 3, 4 etc up to the 
number of bands in the initial nember set when created.. 

Example 2

If you type:

Ch_No=_band/_bands

then for every line and station value band 1 of Ch_No will contain 1/10 = 0.1, band 
2 of Ch_No will contain 2/10 = 0.2, band 3 of Ch_No will contain 0.3, ..., and band 
10 of Ch_No will contain 1.0.

Example 3

If you type:

Test=_station 

ABS ACOS ASIN ATAN COS

EQV EXP LN LOG SIN

RAND SQRT TAN
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then a field called Test will be created which for each line contains the station 
number. e.g. Test for Line 1 Station 1 will contain the value 1, Test for Line 1 
Station 2 will contain the value 2, etc.

Note that:

Array Operations

For use with the Line Calculator, array data expressions can be used. The array 
index of zero [0] is not used. An array index one [1] is the first element in an array. 

Syntax

Output = Ch1[m] operator Ch2[n]

where the Output data channel (a non-arrayed channel) will contain the combined 
operator result of the mth band of channel Ch1 with the nth band of channel Ch2.

Example 1

ZCh_ratio=ZCh[1]/ZCh[2]

Example 2

Spec_Ratio = K[215]*K[168]/Tot[32]

Line Filtering

The Line Filter module is a powerful tool that provides the following functionality:

• Numerous line-based operations including padding, filtering, null filling, 
noise adding, and threshold.

Variable Function

_band Creates an increasing number based on the number of array 
values of the requested field (eg Ch_No of 1,2,3,4...).

_bands Creates a constant number entry of the total number of array 
values in the field (eg Ch_No of 24, 24 24, 24 etc).

_station Creates a station number for each value entry of the field.

_stations Creates a total number of stations of each line.
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• Convolution line filters can be applied including standard, Gaussian, 
average and user-defined filters.

• FFT filtering using sophisticated operators to apply geophysical filter 
results.

Access to the Line Filter module is from the Filtering>Line Filters menu item.  

All operations of the Line Filter module are applied to individual reading values of 
a specified data channel of an open dataset. Padding can be applied to fill nulls 
in the data and to the ends of the line to avoid end effects from the filters. Nulls 
are skipped in the processing but optionally transferred through to the output 
channel in the same location as for the input channel. 

There is no option to apply an operation that overwrites the original, input data 
channel. You can, however, overwrite a previously created output channel. This 
is useful when resetting filter parameters and wanting to update processed 
results.

Line Filter Settings dialog

Line filter operations are cumulative in their effect. This means that as a filter type 
is selected, its presence is listed in a scrollable list. Processing (when applied by 
clicking the Process button) is applied to the data using the first operation in the 
listed sequence. When completed, the second selected operation is applied to the 
output of the first, as so on through the selected operations.

The Line Filter dialog presents selection fields for the dataset, input data channel 
plus output channel. A Line Selection buttton is available beside the Dataset 
selection field that permits filtering operation to only be applied to the chosen 
lines. As filters are added and applied, the initial channel name is used plus the 
applied filters to result in a created channel name. If you wish to rename or 
specify the output channel name, click the Settings button and unselect the 
option to Automatically form output names from the filters.
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Line Filter dialog with listing of selected filters and operators 

When applying line filters, you can choose to pad before filtering to remove end 
effects and to assist the FFT process.  This is achieved by selecting the Pad 
before filtering option. The amount of padding is set in the Settings (accessed 
by clicking the Settings button)

After processing is completed you can have the original and filtered output 
channels automatically displayed in Encom Discover PA. To do this, enable the 
Show filtered data in Encom Discover PA option. A new profile display window 
is opened that has one Profile and two Curve branches specified in the created 
workspace. One of the Curves has the original specified data channel and the 
second has the filtered output.

When multiple operations are displayed in the list, their order can be controlled 
by the Up or Down arrow buttons after selecting the filter or operation. A 
selected filter can also be removed using the Delete button.
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Profile display after processing with the Line Filter.

Line filters are grouped into the following categories:

• Convolution Filters (Conv button)

• FFT Filtering  (FFT button)

• Other Filters and Line Filter Utilities (Other button)

Buttons are provided to select the various filtering operations from each of these 
groups.

Convolution Filters

The convolution filter operators define a 1 x n convolution matrix that is convolved 
along the data of a line. The convolution filters operate by passing a weighted 
kernel function across a window of data. The kernel weights are displayed in the 
dialog. For the User Defined filter the filter weights can be edited. Filter weights 
are normalised during the filter application.

Convolution filters provided include:

• User Defined

• General user-defined weightings – the user inputs weights a 
specified number of columns (stations).  Weights are normalised 
during filter application such that the sum of weights are 1.

• Averaging filter – weights of 1 are assigned over the user specified 
number of columns (stations).
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• Gaussian filter – weights are assigned as a Gaussian function over 
the user specified number of columns (stations).

• Average – Select from several predefined averaging filters. Filter weights 
are all 1.

• Gaussian – Select from several predefined Gaussian filters. Weights are 
assigned as a Gaussian distribution.

The above filters provide examples of convolution filters and how they can be 
created. If you wish to create a specific filter and so have weights that you assign, 
select the user-defined General User Defined filter. This filter allows you to 
specify the number of data values in its window from the Columns entry. Each 
cell containing a weight using this filter type can be modified by positioning the 
cursor over the cell and double clicking the left mouse button. Modify the data 
value to edit the weight. Once a series of weights have been defined, you can 
save the filter using the Save Filter button.

Specify the number, weights and save the filter for re-use 

FFT Filtering 

Fast Fourier Transform (FFT) Filters are selected from the FFT button. After a 
filter is selected, it is added to the process list and its properties are displayed to 
allow you to enter the control parameters appropriate to that filter. Fast Fourier 
Transform filters provide an alternative method to convolution filters for 
transforming data.
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The Fast Fourier Transformation operation performed in the Line Filter module 
uses the theory described by Singleton, (1969 - An Algorithm for Computing the 
Mixed Radix Fast Forward Fourier Transform IEEE Trans Audio and 
Electroacoustics, AU-17, 2, p.93.). A detailed description of the FFT one 
dimensional filters is provided in Appendix C: Grid Filters (One Dimensional FFT 
Line Filter Descriptions).

The major advantage of the FFT approach is its ability to look at the energy 
spectrum and to more efficiently process long wavelengths. 

A disadvantage often associated with FFT is that it normally uses datasets with 
lengths that are powers of 2. To avoid this constraint, a mixed radix FFT that is 
based on prime factors up to a maximum of 23 has been used. With this 
algorithm, an FFT can normally be performed on a dataset length that is within 1 
percent of the total data length. This computation and adjustment can be made 
by padding the data lines before processing. To do this, ensure the Padding 
option is enabled before using FFT filters. The degree with which padding is 
applied (as a percentage) is specified from the Settings button.

Selection of a FFT filter.

Frequencies for FFT filters are specified in a range of cycles or as wavelengths 
(in distance). Cut-off rates control the sharpness of the tapering of the energy 
spectrum. A high value for the cut-off rate will taper the spectrum more sharply, 
but may cause ringing on the edges of large amplitude changes.

Note New data channels may be created for the forward transformation process but, 
as for convolution filters, care must be taken in naming output channels since 
newly created channels can be specified to overwrite previously generated data 
with the same channel name.
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• Low pass filters pass wavelengths longer than a specified wavelength. 
The controlling parameters required are the wavelength cut-off and the 
cut-off rate. All wavelengths smaller than the specified wavelength are 
filtered.

• High pass filters pass wavelengths that are shorter than the specified cut-
off wavelength. As for low pass filters, the wavelength cut-off and cut-off 
rate are required.

• Band pass filters pass frequencies that lie between two specified 
wavelengths. Information must be entered for Short Wavelength cut-off, 
Long Wavelength cut-off and the cut-off rate (between 1 and 15). The 
result of this is the same as applying a low pass and then a high pass filter 
using the same cut-off frequencies.

• FFT Derivative filters are computed using a definable order and the 
choice of Horizontal or Vertical. Ensure the correct derivative filter is 
chosen from the pull-down list.

• Continuation – Upward and Downward filters allow either magnetic or 
gravity data to be filtered in such a manner that it appears to have been 
collected at a greater or lesser height than was actually the case. This is 
equivalent to a low pass filter operation. The height of continuation is 
specified in metres distance. When using the Downward continuation 
filter, care should be taken not to continue below the top of the shallowest 
magnetic or anomalous density contrasts, as in this circumstance the 
process becomes unstable.

• Reduction to the Equator performs a transformation on magnetic data to 
make it appear as though it were recorded at the Earth's equatorial pole. 
Information is required on the direction of the Earth's magnetic field 
(inclination and declination in degrees) and the direction of remanent 
magnetization (if any). Field inclinations should be specified as negative 
for the Southern Hemisphere.

• Reduction to the Pole performs a transformation on magnetic data to 
make it appear as though it were recorded at the Earth's magnetic pole. 
Information is required on the direction of the Earth's magnetic field 
(inclination and declination in degrees) and the direction of remanent 
magnetization (if any). Field inclinations should be specified as negative 
for the Southern Hemisphere.
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• Pseudo gravity filter can be computed from a total field magnetic data 
channel in a manner similar to that of reduction to the pole. Magnetization 
Type can be specified as Induced or through defining an Arbitrary 
Magnetization Direction. The information required is the Earth's field 
inclination and the field declination in degrees. Default Density and 
Magnetic Susceptibility values are also required to be used in zones 
where the pseudo magnetic values cannot be derived.

• Pseudo magnetic filter can be computed from a measured gravity data 
channel. The information required is the Earth's field inclination and the 
field declination in degrees. Default Density and Magnetic Susceptibility 
values are also required to be used in zones where the pseudo magnetic 
values cannot be derived.

Other Filters

A number of line-based filters and other processing operations are available from 
the Line Filter Other button. 

For many of the line filters, you must specify Operator Length. Operator lengths 
can be specified in terms of samples or metres which can be changed for your 
convenience but are converted to samples for the actual filter operation. Operator 
lengths should be chosen such that they can properly resolve the longer 
wavelengths. You should maintain an operator length which is in the order of 
twice the longest wavelength that you are trying to remove from the data, that is, 
Operator length = 2 x wavelength/data spacing.
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List of Other filters available in the Line Filter utility.

• Moving average filters are similar to low pass filters. The major difference 
is that the cut-off is not as clean as the low pass filter and it allows 
considerable leakage of high frequencies into the filter output.

• Low pass filter outputs wavelengths that are longer than the specified 
wavelength. Selection of this filter requires specification of the cut-off 
wavelength and operator length.

• High pass filters output wavelengths that are shorter than the specified 
pass wavelength. 

• Band pass filters require the specification of an upper and a lower 
wavelength. Output from this filter gives the same result as applying two 
low pass filters with cut-offs equivalent to the top and bottom wavelengths 
of the band pass.

• Median filter is a specifically designed filter for the removal of spikes or 
data having a specific wavelength and amplitude. In particular, this filter 
can be used for the removal of cultural noise in magnetic data. The filter 
operates by defining a threshold amplitude. An operator window is also 
specified to define the wavelength. The filter moves incrementally along 
the required lines and compares the middle sample of the window with the 
difference between the median value of the window and the threshold. If 
the absolute value is greater than the threshold, the median is substituted 
for the value.
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• Automatic Gain Control (AGC) filters apply a non-linear amplification 
process to a dataset intended to increase the amplitude of small 
anomalies and decrease the amplitude of large anomalies. A benefit of 
this filter is that it maintains an anomaly's shape and wavelength as far as 
possible while filtering. That is, small amplitude features are amplified and 
large amplitude features are attenuated.

The AGC process is achieved by defining a window width and using the 
mean amplitude for the line or survey to define an amplification factor that 
is then applied to the centre value for that window. 

The formulation of the AGC filter is provided by Rajagopalan (1987 - The 
use of Automatic Gain Control to display vertical magnetic gradient data. 
Bull. Aust. Soc. Explor.Geophys. 18, No.1/2 pp.166-168) as:

Where
ƒουτ is the computed AGC output
ƒin is the function input
ƒav is the average value at point f in the moving window
ƒsdwin is the standard deviation for window
ƒsdsur is the standard deviation for survey

• Analytic signal – The analytic signal filter uses the computation of the 
Hilbert Transform. The filter creates an amplitude spectrum which differs 
by 90 degrees from the original input data. This operation is especially 
useful in magnetic anomaly detection since the anomaly peaks created 
occur at infection points of the original input.

The modulus of the (3D) complex analytic signal of a function g(x,y,z) is 
given by :

AS(g) = [(∂g/∂x)2 + (∂g/∂y)2 + (∂g/∂z)2]1/2

This enhancement is popular for use in magnetic interpretation because it 
reduces complexity due to magnetization direction. The Line Filter module 
provides the 2D version of the analytic signal given by:

AS2D(g) = [(∂g/∂x)2 +  (∂g/∂z)2]1/2

f f f f
f

fout
in av sdwin

sdsur
av= − +( ) *



806 Encom Discover PA User Guide

This function produces output identical to the 3D analytic signal for any 
profile input which has no off-profile variation. For inputs that vary 
perpendicularly to the profile, the 2D analytic signal does not record the 
full variation of the 3D function. The advantage of the 2D version is that it 
can be computed rapidly along any individual line. While the 2D analytic 
signal provides only an approximation of the 3D function it does produce a 
valid comparison of model input and output channels as it is applied 
identically to each.

• First derivative filters compute the horizontal gradient of the selected 
column. No operator length is required as this is a simple 5 point 
numerical operator.

• Second derivative filters compute the second horizontal derivative of the 
selected data. A three point operator based on the work of McIntyre 
(1981) is used 

• Square root of second derivative is the square root of the amplitude of 
the second derivative filter. Negative amplitudes are preserved. McIntyre 
demonstrated that this method provided an effective enhancement 
procedure for the recognition of small anomalies on the flanks of large 
amplitude anomalies. Care is required with this filter because it is also a 
noise enhancement filter. It is often desirable to low-pass filter the 
selected column prior to second derivative filtering.

• Vertical magnetic gradients can be computed for gravitational or 
magnetic  fields. This is the vertical rate of change of the potential field. A 
high pass filter enhances the edges of shallow magnetic sources. The 
operator length should be as long as possible for accurate computation.

• Upward continuation is a classic geophysical filter for low pass filtering 
of magnetic and gravity data. It is mathematically exact for two-
dimensional geological sections. This is the case if the geology is uniform 
in a direction perpendicular to the direction of the data profile. 
Continuation height is specified in multiples of the sample interval or as a 
specific distance in metres. Operator lengths should be as long as 
possible to achieve accurate continuation.

• Fourth difference filters are useful tools for the detection of noise spikes, 
especially in aeromagnetic data. This technique is commonly used for 
quality control of magnetic data recording systems. The amplitude of the 
operator is divided by 16 to normalise the output to equivalent noise 
levels.
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• Noise generator filter can be used to study the application of other filters. 
You can artificially add white noise from this filter to create a new channel 
of signal plus noise. This channel can then be filtered to test the design 
and characteristics of a second filter in removing noise. Parameters of 
Mean and Standard Deviation set up a Gaussian noise distribution which 
is added to the input channel.

• Standard Deviation filter returns the standard deviation of the values 
contained within the moving window.  This filter can be used as a moving 
measure of noise along a line. Care should be taken at the ends of the line 
where the padding will affect the result.  It may be better to run this filter 
without padding. 

• Threshold filter had two bounds that can be set. It checks the input data 
to see if it is between the bounds.  If the data point is below the lower 
bound the filter returns -1. If it is above the upper bound it returns 1 and if 
it is equal to or between the bounds, it returns zero.  This can be used as 
a quality check e.g. to produce statistics on the number of points above a 
specified bound.

• Transform filter performs an offset and/or scaling of the input values.  To 
offset the input values without scaling, set the scaling to 1. To perform 
scaling without offset, set the offset to 0.

A range of other filters such as Band Pass, High/Low Pass Moving Average etc 
are described in the Appendix C: Grid Filters (Convolution Filter Descriptions).

TEM Tau Calculator

When interpreting time-domain electromagnetic (EM) data the time constant 
(Tau) is a direct indicator of ground conductivity and is an excellent method of 
quickly and simply acquiring an overview of EM survey results. The time constant 
is computed at every station by fitting an exponential function to the measured 
TEM decay over a subset of the off-time decay windows. Using data from survey 
lines contained within a loaded database, the TEM Tau Calculator is designed to 
compute the time constant Tau value (and associated error data) along the lines 
containing EM decay readings and then save the results in the input database. 

Note This tool requires an Encom Discover PA Professional licence. If you wish to 
purchase or evaluate this module, please contact Pitney Bowes Software..
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EM Channel Times Specification

Encom Discover PA is the ideal environment for analysing EM time domain 
survey data as it is designed to easily manage multi-banded EM data and analyse 
the decay using the Decay Curve display (see EM Decay Curves). As with the 
Decay Curve display the specification of the recorded window times used in the 
recording of the EM data is necessary for the computation of the Tau values within 
the TEM Tau Calculator. 

An ATEM.TXT file with format as shown below is the mechanism for the definition 
of these times and must be present in the same data folder as the input EM 
database.

Begin Survey
XChannelCenter[18] = {78.0625, 103.3875, 128.7125, 154.0375, 
228.7499, 341.450, 454.15, 566.85, 735.90, 1017.76, 1412.10, 1919.25, 
2539.1, 3271.65, 4116.9, 5074.85, 6145.5, 7328.85} # microSeconds.
End Survey

Tau Computation

The Decay Tool available in Encom Discover PA already computes the Tau value 
of a selected number of data channels, however the TEM TAU Calculator 
provides a mechanism to store the results in a database. In addition to the Tau 
computation formula, the TEM Tau Calculator allows the specification of a ‘noise’ 
threshold above which data channels are to be excluded from being used in the 
tau estimation process. This is specified by the user and the noise rejection is 
then calculated.

The time constant is computed by fitting an exponential decay function to a 
selection of off-time decay windows. By carefully selecting the input decay 
windows you can improve the value of the result. For example, if your aim is to 
detect good conductors then restrict the windows to late time only. Furthermore, 
measurement noise can compromise the calculation or even invalidate it. If, within 
the range of decay windows in question, the measured decay in any window is 
negative or less than a user specified noise threshold, or if the amplitude of the 
measured response is not monotonically decreasing with decay time, then the 
computation can be invalidated or modified. 

The TEM Tau calculator contains options to adapt the range of input decay 
windows at each station to ensure that the input data meets your noise criteria. 
The range of windows can be modified in response, or expanded to exclude 
windows that violate the noise criteria. The result will be a more stable and robust 
time constant computation.
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The TEM Tau Calculator utility is accessed within Encom Discover PA from the 
Database menu.

The TEM Tau Calculator dialog.

The specifications for performing a calculation with the TEM Tau Calculator utility 
are as follows:

Dataset

Choose from the available Geosoft (.GDB) databases currently open in Encom 
Discover PA from the drop-down list. Ensure that a "ATEM.TXT" file defining the 
channel times is present in the same data folder as the input Geosoft database 
(see EM Channel Times Specification).

Line Selection

Specify which lines in the Geosoft (.GDB) database will be computed.

EM Field

Ensure that the Field visible in the EM Field box is the correct array channel for 
the calculation.
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Bands to use

The user can specify which measurement windows the derived time constant 
computation should commence from and finish with. You should exclude any on-
time windows - if present. If an adaptive calculation method if selected then the 
decay windows chosen at each station will be restricted to within the specified 
bands.  

Noise Estimate

Specify a value representing the estimated noise. If the response in a decay 
window is less than this noise estimate then the window may be ignored or the 
calculation may be invalidated.

Maximum Tau

Specify a value representing the maximum number of channels to be used. The 
algorithm will find no more than MAX channels that are monotonically decreasing 
and above the noise threshold. 

Tau Calculation Method

A number of methods for determining which data channels to use in the 
calculation are provided. See Tau Calculation Methods for details.

Window Size

The number of station samples used for the adaptive tau calculation.

Continuous data

This option is available for all adaptive methods. If selected, then the algorithm 
will attempt to find an uninterrupted sequence of the requested number of 
windows that satisfy the noise criteria. If any window within the sequence does 
not satisfy the noise criteria then the window selection is modified. If no valid 
sequence of windows can be found satisfying the noise criteria then no result will 
be computed. If unselected then the algorithm can ignore invalid decay windows. 
It will still attempt to find the requested number of windows but they may not be in 
an uninterrupted sequence. 

Note A minimum of three channels must be used for the calculation to succeed.
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Output start and end bands used for Tau computation

By enabling this option, the indices of the first and the last stations of the chosen 
range will be recorded in the database as separate fields.

Tau Calculation Methods

A number of methods for determining which data channels to use in the 
calculation are provided. The options available are:

• Calculate Tau at a Selected Range

• Calculating Adaptive Tau

• Calculate Adaptive Tau (Late)

• Calculate Adaptive Tau (Early)

• Calculate Adaptive Tau (Optimum) 

The effectiveness of the Tau computation technique is based upon the selection 
of the data channels (bands) to use in the computation process. 

Calculate Tau at a Selected Range

This is a method for a fit to all off time channels in the range specified in Bands 
to use from channel A to channel B. 

Calculating Adaptive Tau

This involves the program fitting the data of the five latest channels above the 
noise estimation value using an exponential decay. 

Calculate Adaptive Tau (Late)

This is a method for computing a fit to all off time channels from channel A to 
channel B, as specified in the Bands to Use option, starting from the later 
stations. The algorithm searches for the specified number of stations with valid 
data (i.e. above the noise level and monotonically decreasing) starting from the 
later stations (i.e. the end of the decaying curve). 

Calculate Adaptive Tau (Early)

This method is very similar to the Calculate Adaptive Tau (Late) method as 
described above but the search starts from the earliest data (i.e. the start of the 
decaying curve). 
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Calculate Adaptive Tau (Optimum) 

This method will find a sequence of decay windows that return the best fit to an 
exponential decay curve and return the time constant for those windows. This 
may vary from early to late time from one station to the next and so the method 
ought to be used with caution. 

Output and Displaying the Results

The output from the TEM Tau Calculator can output to an array channel in the 
same database the following: 

• TAU – the time constant in msec

• Fit factor – fitting coefficient

• RMS error – average fitting error

• StartBand and EndBand – outputs as individual fields indices of the first 
and last bands of the chosen range which the computation used.   

Once the Tau values are computed for all available readings, the above output 
fields of data can be plotted in a Curve Profile (see Profiles) for line-by-line 
analysis or alternatively, as a Line series in a 2D Map display (see Displaying 
Lines) or else gridded (see Interactive 2D Gridding) to provide imagery of the time 
constant information.

A profile display of (from top to bottom track) the EM Channels used in TEM Tau 
calculation, and the output fields of Tau (black), Fit Factor (blue) and Error (red).
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A 2D map display of (from top map to bottom map), gridded data of the median conductivity 
field, output Tau field displayed as stacked profiles, and gridded output of the Tau field. 

Flight Path Simulator

Note This tool requires an Encom Discover PA Professional licence. If you wish to 
purchase or evaluate this module, please contact Pitney Bowes Software.

Disclaimer The flight simulation algorithm used in the SimFlightPath program is intended 
only to simulate flight surveys and not to be used to plan real world surveys. A 
number of factors such as the changes in maximum aircraft climb rate 
depending on weather conditions and altitude are not taken into account.
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The Flight Path Simulator allows generation of a Geosoft database containing a 
simulated, geophysical flight path. This utility is useful in planning flight surveys, 
minimising flying time and distance covered but ensuring a particular region has 
adequate flight coverage. An intelligent flight path algorithm is used to predict 
climb and fall rates of the aircraft over the digital elevation model (DEM) using 
aircraft performance specifications and even a look-ahead factor to account for 
pilot control when approaching an elevation rise or fall of terrain. This terrain-
following flight-track are used in calculating the resultant distance travelled and in 
estimating simulated height coverage over the topography.

The flight path can be generated from an input digital terrain (DTM) grid using a 
combination of editable parameters such as flight path angle, flight line spacing, 
station spacing, desired clearance and an optional survey area polygon, and input 
vector file representing flight lines. Aircraft characteristics are read from a 
Microsoft Access database that has been populated with several common survey 
aircraft flying characteristics. You can add extra aircraft specifications and modify 
the various survey aircraft settings in the database.

• Data Inputs

• Run Flight Path Simulator

• Using the Simulator Dialog

Data Inputs

The following data files can be used with the Flight Path Simulator:

• A digital terrain grid in a standard grid format with elevation in metres is 
mandatory. Supported grid formats are the same as for Encom Discover 
PA and include ER Mapper, Geosoft (Compressed or Uncompressed), 
Surfer etc. 

• The survey clipping polygon can optionally be used. The polygon shape 
can be an ESRI shape file (.SHP), a MapInfo Professional .TAB or .MIF 
file or a Encom Discover PA polygon from a Features database. If a 
clipping polygon is not used, a rectangular area defined by the dimensions 
of the input digital terrain grid is used by default.

• The use vectors can also be optionally used. The vector input is a 
representation of the flight lines and can be in the format of an ESRI 
Shape file (.SHP), a MapInfo Pro (.TAB or .MIF) file, an AutoCAD (.DXF) 
plus many others. If a vector input is used to define the survey lines the 
Flight lines section is disabled.



25 Database Utilities 815

• The aircraft performance database in Microsoft Access format. New 
entries can be added to the database or existing aircraft stored in the 
database can be modified.

Run Flight Path Simulator

After running the Flight Path Simulator tool from the Database menu, you are 
required to specify a digital terrain grid since this is mandatory (although you can 
create an artificial flat grid) for operating the Flight Simulator. A single dialog 
allows specification of all aspects of the proposed survey flight design (including 
traverse and tie lines). Use the Browse button to navigate to a folder and select 
the required terrain grid. Modify the Files of Type option as required to suit the 
format if necessary. 

By default, the area chosen for the flight simulation is a rectangle defined by the 
corner points enclosing the chosen terrain grid. If the survey area is to be an 
irregular shape, a polygonal area defined by a .TAB, .MIF or .SHP file can be 
used.  Ensure the areas of the digital terrain grid and polygon file overlap for 
correct operation.
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Using the Simulator Dialog

Flight path simulator dialog

The figure above illustrates the appearance of the simulator dialog using the input 
DTM Grid and Survey polygon.

• Input Files

• Creating an Artificial DTM Grid

• Survey Polygon Parameters

• Flight line parameters

• Aircraft Selection

• The Aircraft Database
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• Description of the Algorithm

• Data Outputs

Input Files

The survey area polygon may be either a MapInfo Professional .TAB, .MIF or 
ESRI shape (.SHP) file. The DTM grid file is mandatory and must be chosen first. 
After the grid is loaded the preview window shows an image of the flight path with 
the current flight path settings (assuming the Show DTM option is enabled).

  
Flight simulator preview window

Select the Refresh preview button when survey parameters are changed to force 
an update of the display 

At the top of the dialog are two File Open buttons that allow you to choose an 
input DTM grid and an optional survey area polygon. The input DTM grid may be 
any of the Encom-supported grid types. For a list of supported formats, refer to 
Appendix E: Supported File Formats.

An Additional Input button is also available if you do not have a DTM grid 
available. In this case a flat, user-defined grid can be created to generate an 
artificial flight survey. Refer to Creating an Artificial DTM Grid for further 
information. 
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Creating an Artificial DTM Grid

Survey Polygon Parameters

  
Survey Polygon details derived from a loaded polygon file

This section of the dialog allows you to control the area of the DTM over which 
the flight lines are generated. If no survey polygon has been provided in the input 
files section, you can alter the corners of the default rectangular survey area by 
using the spin buttons or entering new easting and northing values. The Reset to 
default survey polygon button resets these parameters to a rectangle that 
covers the whole of the DTM area.

If a survey polygon has been specified in the input files section, the Use loaded 
survey polygon check-box is checked. This can be unchecked if you wish to 
override the loaded survey polygon with a rectangular area.

If a DTM grid is not available for the area required, an artificial, flat grid can be 
created to use for the flight simulation. Click on the New flat grid button to 
display the Create new grid dialog. You can specify a rectangular area for the 
new grid (from the minimum and maximum X and Y plus the grid cell width and 
height). The grid can contain multi-bands if necessary and be assigned a default 
elevation even though the created grid is horizontally planar. Any of the 
supported grid formats can be used to save the output. Refer to Appendix E: 
Supported File Formats.
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Flight line parameters

  
Controls for bearing, spacing and line directions

Controls for the orientation and distribution of flight lines (traverses) and tie lines 
are provided for when the Use Vectors option is not selected. Entry fields in this 
section allow you to specify the line angle, and line spacing, sample spacing and 
line direction. You may also want to adjust the start offset of the flight lines (the 
distance from the centre point of the survey), and the minimum length of flight 
lines. The minimum length parameter suppresses the generation of flight lines 
that would be shorter than the specified length.

Three different line direction options are provided: constant, alternate, or race-
tracked. If race-tracked lines are selected, a number can be entered to control 
how many flight lines go in the same direction before the line direction swaps (that 
is, the number of traverse lines in each race-track).

Aircraft Selection

Aircraft selection with links to an aircraft specification database
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Select an aircraft from the database and enter the desired mean terrain clearance 
in metres. The minimum safe clearance value can also be edited. The simulated 
aircraft is an attempt to maintain the desired clearance and never goes below the 
minimum clearance. To access the characteristics of a particular aircraft or add a 
new type, select either the Edit or New buttons.

  
Aircraft properties dialog

The Aircraft Properties dialog allows you to select one of a number of aircraft that 
are stored in the database (AIRCRAFT.MDB). If you want to view or modify the 
aircraft characteristics you can click the Edit button to display the Aircraft 
Properties dialog. Changes made in the Aircraft Properties dialog can be made 
permanently by selecting the Save to Database button. You can also remove 
existing aircraft entries by selecting the Delete aircraft button. The database 
format used to retain the aircraft information is Microsoft Access (see The Aircraft 
Database).

A good internet facility to investigate aircraft flight specifications can be found at 
www.risingup.com/planespecs/.

http://www.risingup.com/planespecs/
http://www.risingup.com/planespecs/
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The Aircraft Database

The aircraft database (retained in file AIRCRAFT.MDB) is a Microsoft Access 
database that is provided with the flight path simulator. It must be placed in the 
same directory as SIMFLIGHTPATH.EXE. It contains the flight characteristics of 
a few common survey aircraft. New aircraft can be easily added using the dialog 
shown above and selecting the Save into database button. 

The aircraft database contains a single table called FlightParameters. Each row 
in this table represents the flight characteristics of an aircraft. Descriptions of each 
of the fields in this table and the units used can be viewed by opening the table in 
design mode. Most of these fields are self-explanatory, however several 
parameters are specific to the flight simulation algorithm used by the flight path 
simulator.

The Top Speed and Stall Speed are only guides for setting the Survey Speed. 
That is, the Survey Speed must be between these two values. This speed is the 
constant velocity at which the simulated plane flys. This is a simplification of 
course as in real-life the aircraft speed changes depending on various factors – 
such as climb rate, temperatures, wind conditions etc.

The Ceiling is a guide only and not used by the program except as an upper 
extrapolation limit. This is in feet rather than metres because the aviation industry 
still use imperial units.

The Max Climb Rate field contains data that is widely available in aircraft 
specifications. However, the other parameters related to climbing and descent 
are more difficult to determine. Max Climb Rate Accel is the maximum rate at 
which an aircraft can change its rate of climb. Max Descent Rate Accel is the 
maximum rate at which an aircraft can change its rate of descent.

The Maximum climb rate, Climb rate acceleration, Maximum descent rate, and 
Descent rate acceleration determine how steeply the flight line can climb over 
peaks and how swiftly it can descend on the other side of a peak. Climb rates are 
in feet per minute and accelerations are in feet per minute squared.

The LookAheadClose and LookAheadFar fields provide the look-ahead 
distances for the terrain following and collision avoidance algorithms respectively. 
The LookAheadFar distance is the distance ahead the simulation looks to ensure 
that the aircraft will always have enough altitude to clear any peaks which are 
coming up. The best value for this is quite large (e.g. 20km) to ensure the plane 
never crashes. The LookAheadClose distance by contrast needs to be 
reasonably small (e.g. 250m) to allow averaging of small scale changes in the 
terrain.
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Description of the Algorithm

When you choose an aircraft for the simulation from the aircraft database, a 
number of parameters are read including the maximum climb rate, descent rate, 
and maximum accelerations of these. These may be manually overridden for the 
current simulation to match expected conditions such as air temperature and the 
average altitude of the survey.

The simulation is performed one flight line at a time and proceeds through the 
following steps:

Step 1: Determine initial altitude of aircraft.

This altitude is chosen such that the aircraft is as close to the ideal ground 
clearance as possible while still allowing it to clear any peaks which lie in its path.

Step 2: Determine desired altitude for next aircraft position.

This uses the “look ahead close” distance to determine the average height of a 
window of terrain (typically a few 100 metres wide) and its average slope. These 
values are used to adjust the current climb rate of the aircraft to make it “hug” the 
terrain so that it flies as closely as possible to the user’s desired clearance.

Step 3: Dampen change in climb rate.

A dampening formula is applied to any changes in climb rate so that the aircraft 
does not oscillate too much above and below the desired clearance.

Step 4: Check for long-range collisions.

The look ahead far distance is used to determine whether the aircraft can clear all 
peaks that lie ahead (typically this look ahead distance is 10-20 kilometres). 
When it becomes necessary to clear a peak by applying the maximum climb rate, 
the algorithm switches into collision avoidance mode and increases the current 
climb rate by the maximum climb rate acceleration each simulation cycle. It 
continues to do this until there is no longer any danger of a collision and then 
reverts to ground hugging mode.

Step 5: Move the simulated aircraft and record the station position.

The changes in climb rate are applied to the simulated aircraft and its ground 
position is advanced to the next simulation position. (The aircraft is assumed to 
move at a constant, user-configurable, survey speed.)

Repeat steps 2 through 5 until the aircraft reaches the end of this simulated flight 
line.
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Data Outputs

Encom Discover PA Spreadsheet summary of simulated survey fields

The simulated flight path is saved in a Geosoft Oasis montaj database (.GDB) file 
that can be accessed from Encom Discover PA.

The database fields created by the flight simulator are listed in the table below

F Description s
X Easting m
Y Northing m
Z Aircraft elevation m

Terrain elevation at sample location

C Ground clearance (radar altimeter) m

Ie Target terrain clearance m

Mi Minimum elevation m

Aircraft climb rate fe

S Aircraft speed ks
C Cumulative distance along line
P Distance projected onto an average baseline 

orientation
m
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Airborne Quality Control Tool

Introduction

This utility is a plug-in to Encom Discover PA which is designed to help check that 
contractual obligations have been met in the collection of airborne geophysical 
survey data.

 Before running the tool, the survey dataset must be open in Encom Discover PA. 
When the tool is run the user must select the input dataset and then choose the 
lines that are to be processed. Lines are considered to be either normal lines or 
tie lines. The normal lines are assumed to be in approximately the same 
orientation as each other (or at 180 degrees to this orientation). All quality control 
checks except for line spacing are performed on all selected lines. Line spacing 
is only checked for normal lines.

Quality Control Checks

• Check station spacing

• Check line deviation

• Check values for field

• Check normal line spacing

• Report survey lines which are approximately co-linear

• Report on normal/tie-line intersections

• Output options

Note This tool requires an Encom Discover PA Professional licence. If you wish to 
purchase or evaluate this module, please contact Pitney Bowes Software.
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Check station spacing

The station spacing dialog.

The Check station spacing option is performed along every selected line. Any 
stations which are less than or greater than the specified distances apart along 
an individual line are considered to be a problem. The range of acceptable station 
spacings are specified using the dialog which pops up when the corresponding 
Properties button is pressed. This dialog also allows the problems to be reported 
in a variety of ways:

• Report all out of range values

• Report where the values are continuously out of range over a specified 
distance

• Report where the values are out of range over a cumulative percentage of 
the line length

These reporting options are designed to mirror the common contractual 
requirements.

Check line deviation

The Check line deviation dialog.
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The Check line deviation option is performed along every selected line. First, the 
best fit line is computed using the least squares linear regression method. Then, 
the perpendicular distance of every station on the line from the line-of-best-fit is 
computed. Distances which are outside the range specified using the properties 
dialog are reported with the same options as for station spacing above.

Check values for field

The Check values for field dialog. 

The Check values for field is a general purpose option that is performed for the 
specified field on every selected line. Fields which are outside the range specified 
using the properties dialog are reported with the same options as described 
above. This check may be useful for finding aircraft clearance values which are 
outside the acceptable range for the survey. If a clearance field is not available in 
the dataset this may need to be computed using the Line Calculator plug-in 
before running this tool.

Check normal line spacing

The Check normal line spacing dialog.
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The Check normal line spacing option is performed between selected normal 
lines only. First, the lines are sorted spatially (using the best fit lines), and then a 
list of adjacent lines is generated. For each pair of adjacent lines, the distance 
between corresponding stations along the lines are computed. Any distances 
greater than the value specified in the properties dialog are reported using the 
same options as for the other checks above.

Since flight lines are sometimes flown in multiple passes, a further option on the 
properties dialog allows a distance to be specified below which adjacent lines are 
considered to be approximately co-linear. Specifying a non-zero distance here 
will allow the program to compare only the correct pairs of adjacent lines to check 
for line spacing. The value you choose depends on the survey. To visually check 
for lines which are approximately co-linear in PA, open a 2D flight path map and 
turn on the Symbols option at the end of the flight lines under the Flight Path 
Properties>Appearance tab.

Report survey lines which are approximately co-linear

The Report survey lines which are approximately co-linear option operates with 
the Line spacing check and uses the same properties dialog. If this check is 
enabled, then report entries will be generated when approximately co-linear lines 
are detected.

Report on normal/tie-line intersections

The Report on normal/tie line intersections option reports all 2D intersections 
between the selected normal lines and the selected tie lines. The report includes 
the location of the intersection and the interpolated vertical offset between the two 
lines. The vertical offset is computed using the selected Z 

Output options

When the Perform QC checks button is pressed, a summary of the qulaity 
control checks are displayed in the top right of the dialog and a report is generated 
for all the checks selected in the QC options area of the main dialog. 

The report is shown at the bottom right of the dialog and can be saved to a .CSV 
file or any of the supported vector file formats (e.g. MapInfo .TAB) using the Save 
reported points button. If the report is saved to a vector file, then this file can be 
displayed in Encom Discover PA over a 2D flight path map to highlight where the 
problems have been found.
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The Report preview dialog.

The Information button  provides the definitions for the codes that are 
displayed in the report (third column).

The definition of report codes dialog.

The best fit lines computed during the run can also be saved to any supported 
vector file format using the Save best fit lines button, and may also be overlaid 
on a flight path map.

A final output option is to save the per-station values checks to a new database, 
or append to the input database. This will add the selected checks as new fields 
in the input database (Station Spacing, Line Deviation and Field Check). This 
option will only output values for the first three quality control checks since they 
are the ones performed for individual lines.
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Diurnal Correction Tool

The purpose of most aeromagnetic surveys is to measure the local deviation in 
the magnetic field caused by crustal geology. It is therefore necessary to define 
the global variation in the earth's magnetic field and then subtract this from 
observed magnetic field to obtain the time constant magnetic anomaly. 

The variations in the total magnetic field with time over time scales ranging from 
seconds to millions of years have a profound effect on how magnetic surveys are 
carried out. 

Diurnal variations follow a daily cycle associated with the rotation of the earth with 
respect to the sun. The 'solar wind' of charged particles emanating from the sun, 
even under normal conditions, tends to distort the outer regions of the earth's 
magnetic field. The daily rotation of the earth within this sun-referenced distortion 
leads to variations in the total magnetic. The main variation occurs towards local 
noon when peaks are observed in mid-latitudes and troughs near the magnetic 
equator.

Since it is unsuitable for airborne surveys to be flown at night when recorded 
geomagnetic observations are more accurate, it is therefore required that surveys 
be planned so as to allow for corrections to be made for diurnal (amongst other) 
variations.

The Diurnal Correction utility, accessible in Encom Discover PA from the 
Database menu with an active Encom Discover PA Professional licence allows 
for the correction of these diurnal variations on collected magnetic values 
recorded in a loaded database.

This is achieved by specifying a loaded database containing the fields for the 
recorded survey magnetic data and Time, then the magnetic field and Time fields 
in either the same or a secondary database representing the magnetic recording 
from a base station magnetometer in the same survey region.
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The Diurnal Correction utility dialog.
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Flight Lines to Vector File

The Flight Path To Vector File plugin utility can be accessed from the Database 
menu and will produce a vector file of survey (flight) lines from a database 
currently loaded into a session. 

The Flight Path To Vector File utility dialog with specified output as a MapInfo .TAB file.

When initiated the Flight Path To Vector File dialog will appear and by default the 
first (if there is more than one) database currently loaded in the session will be 
selected as the Input Data Dataset. To change to a different database activate 
the Dataset drop-down list and select the required database.

The Line Selection dialog allows a subset of survey lines to be converted to a vector file.

A subset of the survey lines from the database can be specified for the output by 
clicking on the Line Selection button
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The X Channel and Y Channel input fields are compulsory and will be 
automatically updated when the Dataset is selected. To change to another X or Y 
field activate the drop-down lists for either of these and select the required field(s) 
in the database.

The Z Channel is an optional channel that can be assigned to the flight lines. To 
assign a Z Channel ensure that the tick box is selected and then select the 
appropriate field from the Z Channel drop-down list. To assign a constant Z value 
to the flight lines ensure that the Z Channel tick box is unselected and enter a 
value into the Z Value box available. 

The output file formats supported by this utility are:

• MapInfo TAB files (.TAB) 

• MapInfo MIF files (.MIF) 

• ESRI Shape files (.SHP) 

• AutoCAD DXF files (.DXF) 

• Comma Delimited ASCII Files (.CSV)

• Encom TKM files (.TKM)

• Google KML files (.KML)

The output file can render the survey lines as either Lines or Points. When 
working with large survey datasets a Line Data Compression (0-100) can also 
be specified.

To proceed with the conversion click on the OK button and a status bar will 
appear. 

Status bar for the conversion process.

Once complete a message will appear confirming that the conversion has been 
successful.
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Confirmation message for a successful Flight Path to Vector File conversion.

3D Symbol Generator

Encom Discover PA can be used to display 3D views of data. Frequently, 
interpretation applications can be executed to create locations in three 
dimensional space that are associated with a solution that provides information 
about the physical property at that location. For example, Euler or depth-to-
basement techniques (such as the AutoMag option of Encom ModelVision) create 
database information of solution locations with magnetic source data (such as 
magnetic susceptibility, depth, dip and azimuth). To display such solutions in 3D 
views and with other datasets (grids, drilling, modelling etc) is useful for 
interpretation.

The Symbol Generator utility program can be run to convert individual depth and 
property solutions for 3D display. The program converts the location, including 
depth and creates a variety of symbol types as AutoCad .DXF format files. The 
Symbol Generator can be run from the Database Menu. 

The Symbol Generator uses any database accessed by Encom Discover PA or 
an external MapInfo Professional .TAB or .MIF file. The database can contain line 
or point data but should optimally have easting, northing and depth information. 
The interface dialog for the Symbol Generator is as shown below:
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Symbol Generator dialog specifying a database for location of symbols

For infoprmation on using the Symbol Generator, see:

• Symbol Generator Controls

• Operating the Symbol Generator

Symbol Generator Controls

• Input Points

• Load from file – Location and attribute information can be converted to 
point symbols using MapInfo Professional .TAB or .MIF format files. Select 
this option and specify the input file location.
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• Output File – The created symbols are stored in an AutoCad .DXF format 
file. You can path and specify a filename if required.

• Direction – 3D Points can be orientated either via specification of Azimuth 
and Dip fields, of Vector component (u, v, w) fields.

• Fields – Data fields used for location (X and Y) and depth (optional) can 
be selected. If the symbols to be created are to have azimuth rotation and 
dip rotation, specify the optional Azimuth and Dip fields.

• Symbols – The Width, Length and Thickness of the 3D symbols created 
can be specified (in scaled metres). The Shape of the 3D symbols can be 
either:

• Triangular

• Rectangular (prisms)

• Arrows

• Tabular

Operating the Symbol Generator

When the Symbol Generator is executed (from the Apply button), the created 3D 
symbols are placed in the specified .DXF output file. When completed, a window 
with the output .DXF file displayed is automatically presented using a provided 
template. You can modify this template if desired.

The created display uses a 3D Map with the output .DXF file included. To this 
window you can add surfaces, flight paths, drilling and modelling. An example of 
a depth solution group of bodies derived from Encom’s AutoMag is shown below.  

• Dataset – A Encom Discover PA accessed database can be used for 
symbol creation at each data point selected by line. Line selection is from 
the Line button
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Use of 3D symbols at depth locations from an AutoMag database

Like most Encom Discover PA utilities, while the Symbol Generator is running, 
you can make modifications to the parameters and reapply these. When this is 
done, the display updates automatically and the .DXF file is saved. Once the 
dialog for the Symbol Generator is closed, you need to re-enter parameters if you 
want to alter the .DXF output.

Stacked Profiles Tool

The Stacked Profile tool creates a graph of a nominated channel displayed along 
a traverse base line. Stacked profile presentations of line oriented data are 
frequently used in geophysical data analysis.

Advantages offered by stacked profiles include:

• Anomaly positions can be made to lie in their correct location

• Subtle trends and anomaly correlation from line-to-line can be extremely 
sensitive and often more so than as presented using contouring or 
imagery

• Various filter operators can be applied to line data and optimally presented 
in stacked profile form

• Stacked profiling is independent of traverse line leveling problems.

Stacked profiles created within Encom Discover PA offer the following features:

• Control over clipping (high and low) thresholds
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• Filling of profile above or below a definable baseline (a variable area 
presentation)

• Linear or logarithmic scaling

• Clipping of upper and lower thresholds of data.

The option requires a database to be initially accessed. In order to generate a 
stacked profile the database must contain a column with a unique line identifier 
attribute (e.g. line number) and at least one numeric data column on which to 
create the profile. 

When the Stacked Profile utility is initiated from the Database>Stacked Profiles 
menu option the following dialog is presented. 

Dialog for control of Stacked Profile display with Line Selection dialog

You can select the following options:

• An available dataset, data field and channel (band).

• Individual lines can be selected from display, for example tie lines could be 
eliminated.

• Both data and baselines can be displayed. Each can have its own line 
style specified.
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• Scaling of the field data can be linear or logarithmic and comply with the 
Scale Factor of the map in which the stacked profiles are displayed or in 
units per centimetre.

• The stacked profiles can be filled above or below a threshold value and 
with different specified colours.

• Colour filled profiles can be clipped at specified upper and lower 
thresholds.

For more information about creating and displaying stacked profiles, see:

• Creating Stacked Profiles

• Displaying a Stacked Profile in a 2D Map

Creating Stacked Profiles

Initiate the Stacked Profile option from the Display Utilities menu and in the 
dialog that appears select one of the open databases from the drop-down list at 
the top of the dialog.

Note The Stacked Profile tool can also be used for Multi-Banded field data. The drop 
down box for Band selection allows different bands to be selected. 

Select the data column to display in the profile from the Field pull-down list. 
Individual lines can be selected using the Select Lines button. Line fill options 
relative to the baseline can be applied to the stacked profiles and Z scaling can 
be left on auto apply or alternatively a specific scale factor and baseline value 
can be specified.
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Example Stacked Profile dialog settings.

The controls available from this dialog are:

• Check the Draw Across Nulls box to allow Encom Discover PA to 
continue to draw a profile when a blank data field is encountered. 

• In the event of larger gaps in the sampling interval within the one sample 
line, check the Distance Threshold box and enter a distance. When the 
distance between two sample points is greater than the value entered as 
the distance threshold, Encom Discover PA starts a new profile on the 
same sampling line. If a distance threshold is not entered, a continuous 
profile for the line is displayed.

• Scaling of the field data can be linear or logarithmic and comply with the 
Scale Factor of the map in which the stacked profiles are displayed or in 
units per centimetre.

• The baseline or x-axis may be displayed with the profile. Use the 
Baseline pull-down list to select from the range of baseline options. A 
baseline may be created according to the minimum, maximum, average or 
median value of the data column. A user-specified baseline value can also 
be entered.

• When the Show Base Lines option is enabled in the Line Styles section 
the base line or x-axis of the profile will be displayed in the final stacked 
profile. The appearance of this baseline can be modified by clicking on the 
style button to the right of this option.
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• Check the Show Field Lines to display the profile for the selected data 
column. Use the line style button next to this option to select the desired 
profile curve style and colour.

• Using the options in the Fill section of the dialog each profile may be filled 
with a solid colour to denote samples with values above or below the 
baseline or a user specified value. Click on the colour buttons to change 
the fill colour. 

• The minimum and maximum values in the data column are automatically 
inserted into the Clip control section. Enable the Above or Below box to 
enter another value in order to clip the data range used to the specified 
data range.

Displaying a Stacked Profile in a 2D Map

Upon selecting the Generate button on the dialog a stacked profile is created 
using the set parameters in the dialog. A new 2D Map display will be automatically 
created showing the Stacked Profile. 

 
Example of a stacked profile map

The Stacked Profile output file type is referred to as a .GSF file extension and is 
2D vector file. Therefore in the workspace tree associated with this display the 
Stacked Profile file will be shown as a 2D Vector file branch. 
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To change the colouring and line style of the stacked profile access the 2D 
Vectors Properties dialog and view the Override tab dialog. The line colour, fill 
colour and line style as well as making the fill hollow can be altered from this 
dialog.

Use the Override tab dialog in the 2D Vectors Properties to alter the appearance of the 
Stacked Profile display.

Note To alter the map scale and vertical scaling of the stacked profiles the .GSF file 
will need to be recreated. It is therefore suggested that the Stacked Profile dialog 
is kept active until a suitable scaling can be set and then select the Close button 
on this dialog.
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26 Gridding Utilities
The Grid menu provides access to the following functionality:

• Interactive 2D Gridding –  Create a continuous surface grid from a 
selected database field using variety of interpolation methods: Inverse 
Distance Weighting, Kriging, Triangulation, Spatial Neighbour, Minimum 
Curvature, Density or Distance.

• Large and Multi-file Gridding: Interpolate multiple large data sets with 
millions of points or polylines to build a massive grid using methods such 
as minimum curvature, inverse distance weighting, and triangulation.

• Section Gridding – produce section grids from profile data such as EM or 
IP.

• Grid Calculator –  Perform grid arithmetic, statistical and Boolean 
calculations on one or more grids

• Grid Filter – Options for filtering gridded data.

• Grid Utility – Classify, grid to grid clip, clip, convert, create RGB, cut/fill, 
edit, fill holes, flip, merge, outline, overlay, replace, reproject, resample, 
rotate, shift, split, vectorize grids or calculate volume.

• Assign Grid Value to Dataset – interpolate and assign data from grid 
centre points to a Geosoft or Feature database field.

• Grid Tiler – Large grids can be 'tiled' (i.e. subdivided) into a number of 
smaller grids without needing to open the source grid into Encom Discover 
PA.

• Vector File to Grid Utility – convert a 3D .DXF vector file to a grid surface.

• SRTM HGT to ERMapper ERS – converts an SRTM .HGT elevation data 
file to a ER Mapper .ERS grid file.
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Interactive 2D Gridding 

The Interactive 2D Gridding in Encom Discover PA allows you to create two 
dimensional data grids of a selected database field (including multi-arrayed fields) 
and then output the grid to a specified grid file in any one of the supported grid 
formats. The optimised gridding algorithms used in this tool have made it possible 
to include a real-time preview window to assist you in choosing the best 
parameters for your data. This preview window allows you to experiment with 
different gridding parameters in real-time and observe the effect they have on the 
quality and appearance of your grid. The Interactive 2D Gridding automatically 
analyses the spacing and distribution of your input data and computes an optimal 
set of parameters for you. If you are not satisfied with the default parameters and 
gridding method selected by the tool, you can override these settings by selecting 
your own method and parameters (grid cell spacing, search criteria, etc). 

The Interactive 2D Gridding Tool showing the data selection tab and grid preview

For more information see:

• Using the Interactive Gridding Tool (includes descriptions of individual 
tabs)

• Previewing the Grid



26 Gridding Utilities 845

Using the Interactive Gridding Tool

The Interactive Gridding is controlled via a series of tabs to the left of the preview 
window. The number of visible tabs in the dialog varies depending on the gridding 
method selected (see Method Tab), however, the four main tabs are always 
visible irrespective of the gridding method selected. 

• Input Tab

• Geometry Tab

• Method Tab

• Output Tab

Additional tabs may be displayed depending on selections made on these tabs. 
When the gridding parameters have been selected, press the Save button. This 
closes the Interactive Gridding Tool dialog, saves the grid surface into the 
specified file and updates the original map window with the surface grid. The 
surface grid is displayed using the same look-up table as selected in the 
Interactive Gridding Tool dialog prior to saving.

• The Save button creates an output surface as specified on the Output 
tab. You do not have to wait for the preview window to complete drawing 
before saving the output grid file. If you are satisfied with the initial 
appearance of your grid you can click the Save button and the grid is 
saved in the same folder as the input data points. It is then loaded 
automatically into Encom Discover PA and placed in a display window 
specified by a default template.

• The Cancel button dismisses the grid tool without creating an output 
surface.

• The Help button displays the on-line help. 

Two additional controls at the base of the dialog determine the operational mode 
of the Interactive 2D Gridding tool:

• Automatic mode – This is specified with the Auto Apply checkbox 
selected and is the default behaviour. In this mode, any changes to a 
control parameter are automatically applied and the grid recomputed 
when the cursor is moved to another tab or field in the dialog. At any stage 
you can manually apply a pending change by clicking on the Apply 
button. If the button is disabled then no changes are pending and no grid 
computation is performed. 
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• Manual mode – Deselecting the Auto Apply checkbox places the 
Interactive Gridding tool in manual mode and grid processing does not 
commence until you select the Apply button or change back to the Auto 
Apply mode. This mode is best suited to situations where you wish to 
modify a number of parameters prior to gridding, or have especially large 
datasets where the gridding operation may take some time.

Manual mode is automatically selected by the program if the dataset is 
detected as having a large number of data points. Consequently, with 
large datasets the gridding process does not automatically commence. 
You can override this by selecting the Auto Apply option or forcing a 
computation by clicking the Apply button.

A vertical progress bar is displayed next to the preview window in both modes and 
shows you the progress of the gridding operation. You can also monitor progress 
by watching the grid growing in the preview area (see Previewing the Grid).

Previewing the Grid

The appearance of the preview display is controlled by five toggle buttons and a 
pull-down list located above the preview area. 

These control buttons are:

View input points in the preview window. Click button to remove input points 
from view.

View search ellipse in the preview window. This displays a graphic illustrating 
the search ellipse used by the Inverse Distance Weighting gridding method. The 
size, shape and orientation of this ellipse is displayed in the preview window and 
will change as you change the search parameters. This control is only available 
for the Inverse Distance Weighted gridding method.

Apply a Histogram Equalisation stretch to the image in the preview window. 
This button can be used to distribute colours more evenly across the image and 
is particularly for data with poor dynamic range.

Display images in the preview window as either coloured or monochrome (e.g. 
greyscale from black to white). This button toggles the image between 
monochrome and colour.

Apply a sun illumination to the image in the preview window. This can be used 
to enhance detail within a gridded image. The sun angle is fixed from the 
northeast direction.
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Additional controls are available by positioning the cursor in the preview window 
and clicking the right mouse button. A pop-up menu as shown below is displayed:

Preview area of the Interactive Gridding tool with pop-up menu .

Options available from the pop-up menu include:

• Zoom Mode – two levels of zoom are available – Normal and zoomed. 
The cursor changes format to indicate the level of zoom.

• Pan Mode – This mode is only available when zoomed in. Again use the 
right mouse button to select pan mode

• Show Value at Cursor – when enabled, a text reading of the location 
(row:column) plus the gridded value at the location is displayed. As the 
cursor is moved within the Preview area, the data location and value 
update in real-time.

• View Input Points – Display the location of the data points used to create 
the surface

Interrogate the interpolated surface using the Statistics Explorer. The 
individual grid nodes of the interpolated surface can be extracted and then 
examined in a spatial or frequency mode using the Statistics Explorer. Refer to 
Appendix F: Statistics Explorer for details on how to use this utility.
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• View Search Ellipse – This option is only enabled if the Inverse Distance 
Weighting grid method is used.

• Histogram Equalisation – Apply a normal distribution to the colouring of 
data values across the area of the grid.

• Pseudocolour - You can select either a Pseudocolour colour table to be 
applied to the image in the preview window or a greyscale.

• Sun-Shading – An artificial north-east sun location can be applied in the 
display of a grid to indicate gradient and shading which enhances the 
presentation of the surface.

• Settings – By default a zoom level of 4 pixels per grid cell are used in the 
display of the preview area. You can control this if higher or lower 
resolution is required. Setting of the resolution is from a displayed dialog.

Input Tab

The Input tab summarises the input data and provides a selectable list of all 
numberic data columns that are available for gridding in the source database. 
Basic summary information is provided for the selected data including minimum 
and maximum easting (X) and northing (Y) values for the minimum bounding 
rectangle that fully encloses the input data and a count of the total number of input 
points.

Numeric data columns from the Input tab appear in the Field (bands) to grid list. 
To change the data field to be gridded, select the field name so it is highlighted. 
The data range for the selected column is automatically displayed in the text 
boxes to the right and if the Auto Apply option is enabled the grid is regenerated 
for the new column. If the Auto Apply option is turned off then you need to click 
the Apply button to generate and display the new grid.
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The Input Tab dialog of Interactive 2D Gridding.

For information on using the other options available from the Input tab, see:

• Breaklines

• Coincident Points

• Statistics Explorer

• Data Conditioning

Breaklines

The Breaklines button enables support for break lines. Break lines are defined 
as multi-segment lines along each segment of which the slope is monotonically 
increasing or decreasing. Examples include stream or river traces, topographic 
ridge lines or roadways. 

To load break line data, access the Breakline Advanced Options dialog from the 
Breaklines button on the Input property page. 
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The Breakline Advanced Options dialog enables you to browse and select an 
input TAB file. Only one input file can be selected. To identify the breaklines it is 
necessary to select a LINE field from the TAB file. All vertices from all features 
with the same LINE identifier will be considered to be a single break line. This 
means that a collection of points can be grouped into polylines but it also means 
that polylines will need to have a unique LINE identifier if they are to be 
considered unique. A Z field must also be specified. It is assumed that the Z data 
will be compatible with the data field selected to grid. In order to define breaklines 
with a variable Z attribute for each node (or vertex) in MapInfo the data must be 
represented as a collection of points. These points must be assigned a LINE 
identifier to distinguish them as being part of a particular break line. By defining 
the break lines in MapInfo as a collection of points identified using a LINE 
identifier it is possible to represent complex 3D geometries such as streams, 
slope ridgelines or cliffs.

Breakline reference to a MapInfo Professional .TAB file

Coincident Points

The Coincident points pull-down list controls the handling of multiple data points 
at the same location. Coincident points may be averaged, the first or last point 
value that does not contain a null value used, the minimum or maximum point 
value taken or all points kept.

Statistics Explorer

The Statistics Explorer is a utility for examining and understanding the spatial 
and statistical aspects of a data set. It has been designed in a way that allows for 
intelligent interrogation of a data set to help identify spatial and frequency 
relationships which may be important when choosing and configuring an 
appropriate gridding method. The operation and functionality of the Statistics 
Explorer is described in the Appendix F: Statistics Explorer.
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Data Conditioning

The Grid Conditioning dialog

The Data Conditioning options enable data to be modified prior to gridding by 
applying one or more of the following processes:

Clip Input Data

Specify maximum and minimum X and Y extents to conduct a data clip. The 
source dataset is clipped to the X and Y extents by checking the Apply data clip 
option. These values can be reset to the initial dataset extents by pressing the 
Reset extents to input button. All source data points outside the defined region 
are ignored and do not contribute to the gridding.

Define NULL Values

Null values are used to flag specific values in a dataset that are not to be included 
in gridding process. These may include values indicating Sample Not Received 
(SNR) or Below Detection limit (BDL), etc. These samples may be attributed with 
a negative numerical value such as -9999 or -0.5 (detection limit). Failure to 
remove such artefacts can result in meaningless output grids.

The Null values are set for one or all bands in data to be gridded in the Field Data 
Conditioning dialog (see Appendix G: Field Data Conditioning).
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Cap Input Data Bands

Data capping options can be set to prevent outlier values in the dataset from 
being included in the gridding process. For example a maximum cap value can 
be set for gold assays which occur in mineralisation systems prone to nugget 
effects. Capping data to remove very high or very low values is used to remove 
samples which may unduly influence the cell values in the output grid.

Setting a Cap minimum or maximum value will cap source data outside the set 
limit to the limiting value. For example, if the Cap maximum value is set to 500, a 
gold assay with a value of 725 ppm will be handled during gridding as having a 
value of 500 ppm value.

Specifying background values

It is also possible to check the Convert NULL to background box and enter a 
user specified value in order to constrain the gridding. For example, if gridding 
drillhole geochemical assays, much of the hole may not have been sampled and 
in these areas the assay result may be assumed to be equal to the background 
value. This helps prevent anomalies ‘ballooning’ into areas with no source data 
coverage. 

The options presented in the Grid Conditioning dialog are global settings. If 
multiple data fields have been selected in the Input Tab (i.e. in order to create a 
multi-banded grid), these settings will affect all fields equally.

Further conditioning controls are available via the Advanced Settings button to 
the right of the listed input data field. If multiple data fields have been selected in 
the Input Tab, the Advanced Settings button can be used to open the Field 
Data Conditioning dialog, used to set individual capping and background values 
for each field by selecting the required field from the pull-down list. For more 
information on this refer to Appendix G: Field Data Conditioning.
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Method Tab

Eight gridding methods are available: six estimation techniques and two analytical 
techniques.

The Method Tab with Minimum Curvature method selected.

The corresponding tab is added to the Interactive 2D Gridding tool when a method 
is selected:

• Minimum Curvature Tab

• Kriging Tab

• Inverse Distance Tab

• Triangulation Tab

• Spatial Neighbour Tab 

• Bi-Directional Spline Method

• Density Gridding Tab

• Distance Gridding Tab

The last two analytical techniques produce grids of parameters derived from the 
spatial distribution of the input data:
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Gridding parameters can be saved and restored or applied from another grid. For 
more information, see Save, Restore, and Apply Gridding Parameters..

Save, Restore, and Apply Gridding Parameters

The Gridding Tool computes the optimum gridding parameters by analysing the 
spatial distribution of the input data. You can recompute the optimum parameters 
at any stage by using the Compute Best Values button located on the Grid 
Geometry Tab. 

You can also save grid parameters or apply pre-defined parameters:

The Load Settings button will present the user with a list of user-defined grid 
parameters. The grid configuration file GridTool.set, containing these settings, is 
located in the user configuration folder, by default this will be
C:\Documents and Settings\<user_name>\Local 
Settings\Application Data\Encom\IGridding\GridTool.xml
on Microsoft XP and older operating systems and
C:\Users\<user_name>\AppData\Local\Encom\IGridding\GridTool.xm
l
on Microsoft Vista operating systems.

The Save Settings button is used to save settings from the existing Create Grid 
session, such as gridding method and search parameters (it does not save the 
grid cell size). These settings can therefore be applied to different bands or 
different datasets. The grid configuration file GridTool.set is located in the user 
configuration folder, by default this will be
C:\Documents and Settings\<user_name>\Local 
Settings\Application Data\Encom\IGridding\GridTool.xml
on Microsoft XP and older operating systems and
C:\Users\<user_name>\AppData\Local\Encom\IGridding\GridTool.xm
l
on Microsoft Vista operating systems.

The Load From Existing Grid option is designed to load gridding parameters 
from an existing grid file. By default an Encom Discover PA-created grid will 
have an associated XML configuration file located in the same folder as the 
parent grid; to load these settings navigate to the associated XML file. Note that 
this option should only be used on the same dataset, as it will load all geometric 
settings for the grid such as grid extents and, cell size and band used.
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Minimum Curvature Tab

The Minimum Curvature gridding method is widely used in many branches of 
science and research. The method creates an interpolated surface similar to a 
thin, linearly elastic plate passing through each of the data values defined in the 
input dataset. An important criteria in creating a surface is that it has a minimum 
amount of bending forced upon it to conform to the data points. The degree of 
bending is constrained by a tension parameter and this can be specified both 
within the data area but also near the edges. Minimum curvature gridding 
generates the smoothest possible surface while attempting to honour the data as 
closely as possible. Like all gridding methods, minimum curvature gridding is not 
an exact interpolation and therefore some error at a majority of data points is 
observed. 

The minimum curvature method produces a grid by repeatedly applying an 
equation over the grid in an attempt to smooth the grid. Each pass over the grid 
is counted as one iteration and the number of iterations can be specified in the 
Gridding Tool. The grid node values are recalculated until successive changes in 
the values are minimised, or the maximum number of iterations is reached.

Minimum curvature attempts to fit a surface through all of the observations 
without putting any abrupt kinks in the surface. Between the fixed observation 
points, the surface bends according to the internal tension. This parameter is 
used to control the amount of distortion on the interior with the higher the tension, 
the less the distortion. The boundary tension controls the amount of distortion at 
the edges. By default, the Boundary Tension is set to 0.

Minimum Curvature parameters specification
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Kriging Tab

The geostatistical estimation method of kriging is a two stage process: 

1. Study the gathered data to establish the predictability of values from place 
to place in the study area. This study results in a graph known as a semi-
variogram which models the difference between a value at one location 
and the value at another location according to the distance and direction 
between them; 

2. Estimate values at those locations which have not been sampled. This 
process is known as kriging. The basic technique “ordinary kriging” uses a 
weighted average of neighbouring samples to estimate the unknown value 
at a given location. Weights are optimised using the variogram model, the 
location of the samples and all the relevant inter-relationships between 
known and unknown values. The technique also provides a “standard 
error” which may be used to quantify confidence levels.

Over the past several decades kriging has become a fundamental tool in the field 
of geostatistics.

Kriging is based on the assumption that the parameter being interpolated can be 
treated as a regionalized variable. A regionalized variable is intermediate 
between a truly random variable and a completely deterministic variable in that it 
varies in a continuous manner from one location to the next and therefore points 
that are near each other have a certain degree of spatial correlation, but points 
that are widely separated are statistically independent. Kriging is a set of linear 
regression routines which minimize estimation variance from a predefined 
covariance model.

The first step in kriging is to construct a variogram from the scatterered points of 
the data to be interpolated. A variogram consists of two parts:

• An experimental variogram

• A model variogram. 

Suppose that the value to be interpolated is referred to as f. The experimental 
variogram is found by calculating the statistical variance (g) of each point in the 
dataset with respect to each of the other points and plotting the variances versus 
distance (h) between the points. Several formulas can be used to compute the 
variance, but it is typically computed as one half the difference of f2.
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Once the experimental variogram is computed, the next step is to define a model 
variogram. A model variogram is a simple mathematical function that models the 
trend in the experimental variogram. As shown below, the shape of the variogram 
indicates that at small separation distances, the variance in f is small. In other 
words, points that are close together have similar f values. After a certain level of 
separation, the variance in the f values becomes somewhat random and the 
model variogram flattens out to a value corresponding to the average variance.

 
Experimental and Model Variogram used in kriging

Once the model variogram is constructed, it is used to compute the weights used 
in kriging. The basic equation used in ordinary kriging is as follows:

where n is the number of scatter points in the set, fi are the values of the scatter 
points, and wi are weights assigned to each scatter point. This equation is 
essentially the same as the equation used for inverse distance weighted 
interpolation except that rather than using weights based on an arbitrary function 
of distance, the weights used in kriging are based on the model variogram.

The creation and analysis of the sample and model variograms is done using the 
Statistics Explorer.

Selection of Kriging on the method tab opens both the Search Tab and Kriging 
Tab on the gridding tool interface. Kriging uses the same searching mechanism 
as the Inverse Distance Weighting method.
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The gridding tool supports two types of kriging estimation; Point and Block. Point 
Kriging estimates the values of the points at each of the grid nodes. Block 
Kriging on the other hand estimates the average value of points which fall within 
a rectangular block centred on each of the grid nodes. Because Block kriging 
estimates the average point value for each block it tends to generate smoother 
grids. In addition because block kriging uses an average of the input sample 
points it is considered an imperfect interpolator even when an input sample falls 
exactly on a grid node. The Block Kriging method provides controls to decimate 
(or break up) the blocks into a smaller mesh of sub cells, defined by the X and Y 
increment values. When a decimation factor is applied in Block Kriging the value 
assigned to each block is determined as the average of the sub cells inside the 
block rather than the average of the entire block.

In addition to the point and block estimation types the gridding tool supports two 
methods of Kriging; Ordinary and Simple. Ordinary Kriging focuses on the 
spatial correlation component between the measured values but ignores drift (drift 
is a regional trend in the data which exists is addition to spatial correlation 
between samples). Simple Kriging is similar to Ordinary Kriging with the 
exception that the weights used do not sum to unity and the average of the entire 
data set is used in the interpolation of each grid node rather than the local average 
of points that fall within the Search Distance of the node. Consequently Simple 
Kriging can be less precise than Ordinary Kriging but generally produces 
smoother grids.

Inverse Distance Tab

Inverse distance gridding is a universal technique that can be applied to a wide 
range of spatial data. IDW uses weighted average interpolation to estimate grid 
cell values and can be used as either an exact or a smoothing interpolator. Each 
grid cell value in an output surface is calculated using a weighted average of all 
data point values surrounding the grid cell that lie within a specified search radius.

The IDW method is optimal when the data has a fairly uniform distribution of input 
points across the area to be gridded, and some degree of smoothing is beneficial; 
for example soil samples taken over a regular grid. With this type of data, a repeat 
measurement at a point does not necessarily give the same results as the first 
measurement. If the input data points are not evenly distributed then using an 
oriented search ellipse may produce a more representative grid.

Selection of the Inverse Distance Weighting method opens both the Search Tab 
and Inverse Distance tab.
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The weighting value assigned to each point within the search ellipse is 
determined by the distance from the data point to the grid node being interpolated. 
The further away a data point lies from the grid node, the less the point value will 
contribute to the final value assigned to that node. The distance weighting 
parameters can be adjusted under the Weighting Model controls in the Inverse 
Distance tab.

A search ellipse of fixed size and orientation can be defined in a similar manner 
to the Kriging method using the Search Tab; a grid cell value is then calculated 
from the weighted average of all data points that lie within the ellipse centred on 
that grid cell.

  
Dialog controls of Inverse Distance tab of the Inverse Distance Weighting method

For descriptions of these controls, see:

• Weighting Model

• Weighting Options

Weighting Model

The weighting of an input data point is (by default) inversely proportional to its 
distance from the grid node (a Power weight model). This can be varied by 
choosing a different Weight Model on the Inverse Distance tab, and altering the 
model’s parameters where applicable. The following models are available for 
selection:

• Linear
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Each input point’s weight is proportional to its Euclidian distance from the 
grid node being interpolated. The linear weight model enables the Nugget 
and Range parameters to be adjusted in order to vary the weight 
assignments. At distances less than the Nugget distance the weight model 
will be 1 – i.e. all data will contribute equally. The Range parameter is 
used to set the outer distance threshold for which the weight model is 
applied. Any samples which exceed the Range and are less than the 
Search Distance (Search Tab) will be assigned an equal weight.

• Exponential

Each input point’s weight is proportional to its distance from the grid  node 
being interpolated raised to the specified power. Increasing the power 
value will cause smaller weights to be assigned to closer points and more 
distant points to be assigned equal but large weights. Increasing power 
values will therefore cause each interpolated grid node to more closely 
approximate the sample values closest to it. As with the Linear model the 
Nugget and Range properties can be modified to constrain that distance 
over which the exponential weight model is most effective.

• Power

The default option, each input point’s weight is proportional to the inverse 
of its distance to the specified Power from the grid node. Increasing the 
weighting power reduces the influence distant points have on the 
calculated value of each grid node. Large power values cause grid cell 
values to approximate the value of the nearest data point, while smaller 
power values will result in data values being more evenly distributed 
among neighbouring grid nodes. The weighting value defaults to 2 (i.e. the 
weight of any data point is inversely proportional to the square of its 
distance from the grid cell) which is appropriate for most situations. If 
required, the weighting value can be altered to any positive value.

• Gaussian

The weight assigned to each input value is determined according to a 2D 
Gaussian function centred on the grid node. The shape and standard 
deviation of the Gaussian function is proportional to the Range with larger 
values producing a flatter function and a smoother grid. 
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Weighting Options

• The Elliptical weighting option is only available when the Elliptical 
Search option is enabled in the Search Tab. It adjusts the distance 
weighting function for data points within the search ellipse depending on 
their relative position with respect to the elliptical shell. Points located on 
the same elliptical shell will be assigned equivalent weighting even though 
their distance from the ellipse centroid may be different. 

• The Density corrections control dynamically adjusts the search 
algorithm to optimise grid cell interpolation in areas of data clustering. 
Activating density corrections can help to enhance detail in datasets 
where sample points are unevenly spaced (e.g. regional geochemistry 
sampling) and may in some cases produce a smoother or more 
representative grid. The density correction modifies the weights for each 
contributing point based on the sample density at that point.

• The Exact hit distance is a tolerance distance for assigning actual input 
data values to coincident grid nodes. As the inverse distance gridding 
technique is attempting to interpolate a continuous surface through the 
data, a certain number of grid nodes coincide with the input data points. 
Where grid nodes and data points coincide, the distance between them is 
zero, so by default the data value is assigned a weighting of 1.0 and all 
other data points in the search radius are given a weight value of zero. 
This means that grid nodes that are coincident with input data points are 
assigned the value of the coincident data point rather than an interpolated 
(averaged) value derived from the data points surrounding it.

This effect can produce significant ‘spotting‘ in the output grid, particularly 
if the data value of the coincident point/grid cell deviates significantly from 
the points surrounding it. By adjusting the exact hit distance it is possible 
to increase the tolerance distance in which input data values are assigned 
to grid nodes. Assigning this value to a high number can produce 
unacceptable spotting or concentric banding in the output grid, while 
reducing the value below 1 has little or no effect.

Note If you have enabled the Use nearest neighbours option (in the Search Tab) in 
conjunction with four search sectors then you will have effectively removed 
clustering from the input data point distribution. The Density corrections option 
is not available when the Use nearest neighbours option is enabled.
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• The Taper controls allow you to apply a taper function to the interpolated 
value of each grid node based on its distance to the nearest valid sample 
point. The taper function is applied using a linear weighting model thereby 
adjusting the expected grid node values towards the background value. 
Between a distance of zero and the FROM distance the taper function is 
assigned a constant value of 1 (i.e. no modification is made to the grid 
node). Between the FROM and TO distance the taper function is applied 
as a linear weighting between the grid node value and the background 
value. Beyond the TO distance grid nodes are assigned the background 
value.

Search Tab

The Kriging and Inverse Distance Weighting methods, when selected on the 
Method Tab, both display the Search tab, along with their individual control tabs. 
These methods, if not optimised, can quickly becomes unworkable as the number 
of input data points increases beyond a few thousand. To improve the 
performance of these algorithms and to ensure these methods are suitable for 
large datasets, a search radius can be used to restrict the number of input points 
that contribute to each interpolation. This introduces a number of problems. For 
example the algorithm may not find a sufficient number of points within the search 
radius to make a reasonable estimation or, the spatial distribution of the points 
within the search radius may not be uniform so that the estimation becomes 
directionally biased.

Dialog controls of Search tab of the Inverse Distance Weighting method
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The Search tab provides controls to resolve these issues by determining the 
shape, size and orientation of the search ellipse used to locate data points during 
interpolation. Specifying an appropriate size and orientation for the search ellipse 
is important. Setting it smaller than the average data spacing may result in a large 
number of the interpolated grid cells being assigned a null value and therefore 
displayed as white in the output grid. Conversely, if the search ellipse is set to be 
too large then significant edge effects or grid artefacts may result around the edge 
of the grid. The Search tab is subdivided into a number of sections:

• Searching

• Anisotropy

• Sample Selection

• Gridding Rule

Searching

By default Encom Discover PA uses a circular search with a radius specified via 
the Search Distance option. If the node cannot be estimated from the points 
located within the search radius then the search radius can be incrementally 
increased and the searching repeated using Search Expansions. The increased 
radius is likely to encompass more input points and consequently the node may 
be able to be interpolated. At each stage the actual search radius used will be 
equal to the stage number multiplied by the initial search radius. The number of 
allowable increments is limited because after a while this process becomes self 
defeating and it is wiser to specify a larger initial search radius.

To optimise performance, choose an initial search radius that is likely to 
encompass the minimum number of required input points most of the time. It can 
sometimes be very difficult to make this decision but the tool will always make a 
suggestion to get started with.

If the spatial distribution of the data points is not uniform (or not uniformly random) 
then the use of search expansions may not be enough to populate the grid 
successfully. For example, a dataset may have regional data located on two 
kilometre centres and local data in parts of the study area on 100 metre centres.

To produce a suitable grid of the whole region that characterises the detail in the 
high resolution areas would require small search radius in these areas and a large 
search radius elsewhere.
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The solution is to use additional refinement Grid Passes which grid the data 
multiple times—once for each pass—at increasingly higher resolution. The 
gridded results from each pass are then used as additional input data for the next 
pass.

The grid cell size and search parameters are scaled up by a factor of two for each 
additional grid pass—for example, if you use three additional passes, then the 
first pass scales up these parameters by a factor of eight, the second by a factor 
of 4, and the third by a factor of two. The final pass grids the data at the requested 
resolution with the specified searching parameters.

Anisotropy

By default the search radius is isotropic creating a circular search area. However 
directional bias can be applied by enabling an Elliptical Search.

The dimensions of the search ellipse can be controlled by specifying the length of 
the major and minor axes. The major axis is defined by the Search distance 
value in the Searching section, whilst the minor axis is governed by the Minor 
search distance option. The Major axis orientation control determines the 
rotation angle of the major axis.

If elliptical searching is used with the Inverse Distance Weighting method, it also 
allows the use of the Elliptical weighting option on the Inverse Distance Tab. 
This option modifies the data point weighting so that they are isotropic with 
respect to angle within the search ellipse – in other words it removes the 
directional bias from the weighting.

Sample Selection

Input points ‘close’ to the grid node may not be uniformly distributed– e.g. they 
may all be on one side of it. This will introduce a directional bias into the 
estimation. This can be resolved by using search sectors.

Encom Discover PA provides options for specifying 1, 2 or 4 search sectors. By 
adjusting the Number of search sectors and Minimum points required (in 
each sector) the appearance and smoothness of the output grid can be varied. If 
any of the sectors contain fewer than the minimum number of specified points, the 
interpolated grid cell value for that node is assigned a null value.

If four sectors are used then each covers 90 degrees of arc (centred about NE, 
NW, SE, SW). If two sectors are used then each covers 180 degrees of arc 
(centred about North, South). Using only one search sector effectively turns the 
option off.
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Using 2 or 4 search sectors can significantly improve the appearance of a grid if 
the input data has been collected on widely spaced lines. Using a one sector 
search ellipse may result in grid node values being estimated from data points 
from a single direction. This might generate unrealistic or sharp slopes between 
the lines producing a rough or stepped grid. Using a two or four sector search with 
an appropriate search distance should generally eliminate or reduce this effect. 
Experiment with the use of search sectors and examine the difference these can 
have on the output grid.

Specifying the Use nearest neighbours option enables you to use only the 
closest Maximum number of samples found within each search sector in each 
estimation. When this option is selected, Encom Discover PA uses the closest 
points (up to the maximum specified in each sector) to interpolate each grid cell. 
Any excess data points within the search ellipse are ignored in the calculation.

Gridding Rule

Enabling the Customise gridding rule option allows a node to be gridded only if 
a specified minimum number of sample points are located in at least a specified 
minimum number of sectors. If a node fails to meet this rule, it will be assigned a 
null value.

Triangulation Tab

The Triangulation method produces a regular gridded surface through a set of 
data points by first creating a triangular mesh where each input point is located at 
the vertex of a triangle. Triangle edges are not allowed to intersect. The triangular 
mesh is created by drawing lines between adjacent input data points which form 
an irregular network such that no two triangle edges intersect. A regular grid is 
then computed from the triangular irregular network by linear interpolation at each 
grid node. Because the original data points form the vertices of the triangles, this 
method is useful in situations where the data must be honoured very closely (for 
example, elevation data in a digital terrain model). 

The triangulation method is best applied to data that is evenly distributed over the 
gridded area. If you have large areas of sparse or missing data you may end up 
with distinct triangular facets in the output grid. Because triangulation uses all the 
input data to construct the triangular mesh, the only variable value that can be 
adjusted is the grid cell size.
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The Method tab with the Triangulation method selected.

Spatial Neighbour Tab

This method is similar to the Inverse Distance Weighting method but does not use 
the search radius to interpolate data values from surrounding cells. For each grid 
cell, neighbouring input points are located based on a ‘spatial neighbours’ 
selection criterion. The value of the computed grid cell is the acerage of the 
neighbours, weighted such that the closer the neighbouring point, the greater the 
influence than points further away.

Search criteria are only radial in this method but the distance and applied 
weighting can be specified in the Spatial Neighbour tab displayed when this 
gridding method is selected.
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The Spatial Neighbour weighting and search specification tab.

A triangular mesh is first formed. Then for each grid node the nearest data point 
is determined and contributions from that point and its immediate neighbours (the 
points that are joined directly to it via triangle edges) are combined using inverse 
distance weighting parameters to determine the value of the grid node.

The main difference between this technique and Inverse Distance Weighting is 
the fact that you don’t need to specify a search radius. The search and weighting 
parameters can be specified on the Spatial Neighbour tab, displayed when this 
grid method is selected.

Bi-Directional Spline Method

This method of gridding is fast and uses an accurate approach with few side 
effects. It has a small memory foot print and is suitable for gridding very large 
datasets collected on lines with a common azimuth.

The bi-directional spline employs a form of damping called the Akima spline. The 
Akima spline interpolates a smoothed curve through a series of given points. The 
interpolation approximates a manually drawn curve better than many other 
ordinary splines. In the Gridding Tool, an Akima spline is applied first along input 
data lines and then across them in alignment with the grid cells in either the North, 
North East or East directions. 
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The Method tab dialog with the Bi-directional method selected.

For best results, choose multiple lines of data that have similar direction azimuths. 
Best results will be obtained for lines that have azimuths close to North, North 
East or East. 

No additional tabs are displayed for this option because it does not require any 
parameters.

Density Gridding Tab

The Density gridding method produces a grid which records a measure of the 
input point density at every grid node. The density at each grid node is determined 
independently using an estimator function. Two estimators are available:

• The Radial Density Estimator method returns a true measure of the 
point density at each grid node (measured as the number of samples per 
square area unit – usually metres). It is a simple method that counts the 
number of input samples within a specified radius of the grid node position 
and then normalises that count by the area of the search.

• The Kernel Density Estimator is a non-parametric density estimator. It 
uses a similar approach but it weights the input samples by a kernel 
function that is normally a function of the normalised distance of the 
sample to the grid node. To achieve a good result with the KDE function it 
is more important to choose an appropriate search radius – sometimes 
referred to as the bandwidth – than to choose an appropriate kernel 
function. If the bandwidth is too small the density will be under-smoothed 
whereas if the bandwidth is too large the density will be over-smoothed 
and lacking in resolution.
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Given a kernel function K and a search radius (or bandwidth) h, the 
estimated density at any point x is given by: 

where n  is the number of samples. The following kernel functions are 
supported.

If you have taken multiple samples at each input data location and this information 
is recorded in the input data, then you can use this information to bias the density 
estimation. To enable this option, check the Interpret selected data channel as 
a count frequency box and, on the Input tab, ensure the frequency or count field 
is selected as the input data field. 
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Density tab dialog options

Distance Gridding Tab

The Distance gridding method produces a grid which records the minimum 
distance to the nearest input data feature at every grid node. A distance envelope 
can be specified to clip the grid at a maximum distance from the nearest feature. 
Any grid node that is outside this envelope will be assigned a null value. 

The Distance gridding method produces a grid which records the minimum 
distance to the input data features at every grid node. A distance envelope can 
be specified to clip the grid at a maximum distance from the nearest feature. Any 
grid node that is outside this envelope is assigned a null value.

When the input data is loaded it is classified as either point data or polyline data 
depending on the source of the data and the type of object that was loaded. By 
default, the method considers all input data as point locations. Optionally, you can 
add to this the input polyline data. In this case the method also checks the 
perpendicular distance to the nearest polyline in addition to looking at all point 
data.
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Point data classification

 
Polyline data classification

In the illustrations above, the first grid has been computed considering all the 
input data as point locations. The second grid has added to this the polyline 
information. In both cases a distance envelope has been applied. 
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Distance dialog options

Geometry Tab

This tab controls the main parameters for determining the geometry of the output 
grid. The Cell Parameters determines the size of each grid cell in the output 
image and is measured in metres. During the loading process, the Gridding Tool 
automatically computes a grid cell size based on the distribution and density of 
the input data. If you wish, you can alter the cell size to better suit your needs.

When a large dataset is loaded the Auto Apply box is disabled and the Compute 
Best Parameters button is active. Use this button to calculate an optimal grid cell 
size.

The extents of the Data coverage to be gridded can be modified by entering new 
co-ordinates into the minimum and maximum X and Y columns. The full extents 
of the original data coverage are displayed by default. If the coordinates have 
been modified select the Reset to Input Extents button to return to the original 
data coverage.

The Grid bounds parameters control the boundary extents of the output grid and 
can be used to reduce the size of the output grid if required. To return to the 
original data extents, select the Reset to Input Extents button. The number of 
Rows and Columns in the output grid is also displayed. These values are 
calculated from the grid extents and cell size and cannot be edited.
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The Grid Geometry tab indicating the cell size, extent and number of rows and columns

When creating a surface, the grid cell size that you choose is important. As a 
general rule-of-thumb the grid cell size should not be made smaller than 
approximately one-fifth of the average data spacing. Reducing the grid cell size 
beyond this limit may introduce unwanted irregularities in the output image. 
Assigning an excessively small grid cell size also increases computation time and 
file size. The Gridding Tool computes a grid cell size for your data but you may 
want to experiment with alternative values.

Output Tab

The Output tab provides controls for saving the gridded image. The top section of 
the dialog provides a summary report of the gridding process and lists the primary 
parameters chosen. You can copy this information to the Windows clipboard by 
selecting it with your mouse and using Windows' copy command and paste it into 
Notepad for saving or printing.

Below the summary box is a pull-down list containing the supported grid formats. 
The Gridding Tool currently supports ER Mapper (.ERS) and Geosoft (.GRD) 
uncompressed grid formats. To save a grid, select the appropriate format from the 
list and click the Save button. The output grid file will be assigned a default name 
and is saved in the same directory as the input data. You can alter the file name 
and directory path by clicking on the small button at the right end of the path name 
box. The Output tab is accessible at any stage during gridding so it is not 
necessary to wait for the preview window to complete drawing before saving the 
final grid. 
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The Clip control provides a number of options for clipping the extents of the 
interpolated grid, so that it more closely approximates the distribution of the input 
data. Enabling this option can improve the appearance of the output grid for 
irregular input data where the gridding method (usually Triangulation or Minimum 
Curvature) has interpolated the grid over large gaps within the data. Options 
available include:

• Creating a Buffer around the input data at a user-specified distance. The 
gridded data outside the buffer is then removed.

• The Near value of the Near/Far option is the distance the grid is to be 
clipped back to from the convex hull of the data points. The Far distance is 
the distance between the points to interpolate between. Areas in the grid 
which lie between data points greater than the Far distance value grid will 
be displayed as null or “white”.

• The Convex Hull option clips the output grid to the smallest convex 
region/polygon enclosing the dataset. This convex region is found 
conceptually by stretching a rubber band around the points so that all of 
the points lie within the band. The convex region can be expanded by a 
specified Buffer value.

• The Concave Hull option starts with a Convex Hull region, and then 
removes/erodes triangles on its edge that have an outward facing angle 
greater than a defined tolerance (specified under the Options button). 
This new concave region can then be expanded by a specified Buffer 
value.
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The Output tab dialog with statistics and grid saving options

If multiple fields have been selected for gridding then three output options are 
available:

• Separate grids – each selected field is created as a separate grid 
which is named using the original source table with the field name 
extension. E.g. MAG, Geochem_Pb, etc.

• Multi-banded grid – multiple fields are gridded and saved to a 
single ERMapper Multi-banded grid.

• Create RGB Image – if three fields are selected for gridding they 
can be saved as an RGB image. Each field is saved as a red, green 
or blue channel in the resulting image. The RGB grid is first loaded 
into the Grid>Grid Utility>Create RGB Grid dialog before the final 
RGB GeoTiff image is created.

Large and Multi-file Gridding

Note This tool requires an Encom Discover PA Professional licence. If you wish to 
purchase or evaluate this module, please contact Pitney Bowes Software.
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The Large and Multi-file gridding tool is a powerful grid interpolator which can 
construct gridded surfaces from extremely large datasets. Interpolated grids can 
be created from a single input file or from multiple input files of point data or 
gridded data in any of the following formats:

• ASCII text (.txt, .asc, csv, xyz), including zip compressed ASCII

• MapInfo .TAB

• ASPRS .LAS

• LizardTech MrSID compressed Lidar (MG4)

• Gridded formats (Arc ASCII, Arc Flt, ER Mapper, BIL, MapInfo, Geosoft, 
MinEx, Surfer, Vertical Mapper)

• Geosoft database .GDB

The Large and Multi-file gridding tool is best suited to gridding very large, closely 
spaced point datasets, such as those commonly acquired by airborne Light 
Detection and Ranging (LIDAR) data surveys. The tool can also be used to 
assemble a large number of adjoining grid tiles into a single large contiguous grid. 
An example of this use case is assembling multiple Shuttle Radar Topography 
Mission Arc ASCII grid files into a single continuous grid.  This method of 
interpolation works best with relatively even spaced points that cover semi-
rectangular survey areas containing minimal internal holes or areas of missing 
data. 

For moderate-sized point datasets (e.g. < 2 million points) or situations where 
some experimentation with interpolation methods is required the Interactive 
gridding tool is a more flexible and suitable choice.

• When to Use Large and Multi-file Gridding

• Using the Large and Multi-file Gridding Tool

• Input Data Files

• Gridding Methods

• Interpolation Settings

• Output Grid
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When to Use Large and Multi-file Gridding

As a rule of thumb if the number of points in the input dataset exceeds 3 million 
points or the number of cells in the output grid is greater than 6,000 columns x 
6,000 rows (360,000,000 cells) or there are multiple input files the Large and 
Multi-file gridding tool is the appropriate tool to use. For all datasets which fall 
below this size threshold the interactive gridding tool is the most flexible and best 
tool to use. For practical purposes the maximum size of the combined input 
datasets that the Large and Multi-file gridding tool can process is 2 billion points 
and the maximum size of the output grid(s) is 1 terabyte.

Using the Large and Multi-file Gridding Tool

• Running the Gridding Tool

• Re-running the Gridding

Running the Gridding Tool

For more information about the settings available from dialog boxes, see 
Interpolation Settings.

1. On the Surfaces menu, point to Create Grid, and click Large and Multi-
file.

The Large and Multi-file Gridding dialog box is displayed.

2. Under Input, to select input files that are stored in a single directory:

• Press the Browse for files button on the top right of the dialog. On 
the open file dialog adjust the file type filter at the bottom to the 
appropriate type (.TAB, . ASCII, .LAS, .SID, .ZIP or one of the 
supported grid formats) and select the files to grid.

Or for input files that are stored in a multiple directories:

• Press the Browse for folder button, second button down on the 
top right of the dialog. On the Select file format dialog which 
appears choose the file type filter which is appropriate for the type 
of input data, press OK and select the top level directory from which 
to search for files to grid.
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3. Depending on the format of the files chosen you may be prompted to  
assign the column field order for the input dataset. To do this press the 
Assign Column order button. On the Select data fields dialog choose 
the field for the X coordinate and Y coordinate. If the input dataset(s) are 
LIDAR LAS files these fields will be automatically assigned. From the field 
list select the data column(s) you wish to grid. If the chosen input files are 
zip compressed files and the zip file contain more than one file (e.g. an 
ASCII data file and a metadata or .PRJ file) you will need to specify a file 
name mask to filter out the correct file to grid. Under Input data format 
enter a file name mask to uniquely identify the name of the file in the .zip 
archive that you wish to grid. The mask can contain characters that are 
part of the file name and/or the extension. For example *.txt or myfile.* or 
*.asc are all valid masks. The mask will be applied automatically and 
when a valid file is found you will see a preview of the content in the File 
preview region. 

4. Assign the appropriate projection for the input data files by pressing the 
Choose Projection button in the bottom right of the dialog.

Note If you are unfamiliar with the distribution of statistics of your input files you can 
examine the spatial statistics of any of the selected input data files using the 
Statistics Explorer. To launch the Statistics Explorer select an input file and then 
press the Statistics Explorer button  (on right of file format dialog).

5. If desired, modify the name that has been assigned in the Group alias 
property for the group in the input manager grid control by double-clicking 
in the cell and typing in a new name.

6. To change the properties of a group of input files, first select the group you 
wish to modify in the input manager and then press the File format button 
on the right of the dialog. On the format dialog you can add or remove files 
from a group as well as change the input data format and projection.

7. If you are familiar with the spatial distribution and coverage of the input 
data enable the Define cell size control and change the cell size from 
<Auto> to an appropriate value that is suitable for the input data and for 
your analytical needs. Should you need assistance in choosing an 
appropriate cell size you can press the Compute cell size button and the 
software will attempt to analyse a small subset of the data and estimate an 
appropriate value. However it is generally recommended that if you are 
not sure what cell size to assign for the output grid that you leave the 
Define cell size disabled so the software can compute an appropriate 
value once it has completed an analysis of the data distribution.

8. Optional steps:
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Re-running the Gridding

• Press the Data conditioning button to configure any null values or 
data ranges you may wish to exclude during the gridding process.

• Define the grid geometry by specifying the Origin X and Origin Y 
coordinate of the lower left corner of the output grid as well as the 
grid dimension in rows and columns.

• Press the Advanced settings button and modify the Options as 
necessary. For a large gridding job you may need to set the 
Temporary directory path to an alternative hard drive which has 
plenty of free space available to store an entire copy of the input 
dataset. You may also wish to adjust the Scan data extents control 
to perform a quick scan of the input data as well as constrain the 
maximum memory that will be used by the software during the 
gridding process.. Use the Output grid Data type to change the 
numeric data type that will be used for the output grid. Choosing an 
appropriate data type for the output grid could have a large impact 
on the size of the output grid file. See Output Grid for more 
information

9. Press the Save file button and select an appropriate file path for the final 
grid file(s). Ensure that you select a location with plenty of free space to 
store the output files. It is recommended that for large datasets the output 
grid(s) are stored on a separate disk drive to the input data.

10. Press the Projection button and choose an appropriate projection for the 
output grid file. It is recommended that the projection of the output grid file 
is set to the same projection as the input file(s). By default the output 
projection will be set to the first input file(s) projection.

11. (Optional) Disable the Auto open output file(s) if you do not want the 
output grid file(s) to be automatically opened into MapInfo on completion 
of the gridding process.

12. Press the Process button to commence gridding.

At the completion of gridding a control file containing a complete set of 
parameters used by the gridding engine are saved to a text file in the same 
location as the output grid. The control file is created with the same name as the 
output grid file and has .final.txt appended to the end.
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Input Data Files

The main features of input files that can be read are:

• One or more input files are supported.

• A range of commonly used input formats can be read including .TAB, 
.LAS, .CSV, space or tab delimited text files (including zip compressed 
files),, MrSID MG4 LIDAR files and a number of common grid files.

• Input files can be located in a single directory or hierarchically in multiple 
directories.

• Input files can be specified in groups. A group of input files share common 
properties such as format (i.e. file structure) and projection. If the file 
format or projection of any of the input files is different they should be 
separated into their own group.

Input file formats

Input files can be provided in any of the following formats:

• MapInfo .TAB
The TAB reader can read simple MapInfo .TAB files which contain 
mapped objects. The coordinate and projection information is extracted 
from the mapped objects and the X,Y point coordinates are obtained for 
every node of simple or multi-part objects. The data field information which 
is used for interpolation can be obtained from any corresponding attribute 
field in the .TAB file.

• ASPRS .LAS
LAS is an industry standard public format used for the interchange of 
LIDAR data. The file format is defined and maintained by the ASPRS 
organisation (www.asprs.org). Discover supports versions 1.0, 1.1 and 1.2 
of the LAS specification and can extract "Z" (elevation) as well as RGB 
(red, green, blue) and intensity information.

Should you wish to create another grid using a different field from the same input 
data or recreate the same grid with slightly modify settings you can reload the 
saved control file. To do this first open the Large and multi-file gridding tool. Next 
press the load control file button (the last button at the top right of input 
manager). When the control file is successfully loaded you can modify the 
settings as necessary and then press the Process button to create a new grid.

http://www.asprs.org
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• MrSID MG4 compressed LiDAR 
MrSID MG4 LiDAR files are a new version of the MrSID format that 
supports compressed LiDAR point data. The files are created using the 
LizardTech LiDAR Compressor™ software. For more information on this 
format please refer to LizardTech (http://www.lizardtech.com). These files 
have an extension of *.MG4 and may be loaded directly into the gridding 
tool. 

• Geosoft database (GDB)
Standard geophysical data format.

ASCII data readers

• ASCII Space, Comma or Tab Delimited (Fast)
This is the faster of the two text readers. It expects data to be stored in 
columns with a space, tab or comma separating each value in a row. The 
text reader can skip multiple header lines at the start of a file but once it 
starts reading data it expects the remainder of the file to be clean and void 
of inline comments or other formatting changes. For well structured, clean 
data this is the best method to use.

• ASCII Generic Text (Slow)
This is a general text reader which handles a wider range of delimiters. It 
can also detect and skip header lines as well as  empty fields (e.g. 
consecutive commas with no data between them) and can  adjust to 
formatting changes within the input file(s). It will also read files with 
unusual delimiters such as a pipe (|).

Grid file readers

• There are several readers available for loading gridded data files (e.g. 
*.ERS, *.GRD, *.BIL, *.ASC) as input to the Large and Multi-file gridding 
tool. All the common industry grid formats that are supported by Discover 
can be loaded as input. 

Input file groups

• Projection information can be assigned to each group of input files. The 
projection information specified must correspond to the spatial reference 
the data is stored in. If no projection is assigned to the input data it will be 
assigned the projection of the output grid.

• You may modify the group alias name for each group of input files to help 
distinguish them in situations where a lot of groups have been added.

http://www.lizardtech.com
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Gridding Workflows

The following gridding methods are available:

• Triangulation

• Inverse Distance Weighting

• Minimum Curvature (Full)

• Minimum Curvature (Stamped)

• Data Density

• Data Point Separation (Distance)

• Stamp Only

Triangulation 

The Triangulation gridding method consists of eight operational phases:

Phase 1. A quick analyse of your computer is performed to establish the 
amount of RAM and free disk space available and all input files 
are validated.

Phase 2. The first 65,000 data stations are loaded to determine spatial 
statistics of the data.

Phase 3. Each input data file is scanned to determine the data extents 
and spatial distribution statistics. Some data will be skipped 
during this phase if the Scan data extents property is set to any 
value other than complete

Phase 4. Preliminary gridding parameters and temporary data storage 
requirements are estimated from the spatial statistics obtained 
during the initial data scan (phase 3)

Phase 5. Gridding properties and memory requirements are established 

Phase 6. The  entire input data set is read and  spatially sorted into a 
collection of tiles.  Unwanted or null readings are cleansed and 
coordinates are reprojected into the output grid coordinate 
system if required.
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Inverse Distance Weighting

The Inverse Distance Weighting gridding method consists of seven operational 
phases:

Phase 7. The spatially sorted input data is triangulated and the 
interpolated values are written to the output file.

Phase 8. The triangulated grid(s) are finalized and corresponding header 
information and.TAB files are written to disk. All temporary files 
an allocated memory is then released.

Phase 1. A quick analyse of your computer is performed to establish the 
amount of RAM and free disk space available and all input files 
are validated.

Phase 2. The first 65,000 data stations are loaded to determine spatial 
statistics of the data.

Phase 3. Each input data file is scanned to determine the data extents 
and spatial distribution statistics. Some data will be skipped 
during this phase if the Scan data extents property is set to any 
value other than complete

Phase 4. Preliminary gridding parameters and temporary data storage 
requirements are estimated from the spatial statistics obtained 
during the initial data scan (phase 3)

Phase 5. Gridding properties and memory requirements are established 

Phase 6. The entire input data set is read and unwanted or null readings 
are cleansed and coordinates are reprojected into the output 
grid coordinate system if required. The points are stamped into a 
spatially indexed file and an inverse distance weighting 
algorithm is applied to interpolate new grid values from the set of 
input points that lie within the specified search radius (Inverse 
Distance Weighting Properties).

Phase 7. The interpolated data file is finalized and written to the output 
grid file along with the corresponding header information 
and.TAB files. All temporary files and allocated memory is then 
released
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Minimum Curvature (Full)

The Minimum Curvature (Full) gridding method consists of thirteen operational 
phases:

Phase 1. A quick analyse of your computer is performed to establish the 
amount of RAM and free disk space available and all input files 
are validated.

Phase 2. The first 65,000 data stations are loaded to determine spatial 
statistics of the data.

Phase 3. Each input data file is scanned to determine the dataset extents 
and spatial distribution statistics. Some data will be skipped 
during this phase if the Scan data extents property is set to any 
value other than complete.

Phase 4. Preliminary gridding parameters and temporary data storage 
requirements are estimated from the spatial statistics obtained 
during the initial data scan (phase 3)

Phase 5. Gridding properties and memory requirements are established 

Phase 6. The entire input dataset is spatially sorted into a collection of 
tiles. Unwanted or null readings are cleansed and coordinates 
are reprojected into the output grid coordinate system if 
required.

Phase 7. The spatially sorted input data is now stamped into the grid.

Phase 8. A multi-resolution grid pyramid is constructed and filled from 
bottom to top.

Phase 9. The clip mask is built, based on the clipping parameters defined 
in the minimum curvature properties dialog.

Phase 10. The source mask pyramid is focussed in each level to allow 
more grid cells to be unconstrained in the gridding procedure.

Phase 11. The pyramid is filled and refined from the top down applying 
minimum curvature at each level.

Phase 12. The final phase of minimum curvature interpolation is performed 
upon the output grid.

Phase 13. The output grid(s) are finalized and written to disk along with 
their corresponding header information and.TAB files. All 
temporary files are removed and allocated memory is released
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Minimum Curvature (Stamped)

The Minimum Curvature (Stamped) gridding method consists of twelve 
operational phases:

Phase 1. A quick analyse of your computer is performed to establish the 
amount of RAM and free disk space available and all input files 
are validated.

Phase 2. The first 65,000 data stations are loaded to determine spatial 
statistics of the data.

Phase 3. Each input data file is scanned to determine the dataset extents 
and spatial distribution statistics. Some data will be skipped 
during this phase if the Scan data extents property is set to any 
value other than complete.

Phase 4. Preliminary gridding parameters and temporary data storage 
requirements are estimated from the spatial statistics obtained 
during the initial data scan (phase 3).

Phase 5. Gridding properties and memory requirements are established 

Phase 6. The entire input dataset is now stamped into the grid. Unwanted 
or null readings are cleansed and coordinates are reprojected 
into the output grid coordinate system (if required).

Phase 7. A multi-resolution grid pyramid is constructed and filled from 
bottom to top.

Phase 8. The clip mask is built, based on the clipping parameters defined 
in the minimum curvature properties dialog.

Phase 9. The source mask pyramid is focussed in each level to allow 
more grid cells to be unconstrained in the gridding procedure.

Phase 10. The pyramid is filled and refined from the top down applying 
minimum curvature at each level.

Phase 11. The final phase of minimum curvature interpolation is performed 
through the pyramid.

Phase 12. The output grid(s) are finalized and written to disk along with 
their corresponding header information and TAB files. All 
temporary files are removed and allocated memory is released.
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Data Density

The Data Density gridding method consists of seven operational phases:

Data Point Separation (Distance)

The Data Point Separation gridding method consists of seven operational 
phases:

Phase 1. A quick analyse of your computer is performed to establish the 
amount of RAM and free disk space available and all input files 
are validated.

Phase 2. The first 65,000 data stations are loaded to determine spatial 
statistics of the data.

Phase 3. Each input data file is scanned to determine the dataset extents 
and spatial distribution statistics. Some data will be skipped 
during this phase if the Scan data extents property is set to any 
value other than complete.

Phase 4. Preliminary gridding parameters and temporary data storage 
requirements are estimated from the spatial statistics obtained 
during the initial data scan (phase 3)

Phase 5. Gridding properties and memory requirements are established 

Phase 6. The entire input dataset is now scanned and unwanted or null 
readings are cleansed and coordinates are reprojected into the 
output grid coordinate system (if required).The points are 
stamped into the grid file and accumulated densities are 
computed within the specified search radius using chosen the 
kernel weighting function.

Phase 7. The output grid(s) are finalized and written to disk along with 
their corresponding header information and.TAB files. All 
temporary files are removed and allocated memory is released

Phase 1. A quick analyse of your computer is performed to establish the 
amount of RAM and free disk space available and all input files 
are validated.

Phase 2. The first 65,000 data stations are loaded to determine spatial 
statistics of the data.
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Stamp Only

The Stamp Only gridding method consists of seven operational phases:

Phase 3.

Each input data file is scanned to determine the dataset extents 
and spatial distribution statistics. Some data will be skipped 
during this phase if the Scan data extents property is set to any 
value other than complete.

Phase 4.
Preliminary gridding parameters and temporary data storage 
requirements are estimated from the spatial statistics obtained 
during the initial data scan (phase 3)

Phase 5. Gridding properties and memory requirements are established 

Phase 6.

The entire input dataset is now scanned and unwanted or null 
readings are cleansed and coordinates are reprojected into the 
output grid coordinate system (if required). The points are 
accumulated and separation distances are computed within the 
defined search radius. The interpolated values are stamped into 
the output grid file.

Phase 7.
The output grid(s) are finalized and written to disk along with 
their corresponding header information and.TAB files. All 
temporary files are removed and allocated memory is released.

Phase 1. A quick analyse of your computer is performed to establish the 
amount of RAM and free disk space available. All input files are 
validated. Note depending on the number, size and type of input 
files selected this phase can take some time.

Phase 2. The first 65,000 data stations are loaded to determine spatial 
statistics of the data.

Phase 3. Each input data file is scanned to determine the dataset extents 
and spatial distribution statistics. Some data will be skipped 
during this phase if the Scan data extents property is set to any 
value other than complete.

Phase 4. Preliminary gridding parameters and temporary data storage 
requirements are estimated from the spatial statistics obtained 
during the initial data scan (phase 3)

Phase 5. Gridding properties and memory requirements are established 
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Interpolation Settings

• Data Conditioning

• Gridding Properties

• Options

Data Conditioning

Data conditioning is a pre-processing operation which is applied to the input data 
prior to gridding. It allows you to define a NULL value as well as ranges of data, 
with upper and lower caps, in order to exclude them from the gridding process. 
The data conditioning process only applies to valid input data. Should any of the 
fields in the input data set for a given point (i.e. X, Y or the field values) have a 
NULL (or missing) value then the entire point is discarded. For more information, 
see Data Conditioning.

Gridding Properties

Because the gridding process is relatively autonomous it is possible to leave the 
gridding properties set to their default settings and the software will attempt to 
automatically compute an appropriate set of parameters for the output grid by 
examining the field and spatial statistics of the input file(s). If you are unfamiliar 
with the distribution or range of the input data sets then leaving the gridding 
properties on their default settings is recommended.

If you are familiar with the input dataset and know in advance what the spatial 
extents and distribution of the data is like and you have a good understanding of 
the  field range then you can manually adjust the gridding properties to best suite 
the input and output data requirements.

Phase 6. The entire input dataset is now scanned and unwanted or null 
readings are cleansed and coordinates are reprojected into the 
output grid coordinate system (if required). The points are then 
stamped directly into the output grid file(s).

Phase 7. The output grid(s) are finalized and written to disk along with 
their corresponding header information and.TAB files. All 
temporary files are removed and allocated memory is released.
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Define cell size

This property controls the size (or resolution) of each cell in the output grid file. 
The size is measured in the spatial units of the output grid coordinate system. The 
default cell value is "Auto" which indicates that the software will attempt to 
compute an appropriate cell size for the output grid by analysing the spatial 
statistics of the input data. Providing the source data is regularly spaced and 
evenly distributed across the entire survey area the automatic cell size estimation 
algorithm will choose a reasonable cell size. However if the data distribution is 
clustered or skewed then it is strongly recommended that you set the cell size to 
an appropriate value manually.

As a general rule of thumb the output grid cell size should not be set to a value 
that is less than 1/5 the average spacing of the input data. A cell size of 1/3 the 
average data spacing is good starting point. Another important aspect of the cell 
size which must be taken into consideration, particularly on large datasets, is that 
halving its size will have the effect of double the file storage requirements of the 
output grid.  For example if you set a cell size of 2 m and the output grid requires 
100 MB of disk space, then reducing the cell size to 1 m will increase the storage 
space requirements for the output grid to 400 MB.

Compute cell size

The compute cell size button will compute a default cell size for the input data. It 
attempts to do this by analysing the spatial statistics of a small subset 
(approximately 65,000 stations) of the first input file. Depending on the regularity 
and spatial coherence of this small subset of data the estimated cell size may or 
may not be assigned an optimal value. 

If you are unfamiliar with the dataset and you are not sure what value to set for 
the cell size then it is recommended that you leave the property set to "Auto". 
When configured this way the software will attempt to adjust the cell size to an 
appropriate value after it has examined the complete spatial statistics of the input 
data.
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Define grid geometry

The define grid geometry properties control the spatial extent and size of the 
output grid file. By default these values will be automatically computed by the 
software to fully encompass the input data once it has scanned all the data files 
and established the spatial statistics and data distribution. If you need to constrain 
the output grid to a larger or smaller area than the extents of the input dataset then 
you can override the default settings and specify the extents manually. By 
configuring the grid extents to an area which is smaller than the extents of the 
input dataset you will effectively clip it to the defined grid geometry. If the output 
grid geometry is smaller than the input data then any input data that does not 
overlap with it will be discarded prior to gridding. The grid geometry is controlled 
by the Origin X and Origin Y coordinate values, which specify the centre 
coordinate of the lower left grid cell and the height and width are specified by the 
number of rows and columns measured in grid cells respectively.

Advanced settings

The advanced settings allow you to control a number of properties relating to the 
memory and temporary storage location that is used during gridding, the 
resolution at which the initial data scan is done, and output grid data type. Details 
of each of these properties are described below.

Options

Maximum memory use

This control is used to constrain the amount of physical memory (RAM) that the 
software will attempt to use during the gridding process. The default control 
setting is disabled and in this state the software will attempt to use up to 80% of 
available physical memory (to a maximum of 2 GB) during gridding. While it is 
possible to constrain the amount of RAM that is available to the software during 
the gridding process; doing so will reduce the gridding performance significantly 
if the software has to repeatedly page tiles of data between disk and memory in 
order to perform the gridding operation. 

To achieve best performance on large datasets it is advisable that you close all 
running applications and free up as much physical memory (RAM) as possible 
before commencing gridding. For very large datasets (>50 million points) it is 
recommended that the software is run on a machine with between 2 and 4 GB of 
RAM.

Note The gridding tool is a 32-bit program, and therefore cannot address more than 
4GB of RAM on a 64-bit operating system.



26 Gridding Utilities 891

Scan data extents

Controls the resolution at which the software initially scans the input data files to 
establish the preliminary spatial statistics during the first phases of gridding. The 
default behaviour is to scan all lines of the input data. It is possible to speed up 
the initial scan of the input files by adjusting the scan data extents control to one 
of the following settings:

• Complete: scans every line of each input data files

• Fine: scans approximately 12% (1-in-8) of the lines from each input data 
file

• Course: scans approximately 3% (1-in-32) of the lines from each input 
data file

• Overview: scans approximately 0.75% (1-in-128) of the lines from each 
input data file

• Bounds: acquires the data extents from information stored in the files 
(e.g. LAS or grid formats such as .ERS and, GRD) if available or performs 
an Overview scan if unavailable.

For datasets that have a relatively even spatial distribution of input points setting 
the scan data extents control to Overview will provide the best compromise 
between speed and a representative statistical sample.

Temp directory

The Temp directory is used to temporarily store the spatially sorted input data tiles 
which are used during the gridding process. If all of the input data can fit into 
system memory then no temporary files will be created and the entire process will 
occur in RAM. If the input dataset is very large (>10 million points) then it will be 
necessary to store a copy of the input data on disk during the gridding process.   
By default the temporary directory is set to the Windows system temporary 
directory; however it may be necessary to map it to an alternative storage location 
depending on the size of the input dataset. 

Note You should always ensure that you have at least the same amount of free 
temporary storage space as the total size of the input dataset. A good rule of 
thumb is to set the temp path to a location that has 2x as much storage space as 
the size of the input dataset.
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Gridding Methods

• Triangulation

• Inverse Distance Weighting

• Minimum Curvature (Stamped)

• Minimum Curvature (Full)

• Data Density

Triangulation

The triangulation gridding method performs a Delaunay triangulation with linear 
interpolation. The method works by first triangulating the input data into a TIN 
mesh. It then calculates a value at the centre of each cell in the output grid using 
linear interpolation from the triangle that overlaps with coordinate of the centre of 
each grid cell. In order for the software work with huge datasets that could 
potentially contain billions of triangles on PCs with limited available memory, the 
input data is scanned, spatially sorted and divided into tiles. Each of the tiles is 
then triangulated and the resulting TIN mesh is either stored in memory or if there 
is insufficient memory available it is stored on disk in temporary files. Once the 
dataset has been triangulated into a TIN mesh the output grid is constructed by 
interpolating cell values from the triangles.

Because the triangulation process is relatively autonomous it is possible to leave 
the gridding properties set to their default settings and the software will attempt to 
automatically compute an appropriate set of parameters for the output grid by 
examining the field and spatial statistics of the input file(s). If you are unfamiliar 
with the distribution or range of the input data sets then leaving the gridding 
properties on their default settings is recommended.

If you are familiar with the input dataset and know in advance what the spatial 
extents and distribution of the data is like and you have a good understanding of 
the range of values in the field(s) being gridded then you can manually adjust the 
gridding properties to suite the input and output data requirements.

Triangulation Properties

The triangulation properties can be used to influence the geometry of the data 
structures,  the number of points and memory that will be used to triangulate each 
tile of input points. 
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Maximum triangle side length

This parameter applies to the triangulation phase of gridding and can be used to 
minimize or eliminate long thin triangles that may be created across large holes 
or gaps in the data or between widely separated points that lie around the 
perimeter of the dataset. By default triangles that are created with a length that is 
greater than half the diagonal length of a tile will be discarded. The size of the tiles 
used during triangulation are determined automatically by the software after it 
analyses the spatial statistics of the input points, however you can modify the size 
of the tiles by applying a Triangle patch multiplier.

Distance specified in data units

This parameter is used to control the units of distance that the Maximum triangle 
side length property is measured in. By default this control is disabled and the 
maximum distance unit is expressed as a ratio of the tile (or patch) size. If you 
wish to constrain the Maximum triangle side length to a fixed value that is 
measured in absolute data units (e.g. 100 m) then enable this control and enter 
in the appropriate value. If the entered value is large and exceeds the size of an 
individual tile of data then it may have no effect on the output grid.

Note: If the coordinate system of the input data is Longitude/Latitude then the 
absolute distance units need to be specified in fractions of a degree (Arc 
seconds).

Triangle patch multiplier

The triangle patch multiplier can be used to modify the number and size of tiles 
(or patches) that the software will segment the input data into before sequentially 
triangulating it. The tile size is automatically determined by the software following 
a detailed analysis of the spatial statistics of the input data. Under special 
circumstances the patch size can be modified by applying a Triangle patch 
multiplier. Increasing the default value of 1 to a higher number will create larger 
patches and may assist in the infilling of large holes or gaps in the dataset, 
however it  will also increase peak memory usage during the gridding phase. For 
very large datasets increasing the Triangle patch multiplier will reduce the number 
(but not the storage requirements) of temporary files that are created during the 
gridding phase. For most datasets a patch multiplier of 1 or 2 will be sufficient. 
Increasing the patch multiplier beyond a value of 4 would be rarely necessary.
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Inverse Distance Weighting

Inverse Distance Weighting (IDW) is a universal technique that can be applied to 
a wide range of spatial data. IDW uses weighted average interpolation to estimate 
grid cell values and can be used as either an exact or a smoothing interpolator. 
Each grid cell value in an output surface is calculated using a weighted average 
of all data point values that lie within a specified search radius surrounding the 
grid cell. The IDW method is optimal when the data has a fairly uniform 
distribution of input points across the area to be gridded, and some degree of 
smoothing is beneficial.

In order for the software work with huge datasets that could potentially contain 
billions of points on PCs with limited available memory, the input data is scanned, 
cleansed and stamped into a temporary grid. The grid is then divided into tiles and 
each tile is then interpolated using the IDW algorithm. The intermediate grids are 
either stored in memory or if there is insufficient memory available they are stored 
on disk in temporary files. Once the dataset has been interpolated the output grid 
is constructed by stitching together the interpolating tiles into a continuous grid.

Before commencing a gridding operation it is important that the IDW Properties 
are appropriately configured for the input dataset. If you are familiar with the input 
dataset and know in advance what the spatial extents and distribution of the data 
is like and you have a good understanding of the range of values in the field(s) 
being gridded then you can manually adjust the IDW properties to best suite the 
input and output data requirements.

Inverse Distance Weighting Properties

The IDW properties can be used to influence the geometry and smoothness of 
the output grid file. 

Model

This parameter controls the weighting model that is used to average the data 
points that are located within the search distance radius. The following four 
weighting models are available:

Gaussian

The weight assigned to each input value is determined according to a 2D 
Gaussian function centred on the grid node. The shape and standard deviation of 
the Gaussian function is proportional to the Range value. Larger range values 
produce flatter functions Gaussian functions and a smoother grid. The Nugget, 
Range and Distance radius values are measured in increments of the output grid 
cell size.
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Linear

Each input point’s weight is proportional to its Euclidian distance from the grid 
node being interpolated. The linear weight model enables the Nugget and Range 
parameters to be adjusted in order to vary the weight assignments. At distances 
less than the Nugget distance the weight model will be 1 (i.e. all data will 
contribute equally). At distances beyond the nugget value the weighting factor will 
be applied according to the selected model. The Range parameter is used to set 
the outer distance threshold for which the weight model is applied. Any samples 
which exceed the Range and are less than the Distance radius will be assigned 
an equal weight. The Nugget, Range and Distance radius values are measured 
in increments of the output grid cell size.

Exponential

Each input point’s weight is proportional to its Euclidian distance from the grid 
node being interpolated raised to the specified power. Increasing the power value 
will cause smaller weights to be assigned to closer points and more distant points 
to be assigned equal but large weights. Increasing power values will therefore 
cause each interpolated grid node to more closely approximate the sample values 
closest to it. As with the Linear model the Nugget and Range properties can be 
modified to constrain that distance over which the exponential weight model is 
most effective.

Power

The default option, each input point’s weight is proportional to the inverse of its 
distance to the specified Power from the grid node. Increasing the weighting 
power reduces the influence distant points have on the calculated value of each 
grid node. Large power values cause grid cell values to approximate the value of 
the nearest data point, while smaller power values will result in data values being 
more evenly distributed among neighbouring grid nodes. The weighting value 
defaults to 2 (i.e. the weight of any data point is inversely proportional to the 
square of its distance from the grid cell) which is appropriate for most situations. 
If required, the weighting value can be altered to any positive value.

Distance Radius

It is important to set an appropriate size for the search distance radius. Setting it 
smaller than the average data spacing may result in a large number of the 
interpolated grid cells being assigned a null value and therefore displayed as 
transparent in the output grid. Conversely, if the search distance is set to be too 
large then significant grid smoothing or artefacts may occur. The search distance 
radius is measured in increments of the output cell size.
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To optimise performance, choose a search radius that is likely to encompass the 
minimum number of required input points most of the time. It can sometimes be 
very difficult to make this decision but a good rule of thumb is to keep the search 
distance to a value less than or equal to 5x the output cell size.

Distance Taper

Taper controls allow you to apply a taper function to the interpolated value of each 
grid node based on its distance to the nearest valid sample point. The taper 
function is applied using a linear weighting model thereby adjusting the expected 
grid node values towards the background value. Between a distance of zero and 
the NEAR distance the taper function is assigned a constant value of 1 (i.e. no 
modification is made to the grid node). Between the NEAR and FAR distance the 
taper function is applied as a linear weighting between the grid node value and 
the background value. Beyond the FAR distance grid nodes are assigned the 
background value.

Minimum Curvature (Stamped)

The Minimum Curvature gridding method is widely used in many branches of 
science and research. This method creates an interpolated surface similar to a 
thin, linearly elastic plate passing through each of the data values defined in the 
input dataset. An important criterion in creating a surface is that it has a minimum 
amount of bending forced upon it to conform to the data points. The degree of 
bending is constrained by a percentage change tension parameter. Minimum 
curvature gridding generates the smoothest surface possible while attempting to 
honour the data as closely as possible. Like all gridding methods, minimum 
curvature gridding is not an exact interpolation technique and therefore some 
error may occur between the input data point values and the interpolated surface 
values

Minimum Curvature (Stamped) Properties

The minimum curvature (Stamped) properties can be used to influence the 
geometry and smoothness of the output grid file.

Stamping Method

This parameter controls the accumulation rules that are applied when multiple 
data points fall within a single grid cell. There are several options available:

• Average all (last in weighted): averaged all data points 

• First Only: the first point value is assigned to the cell. All subsequent 
points are discarded.
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• Last Only: the last point value is assigned to the cell.

• Average All: averages all coincident point values.

• Average All (inverse distance weighted): averages all coincident points 
by applying an inverse distance weighting function.

Radius

The radius control defines a distance radius around a grid cell to search for valid 
input points. Distance is measured in increments of the output grid cell size.

Clipping

The clip control provides a number of options for clipping the extents of the 
interpolated grid, so that it more closely approximates the distribution of the input 
data. Options available include

• None
No clipping is applied to the output grid. With none selected the entire 
output grid will be filled with interpolated values.

• Near
The Near value represents the distance, in cell size increments, that the 
grid is to be clipped back to from the convex hull of the data points. Areas 
in the grid which lie beyond the Near distance will be assigned null. 
Setting a Near only clip value will have the same effect as setting a buffer 
clip distance.

• Near and Far
The Far distance is the maximum distance for which interpolation will 
occur between input points. Any area in the grid that has data points 
greater than the Far distance value will be displayed as null.
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Minimum Curvature (Full)

The Minimum Curvature gridding method is widely used in many branches of 
science and research. This method creates an interpolated surface similar to a 
thin, linearly elastic plate passing through each of the data values defined in the 
input dataset. An important criterion in creating a surface is that it has a minimum 
amount of bending forced upon it to conform to the data points. The degree of 
bending is constrained by a percentage change tension parameter. Minimum 
curvature gridding generates the smoothest surface possible while attempting to 
honour the data as closely as possible. Like all gridding methods, minimum 
curvature gridding is not an exact interpolation technique and therefore some 
error may occur between the input data point values and the interpolated surface 
values

Minimum Curvature (Full) Properties

The minimum curvature (Stamped) properties can be used to influence the 
geometry and smoothness of the output grid file.

Stamping Method

This parameter controls the accumulation rules that are applied when multiple 
data points fall within a single grid cell. There are several options available:

• Average all (last in weighted): averaged all data points 

• First Only: the first point value is assigned to the cell. All subsequent 
points are discarded.

• Last Only: the last point value is assigned to the cell.

• Average All: averages all coincident point values.

• Average All (inverse distance weighted): averages all coincident points 
by applying an inverse distance weighting function.

Radius

The control defines a distance radius around a grid cell to search for valid input 
points. Distance is measured in increments of the output grid cell size.

Clipping

The Clip control provides a number of options for clipping the extents of the 
interpolated grid, so that it more closely approximates the distribution of the input 
data. Options available include
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None

• None
No clipping is applied to the output grid. With none selected the entire 
output grid will be filled with interpolated values.

• Near
TThe Near value represents the distance, in cell size increments, that the 
grid is to be clipped back to from the convex hull of the data points. Areas 
in the grid which lie beyond the Near distance will be assigned null. 
Setting a Near only clip value will have the same effect as setting a buffer 
clip distance.

• Near and Far
The Far distance is the maximum distance for which interpolation will 
occur between input points. Any area in the grid that has data points 
greater than the Far distance value will be displayed as null.

Full minimum curvature vs stamped minimum curvature methods

Although the operational phases for these methods appear to be very similar, 
there are important processing and operational differences between the two 
techniques. It is important to consider these differences carefully when deciding 
which gridding method to use. The primary operational difference between the 
stamped minimum curvature and full minimum curvature methods is that the 
stamped method is faster and requires less hardware resources (disk space 
memory and processing power) than the full minimum curvature method. The 
stamped minimum curvature method is generally faster because it does not 
spatially sort or retain a full temporary copy of the input data during phase 3. 
Instead it stamps the input data directly into a temporary grid. In contrast the full 
minimum curvature method spatially sorts and stores a complete temporary copy 
of the input data in addition to stamping the points into a temporary grid. The two 
methods also differ during the final interpolation phase where the full minimum 
curvature gridding operation loads the spatially sorted temporary data again to 
complete the interpolation. Loading the data a second time requires additional 
processing time.

The additional performance cost incurred by the full minimum curvature algorithm 
is often rewarded in terms of better grid quality and estimation accuracy. The 
method is able to produce a better estimation for grid cells that contain one or 
more input data points. In comparison the stamped method may simply shift the 
data values to the centre of each cell (depending on the data accumulation 
methodology selected). The full method is able to make a better estimate of the 
cell value in these cases by taking into account the actual position of the input 
data value(s) rather than just the cell centre which may improve the estimates for 
all surrounding grid cells.
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Due to the potential improvement that the full minimum curvature method offers 
in output grid quality it is the recommended method, except where you determine 
the improvement in the grid quality will not be detectable or significant, or that the 
additional processing cost will be too high.

The stamped minimum curvature method may be more appropriate in the 
following situations:

• Re-interpolating existing gridded data onto a finer mesh. If the fine mesh is 
carefully designed so that the centre of the existing grid cells always fall in 
the centre of the cells of the new grid, then stamped minimum curvature 
will return the same result as the full method. However, if the cells are 
non-aligned then the full method will produce a better result.

• The output grid cell size is very small compared to the input data spacing. 
As a guideline if the grid cell size is 8x to 10x smaller than the input data 
spacing. In this case the input data value will be close to the centre of the 
cell into which it is stamped.

• The output grid cell size is large compared to the input data spacing. As a 
guideline if the grid cell size is 2x larger than the input data spacing then 
you are more likely to want the grid cell estimation to represent the 
average value of the observations within the cell.

• Noisy data. If the input data has a high level of noise then there is little 
reason to more accurately represent it by using the full minimum curvature 
method.

• Large data measurement footprint. If the data observations represent an 
average of a large footprint (e.g. radar) then stamped minimum curvature 
may be sufficiently accurate. However, where the observations represent 
an accurate point measurement of a smooth continuous field then full 
minimum curvature should always be used.

Data Density

The Density gridding method produces a grid which records a measure of the 
point density at each grid node. The density at each grid node is determined 
independently using a kernel estimator function 
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Data Density Properties Kernel 

The Kernel Density Estimator method is a non-parametric density estimator. It 
uses a similar approach but it weights the input samples by a kernel function that 
is normally a function of the normalized distance of the sample to the grid node. 
To achieve a good result with the KDE function it is more important to choose an 
appropriate search radius – sometimes referred to as the bandwidth – than to 
choose an appropriate kernel function. If the bandwidth is too small the density 
will be under-smoothed whereas if the bandwidth is too large the density will be 
over-smoothed and lacking in resolution.

Given a kernel function K and a search radius (or bandwidth) h, the estimated 
density at any point x is given by – 

where n  is the number of samples. The following kernel functions are supported:
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Radius

To achieve a good result with the Density gridding function it is more important to 
choose an appropriate search radius—sometimes referred to as the 
bandwidth—than to choose an appropriate kernel function. If the bandwidth is too 
small the density will be under-smoothed whereas if the bandwidth is too large the 
density will be over-smoothed and lacking in resolution. The radius distance is 
measured in increments of the output cell size.

Normalise by area

This control converts the data frequency values into spatial density values by 
dividing the value of each cell by the area of the search radius.

Bias by input field value

When enabled this control interprets the selected input field(s) as a count of the 
number of observations at that location. It allows a single point to represent more 
than one observation.

Data Point Separation 

The data point separation gridding method produces a grid which records the 
distance to the closest input data features to each grid node. 

Data Point Separation Properties

The distance radius specifies the maximum distance to search for valid input 
points. The distance is specified in increments of the output grid cell size.  

Output Grid

Data Type

The data type control is used to set the numeric storage type for the interpolated 
values in the output grid. It is advisable to select the appropriate data type that 
most efficiently represents the range of data that will be stored in the output grid. 
For example a signed 2-byte integer is generally suitable for storing typical 
elevation data at 1m vertical resolution. The table below lists the available options 
and the valid data range that can be stored by each of the data types.

Data Type Bytes Range of Values

Unsigned byte 1 0 to 255
Signed byte 1 -128 to 127
Unsigned short 2 0 to 65,535
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The automatic option will set the output format to an appropriate data type based 
on an analysis of the input data range.

File Name and Grid format

The output grid file(s) can be specified as either a single band ERMapper or BIL 
format grid. Although both of these formats support multiple bands in a single file, 
the grids created by the Large and Multi-file gridding tool can be extremely large, 
so we have chosen to output each band (or field) to a separate grid file for 
convenience. If multiple fields are selected for interpolation then multiple output 
grid files will be created. The name of each file will be the user specified name 
(e.g. MY_DEM) with the field name appended to it in square brackets (e.g. 
MY_DEM_[elevation].ers).  

In addition to the ER Mapper (.ERS) or BIL (.BIL) grid header and data files a 
MapInfo .TAB file will also be generated for each output grid if the Auto open 
output file(s) option is enabled.

Grid projection

A projection must be assigned to the output grid(s). While it is possible to specify 
different projections for the input data and output grid it is not recommended for 
very large datasets as it may degrade the performance of the input processing 
phase significantly as each point will need to be reprojected into the output grid 
coordinate system prior to gridding.

Auto open output file(s) 

When enabled the output grid file(s) will be automatically open into MapInfo.

Section Gridding

Signed short 2 -32,768 to 32,767
Unsigned int 4 0 to 4,294,967,295
Signed int 4 -2,147,483,648 to 2,147,483,647  
Float 4 -3.8e-38 to 3.4e38

Note This tool requires an Encom Discover PA Professional licence. If you wish to 
purchase or evaluate this module, please contact Pitney Bowes Software.
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Encom Discover PA can display gridded data in profiles. These items are referred 
to as Section Grids which are designed to display grids (in ERMapper format) as 
images. Section Grids can be used with their line association such that the Line 
Iterator can be used to cycle through survey data.

The Section Grids can be added to documents containing either Profiles or 2D 
Graphs via the menu command Add Data>Section Grid method. An example of 
a Section Grid is shown below:

Example of Section Gridding Group with conventional section of the same data line.

To operate the Section Gridding tool:

1. Choose the source dataset and the lines to grid. One grid file is produced 
for each line chosen. You can select the lines required from the Line 
Selection button. 

Note Although section gridding produces ERS files with registration information, this 
3D registration is customized and only recognized by PA. Third-party 
applications will not display the ERS in the correct 3D geo-location.
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2. Choose the X and Y fields that define the geometry of the line. These 
fields are used to compute Chordlength that is used as the horizontal field 
in the output grid. 

3. Sort the input data if it lies on an essentially straight line. 

4. Compress the line data. This reduces the amount of output line 
information and is advised for most line data. If your line data is not 
straight, you can elect to switch this off.

Section Gridding dialog for creating gridded sections

The line data needs to be correctly prepared for gridding. The tool converts the X 
and Y fields into chordlength that are used as the horizontal grid coordinate. To 
do this properly the data must be properly sorted so that each station is at least 
as far or further along the line than the last. The software automatically sorts the 
input data to ensure this is the case which is appropriate for the majority of 
datasets that approximate a straight line. If your input data follows a convoluted 
path the sorting algorithm may fail. In these cases you can disable sorting but you 
must then ensure that your data is appropriate for gridding.
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Usually, the vertical dimension is depth, RL or similar. The vertical field is 
expected to decrease downwards. If you have depth values that increase 
downwards you can specify the Subtract depth from DTM option to reverse the 
sign of the depth, regardless of whether you specify a DTM field. If the depth 
values are in local coordinates then you can specify a DTM field which is added 
to the depth field to obtain true RL.

Set the DTM offset field if required. If the depth/RL field is increasing downwards, 
enable the Subtract depth from DTM option to reverse the sign.

The Section Gridding tool can be used to grid either multi-banded or single 
banded data. The prior case is suitable for EM inversion data which is generally 
stored as a multi-banded depth field and a matching multi-banded conductivity 
field. In this case, ensure that the number of depth bands match the number of 
conductivity bands. IP data is a special case as it usually is single banded with a 
depth, resistivity and chargeability fields (see Display of IP Data). In all cases, the 
output grid is only single banded so you can only grid one parameter at a time.

By default the Section Gridding utility only displays the multi-banded fields in the 
dataset. To display all fields, enable the Show all fields box.

Select the depth field and the data field. It is likely you will choose to use all bands 
from these fields, in which case check the All bands box. Otherwise, you can 
select the bands individually. By checking the Use depth bands box you can 
force the tool to use the same band numbers for data as you have selected for 
depth.

The tool uses a minimum curvature algorithm to grid the data. You can specify the 
grid cell size plus smoothing and clipping. Set the grid cell size in the horizontal 
and vertical dimensions. Note that a suggested cell size is automatically 
displayed when you change the input data specifications but once you have 
manually set the cell size it is retained.

Allow some padding around the data nodes to ensure the grid is extended 
beyond the data. The padding distance is specified in units of grid cells. You can 
smooth the grid prior to output in which case you ought to specify a Gaussian filter 
width (in units of grid cells).

You can clip the grid prior to output. The clipping algorithm clips tightly about the 
input data points but takes into account any padding specified. The Advanced 
Clipping dialog allows you to set advanced options. 
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Section Gridding utility with the Clipping options dialog.

The Section Gridding tool produces an output grid for each input line. To use 
these grids in a profile display in Encom Discover PA they should all have similar 
names, varying only by the line number, and they ought to be located in the same 
disk directory.

If you enable the Open in Encom Discover PA option, the first grid generated is 
opened in a section profile as soon as it is written to disk. To view the section grids 
in a 3D display, see Section Profiles in 3D Displays.

Display of IP Data

Induced Polarisation data can be displayed in Encom Discover PA using the 
Section Gridding utility. Standard Geosoft IP databases can be used. These 
datasets routinely have a multi-banded data field for IP, but multiple records for 
each data location corresponding to a different n-spacing (or receiver dipole pair).

This data storage format means that if you wish to display a conventional 
psudosection of resistivity or chargeability (using the n-spacing for vertical 
scaling, the data must first be sorted. The Section Gridding utility sorts the data 
so that each station is at least as far or further along the survey line than the last 
point.

Normally the utility automatically sorts the input data to ensure this is the case and 
for the majority of datasets that approximate a straight line.
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When sorting an IP dataset, the assumption is made that the line is straight, but 
the sorting uses the n-spacing to order the data. The usual Data fields of 
Resistivity, Metal Factor or Chargeability could be used and a DTM data field can 
be used to determine an upper topography surface.

Due to the n-spacing distribution of a pseudosection, clipping is important.

Clipping in the Section Gridding utility generates an outer perimeter of the input 
data, then erodes this by triangulation from the outside inwards, progressively 
removing edge triangles whose outward angle exceed a tolerance. Be aware that 
when the horizontal coordinates are different to the vertical coordinates the 
triangles can get flattened and the algorithm can perform poorly. For example, if 
the horizontal coordinates are in metres along line and vertical coordinates are n 
spacing (e.g. 1-6) then the horizontal range may be 100 times greater than the 
vertical range or more. In cases like this it is advisable to normalise the data to 
regularise the triangles. Also, the rejection tolerance can be modified between 0 
to 180 degrees. Both of these options are controlled from the Advanced clipping 
dialog as shown below:

In this dataset, the Resistivity data channel (Res) is being gridded above. Note 
that topography is being applied as an offset from the DTM field and Smoothing 
and Clipping are applied. A jagged edge on the outer margins of the grid can 
result if the horizontal and vertical dimensions are not normalised for clipping.

The output gridded and contoured result is shown below.

Examples of IP pseudosections with Chargeability and Resistivity
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Grid Calculator

The Grid Calculator can apply arithmetic operations, logic, comparative and 
Boolean operations directly to grids or between grids of any supported format. It 
performs the operations directly writing to the disk file, and does not require the 
grid to be loaded into memory or opened in Encom Discover PA.

Grid Calculator and specifying a formula

 

Available grids are displayed in the scrollable list at the top of the dialog. This list 
is initially populated by all grids currently open. Further grids can be added to the 
list using the Load Grid button, and removed from the list using the Delete Grid 
button. Use the Information button to obtain details of a selected grid.
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Grids can be assigned an alias name to enable the shortening of complex file 
names for ease of use in the expression line. For example, the grid file 
Rockchip_samples_As_210503 can be simplified to the alias name X. This 
enables the following simple expression output=X/(X*2) to be entered into the 
expression line rather than full grid name. To create a grid name alias, double 
click on the relevant cell in the Alias Name column and type the desired alias 
name.

The Grid Calculator requires a formula to be specified in the Expression line in 
the middle of the dialog. Complex grid operations such a Boolean and decision 
functions can also be applied. 

If the areas covered by selected grids are different, results are computed only for 
grids where data overlap occurs. The remaining area of the first grid specified in 
the command line is filled with nulls. If node points are offset between grids, the 
data is interpolated prior computation. If grids of different mesh sizes are used, 
the mesh size of the first specified grid in the command line is output.

The Grid Calculator dialog and expression control is shown below:

 

Note In the Grid Open dialog, a range of supported grid formats are available. The 
Grid Calculator can be used to convert grid formats if required. Grid to grid 
computation can also be performed irrespective of the input formats or 
requested output format.
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Grid Calculator button layout and command line control

An expression must be a ‘correct’ arithmetic formula of the format:

output = function(input)

A new grid file alias must be entered on the left hand side of the expression. By 
default this is "output". This alias is automatically used by default for the output 
grid file name when the output grid is generated.

Click the individual operation buttons to enter the operation into the expression 
line. Formulas can be entered directly into the expression line by keyboard entry 
or by selecting the appropriate fields and buttons via the Grid Calculator.

To add a grid to the expression line, place the cursor at the desired location in 
the expression (if not already there), highlight the grid in the grid list and press 
the Add Grid button
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The Save As button enables an expression to be saved to a text file. Use the 
Load button to re-load the saved expression into the Grid Calculator dialog.

The Insert Function button enables the construction of complex formulae. A 
wide range of arithmetic, logic and Boolean operations are available from within 
the Grid Calculator. When a function is selected from the Insert Function 
pulldown list a definition of the function and the syntax required is displayed in the 
Grid Calculator dialog.

The actual output grid file name can be to be specified when the expression is 
computed in the Output section or using the file Save As button. If the output file 
name is not changed, the alias name is automatically saved. The Output grid file 
type can also be selected from the Format drop down list. The Compute 
Summary statistics option enables the calculations of grid statistics which are 
used by Encom Discover PA’s Grid Handlers to display the grid.

When the expression is completed, press the Compute button. If the syntax is 
correct, a progress window is displayed as the Grid Calculator processes the 
expression. If there is a syntax error in the expression line a message is 
displayed:.

Using Multi-banded Grid Inputs

The Grid Calculator also has the ability to reference individual bands from a multi-
banded input grid in the formula. Using an example of two grids called GridA and 
GridB, both with 3 bands, a typical expression to access the second band of GridA 
and the third band of GridB would be:

Output = GridA[2] + GridB[3]*0.5 + GridB[3]*0.25

The above example would produce a single banded output grid. 

However if one or more inputs were 'all bands' such as the below expression, you 
would get a multi-banded grid output:

Output = GridA + GridB*0.5 + GridB*0.25

The Recently Used Expression button opens a drop down list of functions last 
used in the Grid Calculator.

 
The Save As button enables an expression to be saved to a text file. Use the 
Load button to re-load the saved expression into the Grid Calculator dialog.
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Grid Filter

The Grid Filter option is a powerful tool that provides the following functionality:

• Numerous grid operations including padding, filtering and null filling can 
be undertaken.

• A wide range of convolution grid filters can be applied including average, 
standard, Gaussian, geophysical, seismic and sun-angle filters.

• FFT filtering using sophisticated operators to apply geophysical filter 
results.

• Advanced FFT filters specifically designed to provide geophysical 
processing for continuations, derivatives, reductions and edge and 
gradient detections.

To access the Grid Filter utility select the Grid>Grid Filter menu option. The utility 
dialog appears as shown below:

Note The FFT>Special>FFT ZS Filters utility requires an Encom Discover PA 
Professional licence. If you wish to purchase or evaluate this module, please 
contact Pitney Bowes Software.
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Grid Filter tool with multiple operators applied to an input grid, zoomed and the resultant 
output grid

The dialog is divided into a number of control and display areas. These are:

• List of specified input grids. Any grids loaded in Encom Discover PA prior 
to opening the Grid Filter utility will be listed here. Additional grids can be 
accessed using the Browse button. A specified grid can also be removed 
from the list using the Delete button.

• Information, Settings and Help buttons provide information on the 
specified grid plus display and filtering controls.

  

• Buttons (Conv, FFT and Utils) provide pull-down lists of available 
operations. In the area beneath these buttons is an area where selected 
operations accumulate. The order of the operations is important as 
processing is incrementally applied from the top to the bottom. The last 
operation produces the output grid. An operation’s position in the order 
can be altered by using the Up or Down arrow buttons after selecting the 
process to be moved. The Delete button can remove a highlighted 
process.
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• Three display windows of the highlighted grid are shown on the right side 
of the dialog. The top window shows the entire original input grid. The 
centre and bottom windows may show the same area of the input grid or a 
zoomed in portion of the original grid. In the upper window, a small 
rectangle is drawn (for grids larger than 400 x 400 rows and columns) over 
the original grid. This rectangle indicates the portion that is being 
processed by the operations. The rectangle can be selected by the cursor 
and moved to a new part of the input grid if required.

The lowest preview window indicates the output result of the various 
operations list. Refer to Using the Grid Filter Tool for information on 
zooming and panning in these windows.

• Some grids may require padding. Padding is used as a pre-processing 
stage necessary for application of certain filters (such as FFT filters). 
Refer to Appendix C: Grid Filters for additional information on padding.

• The Filter Properties area details any controls that apply to a highlighted 
operation. The controls may list kernels, required wavelengths and filter 
specifications or magnetic field controls (for example when using the 
pseudo-gravity FFT filter). 

• The output grid name is listed at the base of the dialog if the Save As 
button is clicked. The standard Encom Discover PA grid formats are 
supported (refer to Supported Grid Formats).

For more information, see:

• Using the Grid Filter Tool

• Preview WIndows

• Filter Operations

• Order of Operations

• Grid Information

• Grid Filter Settings

• Fill Holes

A detailed description of the various filters and their application is provided in 
Appendix C: Grid Filters (Convolution Filter Descriptions, FFT Filter Descriptions, 
Grid Filter Operators, and GeoFilter filters).
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Using the Grid Filter Tool

To use the Grid Filter tool, use the Browse button to load a grid. You can specify 
the grid format from the Files of Type entry in the Open dialog.

Use the Files of Type option to select a specific file type

Once loaded, the grid content is displayed in the three preview windows. Using 
the CONV (Convolution filters), FFT (FFT Filters) or Utils (Utilities) buttons and 
the provided pull-down lists, select the operations to be performed on the grid. 
Note that as operations are added, they are immediately performed on a portion 
of the input grid. The area over which the operations are applied is indicated by a 
square drawn in the top preview window. The content of this square is shown in 
the second, middle window. The output of the processing steps is shown in the 
bottom preview window.

Preview WIndows

If you wish to examine the effects of the processing more closely, you can position 
the cursor in the middle or lower preview windows and click the left mouse button. 
When placed in the window initially, the cursor changes to be a magnifying glass. 
Clicking the left mouse button zooms the view in the middle and output preview 
windows and allows you to see a portion of the processed area. A subsequent left 
mouse click returns the view back to the original size. If you wish to pan the 
zoomed view, click the right button and while the cursor hand is shown, you can 
drag-and-drop the zoomed image.
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Note that the square drawn in the upper window indicates the area of processing. 
Since processing can take some time for complex operations, only this small (400 
x 400 row/column) area is used. If you wish to move the processed area, position 
the cursor over the square in the upper preview window and with the left mouse 
pressed, drag-and-drop it to a new location. The processing is then applied to this 
new data. 

When you request that the processed grid be output, using the Save As button, 
the processing is applied to the entire grid and written to the new file specification 
nominated from the Save As button.

 

The dialog for the Grid Filter with input, raw and output grids
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If you wish the gridded output to automatically be displayed in Encom Discover 
PA after writing to the nominated output file, turn on the Auto open after save 
option.

Filter Operations

The operations provided by the Grid Filter are:

Filter Type Option
Convolution User Defined General mxn Filter

Average mxm Filter
Gaussian mxm Filter

Advanced amedian
average 
deviation
median
wlocalmadj

Average nxn Average Filters
Diagonal Filter
Horizontal Filter
Vertical Ffilter

Gaussian Standard Deviation = 0.391
Standard Deviation = 0.625
Standard Deviation = 1.0
Standard Deviation = 1.6

Geophysical Bandpass Filter (3 to 5 grid spacings
High Pass Filter (4 grid spacings)
Low Pass Filter (4 grid spacings)
Downward Continuations
Ford High Frequency Enhancement
Horizontal Edge Eenhancement
Residual Ring Filters
Edge Sharpening Filters
Upward Continuation Filters
HZ Second Dderivatives

Seismic Easterley Ddip
Hanning
Northerly Dip
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Standard Darn holes
Default Kernel
Force no subsampling
Laplacian Filters
Horizontal Edge Enhancement Filters
Vertical Edge Enhancement Filters
Low Frequency Filter
Edge Sharpening Filters
nxn Avg, Threshold = 5 Filters

Sun Angle East
North
North East
North West
South
South East
South West
West

FFT Component FFT TMI to Single Magnetic Component 
(General)
FFT TMI to XYZ Magnetic Components
FFT General Directional Transform Filter

Derivative FFT Derivative Filter (Advanced)
FFT Integration Filter (Advanced)
FFT Vertical Derivative Filter

General FFT Analytic Signal
FFT Band Pass Filter
FFT Butterworth Filter
FFT Continuation Filter
FFT Directional Cosine Filter
FFT High Pass Filter
FFT Low Pass Filter
FFT Directional Pie Slice Filter

Special FFT Encom ZS Filters
Tensor FFT gz to Gravity Gradient Tensor (GGT) Filter

FFT TMI to Magnetic Gradient Tensor (MGT) 
Filter

Filter Type Option (Continued)
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Descriptions of the various filters and operators are provided in Appendix C: Grid 
Filters (Convolution Filter Descriptions and FFT Filter Descriptions). A full 
description of the GeoFilter filters is also provided.

Order of Operations

Filters and processing operations are applied in the order listed. Each operation 
may require you to specify some controls in the Filter parameters area. The 
controls and parameters for each operation and filter type are described in the 
Operation and Filter Descriptions of Appendix B. The required controls vary 
according to the highlighted operation in the list shown in the dialog.

Grid Information

FFT Tensor (MGT/GGT) to Field Component 
Filter

Transform FFT TMI Pseudo-gravity Transform Filter
FFT gz Pseudo-magnetic Transform Filter
FFT TMI Reduction to the Equator Filter
FFT TMI Reduction to the Pole Filter
FFT TMI Reduction to the Pole Filter (low 
latitude)
FFT TMI General Phase Transformation Filter

Utilities Utils Fill Holes

Note When applying FFT filters, especially such as the Low Latitude filter, to avoid 
Gibbs Phenomena becoming apparent, it is a good idea to initially apply an 
Upward Continuation filter of approximately half the grid cell width.

The processing is applied such that the output of one operation is the input of the 
next. This means that complex processing can be applied cumulatively. If you 
wish to alter the order of operation, use the Up and Down button to the right of 
the operation list. You can also remove an operation by selecting it and then 
clicking the Delete button.

Information relating to the size, rows/columns and data within each of the three 
preview buttons can be displayed by clicking the Information button. When 
zoomed and processing is applied, each preview window contains different grid 
data content and so the displayed dialog report indicates this:

Filter Type Option (Continued)
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Grid Information for the three preview windows of the Grid Filter

Grid Filter Settings

The Grid Filter allows you to control the zoom and padding of the Grid Filter. 
Select the Settings button to display a control dialog.

The zoom level can be specified as default. The integer indicates the increase of 
level such that an entry of 5 zooms the area to 5 rows/columns for each one seen 
in the original, upper preview window. The window titles (Full, Input and Filtered) 
can also be eliminated if required.

Grid Filter settings for zoom levels and padding

Padding controls permit an area surrounding the input grid to be created to 
minimise edge and filtering effects when certain filters are applied. Refer to FFT 
Filter Descriptions for additional information. The area around the original grid to 
be processed can be set as a percentage of grid area around the perimeter. This 
is referred to as the Padding margin. Two methods are also provided for the 
padding. These are:



922 Encom Discover PA User Guide

• Padding by row and then by column – This option duplicates the outer 
rows then columns of the input data grid and extends them outwards to 
the Padding margin to surround the grid 

• Padding in 2D using gridding – This method extends the grid margin by 
extending the grid data and gridding it over the extent of the Padding 
margin. This method produces a relatively seamless edge to the grid and 
allows for smooth filter application without edge effects. This method is 
superior in many cases to the first because it eliminates the horizontal and 
vertical streaks which padding by row and then by column can introduce.

The Padding Margin as it is appended to the original grid can be saved for 
examination if required. Enable the Save padded grid option to this.

It is recommended that padding is always used when running an FFT filter. If the 
input grid is not square then FFT filters cannot be used unless padding is 
selected. Padding squares up the grid.

Fill Holes

The Grid Filter Utils>Fill holes option can be used to replace nulls in a grid by 
extrapolating the surrounding data. There are two options available for this 
module:

• Fill internal holes only

• Fill internal holes and nulls surrounding grid

If the first option is selected then only null values which are not connected by nulls 
to the outer edge of the grid are filled that is, internal holes. If the second option 
is selected, then all nulls in the grid are replaced with extrapolated values.

The method used to fill holes involves progressive extrapolation from the outer 
rim of the hole towards the centre until the entire hole is filled. This process can 
be slow for large holes.

Grid Utility

The Grid Utility allows various operations to be performed on one or more 
specified input grids. These operations include:

• Classify – Classify each grid cell into one of a number of ranges.

• Grid to Grid Clip – Clip a grid to the non-null area of another grid.
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• Clip – exclude or include the data from a grid defined by an irregular 
polygonal region or by a rectangular region. The data can be clipped 
outside or inside the region.

• Convert – input a data grid in one format and save as another to convert 
the output format as required.

• Create RGB – combine separate grids having Red:Blue:Green colour 
signatures to a single, multi-banded RGB grid file.

• Curvature – compute curvature of each cell in a grid.

• Cut/Fill – compute the cut and fill differences between two grids.

• Edit – point to a grid node and the data values for it and its surrounding 
cells are displayed. You can edit the data values if required. 

• Fill Holes – Replace nulls within or around a grid by extrapolating values 
using the surrounding data.

• Flip – the rows or the columns of a grid can be inverted in their location 
either horizontally or vertically.

• Merge - Merge several grids to form a new grid.

• Outline - Outline grid bounds or non-null regions as polygons.

• Overlay - Modify grid cell values based on polygon boundaries in a 
specified TAB or MIF vector file.

• Replace – allow specific grid values (such as Nulls or nominated values) 
to be replaced by another data value or Null

• Reproject – permits the input grid to be reprojected to an alternative 
Projection and Spheroid/Datum combination.

• Resample – grids can be resampled to a new cell size using any of three 
available interpolation schemes.

• Rotate – a grid can be rotated about its defined origin by a specified angle. 
Interpolation processing is required for this procedure.

• Shift – apply an east or northing offset to the origin of a grid.

• Slope – calculate the slope angle or aspect (dip direction) of each cell in a 
grid.
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• Split – used for multi-banded grids, this operation outputs separate 
component grids of the individual single bands.

• Statistics – compute statistics for a grid, or the cells contained by one or 
more overlying vector objects, or by regions in a classified grid.

• Surface Area – compute the 3D surface area, planar area, and roughness 
of cells ina grid.

• Vectorise – converts each grid cell or grid outline into a polygon in the 
output vector file and assigns each polygon a grey-scale value.

• Viewshed – compute the view-shed of one or more towers of a specified 
height above the grid to an observer at a specified height above the grid.

• Volume – computes the volume between two grid surfaces or between a 
grid surface and a defined value.

All functions are operated from a common dialog as shown below.

Other controls include a Settings button (to control the zoom level in the preview 
screens) and Help.

A Function pull-down list allows selection of the required operation and a 
Description for each is displayed when selected. As each Function is individually 
selected, the control parameters for that operation are displayed.

The upper portion of the dialog allows grids to be added to a list (from the 
Browse button). If you wish to apply operations on a created, flat grid, you can 
use the Create Grid button.

By highlighting a grid in the list and clicking the Information button, a display of 
the grid statistics is provided. The current grid projection can also be queried by 
using this button.
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Grid Utility dialog with grid selection and Function parameter displays

In the two Preview panes on the right side of the Grid Utility dialog are Before and 
After views of the selected grid. As you change the grid selection or the grid 
function, so the preview panes redraw and update with the changes. Note that the 
visual changes occur in memory only and are not permanently saved until you 
specify and save an output grid using the Save As button.

You can control the monochrome or colour appearance of the grids from the Use 
Colour Look-Up table button and a linear or equal area histogram stretch can 
be applied from the Histogram Equalisation button. When the cursor is 
positioned in either of the Preview panes, its function (and appearance) alters 
depending on the selected button control at the bottom of the panes.

Pointer mode – Used to select a position or cell value in a grid

Zoom In or Out – Click the button and move the cursor into the preview pane. 
Click again and the level of zoom doubles (or halves) each time the mouse is 
clicked. This zooming occurs in both Before and After panes.

Pan the image content in the preview pane by positioning the cursor, hold the 
left mouse button down and drag. When released the image is redrawn.
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The Settings button allows a cross-hairs cursor to be displayed in the After pane. 
A second setting toggles the display of the text After or Before if these are 
optionally not wanted. Beneath the various button controls (described above), the 
cursor position indicates the Column and Row location on the displayed grid.

At any time in the processing of a grid, the Stop button can be used to halt 
computation and return to the previous state.

The various grid operation functions are described below.

Classify

The Classify grid utility enables an input grid to have the value of each cell 
classified into one of a number of ranges. By default the input grid is automatically 
classified into 5 bins. Each bin represents an equal data range spread between 
the minimum and maximum grid values. The output cells are assigned a bin value 
of 1 to 5 based on the input cell value range.

Return a zoomed or panned grid to its default fitted preview view.

Return a zoomed grid to a 1:1 zoom ratio.
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Use the Auto button to automatically classify the grid cells. Use the Auto classify 
dialog to modify the Input classification range and the Number of 
classifications or bins in the output grid. By default the bin or classification 
values start at 1 and increase by 1 but these options can be changed by setting 
a new Output value start and Output value step. The Output value start and the 
Output value step are saved in the registry and are used as the defaults next 
time the Classify utility is opened. The input classification range is re-computed 
each time a new input grid is loaded.

Complete manual control of the classification process is possible by manually 
editing the bin ranges. In addition use the Add row and Insert row buttons to 
append or insert a row and the Delete rows button to remove rows from the 
classification. Hold down the SHIFT or CTRL keys to select multiple rows for 
deletion.

Note that to assign any classification of the grid ranges to their appropriate bins, 
you must:

• Turn on the option in the Settings to Use separate colour stretch after 
preview.

Specify the upper and lower range of data to be binned and the number and increment of 
bins

Saving the output grid stores the binned data ranges with all null values being 
retained.

• Turn off the Histogram Equalisation button for the colour stretch.
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Grid to Grid Clip

The Grid to Grid Clip tool allows a source grid to be clipped to the extents of 
another grid. This requires both grids to be in the same projection (use the 
Reproject utility to convert grid projections), and the grids must overlap.

Select the source grid (i.e. the grid to be clipped) from the listing of available grids 
at the top of the GridUtility. This will automatically populate the Input grid window. 
Select the grid to clip against (i.e. the grid whose extents the source grid will be 
clipped to) in the Clip to Grid pull-down list. The output will be presented in the 
Preview window; use Save As to generate the output clipped grid.

Clip

By opening a grid and selecting the Clip operation from the Function pull-down 
list, the following control parameters are displayed.

Clip parameters in the Grid Utility dialog
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The Clipping process can operate in two ways:

• Define a rectangular area (using the Min and Max X and Y corner extents) 
and clip data as controlled by this region or

• Use a polygonal shape defined by a MapInfo Professional .TAB or .MIF 
file, ESRI .SHP file or a Encom Discover PA Features database polygon.

In both cases above, you can use the bounding region to clip data inside (using 
the Clip grid to region) or outside the area (using Blank grid underneath 
region).

Note that when a grid is clipped, where possible the size of the grid is minimised 
and nulls and unused whole rows or columns removed. This can substantially 
reduce the size of a large grid if only a small portion is extracted.

Convert

Selected grids can be converted to an alternate grid format. The formats available 
include:

• ER Mapper

• Geosoft

• Vertical Mapper

• Surfer

• Encom .GRD

• GeoTiff

No parameters are used for this option. Select the file required to be converted 
and then click the Save As button. From the Save as type pull-down list, 
nominate the output file format required and then give it a location and name. If 
you do not specify a file extension, the output file has the format’s default file 
extension added (refer to Appendix E: Supported File Formats).
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Select the required output grid format from the pull-down list

Create RGB

This operation combines single band grids into one multi-banded grid. This 
operation can be used for combining Red:Blue:Green grids to a single multi-
banded RGB grid. It can also be used to combine multi-component data grids 
such as used in spectrometery (for example, Potassium, Uranium and Thorium).

Curvature

The Curvature utility calculates the curvature of a surface at each cell centre. 
Three types of curvature grids are available:

• Profile curvature is estimated along the direction of maximum slope

• Plan curvature is estimated across the direction of maximum slope

• Surface curvature is computed as the difference between the Profile and 
the Plan curvatures.

The method used to create the curvature grids is as follows.

Curvature is computed for the centre cell (e0) within a 3x3 kernel such as:
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The first step is to estimate the coefficients D through H of a quadratic polynomial 
equation that fits the 3x3 window.

z = Ax2y2 + Bx2y + Cxy2 + Dx2 + Ey2 + Fxy + Gx + Hy + I

where

D = [(e4 + e5)/2 - e0] / CellSize2

E = [(e2 + e7)/2 -e0] / CellSize2

F = (-e1 + e3 + e6 - e8) / 4 x CellSize2

G = (-e4 + e5) / 2 x CellSize
H = (e2 - e7) / 2 x CellSize

The Profile Curvature is estimated along the direction of maximum slope and is 
computed as:

Profile Curvature = -2 [(DG2 + EH2 + FGH) / (G2 + H2)]

The Plan Curvature is estimated across the direction of maximum slope and is 
computed as:

Plan Curvature = 2 [(DH2 + EG2 - FGH) / (G2 + H2)]

The Surface Curvature is the difference between the Profile and Plan and is 
computed as:

Surface Curvature = -2 (D + E)

A positive curvature indicates that the surface is upwardly convex at that point, 
whilst a negative curvature indicates that the surface is upwardly concave. A 
value of zero indicates that the surface is flat.

Cut/Fill

This utility will compute the difference between two grids.

Once two grids have been loaded into the session, open the Grid Utility from the 
Grid menu and choose the Cut/Fill option from the available list. 

e1 e2 e3

e4 e0 e5

e6 e7 e8
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In the list of available grid files appearing at the top of the dialog highlight the grid 
you wish to compute the change from. This grid file will appear in the Before grid 
box further down in the dialog.

Then in the drop down list for the After grid choose the grid that you want to 
subtract values from. 

The Volume change entry box will automatically update with the computed 
change in volume between the two grids.

The Cut/Fill grid utility parameters.
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Edit

To more precisely locate the cursor and grid cell, you may also wish to display a 
line cursor (see diagram below). This is enabled from the Settings button. 

Once a grid cell has been selected, double clicking inside the spreadsheet cell 
allows the data value to be edited with a new value typed from the keyboard. 

Selected grid cell and displayed data value available for editing

Fill Holes

The Fill Holes utility is used to replace nulls in a grid by interpolating the 
surrounding data values. The following Fill Holes options are available:

The data values of grids can be individually selected and modified if required. 
Select a grid and highlight it in the grid list. The Preview panes show the grid 
after selection. After choosing Edit in the Function pull-down list, the Pointer 
mode can be used to select individual grid cells for editing. Select the Pointer 
mode button, move the cursor to the Preview pane and select the grid cell. When 
this is done, the spreadsheet redisplays to indicate the data values of the 
selected cell and the various nodes around it.

If the level of zoom is inappropriate, select the magnifying glass zoom in or out 
buttons and adjust the view.
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• Fill internal holes only

• Only internal holes or null grid cells which are not connected by nulls to 
the outer edge of the grid are given a new interpolated value 

• Fill internal holes and nulls surrounding grid

• All null grid cells in the grid are replaced with interpolated values.

The method used to fill holes involves progressive interpolation from the outer rim 
of the hole towards the centre until the entire hole is filled. This process can be 
slow for large holes.

Flip

A selected grid can have the order of its rows reversed to produce a vertical flip 
and columns reversed to produce a horizontal flip. No change is made to the 
number of rows or columns of a grid in this operation and the extent and origin of 
the grid in unchanged.

Merge

The Merge grid tool allows multiple grids (overlapping or non-overlapping) to be 
combined into a single output grid. A number of data handling options are 
provided for overlapping cell values. This tool requires all grids to be in the same 
projection (use the Reproject Grid utility to convert grid projections).

Within the Merge grid dialog area, select the source grids from the pull-down list 
and use the Add button to add these to the Grids to merge window below. 
Selecting grids from this pull-down list will not force a refresh of the preview 
screen each time a grid is selected, which is useful when dealing with large grids. 
The preview screen can be manually refreshed using the Update button. Grids 
can be removed from the Grids to merge window using the Remove button. 

A primary grid must be highlighted in the Grids to merge window; the Merge tool 
will use this grid’s cell dimensions for the output grid. 

A range of Overlap combining methods are provided for handling of 
overlapping grid cells:

Minimum
Maximum
Average
Sum
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Outline

The Outline utility allows the bounds of multiple grids to be outlined as polygons 
in a single output vector file. Each bounding polygon is attributed with the source 
grid file name, and its minimum and maximum X and Y coordinates.

This is a useful way of visualising the extents of multiple regional airborne 
surveys, such as aeromagnetic and gravity surveys.

Overlay

Grid cells may be attributed with a Constant overlay value by entering a numeric 
or text value into the Overlay value window. If the polygons or polylines in the 
vector file contain attributes then choose the Overlay value from field option and 
select the attribute field from the Value field pull-down list. All grid cells that are 
located within a polygon or polyline will have an output value equal to the overlay 
value of that polygon. Cells which are outside polygons or polylines in the vector 
file can be assigned a null value, the value of the input grid (unchanged) or a user-
defined constant value.

In addition to the use of polygons in the input vector file, polylines and point 
objects are also supported. A Buffer zone may be specified by the user to control 
how wide these objects appear in the overlay output. The default buffer zone of 0 
means that a polyline will create an overlay that is approximately one grid cell 
wide. For example, a buffer value of 15 will create a line overlay with a width of 
30 metres (15 metres each side of the line). Points will result in a circular 
coverage with a radius equal to the buffer zone.

If the buffer zone value is non-zero then polygons will also have their boundaries 
extended by the amount specified. An example of an overlay with polygons used 
to define areas on a DEM surface is shown below:

Note Each input grid must have the same projection.

The Overlay utility enables grid cells to be classified using polygons or polylines 
from a specified MapInfo Professional TAB or MID/MIF vector file. The dialog is 
enabled once an appropriate vector file (polyline or polygons) is opened using 
the Browse button 
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Use of a polygonal file to assign colour values over a grid surface plus the surface when 
displayed in a 3D view

Replace

Replace all instances of a specified grid cell value with a new value. 

This operation is especially useful when manipulating null values within grids. The 
value of a Null may differ with different grid formats but the Grid Utility 
compensates for this.

Use Replace From...To...With to replace nulls or values, such as negative 
values.

Reproject

Most grids have a Projection and Spheroid/Datum specification either embedded 
in their format or in a separate header file (for example, .ERS in the case of ER 
Mapper files). This information can be re-specified by the Reproject option and 
used when a new output grid is written. Note that this operation relocates the 
various mesh points in the grid through an interpolation method to match the 
requested output Projection and Datum combination.
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The Reproject dialog and associated controls

The dialog as shown allows the following functions:

• Both X/Y (Easting/Northing) or Latitude/Longitude grids can be 
reprojected.

• A wide range of Projections, Spheroids and Datums are supported for 
import and export.

• False Easting and False Northings can be defined

• The data can be interpolated using either Bilinear, Bicubic and Nearest 
Neighbour (refer to details in Resample a Grid).

Resample

Resampling a grid allows a resizing of the cell size of the grid. Select the 
Resample option in the Function pull-down list. The control parameters appear 
as below. You can specify a new height or width of the interpolated cells. By 
default these are set to be the same, but if you want to create rectangular mesh 
sizes for the grid, deselect the Lock cell width to cell height checkbox.
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Resample control parameters in the Grid Utility dialog

The resampling is done by interpolation of the specified input grid data values. 
The methods available include Bilinear, Bicubic and Nearest Neighbour.

These interpolation methods use a transformation (for scaling), where the row/
column values [u,v] describe a transformed plane and [x,y] the original grid 
data plane. To determine the samples of the transformed grid g([m,n]) from the 
samples of original f([k,l]) the following steps are applied: 

• Calculate c([k,l]) from the grid values at each  f([k,l]) where c = 
cell reference

• For each [m,n] of the transformed grid find corresponding source 
location [x,y] in the input grid

• Compute f([x,y]) using the spline model, where 
g([m,n])=f([x,y]) 

For the resampling of a grid to new cell sizes and comparing the fits using 
φn([m,n]), the order on the nth term determines the method applied where n=0 
(nearest neighbour), n=1 (bilinear), n=3 (bicubic).  

Jagged or sharp edges using a nearest neighbour interpolation progressively 
smooth out in higher order spline-interpolation. Bicubic spline interpolation is 
popular as cubic splines appear smooth to the human eye.

After a cell size and method have been chosen, you can click the Update button 
to force the processing to proceed and review the result in the preview pane.
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Rotate

Similarly to the Resample operation (described above), the interpolation methods 
of Bilinear, Bicubic and Nearest Neighbour can be used to rotate a grid around 
a fixed point (by default, its centre or the bottom left corner). The control 
parameters for this function are shown below:

Rotation of a grid and the Before and After results shown in the Preview panes

An angle that is positive causes the rotation to be clockwise and vice versa. Refer 
to the Resample a Grid operation for a description of the Interpolation methods 
available.

Shift

The origin of a grid can be transformed horizontally and/or vertically using the 
Shift function of the Grid Utility. The control parameters appear as below. Entries 
of a New grid origin can be made or you can enter a specific Offset for either 
the east (X) or north (Y) directions. Once the shift parameters are entered, clicking 
the Update button causes the grid to redisplay with the adjustment in the After 
preview pane.
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Shifting a grid control parameters

Slope

The Slope utility analyses the eight cells surrounding each grid cell and 
determines the slope angle in degrees or the slope direction for each grid cell. The 
slope angle or direction is then stored as the cell value for the output grid.

The slope direction is measured in degrees clockwise from the grid Y (north) axis. 
The slope direction indicates the downwards direction of the maximum gradient 
(slope) of the cell.

The direction is calculated by 

(180/pi) x atan2(dz/dy,-dz/dx)

Where dz/dy is the rate of change from above to below the cell (vertically) and
dz/dx horizontally across the cell's left and right neighbours.

The rate of change in the x direction for cell 'e' is calculated with the following 
algorithm:

dz/dx = ((c + 2f + i) – (a + 2d + g)) / 8
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The rate of change in the y direction for cell 'e' is calculated with the following 
algorithm:

dz/dy = ((g + 2h + i) – (a + 2b + c))  / 8

The slope is the maximum value of slope across the cell, where a percentage 
value of 100% is equal to 45 degrees gradient. the algorithm calculates this by 
comparing each of the 8 neighbour cells, and then 

(180/pi) x atan(sqrt([dz/dx]^2 + [dz/dy]^2))

To convert the slope direction into a driectional aspect—e.g. N, NE, and so 
forth—use the Classify tool to classify each cell by its slope direction.

Split

The Split operation is the converse of the Combine function. The Split outputs the 
individual bands of a multi-banded grid (such as an RGB grid) and outputs 
individual, single band grids.

Statistics 

This tool calculates a range of standard Statistics for either:

• The entire grid.

• Grid cells enclosed or intersected by any objects in a vector file, either 
totally or partially overlying a grid.  The vector file can be composed of a 
mixture of object styles. 

• Grid cells within classified regions in another classified (i.e. integer) grid.

The grid statistics which are computed include:

• Number of cells

• Number of valid (non-null) cells

• Number of null cells

• Minimum cell value

• Maximum cell value

• Mean (average) cell value
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• Range (minimum to maximum cell value)

• Variance (average of the square of the difference between the cell value 
and the mean)

• Standard deviation (a measure of the “spread” of cell values equal to the 
square root of the variance)

• Sum of all grid cell values

• Percentage of null cells

For large grids, only the preview tile area statistics will be displayed until the Save 
As button is used to process the full grid and save the results.

Any statistical values which can be computed, for example due to no valid cells in 
the region or negative values, will be written as -9999.

Integer Grid

An "integer grid" is a grid which has been classified into a set of discrete values, 
i.e. by using the Classify tool. Typically these will be integers, but it may also be 
decimal numbers and can contain null areas.

The regions used for statistics will be area of the integer/classified grid which have 
the same value (including null value).

One selected output property (statistical value) can be created.

When Save As is clicked, or the batch process run, a grid will be created 
containing cells attributed by the select property.

Vector File

If a unique identifier field exists for each vector object (e.g. sample number, rock 
code, etc), this field can be set as the ID Field. The attributes in this field will be 
used as an identifier in the output file for each vector object., The Objects to 
process option allows the user to either create statistical output for all object types 
in the vector file, or one style in particular (points, lines or polygons).

Note Each input grid must have the same projection, cell size, and should overlap.

Note The input grid and vector file must have the same projection.
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If an object lies partially or entirely outside the grid file extents, this portion of the 
object will ignored for the statistics. For example, a polygon which is half area 
outside the grid, will still be 0 or 0% null cells, provided there are no null cells in 
the grid. Averages etc will be calculated based on the cell count, not the polygon 
area.

Clicking the Save As button will create a new MapInfo vector file named 
vectortablename_stats), with each input object attributed with its calculated 
statistics (as well as the ID Field if specified). These statistics can also be 
exported to either a Comma delimited (*.CSV) or Tab delimited (*.TXT) file using 
the Export Statistics button.

The method used to determine if a grid cell is located within a polygon, is whether 
the centre point of the cell is located within the polygon. Note that some partially 
covered cells may not be included due to this.  To increase the accuracy you can 
use the Resample tool to decrease the cell size.

Surface Area

The Surface Area utility calculates the total 3D surface area and 2D planar area 
for a grid. It also calculates the roughness of the surface, which is the surface area 
divide by the planar area. A perfectly flat grid (i.e. where every grid cell has the 
same value) will have a roughness of 1.

The values for the total grid are reported in the dialog in the same units the grid 
is defined in. Individual grid cell surface area or roughness values are saved to 
the output grid.

The algorithm calculates the 3D area by diving each cell into 8 triangles, and 
calculating the side length of the triangles by accounting for the slope of the cell 
edges. It then calculates the area for each triangle. This is similar to creating a 
vector TIN and calculating the surface area of this.

Usage examples of this tool include: 

• Comparing the relative roughness of different DEM/DTMs.

• Calculating the actual topographic surface area of a catchment/drainage 
basin, for 'run-off' studies.

• Analysing the effects of different filters or gridding techniques on the 
'topography' of the grids.
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Vectorise

The Vectorize utility converts a grid into a vector file. Each grid cell of the input 
grid is converted into a single region (or polygon) in the output MapInfo TAB or 
MID/MIF file. Each output region cell is assigned a grey-scale colour value based 
on the input cell value using a simple linear stretch on the data range.

It is recommended that large grids are re-sampled prior to using the vectorize 
utility to reduce the number of vector polygons.

The Vectorise utility for grid files.

Four options are supplied for vectorising grids in this utility:

• Generate one rectangular region for each grid cell – this produces a 
region for each grid cell. 

Each grid cell of the input grid is converted into a square polygon in the 
output MapInfo TAB or MID/MIF file, attributed with the grid cell value. 
Each output region cell is assigned a grey-scale colour value based on the 
input cell value using a simple linear stretch on the data range.

• Generate a region for each discrete grid value.

Note The preview for either the surface area or roughness will look almost identical 
with histogram equalization applied, but the value of the grid cells will be 
different. 
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Each unique value in the grid is analysed for contiguous areas and a  
polygon boundary drawn around these. This will produce a vector map 
with polygons bounding areas of homogenous grid values, each attributed 
with the unique region valuer. Each output region is assigned a grey-scale 
colour value based on the input cell value using a simple linear stretch on 
the data range.

• Generate a region for each group of non-null values.

This produces a separate polygon for each contiguous area of valid 
(nonnull) grid data. For instance, a series of polygons outlining coastlines 
could be generated from a DEM by first using the Classify Grid Utility to 
set all grid cells with sea level heights (and lower) as 'Nulls', then 
Vectorizing the resulting grid using this mode.

• Generate a region for the grid extents. 

Produces a polygon outlining the area covered by the grid cells.

 

Original grid before being vectorised.
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Examples of vectorised grids (clockwise from top left): One rectangular region for each grid 
cell; One region for each group of non-nulls; One region of the grid extents; One region for 
each discrete grid value.

The option Make generated regions hollow will produce ‘empty’ vector regions 
without any fill colour or pattern.

It is recommended that large grids are resampled to a larger cell size (see 
Resample) prior to using the Vectorize utility to reduce the number of vector 
polygons.

Viewshed

The Viewshed utility computes the view-shed from one or more locations of a 
specified height above the grid to an observer at a specified height (terrain offset) 
above the grid. The areas of the grid that lie within the line of sight are saved to a 
new grid. This is a useful tool when considering, for instance, the spatial coverage 
provided by a series of telecommunication or repeater towers, or the positioning 
of fire observation platforms.

Note The input grid and vector file must have the same projection.
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Grid Utility Dialog showing Viewshed options

The Height or z-value is the height of the view-point origin above the specified 
grid; this may represent a structure such as a transmission tower. 

The Maximum distance is the radial extent around the viewshed origin or tower. 
The line of sight is calculated for each grid cell within this radius. 

The Viewshed origin is the location from which the line of sight is to be 
calculated. The X and Y position of the Viewshed origin can be manually 
entered or selected by clicking the arrow tool and selecting a location in the 
“Before” or “After” preview windows. Alternatively, one or more viewshed origins 
or tower positions can be specified by using a MapInfo TAB or MIF file containing 
point locations. This TAB/MIF file may optionally include the following fields: 
sweep azimuth, sweep angle, height, maximum distance and ID field. These 
optional fields can be specified for the appropriate parameters (below) allowing 
each viewshed origin to have differing values (e.g. different tower heights and 
ID’s) instead of a single Constant value.
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Sweep Angle and Azimuth controls are available, limiting the view from a 
Viewshed Origin to the specified bearing range.

Setting a Terrain offset adds the specified value to each grid cell (e.g. the height 
of a receiver or person) and is incorporated into the line of sight calculation.

The curvature of the earth can also be taken into account when calculating the 
view-shed by specifying a Curvature Model. If this option is selected, the grid 
distance unit needs to be selected to allow the scaling of the earth’s radius to the 
correct units. 

A Gaussian smoothing filter can be applied to the line-of-sight grid to eliminate 
spurious lines caused by small irregularities in the input grid. The calculated line-
of-sight grid values may also be classified into one of two options:

• 2 (in/out)
Denotes whether a cell is visible or not from the viewshed origin.

• 3 (in/fringe/out)
Denotes whether a cell is visible, not visible or on the fringe when viewed 
from the viewshed origin.

Two Output types are available:

• Grid – if multiple viewshed origins are used (via a .TAB or .MIF file), the 
tool can Create a separate coverage grid for each viewshed origin. 
The output grids will be suffixed with the ID Field (if assigned), otherwise 
a 1, 2, 3, etc suffix will be used. 

• Polygons – can only be selected if the Perform Gaussian Smoothing 
option is enabled. This will produce a polygon outlining the extent of the 
viewshed (or combined viewsheds). The polygon table incorporates a 
Coverage field, indicating the percentage of the total input grid (null and 
non-null cells) covered by the polygon. If multiple viewshed origins are 
used (via a .TAB or .MIF file), the tool can Create a separate coverage 
polygon for each viewshed origin. The output table will incorporate an 
ID field, which will be populated with either the specified ID Field (if 
assigned), or an integer value (1, 2, 3).  The Compress polygons option 
reduces the number of nodes in the output polygons by applying Tomek 
compression (removing details which are smaller than the cell width). This 
option is only available for the 2 (In/out) Value Classification.

Note For best results with this tool, it is recommended to enable the Histogram 
Equalisation and Look-Up Table options.
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Volume 

The Volume utility computes and displays the volume between two grids, or 
between one grid and a constant Z value. Examples of use include calculating the 
volume between:

• The water table and a mining surface

• A DEM (top surface) and the same DEM after open-cut mining (modified 
by overlaying a series of attributed polygons representing mining benches 
(bottom surface).

• Upper and lower depth surfaces for a heavy mineral layer in mineral 
sands.

• A DEM and the DEM modified with a new airstrip.

This tool requires both grids to be in the same projection (use the Reproject utility 
to convert grid projections) and have the same cell size (use the Resample utility).

Volume calculation parameters for two loaded grids in the Grid Utility

The volume between two grids is calculated by subtracting each bottom grid cell 
Z value of one grid from the corresponding top grid cell Z value and then 
multiplying by the first grid cell width (X) and height (Y). Each individual grid cell 
volume is then added together to compute the final volume. 

The following volume calculation options are available:

• Compute volume of main grid above secondary grid: only those cells 
where the main grid lies above the secondary grid are used to calculate 
the volume 

• Compute volume of secondary grid above main grid: only those cells 
where the secondary grid lies above the main grid are used to calculate 
the volume 
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• Compute total volume between the two grids: all overlapping cells are 
utilized to calculate the volume, regardless of which grid in is top. The 
difference between cell values is treated as absolute i.e. all values are 
positive. 

• Compute volume of main grid above constant Z value 

• Compute volume of main grid below constant Z value

Where the grid cell sizes between the two grids are different, a Nearest 
Neighbour interpolation is used on each grid cell in the top grid to determine a 
value for the bottom grid at that location. This will result in the closest bottom cell 
grid value to the top grid location being used in the volume calculation for that grid 
cell.

If the two grids overlap vertically (i.e. portions of the lower grid extend above the 
upper grid), the calculation will treat the overlap volumes as negative volumes. 
These will therefore be subtracted from the positive volumes (below the upper 
grid), resulting in a reduced volume calculation. To treat these overlap volumes 
as positive volumes, use the Grid>Grid Calculator.

Assign Grid Value to Dataset

Grid > Assign grid values to dataset

The Assign grid values to dataset tool will assign values from select grid(s) to a 
survey Database or Feature database file. It does this by taking the input grids as 
point datasets, with each points at the centre of a cell. At each of the dataset's XY 
point, it then interpolates the surrounding grid cell centre points using the select 
interpolation method, to calculate a value to assign. This can be assigned to a 
numerical field or to each node's/station's Z value. 

For Feature baseases, as these contain polygons, polylines, and surface TINs; 
there are extra options to Inteprolate the Z value.

By default, the Z value of each node will be overwritten and replaced with the 
value of the grid (Interpolate to Z - replace). You may also choose to  offset the 
original features by the grid values with the options -

• Interpolate to Z - sit Z = GridZ + (FeatureZ - ObjectsMinimumZvalue)

Note This interpolation steps (Bicubic, Bilinear or Nearest Neighbour) has the effect of 
smoothing or blurring the input grid cells resolution and the value assigned will 
not exactly match the overlying grid cell values. 
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• Interpolate to Z - straddle Z = GridZ + (FeatureZ - ObjectsMidZvalue)

• Interpolate to Z - hang Z = GridZ + (FeatureZ - ObjectsMaximumZvalue)

Where FeatureZ is the original Z value of the node, and Z the new node value.

The object’s minimum/maximum Z value, is the highest of lowest value of original 
values in the entire Feature database.

The object’s Mid Z value, is the (Minimum Z + Maximum Z )/2.

To assign grid values to a dataset:

1. Ensure the Feature Database or Geosoft Database and grid files are open 
in PA.

2. Select Grid>Assign values to Dataset.

3. Select the Dataset to assign to.

4. Check the Interpolate setting, to Interpolate to Field or Interpolate to Z (if 
using a Feature Database)

5. In the Grids list, tick or deselect the Use field to indicate which grid will be 
assign to the dataset.
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Grid Tiler

Grid Tiler dialog for large grids

The Grid Tiler allows large grids to be sub-divided or tiled into a number of equally 
sized smaller grids. This is useful when a grid file is either too large to open or 
import into Encom Discover PA, or too large to modify or interrogate with the Grid 
Utility or Grid Filter tools.

1. To subdivide a large grid: Open the Grid Tiler (the source grid does not 
have to be open within Encom Discover PA). 

2. Using the File Open button at the top right of the dialog, select the source 
grid file (if the grid is already open within Encom Discover PA, select it 
from the top pull-down list). A preview of this grid will be shown along with 
the grid size information. 

3. In the Tile Layout section, set the number of tiles to divide the source grid 
into in both the East-West and North-South orientations. See Tile Layout 
below for further information. 
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4. Ensure that the Create .GHX option is enabled to allow the pre-calculation 
of grid statistics for more efficient grid handling. Enable the Create .TAB 
option if you want to automatically create a .TAB file for output tiled grid to 
Encom Discover PA. 

5. By default the output grid tiles will be created in the same directory as the 
source grid: this can be modified in the Tile Naming section. 

6. The output tiles will be named by adding a suffix to the input file name. A 
number of suffix options exist – see Tile Naming below for more 
information. 

7. Select the output Tile Format (formats available are ERMapper, BIL, 
Encom or Surfer grid formats and press Create Tiles. The grid tiles will be 
automatically registered in the same projection system as the input grid 
file.

Tile Layout

In addition to setting the number of tiles to create along the X and Y axes, you can 
instead define the size of the tiles by the distance (width or height) or the number 
of cells (rows or columns). An Overlap can also be defined between adjacent tiles 
as a percentage of the distance (width or height), or by a number of cells (rows or 
columns). The overlap interval is applied to both sides of each tile (east and west 
or north and south).

If the size of tiles does not divide evenly into the input grid dimensions, the edge 
tiles will extend slightly past the source grid bounds. The Crop to grid option will 
crop these tiles to the extents of the input grid. The Origin can be set to the Top 
left or Bottom left so that these edge tiles will be located at the Bottom or Top row 
of the grid. Cropped are always located at the right side of the grid. 

Tile Naming

The suffix applied to the output tiles can either be a Name-Column-Row or Name-
Row-Column format. For either format, the initial tile Origin (i.e. 01x_01y) must 
be specified as either the bottom left or the top left corner tile. 

The E-W or N-S components (i.e. Column and Row suffixes) of the output tile 
suffix can each independently have either a numeric or character format. 
Additionally each component can have individual prefixes and/or suffixes. The 
preview of the entire Tile name suffix is shown in the example box.
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Vector File to Grid Utility

The Vector File to Grid plugin utility is a very powerful tool for converting a vector 
file to a grid file. The utility supports the import of a large range of industry 
standard vector file formats as well as most industry standard grid file formats for 
converting the vector file to.

The following input vector and output grid file formats are supported by this utility:

Vector Files:

• 3D Studio files (.3DS)

• AutoCAD DXF files (.DXF)

• Datamine wireframe files (.DM)

• ERMapper Vector files (.ERV)

• ESRI TIN files (.ADF)

• ESRI Shape files (.SHP)

• Gemcom BT2 files (.BT2)

• Google KML files (.KML)

• GOCAD vector files (.TS, .PL and .VS)

• GPS eXchange files (.GPX)

• LizardTech MrSID files (.SID)

• MapInfo TAB files (.TAB)

• MapInfo MIF files (.MIF)

• Surpac DTM files (.DTM .STR)

• Vulcan triangulation files (.00T)

Grid Files:

• Arc Ascii grid files (.ASC)

• Arc Gridfloat grid files (.FLT)
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• BIL grid files (.BIL)

• Encom grid files (.GRD)

• ERMapper grid files (.ERS)

• Geosoft grid files (.GRD)

• GeoTIFF files (.TIF)

• MapInfo grid files (.MIG)

• Minex grid files (.XYZ)

• Surfer Binary grid files (.GRD)

• Vertical Mapper grid files (.GRD)

Access this utility from the Grid>Vector File to Grid menu option and the below 
dialog will appear.

The Vector File to Grid dialog
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Files

Click on the Browse button for the Input vector file option to load a vector file from 
its known file location. Then click on the Save As button to specify the intended 
location of the output file. Once these are specified, the Data range section of the 
dialog will be populated with the minimum and maximum Easting (X), Northing (Y) 
and Elevation of other property (Z) values. The Output Grid Properties and some 
of the Processing options will be automatically populated based upon the input 
vector file data.

Output Grid Properties

Under the Output grid properties section the Cell size and Extension width will 
be filled with a default (safe) value based on the vector file dimensions. Edit this 
value to the desired cell size and extension width. The Rows and Columns boxes 
will be updated to compute the edited cell size. The Projection information will 
also be automatically populated. Press the Choose button to change the 
coordinate projection of the output grid file.

Processing Options

When satisfied with the output grid paramters specified, select the Create grid 
button. The following processing options will become available depending upon 
whether the input vector file is a 2D vector file or a 3D vector file.

When a 3D vector file is loaded in the utility:

• The Vector objects to process option automatically displays as 3D 
faces

• The For cells in the grid where there is no data option allows the choice 
between:

• Use null values - populates any cell that doesn't have a Z value 
with the null value

• Use minimum Z value - populates any cell that doesn't have a Z 
value with the minimum value

• Use maximum Z value - populates any cell that doesn't have a Z 
value with the maximum value

When a 2D vector file is loaded in the utility:

• The vector file to grid conversion utility will not automatically open the 
generated grid into a window display in Encom Discover PA. To view the 
grid file open a 2D grid map or 3D display window.
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An example of a 3D DXF file representing a topographic surface

An example of a grid (overlain by the input vector file) created by the Vector File to Grid 
plugin utility.

SRTM HGT to ERMapper ERS

The SRTM HGT to ERMapper ERS utility is accessed from the Grid menu and is 
a simple tool for converting a SRTM HGT elevation (height) file to a ER Mapper 
.ERS file.
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Each data file covers a one-degree-of-latitude by one-degree-of-longitude block 
of the earth's surface. The first seven characters indicate the southwest corner of 
the block, with N, S, E, and W referring to north, south, east, and west. Thus, the 
"N34W119.hgt" file covers latitudes 34 to 35 north and longitudes 118-119 west 
(this file includes downtown Los Angeles, California). The filename extension 
".HGT" simply stands for the word "height", meaning elevation. It is NOT a format 
type. These files are in "raw" format (no headers and not compressed), 16-bit 
signed integers, elevation measured in meters above sea level, in a geographic 
(latitude and longitude array) projection, with data voids indicated by -32768.

International 3-arc-second files have 1201 columns and 1201 rows of data, with 
a total file size of 2,884,802 bytes ( = 1201 x 1201 x 2).

United States 1-arc-second files have 3601 columns and 3601 rows of data, with 
a total filesize of 25,934,402 bytes ( = 3601 x 3601 x 2).
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27 Voxel Utilities

The Voxels menu provides access to the following functionality:

• Array Data 3D Gridding – Create a 3D grid (voxel model) of  layered data 
from a selected database containing multi-channel fields, e.g. 
conductivity-depth fields using minimum curvature.

• Voxel Toolkit – Create a voxel model from a loaded dataset or further 
enhance a voxel model.

Array Data 3D Gridding

The Array Data 3D Gridding tool is an external utility that creates a 3D voxel 
model from a database accessed by Encom Discover PA. The database must 
have two multi-arrayed data fields corresponding to depth and a property (such 
as magnetic susceptibility or conductivity). Such a database is derived from 
interpretation software like EM Flow.

The gridding process used by this utility (EM Voxel), creates a 3D voxel model 
output, but its internal operation is in reality only a 2.5 dimensional gridding 
process. Each layer of data for the input multi-banded data fields are horizontally 
gridded using either a spline or a minimum curvature method. Once the grids for 
each available depth are gridded, they are then combined and output to form the 
voxel model. 

Note All tools in this menu require an Encom Discover PA Professional licence. If you 
wish to purchase or evaluate this module, please contact Pitney Bowes 
Software.

Note This tool requires an Encom Discover PA Professional licence. If you wish to 
purchase or evaluate this module, please contact Pitney Bowes Software.
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Array Data 3D Gridding (EMVoxel) dialog and control of voxel model creation.

The parameters specified in the EM Voxel gridding tool dialog are:

• Dataset – The name of a database accessed by Encom Discover PA. The 
pull-down list provides the available datasets. Note that the database must 
contain at least two data channels that contain a multi-arrayed data 
channel corresponding to depth and a second multi-arrayed data channel 
corresponding to a property. A property may be magnetic susceptibility, 
conductivity etc.

• Depth Field – The Depth Field specifies the multi-arrayed data channel of 
the selected database to use for the vertical axis of the gridding. By 
default the program uses all available array bands, but this can be 
overridden by turning off the All Bands option. With this option turned of, 
you can select the bands required.

• Data Field – This data channel specifies the required property channel. 
Note that you must have the same number of bands as are defined for 
depth and the corresponding bands must be selected. For example, you 
cannot have Bands 1,3,5,7… selected for Depth and Bands 2,4,6,8… 
selected for Data.

• Cell Size – The size (in metres) of voxels horizontally can be specified. 
The vertical voxel size is determined by the Depth data channel, unless 
the Square Cells option is enabled. In this case, each voxel block is 
cubic.
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• Min/Max Coverage – The voxel model created uses the extents of the 
dataset by default. If these extents are to be altered, you can modify the 
entry fields. The created number of Columns, Rows and Slices is 
reported. If a change to the extents is made, the entries can be reverted 
back to the original data extents by clicking the Reset to Input Extents 
button.

• Smoothing – Frequently the data derived from inversion section 
processing (such as EM Flow) can have noise and processing effects that 
occur on one data section but not adjacent. Smoothing helps to remove 
these artifacts. The larger the Smoothing Factor used, the greater the 
distance in 3 dimensions of smoothing is applied.

• Gridding Method – Two methods are provided – Spline or minimum 
curvature. For most geophysical data, it is recommended that the 
minimum curvature approach be adopted.

• Output Dataset – Specify a path and filename to contain the output voxel 
model. The Voxel Gridding program creates voxel models using the UBC 
model format and therefore two files (a header and data file) are created. 
The data file uses the filename as specified and adds the file extension 
.DAT.

• Open in Encom Discover PA – This option allows a 3D map to 
automatically display at the end of a 3D Gridding processing and present 
the created voxel model. The display uses a standard Encom Discover PA 
template that can be modified if required.
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Gridding Operation

The Array Data 3D Gridding utility (called EMVoxel) uses a minimum curvature or 
spline gridding method and applies it to each depth layer horizontally. Allowance 
is made for the high difference in data resolution typically seen along data lines 
(sample intervals), vertically (depth resolution) and widely spaced line separation 
distances.

Artifacts observed on some data lines are not present on adjacent lines and are 
therefore filtered out by the gridding process.

Gridding in each direction horizontally and vertically from properties of each line

Once you have specified the dataset, data channels and any other required 
parameters, click the OK button. After process (with the Show in Encom 
Discover PA option enabled), a display window with the created voxel model is 
displayed. Once displayed, you can use the various Voxel Model settings and 
controls to clip, threshold and create isosurfaces of the model.

Note You may need to correct the depth data for effects such as topography and 
elevation. If this is required, the appropriate depth and property data channels 
may require pre-processing using the Depth Interpolation option.
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Example voxel model derived from Swamp example dataset

Voxel Toolkit

Note This tool requires an Encom Discover PA Professional licence. If you wish to 
purchase or evaluate this module, please contact Pitney Bowes Software.
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The Voxel Toolkit is a stand-alone plug-in tool that provides the ability to create, 
process and export voxel models (often referred to as 3D meshes, block models 
or 3D grids). 3D Gridding interpolates between the existing data points/intervals, 
creating a continuous 3D mesh of cells, each of which is assigned a value (either 
numeric e.g. geochemical assay or character e.g. lithology). The 3D interpolation 
process allows dispersed source data to be visualised as a continuous dataset 
(e.g. a voxel model isosurface), providing the geoscientist with The Voxel Toolkit 
is accessed via the Gridding or Voxels menu of Encom Discover PA.

Voxel Toolkit dialog with numerous operations available

The main menu page provides the following functionality:

• Voxel Toolkit Settings – Click the Properties button to access advanced 
settings for 3D gridding and 3D calulator.

• Gridding – Create 2D grids (surfaces) or 3D grids (voxel models) from 3D 
point or segment data, such as a drillhole database.

• Apply 3D Grid Convolution Filtering to Voxel Models.

• Voxel Utilities – Merge and Resample Voxel Models, Convert Null’s and 
Clip DEM grids.

• 3D Grid Calculator – conduct mathematical operations on Voxel Models.

• 3D Display Assistant – load and display Voxel Models in Encom Discover 
PA.
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• Grid Management – import and export Voxel Models in a variety of 
formats.

Using the Voxel Toolkit

The Voxel Toolkit automatically loads voxel models which are open in Encom 
Discover PA. The list of grids presented in the various function dialogs will display 
an icon indicating whether a grid is on-disk, in memory or in memory and 
unsaved. Grid information can be viewed for any file by selecting the information 
icon in the list. Grids listed in the Voxel Toolkit are available to all the functions.

Voxel Toolkit Settings

The Properties button in the Voxel Toolkit dialog provides advanced settings for 
the 3D Gridding and 3D Calculator utilities.

• Gridding Settings

• Calculator Settings

Gridding Settings

Gridding tab options for the Voxel Toolkit Settings dialog.
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Load entire hole length

This option modifies the behaviour when drillholes are loaded via Encom 
Discover PA. If it is turned off, then Encom Discover PA may only supply a part of 
the hole – namely that part which has some data in it. For example, there may be 
a 400m long drillhole where the top 200m has no assay information, then there 
may be some logged assay information for 50m and then for the remaining 150m 
the drilling should have ceased but didn't, providing no further logged information. 
So there may only be a portion of data in the hole. If this option is turned off the 
Encom Discover PA may only supply these stations where assay information was 
logged.

If the option is enabled then Encom Discover PA will supply the entire hole from 
top to bottom. This will provide an entire series of nulls. However, if the data 
conditioning tool (see Conditioning Data Prior to Gridding) is used then the nulls 
can be converted to a background value (eg zero). Therefore, by loading all 
stations in the drillhole and converting null values to background some constraints 
on your gridding procedure can be applied. This prevents assay envelopes, from 
ballooning out into wasted rock.

Segment break length

When you import drillhole data each data segment can be broken up into multiple 
shorter segments of the length entered. This means that data is spread along the 
hole rather than concentrated at the top of the segment.

Default numeric null

The value entered can be set as the default null value for data conditioning. i.e. it 
is the value that invalid data is converted to by the data conditioning tool. There 
is little requirement for this value to be modified.

Default text null

The value entered can be set as the default null value for data conditioning. i.e. it 
is the value that invalid data is converted to by the data conditioning tool. There 
is little requirement for this value to be modified.

Note It is advisable that if you are gridding assay data to enable this option (and to 
convert NULL to background).
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Generate compressed storage

When enabled this option allows the grid to remain compressed in memory and 
when exported to an Encom model (.e3d) file. If you export to UBC model format 
however it will be decompressed as it is exported.

This option is useful if you intend to create a very large grid that is very sparsely 
populated. If the grid is densely populated, then there is no advantage to having 
it compressed in memory and may actually use more memory. Also, gridding 
performance is reduced when the model is compressed. 

By default this ought to be OFF and only activated by advanced users.

Calculator Settings

Calculator tab options for the Voxel Toolkit Settings dialog.

Output the superset of all input meshes

If the 3D grids (voxel models) loaded into the calculator don’t perfectly overlap, 
this option allows the output of a grid (voxel model) that encompasses all input 
grids. 

Output the intersection of all input meshes

The alternative option for output is to output a 3D grid (voxel model) that only 
covers the intersection area.



968 Encom Discover PA User Guide

For example, if you add Grid A and Grid B together and they do not overlap, then 
using the superset method will achieve a result of both grids being merged into a 
new grid. If the intersection option is used then no result will be achieved.

Enable strict null handling

When strict null handling is enabled and if any parameter of the equation is NULL, 
then the result will be NULL.

When this option is disabled, in some equations you can have a null value as a 
parameter and the result may be non-null.

For example C = A+B. If A is null, it will return B. This is useful when merging grids 
etc.

Gridding

The input data may be either a collection of three dimensional points or drillhole 
intervals. An interval must be defined by two 3D points – the beginning and end 
of the sample. The value of the sampled data is assumed to be constant between 
the it’s end points.

To simplify the process of creating 2D or 3D grids the gridding operations are 
presented with a wizard interface. The gridding methods available with this tool 
are discussed under 3D Gridding Methods.

Note The 3D Grid Calculator uses the intersection method, but 3D Gridding uses the 
super-set method by default.

Note The Grid Calculator utility does not have this flexibility – it uses strict null 
handling always.

The gridding operations in the Voxel Toolkit can generate either 2D or 3D grids. 
3D gridding interpolates spatial data into a regular 3D grid (voxel model or block 
model – terms commonly used in the mining industry). The 2D gridding 
operations generate horizontal surfaces (in the X, Y plane) at a user-specified 
RL level. These grids can then be exported as ER Mapper format files.
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Creating a voxel model

The following steps guides the user through process required to apply 3D gridding 
to a drillhole dataset. This will apply an interpolation (in this case Inverse Distance 
Weighting) to a downhole data field (e.g. an assay field), the creating a voxel 
model. This can then be used to visualise high assay value correlation between 
holes, using the Voxel Model Properties.

1. Ensure that the drillhole dataset is open in Encom Discover PA (use one 
of the File>Open>Downhole menu options). 

2. Open the Voxel Toolkit from the Grid or Voxel menu. 

3. Press the Gridding button, and in the following dialog, select the 
Continuously Variable technique. Set this to Inverse distance 
weighting. Press OK.  

4. In the Input Data tab, select the Dataset to grid, and check that the XYZ 
field assignments are correct. Select the Data Field to grid, such as an 
assay or geophysical field. Enable the From-To segments option (will 
handle drillhole intervals as segments rather than as points).

6. In the Size tab, use the Auto button to set the cell sizes to Low 
resolution (i.e. larger grid cell sizes). Higher resolutions (smaller grid cell 
sizes) should only be set after the gridding parameters have been 
extensively refined- they will create a much larger block model (memory 
consumption) as well as significantly increase the processing time.

7. In the Search tab, select Elliptical Search.

5. On the Conditioning tab use the Data Conditioning button (see 
Appendix G: Field Data Conditioning) to remove abnormal or invalid data, 
such as negative values representing missing samples and spurious 
outliers, as well as providing Null value assignment and handling. It can 
also be utilised to query out and display specific portions of a dataset, for 
example all downhole gold assays between 2g/t and 5g/t, or only intervals 
with a QBX or QV lithological code. 

Optionally, prior to gridding, you can reduce the input drillholes to just those 
with good assay sampling and are closely spaced. Selecting a subset of 
drillholes will improve the speed of the gridding process. 

Note If custom cell sizes are entered, ensure that the Auto>Fit to extents option is 
then applied to recalculate the number of cells to cover the input dataset.
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• Leave the default Strike, Plunge and Dip orientations of 0.

• Set the Major and Minor axis search values at approximately a 
third to half the average spacing between the holes.

• Set a Depth axis value of approximately half of the XY axes, which 
corresponds to the much higher sampling downhole.

• Set a Search Expansion of 3. This will result in the gridding 
algorithm using the initial search radius defined; if it cannot find any 
data points or meet the sample selection criteria within this radius, it 
will then try a double size radius and finally a triple sized radius. If it 
still cannot calculate a cell value with data points within this volume, 
the cell value will be set to Null. 

• Also set Grid passes to 3. This is useful for uneven data as initial 
‘rough’ pass is performed at one-third the resolution to determine 
areas where to perform subsequent half and full resolution passes 
will be calculated.

8. Still in the Search tab, set the Sample Selection parameters to 2 Z 
sectors, and 2 points for both minimum and maximum. These set the 
required number and distribution of data points in the search area before a 
cell will be calculated. The more stringent these rules, the more likely the 
output model will reflect the input data. 

9. The Sample Selection criteria can be relaxed by enabling the Gridding 
Rule option.

10. The Preview button at the top of the Search tab allows the user to 
visualise the resulting search volume with an overlay of the input data 
points in a rotatable 3D view. The search distance and number of search 
expansions can be dynamically altered from within this view. Press Next 
to advance to the final dialog.

11. The Method tab provides a number of Weight Models; leave the default 
Power model selected. These control how the data points within the 
search volume are weighted in the final cell value calculation, based on 
their distance from the cell centre. Press Finish to start the gridding 
process.

12. Upon gridding completion, a Save grid dialog will appear, prompting for a 
file name and location. The output grid is saved as an Encom 3D format 
(.E3D). Upon closing this dialog, the new grid will be displayed in the 3D 
window and also the 3D Display Assistant dialog.
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3D Gridding Methods

 
Grid Toolkit selection of two or three dimensional operation.

The Voxel Toolkit can generate either two or three dimensional grids. Regardless 
of the dimensionality of the grid, the gridding methodology is identical and three 
dimensional. 2D grids are generated as horizontal planes at a specified RL level 
and are exported as ERMapper compatible raster grid files. You can create four 
different kinds of grids.

• Continuously Variable. This method is useful for gridding data like drillhole 
geochemical assay values. It smoothly interpolates values at the grid 
nodes based on the surrounding data.

• Discretised Gridding. This method allows you to grid discrete or classified 
data. An example is the geological rock codes recorded for samples down 
a drillhole. These strings are classified into a legend. The legend can 
either be automatically generated or the user can specify a legend file 
used to classify the data. Both string and numeric data can be classified. 
Once the data is classified it is gridded using similar techniques except 
that the value at each grid node is assigned to a particular classification. 

The method produces a legend file as one of the products of the gridding 
process. This legend file can define surface and line colour, style and 
pattern for each classification. It can be used as a rendering guide when 
the grid is displayed.
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• Distance Gridding. This produces a grid that records the distance from the 
centre of each grid cell to the nearest valid data point. It is useful for 
identifying gaps in data coverage. It is also used as an input to some 
filtering processes because it can be used to define nodes in the output 
grid that are near to input data points.

• Density Gridding. This method produces an estimation of the 3D point 
density at the centre of each grid cell.

Continuously Variable

This technique is used to grid variably spaced numeric data such as drillhole 
assay values. It smoothly interpolates values at each grid node based on a 
weighted function of the surrounding data. Two weighting methods are available:

• Inverse Distance Weighting

• Kriging

Inverse Distance Weighting

Inverse Distance Weighting (IDW) is a universal technique that can be applied to 
a wide range of spatial data. IDW uses weighted averages to estimate new grid 
cell values and can be used as either an exact or a smoothing interpolator. The 
value assigned to each grid cell in an output grid is calculated using a distance 
weighted average of all data point values that fall within a specified search radius 
if the grid cell.

The IDW method is optimal when the input data is uniformly distributed 
throughout the volume to be gridded, and some degree of smoothing is required 
in the output grid. 

IDW gridding provides the following wizard dialogs:

1. Input Data Selection 

2. Data Conditioning 

3. Grid size specification 

4. Search parameters  

5. Method
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Kriging

Kriging is a geostatistical gridding method which has proven popular across a 
variety of industries due to its flexibility and data driven approach to surface 
interpolation. Kriging is an advanced technique which is based on the assumption 
that the spatial variability in a measured property is neither due to totally random 
or deterministic constraints. The main advantage of Kriging over simpler 
interpolation techniques such as IDW is that it is data driven and uses a weighting 
model which is adaptive to the inherent trends in a data set rather than imposing 
a set of fixed conditions upon them.  Using Kriging in interpolation can be a 
complex process as it requires an intimate knowledge of the structure and 
variability in the data set in order to choose an appropriate sample model and set 
of gridding properties.

Over the past several decades kriging has become a fundamental tool in the field 
of geostatistics. The method of interpolating a surface using kriging is generally 
performed as a two-stage process: 

Stage 1

• The input data is analysed to establish the spatial predictability of the 
measured values in the study area. This analysis generally focuses on the 
spatially correlated component of the data by means of determining the 
degree of spatial dependence among the sample points. The average 
degree of spatial dependence among variables is summarised in a plot 
known as the semi-variogram. The semi-variogram is a concise means of 
representing the average intersample variation according to sample 
separation distance and direction. In order to use the sample variance as 
part of the interpolator in the Kriging process it is necessary to model the 
semi-variogram in order to define a mathematical function which optimally 
describes the underlying structure in the data. This process is known as 
variogram modelling which in itself and can be a very involved and 
complex task. Once an appropriate model has been chosen it can then be 
used to estimate the semivariance or weighting at any given sample 
distance.

Stage 2

• New values are interpolated or estimated at locations which have not 
been adequately sampled. This process is known as interpolation kriging. 
The simplest technique, known as “ordinary kriging” uses a weighted 
average of the neighbouring samples to estimate the unknown value at a 
given grid node. The weights are optimised for each node using the 
variogram model, the distance to the surrounding samples and the inter-
sample variance.
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The first step in kriging is to construct a variogram (or semivariogram) from the 
input data which describes the spatial correlation between the sample points. A 
variogram generally consists of two parts: 

• The experimental (or sample) variogram 

• The model variogram (a descriptive function which mathematically models 
the experimental variogram). 

The degree of spatial dependence among sample points is measured by the 
average semivariance:

Where h is the distance or lag between sample points, n is the number of samples 
separated by h and z is the attribute value of interest. The computation of γ(h) is 
performed in two steps. First pairs of sample points are grouped together by 
distance. For example, if the distance interval (or lag) is 1000m then pairs of 
points separated by less than 1000m are grouped together into a 0-1000m lag, 
samples separated by a distance of between 1000 and 2000m would be grouped 
into a lag of 1000-2000m and so on.  Next the average distance h and the average 
semivariance γ(h) is calculated for each group. If spatial dependence exists 
among the samples, then pairs of points closer together will have more similar 
values than pairs that are further apart. The semivariogram is a plot which has the 
average semivariance γ(h) along the y-axis and the separation distance h along 
the x-axis. 

Experimental and Model Variogram used in kriging

The semivariogram can be broken down into thee main components; the Nugget, 
Sill and Range.
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• Nugget - is the semivariance at a distance of zero and represents the 
degree of sample repeatability or spatially uncorrelated noise.

• Range – is the spatially correlated portion of the semivariogram that 
exhibits an increase in the semivariance with distance. Towards the limit of 
the range the semivariance levels off such that with additional increases in 
distance it is indistinguishable from one point to the next. This point of 
flattening is called the sill.

• Sill – is the point at which the semivariance (range) levels off to a 
relatively constant value.

Once an experimental variogram has been computed, the next step is to define a 
model variogram. A model variogram  is a mathematical function that models the 
trend in the experimental variogram. Once the model variogram is constructed, it 
is used to compute the weights which are used in the kriging interpolator. The 
basic equation used in ordinary kriging can be described as follows:

Where n is the number of points in the data set, fi are the attribute values of these 
points, and wi are weights assigned to each point. This equation is essentially the 
same as the equation used for inverse distance weighted interpolation except that 
rather than using weights based on an arbitrary function of distance, the weights 
used in kriging are based on the model variogram. The creation and analysis of 
the sample and model variogram is done using the Statistics Explorer Variogram 
dialog, which is accessed from the Kriging Method dialog.

The gridding wizard dialogs utilised by Kriging are virtually identical to IDW:

1. Input Data Selection

2. Data Conditioning 

3. Grid size specification 

4. Search parameters 

5. Method

The main difference is the final Method tab, which provides Kriging-specific 
options.

Two types of kriging estimation are provided; Point and Block.
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• Point kriging estimates a point value at each grid node.

• Block kriging on the other hand estimates the average value from all 
points which fall within a rectangular block centred on each of the grid 
node.

Because Block kriging estimates the average point value for each block it tends 
to generate smoother grids. Because block kriging uses an average of the input 
sample points in a given region it is considered to be an imperfect interpolator 
even when an input sample falls exactly on a grid node. The Block Kriging method 
provides controls to decimate (or break up) the blocks into a smaller mesh of sub 
cells, defined by the X, Y and Z increment values. When a decimation factor is 
applied in Block Kriging the value assigned to each block is determined as the 
average of the sub cells inside the block rather than the average of the entire 
block.

In addition to the point and block estimation types the 3D gridding tool supports 
two Kriging methods; Ordinary and Simple.

• Ordinary Kriging focuses on the spatial correlation component between 
the measured values but ignores drift (drift is a regional trend in the data 
which exists is addition to spatial correlation between samples).

• Simple Kriging is similar to Ordinary Kriging with the exception that the 
weights used do not sum to unity and the average of the entire data set is 
used in the interpolation of each grid node rather than the local average of 
points that fall within the Search Distance of the node. Consequently 
Simple Kriging  can be less precise than Ordinary Kriging and generally 
produces smoother grids.

Variogram Creation

Selecting the Variogram button from the Kriging method tab opens the Statistics 
Explorer Variogram dialog. This utilises the assigned data field in tandem with the 
spatial coordinates to compute a Sample variogram. A variogram shows the 
degree of correlation between data in a spatial dataset in different directions and 
at different distances.

Sample Variogram

Computing a sample variogram is a laborious task and can take a very long time 
as the number of samples increases. In order to construct a variogram it is first 
necessary to compute the distances between every possible pair of points in the 
dataset. In most cases it will be impractical to do this unless the dataset is 
relatively small (< 30,000 samples).  In order to speed up sample Variogram 
calculations several restrictions are imposed. These are:
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• Capping the maximum range (distance between points) that will be 
considered

• Capping the number of input samples that will be considered.

A default variogram is computed using parameters that should ensure that the 
computation time is of the order of a few seconds. Thereafter the range and 
maximum number of samples being considered can be modified and the 
variogram recomputed by clicking the Recompute Variogram button. Note that 
if the maximum number of samples is set to negative one (-1), then all samples in 
the dataset will be used to compute the sample variogram. It is not advisable to 
include all samples in the data set if it exceeds 30,000 samples as the 
computation time required to build the variogram could be extremely long. If the 
number of samples is restricted the algorithm will look at a sub-set of samples that 
are evenly distributed spatially within the dataset. In some cases it may be 
desirable to increase the range and increase the maximum number of samples to 
improve the statistical reliability of the variogram.

Display of the calculated variogram
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Once computed, the sample variogram is plotted in the left lower corner of the 
Statistics Explorers Sample dialog as a radial grid. The default display is the 
Moment of Inertia (or semivariance). The moment of inertia is defined as half the 
average squared difference between the x and y coordinates of each pair of 
points. This is equivalent to the spread (separation distance) of the lagged points 
from the 45 degree line (1 to 1) on a h-scatter plot. A directional variogram is 
extracted from this grid and is plotted in graphical format on the right of the dialog. 
The source data is shown in a spreadsheet at the top of the dialog. The red 
wedges represent the area of the grid that is used to extract the directional 
variogram. This volume is controlled via Direction (0 to 360 degree clockwise 
from North), Plunge (-90 to 90 degrees via the control adjacent to the Direction 
control) and Width (degrees of arc) controls. If the width is set to 180 degrees 
then direction is ignored and an omni-directional variogram is extracted. 
Otherwise a direction-dependent variogram is extracted. The variogram records 
several parameters including the moment of inertia (semi-variogram), covariance 
and pair count.

Model Variogram

Once the Sample variogram has been computed a Model Variogram can be 
constructed or edited using the Model Tab on the Statistics Explorers Variogram 
dialog. The model variogram will be automatically initialised to a default linear 
model with nugget to fit the data. You can press the Initialise Model button at any 
time to reset the model to this default.

The model is plotted to a range controlled via the Range edit parameter. By 
default this is equal to the sample variogram range.

The model variogram is displayed as a grid and also as a directional extraction – 
just like the sample variogram. The sample variogram curve can be plotted for 
comparison. In the upper right corner of the Model dialog the model variogram 
nests are displayed. Each nest corresponds to an individual component of the 
model. Individual nest can be edited, added, cloned and deleted via the buttons 
on the right or by double clicking on a nest in the list. The final variogram model 
is generated from the accumulated nests.

The basic parameters of each nest can be altered directly from the model graph. 
To do so select the appropriate nest from the list of model at the top of the dialog 
and then adjust the parameters by moving the blue edit (triangle) tags on the 
variogram graph.
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The Model dialog of the Statistics Explorer showing three individual nests of a model 
variogram. The top portion of the dialog lists the type and parameters of each nest and the 
corresponding plot at the bottom shows the selected nest graphically.

Editing a nest in the model presents the following Edit Variogram Nest dialog. If a 
new nest is added the dialog is presented in a wizard mode rather than a tabbed 
mode.

Edit Variogram Nest dialog showing the various Model Types that are available
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• The Model Type page allows you to select an appropriate theoretical 
model to use as the basis of the nest. A graph is displayed on the Model 
Type page to show the selected function. The coordinates used in the 
example graph are theoretical and are not representative of the actual 
model coordinates.

Controlling the parameters of the variogram

• The Parameters page provides controls for editing the model parameters. 
At the top right of the dialog is a selection control for switching between 
the available model types. The graph below it shows the sample 
variogram, the model variogram excluding the current nest you are editing 
or adding, the currently selected nest and the final model variogram 
including the current nest. The model parameters are presented below the 
graph and can be edited directly. Most of the model parameters can also 
be adjusted graphically by dragging the blue triangular handles that are 
presented on the graph axes. For example, when a spherical model is 
selected the left vertical (Y) axes handle allows the editing of the sill and 
the bottom horizontal (X) axis handle allows the range to be edited.

The sample variogram grid is displayed in the bottom left corner of the 
dialog. The view direction for the grid can be changed by clicking on the 
plot and dragging the cursor to spin the view in 3D. Changing the view 
direction of model variogram grid does not change the direction 
parameters used to extract the model variogram. The grid graph rotation 
and spin controls are provided for visualisation purposes only. Note that 
the width of the extraction is equal to the width of the extraction on the 
main Sample page and cannot be modified here.
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Editing the variogram nest

• The Anisotropy page controls the range of the model along three axes – 
the Primary, Minor and Depth axes. A preview of the currently selected 
nest is shown on the left, whilst the final model preview is shown on the 
right of the dialog. 

The default Primary Axis range is equal to the range established on the 
Parameters page. The Minor and Depth Axis ranges are used to introduce 
anisotropy into the model. If the minor and depth axes ranges are set 
equal to the primary axis range then the model is isotropic. 

Gridding Data Specification

Source data can be obtained from any database currently loaded in Encom 
Discover PA. Both drillhole and survey datasets can be used. A memory efficient 
direct ASCII file import is also supported where the ASCII file is in a delimited 
column format. The input lines or drillholes can be specified manually or via a 
graphical selection dialog by clicking the Line Selection button.
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Specify the input dataset to be gridded plus the data fields

By default the input data is assumed to be 3D point source data. In other words, 
it has a defined X, Y and Z coordinate and is considered to be a point sample 
taken at that location. Alternatively, you can specify that the input data are “from-
to segment” samples. In this case, each sample is defined by a beginning and end 
point location. The value of the data over the segment is assumed to be constant. 
An example of segment data would be drillhole geochemical assays from depth 
162.5 to 163 metres. This results in more accurate solutions as the distance from 
the interpolation point to the sample may be less than the distance to either of the 
sample end points.

You are required to specify the X and Y input fields and select a single band from 
any available for these fields.

There are three ways to specify the Z (or RL) band(s) and data band(s) and each 
results in a different grid. If a multi-banded grid is generated then multiple 
independent properties are stored at each grid cell. Note that not all export 
formats support multi-banded grids.

• Single Z Band, One or more Data fields - In this case you can generate 
a grid band for each data field selected. Select multiple data fields by 
holding down the CTRL or SHIFT keys whilst selecting fields in the data field 
list



27 Voxel Utilities 983

• Single Z band, One or more bands from an array Data field. In this 
case you can generate a grid band for each band selected from the data 
array field. Select multiple data bands by holding down the CTRL or SHIFT 
keys whilst selecting bands in the data field band list.

• Multiple Z bands and Data bands from Z and Data array fields. In this 
situation you can create a single banded grid. The software matches each 
Z band to a Data band and generates a unique point sample for every 
station. Note that you should choose an equal number of Z and Data 
bands. One application of this is the gridding of EM CDI data which is 
often stored in multi-banded Depth and Conductivity arrays.

Coincident points are detected and processed according to the users 
specifications defined from a pull-down list (average, minimum etc). If you specify 
that segment data is being used, the software expects each point to be the first 
point of the next segment as well as the last point of the previous segment. In this 
case you are advised to choose an appropriate coincident point handling method 
carefully – the first point of each segment may be coincident with the last point of 
the previous segment. If this is the case, you would not want to average or 
otherwise modify the data at the coincident point – you would elect to leave it 
unchanged. Otherwise the value of the assay along the entire segment would be 
modified.

Conditioning Data Prior to Gridding

Source data can be conditioned prior to gridding. This process can be used to 
eliminate poorly defined data from the input dataset. The main property page 
presents settings that are common to all the source data bands (or fields). 
Individual and more detailed control over each band can be obtained via the 
Advanced Settings button.

• Grid Conditioning

• Field Data Conditioning
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Grid Conditioning

Conditioning of data to be gridded using the Voxel Toolkit

This dialog also provides range of options for data conditioning prior to 3D 
gridding. This process is essential to eliminate poorly defined data from the input 
dataset, such as negative values representing missing samples (e.g. Sample Not 
Received (SNR), Below Detection limit (BDL), etc). It also provides data capping 
options (e.g. capping gold assays in mineralisation systems prone to nugget 
effects), as well as conversion of Null values to a user-defined background value. 
Failure to remove such artefacts can result in meaningless output grids.

Setting a Cap values below or above value will cap source data outside the set 
limit to the limiting value. For example, with Cap values above set to 500, a gold 
assay on 725ppm will be handled during 3D gridding as a 500ppm value. It is also 
possible to Convert null values to a background value specified by the user, in 
order to constrain the gridding. For example, if gridding drillhole geochemical 
assays, much of the hole may not have been sampled and in these areas the 
assay result may be assumed to be equal to the background value. This helps 
prevent anomalies ballooning into areas with no source data coverage.

These conditioning options presented in the main dialog are global settings: if 
multiple data fields have been selected in the Input Data dialog (i.e. in order to 
create a multi-banded grid), these settings will affect all fields equally. 
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Field Data Conditioning

The Field Data Conditioning dialog

The Field Data Conditioning dialog can be accessed from a number of Encom 
Discover PA tools using the Advanced Settings button (shown left). It allows 
the user to remove abnormal or invalid data, such as negative values 
representing missing samples and spurious outliers, as well as providing Null 
value assignment and handling. It can also be utilised to query out and display 
specific portions of a dataset, for example all downhole gold assays between 2g/
t and 5g/t, or only intervals with a QBX or QV lithological code.

The Statistics button at the top of the dialog opens the Statistics Explorer. This 
tool provides a powerful means of analysing the dataset for geochemical 
outliers, invalid data ranges, data distribution, etc via Graphical, Statistical and 
Histogram views. This dialog is dynamic: it will reflect any invalid data ranges or 
cap values set in the Field Data Conditioning dialog, allowing the user to check 
the effect of any conditioning applied to the data range.
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The Graph view of the Statistics Explorer

The central part of the Field Data Conditioning dialog allows the specification of 
invalid data and/or data ranges. The first option auto-populates with the datasets 
default null value: generally -1.0×1032 or -99999. Disabling this option (via the 
tick box) will disable null handling; invalid data (either user defined or pre-existing 
null input data) will not be converted to Null values in the output grid, but will be 
populated and handled as valid data values. A global Default numeric null can 
be set in via the Properties button in the main Voxel Toolkit dialog; this value will 
be applied not only to all data fields, but also the X, Y and Z fields

Within the Graph and Histogram views of the Statistics Explorer, data subsets 
can be selected using the Rectangle Selection tool.  

And then viewed using the View Current Selection button.

Return to the previous selection (or entire dataset) using the View Previous  
Selection button.
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The auto-populating Null value assignment option based on the dataset type

Specifying individual invalid data values. This is appropriate for removing  negative values 
representing BDL (Below Detection Limit), SNR (Sample Not Received), etc.

The following options allow specification of a list of user-defined invalid data 
values and/or ranges specific to the data field. Enter the invalid value or range at 
the left and then press the Add button to add it to the list at the right.

List entries can be removed using the Delete button. Some examples of use are 
presented below:
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Using the Field Data Conditioning dialog to display only a data range of interest, in this 
case only gold assays between 2 and 5g/t. This is done by specifying all data outside this 
range as a series of invalid ranges.

Setting a Cap values below or above value will cap source data outside the set 
limit to the limiting value. For example, with Cap values above set to 500, a gold 
assay on 725ppm will be handled during 3D gridding as a 500ppm value. It is also 
possible to Convert null values to a background value specified by the user, in 
order to constrain the gridding. For example, if gridding drillhole geochemical 
assays, much of the hole may not have been sampled and in these areas the 
assay result may be assumed to be equal to the background value. This helps 
prevent anomalies ballooning into areas with no source data coverage.

If the data field is a text field (e.g. lithology codes for use in drillhole colour 
modulation, or Discretised 3D gridding), the Field Data Conditioning dialog 
display will be altered accordingly.  
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The Field Data Conditioning dialog when the source data field is a text field

This allows individual text strings to be specified. The Get Strings button will 
populate a pull-down list with all unique attributes in the text field, allowing a list 
of invalid text strings to be easily created. A global Default text null can also be 
set in via the Properties button in the main Voxel Toolkit dialog; this null string will 
be applied to all string data fields.

Creating a list of invalid lithological codes (e.g. so that only the valid codes are displayed 
when colour modulating drillholes) 
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Specifying the Grid Size

A 3D grid consists of NX*NY*NZ cells in the X, Y and Z dimensions. The gridding 
process interpolates a value for the centre of each cell from the source data. 
Thereafter, most visualisation techniques consider the value of each cell to be 
constant across the cell. Some visualisation techniques require smooth 
interpolation between cells and to do this they consider the value to be defined at 
the centre of the cell and to smoothly vary to the values at adjacent cells.

The 3D grid mesh is defined by specifying the bottom left front corner coordinate 
(minimum) and the sizes and number of cells in the XYZ dimensions. The cell size 
can be fixed or variable. For example, a larger cell size can be specified on the 
edges of the mesh and a finer cell size in the centre of the mesh.

Specify the 3D grid mesh size in each of the three dimensions

Data conditioning parameters (invalid data ranges, cap values, etc) can be 
saved and reused by using the Save and Load buttons at the top of the dialog. 
These create and handle Data conditioning files (.edc) that store the user-
defined parameters.



27 Voxel Utilities 991

You can specify a variable cell size by checking the Variable cell size option and 
defining the cell sizes in all three dimensions using a count*size notation. For 
example 5*200 10*50 5*200 specifies a total of 5 cells with width 200 metres on 
both outside surfaces and 10 cells of 50 metres width in the middle.

You can specify a rotation for the grid by adjusting the Rotation about the X, Y or 
Z axis. Note that this rotation is relative to the origin X, Y, Z. By default the origin 
is set to the centre point of the Data and Grid range, with cells Extending to either 
side of this. However in some case, such as when working in a local mine grid, 
the origin may need to be adjusted to a corner of the grid, or the a local mine grid 
origin.

The definition of 2D grids is similar except that variable cell sizes are not 
supported and only a single plane can be generated.

The wireframe/mesh of the Grid can be previewed at any time by clicking the 
Preview button. This allows alignment of the grid to a feature of trend in a 3D map 
window.

The software makes an initial grid size suggestion based on the spatial 
resolution of the source data. However, you almost always want to set the grid 
size yourself. To make specification of the grid size easier the Auto button 
provides a menu of automatic options which set the grid size. Fit to extents sets 
the origin and cell count based on the current cell size. The Auto… options set 
the origin, cell size and cell count appropriately to cover the source data extents 
at a variety of useful resolutions. The Load and Save options retrieve or save 
settings to a simple ASCII text file with a .E3X file extension. The Match Grid 
option allows you to browse to an existing grid on disk and retrieve the grid size 
from that.
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Defining the Grid Control Parameters

  
Specifying the Inverse Distance Weighting parameters using a Simple Search

The Voxel Toolkit currently only offers one interpolation method - inverse distance 
- which is used for both continuously variable and discrete input data. 

The inverse distance interpolation algorithm proceeds by examining each grid cell 
in turn. It finds the distance from the grid cell centre to all source data points. 
Using one of a variety of weighting schemes, it interpolates a value at the node 
by summing the contribution from all data points, weighted according to the 
distance between the grid cell and the data point. The weighting scheme ensures 
that data close to the grid cell contributes more to the final value at that cell than 
data far from the cell.

This is a simple technique that suffers from one major problem – it is slow and 
runs in a time proportional to the number of grid nodes multiplied by the number 
of input data points. In many cases, it is simply too slow and so a variety of 
techniques are used to improve performance. Unfortunately all of these 
techniques degrade the quality of the solutions. The key to generating a quality 
grid is to balance speed requirements against quality requirements and 
experimentation is almost always necessary. For this reason you are advised to 
experiment with a low resolution grid first and then generate the final grid at the 
required resolution once you have determined appropriate gridding parameters.
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Search Radius

The first technique designed to improve performance is to introduce a search 
radius. The algorithm only searches for contributing data points within the 
specified radius of the grid cell. Data points outside of this distance do not 
contribute to the solution at that cell.

The first problem this causes is a failure to grid the node as an insufficient number 
of contributing data points may be found within the search radius to satisfy the 
algorithm. The 3D gridding algorithm accommodated this by using two additional 
parameters. 

• Firstly, a Search Expansion (i.e. increment) ranging from 1 – 5 can be 
specified. If an insufficient number of data points are found within the 
search radius, that search radius is increased (by the initial radius) and 
the search is repeated. This occurs up to “n” times – as specified by the 
increment. The final search radius is the number of increments multiplied 
by the initial search radius.

• Secondly, the number of Grid Passes can be set to greater than 1. If a 
number greater than one is applied the grid is generated at a lower 
resolution first. The nodes gridded in the first pass are added to the input 
data for the second pass. From 1 to 5 grid passes can be requested. The 
initial search distance is equal to the number of passes multiplied by the 
initial search distance. This feature is useful if the input data points are 
unevenly distributed as it fills in the gaps in coverage more efficiently.

If you use restricted search radii to improve gridding performance you invite the 
possibility that the contributing data points chosen for each interpolation are not 
evenly distributed about the grid cell. This can lead to poor solutions. The 
software therefore uses ellipsoidal searches and sector searches to eliminate this 
problem.

An Elliptical Search radius can therefore be defined by set the major (X), minor 
(Y) and depth (Z) axis radii. The major axis can be rotated from its default position 
(aligned east-west). 

When gridding data that is sampled sparsely in two dimensions and densely in 
another, it is advisable to use an ellipsoidal search radius. Optionally, the 
weighting scheme can take account of the ellipsoidal search radius. This 
normalises the axes and ensures that data are weighted evenly in all dimensions.

To activate the parameters for this option ensure that the Elliptical Search check 
box is active. The following parameters can be applied:

• Strike of the major horizontal axis in degrees east or north.
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• Plunge of the major horizontal axis in degrees positive downwards from 
the horizontal plane.

• Dip of the minor horizontal axis in degrees positive downwards from the 
horizontal plane.

• Major horizontal axis search distance

• Minor horizontal axis search distance

• Minor vertical axis search distance.

Glossary:

• Strike is the azimuth of the Major Horizontal Axis (Y), degrees clockwise 
of north. It is a rotation about the Z axis.

• Plunge is the plunge of the Major Horizontal Axis (Y), degrees positive 
downwards from the horizontal, clockwise looking west. It is a rotation 
about the X axis.

• Dip is the inclination of the Minor Horizontal Axis (X), degrees positive 
downwards from the horizontal, clockwise looking north. This is the 
rotation of the X axis about the Y axis. It is a rotation about the Y axis.

• Major Horizontal Axis is the radius of the Y axis of the ellipse which is 
positive north when unrotated.

• Minor Horizontal Axis is the radius of the X axis of the ellipse which is 
positive east when unrotated.

• Minor Vertical Axis is the radius of the Z axis of the ellipse which is 
positive up when unrotated.

In all cases: Minor vertical axis ≤ Minor horizontal axis ≤ Major horizontal axis 

This rule should never be broken and the property pages will attempt to stop you 
from doing so. If (for example) you want the X axis longer than the Y, you need to 
rotate the major axis to achieve it.
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These parameters that are available for an elliptical search allow the user to easily 
introduce a bias into the estimation. In particular, at a new prospect the best 
information the geologist might have about the directionality trend of 
mineralization is that it seems to be conformant with the geology. It is likely that 
the geologist will know the rough strike of the geology and they may also have 
some idea of the dip. In general they will be drilling along strike and against the 
dip. This provides good information for estimation bias. The degree of the bias is 
determined by the ratio of the axis radii to the vertial axis radii. For example, by 
setting the vertical axis length to 10m, the minor axis length to 20m and the major 
axis length to 40m you are saying you expect the continuity of the mineralization 
to be four times as strong along strike and down plunge as it is perpendicular to 
the strike and dip of the geology. Within the plane of the geology you expect the 
continuity to be twice as good down plunge as perpendicular to the plunge.

Only data found within the boundary of this 3D search ellipse will be considered 
in the estimation. Note that with the editing of these parameters the Search 
Expansions and Grid Passes specifications incrementally increase those ellipse 
axis lengths.

Note that the Sector requirements (in Sample Selection parameters) also refer to 
this ellipse. In 3D space these sectors will be rotated to match the ellipse axis 
rotations.

The Sample Selection options for 3D gridding improve the final output. Options 
include:

• Specifying the Search Sectors to be used will help ensure that input data 
is evenly distributed spatially around the grid cell. 

• You can specify that the gridding cannot succeed unless a Minimum 
number of input points are found within the search radius within each 
sector. You can elect to use 1, 2, 4 or 8 sectors by selecting the options: 1, 
2X, 2Y, 2Z, 4XY, 4XZ, 4YZ, or 8. For 2 or 4 sectors the axis which 
separates the sectors is also specified. This option often results in a grid 
that is not fully defined – that is, many nodes are not gridded as the 
algorithm requirements cannot be met. You can use this option to improve 
the solutions, but then override it at the last minute by electing to grid the 
cell and retain the solution if the algorithm requirements have not been 
fully met but at least one valid source data point has been found.
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• Within each sector the algorithm may locate many points. You can elect to 
consider just the closest of those points by entering selecting the Use 
nearest samples check box and then specifying a value (from 1-100) in 
the Maximum number of samples (per sector) box. If you do not restrict 
the number of input points in this way then many input points may 
contribute to each solution. This can have unusual effects especially as 
you begin to move away from input data and the distance to all points 
becomes approximately equal. Also, the uneven population density of the 
input data can produce problems. This can be eliminated by applying 
density corrections which are recommended whenever you allow the 
algorithm to use all the located points in the search radius as contributing 
points to the solution.

The Search parameters dialog for 3D Gridding.
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Preview Window

The Preview window for the Search parameters of 3D Gridding.

The controls at the base of this dialog link directly back to those in the Search 
dialog. The user can therefore modify on-the-fly the search distance, ellipsoid axis 
lengths and orientation, as well as the number of grid passes and expansions, 
visualising these changes immediately with respect to the source data 
distribution.

Weighting of Points

Several weighting schemes can be employed including Linear, Exponential, 
Power law and Gaussian. The usual choice is Power Law where the contribution 
from each data point is weighted by the distance to the point raised to the 
specified power. A higher power ensures that closer points have a higher 
influence on the solution. The weighting schemes are described below.

The current search spheroid or ellipsoid can be viewed in a simple 3D preview 
window with the source dataset by pressing the Preview button at the top right of 
the Search dialog. 

Search parameters can be saved and reloaded as a grid Parameters file (.e3g) 
using the Load and Save options under the Auto button.
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Linear

The weight assigned to each data point which is used to interpolate the value at 
a grid node is proportional to its Euclidian distance from the node being 
interpolated. If a simple linear (to cut-off) weight model is selected then the 
Nugget and Range parameters are enabled. These parameters can be adjusted 
to vary the weighting assignments that are applied within a Range and Nugget 
distance. At distances less than the Nugget distance the maximum weight is 
applied to the input points (i.e. all data values will contribute equally to the 
averaged node value). The Range defines an outer distance threshold for the 
weight model. Any data points which exceed the Range distance but are less than 
the Search Distance (Search Parameters) will be proportionally weighted by their 
distance from the grid node such that:

Distance < Range:  Weight =  

Distance >= Range: Weight = 1

Exponential 

The weight assigned to each data point is proportional to its distance from the grid 
node being interpolated raised to a specified power. Increasing the power value 
will result in smaller weights being assigned to closer points and more distant 
points being assigned equal but large weights. Increasing the power value will 
cause each interpolated grid node to more closely approximate the value of the 
sample which is closest to it. As with the Linear model the Nugget and Range 
properties can be modified to constrain the distance over which the exponential 
weight model is applied.

Distance < Range: Weight  

Distance>=Range:  Weight = 0

Range
DistNugget −

⎟⎟
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Power 

The weight assigned to each data point is proportional to the inverse of its 
distance to the grid node, raised to a specified Power. Increasing the power value 
reduces the amount of influence distant points have on the calculated value of 
each grid node. Like the exponential weighting model, large power values cause 
grid cell values to approximate the value of the nearest data point. Smaller power 
values will result in a higher degree of averaging such that their values will be 
more evenly distributed among neighbouring grid nodes. The default weighting 
value is 2 (i.e. the weight of any data point is inversely proportional to the square 
of its distance from the grid cell). This is appropriate for most situations. If 
required, the weighting value can be altered to any positive value.

Weight 

Gaussian 

The weight assigned to each data value is determined according to a 1D 
Gaussian function centred on the grid node. The shape and standard deviation of 
the Gaussian function is proportional to the Range with larger values producing a 
flatter function and a smoother grid.

Weight 

The 3D Gridding includes a Simple mode that does not restrict the search radius 
and allows all input data to contribute to each solution. It may take a long time to 
run, but the grid generated is often quite smooth and may serve as a guide for 
further gridding attempts.

For Inverse Distance Weighting and Classified gridding you can activate the 
check box for Use elliptical weighting (elliptical search) when elliptical search 
is specified in the Seach Parameters dialog. This modifies the weighting assigned 
to contributing samples by computing the anisotropic distance between the 
sample and estimation position. When the sample is located in the direction of the 
major or minor axes this distance will likely be shortened and so the weight 
assigned to that sample will be increased.

PowerDist
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Tapering

As your solution centre moves away from data sources your confidence in the 
solution may decrease. Statistically, at some point you will exceed the range 
beyond which there is no correlation between source data. The tapering option 
enables you to taper the solutions back to background at large distances from 
source data. The tapering function is linear and applies between the From and To 
distances. Beyond the To distance all solutions are assigned the background 
value. 

The Method dialog for 3D Gridding which allows the specification of weighting applied to 
each sample.

Advanced Properties

• Load entire hole length: when disabled, Encom Discover PA will only 
use that portion of the hole that has valid data. As NULL values can be 
converted to background and used to constrain the gridding (see Data 
Conditioning) this option is enabled by default.

• Segment break length: used when loading drillhole data and the From-to 
segment option is enabled (see Input Data Specification). Each segment 
is sub-sampled so that there is a point location along the segment every 
specified unit of distance. This can be used to speed up the distance to 
data gridding method and to return more accurate point density grids.

Advanced Gridding properties can be accessed via the Properties button on the 
Voxel Toolkit main window. 
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• Default numeric null: allows user-definition of the global null value for the 
input X, Y, Z and data fields. 

• Default text null: allows user-definition of the global null string for input 
string/character fields; only applicable when using discretised gridding.

  
Example of drillholes to be gridded using gold assay intervals

Discretised Gridding

This method uses Inverse Distance Weighting to interpolate discrete or classified 
data. An example would be to classify geological rock codes recorded for drillhole 
samples and assign these to a 3D grid. Both string and numeric data can be 
classified by this method. Once the data has been classified it is then interpolated 
into a grid using similar techniques to the continuous interpolation method. The 
main difference being the value assigned at each grid node represents a specific 
classification code rather than a weighted value. The classification code which is 
assigned to each node is the one with the highest probability of occurring at the 
interpolation point. 

The method produces a legend file as one of the products of the gridding process. 
This legend file can define surface and line colour and pattern for each 
classification. It can be used as a rendering guide when the grid is displayed.

Discretised gridding presents the following gridding dialogs:

1. Input Data Selection

2. Data Conditioning
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3. Classification

4. Grid size specification 

5. Search parameters 

6. Method

After selecting the Discretised method from the Gridding Technique dialog of the 
Voxel Toolkit choose the field in the loaded database that is to be gridded from 
the Input Data dialog. Then click Next to proceed to apply Conditioning to the data 
i.e. converting null values in the data to the background value.

Choose the Discretised gridding technique.

Then click the Next button to proceed to the Classification dialog which provides 
two options for classifying unique values:

• Classify from Legend: use an existing .leg file to classify the input data. 
Existing legend files which have been created (for example to colour 
downhole lithologies in a drillhole project) can be used. These are 
normally stored in the C:\Program Files\Encom\Common\LUT directory.  
Any data which does not match a record contained in the legend file will 
be treated as a NULL value in the output.

• Auto-classify: creates a new legend using the entire input dataset. All 
input data will be classified unless it has been set as Null in the Field Data 
Conditioning dialog.
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The Classification dialog for Discretised 3D gridding

Proceed to the Size parameters dialog to specify the voxel (i.e. cell) sizes and 
resolution of the gridded model.

The output of this procedure is a grid that records the distance from the centre of 
each grid cell to the nearest valid data point. It is useful for identifying gaps in data 
coverage. It is also used as an input to some filtering processes because it can 
be used to define nodes in the output grid that are near to input data points.

An example of a voxel model showing lithology patterns produced from the discretised 
grdding technique.
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Distance Gridding

Distance gridding utilises the following wizard dialogs:

1. Input Data Selection

2. Data Conditioning

3. Grid size specification

In addition, the final dialog is the Distance Parameters dialog. In this, a 
maximum distance envelope can be specified to clip the grid to from the nearest 
input data. Any grid node that is outside this envelope is assigned a null value.

  
The Distance Parameters dialog

If you have checked From-To segments on the Input Data dialog, a more 
accurate solution can be obtained by also considering the perpendicular distance 
to each segment as well as the end points (the distance-to-line enhancement 
option). This has the unfortunate side-effect of severely reducing the speed of 
operation. If the segments have been discretised sufficiently then it is usually 
sufficient to use just the point data. Note that the performance of the algorithm can 
be improved considerably by enabling the check box to Restrict to maximum 
distance envelope and then specifying an Envelope Distance. This option will 
restrict the search distance to the maximum envelope distance specified. 

The old method computed the isotropic distance from the centre of each grid cell 
to the closest valid sample point. 
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There is a check box option available called Use distance-to-line solution which 
when enabled will compute the distance to the input line segments. This is handy 
for drillhole data that has not been composited but it can degrade the algorithm 
performance considerably.

The Compute anisotropic distance check box option allows the user to define 
spatial compression factors in two directions in 3D space. The components of a 
vector in 3D space will be shortened in these directions. For example, in 
geological terms this means that we can define the distance along the strike and 
plunge of a geological unit to be shorter than the distance perpendicular to the 
plane of the geology.

Note changes to the Distance to data method (Distance Parameters’ property 
page) shown below.

To compute the anisotropic distance you must specify:

• The Strike of the major horizontal axis in degrees east or north

• The Plunge of the major horizontal axis in degrees positive downwards 
from the horizontal plane.

• The Dip of the minor horizontal axis in degrees positive downwards from 
the horizontal plane. 

• The Shortening factor on the major horizontal axis. The factor on the 
major horizontal axis must be greater than or equal to the minor horizontal 
axis factor.

• The Shortening factor on the minor horizontal axis. The factor on the 
minor horizontal axis must be greater than or equal to the minor vertical 
axis factor.

• The Shortening factor on the minor vertical axis is fixed at 1.0 (ie no 
distortion). 

There is a 3D preview graph – click to activate. Use the left mouse button to spin 
the graph and the right mouse button to zoom in and out.

Note The distance envelope remains an isotropic distance regardless of whether 
anisotropic distance is being computed.
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Density Gridding

The Density gridding method produces a grid which records a measure of the 
point density at each grid cell.

As with Distance gridding, it utilises the following gridding wizard dialogs:

1. Input Data Selection

2. Data Conditioning 

3. Grid size specification

Additionally a Density Parameters dialog provides two estimator function options 
for the independent calculation for each grid node: the Radial density estimator 
and the Kernel density estimator (KDE).

The Density Parameters dialog

• The Radial density estimator returns a true measure of the point density 
at each grid cell (measured as the number of samples per cubic volume 
unit – usually metres). It is a simple method that counts the number of 
input samples within a specified radius of the grid cell position and then 
normalises that count by the area of the search.



27 Voxel Utilities 1007

• The Kernel density estimator is a non-parametric density estimator. It 
uses a similar approach but it weights the input samples by a kernel 
function that is normally a function of the normalised distance of the 
sample to the grid cell. To achieve a good result with the KDE function it is 
more important to choose an appropriate search radius – sometimes 
referred to as the bandwidth – than to choose an appropriate kernel 
function. If the bandwidth is too small the density will be under-smoothed 
whereas if the bandwidth is too large the density will be over-smoothed 
and lacking in resolution.

Given a kernel function K and a search radius (or bandwidth) h, the 
estimated density at any point x is given by – 

where n  is the number of samples. The following kernel functions are 
supported.
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If you have taken multiple samples at each input data location and this information 
is recorded in the input source data you can use this information to bias the 
density estimation. 

Often a density grid will contain a large number of cells with zero density. These 
can be converted to NULL values using the grid calculator using an expression 
like NEW = if (OLD == 0, null, OLD) which will make visualising the grid easier.

Note that this method only uses point samples, so to ensure that segment 
sampled data is accurately represented, use the advanced gridding properties 
options to set a suitable Segment break length.

3D Grid Convolution Filtering

Basic filter properties include:

• Data honouring - When used, grid nodes that are close to a known data 
point will not be modified by the filter operation. Currently a distance grid is 
used to measure the closeness of a node to the input data. The distance 
grid can easily be generated using the 3D gridding tool.

• Result - Either the convolved or residual result can be output.

• Iterations - You can apply the filter one or more times.

Cosinus

From the Voxel Toolkit wizard, the Convolution filtering option enables a 
filtering tool that allows you to apply one or more 3D filters to a 3D grid.

The tool enables you to load/import and unload grids from a grid manager (click 
the Add filter button) and to select a grid to operate. Multiple filters can be 
applied to the grid in a user-specified order. The filter properties are accessible 
via the filter button in the Filter column.

)1()
2

cos(
4

≤uIππ



27 Voxel Utilities 1009

Convolution filtering tool operating over a selected 3D grid

Voxel Utilities

Voxel>Voxel Utilities

Encom Discover PA Professional provides a range of powerful Voxel Utilities, 
from simple voxel cell size resampling through to advanced analytics and 
calculations between voxels and polyhedron volumes. 

This functionality can aid in determining the average voxel cell value (e.g. gold 
grade) within a user-modelled polyhedron volume, allowing simple resource 
calculations;  clip a voxel to a mineralisation  volume's extents or interpolated 
unconformity surface; or convert lithological vector volumes into a voxel model of 
densities.

 These utilities are accessible via the Voxel>Voxel Utilities menu option in the 
3D application:

• Assign Values to Features – Attribute multiple feature objects with any 
coincident voxel cell values.

• Clip to Surface – Clip a voxel model with a surface, producing two output 
voxel models.
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Assign Values to Features

For example, this can be used for calculating the average gold grade of a number 
of wireframed supergene volumes from their contained cell values of an 
encompassing voxel model.

Requirements:

• A voxel model (preferably open in Encom Discover PA).

• A feature database open in Encom Discover PA containing either point or 
solid (polyhedron volumes) objects only.

To assign values from a voxel model to a features database:

1. Open the source voxel model and coincident feature database into Encom 
Discover PA.

2. From the Voxel>Voxel Utilities menu, select Assign Values to 
Features.

• Clip to Vector Volume – Clip a voxel model to one or more vector 
volumes, producing two output voxel models.

• Convert Nulls – This utility converts the NULL value in the input voxel 
model to a specified value.

• Convert Vector to Voxel – Convert one or more polyhedron volumes into 
a voxel model.

• Create Mesh – Create a blank voxel mesh, either from an existing voxel 
model or via user-specified parameters.

• Merge – Merge two or more voxel models into a single multi-banded 
voxel model.

• Resample – Resample and/or resize an existing voxel model into a new 
voxel model.

Attribute multiple feature objects with the statistical aggregation of any 
coincident (for feature points) or contained (for polyhedorn volumes) voxel cells. 
The following statistical calculations are available for polyhedrons: Mean, 
Minimum, Maximum and Sum.
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3. Select the source voxel model in the File Selection dialog and press 
Next. If not already open, a voxel model can also be loaded into Encom 
Discover PA via the browse button at the top right of this dialog.

4. In the Assign Values to Features dialog, select the Feature database 
andd Feature set that values will be assigned to.

5. Select the fields in the feature database to be attributed:

• For multi-banded voxel models, select the Voxel field.

• For polyhedron feature datasets, under Assign variable, select the 
desired fields to attribute with any of the Mean, Minimum, Maximum 
or Sum operations. If an appropriate field does not exist, use the 
adjacent New Field button to add and name new numeric fields.

Polyhedron volume feature datasets can be attributed from only 
numeric voxel models.

• For point feature datasets, use the Assign value pull down to set 
the target field for coincident cell numeric or text attributes. If an 
appropriate field does not exist, use the adjacent New Field button 
to add and name a new field.

Point feature datasets can be attributed from either numeric or 
lithological voxel models.

6. Select the desired Test rule and Acceptance test (if appropriate)  (see 
Volume Selection Method) and press Finish.

When processing has finished, open the Feature Data Window, and select the 
target feature database selected in step 4. Note the selected fields have now 
been statistically attributed.

Note Feature datasets with mixed object types, or any invalid object types such as 
polylines, polygons and surfaces will be rejected.

Note Attributable feature database fields (such as MaxCu, MeanCu or Lithology) can 
be pre-added to the database (use the Features>Modify tool) or added from 
within this utility.
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Clip to Surface

This could be used to restrict an interpolated downhole-copper voxel model to the 
volume below an unconformity surface.

Requirements:

• A voxel model (preferably open in Encom Discover PA).

• A gridded surface or a feature database (preferably open in Encom 
Discover PA) containing a single surface.

• The extents of the surface (perpendicular to the intersection direction) 
must fully encompass the extents of the voxel model in the direction

• The surface must fully truncate the voxel model

• If using a feature database, it must contain only a single surface object. 
Feature databases with any other feature type, or multiple objects, will be 
rejected.

To clip a voxel model with a feature surface:

1. Open the voxel model in Encom Discover PA.

2. Open the feature database in Encom Discover PA.

3. From the Voxel>Voxel Utilities menu, select Clip to Surface.

4. Select the voxel model in the File Selection dialog and click Next. If not 
already open, a voxel model can also be loaded into Encom Discover PA 
via the browse button at the top right of this dialog.

5. In the Clip to Surface dialog, select the appropriate feature database 
from the Use an open feature database option. 

6. Set the Intersection direction. This controls the 'ray' or 'hit' test direction 
for each voxel cell to the feature surface, with options for testing along 
either the X, Y or Z axis directions. 

Cut a voxel model with a surface, producing two output voxel models (one either 
side of the surface). The clipping surface can be either a triangulated feature 
surface (e.g. a fault plane), or a 2D gridded surface (e.g. DEM topographic grid).

Note The intersection/hit test is performed on the cell centres only.
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This should be as close to perpendicular to the plane of the feature 
surface as possible. For instance, a relatively horizontal unconformity 
surface would be best tested against with a Z axis intersection direction, 
whilst a near vertical fault surface orientated north-south would require an 
X axis intersection direction.

7. This will generate two voxel models; the locations and names of these can 
be altered at the bottom of the dialog. The user can elect to prevent the 
generation of either output grid via the check boxes. Press Finish to run 
the clipping process.

To clip a voxel model with a gridded surface:

1. Open the voxel model in Encom Discover PA

2. From the Voxel>Voxel Utilities menu, select Clip to Surface.

3. Select the voxel model in the File Selection dialog and press Next. If not 
already open, a voxel model can also be loaded into Encom Discover PA 
via the browse button at the top right of this dialog.

4. In the Clip to Surface dialog, select the Use DEM surface option. 
Browse for the gridded surface via the adjacent Open button. If using a 
multiple-banded grid, also select the band from the Band pull-down list

5. Set the Intersection direction. This controls the 'ray' or 'hit' test direction 
for each voxel cell to the feature surface, with options for testing along 
either the X, Y or Z axis directions. 

This should be as close to perpendicular to the plane of the feature 
surface as possible. For instance, a relatively horizontal unconformity 
surface would be best tested against with a Z axis intersection direction, 
whilst a near vertical fault surface orientated north-south would require an 
X axis intersection direction.

6. This will generate two voxel models; the locations and names of these can 
be altered at the bottom of the dialog. The user can elect to prevent the 
generation of either output grid via the check boxes. Press Finish to run 
the clipping process.

Note The intersection/hit test is performed on the cell centres only.
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Clip to Vector Volume

This is an excellent means of visualising/restricting a voxel model to only those 
portions within a wireframed mineralisation volume/s, perhaps as a precursor to 
using the Assign Values to Features tool.

Requirements:

• A voxel model (preferably open in Encom Discover PA) and 

• A feature database volume or volumes open in Encom Discover PA or one 
or more 3D volume third-party vector files (eg AutoCAD DXF)

To clip a voxel model with a vector volume:

1. Open the source voxel model.

2. If using a feature volume, open the coincident feature database in Encom 
Discover PA.

3. From the Voxel>Voxel Utilities menu, select Clip to Vector.

4. Select the source voxel model in the File Selection dialog and press 
Next. If not already open, a voxel model can also be loaded into Encom 
Discover PA via the browse button at the top right of this dialog.

5. In the Clip to Vector dialog, choose one of:

• Use a feature dataset and then select the feature database 
containing the polyhedron volume/s from the pull-down list.

• Use a 3D vector file and then use the adjacent Browse button to 
select one or more vector files.

6. Select the appropriate Test rule and Acceptance test (if appropriate); 
see Volume Selection Method for more information.

Clip a voxel model to one or more vector volumes, producing two output voxel 
models. This functionality supports both feature database polyhedrons as well 
as 3rd-party vector formats such as AutoCAD (.DXF) volumes.

Note Only polyhedron volumes (i.e. 'solids') will be processed; any other object types 
will be ignored in the input feature dataset or vector files will be ignored.
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7. This process will generate two output voxel models, one with valid cells 
within the clipping volumes, and the second with valid cells external to the 
clipping volumes. Change the voxel names and output location if desired, 
and press Finish. 

Convert Nulls

Convert Vector to Voxel

This allows the conversion of a polyhedron volumes into voxel regions of constant 
values, perhaps  as a precursor for more advanced voxel processing/calculations 
such as using the Grid Calculator. For instance, convert a series of modelled 
lithogical wireframe volumes into a voxel model of appropriate specific gravities, 
allowing further processing against a gold grade voxel to calculate basic resource 
estimates.

Requirements:

• A feature database with one or more polyhedron volumes open in Encom 
Discover PA, or

• One or more third-party 3D vector files (eg AutoCAD DXF) containing 
volumes to be selected by the user, or

• One or more Encom Modelvision TKM files.

To convert vector volumes to voxels:

1. If using a feature volume, open the feature database into Encom Discover 
PA

2. From the Voxel>Voxel Utilities menu, select Convert Vector to Voxel.

3. In the Convert Vector to Voxel dialog, choose one of:

This utility converts the NULL value in the input voxel model to a specified value 
(e.g. a different null value). Existing NULL values will be converted.

Convert one or more polyhedron volumes into a voxel model. This utility 
supports volumes in either a feature database or multiple input vector files (e.g. 
DXF and TKM). Output voxel values can be sourced from a feature database 
field, or set via a single global value. 
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• Use an open feature database and then select the feature 
database containing the polyhedron volume/s from the pull-down 
list or

• Use vector files and then use the adjacent Browse button to select 
one or more vector files.

• Use a ModelVision TKM file and then use the Browse button to 
select a TKM file

4. Select the value/s to assign to the resulting output voxel:

• Select to Stamp selected fields to the voxel cells. This allows 
selection of numeric fields to populate the voxel model from. 
Overlapping polyhedron volumes will be determined by the 
Multiple cell overlaps rule.

• Stamp single value will apply the same value to all voxel cells 
within the polyhedron volume.

5. Select the appropriate Test rule and Acceptance test (if appropriate); 
see Volume Selection Method for more information.

6. Press Next.

7. In the following dialog, select one of:

• Create a new grid with the XYZ extents of the input polyhedron 
volumes (recommended)

• Copy the extents of an existing grid

8. Press Finish.

Create Mesh

Note Only polyhedron volumes (i.e. 'solids') will be processed; any other object types 
will be ignored in the input feature dataset or vector files will be ignored.

Create a blank voxel mesh, either from an existing voxel model or via user-
specified parameters.
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Merge

The output merged grid is a multi-banded voxel, with one band per input voxel. 
Band visualisation can be controlled via the pull-down list in the Colour tab of the 
Voxel Properties dialog (see Changing Voxel Model Display Properties ). 

Requirements:

• Open the utility from the Voxel>Voxel Utilities menu

• Select the voxel models to merge and press Finish.

Resample

Volume Selection Method

All utilities involving processing between feature objects and voxel models need 
to determine whether a voxel cell is within the feature volume or not. The accuracy 
and speed of this calculation is controlled via the Test Rule and related 
Acceptance Test options. 

 

In general, the more accurate the method chosen, the more iterations/tests that 
need to be performed, and therefore the slower the processing time.

Merge two or more voxel models into a single multi-banded voxel model. All 
input bands are preserved and all cell boundaries are preserved without 
interpolation.

Resample and/or resize an existing voxel model into a new voxel model; a 
number of interpolation options are available.
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Test Rule

Four  levels of density testing are available for determination of whether a voxel 
cell is within a polyhedron volume:

• Test centre: Only the voxel cell centre position is evaluated. Fastest but 
least accurate method.

• Test volume – low accuracy: Each voxel cell is subdivided into 8 regions 
(2X x 2Y x 2Z) and the centre position of each of these is evaluated
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• Test volume – medium accuracy: Each voxel cell is subdivided into 27 
regions (3X x 3Y x 3Z) and the centre position of each of these is 
evaluated.
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• Test volume – High Accuracy: Each voxel cell is subdivided into 64 
regions (4X x 4Y x 4Z) and the centre position of each of these is 
evaluated (i.e. slowest but most accurate method)

Acceptance Test

If any of the Test volume options are selected, a range of Acceptance tests are 
enabled. These allow the user to specify how many of the subdivided regions 
(samples) need to be within the volume for the voxel cell to be accepted:

• One or more samples within the volume: Fastest but least accurate 
method.
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• >= 50% of the samples within the volume: Medium accuracy.

• All samples within the volume: Slowest but most accurate method.

3D Grid Calculator

NewName = exp<Name1>…exp<Name2>

The 3D Grid Calculator is a powerful tool for modifying 3D grids. To operate the 
calculator, build an expression using the following:
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3D Grid Calculator dialog

The calculator uses the grid names as arguments for the expression. These grid 
names are shown in the grid list and are assigned a default when the grid is 
loaded, saved or created. To ensure that the names are easy to use and are not 
too verbose, you can edit the name at any time by double clicking on it and 
overtyping the original name. Note that this does not affect the grid file on disk and 
is only stored locally.

The calculator can employ a full range of mathematical, scientific and Boolean 
operations. Use the load and save buttons to the right of the expression text to 
retrieve and store expressions for easy reuse.

The calculator recognises NULL values in the input grids. At any cell, if any of the 
input values are NULL then the result of the expression will be NULL. You can 
test for NULL values using the Boolean operators and the null keyword.

Advanced grid calculator properties are accessed via the properties button on the 
software main window. This allows you to control the output mesh size. There are 
two options:

• A superset of all input meshes. This option is the default and produces 
an output grid that fully encompasses all the input meshes. The mesh 
incorporates all the mesh boundaries of the original input meshes.
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• The intersection of all input meshes. This alternative can choose to 
output the area that is the common intersection of all the input meshes. In 
many cases this is a more logical choice since unless you implement 
Boolean operations to prevent it, the expression always evaluates to 
NULL when the target cell is outside one or more of the input meshes.

The advanced properties also allow you to control the NULL handling. By default, 
strict NULL handling is tuned off. This means that the outcome of simple 
expressions using the +, - , * and / operators will be valid if one of the operands 
is NULL and it will be equal to the non-NULL operand. If strict null handling is 
turned on, the outcome of any expression where any operand is NULL will be 
NULL. 

Press Apply to run the calculator on the expression. This creates an output grid 
that is not automatically saved to disk. You can save it manually from the 
calculator or from the Grid Management wizard. 

Click OK to run the calculator on the expression. This creates an output grid which 
you are prompted to immediately save to disk. If you choose to save the grid you 
are then directed to the Display Assistant that displays the new 3D grid.

3D Display Assistant

Display Assistant dialog with two voxel model files selected

The Display Assistant function of the Voxel Toolkit allows direct access to voxel 
model displays within Encom Discover PA. Selecting the Display Assistant 
button from the Voxel Toolkit displays the Assistant dialog as shown below:
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The Display Assistant dialog allows you to do most of the basic display functions 
of voxels within Encom Discover PA. You can:

• Create a chair display by selecting the section of the model to be clipped 
from a drop-down menu

• Display the voxel model with slices (not available for isosurface displays)

• Have the voxel model display in Voxel, Threshold or Isosurface format. 
The Threshold and Isosurface style use a slider bar to control the property 
threshold to remove or display.

For greater and more precise control over a displayed voxel model, refer to the 
descriptions of the various properties in Voxel Displays and various property 
descriptions.

Grid Management

Grid management tool to open, load and save 3D grids

The Grid Management tool available from the Voxel Toolkit enables you to load, 
import, save, export and unload 3D grids
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The program uses a grid management scheme that only loads grids into memory 
when they are required. The Status icon in the list indicates whether a grid is on 
disk, in memory (saved) or in memory (unsaved). Grids that are on disk or in 
memory (saved) can be safely unloaded. This does not modify the grid file on 
disk.

The Voxel Toolkit can load grids in a variety of formats including:

• UBC (University of British Columbia) (.MSH files)

• CEMI (University of Utah) (.CEM files)

• Noddy (Pitney Bowes Software) (.g00 files)

• Encom 3D Grid (Multi-banded) (.e3D files)

• Datamine (*.DM files)

• Surpac (*.MDL files)

• Vulcan (*.BMF files)

• GoCAD (*.VO voxet files)

• Gemcom (.BPR files)

• ASCII Import (.CSV or .DAT files)

ASCII Import of 3D Data

The ASCII import tool loads delimited (comma, tab, space) ASCII data. It may 
include zero or more header lines. If a header line is present it can be used to 
assign field names. If no header line is specified (by setting the header line to line 
0) then the fields are referred to using column numbers where the first column is 
column 1.

It also includes a powerful ASCII import wizard that loads delimited ASCII data 
and generate multi-banded 3D grids. This tool and all other grid file imports are 
accessed from the Open File button in the Grid Management tool.

Voxel Toolkit can save or export grids. Grids can be saved in UBC and Encom 
3D formats. Grids can be exported to ASCII file in either a simple delimited XYZ 
Data,Data… format where the coordinate is the centre of the cell or to a XYZ NX 
NY NZ Data,Data… format where the coordinate is the origin of the cell and the 
cell dimensions are specified. You can also export to an Encom ModelVision 
TKM file.
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The tool expects to load an X, Y and Z coordinate for each cell. This may be the 
minimum, centre or maximum extremity of the cell.

Specify the input data file

If the cell extent is specified it can also be loaded. Otherwise you can specify a 
constant cell size or no known cell size. In the latter case all cell boundaries are 
detected and the import is assumes the cells lie between the imported 
boundaries.

  
Specify the East, North and Vertical fields plus any sizes of cells known

Finally, you can specify one or more data fields which are each saved as a band 
in the 3D grid. Note only the Encom 3D Grid format can support multi-banded 3D 
grids.
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Specify the data fields to read for the gridding.
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28 Vector Utilities
• 3D Solid Generator

• 3D Extrusion Tool

• Topology Checker

• Transform Vector File

• Combine DXF Files

• MapInfo TAB to Geosoft GDB

• Geosoft GDB to MapInfo TAB

• DXF to ModelVision TKM

• MapInfo TAB to Vulcan Archive

• Vulcan Archive to MapInfo TAB

• EM Plate Importer

• MapInfo MIF/TAB to ArcView SHP

• Gemcom BT2 to MapInfo TAB

3D Solid Generator

The 3D Solid Generator is useful for creating interpreted 3D objects such as 
orebody, fault or other geological solids (e.g. aquifers), as well as infrastructure 
such as dams or open-cuts. 

This utility interpolates between polygon or polyline objects in a Feature Set (see 
Features) to produce simple, open 3D surfaces (e.g. faults) or closed polyhedral 
objects (e.g. alteration zones). 

Note This tool requires an Encom Discover PA Professional licence. If you wish to 
purchase or evaluate this module, please contact Pitney Bowes Software.
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The input data for the Solid Generator commonly consists of interpreted 
geological/infrastructure boundaries that have been digitized onto a number of 
parallel drillhole cross-sections (or plans) either in 2D or 3D. The utility then 
processes these polygons/polylines, interpolating the triangular facets between 
each of the sections/plans to produce a single 3D solid body.

  
Individual slices of interpreted regions are used to create a solid object DXF

A default output file name is required and the location of this file can be changed 
using the Browse button. Depending on the geometry of the input .DXF file, two 
output types can be chosen:

• Simple, open surface – produces a ribbon-like surface with no closed 
ends (eg a Fault plane). To generate a simple open surface, the input file 
must contain at least two open ended (that is, non-closed) lines. 

• Closed, polyhedral object – produces a fully enclosed 3D solid object. 
For this output type an End capping style can be selected with options 
ranging from None, Flat, Point or Smooth. To generate a closed 3D solid 
object the input file must contain at least two closed polylines i.e. 
polygons.

A .TKM file can be created from this utility which allows the solid object to be 
imported into Encom ModelVision Pro for modelling and interpretation.

Creating Boundaries 

The source Feature Set containing polygons/polylines representing interpreted/
inferred geological/structural/infrastructure boundaries can be created via two 
methods:

1. 2D – digitizing into section profiles or geological cross-sections using the 
feature digitising utility (see Features).

2. 3D - digitizing directly in the 3D environment into an editable Feature 
Database and Feature Set using the Cursor Plane functionality. For 
information on 3D boundaries, see 3D Digitized Boundaries.
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3D Digitized Boundaries

To digitize boundaries directly into the 3D environment ensure that the 
appropriate base datasets are open in 3D (e.g. Drillholes, voxel models, etc). 
Ensure that the Feature Database (see Feature Databases) into which the 
boundaries are to be digitized is editable (either the cosmetic layer or a new 
database). Align the Cursor Plane (see Toolbars for information on the Cursor 
Plane Toolbar) as required and use the Feature drawing tools to digitize the 
appropriate polygon and/or polyline vertices.

See Working with Features for more information about the many tools available 
for 3D digitizing. In particular, the ability to snap to drillhole intervals is a important 
function.

Some digitization tips which are controlled via the Cursor Plane tab of the Cursor 
Plane Properties dialog are:

• Use the keyboard PGUP and PGDN keys to offset the Cursor Plane 
perpendicularly from its existing position, in order to keep digitized 
features parallel.

• Use the User-defined step option to set the distance the PGUP and PGDN 
keys move the Cursor Plane.

• The exact location of the Cursor Plane can be set via the Origin (X, Y and 
Z), Inclination and Azimuth controls.

• To limit the amount of existing 3D data visible either side of the Cursor 
Plane (i.e. simulate a 2D section envelope), enable either the Envelope or 
Slice Clipping options. These enable only a user-defined Slice Width of 
data to be viewed either side (envelope) or behind (slice) the Cursor 
Plane. This is an excellent way to ensure that interpreted boundaries are 
based only on data within, for example, 50m of the Cursor Plane.

Orientate the view direction perpendicular to the cursor plane, thereby 
increasing the accuracy of your digitization.

• If digitizing onto georeferenced images (e.g. geophysical profiles), use the 
Bond to Image option on the Cursor Plane Toolbar.

Try enabling the Orthographic view mode (on the Zoom Controls 
Toolbar) to remove object scaling due to distance bias (as occurs in the 
default Perspective view). This will allow accurate object size comparison.

The Distance/Bearing tool on the Main Toolbar can be a useful guide to 
distances,bearings and dip angles between objects on the cursor plane.
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Create 3D Solid

The 3D Solid Generator is accessed via the Display Utilities menu within 
Encom Discover PA. It requires two or more individual Feature Objects (not in the 
same plane) in order to create an output DXF solid. 

3D Solid Generator dialog

The controls available from this dialog are:

• The top Feature pull-down list enables the choice of the source Feature 
Database (if multiple feature datasets are open in Encom Discover PA) 
and Set containing the source objects. This dialog can be kept open while 
changes are made to a Feature Database or Set.

Note When creating very simple shapes for use by the 3D Solid Generator, it is 
recommended to use more than just the bare minimum on nodes/vertices to 
create the shape (i.e. more than say just 6 or 10 nodes to create a ‘banana’ 
shaped polygon). Solids created out of shapes with too few nodes generally 
result in some ‘ugly’ triangulations (as the 3D Solid Generator has very few 
nodes with which to work), particularly through bends/curves, which are very 
difficult to model satisfactorily without a good distributions of nodes. The 
Refinement control of the Solid Generator can help overcome this problem 
automatically (see Algorithm Options)
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• The Body ID Field option enables a field in the feature database to be 
used to separate the output into separate bodies/solids. Within the Solid 
Generator utility the Body ID Field would be set to the Feature_ID field, 
in order to build a separate object for each of the unique attributes in this 
field. For instance, a series of 2D geological section boundaries are 
created and attributed using the Feature_ID field with “L1”, “L2” and “L3”, 
representing different lithology units.

The 3D Solid Generator configured to create separate output bodies (using the 
Body ID Field selector) for each unique attribute in the Ranking field of a Feature” 
database.

• The 3D Solid Generator supports the optional use of Tie Lines. These 
allow you to control both individual vertex-vertex joins on adjacent objects, 
as well as the overall join order of the source objects. To use tie lines, 
enable the Tie Lines option and specify the feature database and set 
containing the tie lines from the adjacent pulldown list. See Tie Lines for 
further information on creating and using tie lines.

• An Output DXF or TKM file name and location can be specified; by 
default this utilises the same name and location as the source file.

• The Preview window of the dataset can be rotated by holding down the 
left mouse button whilst moving the mouse. Hold down the right mouse 
button (whilst moving the mouse) to alter the zoom level.

• The Refresh button allows any such changes to be updated in preview 
window of the dataset within the 3D Solid Generator.



1034 Encom Discover PA User Guide

• A Surface Colour can be set for the output DXF solid/s, as can an End 
capping style (only applicable to closed polyhedral objects). The 
available end capping styles are None, Flat, Point or Smooth; however, 
selecting None will not produce a volume calculation in the output report 
generated at the bottom of the dialog.

Completed DXF solid with a Flat end capping style previewed in the 3D Solid Generator, 
including surface area and volume calculations in the report screen.

For more information, see:

• Tie Lines

• Output Options

• Algorithm Options

• Structure Analysis

• Shape Matching

• Compression
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Tie Lines

Whilst the 3D Solid Generator will generally produce satisfactory results for 
simpler shapes, for more complex shapes you may notice incorrect vertex joins 
occurring. These issues can be resolved via the use of Tie Lines, allowing you to: 

• Manually control/specify multiple individual vertex-vertex joins between 
objects (e.g. significant inflexion points such as splay separations, related 
peaks and troughs, etc)

• Control the join order of objects in complex datasets, such as those with 
large distances between objects, large lateral offsets between objects, or 
complicated joining orders. 

An example of the use of tie lines to guide solid generation between two different 
shapes is presented below. Each figure portrays the same dataset, viewed from 
different angles.

 
Figure 1: Two adjacent parallel polygons, the left a simple polygon, whilst the right hand 
shape splays into two lenses

Figure 2: The resulting semi-transparent and wireframed dxf solid generated by the 3D 
Solid Generator without using tie lines. Whilst the bottom lens of the right-hand polygon 
has been joined satisfactorily to the left-hand shape, the upper lens on the right hand 
shape has not.
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Figure 3: The preferred solid would have both these lenses joined to the near end of the 
left-hand shape. Red tie lines have been added indicating the user-required vertex-vertex 
joins between the two objects.

Figure 4: With the original (unsatisfactory) output solid removed, the tie line joins are 
clearer, linking the most prominent inflexion points (troughs and peaks) on the right-hand 
shape with the corresponding vertices on the left-hand polygon.
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Figure 5: The resulting wireframed and semi-transparent solid incorporating the user-
specified tie lines. The twin-lensed shape now clearly joins the left-hand polygon as 
desired. The red tie-lines are displayed for reference.

Before creating tie lines, it is recommended that the source shapes are put 
through the 3D Solid Generator by themselves to see what output is possible, and 
then utilise tie lines to refine this output. Experiment with the following options 
before applying tie lines:

• If the dataset contains multiple shapes relating to different attributes (e.g. 
different alteration haloes, fault sets, etc, ensure that an appropriate 
BodyID field is specified so that each series of shapes is handled 
separately 

• If shapes are offset laterally, try disabling the Structure Analysis option 
under the Algorithm Options button.

Note Using a tie line dataset may significantly increase the processing time of the 3D 
Solid Generator.
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Creating Tie Lines

The following points are critical to the correct use of tie lines:

• Tie lines must be placed in a separate feature database to the source 
polygon/polyline objects being joined (commonly the Cosmetic layer is 
used for initial tie line creation, and then saved using the Save Cosmetic 
Features command). 

• Each tie line must be a line, not a polyline (i.e. each tie line must comprise 
of exactly two nodes only). 

• Each end of a tie line must be snapped to a node on a separate object. 

Recommended procedure for creating tie lines:

1. Run the source dataset through the 3D Solid Generator (with and without 
the Structure Analysis option enabled) to visualise the solid output. In 
the 3D window, make this output DXF semi-transparent, and enable the 
wireframe view.

Enabling the wireframe view of a vector file

2. Examine in detail via the wireframe view the various vertex-vertex joins 
created by the 3D Solid Generator algorithm. 

3. Make the Cosmetic Layer editable, and set its line colour to red, with a 
weight of 3 points.
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Setting the line style of the tie lines in the Cosmetic Layer to stand out

4. Make the source object feature database selectable, and perhaps turn off 
the Fill appearance option for the source shapes to more clearly see their 
boundaries.

The polygon Fill tick box on the Feature Properties dialog (red circle) allows the fill 
of polygons to be disabled, allowing their boundaries to be more clearly visualised 
when a high density of polygons is involved.
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6. Rotate the 3D View to encompass the first two nodes (on adjacent 
objects) to be joined. 

8. Repeat steps 6 and 7 for the most prominent vertices.

9. Rerun the 3D Solid Generator, enabling the Tie Lines option and setting 
the Cosmetic Layer as the tie line dataset.

10. Re-examine the output, noting the effect the input tie lines have had on 
the resulting wireframe. If necessary, repeat steps 6-9, adding further tie 
lines to refine the output wireframe.

Output Options

The Output Options dialog controls the following components of the generated 
output solid and their display colour:

• Surface - this option is recommended to be enabled (default) as it creates 
the surface planes between joined vertices. 

• Edges - displays only the linework representing the joins between vertices

• Structure - shows the connections between objects (sections) used to 
interpolate the solid

• Diagnostics - contains duplicates of any erroneous/self-intersecting 
facets

An option to use RGB colours in the output DXF file is available. Note however 
that not all DXF-compatible programs can handle RGB colours within a DXF file.

5. Enable the Snap tool.

7. Enable the Create Line tool, and hover the cursor near the first node. 
When the snap beep sounds, click to snap to the point. Move the cursor to 
the second node, and double click when the snap beep sounds to snap to 
this node and finish the line.

The 3D Solid Generator can be kept open through this entire process. It will 
automatically refresh any changes to the updated source and tie line datasets 
when the Apply button is clicked. To manually refresh (at any time) the preview 
screen within the 3D Solid Generator, click the Refresh button.
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Enable the Dynamically update view option to update the 3D view during solid 
generation (once per facet).  

The Output Options dialog for the 3D Solid Generator utility.

Algorithm Options

The Algorithm Options dialog contains a number of advanced functions that can 
help to improve the quality of the output dxf shapes, particularly when applied in 
conjunction with Tie Lines.

The Algorithm Properties dialog for the 3D Solid generator utility.
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Structure Analysis

The Structure Analysis option will only join objects when there is some degree 
of overlap between the objects on a common plane (default option). Where no 
common plane exists, an averaged plane is calculated between the various object 
planes involved. 

Disabling this option allows the Solid Generator to search laterally (parallel to the 
common section plane) for objects to incorporate into the processing; this will, 
however, increase the processing time of the 3D Solid Generator. The images 
below illustrate this functionality. 

     
The effect of the Structure Analysis option. Figure 1: three parallel polygons, with the 
intermediate polygon substantially offset along the common plane. Figure 2: With Structure 
Analysis enabled, the intermediate shape is ignored in the solid generation process, as it 
does not overlap with the other two polygons. Figure 3: Disabling the Structure Analysis 
option allows the Solid Generator to find and utilise the intermediate shape.

The lateral search radius utilised (by disabling the Structure Analysis option) 
depends on a number of factors, primarily relating to the distance between the 
object planes. If disabling the Structure Analysis option fails to incorporate 
‘outlying’ objects into the final solid, you will need to create and apply Tie Lines to 
force the source objects to be joined in the required order.
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Shape Matching

The Shape Matching option will only be applied (if enabled) when the 3D Solid 
Generator detects two or more Tie Lines. It is recommended to always have this 
option enabled.

Shape matching is performed on 2D projections of the original objects. The 
algorithm constructs a warping transformation that makes the vertices of the 
projections corresponding to the tie lines’ ends coincide. This transformation 
affects all vertices by moving them closer to the points of exact match and 
improves the edge detection procedure.

Figure 1: A wire-framed solid dxf (green) created between three polygons without using tie 
lines. Note the poor correlation between peaks and troughs

Figure 2: Tie lines (red) created to control the join of major structures
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Figure 3: The output solid created using tie lines from the previous step, and Shape 
Matching disabled. There is a good correlation between peaks and troughs at tie line 
locations, but it is less robust between these locations.

Figure 4: The output solid with Shape Matching enabled and the tie line input from the 
previous steps. This displays an excellent correlation between peaks and troughs, and 
realistic surface creation elsewhere.

Compression

Applying compression to an object/shape database reduces the number of 
nodes/vertices utilised by the 3D Solid Generator. This can be useful for dealing 
with high density datasets (e.g. objects with 100’s or 1000’s of nodes/vertices) 
where each object is separated by relatively large distances (with respect to the 
distance between nodes in each object), which would result in very long and thin 
triangular facets being generated.
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This option should be used with caution, and only applied when the dataset meets 
the above criteria and processing is very slow and/or generates a large number 
of errors. Generally using a compression value of up to 5 is sufficient: a value of 
1 often solves most issues.

Once the 3D Solid Generator dialog has been configured press the Apply button 
to generate the output DXF solid/s. Depending on the number of Feature Objects 
involved, their complexity, and whether a Body ID Field has been specified, this 
may take some time. During processing, tie-lines indicating the drawing order 
between Feature Objects are displayed and eventually the DXF solid outlines are 
displayed in the preview screen. A new Vector branch is also displayed in The 
Workspace Tree populated with the output vector solid. (see 3D Vector Displays). 
Simultaneously, the Report screen at the bottom of the 3D Solid Generator dialog 
details the current processing and upon completion lists the output model centre, 
extents, dimensions, surface area and volume if appropriate. This report can be 
cleared at any time using the Clear Report button.

The 3D Solid Generator dialog can be kept open while changes are made to a 
Feature Dataset (see Features), allowing the shape of the input objects or tie lines 
to be refined prior to reprocessing.

Note Applying compression will naturally result in not all of the input object nodes 
being utilised in the output triangulation, possibly creating discrepancies 
between the output surfaces and the input shapes. Minimise the compression 
factor applied to reduce this problem.

Note A volume cannot be calculated for a solid created from a series of polylines, 
even if the end points of each polyline are coincidental. Volumes can only be 
created for solids created from a series of polygons.
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3D Extrusion Tool

It is often useful to have two dimensional map polygonal interpretations transfered 
to meaningful three dimensional displays when the objects can be associated 
with properties of height or volume. Polygonal objects drawn in a map may have 
an elevation, but with the addition of size or volume, a 3D display can be much 
more appealing, allowing visual comparisons between areas. For example, a 
geological map showing polygons of interpreted geology may be overlain over a 
topographic surface. However, a 3D representation of geology is more useful if 
thickness and volume could be displayed What if we could associate the volumes 
with physical properties such as density or magnetic susceptibility? The volumes 
could then be geophysically modelled.

The Extrusion Wizard allows you to extend (extrude) the shape of a 2D or 3D 
object (e.g. a polygon or polyline) from a base surface to a second or  upper/lower 
surface. This allows meaningful and useful visualisation of various bodies such 
as fault surfaces, mine shafts and workings, vein systems and  buildings in three 
dimensions.

The 3D Extrusion Wizard can operate on objects either within a 2D vector file or 
an open Feature Database. Height information can be specified from fields within 
the vector file/feature database or manually set by the user. The sides of the 
extruded shape can be created as polygonal walls that give the impression of an 
enclosed volume within the mapped outline of the 2D object.  For more 
information, see Using the Extrusion Wizard.

Note This tool requires an Encom Discover PA Professional licence. If you wish to 
purchase or evaluate this module, please contact Pitney Bowes Software.
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Example of extruded objects below a terrain surface.

Using the Extrusion Wizard

Step 1 – Load input data

Start the Extrusion Wizard from the Display Utilities menu.

An Enable sub-sampling of input data option is available; this can improve the 
quality of the output extrusion by inserting extra points along any straight edges 
of the source object.

 
 In the first dialog of the Extrusion Wizard that appears select an input file to use 
that contains polygonal outlines or polylines that are able to be displayed as 3D 
extruded volumes. To load a Vector file select the File option and then click on 
the Browse button to locate the file. 

To load a Feature Database that is already open in the current session of 
Encom Discover PA as the input data select the Feature Dataset option and 
then select from the drop down lists that appear a Feature Database and a 
corresponding Feature Set.
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Click Next to proceed to the next dialog of the Wizard.

Select the File or Feature dataset with 2D outlines of items to be extruded

Step 2 – Set Primary Surface Properties

The Base Z value of the objects to be extruded can be specified in one of three 
ways:

• Primary Z:  enter a fixed primary Z value to be applied to the objects to be 
extruded. Note that the elevation uses a positive up sense of height.

• Plus Field Value: use a Primary Z value from a field contained within the 
vector file or feature database for each map object to be extruded. For 
example, if geological units were to be used, these could be stored in the 
selected file with a data column called Vert_base or Thickness. The 
values are in metres and are added to any entry in the Primary Z field.

Note It is important to select a vector file or feature database that has suitable map 
object outlines such as polygons, closed polylines (eg. Contours) or regular 
objects such as rectangles, squares or circles. If the vector file of feature 
database contains point objects the 3D Extrusion Wizard can create three 
dimensional objects such as curtains or vertical bars using point data. 
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• Plus Grid Value: use a Primary Z value calculated from a surface grid for 
each map object to be extruded. For items that you wish to lie on top of a 
topographic surface, use this surface as the base height. The values are 
in metres. Check the Generate flat surface using centre grid line to use 
a constant grid value as the Primary Z value. Note that these values are 
added to any Primary Z and Field Value entries.

3D Extrusion Wizard Step 2 defines the base of the extruded object

You can apply a scaling or add field or grid values to the data values of the base. 
This is useful when attempting to match the elevations of other objects you may 
wish to import into your three dimensional views. The Scale factor is multiplicative 
such that a value of 2 doubles the offset height of the base of the object. To use 
field or grid Base Z values only leave Primary Z as 0.

The Generate Primary Surface option is turned on by default. This option 
creates a base for the extruded object. If this option is left unchecked the extruded 
object is left open at the base. Click Next to continue.

Step 3 – Set Extruded Surface Properties

The Extruded Z value (or upper surface value) of the objects to be extruded can 
be specified in one of three ways:

• Extruded Z: enter a fixed value of height to be applied to the objects to be 
extruded. Note that the elevation uses a positive up sense of height.
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• Plus Field Value: use an extruded Z value from a field contained within 
the MapInfo Professional table for each map object to be extruded. For 
example, if a geological depth below surface were to be used, these could 
be stored in the selected table with a data column called Dpth_to_Top or 
Depth. The values are in metres.

• Plus Grid Value: use an Extruded Z value calculated from a surface grid 
for each map object to be extruded. The values are in metres. Check the 
Generate flat surface using centre grid line to use a constant grid value 
as the Extruded Z value.

You can apply a scaling or add field or grid values to the data values of the 
Extruded surface. This is useful when attempting to match the elevations of other 
objects you may wish to import into your three dimensional views. The Scale 
factor is multiplicative such that a value of 2 doubles the offset height or depth of 
the base or top of the object. To use field or grid Extruded Z values only leave 
Extruded Z as 0.

The height of the upper surface can also be chosen Relative to primary (ie. an 
object height from bottom to top) or in Absolute terms such that the actual 
elevation of the top surface is defined.

The Generate Extruded Surface option is turned off by default. This option will 
create a top for the extruded object. If this option is left unchecked the extruded 
object will be open at the top. Click Next to continue.

Step 3 - Define the upper surface of the extruded objects
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Step 4 – Set Azimuth and Dip

Ticking the Specify an azimuth and dip option allows these parameters to be 
applied to the extruded objects. This allows faults and veins to be displayed in 
their correct structural orientations. Likewise buildings, shafts and pipelines can 
be visualised with a specified tilt angle.

Bearing and Inclination values can be specified either as fixed/constant values, 
or from appropriate fields in the object table.

 
Specify the azimuth and dip angles for volumes to be tilted

This feature is useful for fault definitions or block offsets of interpreted objects. By 
default the dip angle is 90 degrees (vertical). An angle of 0 degrees is horizontal.
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Step 5 – Set Grid Compression

Adjust the primary and extruded grid compressions in Step 5

Use the Grid Compression options available in the dialog for Step 5 of the 
extrusion wizard if a grid has been used in defining either the primary or extruded 
surfaces (in Steps 2 and 3). This will reduce the size of the output 3D model vector 
file.



28 Vector Utilities 1053

Step 6 – Set Appearance

The colour and appearance of individual extruded objects can be controlled by 
the following wizard screen.

Step 6 - Specify the surface properties of the extruded objects

Four options are provided to allow the colour of the objects to be controlled:

• From input - the individual objects obtain their colour from the default list 
of standard colours

• Fixed - all the created objects are of the same colour. Select the required 
colour from the pull-down palette.

• Cycle through standard DXF colours - apply colours from the 16 
standard colours provided for .DXF support 

• Modulated by Field - individual objects are coloured using the data value 
in the specified field and a selected look-up Colour table. A wide range of 
look-up tables is provided.

If the original data specified for extrusion is points rather than polygons, the point 
data can be extruded as Lines, Tubes, Square or Triangular prisms.

By default the Generate Sides option is ticked to create an enclosed object. 
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Step 7 – Default Layer

Specify a layer name association with the output data field

In the final screen, the extruded 3D DXF objects can be saved either: 

• To single layer within the output DXF file by selecting the Default Layer 
option; or

• If field is selected from the pull-down list, a separate layer will be created 
in the output DXF for each unique attribute in this field. It is also possible 
to Create a separate DXF file for each of these layers, resulting in an 
output DXF file for each unique attribute in the specified field.

• If the Finish button is clicked, the extruded objects are created in the 
defined DXF file(s) and added to the Discover PA 3D map window. The 
Extrusion Wizard is then exited.

• If the Apply button is clicked, the wizard creates the DXF file and 
automatically displays it in the Discover PA 3D map window but leaves the 
Extrusion Wizard operating. It also activates additional Apply buttons on 
each of the previous wizard screens. This allows the outputted extrusion 
to be modified by using the Back and Next buttons to make changes. To 
view changes click the Apply buttons. The objects are then updated in a 
3D map window.
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Step 8 – Choose Output File

The Output File screen allows the extruded shapes to be saved as a DXF vector 
file or feature dataset, and to generate a summary report:

• DXF/TKM Vector File Output

• Feature Dataset Output

• Generating a Report

DXF/TKM Vector File Output

Enabling the File option in Step 1 will create an output .DXF vector file utilising 
the same name and directory as the input file by default. These can be altered 
using the Browse button.

The output file can include Output RGB colours. However, not all  DXF 
compatible programs can handle RGB colours within a DXF file.

An option is also provided to generate a text report of each output 3D solid’s 
extents, surface area and volume (this only applies to extruded polygons). 
Pressing the Report button in this report screen allows the creation of this report 
as a .CSV file in the output file directory. Press Next to progress to Step 8 (only 
applicable for DXF output).

The Output File screen configured to generate a .DXF Vector file.
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Feature Dataset Output

Selecting the Feature Dataset option in Step 1 allows the extruded objects to be 
added to either a new or existing Feature Database. These can then be edited in 
3D using the feature editing tools (see Working with Features).

Either select a feature database already open in 3D from the pull down list, or 
create a new feature database using the new file button to the right.

By default, the extruded objects will Overwrite existing objects in an existing 
feature database. 

The Output File screen configured to generate the extruded objects in a feature database.

If the Finish button is clicked, the extruded objects are created in the defined 
feature database and added to the 3D map window. The Extrusion Wizard is then 
exited.

If the Apply button is clicked, the wizard creates the feature database and 
automatically displays it in the 3D map window but leaves the Extrusion Wizard 
operating. It also activates additional Apply buttons on each of the previous 
wizard screens. This allows the outputted extrusion to be modified by using the 
Back and Next buttons to make changes. To view changes click the Apply 
buttons. The objects are then updated in the 3D map window 
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Generating a Report

If the Generate a report on the volume of output bodies option is enabled a 
summary of the 3D model generated by the extrusion process will be created in 
a text file and automatically displayed in Notepad. The report summary provides 
information such as:

• The number of bodies

• Input polygon area of an extruded body

• Attributes from the input file, such as lithology, age, etc.

• 3D Model extents for each body (XYZ)

• Surface area of extruded body

• Volume  of extruded body

Example report generated from the Extrusion Wizard utility
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Topology Checker

Encom Discover PA can check the integrity of models imported from 3D vector 
files prior to import into a feature database or for modelling purposes in an 
external software package, such as Encom ModelVision. This is important if 
advanced feature object editing functionality is to be used on the model, such as 
the Combine, Intersect and Cut tools). These tools require a consistent method 
of ordering the vertices of every face and that all surfaces were closed. This is an 
essential requirement of any modelling software and any gaps or incorrectly 
defined faces in a model will lead to errors in the model computations. 

The Topology Check utility collates all faces and organises them into closed 
surfaces reporting any that break the rules. It can then correct some errors and 
export the intact surfaces as a new DXF file, import into a feature database or as 
individual polyhedron bodies in a TKM (Encom ModelVision format) file that can 
be imported into Encom ModelVision. If any surfaces are reported as not closed, 
the model must be closed in the software application that it originated from before 
using it in the Topology Checker. It has its own 3D visualiser with many features 
to identify and examine anything from the entire model right down to individual 
facets and their coordinates.

• Using the Topology Checker

• Topology Checker Controls

• Surface Options

• Global Options

• Rendering Options

• 3D View Controls

Using the Topology Checker

Generally the Topology Checker will only need to be run after errors have been 
detected during Importing Data Into a Feature Database (e.g. planar or volume 
surface) into a Feature Database or when attempting to model in Encom 
ModelVision. Errors in each surface will be indicated by the following Import 
Warning Report dialog, detailing which layers are unclosed, and which need their 
vertices reversed.
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Errors reported in the Import Warning Report dialog.

1. If you are intending using the Feature Editing tools on the model, press 
the Cancel Import button, and run the Topology Checker from the 
Display Utilities menu in the 3D interface.

2. Use the browse button at the top right of the dialog to select the source 
vector model file. The various layers comprising the model will be listed, 
and attributes detailed including whether they are closed, number of 
facets, volumes, areas, etc. 

3. The last Export column allows the user to select which of the model’s 
layers will be exported. By default all Closed layers will be enabled for 
export (i.e. unclosed layers will not be exported). This will therefore result 
in new vector file comprised solely of closed layers. Unclosed layers can 
be visualised in the preview area by enabling the Show Unclosed option, 
and setting an appropriate colour. 

4. Any layers requiring the Reversing of their vertex order will have this 
applied automatically when the output file is generated. 

5. Press the Save button to export the selected layers to a new vector file. 

6. Rerun the Feature Database Creation Wizard using this new vector file as 
the source file.
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Topology Checker Controls

The Topology Check option is accessed from the Display Utilities menu. The 
Topology Check dialog that appears consists of the following properties:

• Input File - Selects the model file to load into the Topology Check utility. 

• List View - The list view displays all surfaces for the input model. Right 
clicking on the list view will activate a context menu with various options 
on how to sort and select cells with the list view columns.

• Layer - Name of the layer in the input file of one is provided.

• Surface - The surface number.

• Show - Select/Unselect the tick box to show/hide the surface.

• # Facets - The number of facets in the mesh for the surface.

• Area - The Area of the surface.

• Volume - The volume of the surface.

• Closed - Green tick indicates that the surface closed. Blue tick 
indicates the surface is closed but has a negative volume. Red 
cross indicates that the surface is not closed. A surface is closed if 
all edges of the triangles in the surfaces mesh are shared by 
another triangle in the mesh.

• # Unclosed Edges - the number of edges that are not shared in the 
surface.

• Reverse – Indicates that the vertex order of the 3D faces for the 
selected layer is to be reversed. Press the Rev (displayed on the 
left) button to execute the reverse process for all enabled layers. 
Any layers requiring vertex reordering to facilitate use in Encom 
Discover PA will automatically have their vertex order reversed 
when the Save button is pressed.

• Export – Indicates whether the mesh for this surface should be 
added into the output file when saving.
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The Topology Check utility dialog 

Surface Options

• Properties - The properties button will open the “Surface Properties” 
dialog for the currently selected surface in the list view. This dialog 
displays a spreadsheet containing the X,Y, and Z coordinate for each 
vertex in each triangle for the surface. Triangles that are not closed, that 
is, have an edge that does not join another triangle are displayed in a 
different colour.

Global Options

• Define each layer in a separate mesh - This control will determine 
whether a defined layer in the input file should be defined in its own mesh 
or whether all layers should be defined in a single mesh. This is done on 
loading the input file.
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• Coincident Point Tolerance - Tolerance value that is used to improve the 
mesh by detecting coincident points and reassigning the triangles to use 
the first instance of any repeated point. Set this to -1 for the Topology 
Checker to automatically calculate this value.

• Advanced - The Advanced button will open the Advanced Options dialog. 
This dialog allows the user to specify the Body Density and Body 
Susceptibility values for the model. These are used when saving the 
model to a .TKM file for use in Encom ModelVision Pro.

Rendering Options

• Cull reverse facing - Turn on/off display of any back facing triangles.

• Wireframe - Turn on/off display of the wireframe mesh for the model. The 
colour of the wireframe mesh can be chosen by using the appropriate 
Set… button. 

• Show unclosed - If this option is turned on then the colour of any triangle 
faces that are not closed will be overrided with the set colour. The override 
colour can be set using the appropriate Set… button.

• Show selection bounding box - Turn on/off the bounding box for the 
model. The bounding box is defined for the currently selected surface in 
the list view.

• Show selection normals - Turn on/off the display of normals for the 
model. The normals are defined for the currently selected surface in the 
list view only. The size of the normals can be modified using the size slider 
control.

• Transparency - Turn on/off transparency for the model. The percentage 
of transparency can be modified using the appropriate slider control.

3D View Controls

• Fit view to window - Fits the view so that the entire model can be seen.

• Fit view to bounding box of selected surface - Fits the view so that the 
selected surface is the focus of the view.

• Advanced settings for the axes scale - Allows the user to apply 
individual scales to the X, Y and Z axes, as well as defining the position 
where the user wants the view to look at.



28 Vector Utilities 1063

• Zoom speed - Changes the speed at the which the user can zoom in/out 
to/from the model.

• Background colour - Sets the colour of the background window for the 
3D view.

Transform Vector File

The Transform Vector File utility can transform, reproject, and convert a wide 
range of vector file formats. The following input file formats are supported:

When converting between file formats (with or without transformation and/or 
reprojection), the following output vector file formats can be created:

3D Studio .3DS
AutoCAD .DXF 
Datamine wireframe (point and triangle) .DM
ER Mapper vector .ERV
ESRI shapefiles .SHP
ESRI TIN .ADF
Gemcom .BT2  
GOCAD vector .TS, .PL, .VS
Google Keyhole Markup Language .KML
GPS exchange .GPX
LizardTech MrSID .SID
MapInfo Professional .MIF
MapInfo Professional .TAB
Surpac string .STR
Surpac wireframe .DTM , .STR
Vulcan triangulation .00T

AutoCAD .DXF
CSV text file .CSV
Encom .TKM
ESRI shapefiles .SHP
GOCAD vector .TS
Google Keyhole Markup Language .KML
GPS exchange .GPX
MapInfo Professional .MIF
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The Transform Vector File dialog

A range of Transformation options are available as independent X, Y and Z 
operations, allowing vector objects to be scaled, offset and rotated. 

Transform options available are:

• Transform coordinates – enable the options button for Scale, offset and 
rotation settings. This is useful for converting feet units to metres or 
transforming from a local grid to UTM.

• Convert to 2D, viewed from – converts an appropriate 3D input Vector 
file into a 2D view. It can be viewed from each primary axis direction.

• Reproject coordinates – reprojection applied to coordinates. Note the 
from field is automatically populated with the first input file's projection if it 
found.

MapInfo Professional .TAB
Surpac string .STR
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• Name field – certain formats only support a single attribute or label field 
for the vector objects. If enabled, select the desired field for labelling the 
points.

• Elevation field – when converting form a 2D (i.e. TAB file) to a 3D file 
format (i.e. DXF), this field is enabled to define the elevation of the object. 
For example this could be populated by using Surfaces>Assign Grid 
Values from a DEM.

Other processing options include:

• Convert to point cloud – converts all nodes/vertices in the input vector 
object to individual point objects in the output vector file.

• Smooth polylines and polygons – applies a line smoothing filter, with a 
width defined over the nearest nodes.

• Correct polygon vertex order problems – checks the node order in all 
polygon objects. Outer parts will be stored clockwise and inner holes will 
be stored counter-clockwise.

• Compress polylines and polygons – removes any nodes with a spacing 
less than the defined distance.

• Convert closed polylines to polygons – converts any closed polyline 
objects to a polygon object. This is particularly useful for formats such as 
DXF which do not have a polygon object type, but do have closed polyline 
objects.

• Convert polylines with one point to point objects and polygons with 
two points to polylines – removes any erroneous objects.

Vector files can also be Reprojected to accommodate absolute coordinate 
handling in Discover 3D. For instance, if all of your MapInfo data is in a UTM 
projection, but an ore body DXF model from a CAD program is in a different 
projection, this option will enable the DXF to be reprojected into the same 
projection as the rest of the 3D data. Enable the Reproject Coordinates option, 
and set the appropriate Source and Target projections using the Choose 
buttons.

Note The projection list available in the Vector Import utility is stored in a separate file 
to the MapInfow.prj file. If you wish to reproject into a custom coordinate 
system which has been added to the MapInfow.prj file, then copy the custom 
projection line into the Encom.prj file located in the 
...\Program Files\Encom\Common\Projections folder.
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3DS tanker ship models transformed (offset, rotation and scaling) into a 3D session to 
illustrate the scale over a shipping channel dredging project.

To use the Transform Vector File tool:

1. Under Files, select the input file and output file names and locations.

2. If a different output file format is required, select the format from the 
Output format box.

3. To explicitly position, scale and/or rotate the input file, select the 
Transform coordinates option, and specify the appropriate parameters.

4. If converting into a 2D vector file format (e.g. a TAB), enable the Convert 
to 2D option, and specify the desired view direction of the output file 
(default view from the Top).

5. To reproject the input file, enable the Reproject coordinates option, and 
specify the input (From) and output (To) projections. See Coordinate 
Reprojection for more information.

6. A range of additional advanced transformation options (described above) 
are also available via the Other processing options button.
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Combine DXF Files

Combine DXF dialog

Click OK. In the following dialog choose a new file name and location for the 
combined .DXF file and click Save. The combined .DXF file is not automatically 
displayed in the Encom Discover PA map window. Use the Add Data>3D Vector 
(right click on the 3D Map branch in the Workspace Tree) menu option to display 
the combined .DXF data.

MapInfo TAB  to Geosoft GDB

MapInfo Professional .TAB file formats can be imported directly into Encom 
Discover PA but only if they contain data columns that record the location (Easting 
and Northing data fields). These two data fields are mandatory. Elevation data is 
optionally required if the imported data is to be displayed in 3D. 

Line information is also optional but required if the data are to be navigated using 
the line navigation facilities. The menu option File>Open>MapInfo TAB allows 
import of .TAB files.

The Combine DXF Files utility enables multiple 3D .DXF files to be combined to 
create a single 3D .DXF file.

If there are a number of 3D .DXF files that are generally opened together in 
Encom Discover PA, to save having to open each of them separately, a single 
3D .DXF can be created. The 3D .DXF files must be in the same directory prior 
to combining. In the Combine DXF dialog click on the Browse button and 
browse to the directory containing the 3D DXF files to be combined. Select all 
the DXF files to combine using the CTRL and SHIFT keys depending on whether 
they are consecutive in the file list.
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Conversion of a .TAB file into a Geosoft .GDB format database

An Open Folder dialog is displayed from the Browse button. Navigate the path 
to locate the required folder containing one or more .TAB files.

Once Encom Discover PA accesses the file, it displays a dialog to permit you to 
specify the Easting, Northing (mandatory) and optionally, the Z (elevation) and 
optionally a Line data field.

Dialog to specify the required and optional .TAB data fields as required

With a MapInfo Professional .TAB file accessed, Encom Discover PA can display 
the data using its available display objects that support the data available. For 
example, a .TAB file that does not have a Line definition could not be displayed 
in a profile display. However, if the .TAB data had located (X, Y) readings 
representing say a geochemical or gravity survey, they could be displayed as a 
Point display (refer to Points).

The imported data is stored in a native Geosoft .GDB database file. All data 
converted is as a single data channel in the .GDB database. If the data to be 
imported has no line identifier it is available as a points database. If however the 
data in the .TAB file has a Line data channel, select the Use Line option and 
specify the Line data channel.
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Geosoft GDB to MapInfo TAB

The Geosoft GDB to MapInfo TAB conversion utility enables you to convert data 
from a Geosoft Oasis montaj database to a MapInfo Professional table. 

The converted data is stored in native MapInfo Professional .TAB file format. 
When importing databases which contain multi-channel array data (such as 
Geotem or EM data) into a .TAB file, each array channel is imported as a single 
column. Since MapInfo Professional has a limit of 255 columns in a table, any 
Geosoft databases which contain more than 255 channels are truncated during 
import. In this situation you are warned that some data loss will occur.  

Importation of a Geosoft database to a MapInfo Professional .TAB file

To run the conversion:

1. Click the Open button and browse for the database file to import.  Geosoft 
databases have a .GDB file extension.

2. By default Encom Discover PA imports all lines in the Geosoft database; 
however you can opt to import only a subset of the lines from the database 
by clicking on the Select subset of lines button and selecting the 
required lines in the selection dialog.
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Select lines from Geosoft Database to import

4. Select the Open in map box to create points for the data and view the 
data in a map window or clear the box to import the data into a browser 
only.

5. Click OK to start the import process.

DXF to ModelVision TKM

A conversion utility to convert an AutoCAD .DXF to Encom ModelVision model file 
of type .TKM is available. For use and specification of the .TKM model file, refer 
to the ModelVision Reference Manual. This conversion is especially useful when 
using a created .DXF CAD file and requiring its geophysical response be 
computed within ModelVision .

To run the conversion:

1. The conversion utility requires only AutoCAD 3D solids to satisfactorily 
create an output file. The dialog appears as below:

3. Assign an appropriate MapInfo Professional projection for the imported 
data using the Choose Projection button.
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DXF conversion to ModelVision TKM model file

3. Specify the Output .TKM file to contain the ModelVision model file.

4. The ModelVision file requires physical properties to be assigned. These 
can be defined in the Body density (in g/cc) and Body susceptibility (in 
CGS units) entry fields. The values entered are relative to the Background 
properties specified.

5. Click the OK button to create the output .TKM file.

MapInfo TAB to Vulcan Archive

MapInfo Professional files can converted into Vulcan Archive ASCII format so 
they can be read directly into Vulcan.

MapInfo TAB to Vulcan utility

2. Specify the Input .DXF file. Use the Open button to navigate and specify 
the required file.
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1. Select the MapInfo Professional table to convert from the Input Table 
pull-down list.

3. Choose the Output type from the three available options: Labels Only, 
Points Only or Auto Select.

4. Select two attribute fields using the Name field and Value field pull-down 
lists.

5. Select a column to use for elevation from the Z field pull-down list. 
Alternatively, check the Use fixed Z value for all objects in the table or 
leave the “0” as default.

6. Coordinate Transform parameters can be entered for X, Y and Z values. 
This is particularly useful for converting data from world coordinates to 
local mine grid coordinates. Enter values to add, multiply or subtract from 
the existing coordinate values.

7. An ASCII file in Vulcan Archive format is then produced that can be read 
directly into Vulcan.

Vulcan Archive to MapInfo TAB

The Vulcan Archive Import tool enables you to convert Vulcan Archive ASCII files 
into MapInfo Professional tables. The data can either be imported as points 
representing each vertex in the string file, strings (polylines) or as closed strings 
(polygons).

Vulcan to MapInfo TAB utility

2. Use Open button to browse to a directory and assign a name for the 
Output file.
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2. Select the output .TAB file name by clicking on the Open button and 
selecting an appropriate location. By default the program will save the 
output file with the same name and in the same location as the source file.

3. Select the required object import method from the Create Object type pull 
down list. Two options are available:

• Points Only - will create points for each vertex in the string file. Use 
this option if you wish to import the string vertices only and preserve 
the original string file X, Y, Z coordinate information.

• Auto Select - creates either point or polyline objects depending on 
whether there are single or multiple line entries per block of data.

5. Set the Coordinate Transform options to apply a transform to the data 
during import if required. The transform options allow you to Add/
Subtract or Multiply the X, Y coordinates in the Vulcan Archive file by 
constant values during import. This is especially useful if you need to 
convert the data from local mine grid coordinates to world coordinates.

6. Click OK to commence the import process.

EM Plate Importer

Encom Discover PA provides a mechanism for importing the output from the 
MaxwellTM software, developed by Electromagnetic Imaging Technology (EMIT). 
Maxwell is a desktop application designed for the processing and interpretation 
of all forms of EM geophysical data: time-domain, frequency-domain, ground-
based, airborne, dB/dt and B field. The output from this software is a Maxwell EM 
modelled plate body in either ASCII table format or DXF format.

1. Select the Input Vulcan file by clicking on the Open button.

Note The X, Y coordinate values cannot be imported into the .TAB and the Z value will 
be an average of the vertex Z values for each string in the original file as MapInfo 
Professional does not support multiple vertex records per object in a browser.

4. Select an appropriate MapInfo projection for the data.

Note This tool requires an Encom Discover PA Professional licence. If you wish to 
purchase or evaluate this module, please contact Pitney Bowes Software.
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To display the table format in Encom Discover PA the EM Plate Importer utility 
must be utilised to convert the EM plate model to a format supported by Encom 
Discover PA. To import the EM plate data use the EM Plate Importer utility, this 
is accessed from the Vector menu.

The EM Plate Importer utility dialog.

Input Plates

The EM Plate table must be in comma delimited (.CSV) ASCII file format. 

Output

The output from the EM plate Importer utility is a Structured Graphics file (.EGB) 
which is native to Encom Discover PA. If the output location and file name is to be 
different to the input file press the Save As button and specify a new name and 
location.

To convert the plate model file press the Commence button.

The file is not automatically loaded into Encom Discover PA after it is generated 
so once the importing process has completed and the utility dialog appears 
similar to that shown below, press the Close button. 
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The Log view for the EM Plate Importer utility.

Then proceed to open the structured graphics .EGB file in Encom Discover PA in 
one of the following methods.

Drag and Drop

In Windows Explorer or the Explorer Window in Encom Discover PA, navigate to 
the file location as specified in the Output field of the EM Plate Importer utility.

Select the .EGB File and holding the left mouse button down drag the file into the 
display area of Encom Discover PA and release the mouse button. A prompt 
dialog similar to below will appear asking if you would like to display the .EGB file 
in a 2D Map or 3D display document.
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The drag and drop prompt dialog in Encom Discover PA.

Data Manager Window

An empty Data Manager window.

If not already visible in Encom Discover PA, open the Data Manager window by 
selecting Data Manager from the View menu.

Position the mouse cursor over the Graphics branch and press the right mouse 
button to view the pop-up menu and select the Structured>Open .EGB... option. 
The .EGB file will then appear in the Data Manager under the Structured Graphics 
branch.



28 Vector Utilities 1077

Opening a structured graphics file in the Data Manager window.

To open this in a 2D Map or 3D display document select the .EGB file in the Data 
Manager and, while holding the left mouse button, down drag the file into the 
display area of Encom Discover PA and release the mouse button. A prompt 
dialog similar to below will appear asking if you would like to display the .EGB file 
in a 2D Map or 3D display document.

The drag and drop prompt dialog in Encom Discover PA.
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To open the EM plate model in a section profile display refer to Section Profile EM 
Plate Model Display.

3D EM Plate Model Display

If the 3D option in the Drag and Drop dialog is selected, the plate model will 
appear in a new 3D display window, similar to the example shown below.

Example Maxwell plate model displayed in 3D as a structured graphic (.EGB).

For more information on editing the appearance of this structured graphic (.EGB) 
file refer to Located Images.

2D Map EM Plate Model Display

If the 2D option in the Drag and Drop dialog is selected a prompt dialog asking if 
you want to render the object using 3D in the 2D document will appear. If Yes 
selected, this option will apply lighting to the plate model as if being displayed in 
a 3D display.
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Example Maxwell plate model displayed in 2D with 3D rendering applied.

If No was selected for rendering the model in 3D, the plate model will appear in a 
new 2D Map window, similar to the example shown below.

Example Maxwell plate model displayed in 2D without 3D rendering applied.
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From the images shown above it will be obvious that the full plate models are 
displayed in 3D, including their dip and depth extent. To show only the top surface 
of the model at a particular elevation the Show intersection at RL "n" option 
must be enabled in the Display tab of the Images Properties dialog. 

Example Maxwell plate model displayed in 2D with both full plates and Intersection at 
900m RL applied.

The result of enabling this option will be that additional grey-coloured rectangles 
will appear in the map display representing the intersection of the plate bodies at 
900m elevation. Select OK to close the Properties dialog. 

To display only the intersections of the model at the specified elevation the full 
plates will need to be removed from the display. To do this, view the Properties 
dialog again and in the File tab first select the Intersection option from the drop-
down list for the Group and then select the Show button for the Group and move 
the Conductive Plates option to the Hide list so that only the Intersection group 
is in the Show list. Press OK on both dialogs.  
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Specifying only Intersection group to be displayed for a 2D map document.

Example Maxwell plate model intersection at 900m displayed in 2D document.

To adjust the colour fill of the plate model intersection (by default this is set as 
grey) press the Edit button for the Group object in the File tab dialog, which will 
display the Surface tab of the Group Properties dialog. Ensure that “User 
Colour” is selected for the Fill, then press the Fill (and Line) button next to 
Default fill and line colours to specify a fill colour. Press OK three times to apply 
this change to the map document.
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Specifying a fill and line colour for the plate intersection appearance.

To colour modulate the plate intersections by a field within the plate model file, 
e.g. Conductivity, view the Group Properties dialog again (press Edit button for 
Group) and then select Object modulated for the Fill option in the Surface tab 
dialog and select the desired field from the drop-down list for Modulation data 
field. Press OK twice to return to the map document.
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Specifying a field to colour modulate the plate intersections by.

A 2D map display of plate intersections which are colour modulated by the Conductivity 
field.

Section Profile EM Plate Model Display

To display a EM Plate model in a Profile display a Section Profile or Curve Profile 
display must be created first and must have a database associated with it for the 
purpose of displaying lines within the database.
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Once a Profile document is displayed to add the EM plate model as a .EGB file to 
this either "drag and drop" the EM plate model .EGB file from the Data Manager 
to the Profile display window or else right mouse click on the Profile 1 branch in 
the workspace tree and select Add Data>Located Image from the pop-up menu 
that appears.

An example Profile display and associated workspace tree is displayed below.

An example Profile display showing a curve (representing elevation) and the conductive 
plates of an EM plate model .EGB file.

The above image is a representation of the full plate models. To display only the 
point of intersection for the plates with the current line in the database view the 
Display tab of the Located Image Properties dialog and enable the Show 
intersection on section plane option. Press OK. 
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Display Properties for showing the intersection on section plane for a Profile display.

Then open the Located Image Properties dialog again and view the File tab. 
Ensure that the Section Intersection option is selected in the Group drop-down 
list and then press the Show button for the Group and move the Conductive 
Plates option to the Hide list so that only the Section Intersection group is in the 
Show list. Press OK on both dialogs.  

Specifying only Intersection group to be displayed for a profile display document.

To adjust the colour fill of the plate model intersection (by default this is set as 
grey) press the Edit button for the Group object in the File tab dialog, which will 
display the Surface tab of the Group Properties dialog. Ensure that User 
Colour is selected for the Fill, then press the Fill (and Line) button next to 
Default fill and line colours to specify a fill colour. Press OK three times to apply 
this change to the profile display document.
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Specifying a fill and line colour for the plate intersection appearance for a Profile display.

A profile display of plate intersections for a single survey line with a user specified line and 
fill colour.

To colour modulate the plate intersections by a field within the plate model file, 
e.g. Conductivity, view the Group Properties dialog again (press Edit button for 
Group) and then select Object modulated for the Fill option in the Surface tab 
dialog and select the desired field from the drop-down list for Modulation data 
field. Press OK twice to return to the profile display document.



28 Vector Utilities 1087

Specifying a field to colour modulate the plate section intersections by.

A profile display of plate intersections which are colour modulated by the Conductivity field.

To open the EM plate model in a 3D Display display refer to 3D EM Plate Model 
Display.

Or to open the EM plate model in a 2D Map display refer to 2D Map EM Plate 
Model Display.
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MapInfo MIF/TAB to ArcView SHP

MapInfo Professional .MIF or .TAB files can be converted to ArcView .SHP files 
using this utility. The .SHP file format contains only polygon, polyline or point data 
and is not by itself capable of retaining attribute data (such as line colouring, 
linestyles etc).

To run the conversion:

1. The dialog to convert a MapInfo Professional .MIF or .TAB file to an 
ArcView .SHP file is as below:

 

The MIF/TAB to .SHP conversion utility dialog.

3. Click the Convert button and nominate the file type to be output from the 
File Type pull-down list. Depending on the input type selected, you can 
convert the output to be either an ArcView .SHP or a MapInfo Professional 
.MIF or .TAB file.

4. The output data file is created once the OK button of the Open File dialog 
is clicked.

Gemcom BT2 to MapInfo TAB

The Gemcom .BT2 format is a 3D file format that can be directly loaded and 
displayed in Encom Discover PA using a 3D Vector object in the Workspace tree. 
There are also situations that require a .BT2 file to be displayed in a 2D Map and 
for this, it needs to be imported and seen as a 2D object. For this, a conversion 
to a Mapinfo Professional .TAB or .MIF file is performed.

Conversion of a .BT2 file to a .TAB or .MIF format is available from the BT2Import 
utility. The following dialog is displayed:

2. Specify the Input file. This file can be either a MapInfo Professional .MIF, 
.TAB or an ArcView .SHP file. Use the Open button to navigate and 
specify the file.
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Gemcom BT2 conversion utility to a Mapinfo Professional .TAB or .MIF file

To run the conversion:

3. Select the required object import method from the Create Object type pull 
down list. Two options are available:

• Points Only - create points for each vertex in the string file. Use 
this option to import the string vertices only and preserve the 
original string file X, Y, Z coordinate information.

• Auto Select - create either point or polyline objects depending on 
whether there are single or multiple line entries per block of data.

1. Select the Input file by clicking on the Open button

2. Select the output .TAB or .MIF file name by clicking on the  Open button 
and selecting an appropriate location and type. By default the conversion 
utility saves the Output file with the same name and in the same location 
as the source file.

Note The Z value will be an average of the vertex Z values for each string in the 
original file as MapInfo Professional .TAB format does not support multiple 
vertex records per object.
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5. Set the Coordinate Transform options to apply a transform to the data 
during import if required. The transform options allow you to Add/
Subtract or Multiply the X, Y coordinates in the .DXF file by constant 
values during import. This is especially useful if you need to convert the 
data from local mine grid coordinates to world coordinates.

6. Specify the Aspect between a Top, South or North view. Note that only the 
Top selection is appropriate for a 2D Map display. 

7. Click OK to commence the import process.

4. Select an appropriate projection for the data



29 Customising Encom Discover PA 1091

29 Customising Encom Discover PA 
Encom Discover PA allows the customisation of the user interface including:

• Toolbars

• Menu and toolbar command descriptions

• Keyboard shortcuts

• External application tools (using the Edit Menu Options tool).

To open the Customise dialog, select Tools>Customise or click on the down 
arrow located at the end of each toolbar.

The Customise dialog can be accessed by clicking on the arrow at the end of each toolbar

• Create and Customise Toolbars

• Keyboard Shortcuts

Create and Customise Toolbars

The Toolbars tab of the Customise dialog allows the creation of a new toolbar or 
customisation of an existing toolbar.

To create a new toolbar click the New button, enter a name for the toolbar and 
click OK. This creates a blank floating toolbar on the screen which can be docked 
in the menu area by clicking and dragging the toolbar. To add commands to a 
toolbar, highlight the toolbar in the Toolbar tab of the Customise dialog and, after 
selecting the Category that contains the command you wish to add, select the 
command from the Commands list and drag it to the toolbar where you wish to 
add it. 
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An example of a customised toolbar is shown below:

  
A toolbar can be customised to display frequently used commands

To remove a command from a toolbar, display the Customise dialog with the 
specific toolbar name highlighted in the Toolbars tab, and click and drag the 
command away from the toolbar and release it in the display window area.

  
To add a command to a toolbar, select the command to add and drag it to the desired 
toolbar
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Keyboard Shortcuts

The Customise dialog also allows a user to link existing Encom Discover PA 
menu commands with a keyboard shortcut. Some commands already contain 
built-in shortcuts, such as Print (CTRL+P). Additional shortcuts can also be set up 
for these menu commands using the Keyboard tab in the Customise dialog.

To add a keyboard shortcut:

1. Open the Customise dialog and select the Keyboard tab

2. Select a Category from the pull-down list and select a command from the 
list displayed.

3. Click the mouse cursor in the Click New Shortcut Key box and select the 
keyboard shortcut (use CTRL and SHIFT keys if desired).

4. Click the Assign button to complete the shortcut creation.

To remove a keyboard shortcut:

1. Select if from the Current Assignments box

2. Click the Remove button.

To remove all custom shortcuts:

• Click Reset All.

Keyboards shortcuts and setting the key strokes.
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A Encom Discover Integration
In this section:

• Integrating with Encom Discover

• 2D Map Displays

• Encom Discover Drillhole Data

• Displaying Sections From Discover in Encom Discover PA

Integrating with Encom Discover

Encom Discover PA can import and display data from the GIS software 
application Encom Discover

Encom Discover can be used to:

• Build geological datasets.

• Compile drillhole cross-sections and plans.

• Produce high-quality scaled maps, with geological symbols and linework.

• Create graphs with maintained spatial link.

• Create, manipulate, contour and profile gridded surfaces.

• Maintain and manage metadata for spatial databases.

Note Encom Discover is a desktop GIS designed especially for the geosciences, 
providing tools to effectively compile, visualise, analyse and map spatial 
geoscience data. Encom Discover runs as an extension to MapInfo Professional, 
the most widely-used desktop mapping system in the geoscience industry.
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Maps, sections and especially drillholes can be displayed in Encom Discover PA 
in 2D and 3D windows. Encom Discover can be used to create geological maps, 
geochemistry and present geoscience data in a variety of ways. In particular, 
Discover can import and manage drillhole data and using this, create interpretive 
sections. Map data, drillhole projects plus sections can be directly loaded into 
Encom Discover PA from Discover to provide an integrated approach to geology 
maps, geophysics and geochemical data. When presented in 3D displays, the 
integration of various data types plus the powerful 3 dimensional navigation 
capability of Encom Discover PA provides a tool for understanding your data 
better than with conventional 2D maps. 

2D Map Displays

2D Maps can be displayed in PA by dragging and dropping the TAB files into the 
PA window. Repeat this for each layer required.

Alternatively if Discover is installed, you can create a draped 3D view of the map 
winodw. Simply right click in a Map Window in Mapinfo-Discover, and select View 
in 3D. Create a file name by ticking Save Permanently. This will automatically 
open in the Discover3D window, and  you will also be able to drag and drop the 
saved EGB file into PA. 

Encom Discover Drillhole Data

Encom Discover has a fully featured drillhole display facility for managing drilling 
projects, displaying sections and maps and analyzing drillhole data. Refer to the 
Discover documentation for information on the import, use and display of these 
data types. For use in Encom Discover PA, a standard Encom Discover project 
must have three file types:

• Collar table – With hole ID, location, elevation, azimuth, dip and total 
drillhole depth.

• Survey table – Drillhole survey data with hole ID, survey position distance 
down the axis of the hole, azimuth, dip and computed, actual XYZ 
location.

• Data table – Data recorded in the drillhole. The hole ID, sample location 
and data channels are present. The data location can be in either Point 
reading or From-To sampling. 
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To access these in Encom Discover PA, select the 
File>Open>Downhole>Discover Downhole menu option. Navigate to the folder 
containing the Encom Discover project and open the three files corresponding to 
the Collar, Survey and Data types. Use the CTRL key to multiply select the 
required TAB files. 

Opening a Collar, Survey and Data .TAB files

The minimal required files are a Collar and Survey TAB file. You can open a 
number of data TAB files related to the drillholes defined by the Collar and Survey 
TAB files if required. Once read by Encom Discover PA, the Spreadsheet can be 
used to view the contents of the files (refer to Spreadsheets) for the various 
drillholes.

To assist in constructing an Encom Discover Drillhole Project and importing .CSV 
or Microsoft Excel data drillhole data files, refer to Encom Discover Drillhole Data.

With the drillholes and data available, both 2D and 3D maps can be used to 
display them. For information on adding drillholes to 2D and 3D maps and 
presenting them with data, refer to Adding Drillholes to a Display, Display of 
Drillholes in Maps, Drillhole Display Properties.

Displaying Sections From Discover in Encom 
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Discover PA

Encom Discover provides the ability to create interpreted geological sections. 
These sections often form part of Discover drillhole projects. Refer to the Discover 
documentation for details on creating sections. 

Displayed Discover sections can be transferred to Encom Discover PA for display 
using Located Images. The method used for this transfer is by Discover copying 
the section window contents to a Located Images plus a second file called an 
Encom Georeferenced Bitmap file (.EGB). The Located Image format is 
described in Appendix B: Data File Specifications. The content of the .EGB file 
allows Encom Discover PA to accurately position the four corners of the captured 
bitmap. 

To capture and locate an image section (or map) displayed with Discover, select 
the Drillholes>Import/Export>Export Located Image to Encom Discover PA 
menu option. When chosen, a dialog is presented to nominate the windows for 
export.

Discover menu item to capture a section for display in Encom Discover PA

You can choose to capture all the available section windows, only the selected 
section window and you can include a drillhole collar map to locate the holes. 
When accepted, you are prompted to specify a folder and filename for the .EGB 
file to be created.
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Follow these steps to display the located images in Encom Discover PA:

Step 1

Create a 3D Flight Path Map or 3D Grid Map using the File>New>Map>3D Grid 
Map or 3D Flight Path Map menu option (or from the appropriate buttons).

Step 2

With a Map plot created, select the Map branch of the Workspace tree and click 
the right mouse button. From the Add Data menu item, select Add Grid. This 
option creates a 3D map display as described in the About Three-Dimensional 
Displays. Manipulate the surface as required with suitable vertical exaggeration 
and offset. Note that the data values of the displayed grid determine the vertical 
position of your display and this is important later when displaying bitmaps with a 
different vertical location.

For example, if you wish to display a magnetic grid (with average data values of 
say, 55,000nT) combined with geological sections (with vertical reference of say 
1-200 metres) as shown above, then an offset is required to bring the two data 
objects into a similar vertical reference frame. Typically therefore, you would need 
to reduce the vertical location of the magnetic grid down by about 55,000. The 
steps following describe this procedure.

Step 3

Select the 3D Map branch of the Workspace tree and click right. Select the Add 
Data>Located Image option. An Images branch is added to the tree associated 
with the 3D Map. 

Step 4

Display the properties dialog of the added Images branch. Initially specify the path 
and Located Image created from Encom Discover. You can use the Browse 
button to navigate to the required .EGB file.
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Located Image properties dialog to specify the EGB file and display options

Step 5

If the displayed map surface and image are widely separated, their vertical offset 
may require adjustment. This can be done either by editing the vertical location in 
the .EGB file (to offset the located image), or by interactively setting an offset 
amount in the surface display control. To do this, display the Surfaces Properties 
dialog and highlight the Surface branch of the Grid Group tree. At the base of the 
dialog are controls to scale and offset the grid surface. Set this to an appropriate 
value by using the slider and increment entries.

Using the Surface dialog to control the Vertical scaling and offset of a grid image

If additional bitmap sections are to be displayed in the one 3D view, repeat steps 
3-4. An example of multiple located images displayed with a geophysical surface 
is shown below:
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Magnetics surface with multiple Located Image depth sections in a 3D display
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B Data File Specifications
In this section:

• ASEG-GDF2 Format Data

• ASCII XYZ Voxel Models

• Datamine Block Model File

• CEMI Model Format

• CSV (Comma Separated Variable) Files

• Decay Curve Ancilliary Data Files

• EGB Files – Located Image Descriptor Files

• ER Mapper Look-Up Files

• ETS Encom Tube Shape File Formats

• Gemcom Block Model

• Geosoft Oasis montaj Input Template

• GoCad TSURF Surfaces Definition

• Intrepid DDF Format

• Intrepid SuveyInfo File

• Micromine Block Model File

• Noddy Model Format

• SEG-2 Data Format

• Surfer Look-Up Tables

• Surpac Block Model File Format

• UBC Model File Formats

To view a full list of file types supported by Encom Discover PA, see Appendix E: 
Supported File Formats.
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ASEG-GDF2 Format Data

This ASCII data format uses a self-defining external data definition file (usually 
with filename extension of .DFN) to describe a separate ASCII data file. A .DFN 
appears as below:

DEFN   ST=RECD,RT=COMM;RT:A4;COMMENTS:A76
DEFN 0 ST=RECD,RT=;FLTLINE:A10:NAME=Line
DEFN 1 ST=RECD,RT=;X:F13.1:NULL=-1E30:NAME=X
DEFN 2 ST=RECD,RT=;Y:F13.1:NULL=-1E30:NAME=Y
DEFN 3 ST=RECD,RT=;MAG:F13.1:NULL=-1E30:NAME=MAG
DEFN 4 ST=RECD,RT=;GRAV:F13.5:NULL=-1E30:NAME=GRAV

The above .DFN file specifies data in its accompanying ASCII data file as follows:

1600     200.0    53800.0      56481.0     -0.01000
1600     220.0    53810.0      56479.5        -1E30
1600     240.0    53820.0      56478.4     -0.00300
1600     260.0    53830.0      56477.5     -0.00100
1600     280.0    53840.0      56477.0      0.00000
1600     300.0    53850.0      56476.8      0.00000
1600     320.0    53860.0      56476.7     -0.00100
1600     340.0    53870.0      56476.7     -0.00300
1600     360.0    53880.0      56476.7     -0.00500

A full format specification of the ASEG-GDF2 is available from www.aseg.org.au.

ASCII XYZ Voxel Models

This format is a simple text representation of a voxel model which allows data to 
be imported from and exported to other software packages. The file starts with a 
header line containing the names X Y Z followed by the names of the attributes. 
The format for each subsequent line is X Y Z Attribute1 Attribute2 Attribute3 etc… 
The X, Y, and Z coordinates are the centre positions of each cell, while the 
attributes are the numeric data values for each cell. The fields may be separated 
by either spaces or commas. Every cell in the rectangular prism model must be 
stored – even null cells. The mesh must be regular – i.e. cells widths, heights and 
depths are uniform across the model. The data should be stored row by row and 
plane by plane. (i.e. X is the fastest changing field, followed by Y, and then Z). 
Planes can be stored in either an upwards or downwards sequence.

http://www.aseg.org.au
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An example is repesented below:

X Y Z susceptibility

-287.5 -287.5 -387.5 0.00012721899972
-262.5 -287.5 -387.5 0.00010271179969
-237.5 -287.5 -387.5 9.764270362e-005
-212.5 -287.5 -387.5 7.809209637e-005
-187.5 -287.5 -387.5 4.203460048e-005
-162.5 -287.5 -387.5 2.547840086e-005
-137.5 -287.5 -387.5 2.742360084e-005
-112.5 -287.5 -387.5 2.435779397e-005
 -87.5 -287.5 -387.5 2.702029997e-005
 -62.5 -287.5 -387.5 2.904669964e-005

Datamine Block Model File

The Datamine block model file format uses a standard definition as specified in 
the table below.

Block Model File

Field Numeric/ 
Character

Implicit/ 
Explicit

Description

XMORIG 
YMORIG 
ZMORIG

N I (X,Y,Z) Origin of the model. DATAMINE 
sets the origin with respect to the corner 
of the first parent cell and NOT its 
centroid.

XINC 
YINC 
ZINC

N I/ E XYZ cell dimensions. If the model is not to 
contain any subcells then these three 
fields can be implicit (not stored on every 
record). This will reduce the storage 
space required by the model.

NX 
NY 
NZ

N I Number of model parent cells in XYZ. 
DATAMINE allows a value of one for 
modelling seams. The number of cells, in 
combination with the cell dimensions, 
defines the extent of the model.

XC 
YC 
ZC

N E (X,Y,Z) coordinates of the cell centre.
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In addition to the above, Block Model Files normally contain one or more value 
fields. Block Model files are normally sorted on increasing IJK values. 

CEMI Model Format

Voxel models used by the Consortium of EM Inversion (University of Utah) are 
similar in format to those of UBC. The CEMI format uses a separate header file 
to describe inverse model parameters. Separate values of the key parameters, 
are used to specify the required spatial and model properties. The key parameter 
begins with the "#" character in the first position of the line, and the values follow 
till the next "#" character. The example below includes the required parameters 
(dimensions and the steps in the X, Y, and Z directions). The values in the model 
file may be resistivity, density or magnetic susceptibility and so on. 

Example of MYMODEL.CEM header:

!CEMI Model Header - 27th Feb 2003 (Software Version 2.3) 
#xdim  
50 
#ydim
40 
#zdim
12 
#xcell          ! X cell widths 
50
#ycell          ! Y cell widths 
50
#zcell          ! Z cell widths (variable) 
50     50     100     100     100    100    100    100    100    100    
100    100
#invpar
    stg = 1:5; % List of stages to execute
    wordy = 2; % Messages: 0-silence, 2-very wordy
    mfit = 0.03; % level of fit in the inversion
    srcpar{1} = 1 % source parameters
sig0 = [1/305 1/283 1/452 1/461 1/607 1/452 1/556]; % conductivity of 
layers of the normal section

IJK N E Code generated and used by DATAMINE 
to uniquely identify each parent cell 
position within the model. Subcells that lie 
within the same parent cell will have the 
same IJK value.

Field Numeric/ 
Character

Implicit/ 
Explicit

Description
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hh0 = [100 200 200 100 100 200]; %  of layers of the normal section 
(m) 

an0 = [1 1 1 1 1 1 1]; % vector of background layer anisotropies
x = 1000:100:6500; % Cell center x-coordinates of the inverted 

area (m)
y = 3200:100:8100; % Cell center y-coordinates of the inverted 

area (m)
z = [25 75 150 250 350 450 550 650 750 850 950 1050]; % Cell center 

z-coordinates of the inverted area (m)
dz = [50 50 100 100 100 100 100 100 100 100 100 100];  % Vertical 

cell sizes (m)
iflag = 2 % Inversion flag: 1-Born 2DQA 3-QA
ma = 0 % A priori model
Nit = [50 20 10] % Number of iteration at each stage of focusing
uconst = 10000 % Upper constraint of anomalous conductivity
lconst = 0.001; % lower constraint of anomalous conductivity
Pfsteep = 0.01 % Parametric functional steepness
qalpha = 0.5 % Updating multiplier for regularization parameter
amlt = 0.1 % Updating multiplier for regularization parameter
qmlt = 0.95 % Updating multiplier for regularization parameter
keyq=0
KEYZ=1

#comment
iterstage=3
Conductivity

Example inversion results

The MYMODEL data file has the structure of a set of four columns defining an 
order of data in any line of X, Y, Z, Value 

  3.2000000e+003  1.0000000e+003  2.5000000e+001  3.0490700e+002 
  3.2000000e+003  1.1000000e+003  2.5000000e+001  3.0490700e+002 
  3.2000000e+003  1.2000000e+003  2.5000000e+001  3.0490700e+002 
  3.2000000e+003  1.3000000e+003  2.5000000e+001  3.0490700e+002 
  3.2000000e+003  1.4000000e+003  2.5000000e+001  3.0490700e+002 

Usually geographical coordinates are used consistent with the input inversion 
source data, but coordinates could be a local system, even rotated with respect 
to the geographical coordinates.
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CSV (Comma Separated Variable) Files

CSV files are primarily used as a transfer format for feature information. CSV 
format files can be imported and exported from Encom Discover PA and used with 
external programs such as Microsoft Access and Excel. The format has an ASCII 
structure with each data value being separated by a comma in variable width 
columns along individual records. Within the first record is a single data line that 
describes the column names assigned to the following data records.

An example of a geochemistry feature CSV file follows:

No,easting,northing,TiO2,MnO,Fe2O3T,Sc,V,Cr,Co,Ni,Cu,Zn,As,Rb,Sr,Ya,
Zr,Nb,Ba,W,Pb,Th,U
1A,-24383,-2766709,0.64,0.1,6.51,13,106,1309,27,251,39,59,15,58,33,2
1,309,14,224,8,5,9,0
2A,-24534,-2767684,0.77,0.1,9.28,20,156,1457,26,354,52,69,11,78,30,2
5,289,14,214,5,4,8,0
3A,-24189,-2768548,0.75,0.1,6.32,14,112,820,24,115,37,47,3,68,28,23,
393,15,182,7,5,12,0
4A,-24257,-2769464,1,0.16,9.4,22,179,635,33,172,69,72,7,91,45,36,304
,16,330,5,8,12,0
5A,-24552,-2770545,0.56,0.08,4.22,8,79,499,19,81,28,49,7,62,37,21,26
9,13,222,6,0,10,0
6A,-24488,-2771405,0.54,0.13,7.15,15,115,4237,54,594,25,66,0,27,39,1
4,293,12,125,7,0,7,0
7A,-24551,-2772608,0.53,0.05,3.51,5,60,521,15,63,20,38,9,34,43,18,30
7,13,111,6,0,11,0
8A,-24639,-2773850,0.52,0.05,3.32,5,54,516,15,60,20,38,11,33,43,19,3
21,13,104,7,2,12,0
9A,-24370,-2774385,0.8,0.14,7.53,15,134,1118,33,220,49,62,13,92,39,2
8,340,16,283,6,4,11,0
10A,-24744,-2775614,0.9,0.22,10.54,22,167,6695,64,786,49,80,0,84,28,
25,361,16,314,7,7,10,0

Within Excel, the same data appears as:

Example of CSV file imported directly into Excel
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For drillhole .CSV files, refer to Importing Drillhole Data.

Decay Curve Ancilliary Data Files

Data used in Encom Discover PA that is derived from banded databases (such 
as Intrepid and Oasis montajTM), uses an external ASCII data file (usually called 
ATEM.TXT). This file is used to define the EM system geometry, transmitted 
waveforms and units used. Each set of entries is arranged relative to flights and 
provides for different calibration or waveforms associated with each.

An example of an ancilliary data file is provided here.

--------------------------------
Begin survey

XChannelCenter[18] = {78.0625, 103.3875, 128.7125, 154.0375, 
228.7499, 341.450, 454.15, 566.85, 735.90, 1017.76, 1412.10, 1919.25, 
2539.1, 3271.65, 4116.9, 5074.85, 6145.5, 7328.85} # microSeconds.
End survey
--------------------------------

Begin survey

ZChannelCenter[20] = {468.7500, 781.2500,1093.7500, 1406.2500, 
4609.3750, 
4765.6250, 4921.8750, 5156.2500, 5468.7500, 
5859.3750, 6328.1250, 6875.0000, 7578.1250, 
8437.5000, 9453.1250, 10625.0000, 12031.2500, 
13750.0000, 15937.5000, 18593.7500} # microSeconds.

ZChannelWidth[20] = {312.5000, 312.5000, 312.5000, 312.5000, 
156.2500, 156.2500, 
156.2500, 312.5000, 312.5000, 468.7500, 
468.7500, 625.0000, 781.2500, 937.5000, 
1093.7500, 1250.0000, 1562.5000, 1875.0000, 
2500.0000, 2812.5000} # microSeconds.

XWaveform[128] = {27560, 1208839, 1748987,
1696193, 1612784, 1507101, 1380841, 1236006, 
1075005, 900210, 714267, 520125, 320526, 
118576, -82920, -280937, -472693, -655550, 
-826972, -984723, -1126681, -1251043, 
-1356134, -1440744, -1503772, -1544610, 
-1561507, -804875, 31103, -13322, -11322, 
-9755, -8565, -7617, -6873, -6172, -5558, 
-5154, -4683, -4323, -3976, -3722, -3444, 
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-3193, -2988, -2799, -2626, -2450, -2344, 
-2171, -2098, -1995, -1871, -1759, -1691, 
-1663, -1551, -1464, -1372, -1372, -1277, 
-1249, -1145, -1123, -1084, -1075, -994, 
-967, -901, -896, -830, -856, -766, -766, 
-775, -735, -701, -679, -688, -687, -649, 
-617, -590, -594, -592, -590, -571, -534, 
-546, -492, -520, -511, -485, -464, -444, 
-448, -427, -413, -444, -428, -411, -417, 
-399, -382, -369, -344, -383, -371, -344, 
-369, -335, -325, -327, -334, -318, -302, 
-305, -344, -307, -304, -278, -279, -279, 
-291, -277, -287, -252, -261} # microVolts

ZWaveform[128] = {27627, 1079321, 1603609,
1568275, 1492445, 1395440, 1279329, 1145986, 
997693, 836572, 665098, 485927, 301680, 
115151, -71116, -254151, -431492, -600741, 
-759477, -905659, -1037269, -1152628, 
-1250328, -1329052, -1387937, -1426296, 
-1441915, -763195, 6733, -12169, -10708, 
-9269, -8131, -7180, -6431, -5780, -5211, 
-4748, -4364, -3972, -3676, -3390, -3122, 
-2898, -2719, -2528, -2363, -2210, -2062, 
-1947, -1862, -1719, -1609, -1556, -1481, 
-1357, -1368, -1261, -1174, -1162, -1091, 
-1045, -1021, -983, -921, -904, -848, -842, 
-815, -762, -765, -702, -693, -683, -632, 
-650, -610, -581, -603, -576, -539, -545, 
-552, -496, -505, -504, -506, -447, -489, 
-444, -436, -447, -398, -403, -396, -386, 
-378, -376, -375, -355, -349, -364, -327, 
-319, -334, -317, -351, -295, -277, -309, 
-297, -276, -275, -286, -274, -269, -258, 
-290, -232, -279, -264, -250, -253, -251, 
-239, -241, -215, -255} # microVolts

End survey
-------------------------------------------
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EGB Files – Located Image Descriptor Files

These ASCII files are used to define the extent, location and geographical 
projection of Located Images to be used for display within Encom Discover PA. 
The image formats available for display include BMPs, TIFs, PNGs, JPGs. The 
files can be derived from any other application and may be created directly by the 
application or by a screen capture program. Any colour depth and resolution is 
suitable.

EGB Located Image Header File

Information is defined at various levels of scope. The highest level of scope is file 
scope where information tags are defined outside of any block structures.

Comments can be defined at file scope. A comment must be preceded by one or 
more of the following characters ~!#*/\.

If a GeoreferenceImage block is defined outside of a GeoreferenceImageGroup 
block then a group will be created to house the object.

The Include command allows you to include other EGB files and so access the 
definitions in those files. For example, to build a forest of trees you may have 10 
different tree species each defined in separate EGB files. These can be included 
in the EGB file that defines the forest group and objects. Note that the image ID 
and object ID tags in all included files have to be unique. If not an error will be 
generated. 

The ImageDefinition block can contain any of the following information tags.

ID                = STRING // New format
Image             = STRING
ImageFormat       = <Identifier>
TransparentColour = <Identifier>,INT
ImageStretch      = <Identifier>,<Identifier>
ImageDimension    = <Identifier>,REAL,REAL

Note that the ID cannot be specified in the old format. Also, the Image tag must 
be ought to be specified prior to all other image tags in the old format. If you want 
to include any of the image processing tags in the old format then either the Image 
or ImageFormat tags must be specified first.

The ID is a unique identifier that you will use to refer to this image in object 
definitions. If it is not specified then a unique identifier will be generated. If the ID 
is not unique the system will report an error.
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The Image is the filename of the image. The image file name can be a local, 
relative or complete path name. If it is relative it will be relative to the location of 
the EGB file. If no image file is specified one will be constructed from the EGB file 
path and name and the image format. The following examples are all valid – 

C:\TEMP\TEST.EGB
“”                         (c:\temp\test.bmp)
Picture.bmp                (c:\temp\picture.bmp)
\IP\Picture.bmp            (c:\temp\ip\picture.bmp)
\IP\                       (c:\temp\ip\temp.bmp)
c:\program files\ip\picture.bmp  (c:\program files\ip\picture.bmp)

The ImageFormat specifies the file format of the image. The following image 
formats are supported. Use the text enumeration to identify the format.

Windows Bitmap             BMP or BITMAP
Jpeg                       JPG or JPEG
Portable Network Graphics  PNG
TIFF                       TIFF or TIF
GIF                        GIF
GeoTiff (located)          GEOTIFF or GEOTIF
TAB (raster located)       TAB

The TransparentColour defines a colour (or colour range) that will be considered 
fully transparent. When the image is rendered any pixels with a matching colour 
will not be displayed. The first variable – Defined/Undefined - activates the 
transparent colour. The second variable specifies the colour. You can use the 
identifiers WHITE and BLACK or specify a TBGR colour as a 4 byte integer.

In 2D and in 3D the image needs to be stretched onto the target geometry. In 2D 
this requires only one operation. In 3D it requires two operations – stretch then 
interpolation. The ImageStretch command specifies the 2D/3D stretch mode and 
the 3D interpolation mode. The stretch mode can be either – 

BLACKONWHITE or PRESERVE_BLACK
WHITEONBLACK or PRESERVE_WHITE
COLORONCOLOR or PRESERVE_COLOUR
HALFTONE or HIGH_QUALITY

In 2D, HALFTONE is usually the best choice as it interpolates smoothly.

The interpolation mode (3D only) can be either:

NONE or COPY
LINEAR or SMOOTH
MIPMAP or HIGH_QUALITY
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Which mode is best varies widely and may require some experimentation. In 
general, the quality of the image improves from NONE to MIPMAP. But that rule 
is not hard and fast – in some cases it degrades the image appearance. Also, 
graphics card drivers still contain bugs of a very basic nature. A computer’s  
graphics card may not render the image correctly in one or more of the stretch 
modes. Often this is related to the size of the image as well.

The ImageDimension command can be used to specify a size for the image. For 
example, if the image is a tillable texture of some bricks you can specify the size 
of the image coverage in meters. This information is used to compute texture 
coordinates and tile textures at an appropriate resolution.  The following 
identifiers are valid: 

UNDEFINED
LOCAL
WORLD

If LOCAL or WORLD are defined, they ought to be followed by the width and 
height of the image in either local coordinates or world coordinates. Note that only 
local coordinates are currently supported.

The ObjectDefinition block can contain any of the following tags:

ID                   = STRING
ImageID              = STRING
Geometry             = <Identifier>
DimensionX           = <Identifer>
DimensionY           = <Identifer>
ImageWrap            = <Identifier>
ClipToImage          = <Identifier>
SurfaceFragmentStyle = <Identifer>
SurfaceColourMode    = <Identifer>,<Identifer>
SurfaceColourField   = STRING

It can also contain the following block definitions:

Registration Begin   // Identical in new and old format
Registration End
SubObject Begin      // New format only
SubObject End

The ID is a unique identifier that you will use to refer to this definition in other 
object definitions and objects. If it is not specified, a unique identifier is generated. 
If the ID is not unique the system reports an error.
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Each ObjectDefinition comes in one of two types – a mesh definition or a root 
object definition. A mesh definition is an end-node and includes a Registration 
block to define the mesh geometry. A root node contains one or more SubObject 
blocks which contain references to other definitions. It does not contain a 
Registration block, Geometry, ImageID, ImageWrap, SurfaceSource or 
DimensionX/Y tags.

The ImageID refers to an ID from an ImageDefinition block. It specifies the image 
is textured onto the mesh geometry.

The Geometry specifies what type of mesh is defined. It has the following types – 

QUAD
QUAD_STRIP_H
QUAD_STRIP_V
TRIANGLE_MESH

A QUAD is defined by four coordinates in space located at the corners of the 
surface. It need not be planar.

A QUAD_STRIP is a strip of QUADs and it can either be defined in a horizontal 
or vertical orientation. This orientation is not implicit in the geometry – it is actually 
a rotation of the image.

A triangle mesh is a collection of vertices in space from which a surface is defined 
by connecting vertices into many triangles. Generally, no two triangles should 
overlap. The surface described can have holes and islands and can be either 
closed or open or comprised of multiple patches.
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 Mesh definition diagrams

The DimensionX and DimensionY commands are used to specify the default 
horizontal and vertical dimensions of the mesh. Valid settings for these 
commands are X, Y or Z. If these settings are not defined then a default setting 
will be computed from the input registration points.

These settings are overridden in many cases. In all 3D graphs and in 2D maps 
and 2D profiles and sections they are always reset to X/Y. If a triangulation is 
constructed from a grid then X/Y is always used.
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In a 2D graph these settings are used to control which dimension is horizontal 
coordinates and which is vertical.

The ImageWrap command controls texture tiling. The usual mode is CLAMP 
which means only texture coordinates between 0-1 are valid. It can also be 
REPEAT which tiles the texture and in this case any texture coordinate is valid.

The Surface… commands have the same syntax as the same commands defined 
for an object group. The only exception is that at this level of scope you do not 
specify any override options. These settings are the default surface colour 
settings that will be applied for the mesh if it is not overridden by the group 
properties. These surface settings need not be defined and appropriate defaults 
are assigned. 

The ClipToImage option can take the values NONE, CLIP, FORCED_CLIP. If 
clipping is defined then the surface is clipped to fit the image.

The Registration block is where the coordinates and structure of the mesh for the 
object definition are specified. All commands in the Registration block are 
common to both the old format and the new. Within this block you need to define 
the mesh vertex coordinates, the mesh structure and the image extents which will 
be converted to texture coordinates. There is plethora of ways to do this.

The texture coordinates of the image range from 0 to 1 in X and Y and the origin 
(0,0) is in the bottom left corner of the image. The process of rendering the image 
onto the surface is called texture mapping. Generally, the image is texture 
mapped onto the surface without distortion and so it is sufficient to supply the 
coordinates in space of the corners of the image. In this scenario the texture 
coordinates will be automatically generated. Alternatively you can specify all the 
texture coordinates. This will be necessary if the surface is closed or if you wish 
to warp the image across the vertices.

Firstly the extents of the image in world coordinates can be specified using the 
following commands. X and Y coordinates are required, Z coordinates are 
optional. If specified, these coordinates are all that is required to correctly locate 
an image on a surface. If these parameters are not supplied the EGB texture 
coordinates will be generated either by reading them explicitly from the EGB file 
or by assuming the texture fits perfectly to the extents of the surface. This is 
usually a valid assumption for QUAD and QUAD_STRIP… geometries but for 
TRIANGLE_MESH geometries it will usually be necessary to specify the Bitmap 
extents as described above.

BitmapOrigin       = x,y,(z)
BitmapExtremity    = x,y,(z)
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To define a QUAD surface specify the four corner coordinates as XYZ with the 
following information tags. Note that if one optional parameter is supplied then all 
must be supplied. However, if you leave and empty data tag it will be ignored – 
eg ,,,.The texture coordinates (tx,ty) generally range from 0-1 but they can exceed 
this. In this case the texture may be clamped or repeated. The colour is recorded 
for each vertex and is specified as a TTBBGGRR value. Alternatively you can 
specify a colour for the entire face using the Colour command.

TopLeft        = x,y,(z),(tx),(ty),(colour)
TopRight       = x,y,(z),(tx),(ty),(colour)
BottomLeft     = x,y,(z),(tx),(ty),(colour)
BottomRight    = x,y,(z),(tx),(ty),(colour)
Colour         = colour

To define a QUAD_STRIP_H surface specify the upper and lower coordinates of 
the strip using the following information tags. Note that the number of upper and 
lower vertices must match.

TopVertex      = x,y,(z),(tx),(ty),(colour)
BottomVertex   = x,y,(z),(tx),(ty),(colour)
Colour         = colour

To define a QUAD_STRIP_V surface specify the left and right coordinates of the 
strip using the following information tags. Note that the number of left and right 
vertices must match.

LeftVertex     = x,y,(z),(tx),(ty),(colour)
RightVertex    = x,y,(z),(tx),(ty),(colour)
Colour         = colour

To define a TRIANGLE_MESH surface specify the vertices of the mesh and then 
specify the optional triangle definitions in an anticlockwise fashion. Each triangle 
is defined by three vertex indices. The vertices are indexed from zero in the order 
in which they are defined in the file. If no triangle definitions are supplied then the 
vertices will be triangulated automatically. Again, colour can be defined for each 
vertex and for each face.

Vertex         = x,y,(z),(tx),(ty),(colour)
Triangle       = vertex0,vertex1,vertex2,(colour)

The old format defined a GeometrySource block within the Registration block 
within which you could specify additional source information for triangle meshes. 
This block is no longer supported but it will be read and parsed without error.

GeometrySource Begin
 …
GeometrySource End 
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The following commands are recognised.

GeometryFormat    = <Identifier>
GeometryFile      = STRING
GridBand          = INT
ClipTriangulation = <Identifier>,REAL,(<Identifier>),(<Identifer>)
GridCompressionMode     = <Identifier>
GridCompressionConstant = <Identifier>,INT,INT
GridCompressionVariable = <Identifer>
GridVertexTableBands    = INT,…

The following commands are also recognised for backward compatibility but are 
now obsolete.

GridName         = STRING
GridCompression  = INT (0 – 100 variable compression value)
GridClipOption   = INT (0/1/2 = Complete/Partial/None) 

The current options for GeometryFormat are:

GRID 
ARC_TIN or ESRI_TIN
DXF
GOCAD
GEMCOM
TKM or MODELVISION

These specify that the triangle mesh will be constructed from a raster grid file, an 
ESRI TIN file(s), a 3D DXF file, a GoCAD TSurf or GEMCOM BT2 file. In all cases 
you need to specify the source file name using the GeometryFile command. 
Specify the grid band (if the input grid is multi-banded) as a zero based integer.

The ClipTriangulation command is only valid if you have defined a set of mesh 
vertices but have not specified any triangulation. In this case a convex hull 
delauney triangulation of the vertices will be generated. The clipping option 
removes long thin triangles which may have been generated on the edges and in 
holes. Use the identifier Defined or Undefined to turn the option on or off. If turned 
on, then specify the length to height ratio of clipped triangles. Optionally specify 
EDGEONLY to only clip triangles on the edge and/or RECURSIVE to continue 
clipping until all thin triangles have been removed.

The grid compression options allow you to decimate or compress the input grid to 
reduce the size of the triangulation. This may be necessary to improve rendering 
performance or reduce memory consumption. GridCompressionMode can have 
the following values.
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NONE
CONSTANT
VARIABLE

CONSTANT will decimate the grid by a factor specified with the 
GridCompressionConstant command. VARIABLE will apply a variable 
compression technique that attempts to minimise the size of the triangulation 
whilst retaining surface detail. 

GridCompressionConstant is used to specify decimation parameters. It has the 
value of SYSTEM, USER or STEP. SYSTEM and USER choose and X and Y 
decimation factor so that the grid is no larger than a specified size in rows and 
columns. In the case of first the size is specified by the system and no further 
parameters are required. In the latter case you can specify the maximum size and 
the columns and rows ought to be included. The final option, STEP, decimates 
the grid using the X and Y step supplied. A factor of 1 indicates every node is 
used.

GridCompressionVariable is used to specify the variable compression 
parameters. Specify the compression factor from 0 – 100 (low to high 
compression). A minimum of 30 is recommended. Then specify one of three 
optional clipping options – COMPLETE, PARTIAL or NONE. If you specify 
COMPLETE then you get a well clipped grid that matches the input grid. However, 
this algorithm does fail on some grids. If so, use the PARTIAL option. The grid 
should still be well clipped. If you use NONE then all holes will be filled and the 
grid will be a convex hull of the input nodes.

The grid can be used as a source of field data for the vertex table and any number 
of bands can be loaded using the GridVertexTableBands command. Specify one 
or more zero based band numbers.

The block can also contain ancillary data tables at four levels of scope - Mesh, 
Surface, Face and Vertex (a fifth data table can be declared for Objects at group 
scope). These all have the same structure and are declared in the following way – 

MeshTable Begin
  FieldDefinition Begin
    Field = STRING,<Identifier>,<NULL>,REAL
  FieldDefinition End
  DataDefinition Begin
    Data = <Data>,…
  DataDefinition End
MeshTable End
SurfaceTable Begin/End
FaceTable Begin/End,
VertexTable Begin/End
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You can declare an unlimited number of fields for each table. Each field definition 
must include the field name. It may also include the field data type, a NULL value 
and a unit conversion value (which converts from field to SI units). The field data 
type can have any of the following values.

BYTE USINT1      (= Unsigned 1 byte integer )
CHAR INT1        (= Signed 1 byte integer )
USINT2           (= Unsigned 2 byte integer )
SHORT INT2       (= Signed 2 byte integer )
USINT4 DWORD     (= Unsigned 4 byte integer )
LONG INT INT4    (= Signed 4 byte integer )
FLOAT REAL REAL4 (= 4 byte real   )
DOUBLE REAL8     (= 8 byte real   )
STRING MEMO      (= String   )

The data is defined in one or more Data lines. A value is expected for each 
declared field. A data line is expected for each vertex/face/surface/mesh/object. 

The SubObject block will generally only be defined in the object definition if it is 
not defining a mesh. In this case the object definition is a container for one or 
more other object definitions each of which is stored in a SubObject block. The 
only other information in the block is the transformation parameters for the object 
definition referred to.

ObjectID   = STRING
Translate  = REAL,REAL,REAL
Scale      = REAL,REAL,REAL
Rotate = <Identifier>,<REAL,REAL,REAL>/REAL,<Identifer>,<Identifer>
Transform = REAL,REAL,REAL,REAL,REAL,REAL,REAL,REAL,REAL,REAL,REAL,
REAL,REAL,REAL,REAL,REAL

The ObjectID is a predefined object definition ID. 

The transformation that is computed for the object is defined by zero or more 
Translate, Scale or Rotate commands. The order in which these are specified in 
the file is important. They are applied in last to first order. The Transform 
command data can be specified on a single line or broken up into multiple lines.

The Translate and Scale commands require X, Y and Z translation and scale 
factors. The Transform command requires the specification of a complete 4x4 
matrix in row then column order.
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The rotate command first requires the rotation axis to be specified. This can be 
defined as X, Y, Z or GENERAL.  In the latter case you should then supply a 
vector for the rotation axis. You should then supply the rotation angle. By default 
the angle is specified in radians. If you append a DEGREES or DEG or RADIANS 
or RAD identifier after the angle you can specify the exact units of the angle. You 
can also specify the angle is CLOCKWISE or ANTICLOCKWISE.

The ObjectGroup block can contain any of the following commands:

Name                 = STRING
ReferenceDTM         = <Identifier>,STRING,INT,REAL,<Identifer>,…
Lighting             = <Identifier>
SurfaceFragmentStyle = <Identifer>
SurfaceColourMode    = <Identifer>,<Identifer>,<Identifier>
SurfaceColourField   = STRING
DisplayList          = <Identifier>
ColourMapping        = <Identifier>,<Identifier>,REAL,REAL

Also supported are the following image definition commands are also valid in 
groups:

TransparentColour    = <Identifier>,INT
ImageStretch         = <Identifier>,<Identifier>  

The ReferenceDTM command is used to specify a DEM grid which can be used 
to shift the Z coordinates of all objects in the group. For example, a forest group 
may define a large number of trees in a landscape. The Z coordinates of the trees 
can then be automatically determined by the system by reference to the DEM 
grid. Specify DEFINED or UNDEFINED to turn the feature on or off. Specify the 
grid file name and the zero based band number. Also specify a scaling factor 
where a value of 1 indicates no scaling. You can use this to scale a DEM without 
scaling the objects in the DEM. You can then specify a number of flags.

PER_OBJECT
PER_VERTEX

This is the rate at which the DEM offset is applied. It can be applied to every vertex 
individually or it can be applied to the centre of the object.

HORIZONTAL
VERTICAL
MULTI_COMPONENT
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This is one of the flags which affect the way the offset is applied to the Z 
coordinate. If the object is HORIZONTAL the Z coordinate is replaced by the DEM 
Z coordinate. If the object is VERTICAL the Z coordinate is added to the DEM Z 
coordinate. If it is MULTI_COMPONENT there may be a mix of different mesh 
types but you are indicating that you want the integrity of the structure of the 
object to remain.

SIT
CENTRE
HANG

These flags position the object either above the DEM, on the DEM or below the 
DEM. For example a tree or a house will sit on the DEM, a road will straddle the 
DEM and a CDI section will hang from the DEM.

Lighting is a surface property and not all lighting modes are compatible will all 
surface properties.  You can specify NONE, PER_FACE or PER_VERTEX. 
Generally you ought to ensure that colour modulation of the surface is at the same 
scope as the lighting.

The SurfaceFragmentStyle command controls the appearance of the triangle 
mesh. You can specify FILL, FILL_LINES or LINES.

The SurfaceColourMode command specifies the scope for both the fill and the 
lines (if displayed) and also the mesh override settings. Fill and line variables 
have one of the following values.

IMAGE   - texture map the loaded image
USER    - use the user specified fill/line colour
OBJECT  - modulate by an object table field
MESH    - modulate by a mesh table field
SURFACE - modulate by a surface table field
FACE    - modulate by a face table field
VERTEX  - modulate by a vertex table field

The override setting has one of the following values – 

ALL     - all meshs will use the group settings
DEFAULT - meshs with no defined surface source use the group settings

If any of the tables are used then the SurfaceColourField command is used to 
specify the field name.
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The DisplayList command specifies how display lists will be generated within a 
group. This is an advanced command. You can define granularity of 
PER_OBJECT or PER_GROUP. If the displays lists are generated for each 
object then the transform can be INTERNAL or EXTERNAL to the list. If you use 
the Facing command for objects in a group then you need to have display list 
granularity set to PER_OBJECT. If you are using animation you will require 
external transforms.

The ColourMapping command stretches any colour assignment. Valid values 
include NONE, LINEAR, LINEAR_DECREASING, LOG, LOG_DECREASING 
and HISTOGRAM. Further control is available from the series property pages. 
You can also specify a band pass as either a percentage (0-100) minimum and 
maximum or as absolute values. Specify BANDPASS or ABS_BANDPASS and 
then the minimum and maximum values.

The following blocks can also be specified in groups, although the 
GeoreferenceImage block is only valid in an old style group.

ObjectTable Begin
:
ObjectTable End
CoordinateSpace Begin
:
CoordinateSpace End
Object Begin
:
Object End
GeoreferenceImage Begin
:
GeoreferenceImage End

The ObjectTable is just like the mesh/surface/face/vertex tables previously 
discussed and has exactly the same command structure. It stores data for each 
object in the group.

The block declares the coordinate system information for the group – hereafter 
referred to as the source coordinate system. If the graph in which the EGB file is 
being plotted has a known coordinate system (hereafter referred to as the 
destination coordinate system) then the vertices in all meshes will be converted 
from the source to destination coordinates prior to display. Note that this 
transformation is the last operation applied and is computed on the final 
coordinates of the mesh after all other transformations have been applied.
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Projection        = STRING
Datum             = STRING
Units             = STRING
CoordinateSystem  = STRING
TransformRate     = <Identifier>

The Projection, Datum and Units strings are old format strings and currently are 
not used. The CoordinateSystem string is a MapInfo Professional compatible 
string which defines the complete coordinate system. 

The TransformRate command can be either PER_VERTEX or PER_OBJECT. If 
it is PER_VERTEX then each vertex in the mesh is individually transformed. If it 
is PER_OBJECT then the centre of the object will be transformed. This will result 
in a translation and a scaling. 

The Object block can contain any of the following tags - 

Name         = STRING
ObjectID     = STRING
Line         = STRING
Colour       = INT
Transparency = INT,<Identifier>
Translate    = REAL,REAL,REAL,<Identifer>
Scale        = REAL,REAL,REAL,<Identifer>
Rotate       = <Identifier>,<REAL,REAL,REAL>/REAL,<Identifer>, 
<Identifer>,<Identifer>
Facing       = <Identifier>,<Identifier>,<REAL,REAL,REAL>
Transform    = REAL,REAL,REAL,REAL,REAL,REAL,REAL,REAL,REAL,
REAL,REAL,REAL,REAL,REAL,REAL,REAL,<Identifier>
Name         = STRING
ObjectID     = STRING
Line         = STRING
Colour       = INT
Transparency = INT,<Identifier>
Translate    = REAL,REAL,REAL,<Identifer>
Scale        = REAL,REAL,REAL,<Identifer>
Rotate       = <Identifier>,<REAL,REAL,REAL>/REAL,<Identifer>, 
<Identifer>,<Identifer>
Facing       = <Identifier>,<Identifier>,<REAL,REAL,REAL>
Transform    = REAL,REAL,REAL,REAL,REAL,REAL,REAL,REAL,REAL,
REAL,REAL,REAL, REAL,REAL,REAL,REAL,<Identifier>

The name is cosmetic and is used to identify the object definition in property 
pages. The ObjectID is a reference to an object definition ID. It is the object that 
will be rendered.
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The line identifier can be used in applications to automatically control which 
objects are displayed in a 2D or 3D graph. It is utilized when EGB objects are 
used as drill hole curtains and when CDI sections and other data are displayed in 
2D sections and profiles.

The colour of the object, if specified, will be recorded in the object table in the 
“_Colour” field. 

The transparency of the object can range from 0 (opaque) to 100 (invisible). You 
can optionally declare NO_SELF_SEE_THROUGH to prevent the user seeing 
the surface through itself.

The translate, scale, rotate and transform commands have the same structure as 
for an object definition with an important exception – you must add a identifier to 
specify whether the transform is applied before the DEM transform (PRE_DTM) 
or after the DEM transform (POST_DTM). This is important only if a DEM 
transform is being applied (by the group). If so you will want geneally want to scale 
and translate the object to place it in its true XY location, then apply the DEM 
offset, and then apply any further transforms.

An additional transformation command for objects is the Facing command. If 
specified, this transformation is a rotation applied after all other transformations. 
The effect of the command is to always face the object towards the eye position. 
Turn it on by specifying DEFINED. You can restrict this rotation so that the object 
can only be rotated through a specific axis. Define this as X, Y, Z or GENERAL. 
In the latter case you must then specify the axis of rotation as an XYZ vector. Note 
that this transformation must be recomputed at every render cycle so it may 
reduce rendering performance. It will force the object to use an individual display 
list and this may also reduce performance. Generally, you would use this for every 
object in a group and quarantine the objects that use this option in that way. Also, 
the coordinates of these objects are always computed as unrotated and this may 
affect selection.

The old format GeoreferenceImage block contains a mixture of commands found 
elsewhere in the new format. It also contains Comments and Version strings that 
are no longer read and are obsolete. If declared outside of a group it may contain 
some group commands as it will be assigned its own group automatically. As it 
defines a single object definition, image definition and object it may contain image 
definition commands and object definition commands. A summary of valid 
commands is shown in the example below.
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GeoreferenceImage Begin
  Name = “Obsolete”
  Comments = “This string is obsolete”
  Version = 1.0 // This version number is obsolete and never used
  Image = “air_photo.jpg”
  ImageFormat = JPG
  TransparentColour = DEFINED,WHITE
  ImageStretch = HALFTONE,MIPMAP
  ImageDimension = UNDEFINED
  ImageWrap = CLAMP
  ClipToImage = CLIP
  Transparency = 0
  Geometry = QUAD
  Line = L1001
  DimensionX = X
  DimensionY = Y
  CoordinateSpace Begin
// All commands in this block are valid
  CoordinateSpace Begin
  Registration Begin
// All commands in this block are valid
  Registration End
GeoreferenceImage End

ER Mapper Look-Up Files

Encom Discover PA uses standard ER Mapper look-up tables for controlling the 
colour of images, displays and contours. A full description of these ASCII files is 
provided in the ER Mapper Reference Manual Version 5.x or 6.0.

An example of an ER Mapper look-up file is shown below:

LookUpTable Begin
 Version       = "1.0"
 Name          = "Azimuth"
 Description   = "LUT"
 NrEntries     = 256
 LUT           = {
  0   0   0   0
  1  900  860   0
  2 1800 1720   0
  3 2700 2580   0
  4 3600 3440   0
  5 4500 4300   0
  6 5400 5160   0
  7 6300 6020   0
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  8 7200 6880   0
  9 8100 7740   0
  10 9000 8600   0
  11 9900 9460   0
  12 10800 10320   0
  13 11700 11180   0
  14 12600 12040   0
  15 13500 12900   0
  16 14400 13760   0
  17 15300 14620   0
   :  :   :   :
 242 7560 11536 13160
 243 7020 10712 12220
 244 6480 9888 11280
 245 5940 9064 10340
 246 5400 8240 9400
 247 4860 7416 8460
 248 4320 6592 7520
 249 3780 5768 6580
 250 3240 4944 5640
 251 2700 4120 4700
 252 2160 3296 3760
 253 1620 2472 2820
 254 1080 1648 1880
 255  540  824  940
 }
LookUpTable End

ETS Encom Tube Shape File Formats

Refer to the Tube Shape Manager and the Display of Curve Data for a description 
of the use of the Tube Shape files. Tube Shape files are stored normally in the 
Program Files\Encom\Common\TubeShape folder. An example of a Tube Shape 
file is:

// Comments…
Shape Begin
  Version = "1.0"
  Comments = "Star tube"
  PointFormat = AngleRadius
  AngleFormat = Degrees
  Name = "4-point Star"
  PointData Begin
    Point = 0,1
    Point = 45,0.5
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    Point = 90,1
    Point = 135,0.5
    Point = 180,1
    Point = 225,0.5
    Point = 270,1
    Point = 315,0.5
    Point = 0,1
  PointData End
Shape End

Each cross-section is defined by a Shape Begin and Shape End block. The 
version is defined as a numeric string. Comments may be added using standard 
comment leading delimiters or after a Comments tag. The shape is identified by 
the Name string.

The PointFormat tag specifies the format of the point data. Valid tags are 
AngleRadius, Point or ScaledPoint. If AngleRadius is specified then each point 
ought to be specified as an angle (see notes below) and a radius. The angle ought 
to be monotonically increasing. If Point is specified then each point is specified as 
an XY coordinate pair. In this case a centre point ought to be specified and the 
angle/radius information is computed relative to the centre point. If ScaledPoint is 
specified then each point is specified as an XY coordinate pair. In this case a 
centre point ought to be specified and the angle/radius information will be 
computed relative to the centre point. In this case the radius information is scaled 
from 0 to 1.

The AngleFormat tag specifies the units of the angle data. Valid tags are Radians 
or Degrees. Radians are defined anticlockwise from East and Degrees are 
specified clockwise from North.

The point data is listed between PointData Begin and PointData End tags. Points 
are specified as Point = Angle,Radius or Point = X,Y depending on the point 
format. If Point or ScaledPoint is used a centre point ought to be specified using 
Centre = X,Y. Currently it scales the data by finding the centre point (from the 
input point data range) and scaling the shape into +/-1 space.
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Gemcom Block Model

The Gemcom file format of a standard block model has the file extension of .TB2 
and is as illustrated below

Gemcom block model definition

In the diagram above the block size is 10x5x5, the block model origin is at the top 
left corner, the upper surface of the block is the reference origin for the levels 
which increase vertically down. Attributes within the block model table relate to 
values calculated at the centroid of the block. Note the block levels increase 
downward and not upward. The following plan and isometric views present the 
geometric layout of the Gemcom block models.
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.
Plan view of block layout

The origin is relative to the numbering sequence for the rows. Below are 3D 
representations of the row/column and layer sequence of the Gemcom model file.
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Typical block model cell distributions

The file format is binary and has a file extension of .BMF.
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Geosoft Oasis montaj Input Template

An example of a template used in Oasis montaj for input of single and multi-
banded (termed array) data is shown below.

/ Wizard Generated Template for .\EM_raw_data_and_CDI_Results.asc
[IMPORT ARCHIVE]
FILEHEADER  3
RECORDFORM  DELIM," \t","","","\""
SKIPSTRING "/"
DATA  0,6,NORMAL,,,,
CHAN  Line,DOUBLE,NORMAL,8,0,LABEL=Line
DATA  1,2,NORMAL,,,,
CHAN  Flight,DOUBLE,NORMAL,8,0,LABEL=Flight
DATA  2,4,NORMAL,,,,
CHAN  Fid,DOUBLE,NORMAL,8,0,LABEL=Fid
DATA  3,9,NORMAL,,,,
CHAN  X,DOUBLE,NORMAL,9,1,LABEL=X
DATA  4,10,NORMAL,,,,
CHAN  Y,DOUBLE,NORMAL,10,1,LABEL=Y
DATA  5,8,NORMAL,,,,
CHAN  Distance,DOUBLE,NORMAL,8,2,LABEL=Distance
DATA  6,6,NORMAL,,,,
CHAN  EM{18},DOUBLE,NORMAL,8,0
DATA  24,6,NORMAL,,,,
CHAN  Radar_Alt,DOUBLE,NORMAL,9,1,LABEL=Radar_Alt
DATA  25,6,NORMAL,,,,
CHAN  Baro_Final,DOUBLE,NORMAL,10,1,LABEL=Baro_Final
DATA  26,7,NORMAL,,,,
CHAN  DEM,DOUBLE,NORMAL,8,2,LABEL=DEM
DATA  27,9,NORMAL,,,,
CHAN  Mag_Final,DOUBLE,NORMAL,9,2,LABEL=Mag_Final
DATA  28,7,NORMAL,,,,
CHAN  TimeCon1,DOUBLE,NORMAL,8,4,LABEL=TimeCon1
DATA  29,8,NORMAL,,,,
CHAN  TimeCon2,DOUBLE,NORMAL,8,4,LABEL=TimeCon2
DATA  30,7,NORMAL,,,,
CHAN  Altitude,DOUBLE,NORMAL,8,2,LABEL=Altitude
DATA  31,8,NORMAL,,,,
CHAN  Distance,DOUBLE,NORMAL,8,2,LABEL=Distance
DATA  32,15,NORMAL,,,,
CHAN  Est_Pene,DOUBLE,NORMAL,15,11,LABEL=Est_Penetration
DATA  33,15,NORMAL,,,,
CHAN  DC{31},DOUBLE,NORMAL,15,11
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In the example template above, the 6th input data channel (labelled EM) has 18 
individual data columns in the input ASCII data file. The 18 data columns are 
specified by enclosing brackets {18}. When displayed in a spreadsheet within 
Oasis, individual data channels of the 18 columns are not able to be numerically 
displayed. Instead they are shown as a decay of data (see the EM data field 
below).

 
Example of Geosoft Oasis montajTM spreadsheet with multi-banded data

GoCad TSURF Surfaces Definition

For a full description of the GoCad TSurf surface, refer to the GoCad Reference 
Documentation. The data file of a GoCad TSurf surface include the inherited file 
elements of an Object and of an Atomic (see below). The Atoms (Vertices) of the 
TSurf are defined before their joining triangles.

• GoCad Objects: The Object file elements define the Object style and the 
Object coordinate space and Units 

• Atomics: The Atomic data format defines the points, locations and 
Property values, of an Atomic (currently, this includes PointsSet, Curve, 
Surfaces, Solids and GShapes). The Atomic inherits all of the Object file 
format elements, plus Atomic data.

Triangle Definition 

Triangles definition must occur after vertices definitions. Each Triangle is defined 
by its three Vertices (Atoms) in the following format: 

TRGL id1 id2 id3

where ids are the IDs of the already-defined Atoms (Vertices). For example, the 
ASCII file corresponding to a TSurf named SQUARE, containing four vertices, 
and two triangles is shown below.
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An example of a TSURF and its data file

In addition to the VRTX or PVRTX point/vertex descriptor find in the Atomic format 
definition, on can find the additional line inside a TSurf ASCII file: 

ATOM id1 id2 

where id1 > id2

where id1 is the index of the new ATOM and id2 is the index of the already existing 
VRTX node which XTZ this Atom shares. 

The goal of the ATOM keyword is to create a new ATOM but which shares an 
already existing vertex. An Atom node has its one Property values but it is 
spatially linked to the existing VRTX node. In other word, an ATOM and its 
referenced VRTX are co-located, but not connected. Triangles construction will 
use the vertex id or the atom id. 

An example of the use of such Atom record is given below:

An example of a shared vertex TSurf



Appendix B Data File Specifications 1137

The input Tsurf file on the left creates a Surface shown at the centre. The Surface 
has two TFaces, because two Triangles need to share an edge to be considered 
connected. When the Surface is saved, GOCAD outputs the file on the right. It 
recognises that the two Triangles both have one vertex at an identical location, 
but topologically, they cannot be the same point. So, GOCAD creates a new point, 
ATOM 6, that shares the identical location of VRTX 3 but is an independent point 
in the sense that it has its own Property values. Had there been two more 
triangles in the input file, TRGL 2 4 3 and TRGL 6 5 1, the ATOM line would not 
have been created because the four triangles are then connected through direct 
or indirect edge-sharing.

Intrepid DDF Format

The Intrepid Data Definition File format is an ASCII data file used to define data 
for input to the Intrepid database software system (refer to Encom Discover PA 
Data Links).

The data is banded such that a series of like data channels are combined to a 
single channel. For example, instead of having EM1, EM2, EM3… all the similar 
EM channels can be banded together into a single data channel such as EM Data.

For additional information on the DDF file format, refer to the Intrepid Import and 
Export Reference Manual. An example of a DDF format input file is provided here.

 TYPE(LINE) 
  LINE  1-5 INTEGER*2
  EASTING 7-15  REAL*4 PROJ(TMAMG55,AGD66) IsX
  NORTHING 17-26 REAL*4 PROJ(TMAMG55,AGD66) IsY
  DAY 121-122 INTEGER*2
  MONTH 119-120 INTEGER*2
  YEAR  117-118 INTEGER*2
  FLIGHT 99-100 INTEGER*2
  LINETYPE 52-53  INTEGER*2
  FID    128-137 REAL*4
  MAGNETIC 184-192 REAL*4 
  ALTITUDE   152-159 REAL*4
  GPSZ 163-170 REAL*4
  BARO 174-180 REAL*4
  X_CHANNEL[1] 194-203 REAL*4
  X_CHANNEL[2] 205-214 REAL*4
  X_CHANNEL[3] 216-225 REAL*4
  X_CHANNEL[4] 227-236 REAL*4
  X_CHANNEL[5] 238-247 REAL*4
  X_CHANNEL[6] 249-258 REAL*4
  X_CHANNEL[7] 260-269 REAL*4
  X_CHANNEL[8] 271-280 REAL*4
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  X_CHANNEL[9] 282-291 REAL*4
  X_CHANNEL[10] 293-302 REAL*4
  X_CHANNEL[11] 304-313 REAL*4
  X_CHANNEL[12] 315-324 REAL*4
  X_CHANNEL[13] 326-335 REAL*4
  X_CHANNEL[14] 337-346 REAL*4
  X_CHANNEL[15] 348-357 REAL*4
  Y_CHANNEL[1] 359-368 REAL*4
  Y_CHANNEL[2] 370-379 REAL*4
  Y_CHANNEL[3] 381-390 REAL*4
  Y_CHANNEL[4] 392-401 REAL*4
  Y_CHANNEL[5] 403-412 REAL*4
  Y_CHANNEL[6] 414-423 REAL*4
  Y_CHANNEL[7] 425-434 REAL*4
  Y_CHANNEL[8] 436-445 REAL*4
  Y_CHANNEL[9] 447-456 REAL*4
  Y_CHANNEL[10] 458-467 REAL*4
  Y_CHANNEL[11] 469-478 REAL*4
  Y_CHANNEL[12] 480-489 REAL*4
  Y_CHANNEL[13] 491-500 REAL*4
  Y_CHANNEL[14] 502-511 REAL*4
  Y_CHANNEL[15] 513-522 REAL*4
  Z_CHANNEL[1] 524-533 REAL*4
  Z_CHANNEL[2] 535-544 REAL*4
  Z_CHANNEL[3] 546-555 REAL*4
  Z_CHANNEL[4] 557-566 REAL*4
  Z_CHANNEL[5] 568-577 REAL*4
  Z_CHANNEL[6] 579-588 REAL*4
  Z_CHANNEL[7] 590-598 REAL*4
  Z_CHANNEL[8] 600-609 REAL*4
  Z_CHANNEL[9] 611-620 REAL*4
  Z_CHANNEL[10] 622-631 REAL*4
  Z_CHANNEL[11] 633-643 REAL*4
  Z_CHANNEL[12] 645-654 REAL*4
  Z_CHANNEL[13] 656-665 REAL*4
  Z_CHANNEL[14] 667-676 REAL*4
  Z_CHANNEL[15] 678-687 REAL*4  
GROUP BY LINE
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Intrepid SuveyInfo File

This file is used to create aliases that are used by Encom Discover PA during 
database import. Encom Discover PA must have certain data fields available 
when importing Intrepid databases. These fields include:

X (Easting)
Y (Northing)
LineNumber
Fiducial
FlightNumber

If any of these fields exist in a database but as a different name (such as Easting 
instead of X), the SurveyInfo file can be used to rename the channels during 
import without having to physically alter the data structure.

An example of the SurveyInfo file follows:

#### Audit Stamp Audit Stamp V3.2- 8/12/2000
Alias Begin
  Comments = "Audit Stamp V3.2- 8/12/2000"
  Bearing = CHORDDIR
  ChordFirstX = CHORDX
  ChordFirstY = CHORDY
  ChordLength = CHORDLEN
  Clearance = RAD_ALT
  Fiducial = FIDUCIAL
  FlightNumber = FLIGHTNUMBER
  LineNumber = LINENUMBER
  X = EASTING
  Y = NORTHING
Alias End

Note in this example that Encom Discover PA also creates auxiliary data 
channels (ChordFirstX, ChordLength etc). These data channels are automatically 
appended by Encom Discover PA and you do not have to add them. In addition, 
data channels such as Clearance (equating to data field RAD_ALT) are available.
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Micromine Block Model File

The Micromine definition is more completely specified in the Micromine 
Reference Manual. The block model file is an ASCII file having a Comma 
Delimited format of a CSV file. The file has with a simple record structure and with 
the first record defining:

The origin in local coordinates
Row (X), column (Y) and layer (Z) increment sizes
Colour definition
Cell property (eg assay or grade)
Index to a specific block in the model
Code relating to data source
Various items that may relate to ore grade, properties (eg Specific Gravity) and 
error andf statistical information (eg Standard Deviation).

An example of a Micromine block model follows:

X,Y,Z,Xinc,Yinc,Zinc,COLOUR,AU,BLOCKINDX,CODE,CUT15,ORECOD,POINTS,SG
,STD_DEV
10835.0,5185.0,432.5,5.0,2.5,2.5,,,,,,,,,
10840.0,5185.0,432.5,5.0,2.5,2.5,0,0.84,002900150014,M37,0.84,,3.0,2
.64,1.057 
10845.0,5185.0,432.5,5.0,2.5,2.5,0,0.85,003000150014,M37,0.85,,3.0,2
.64,1.057
10850.0,5185.0,432.5,5.0,2.5,2.5,0,1.13,003100150014,M37,1.13,,2.0,2
.62,1.294
10825.0,5182.5,432.5,5.0,2.5,2.5,0,1.11,002600140014,M37,1.11,,2.0,2
.62,1.294
10830.0,5182.5,432.5,5.0,2.5,2.5,0,0.86,002700140014,M37,0.86,,3.0,2
.64,1.057
10835.0,5182.5,432.5,5.0,2.5,2.5,0,0.89,002800140014,M37,0.89,,3.0,2
.64,1.057
10840.0,5182.5,432.5,5.0,2.5,2.5,0,0.9,002900140014,M37,0.9,,3.0,2.6
4,1.057
10845.0,5182.5,432.5,5.0,2.5,2.5,0,1.16,003000140014,M37,1.16,,2.0,2
.62,1.294
10820.0,5180.0,432.5,5.0,2.5,2.5,0,1.98,002500130014,M37,1.98,,1.0,2
.55,0.0
10825.0,5180.0,432.5,5.0,2.5,2.5,0,1.15,002600130014,M37,1.15,,2.0,2
.62,1.294
10830.0,5180.0,432.5,5.0,2.5,2.5,0,1.17,002700130014,M37,1.17,,2.0,2
.62,1.294
10835.0,5180.0,432.5,5.0,2.5,2.5,0,1.17,002800130014,M37,1.17,,2.0,2
.62,1.294
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Noddy Model Format

Noddy models can be viewed in the Voxel Modelling facility. The Noddy software 
was originally developed in 1997 at Monash University by Dr Mark Jessell. Two 
files are necessary. These are a mesh file (G00) and a property and lithology file 
(Gnn). The property file reflects the number of different lithological units within the 
model (eg G12 etc). 

An example of a .G00 file is shown below:

VERSION = 7.11
FILE PREFIX = Noddy Block Format
DATE = 01/01/05
TIME = 12:00:00
UPPER SW CORNER (X Y Z) = -900.0 -900.0 5001.0
LOWER NE CORNER (X Y Z) = 10800.0 7800.0 201.0
NUMBER OF LAYERS = 16
 LAYER 1 DIMENSIONS (X Y) = 39 29
 LAYER 2 DIMENSIONS (X Y) = 39 29
 LAYER 3 DIMENSIONS (X Y) = 39 29
 LAYER 4 DIMENSIONS (X Y) = 39 29
NUMBER OF CUBE SIZES = 16
 CUBE SIZE FOR LAYER 1 = 300
 CUBE SIZE FOR LAYER 2 = 300
 CUBE SIZE FOR LAYER 3 = 300
 CUBE SIZE FOR LAYER 4 = 300
CALCULATION RANGE = 3
INCLINATION OF EARTH MAG FIELD = -67.00
INTENSITY OF EARTH MAG FIELD = 63000.00
DECLINATION OF VOL. WRT. MAG NORTH = 0.00
DENSITY CALCULATED = Yes
SUSCEPTIBILITY CALCULATED = Yes
REMANENCE CALCULATED = No
ANISOTROPY CALCULATED = No
INDEXED DATA FORMAT = Yes
NUM ROCK TYES = 8
ROCK DEFINITION = 1
 Density = 2.000000
 Sus = 0.001000
ROCK DEFINITION = 2
 Density = 2.200000
 Sus = 0.001100

The file PROPERTY.ROX details the lithology in the Noddy model. An example 
of its format is:
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Version = 7.100000
Number of Rocks = 19
 Unit Name = Amphibolite
 Height = 0
 Apply Alterations = ON
 Density = 2.96e+000
 Anisotropic Field = 0
 MagSusX = 6.00e-005
 MagSusY = 0.00e+000
 MagSusZ = 0.00e+000
 MagSus Dip = 0.00e+000
 MagSus DipDir = 0.00e+000
 MagSus Pitch = 0.00e+000
 Remanent Magnetization = 0
 Inclination =   0.00
 Angle with the Magn. North =   0.00
 Strength = 0.00e+000
 Color Name = Dodger Blue
 Red = 30
 Green = 144
 Blue = 255
 Unit Name = Andesite
 Height = 0
 Apply Alterations = ON
 Density = 2.61e+000
etc.

Within the Noddy application, the models are derived from the Tools>Export 
Block>Export Noddy Model option.
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Noddy model with folds, dyking and intrusive

SEG-2 Data Format

This data file is a SEG (www.seg.org) specified seismic and Ground Penetrating 
Radar format and approved by their Standards Committee. The data files consist 
of a File Descriptor Block, one or more Trace Descriptor Blocks and one or more 
Data Blocks.

Pointers are used to indicate locations of blocks with respect to the beginning of 
the file. The pointers are always unsigned long integers (32 bits). 

For a full definition of the SEG-2 file format, refer to the specification published by 
the Society of Exploration Geophysicists (http://www.seg.org).

FILE DESCRIPTOR BLOCK 
TRACE DESCRIPTOR BLOCK 1 

DATA BLOCK 1 
TRACE DESCRIPTOR BLOCK 2 

DATA BLOCK 2 
... 

TRACE DESCRIPTOR BLOCK N 
DATA BLOCK N 

http://www.seg.org
http://www.seg.org
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Surfer Look-Up Tables

Encom Discover PA can use standard Surfer look-up tables for controlling the 
colour of images, displays and contours. A full description of these ASCII files is 
provided in the Surfer Reference Manual Version 6.x, 7.x or 8.0.

An example of an Surfer look-up file is shown below:

ColorMap  1 1
  0  153  102  255
 20    0    0  255
 40    0  255 0
 60  255  255 0
 80  255  102 0
100  255 0 0

Surpac Block Model File Format

The Surpac three dimensional Block Model is simple to use and understand yet 
is fast in its creation. Modelling parameters can be added and modified at any 
time.

The Surpac Block Model is a form of database. This means that its structure not 
only allows the storage and manipulation of data, but also the retrieval of 
information derived from that data. It differs from a more traditional database, in 
that data stored are likely to be interpolated values, rather than true 
measurements. Another major difference is that these values may be spatially 
referenced as well as being spatially related. A third important difference is that 
the Block Model is recalled in its entirety into memory which makes dynamic 
operations such as colouring of attributes possible but imposes significant 
memory overheads.

For example, consider a Geological database. Records have spatial attributes 
which relate them to a spatial position. However, the converse does not 
necessarily hold as spatial positions are not necessarily related to a record in the 
database.

The Block Model apportions space into a set of blocks, each being related to a 
record. The records may be spatially referenced, so information may be retrieved 
for any point in space, not just for points that have been explicitly measured. This 
spatial referencing allows the addition of a number of operators to the querying 
capabilities of the database manipulation scheme, namely spatial operators such 
as INSIDE and ABOVE, which may operate on solids and surfaces. Outside and 
below may be built using the NOT logical operations of NOT INSIDE or NOT 
ABOVE.
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The Block Model comprises of a number of components:

• Model Space: The model space is a cuboid volume outside of which 
nothing exists in terms of the Block Model. 

• Attributes: The properties of the model space that are to be modelled are 
termed attributes. These attributes may be nominal, ordinal, interval or 
ratio measurements expressed as numeric or character data. Attributes 
may also be calculated from the values in other attibute fields, for 
reporting and visualising.

• Constraints: Constraints are the logical combinations of spatial operators 
and objects that may be used to control the selection of blocks from which 
information may be retrieved and/or into which interpolations may be 
made. Constraints may be saved and have file extensions of .CON.

The model itself is a binary image constructed in the model space and 
defined by the existence or non-existence of blocks. Model files have file 
extensions of .MDL.

The Block Model may be applied to any situation where properties of a 
volume of space are to be modelled in terms of the distribution of values 
through that space.

Block Model Concepts

The following terms are used in a Surpac model definition:

• Origin - The origin of the model is the lower, front, left hand corner (ie. the 
minimum Y, X and Z coordinates) of the model expressed in Y, X, Z 
Cartesian coordinates. The origin is the anchoring point from which 
rotations involving the Bearing, Dip and Plunge are to be performed.

• Extent - The extent of model is the dimensions of the model in the Y, X 
and Z directions. For example, if a model was to cover the following area:

3000 m N to 3650 m N
1500 m E to 2100 m E
120 m El to 270 m El

The origin is: Y=3000 X=1500 Z=120

The extent of the model will be: Y=650 X=600 Z=150
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• Bearing - The bearing of the model is the horizontal angle in degrees of 
the direction of the major axis of the model. A bearing of zero indicates a 
non-rotated model where the major axis of the model is in a north-south 
orientation.

• Dip - The dip of the model is the vertical angle of the blocks in degrees 
from the horizontal in a direction perpendicular to the bearing of the 
model. A negative dip is an angle below the horizontal to the right when 
looking along the bearing of the model. A dip of zero indicates horizontal 
blocks normal to the bearing of the model.

• Plunge - The plunge of the model is the vertical angle of the blocks in 
degrees from the horizontal along the bearing of the model. This can also 
be referred to as the tilt of the model. A negative plunge is an angle below 
the horizontal when looking along the bearing of the model. A plunge of 
zero indicates horizontal blocks along the bearing of the model.

• User Block Size - The block size in the Y, X and Z directions. The user 
block size is used as the reporting unit for the Block Model. The user block 
is also the block size upon which interpolation is performed. 

The user block size depends on the Model purpose (ie. Grade Control, 
Resource Calculation, Pit Optimization) with reference to the data 
spacing.

For example, what block size is appropriate for a prospect drilled on a 
100m x 100m pattern, which is to have a resource estimate completed? It 
would not be appropriate to set this model up with a block size of 5x5x5, 
as the small blocks won't give a better estimate of the resource, as the 
original data is widely spaced. Perhaps, 25x25x10 may be more realistic 
(that is, one-third to one-quarter of the sample spacing).

• Maximum sub-blocks per side - The maximum number of blocks along 
each side of the model. This number must always be 2 to the power of an 
integer. ( eg 2, 4, 8, 16, 32, 64, 128, 256, 512)

This value will need to satisfy a base resolution. For the example used 
previously: extents Y=650 X=600 Z=150 user block size 25x25x10

The number of blocks along each side will be 26x24x15(extent divided by 
user block size). This means that the base resolution will be 32 (the 
number greater than the maximum number of blocks and is 2 to the power 
of something). If we wish to allow sub-blocking (the sub-dividing of 
blocks), the resolution needs to be greater than base resolution.
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For this example: 
if maximum sub-blocks per side = 64 
smallest sub-block = 12.5x12.5x5 
if maximum sub-blocks per side =128 
smallest sub-block = 6.25x6.25x2.5

In this way we find it possible to fill a model with interpolated values calculated at 
a User Block Size, that is user block size 25x25x10 and still constrain the data 
within geological envelopes that are able to be sub-blocked to smaller sizes that 
is 6.25x6.25x2.5. This becomes important when considering the size of the model 
and the number of calculations to be performed to fill the model.

The model definition for the file Block_Model .MDL is:

UBC Model File Formats

The UBC model requires two separate ASCII files. These are:

• Mesh File – 3D mesh defining the discretisation of the 3D model region

• Property File – The assignment of the property (eg magnetic susceptibility, 
density etc) for each cell of the model

Type Y X Z
Min Coordinates 7100 1270 -10
Max Coordinates 770 2030 250
User Block Size 20 20 20
Min Block Size 5 5 5
Rotation 0 0 0

Attribute 
Name

Type Decimals Background Description

Gold Real 2 -99 Gold grade estimated 
from drill hole samples in 
database

sg Real 2 -99 Specific Gravity of 
material
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Mesh File

This file contains the 3D mesh which defines the model region. mesh has the 
following structure:

NE NN   NV
EO NO   VO
DE1   DE2   …….    DENE
DN1   DN2   …….    DNNN
DV1   DV2   …….    DVNV

where:

NE NN NV = Number of cells in the East, North, and vertical direction.

EO NO VO = Coordinates, in meters, of the southwest top corner, 
specified in (Easting, Northing and Elevation). The elevation can be 
relative, but it needs to be consistent with the elevation used to specify the 
observation position in additional location files (called OBS.DAT and 
OBS.LOC).

DEn = Cell widths in the easting direction (from West to East).
DNn = Cell widths in the northing direction (from South to North).
DVn = Cell depths (top to bottom).

The mesh can be designed in accordance with the area of interest and the 
spacing of the data available in the area. In general, the mesh consists of a core 
region which is directly beneath the area of available data, and a padding zone 
surrounding this core mesh. Within the core mesh, the size of the cells should be 
comparable with the spacing of the data. There is no restriction on the relative 
position of data location and nodal points in horizontal direction. The cell width in 
this area is usually uniform. The maximum depth of the mesh used for inversion 
should be large enough so that the no magnetic material below that depth would 
produce a noticeable anomaly with the length scale covered by the data area. A 
rule of thumb is that the maximum depth should be at least half of the longest side 
of the data area. Based upon the user’s knowledge of the survey area, one may 
adjust the maximum depth as necessary. The cell thickness in vertical direction 
usually increases slightly with depth. In the shallow region, the ratio of thickness 
to width of about 0.5 is good, especially when surface topography is present.

At depth, a cell thickness close to the cell width is advisable. Once this core mesh 
is designed, it can be extended laterally by padding with a few cells, possibly of 
variable width. This padding is necessary when the extracted anomalies are close 
to the boundary of the core mesh or if there are in influences from anomalies 
outside the area which cannot be easily removed.
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The vertical position of the mesh is specified in elevation. This is to accommodate 
the inversion of a data set acquired over a topographic surface. When there is 
strong topographic relief and one wishes to incorporate it into the inversion, 
special care should be taken to design the mesh.

An example of a mesh file where a 10 10 5 mesh where each cell is 50m by 50m 
by 50m.

10 10 5
0 0 0
50.0 50.0 50.0 50.0 50.0 50.0 50.0 50.0 50.0 50.0
50.0 50.0 50.0 50.0 50.0 50.0 50.0 50.0 50.0 50.0
50.0 50.0 50.0 50.0 50.0

Property File

To illustrate and describe the properties of a model, this example uses Magnetic 
Suceptibility, abut all UBC property files are of this format irrespective of the 
property being displayed. The following details the file structure:

sus1,1,1
sus1,1,2
:
sus1,1,NV
sus1,2,1
:
susi,j,k
:
susNN,NE,NV

where:

susi,j,k  is susceptibility at location i,j,k

[i j k]=[1 1 1] is defined as the cell at the top-south-west corner of the model. The 
total number of lines in this file should equal NN NE NV, where NN is the number 
of cells in the North direction, NE is the number of cells in the East direction, and 
NV is the number of cells in the vertical direction. The lines must be ordered so 
that k changes the quickest (from 1 to NV), followed by j (from 1 to NE), then 
followed by i (from 1 to NN). If the surface topography (topo.dat) file is supplied, 
the values above the surface will be ignored. These values should be assigned 
–1.0 (nulls) to avoid confusion with the other model elements.
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C Grid Filters
Filtering of gridded surface data can be done in the frequency domain (using 
FFTs and the Grid Filter option) or in the spatial domain using convolution filter 
methods in the Grid Filter tool. A broad suite of smoothing (low-pass) filters, 
contrast enhancement filters, edge detection filters, geophysical and general 
high-pass filters, are provided. Several user-defined filters also enable you to 
create and apply your own designs. 

In this section:

• The Convolution Filtering Process

• Convolution Filter Descriptions

• One Dimensional FFT Line Filter Descriptions

• Two Dimensional FFT Filter Descriptions

• The FFT Derivative Filters

• FFT Magnetic Component or Phase Transformation Filters

• Encom GeoFilters

The grids supported by Encom Discover PA are listed in Appendix E: Supported 
File Formats.

The Convolution Filtering Process

Grids are comprised of equi-spaced data values located along rows and columns. 
The intersection of these rows and columns is called a mesh point or node. When 
filtering a grid, each grid node of the output grid is calculated as a function of the 
corresponding node and its neighbors. The size of the neighbourhood used in the 
filtering process is defined by the size and shape of the filter (or kernel). Filters 
are generally defined as a rectangular sub-array of nodes, which are assigned a 
set of filter weights. Because the filter neighborhood needs to be centered on a 
grid node during the filtering process, filters are generally defined by an odd 
number of rows and columns. For example, if the width and the height of the filter 
neighborhood are both three, then the neighborhood of the output grid node 
centred at (Row 40, Column 32) is the following rectangular sub-array is:

(39,33) (40,33) (41,32)
(39,32) (40,32) (41,32)
(39,31) (40,31) (41,31)
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Shifting the filter neighbourhood across the grid and computing a new value for 
each grid node produces the filtered output of the image. If the heights of the 
neighborhood nodes are represented by H and the width by W, the number of 
nodes in the neighborhood equals H × W. Therefore, any nodes in the 
neighborhood can be defined as:

Filter Weight (Row+i,Col+j) where:

  and  (1)

where each array is the largest integer less than or equal to its neighbour array.

When using the Grid Filter module, the Rows and Columns in the dialog specify 
the neighbourhood size of the selected filter. The weights for each grid node in 
the neighbourhood are displayed below. Each element of the matrix is used to 
weight the grid node that lies below it. The products are computed and then 
summed, normalised, and assigned to the value below the centre node. The filter 
is then shifted to the next node and the process is repeated until all nodes of the 
input grid have been processed.

Convolution Filter Descriptions

The filters supplied with the Grid Filter utility are text files (with file extension of 
.KER) and are located in the \FILTER folder of the main Grid Filter directory. The 
kernel files used are identical in format to those specified for use by ER Mapper.

Below is a list of the provided filter types and a brief summary of their application:

• Smoothing Filters

• Enhancement Filters

Smoothing Filters

• Averaging Filters

• Gaussian Filters
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Averaging Filters

Averaging filters preserve the low frequency components in an image by reduce 
the amount of intensity variation between one grid cell value and the next. They 
achieve this by simply replacing each grid cell value in an image with the average 
(mean) value of its neighbours, including itself. Averaging filters have the effect of 
eliminating grid cell values, which are unrepresentative of their surroundings, 
thereby removing noise and smoothing its appearance. A 3×3 square kernel will 
generally provide sufficient smoothing for most datasets, although larger kernels 
(e.g. 5×5 or 7x7) can be used for more severe smoothing. In some situations 
applying a small (3x3) averaging filter to a grid several times may produce a 
slightly better result than filtering once with larger kernel.

Averaging filters can also be used to enhance the sharpness of an image or 
improve the appearance of edges (high frequency components). This technique 
is commonly known as the “Unsharp” filtering method. To sharpen an image using 
a smoothing filter, first apply the smoothing filter to the grid.  Then subtract the 
smoothed grid from the original grid to produce the Unsharp image. This 
technique can be used for crispening the appearance of images prior to printing.

The averaging filters supplied with Grid Filter include:

3x3 Average
3x3 Diagonal
5x5 Average
7x7 Average
9x9 Average

Gaussian Filters

Gaussian convolution filters are smoothing filters that can be used to blur images, 
thereby removing high frequency detail and noise. The degree of smoothing 
produced by a Gaussian filter is largely determined by the standard deviation of 
the filter kernel. The Gaussian filters output a “weighted average” value for each 
grid cell's neighbourhood, with the average weighted more towards the value of 
the central grid cells. This is in contrast to an averaging filter, which uses a 
uniform weighting for all cells. Because of this property, a Gaussian filter provides 
gentler smoothing and preserves edges better than a similarly sized averaging 
filter. Because Gaussian smoothing filters remove high spatial frequency 
components from an image they are often used as a pre-processing step to edge 
enhancement filters such as the Laplacian and Sobel filters. In most situations a 
Gaussian filter will provide the best smoothing for grids with high frequency noise 
such as geochemistry or magnetics.
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The Gaussian filters supplied with Grid Filter are:

3x3 Gaussian, Standard Deviation = 0.391
5x5 Gaussian, Standard Deviation = 0.625
5x5 Gaussian, Standard Deviation = 1.0
9x9 Gaussian, Standard Deviation = 1.0
11x11 Gaussian, Standard Deviation = 1.6

Enhancement Filters

• Sharpening Filters

• Line and Edge Enhance Filters

• Laplacian Filter

• Laplacian of Gaussian

• Sobel Filters

• Sun Angle Filters

• Custom User-Defined Filters

Sharpening Filters

Sharpening filters enhance areas of high spatial frequency or contrasting 
gradients in an image by removing the low frequency components. These filters 
can be useful for enhancing edges in an image as well as “sharpening” the overall 
appearance. Applying a sharpening filter to a digital terrain image prior to 
performing a lineament analysis for example, may help emphasise structural 
discontinuities.

Four general sharpening filters are provided with Grid Filter:

5x5 Horizontal Edge Enhance
5x5 Vertical Edge Enhance
3x3 Edge Sharpen
5x5 Edge Sharpen
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Line and Edge Enhance Filters

Line and edge enhance filters are designed to selectively enhance image features 
with specific directional components (gradients). The filters output an 
approximation of the first derivative and therefore enhance edges in an image. 
The sum of the directional filter kernel elements is zero, so areas within an image 
with uniform intensity (or grid cell values) will compute to zero in the output grid. 
Areas of variable intensity or contrast will be amplified and appear as bright 
edges.

Grid Filter provides the following directional filters:

3x3 Horizontal Edge Enhance
3x3 Vertical Edge Enhance
3x3 Horizontal Line Enhance
3x3 Vertical Line Enhance

Laplacian Filter

Laplacian filters approximate a 2D isotropic measure of the second spatial 
derivative of an image. Therefore they highlight regions of rapid intensity change, 
which are often associated with edges. Laplacian filters emphasise maximum 
values within an image by using a kernel with a high central value, surrounded by 
negative weighted values with lower weights. Laplacian filters can be very 
sensitive to noise (high spatial frequency data) so it is often best to apply a 
Gaussian smoothing filter prior to convolving the image with the Laplacian filter. 
Laplacian filters are normally applied to scaled graylevel images.

Grid Filter provides the following Laplacian filters:

3x3 Laplacian
9x9 Laplacian

Laplacian of Gaussian

A Laplacian of Gaussian filter (LoG) is similar to a Laplacian filter, with the only 
exception being that it has already been convolved with a Gaussian filter. The 
advantage of using a LoG filter over the standard Laplacian filter is that you not 
required to smooth the grid prior to applying the LoG as the whole process is 
achieved in a single pass. This property makes the LoG filter faster to compute 
on large datasets. LoG filters calculate an approximation of the second spatial 
derivative of an image. Therefore areas in an image that have a constant intensity 
(or a gradient of zero) will produce values of zero in the Laplacian image, while 
areas of high intensity variation (or gradient) will produce positive or negative 
values. Adding the LoG filtered grid back to the original grid will have the effect of 
enhancing contrast in the original image and making edges appear much sharper. 
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Grid Filter provides the following LoG filter:

9x9 Laplacian of Gaussian (Standard Deviation  = 1.4)

Sobel Filters

Like the Laplacian filter, the Sobel filter approximates a 2D spatial gradient 
measurement on an image and therefore emphasises regions of high spatial 
frequency. This type of filter is typically used to find the approximate absolute 
gradient magnitude at each point in an input grayscale image. Two Sobel filters 
are provided in Grid Filter. These are a pair of 3x3 filters, where one filter is simply 
the other rotated by 90°. The filters provided are designed to respond maximally 
to edges running vertically and horizontally relative to the grid cell orientation. 
One filter is supplied for each of the two perpendicular orientations (horizontal & 
vertical). The filters can be applied separately to the input grid, to produce 
separate measurements of the gradient component in each orientation or they 
can be combined together to find the absolute magnitude and orientation of the 
gradient at each point. The Sobel filter will often reduce edges in an input image 
to lines in the output image. This property makes the filter useful for assisting with 
lineament interpretations and structural mapping.

Grid Filter provides two Sobel filters:

Sobel Horizontal
Sobel Vertical

Sun Angle Filters

These filters provide directional enhancement to grid surfaces. The filter kernels 
are designed to amplify gradients perpendicular to the direction of perceived 
ambient lighting. For example, an East-West sun angle filter enhances frequency 
content for artificial illumination from the north or south. Supplied filters include:

North
North East
East
South East
South
South West
West
North West
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Custom User-Defined Filters

The following three user-defined filters are supplied with Grid Filter:

General user-defined (mxn) filter
Average mxn filter
Gaussian mxn filter

These filters can be used as templates for designing and creating your own 
custom filters and offer a convenient way of experimenting with the properties of 
digital filtering. When you have designed a filter you wish to save click the Save 
As button and assign it a name. The filter is stored in a \CUSTOM sub-folder in the 
Filters directory. 

Once a filter has been saved it will be displayed using the assigned name in the 
Available filters list and can be reapplied during a subsequent filtering session

One Dimensional FFT Line Filter Descriptions

• The General Linear Filter

• The 1D FFT Vertical Continuation Filter

• General Expression for the 1D FFT Directional Derivative Filter

• The 1D FFT Vertical Derivative Filters

• The 1D FFT Horizontal Derivative Filters

• The General 1D Phase Transformation Filter

• The BT(k) to BH(k) Transformation Filter

• The BT(k) to Bz(k) Transformation Filter

• The 1D FFT Reduction to the North Magnetic Pole Filter

• The 1D FFT Reduction to the Magnetic Equator Filter

• The 1D FFT Pseudogravity Filter 

• The 1D FFT Pseudomagnetic Filter

• The 1D FFT Low-Pass and High-Pass Butterworth Filters
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The General Linear Filter

A one dimensional line profile of scalar potential field data representing a 
harmonic scalar potential field function F1(k,z0) may be transformed to another 
scalar potential field function F2(k,z0) in the one dimensional wave-number 
domain via use of the convolution theorem, namely, if the transfer function is 
G(k) then:

(2)

Here it is noted that F1(k,z0) is the one-dimensional Fourier transform of the 
input scalar potential field function f1(x,z0) , namely,

(3)

where k = kx and  ky ≡ 0.

For measurements of a scalar potential field function f1(xi,0;z=z0) defined on 
a one-dimensional profile line  1 ≤ i ≤ Nx ,  the one-dimensional discrete 
Fourier transform is defined as a complex Hermitian function F1(k1,z0) such 
that

(4)

where xi = (i -1)Δx and the discrete kx wave-number is given by the relation:

k = kx = 2π(k1-1)/NxΔx; 1 ≤ k1 ≤ Nx (5)

The 1D FFT Vertical Continuation Filter

The equivalent expression for the vertical continuation operator GUDC(k) for line 
profile potential field data, i.e. at a point k = kx in the 1D wave number domain 
(k,0,|k|), is given by the following relation

GUDC(k) = exp{|k|δz}; δz<0 for upward continuation to z1 (6a)

GUDC(k) = exp{|k|δz}; δz>0 for downward continuation to z1 (6b)

where δz = (z1-z0) is the change in vertical datum from z0 to z1 for the 1D line 
profile and |k| is the modulus of the 1D wave number k = kx

F2 k z0;( ) G k( ) F1 k z0,( )=

F1 k z0;( ) F1 kx 0 z0;,( ) f1 x z0;( ) ikx–[ ] xdexp

∞–

∞

∫= =

F1 k1 z0;( ) f1 xi z0,( ) 2πik1xi N⁄ xΔx–[ ]exp

i 1=

Nx
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General Expression for the 1D FFT Directional Derivative Filter

The equivalent expressions for calculating the p th order (p ≥ 0) directional 
derivative of a 2D harmonic scalar potential field function F(x,y=0,z=z0) in the 
1D wave number domain are derived by setting k = kx and  ky ≡ 0 in equations 
(37) and (38) below.  Hence for –i forward Fourier transform, the expression for 
the complex gradient vector g1D in the 1D wave number domain is

g1D = [ikx,iky,|k|] = [ik,0,|k|] (7)

where |k| is the modulus of the 1D wave number k = kx . Also since the 
direction of measurement q is within the vertical plane containing the line profile 
then the direction cosines are now q1D = (qx,0,qz).  Whence the equivalent 
expression for the transfer function Gqdd(k,z0) for computing the p th order (p ≥ 
0) directional derivative at a point k = (kx,0,|k|) in the 1D wave number 
domain is now given by the following vector dot (scalar) product relation:

Gqdd(k) = (g1D ⋅ q2D)p (8)

It is noted that the order p of the directional or partial derivative may be a whole 
or fractional non-negative number, i.e. p≥0.   

The 1D FFT Vertical Derivative Filters

The transfer function Gzdd(k) for the vertical derivative operator of order p>0 
acting upon a grid of scalar potential field data in the 2D wave number domain is 
derived from equation (8) by putting the direction cosine vector q1D = (0,0,1).  
Hence: 

Gzdd(k) = |k|p ; for p > 0 (9)

where |k| is the modulus of the 1D wave number vector k.  Whence the 
expression for the first vertical derivative operator (i.e. for p = 1) is:

G1vd(k) = |k| (10)
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The 1D FFT Horizontal Derivative Filters

The transfer function G(k) for the horizontal directional derivative operator of 
order p > 0 acting upon a line of scalar potential field data in the 1D wave number 
domain is derived from equation (8) by putting the direction cosine vector 
q1D = (1,0,0).  Hence from equations (7) and (8),

Gxdd(k) = [ikx]p = [ik]p  (11)

The General 1D Phase Transformation Filter

The equivalent expressions for transforming a 1D line profile of total magnetic 
field intensity (TMI) measurements BT(k;z0) to a line profile of scalar magnetic 
field measurements Bq(k;z0)  along a newly specified directional component 
q1D with direction cosines (qx,0,qz) in the 1D wave number domain are derived 
by setting k = kx and  ky ≡ 0 in equations (16) to (17) below.

GT2q(k) = (g1D⋅q2D)/(g1D⋅f2D) for BT(k;z0) → Bq(k;z0) (12)

or in terms of the transformed 1D Hilbert operator H1D = g1D/|k| = (H,0,1) 
where

H = Hx(k) = ik/|k| = i sgn k (13)

Then,

GT2q(k) = (H1D⋅q2D)/(H1D⋅f2D) for BT(k;z0) → Bq(k;z0) (14)

or in terms of Θ’f and Θ’q  where  Θ’f = H1D⋅f2D  and  Θ’q = H1D⋅q2D , then

GT2q(k) = Θ’q/Θ’f for BT(k;z0) → Bq(k;z0) (15)

The BT(k) to BH(k) Transformation Filter

From the general 1D relations in equations (12) to (15) and after noting that the 
vector of direction cosines q2D  is (1,0,0) for the in-line horizontal field 
component along the x axis, then for the transformation to Bx(k) then:

GT2H(k) = ikx/(g1D⋅f2D) = Hx/(H1D⋅f2D) = H/Θ’f (16)
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The BT(k) to Bz(k) Transformation Filter

Similarly, after noting that the vector of direction cosines q2D is (0,0,1) for the 
vertically down or Zd field component, then for the transformation to Bz(k) then

GT2z(k) = |k|/(g1D⋅f2D) = 1/(H1D⋅f2D)  =  1/Θ’f (17)

The 1D FFT Reduction to the North Magnetic Pole Filter

The equivalent expressions for calculating the reduction to the pole (RTP) 
transfer filter for a line of total magnetic field intensity measurements in the 1D 
wave number domain are derived by setting k = kx and  ky ≡ 0 in equations 
(18) to (21) below. The following relation applies:

Grtp(k) = |k|
2/[((g1D⋅f2D)((g1D⋅m2D)] (18)

where

g1D = (ik,0,|k|) is the complex gradient vector in the 1D wave 
number domain

f2D = (f’x,0,f’z) is the vector of direction cosines for the local 
geomagnetic field vector expressed within the [x’,0,z] coordinate 
system of the line profile

m2D = (m’x,0,m’z) is the vector of direction cosines for the resultant 
magnetization vector expressed within the [x’,0,z] coordinate system 
of the line profile.

The one-dimensional RTP transfer function may also be expressed in terms of the 
transformed 1D Hilbert operator H1D = g1D/|k| = (Hx,0,1) as defined in 
equations 5.2a,b above:

Grtp(k) = [(H1D⋅f2D)/(H1D⋅m2D)]−1 (19)

or in terms of Θ’f and Θ’m  where  Θ’f = H1D⋅f2D  and  Θ’m = H1D⋅m2D , then:

GT2q(k) = 1/[ Θ’f Θ’m] (20)

And for the induced magnetization case in which the direction cosines m1D of the 
resultant magnetization vector are identical to the direction cosines f1D of the 
ambient geomagnetic field, then equation (47) becomes:

Grtp(k) = 1/Θ’f2 (21)
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The 1D FFT Reduction to the Magnetic Equator Filter

The equivalent expressions for calculating the reduction to the pole (RTP) 
transfer filter for a line of total magnetic field intensity measurements in the 1D 
wave number domain are derived by setting k = kx and  ky ≡ 0 in equations 
(22) to (25) below. The following relationship applies:

Grte(k) = (gH1D⋅n2D)2/[((g1D⋅f2D)((g1D⋅m2D)] (22)

where

gH1D = (ik,0,0) is the horizontal complex gradient vector in the 1D 
wave number domain

g1D = (ik,0,|k|) is the complex gradient vector in the 1D wave 
number domain

f2D = (f’x,0,f’z) is the vector of direction cosines for the local 
geomagnetic field vector expressed within the [x’,o,z] coordinate 
system of the line profile

m2D = (m’x,0,m’z) is the vector of direction cosines for the resultant 
magnetization vector expressed within the [x’,o,z] coordinate system 
of the line profile

n2D = (n’x,0,0) is the vector of direction cosines for the specified true 
north or magnetic north direction within the [x’,o,z] coordinate system 
of the line profile

The one-dimensional RTE transfer function may also be expressed in terms of the 
transformed 1D Hilbert operator H1D = g1D/|k| = (H,0,1) as defined in 
equation (22) above:

Grte(k) = (H1D⋅n2D)2/[(H1D⋅f2D)(H1D⋅m2D)]-1 (23)

or in terms of Θ’f and Θ’m  where  Θ’f = H1D⋅f2D  and  Θ’m = H1D⋅m2D , then

Grte(k) =  Θ’n2/[Θ’f Θ’m] (24)

For the induced magnetization case in which the direction cosines m2D of the 
resultant magnetization vector are identical to the direction cosines f2D of the 
ambient geomagnetic field, then the expression for the 1D RTE operator  
becomes:

Grte(k) =  Θ’n2/Θ’f2 (25)
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The 1D FFT Pseudogravity Filter 

The equivalent expressions for calculating the 1D pseudogravity transfer filter for 
a line of total magnetic field intensity measurements in the 1D wave number 
domain are derived by setting k = kx ; ky ≡ 0 and |k| = |k| in equations 
(52) and (53) above. The following relationship applies:

Gpsg(k) = Cpsg/(Θ’f Θ’m |k|) (26)

where  Θ’f = H1D⋅f2D ; Q’m = H1D⋅m2D and Cpsg are the same quantities as 
those defined above.  And for the induced magnetization case in which the 
direction cosines m2D of the effective resultant magnetization vector are identical 
to the direction cosines f2D of the ambient geomagnetic field, then equation (26) 
becomes

Gpsg(k) = Cpsg/(Θ’f2 |k|) (27)

The 1D FFT Pseudomagnetic Filter

The equivalent expressions for calculating the 1D pseudomagnetic transfer filter 
for a line of total magnetic field intensity measurements in the 1D wave number 
domain are derived by setting k = kx ; ky ≡ 0 and |k| = |k| in equations 
(55) and (56) below. The following relationship applies:

Gpsm(k) = Cpsm |k|/(Θ’f Θ’m) (28)

where  Q’f = H1D⋅f2D ; Q’m = H1D⋅m2D and Cpsg are the same quantities as 
those defined above.  And for the induced magnetization case in which the 
direction cosines m2D of the effective resultant magnetization vector are identical 
to the direction cosines f2D of the ambient geomagnetic field, then equation 28 
becomes:

Gpsm(k) = Cpsm|k|/Θ’f2 (29)

The 1D FFT Low-Pass and High-Pass Butterworth Filters

The equivalent expressions for calculating the 1D low-pass and high-pass 
Butterworth filters are derived by setting k = kx ; ky ≡ 0 and |k| = |k| in 
equations (69) and (70) below. The expression for the low-pass Butterworth filter 
of degree m and central wave number k0 at a point k = kx in the 1D wave number 
domain is given by:

Glp(k) = 1/[1+(|k|/k0)
m] (30)
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where k0 = 2π/λ0  and  λ0 is the cutoff wavelength (metres).  The expression for 
the high-pass Butterworth filter of degree m and central wave number k0 at a point 
k = kx in the 1D wave number domain is given by

Ghp(k) = 1-Glp(k) = (|k|/k0)
m/[1+(|k|/k0)

m] (31)

Two Dimensional FFT Filter Descriptions

Frequencies of filters are specified in terms of wavelengths (distance in metres). 
Cut-off rates determine the sharpness of the filter and the tapering of the energy 
spectrum. A high value of the cut-off has the effect of removing high frequencies, 
but causes ringing on the edges of large amplitude changes. 

A theoretical description of the filters available in the Grid Filter option is provided 
below. 

A 2D grid of scalar potential field data representing a harmonic scalar potential 
field function F1(k,z0) may be transformed to another scalar potential field 
function F2(k,z0)  in the 2D wave-number domain via use of the convolution 
theorem, namely, if the transfer function is G(k) then:

F2(k;z0) = G(k)F1(k,z0) (32)

Here it is noted that F1(k,z0) is the two-dimensional Fourier transform of the 
input scalar  potential field function, namely,

(33)

Whence for measurements of a scalar potential field function f1(xi,yj;z=z0) 
defined over the 2D grid  1 £ i £ Nx , 1 £ j £ Ny , the 2D discrete Fourier transform 
is defined as a complex Hermitian function F1(k1,k2;z0) defined over the same 
size (Nx*Ny) grid, namely,

F1 k z0,( ) F1 kx ky z0;,( ) f1 x y z0, ,( ) i kxx kyy+( )–[ ]exp xd yd

∞–

∞

∫∫= =

F1 k1 k2 z0;,( ) f1 xi yj z0, ,( ) 2πik1xi NxΔx⁄–[ ] 2πik2xj NyΔy⁄–[ ]expexp

j 1=

Ny

∑
i 1=

Nx

∑=
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where xi=(i -1)Δx and yj=(j -1)Δy and the discrete kx,ky wave-numbers 
are given by the relations:

kx = 2π(k1-1)/NxΔx ; 1 ≤ k1 ≤ Nx and

ky = 2π(k2-1)/NyΔy ; 1 ≤ k2 ≤ Ny

The FFT Derivative Filters

• Derivative Filter of nth Order (Advanced)

• The General Expression for FFT Directional Derivative Filters

• The FFT Vertical Derivative Filters

• The FFT Horizontal Derivative Filter

• The FFT TMI Reduction to the Pole Filter

• The FFT TMI Reduction to the Equator Filter

• The FFT Pseudo-gravity Transform Filter

• The 2D FFT Pseudo-magnetic Transform Filter

Derivative Filter of nth Order (Advanced)

Derivative filters can be applied in any direction with options of East, North, 
Vertical or Any defined orientation. If any direction is selected, an Azimuth and 
Inclination need to be specified. 

The horizontal derivative (East or North) can be used for creating shaded images. 
The operator used for this computation is simply:

L(f) = (i/f)n

where:

n = order of differentiation
f = the frequency component in the specified horizontal direction
i = square root of -1 (the imaginary component).
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The vertical derivative is commonly applied to potential field data to enhance 
shallow geological sources. As with other filters that enhance the high frequency 
components of the spectrum, also apply low-pass filters to remove high frequency 
noise.

The General Expression for FFT Directional Derivative Filters

The transfer function G(k,z0) for computing the pth order (p ≥ 0) directional 
derivative of a harmonic scalar potential field function along a specified direction 
q = (qx,qy,qz).at a point k = (kx,ky) in the 2D wave number domain is given 
by the following vector dot (scalar) product relation (see for example, Blakely, 
1995) :

Gqdd(k) = (g⋅q)p (36)

where g is the complex gradient vector in the 2D wave number domain.  For a 
–i forward Fourier transform (see above) the gradient operator g is defined as the 
complex vector:

g = [ikx,iky,|k|] (37)

where  |k| is the modulus of the 2D wave number vector k, namely,

|k| = [kx
2+ky

2]1/2 (38)

It is further noted that the order p of the directional or partial derivative may be a 
whole or fractional non-negative number, i.e. p ≥ 0.

The FFT Vertical Derivative Filters

The transfer function Gzdd(k) for the vertical derivative operator of order p > 0 
acting upon a grid of scalar potential field data in the 2D wave number domain is 
derived from equation (36) by putting the direction cosine vector q=(0,0,1).  
Hence:

Gzdd(k) = |k|
p ; for p > 0 (39)

where |k| is the modulus of the 2D wave number vector k.  Whence the 
expression for the first vertical derivative operator is

G1vd(k) = |k| (40)
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The FFT Horizontal Derivative Filter

The transfer function G(k) for the East (IGRF-y) or North (IGRF-x) horizontal 
directional derivative operator of order p > 0 acting upon a grid of scalar potential 
field data in the 2D wave number domain is derived from equation (36) by puting 
the direction cosine vector q=(1,0,0) for the x-North direction or q=(0,1,0) 
for the y-East direction.  Hence

Gxdd(k) = [ikx]
p the x-N directional derivative of order p > 0 (41)

and

Gydd(k) = [iky]
p the y-E directional derivative of order p > 0 (42)

The FFT TMI Reduction to the Pole Filter

The reduction to the pole (RTP) filter is used to transform a grid of total magnetic 
field intensity measurements to a grid of magnetic intensity measurements that 
would be observed at the north magnetic pole. The expression for the RTP 
transform operator Grtp(k) at a point k = (kx,ky) in the 2D in the wave 
number domain is given by Gibert and Guillamin (1985) and Blakely (1995) as 
follows :

Grtp(k) = |k|
2/[(g⋅f)(g⋅m)] (43)

where

g  = (ikx,iky,|k|) is the complex gradient vector in the 2D wave 
number domain

f = (fx,fy,fz)  is the unit vector of direction cosines for the local 
geomagnetic field vector

m = (mx,my,mz)  is the unit vector of direction cosines for the resultant 
magnetization vector.

Here it is noted that the direction cosines are measured using the International 
Geomagnetic Reference Field (IGRF) coordinate system, namely, X-North; Y-
East, Z – vertically down.  Furthermore, it is possible to express the RTP transfer 
function in terms of the transformed 2D Hilbert operators Hx(k),Hy(k) 
(Nabighian, 1983) in the k = (kx,ky)  wave number domain, namely, 

Hx(k) = ikx /|k| ; Hy(k) = iky /|k| (44)
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After puting H = g/|k| = Hx,Hy,1), then:

Grtp(k) = [(H⋅f)(H⋅m)]-1 (45)

Or, after putting  Θf = H⋅f  and  Θm = H⋅m, in the notation of Blakely (1995, Ch 
12), then:

Grtp(k) = 1/[Θf Θm] (46)

Whence for the induced magnetization case in which the direction cosines m of 
the resultant magnetization vector is identical to the direction cosines f of the 
ambient geomagnetic field, then equation (46) becomes:

Grtp(k) = 1/Θf
2 (47)

The FFT TMI Reduction to the Equator Filter

The reduction to the equator (RTE) filter is used to transform a grid of total 
magnetic field intensity measurements to a grid of magnetic intensity 
measurements that would be observed at the magnetic equator, i.e. where the 
inclination of the geomagnetic field is zero degrees.  The expression for the RTE 
transform operator Grte(k)  in the wave number domain is given by Gibert and 
Guillamin (1985) and Blakely (1995) as follows :

Grte(k) = (gH⋅n)2/[(g⋅f)(g⋅m)] (48)

where

g = (ikx,iky,|k|) is the complex gradient vector in the 2D wave 
number domain

gH = (ikx, iky)  is the horizontal gradient vector in the 2D wave 
number domain

f = (fx,fy,fz)  is the unit vector of direction cosines for the local 
geomagnetic field vector

m = (mx,my,mz)  is the unit vector of direction cosines for the resultant 
magnetization vector

n = (nx,ny,0)  is the unit vector of direction cosines for the specified 
true north or magnetic north direction
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As noted previously the direction cosines are measured using the International 
Geomagnetic Reference Field (IGRF) coordinate system.  From equations (44) 
above it is possible to express the RTE transfer function in terms of the 
transformed 2D Hilbert operators Hx(k),Hy(k) in the k = (kx,ky)  wave 
number domain, namely, 

After puting H = g/|k| = (Hx,Hy,1), and  H2D = gH/|k| = (Hx,Hy), then:

Grte(k) = (H2D⋅n)2/[(H⋅f)(H⋅m)] (49)

Or, after puting  Θf = H⋅f  and  Θm = H⋅m and  Θn = H2D⋅n ,  then:

Grte(k) = Θn
2/[Θf Θm] (50)

Whence for the induced magnetization case in which the direction cosines m of 
the resultant magnetization vector is identical to the direction cosines f of the 
ambient geomagnetic field, then equation (50) becomes

Grte(k) = Θn
2/Θf

2 (51)

The FFT Pseudo-gravity Transform Filter

The pseudogravity filter is used to transform a grid of total magnetic field intensity 
measurements to a grid of vertical gravity component gz data.  The expression 
for the pseudogravity transform operator Gpsg(k) at a point k = (kx,ky) in the 
2D wave number domain is given by Blakely (1995) as follows :

Gpsg(k) = Cpsg/(Θf Θm |k|) (52)

where  Θf  = H⋅f  and  Θm  =  H⋅m  are the same quantities as those defined above 
in and identical to those in Blakely (1995). The quantity Cpsg is a constant given by

Cpsg = (G/Cm)(r/Mres) (53)

where

G is the Universal Gravitational Constant [= 6.6726 x 10-11 Nm2/kg2]
d is the density [kg/m3]
Mres is the resultant magnetization in ampere/metre [A/m]
Cm is a constant equal to Θ0 /4π  in henry/metre [H/m]
δ0 is the magnetic permeability of free space = 4π x 10-7 H/m.
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Note for the induced magnetization case in which the direction cosines m of the 
resultant magnetization vector are identical to the direction cosines f of the 
ambient geomagnetic field, then equation (52) becomes

Gpsg(k) = Cpsg /(Θf
2 |k|) (54)

The 2D FFT Pseudo-magnetic Transform Filter

The pseudomagnetic filter is used to transform a grid of vertical gravity 
component data gz(k,z0) to a grid of total magnetic field intensity Bt(k,z0) 
data.  The expression for the pseudomagnetic transform operator Gpsm(k) at a 
point k = (kx,ky) in the 2D wave number domain is given by Blakely (1995) as 
follows:

Gpsm(k) = Cpsm|k|/(Θf Θm) (55)

where  Θf = H⋅f  and  Θm = H⋅m  are the same quantities as those defined above 
and in Blakely (1995). The quantity Cpsm is a constant given by:

Cpsm = (Cm/G)(Mres/r) = 1/Cpsg (56)

where

G is the Universal Gravitational Constant [= 6.6726 x 10-11 Nm2/kg2]
r is the density [kg/m3]
Mres is the resultant magnetization in ampere/metre [A/m]
Cm is a constant equal to μ0 /4π  in henry/metre [H/m]
μ0 is the magnetic permeability of free space = 4π x 10-7 H/m.
Cpsg is a constant given by equation (8.2).

Note for the induced magnetization case in which the direction cosines m of the 
resultant magnetization vector are identical to the direction cosines f of the 
ambient geomagnetic field, then equation (55) becomes

Gpsm(k) = Cpsm|k|/Θf
2 (57)
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FFT Magnetic Component or Phase Transformation 
Filters

• The TMI General Phase Transformation Filter

• The BT(k) to Bx(k)Transformation Filter

• The BT(k) to By(k)Transformation Filter

• The FFT Vertical Continuation Filter

• The 2D FFT Low-Pass and High-Pass Butterworth Filters

• The FFT Band-Pass and Band-Reject Directional Cosine Filters

• The First Order Magnetic Moment Transformation

• FFT TMI Reduction to the Pole (Low Latitude) Processing

• Low Latitude Processing Theory

• Aspects of Numerical Computation

• Computation of the Magnetic Moments

• Low Pass Filter

• High Pass Filter

• Band Pass Filter

The TMI General Phase Transformation Filter

The phase transformation filter is used to transform a grid of total magnetic field 
intensity (TMI) measurements BT(k;z0) to a grid of scalar magnetic field 
measurements Bq(k;z0) along a newly specified component direction q with 
direction cosines (qx,qy,qz).  The expression for the general phase 
transformation operator GT2q(k) at a point k = (kx,ky) in the 2D wave number 
domain is given by the following relation (see for example, Blakely, 1995 or 
Schmidt and Clark, 1998):

GT2q(k) = (g⋅q)/(g⋅f) for BT(k;z0) → Bq(k;z0) (58)

or in terms of the transformed 2D Hilbert operator H = g/|k| = (Hx,Hy,1) as 
defined in equations 2.2a,b above:
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GT2q(k) = (H⋅q)/(H⋅f) for BT(k;z0) → Bq(k;z0) (59)

or in terms of Θf and Θq  where  Θf = H⋅f and Θq = H⋅q , then:

GT2q(k) = Θq/Θf for BT(k;z0) → Bq(k;z0) (60)

A pair of red-blue anaglyph glasses is available from Pitney Bowes Software upon 
request, which can be applied when viewing the output of the FFT TMI General 
Phase Transformation Filter. The use of these glasses enables the creation of 
stereo pairs from magnetic grids that allow direct depth perception. 

The method is based on a technique proposed by Roger Clifton (Clifton, R. 2006, 
“Visualisating magnetic depths.” AESC Conference, 2-8 July, Melbourne). Our 
method allows for a direct east-west transformation of the magnetic grid which 
eliminates the need to rotate the images when using the reduction to pole method 
proposed by Clifton.

The BT(k) to Bx(k)Transformation Filter

From the general relations in (58 to 60) and after noting that unit vector of 
direction cosines q is (1,0,0) for the North or X field component, then for the 
transformation to Bx(k) then:

GT2x(k) = ikx/(g⋅f) = Hx/(H⋅f) = Hx/Θf (61)

The BT(k) to By(k)Transformation Filter

Similarly after noting that unit vector of direction cosines q is (0,1,0) for the 
East or Y field component, then for the transformation to By(k) then:

GT2y(k) = iky/(g⋅f) = Hy/(H⋅f) = Hy/Θf (62)

The BT(k) to Bz(k)Transformation Filter

Similarly after noting that unit vector of direction cosines q is (0,1,0) for the 
Depth or Z field component, then for the transformation to Bz(k) then:

GT2z(k) = |k|/(g⋅f) = 1/(H⋅f) = 1/Θf (63)
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The FFT Vertical Continuation Filter

The vertical continuation filter is used to transform a 2D grid of scalar potential 
field (magnetic or gravity) measurements from one datum level at z=z0 to another 
datum level at z=z1 in either an upward or downward direction.  The expression 
for the vertical continuation operator GUDC(k) at a point k = (kx,ky) in the 2D 
wave number domain is given by the following relation (see for example, Blakely, 
1995):

GUDC(k) = exp{|k|δz} δz<0 for upward continuation to z1 (64)

GUDC(k) = exp{|k|δz} δz>0 for downward continuation to z1 (65)

where δz = (z1-z0) is the change in vertical datum from z0 to z1 for the 2D grid 
and |k| is the modulus of the 2D wavenumber vector k as defined in equation 
(38).  Here it is noted that z is measured positive downwards which is in keeping 
with both the IGRF and the Encom grid coordinate systems.

The 2D FFT Low-Pass and High-Pass Butterworth Filters

The Butterworth filter is used to apply either low-pass or high-pass filtering to a 
grid of transformed potential field measurements.  The high- or low-pass filters 
are employed to reject regional or residual scale features respectively in grids of 
scalar potential field data.  The rate of amplitude roll-off for the Butterworth filter 
is controlled by its degree m whereas its cutoff wavelength is specified via the 
central wave number k0 or wavelength λ0 parameter, namely, k0 = 2π/λ0  (i.e. 
the half-amplitude point).  The expression for the low-pass Butterworth filter of 
degree m and central wave number k0 at a point k = (kx,ky) in the 2D wave 
number domain is given by:

Glp(k) = 1/[1+(|k|/|k0|)
m] = 1/[1+(k/k0)

m] (66)

where

k = |k| = [kx
2+ky

2]1/2 ; k0 = |k0| = 2π/λ0  (67)

and λ0 is the cutoff wavelength (metres).

The expression for the 2D high-pass Butterworth filter of degree m and central 
wave number k0 at a point k = (kx,ky) in 2D the wave domain is given by

Ghp(k) = 1-1/[1+(|k|/|k0|)
m ] = 1/[1+(k/k0)

m] (68)
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The FFT Band-Pass and Band-Reject Directional Cosine Filters

The directional filter is used to pass or reject regional or residual scale features in 
grids of transformed scalar potential field data. These features have a preferred 
azimuth or strike direction which is specified by an angle α0 while the angular 
bandwidth of the directional cosine filter is controlled by its degree m.  The 
expression for the response function of a band-pass directional cosine filter of 
degree m and azimuthal strike direction α0 (the maximum amplitude point) at a 
point k = (kx,ky) in the 2D wave number domain is given by

Gbpaz(k) = (|cos{α0-θ(k)}|)m (69)

where

θ(k) = arctan{kx/ky} ; -π/2 ≤ θ(k) ≤ π/2 (70)

The expression for the response function of a band-reject directional cosine filter 
of degree m and azimuthal strike direction α0 (the zero amplitude point) at a point 
k = (kx,ky) in the 2D wave number domain is given by

Gbraz(k) = 1-(|cos{α0-θ(k)}|)m (71)

The First Order Magnetic Moment Transformation

Consider a disturbing magnetic body or magnetic source centred at (xc,yc,zc) 
whose anomalous magnetic field is ΔB(r) = [ΔBx(r),ΔBy(r),ΔBz(r)]. 
Helbig (1963) has shown that the magnetic dipole moment M = (Mx,My,Mz) of 
the disturbing magnetic source may be calculated from the components of the 
anomalous magnetic field at any point r = (x,y,z0) in the horizontal plane 
z = z0.  In this instance the three components Mx,My,Mz of the zero-th order 
magnetic moment M are the first order moments of ΔBz(r), about the x,y axes 
and the first order moments of ΔBx(r) and ΔBy(r) about the x,y axes 
respectively.  These relations between the magnetic moment of the body and the 
first order moments of the magnetic field may be expressed through the following 
double integrals, namely, for the Mx moment:

(72)

and for the My moment,

(73)

Mx 1 2π⁄( ) x x0–( )ΔBz x y z0, ,( ) xd yd

∞–

∞

∫∫=

My 1 2π⁄( ) y y0–( )ΔBz x y z0, ,( ) xd yd

∞–

∞

∫∫=
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and for the Mz moment

(74)

or alternatively

(75)

Furthermore and importantly it is also noted that the following pair of integrals are 
identically zero.

(76)

and also,

(77)

By inspection of equations (72 to 75), it is noted that the magnetic moment M is 
completely determined from measurements of a single pair of magnetic field 
components, i.e. either from ΔBx(x,y,z0), ΔBz(x,y,z0) or from 
ΔBy(x,y,z0), ΔBz(x,y,z0).  In practice however a more stable estimator of the 
vertical component Mz of the magnetic moment is 

Mz = [Mz(x)+Mz(y)]/2 (78)

where Mz(x) and Mz(y) are given by equations (74) and (75) respectively.  Also a 
further necessary condition for the existence of a reliable magnetic moment is that 
the integrals in equations (76) and (77) are both approximately zero, namely,

Mx,By ≅ My,Bx ≅ 0 (79)

Other magnetic moment components which can be used are the horizontal 
moment,

MH = [Mx
2+My

2]1/2 (80)

and the total magnetic moment, 

Mz 1 2π⁄( ) x x0–( )ΔBx x y z0, ,( ) xd yd

∞–

∞

∫∫=

Mz 1 2π⁄( ) y y0–( )ΔBy x y z0, ,( ) xd yd

∞–

∞

∫∫=

MxRy 1 2π⁄( ) x x0–( )ΔBy x y z0, ,( ) xd yd

∞–

∞

∫∫ 0= =

MyRx 1 2π⁄( ) y y0–( )ΔBx x y z0, ,( ) xd yd

∞–

∞

∫∫ 0= =
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MT = |M| = [Mx
2+My

2+Mz
2]1/2 = [MH

2+Mz
2]1/2 (81)

Furthermore the declination Dm and inclination Im of the magnetic moment vector 
M are given by

Dm = arctan [Mx/My] for 0 ≤ Dm < 2π (82)

Im = arctan [MH/Mz] for 0 ≤ Im < 2π (83)

It is noted that the above formulae are for the zero order magnetic dipole moment 
of the disturbing body under the plane z= z0 (see Helbig, 1963, p. 84).  This is 
related to the reduced multipole moments of Grant (1952) and Grant and West 
(1965, p.222-225).  Expressions exist for the zero, first and second order dipole 
moments of various simple bodies including spheres, ellipsoids of revolution, 
triaxial ellipsoids, finite length elliptic cylinders, rectangular prisms and wedges. 
Medeiros and Silva (1995) have estimated the total intensity, direction of 
magnetization and the 3D spatial orientation of a seamount source using 
inversion based on dipole moments up to second order.

FFT TMI Reduction to the Pole (Low Latitude) Processing

In addition to the standard RTP filter provided for Reduction-To-the-Pole 
processing (see above), an additional filter specifically for use with magnetic data 
acquired at low magnetic latitudes is provided. This FFT filter uses analytic signal 
computation to calculate simplified responses from magnetic data acquired at 
magnetic latitudes less than approximately 30° of inclination. As the analytic 
signal computation produces response maxima over magnetic contacts 
irrespective of the direction of magnetisation, this can be used to assist the 
processing of observed magnetic data acquired near the magnetic equator.

The formulation used for the low latitude computation is described in Low Latitude 
Processing Theory. 

The Low Latitude filter dialog appears as below. Operation of the filter computes 
both a phase and an amplitude component. A compensation applied to the phase 
component can be used to prevent the amplitude increasing and causing the 
equation to become unstable. This instability is primarily due to any anomalies 
oriented north-south within the observed data. 

The Minimum angle factor defaults to a value of 20° but in the filter’s 
implementation, if it specified less than the data’s inclination (I), then the Minimum 
angle correction is reset to the value of 20° to maintain stability.
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Application of the Low Latitude filter

Use the IGRF calculator to automatically assign the Declination and Inclination. A 
default Minimum angle of 20° is assigned.

The effect of changing the Minimum angle factor alters the relative sizes of the 
phase and amplitude. If the factor is increased (to a maximum of 90°), the phase 
component increases and amplitude adjustment is reduced (to be zero at 90°). If 
the correction factor is reduced, the phase and amplitude components become 
evenly applied.

Low Latitude Processing Theory

The Reduction-To-the-Pole (RTP) filter is used to transform a grid of total 
magnetic field intensity measurements to a grid of magnetic intensity 
measurements that would be observed at the north magnetic pole. The 
expression for the RTP transform operator Grtp(k) at a point k = (kx,ky) in 
the 2D wave number domain is given by Gibert and Guillamin (1985) and Blakely 
(1995) as follows:

Grtp(k) = |k|
2/[(g⋅f)(g⋅m)] (84)
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where,

g  =  (ikx, iky, |k|) is the complex gradient vector in the 2D wave number 
domain

f   =  (fx,fy,fz)  is the unit vector of direction cosines for the local 
geomagnetic field vector

m  = (mx,my,mz)  is the unit vector of direction cosines for the resultant 
magnetization vector.

Here it is noted that the direction cosines are measured using the International 
Geomagnetic Reference Field (IGRF) coordinate system, namely, X-North; Y-
East, Z-vertically down.  Furthermore, it is possible to express the RTP transfer 
function in terms of the transformed 2D Hilbert operators Hx(k), Hy(k) 
(Nabighan, 1983) in the k = (kx,ky) wave number domain, namely, 

Hx(k) = ikx/|k| = icosα(k)

Hy(k) = iky/|k| = isinα(k) (85)

where α(k) is the horizontal azimuth of a point k = (kx,ky) in the 2D wave 
number domain,

α(k) = arctan ky/kx (86)

Then after putting H = g/|k| = (Hx,Hy,1), we have omitting the k 
dependence of H(k), Hx(k) and Hy(k) from now on

Grtp(k) = [(H⋅f)(H⋅m)]-1 (87)

Or, after putting  Θf = H⋅f  and  Θm = H⋅m, we have in the notation of Blakely 
(1995, Ch 12) and omitting the k dependence of Θf(k) and  Θm(k) from now on

Grtp(k) = 1/[Θf Θm] (88)

Whence for the induced magnetization case in which the direction cosines m of 
the resultant magnetization vector are identical to the direction cosines f of the 
ambient geomagnetic field, then equation (88) becomes:

Grtp(k) = 1/Θf
2 (89)

Or, noting that Θf = H⋅f  is a complex quantity with complex conjugate 
[Θf

2]* = [Θf*]
2 = (H*⋅f)2, we have multiplying the numerator and 

denominator by:
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[Θf
2]*Grtp(k) = [Θf*]

2/|Θf|
4 (90)

The direction cosines f of the geomagnetic field F are given by:

 f = (fx,fy,fz) = (cosIfcosDf,cosIfcosDf,sinIf) (91)

where Df is the declination of the geomagnetic field and If is its inclination.  Now 
if we expand the expression for Θf we have,

Θf = H⋅f = [fz+Hxfx+Hyfy] (92)

or

Θf = H⋅f = [sinIf+cosIf[HxcosDf+HysinDf] (93)

And, after substitution for Hx and Hy from equations (1.2a,b) above, we have

Θf = H⋅f = [sinIf+icosIf[cosαcosDf+sinαsinDf]

Hence, it is easily shown that

Θf = H⋅f = [sinIf+icosIfcos(Df-α)] (94)

and

|Θf|
4 = [Θf Θf*]

2 = [sin2If+cos
2Ifcos

2(Df-a)]
2 (95)

From equations (94 and 95) it is easily deduced that the transfer function for 
reduction to the pole Grtp(k) in a zero inclination If geomagnetic field is given by 
the relation,

Grtp(k) = [Θf*]
2/|Θf|

4 = 1/cos2(Df-α) for If = 0 (96)

Therefore if the angle |Df-α| is an odd multiple of? π/2 ?such that cos(Df-α) 
is zero, then Grtp(k) will become infinitely large.  Even at low geomagnetic 
latitudes (say 0° < |If| < 20°) there is very significant directionally selective 
amplification of any noise present within a grid of total magnetic intensity 
measurements (see for example, Blakely, 1995; Silva, 1989, Hansen and 
Pawlowski,1989).  This amplification has the effect of producing short wavelength 
artifacts which trend parallel to the direction of the declination Df (Blakely, 1995).
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One means of overcoming this difficulty is to retain the phase information in the 
numerator term [Θf*]

2 above but make a modification to the denominator 
|Θf|

4  in equation (95 etc.) which prevents it from becoming too large.  This may 
be achieved by introducing a second inclination angle If’ (referred to as the 
Minimum angle factor) as follows (see for example, McLeod et al, 1993):

Grtp(k) = [Θf*]
2/|Θf|

2|Θf’|
2 ; for |If| < I’f (97)

where 

Θf’ = H⋅f’ = [sinI’f+icosIf’cos(Df-α)] for |If|<I’f  (98)

Whence from equations (95, 97 and 98), the modified expression for the reduction 
to the pole operator at low latitudes, i.e. for |If| < I’f , is given by,

Aspects of Numerical Computation

In most cases, magnetic survey data will consist of raw total magnetic intensity 
(TMI) measurements Bm(xi,yj;z0) which have been interpolated over a two-
dimensional grid  1 ≤ i ≤ nx , 1 ≤ j ≤ ny.  Therefore, in order to calculate 
the magnetic moments using Helbig’s method, calculate the anomalous magnetic 
field components ΔBx(xi,yj;z0), ΔBy(xi,yj;z0), ΔBz(xi,yj;z0) from the 
original TMI data.  This involves several steps namely:

1. Anomaly isolation.

2. Removal of a constant background field Bp(xi,yj;z0) from the original 
TMI data Bm(xi,yj;z0) to reveal the raw total magnetic field anomaly 
ΔBraw(xi,yj;z0), i.e.

ΔBraw(xi,yj;z0) = Bm(xi,yj;z0) - Bp(xi,yj;z0).

3. Computation of a regional field ΔBreg(xi,yj;z0) for the raw anomalous 
total field ΔBraw(xi,yj;z0) over the area of interest.

4. Removal of the computed regional field ΔBreg(xi,yj;z0) from raw 
anomalous total field ΔBraw(xi,yj;z0) to reveal the final corrected total 
magnetic field anomaly ΔBcor(xi,yj;z0), i.e.

ΔBcor(xi,yj;z0) = ΔBraw(xi,yj;z0) - ΔBreg(xi,yj;z0)

Grtp k( )
If i If Df α–( )coscos–sin[ ]2

If I
2

f Df α–( )2
coscos+sin[ ] I

2
f ′ I

2
f ′ Df α–( )2
coscos+sin[ ]

--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------=
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5. Pad the grid of corrected total magnetic field anomaly measurements 
ΔBcor(xi,yj;z0) ready for 2D Fourier transformation [new grid size is 
Nx*Ny].

6. Fourier transform the corrected anomalous TMI grid ΔBcor(xi,yj;z0) 
and keep a copy of it [see equation (32) for the 2D discrete Fourier 
Transform above].

7. Apply the BT(k) to Bx(k) (x-North) transformation filter GT2x(k) to the 
Fourier transformed TMI grid, namely, compute

ΔBx(k) = GT2x(k) ΔBT(k), where the transfer function

GT2x(k) = ikx/(g⋅f) = Hx/(H⋅f) = Hx/Θf

Apply the BT(k) to By(k) (y-East) transformation filter GT2x(k) to the 
Fourier transformed TMI grid, namely, compute

ΔBy(k) = GT2y(k) ΔBT(k), where the transfer function

GT2y(k) = iky/(g⋅f) = Hy/(H⋅f) = Hy/Θf.

Apply the BT(k) to Bz(k) (z-Down) transformation filter GT2x(k) to the 
Fourier transformed TMI grid, namely, compute

ΔBz(k) = GT2z(k) ΔBT(k), where the transfer function

GT2z(k) = |k|/(g⋅f) = 1/(H⋅f) = 1/Θf.

8. Apply the inverse 2D Fourier transform to each of the three transformed 
grids of magnetic component data ,namely, ΔBx(k), ΔBy(k), ΔBz(k)  
in the x-north, y-east, z-down directions respectively.

9. Extract the real component parts of the inverse Fourier transformed grid 
scaled by the size of the padded grid, i.e. by the factor 1/( Nx*Ny).  
Importantly the extracted grids containing the anomalous magnetic field 
components ΔBx(xi,yj;z0), ΔBy(xi,yj;z0), ΔBz(xi,yj;z0) should 
exactly equivalent in size and location to the original and corrected TMI 
grids ,e.g. ΔBcor(xi,yj;z0).

10. Remove any DC trends from the  ΔBx(xi,yj;z0), ΔBy(xi,yj;z0), 
ΔBz(xi,yj;z0) grids  This is to ensure that the zero order moments of  
the ΔBx(xi,yj;z0), ΔBy(xi,yj;z0) and ΔBz(xi,yj;z0) field 
components are zero (see Helbig, 1963).  The data are now ready for 
magnetic moment computation.
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Computation of the Magnetic Moments

In order to calculate the magnetic moments using Helbig’s method, replace the 
continuous double integrals in equations (72 to 75) with their discrete equivalents.  
This involves numerical integration of the anomalous magnetic field components 
ΔBx(xi,yj;z0), ΔBy(xi,yj;z0), ΔBz(xi,yj;z0) defined over the two-
dimensional grid  1 ≤ i ≤ nx , 1 ≤ j ≤ ny .  Here it is assumed that the 
anomaly of interest is quite compact and isolated.  Furthermore, it assumes that 
the anomalous field components have been sufficiently closely sampled over a 
wide enough area of interest so that the first order moments can be accurately 
determined.  A number of tests can be conducted to ensure this is approximately 
true.  First the zero order moments of DBx(xi,yj;z0), DBy(xi,yj;z0) and 
DBz(xi,yj;z0) should be approximately zero as should the two cross 
moments Mx,By and My,Bx in equations (76) and (77) respectively.  The double 
integrals in equation (72 to 77) may be each be evaluated numerically using a 
double application of the extended Simpson's Rule, closed 1D formula (Press et 
al, 1992, Ch 4, pp.127-129, equation 4.1.13) in the x and y grid directions.  For 
the x grid direction then:

where ƒ″″ indicates the fourth derivative of the function ƒ(x).

Once the numerical integrals corresponding to those in equations (72 to 77) have 
been computed the Mx,My,Mz computes of the magnetic moment may be 
calculated. The Mz magnetic moment is best computed using equation (78).  The 
total magnetic moment MT, its declination DM and inclination IM are calculated 
using equations (80 to 83).  The declination and inclination are equivalent to the 
average values for the source body magnetization. The computed value of the 
magnetic moment may be increasingly underestimated as the grid size becomes 
progressively smaller. Schmidt and Clark (1998) have attempted to compensate 
for this in their paper (see the correction factors in Table 1).

ƒ x( ) xd

x1

xn
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3
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Low Pass Filter

The FFT Low Pass Filter applies an operator to remove high frequency content 
with wavelengths above (that is, smaller than the defined wavelength cut-off). The 
cut-off rate specifies the severity of the filter at its wavelength margins. The higher 
the cut-off, the greater and the sharper the cut-off effect of removing a particular 
wavelength cut-off.

High Pass Filter

This FFT filter is the converse of the Low Pass filter. The High Pass filters pass 
frequencies that are higher than the specified cut-off. 

Band Pass Filter

Band Pass filters remove wavelengths that lie between two specified wavelength 
limits.

A common cut-off is applied for both the high and low ranges of the wavelengths. 
Applying a simple cutoff filter to an energy spectrum (such as a Band Pass filter) 
almost invariably introduces a significant amount of ringing (referred to as the 
Gibbs' Phenomena).

Encom GeoFilters

In this section:

• About Encom GeoFilters

• Edge Filters

• Block Filters

• Applying GeoFilters

About Encom GeoFilters

The Encom GeoFilter filters are a specialist group of filters provided with Encom 
Discover PA. The Geofilters are only provided with the Utility Option of Encom 
Discover PA and require licensing of this module to be enabled before access is 
provided. A complete reference for these filters is provided in Zhi and Butt 
(2004)1. 
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The GeoFilters comprise two types of filters that have been developed for the 
purpose of enhancing weak magnetic anomalies from near-surface sources while 
simultaneously enhancing low-amplitude, long-wavelength magnetic anomalies 
from deep-seated or regional sources. The Edge filter group highlights edges 
surrounding both shallow and deeper magnetic sources. The results are used to 
infer the location of the boundaries of magnetized lithologies. The Block filter 
group has the effect of transforming the data into zones which, similar to image 
classification systems, segregate anomalous zones into apparent lithological 
categories. Both filter groups change the textural character of a dataset and 
thereby facilitate interpretation of geological structures.

The effect of each filter is demonstrated using theoretical model studies in the 
paper by Zhi and Butt. The models include both shallow and deep sources with a 
range of magnetizations. Comparative studies are made with traditional filters 
using the same theoretical models. 

Edge Filters

The Edge Filters increase the sharpness of anomalies used to map the edge of 
magnetic sources. The modulus of horizontal derivatives (MS) of grids yields 
anomaly peaks over the source edge locations, whereas these edges coincide 
with gradients in the First Vertical Derivative (1VD), Tilt and Analytic Signal (AS) 
filtered outputs. None of these filters produces easily interpreted edges in image 
form when the sources are weakly magnetized or are deep.

A new linear, derivative-based filter termed the ZS-Edgezone filter has been 
developed to improve edge detection in these situations. The advantages of the 
filter are greatly increased anomaly sharpness over source edges and 
compression of the amplitude range so that differences in the original TMI 
amplitudes do not persist to dominate the edge interpretation. This has the 
ancillary effect that the method can be modified to provide automated edge 
conversion to vectors for use in GIS systems.

1. Zhi, S. and Butt, G.R. 2004. “New Enhancement Filters for Geological Mapping”, ASEG 17th
Annual Conference Edition, Preview, Sydney 2004
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RTP image derived from multiple theoretical 3D magnetic sources, shown as wire frame 
outlines

Although this filter significantly improves the precision of edge determination, it is 
subject to normal potential field limitations which determine that source edges 
cannot be resolved where the source is narrow relative to its depth. The filter also 
can produce a halo type artefact due to superposition of the response of a limited 
depth extent shallow source (see Model 6 in the diagram above) on that of deeper 
sources.
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Block Filters

In attempting to improve edge detection filters, an obvious progression is to 
highlight the magnetic regions whose edges have been mapped. To do this, a set 
of filters called block filters has been developed.

The Block filter group has the effect of transforming the potential field data into 
zones which, similar to image classification systems, segregate anomalous zones 
into apparent lithological categories. These filters can be imported for use in 
image classification systems or displayed in RGB space with other grids for 
empirical classification purposes.

The block filters, like the edge filters, are linear, derivative-based filters which use 
a combination of derivative and amplitude compression techniques to render the 
magnetic data into regions whose edges are sharply defined and whose 
amplitudes have a reduced range in comparison to the original TMI.

 

 
Anomaly edge and block enhancements using the ZS-Edgezone (left) and ZS-Block filters 
(right). Model positions are shown using wire frames

The ZS-Block filter and the ZS-Plateau filter depict the magnetic data as a 2D plan 
of apparent magnetic source distribution. Artefacts may occur as discussed for 
the edge filters.

The choice of ZS-Block, ZS-Plateau or ZS-Area filters will depend on the data 
characteristics of each magnetic survey and on the end-use requirement. The ZS-
Plateau filter, for example, yields less variation in amplitude “texture” over a 
magnetic unit that either the ZS-Block or ZS-Area filters.



Appendix C Grid Filters 1187

Comparison of ZS-Edge, ZS-Edgezone, ZS-Block and ZS-Plateau filtered outputs of RTP 
data
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An example of some edge filter enhancements are shown below.

Comparison of geology and ZS-Area enhancement

Traditional filters used to enhance magnetic data, including the more recently 
developed potential field tilt filter, are currently used to assist in determination of 
the location and extent of magnetic units.

Newly developed derivative-based filters may be used to improve the precision of 
source edge detection and, by extension, the determination of the spatial extent 
of magnetic units. These filters are demonstrated to perform successfully on both 
strongly magnetized features as well as on weakly magnetized or deep magnetic 
features. Artefacts may result particularly where anomaly superposition occurs.

The impact of noise in real data may be accommodated by these new methods 
provided noise-reduction techniques are employed.

The new filter outputs may be used as part of regional or detailed geological 
mapping projects, including in classification systems or in RGB space, to improve 
lithological discrimination and mapping.

The speed of magnetic unit mapping can be considerably increased through 
reliance on edge detection filters. Further improvements in mapping speed can 
be envisaged through automated conversion of edge anomalies to vector files.
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Applying GeoFilters

The GeoFilters are only available with a GeoFilter module licence of Encom 
Discover PA. Access to the various GeoFilters is through the Grid Filter tool (see 
Grid Filter). After accessing the required grid, select the FFT button and the 
Encom ZS Filters option from the pull-down filter list.

The Grid Filter dialog and the selection of the specialist Encom GeoFilter options

Once the Encom ZS filters are chosen, the Filter properties area alters with:

• Input specification for the Geomagnetic Field Declination and 
Inclination in degrees. If you are unsure of these for the area of your grid, 
select the IGRF button. You can enter the location of the grid or use the 
cursor to position it. When this is done, for the date specified, the total 
magnetic field (TMI), Declination and Inclination are computed 
automatically.
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For computation of IGRF for the grid area for use by the GeoFilters

• Single or multiple GeoFilters can be chosen to be computed concurrently. 
The available filters include:

• Analytic Signal (AS) 

• Modulus of Horizontal Derivative (Mod) 

• Tilt

• Edge

• Edge Zone

• Area

• Block

• Plateau

Refer to Zhi and Butt (2004) for additional details of these filters. All filters 
can be selected from the Select All button, or you can choose which are 
to be computed.

• The Refresh Preview button can be clicked when a change of filters is 
selected. This button forces the processing to update.
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• The grid output shown in the bottom preview window shows the GeoFilter 
selected in the Filter to preview list. 

When the specification of filters and processing is satisfactory, use the Save As 
button to output the resulting grid. Note that some filter combinations can take 
significant time to process across a large grid. In this case, a progress bar is 
displayed to indicate output status. 
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D Fonts
Encom Discover PA can use True Type fonts for symbol, labelling and other text 
or symbol drawing requirements.

In addition, two font datasets are provided with Encom Discover PA

• Encom Discover PA Basic Font

• Geological Font

Encom Discover PA Basic Font

File name is ETBASIC__.TTF.

ASCII ET Basic ASCII ET Basic
33 ! 47 /
34 " 48 0
35 # 49 1
36 $ 50 2
37 % 51 3
38 & 52 4
39 ' 53 5
40 ( 54 6
41 ) 55 7
42 * 56 8
43 + 57 9
44 , 58 :
45 - 59 ;
46 .
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Geological Font

File name is ETGEE__.TTF

Encom Discover PA includes a Geological True Type Font (ET GeoExplore) that 
contains non-rotatable geological symbols. These symbols may be used with the 
Encom Discover PA.

Contained below is a list of the ASCII and symbol equivalent list of all geological 
symbols available in this font.

Name ET GeoExplore ASCII
Petroleum exploration well, proposed site ! 33
Petroleum exploration well, dry, abandoned " 34
Petroleum exploration well with show of oil # 35
Petroleum exploration well with show of oil, 
abandoned

$ 36

Petroleum exploration well with show of gas % 37
Petroleum exploration well with show of oil and gas, 
abandoned

& 38

Petroleum exploration well with show of oil ' 39
Petroleum exploration well with show of oil and gas ( 40
Stratigraphic hole for petroleum exploration ) 41
Oil well, shut in or suspended * 42
Oil well, abandoned + 43
Gas well , 44
Gas well, shut in or suspended - 45
Gas well, abandoned . 46
Oil and gas well / 47
Oil and gas well, shut in or suspended 0 48
Oil and gas well, abandoned 1 49
Gas and condensate well 2 50
Gas and condensate well, shut in or suspended 3 51
Gas and condensate well, abandoned 4 52
Fossil locality 5 53
Macrofossil locality 6 54
Microfossil locality 7 55
Trace fossil locality 8 56
Fossil wood locality 9 57
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Oncolite locality : 58
Palynomorph locality ; 59
Plant fossil locality < 60
Stromatolite locality = 61
Vertebrate fossil locality > 62
Sample location for isotopic age determination ? 63
Type locality @ 64
Drill hole A 65
Unworked deposit B 66
Prospect or mine with little production C 67
Abandoned prospect or mine with little production D 68
Mine; may be abandoned E 69
Major mine F 70
Mine abandoned or not being worked G 71
Minor open cut or quarry H 72
Major open cut or quarry I 73
Abandoned open cut or quarry, or not being worked J 74
Minor alluvial workings K 75
Major alluvial workings L 76
Abandoned alluvial workings, or not being worked M 77
Treatment plant N 78
Treatment plant not operating, or abandoned, or 
former site

O 79

Main shaft showing number of compartments P 80
Shaft extending above and below plan level Q 81
Accessible shaft extending below plan level R 82
Accessible shaft extending above plan level S 83
Head of rise or winze T T 84
Foot of rise or winze U 85
Rise or winze extending through level V 86
Inclined accessible shaft extending below plan level 
(small scale)

W 87

Inclined accessible shaft extending below plan level 
(large scale)

X 88

Cross section of cross-cut or drive; same side of 
plane of section as observer

Y 89

Name (Continued) ET GeoExplore ASCII
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Cross section of cross-cut or drive; opposite side of 
plane of section

Z 90

Cross section of cross-cut or drive extending across 
plane of section

[ 91

Ore chute \ 92
Filled workings ] 93
Portal and approach of tunnel or adit ^ 94
Natural surface _ 95
Grab-sample locality ` 96
Costean or trench a 97
Oil seep b 98
Gas seep c 99
Oil and gas seep or show d 100
Oil seep reported (by geoscientist) but not relocated e 101
Gas seep reported (by geoscientist) but not relocated f 102
Oil and gas seep reported (by geoscientist) but not 
relocated 

g 103

Mud volcano or mud volcano without with 
hydrocarbons

h 104

Mud volcano with hydrocarbons i 105
j

Relative gravity high k 107
Relative gravity low l 108
Proterozoic symbol m 109
Cambrian symbol n 110
Photo point o 111
Drillhole p 112
Registration cross q 113
Scarp r 114
Inclined drill hole s 115
Inclined drill hole t 116
Inclined drill hole u 117
Inclined drill hole v 118
Major eruptive centre with recorded eruption w 119
Major eruptive centre with no recorded eruption x 120
Minor eruptive centre with recorded eruption y 121
Minor eruptive centre with no recorded eruption z 122

Name (Continued) ET GeoExplore ASCII
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Astrobleme or impact structure or cryptoexplosive 
structure

{ 123

Trigometrical | 124
Astronomical station } 125
Major volcanic centre ~ 126
Volcanic plug residual � 127

? 128
Basalt capped residual hill � 129
Residual hill ? 130
Crater wall ? 131
Pediment ? 132
Landslips ? 133

Name (Continued) ET GeoExplore ASCII
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E Supported File Formats
In this section:

• Supported Grid Formats

• Supported Located Image Formats

• Supported 2D Vector Formats

• Supported 3D Vector Formats

• Supported Databases

• Supported Image Formats

• Supported Lookup Table Formats

• Supported Drillhole Formats

• Supported Voxel Model Formats

Supported Grid Formats

A wide range of industry-standard grid formats are supported and can be 
imported for use in Encom Discover PA. Compatible grids include:

• Arc ASCII grid files (.ASC)

• Arc Binary grid files (.ACF)

• ASEG GXF (.GXF)

• BIL files (.BIL)

• Encom grids (.GRD)

• ER Mapper (.ERS)

• ESRI/Arc triangulation grid format (.TIN)

• Intrepid (.ERS)

• Geopak grid (.GRD compressed and uncompressed)
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• Geosoft compressed and uncompressed Oasis montaj (.GRD)

• GeoTIFF georeferenced TIFF files with file header (.TIF, .TIFF)

• Landmark Seismic grid format (.GRD)

• MapInfo grid files (.MIG)

• Minex grid files (.XYZ)

• Surfer ASCII grid files (.GRD)

• Surfer binary grid (.GRD)

• USGS grids (.USG)

• USGS DEM grid file (.DEM)

• USGS SDTS grids (.TAR)

• Vertical Mapper grid files (.GRD, .GRC)

Supported Located Image Formats

Read

The Located Image option allows display of a variety of positioned raster and 
vector data formats:

• 3D Studio files (.3DS)

• Arc ASCII grid files (.ASC)

• Arc Binary grid files (.ACF)

• ASEG GXF (.GXF)

• AutoCAD 3D DXF files (.DXF)

• BIL files (.BIL)

• Compuserve GIF (.GIF)

• Datamine vector files (.DM)

• Encom grid files (.GRD) 
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• Encom located image files (.EGB)

• ER Mapper algorithm files (.ALG)

• ER Mapper compressed wavelet format files (.ECW)

• ER Mapper grid files (.ERS)

• ESRI triangulation files (.TIN)

• Geopak grid files (.GRD)

• Geosoft grid files (.GRD)

• GeoTIFF format files (.TIF, .TIFF)

• GoCAD (.TS, .PL, .VS)

• Gemcom (.BT2)

• JPEG (.JPG, .JPEG)

• Landmark grid files (.GRD)

• MapInfo grid files (.MIG)

• MapInfo raster files (.TAB)

• Minex grid files (.XYZ)

• ModelVision (.TKM)

• Portable Network Graphics (.PNG)

• Surfer ASCII grid files (.GRD)

• Surfer binary grid files (.GRD)

• Surpac vector files (.DTM)

• USGS grid files (.USG)

• USGS DEM grid files (.DEM)

• USGS SDTS grid files (.TAR)

• Vulcan vector files (.00T)
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• Vertical Mapper grid files (.GRD, .GRC)

• Windows Bitmap (.BMP)

EGB Image Sources

Image formats .BMP, .JPEG, .PNG, .TIFF, and .GIF files are supported as image 
sources within .EGB files.

Write

Located images can be saved by Encom Discover PA in the following formats:

• PNG – Portable Network Graphics

• TIFF – Tagged Integrated Format

• BMP – Windows standard bitmap format

• JPG – Compressed bitmap format

• ECW – ER Mapper Compressed Wavelet format

Located Bitmap Surfaces

These located bitmap surface formats can be associated with a grid (see Located 
Bitmap Surface option in Transparency and Colour-Intensity Balance):

• ERMapper Algorithm files (.ALG)

• ERMapper ECW files (.ECW)

• GeoTiff files (.TIFF)

• JPEG 2000 files (.JP2)

• MapInfo files (.TAB)

Supported 2D Vector Formats

• MapInfo Professional (.TAB, .MIF)

• AutoCAD (.DXF)

• ESRI (.SHP)
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• ER Mapper (.ERV)

• Encom GPinfo (.GSF)

Supported 3D Vector Formats

• AutoCAD (.DXF)

• GoCAD (.TS, .PL, .VS)

• Gemcom (.BT2)

• ESRI TIN (.ADF)

• ESRI 3D shape (.SHP)

• Datamine wireframe (.DM)

• Surpac (.DTM)

• Vulcan Triangulation (.00T)

• 3D Studio (.3DS)

Supported Databases

• Geosoft Oasis montaj

• DFA Intrepid

• MapInfo .TAB file

Supported Image Formats

• .PNG – Portable Network Graphics

• TIF – Tagged Integrated Format

• .BMP – Windows standard bitmap format

• .JPG – Compressed bitmap format

• .EMF – Enhanced Windows Metafile
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Supported Lookup Table Formats

• ER Mapper (.LUT)

• MapInfo Professional (.CLR)

• Geosoft Oasis (.TBL)

• Engage3D Legend (.LEG)

Supported Drillhole Formats

• ASCII collars, survey and downhole data files

• ASCII XYZ desurveyed data files

• Geosoft .GDB

• Encom Discover .TAB

• acQuire databases - Microsoft Excel, FoxPro dBase, Microsoft Access, 
SQL Server, VisualFoxPro databases, and text files.

Supported Voxel Model Formats

• UBC 3D (University of British Columbia) (.MSH, .DAT)

• CEMI (University of Utah) (.CEM)

• Datamine (single precision) (.DM)

• Surpac (versions 1.0 to 3.0) (.MDI)

• Vulcan (Warning: support may be incomplete) (.BMF)

• Gocad voxet (Warning: support may be incomplete) (.VO)

• Gemcom (Warning: support may be incomplete) (.BPR)

• Noddy (.G00 and .GXX)

• Encom 3D grid (.E3D)

• ASCII XYZ (.XYZ)
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F Statistics Explorer

The Statistics Explorer window is divided into two main sections; the upper 
Spreadsheet window and the lower Property Page window. The contents of these 
depend on the view selected; the Statistics Explorer has four views, selectable 
from drop list at the top left of the window. These present graphical and statistical 
information using different Property Pages, which can be controlled using the 
Property Page tabs in the middle of the window. 

The Statistics Explorer is generally accessed via the statistics button in the 
various Field Data Conditioning dialogs (see Appendix G: Field Data 
Conditioning) accessed from many Properties dialogs, as well as the 3D Gridding 
tool.

The components of the Statistics Explorer window

The Statistics Explorer is a series of dialogs that enables you to examine any 
dataset both statistically and spatially.
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The Statistics Explorer window is divided into two main sections; the upper 
Spreadsheet window and the lower Property Page window. The contents of these 
depend on the view selected; the Statistics Explorer has four views, selectable 
from drop list at the top left of the window. These present graphical and statistical 
information using different Property Pages, which can be controlled using the 
Property Page tabs in the middle of the window.

These views are:

• The Univariate view examines a single field in the input data and presents 
basic summary statistics and histogram analysis.

• The Bivariate view examines any two fields in the input data and presents 
scattergram plots and basic summary statistics.

• The Spatial view plots the data using its spatial X, Y and Z coordinates 
and presents basic summary statistics.

• The Variogram view computes a variogram grid and displays directional 
semi-variogram data. This allows the creation of sample variograms, and 
creation and editing of model variograms.

The Statistics Explorer allows data to be selected in the spreadsheet or any of the 
univariate, bivariate or spatial views using the Selection Tools at the base of the 
window. The explorer can then ‘collapse’ the dataset to the current selection, and 
display the statistics for this new data subset.

Spreadsheet

The Spreadsheet comprises the top half of the Statistics Explorer dialog, and 
displays the records for the currently viewed selection.

• It uses the following colour codes to highlight records:

• The currently selected data points are highlighted red.

• The currently selected data point is highlighted purple.

• Invalid data is highlighted orange (e.g. coincident data).

• The current key and ancillary fields are highlighted purple.
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The spreadsheet shortcut menu can be accessed by right clicking on any column 
header. This provides a number of column resizing options (including the various 
‘Fit to’ options). Alternatively, columns and rows can be resized by clicking on 
their boundaries and dragging.

The Spreadsheet shortcut menu

The spreadsheet can also be sorted by any column using the Sort menu options.

The Statistics option returns a basic statistical summary of any field.

The statistics summary for a gold field

Data points can be selected from the spreadsheet (if valid for the current view) by 
clicking on the row header; use the CTRL and SHIFT keys to unselect stations and 
make multiple selections. A range of cells can be also be selected by clicking and 
dragging the mouse. These selection operations are treated exactly the same 
way as graphical selections and the undo/redo operations can be applied.
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The key field (whilst in univariate mode) or the ancillary field (whilst in bivariate 
mode) can be changed by double clicking on the field header in the spreadsheet.

Zoom, Selection and Display Controls

Each of the view types incorporates a number of property pages, discussed 
further under the relevant view sections. Depending on the view type, some or all 
of the following controls may be available within a property page window:

Zoom controls

The Zoom controls toolbar

• Use the three buttons in the middle to Zoom In, Zoom Out and Pan.

• The Restrict Zoom button on the left restricts zooming and panning to the 
horizontal dimension only.

• The Fit to Data button on the right cancels any zoom and returns to the 
default view showing all data.

Selection Tools

The Selection controls toolbar

When a single data point is selected in any graph (using the Pointer tool, see 
Selection Tools) the spreadsheet will scroll to the appropriate record.

 The Selection tools provide a powerful data selection capability. The Pointer 
button displays a cursor which can dragged through the graph. It may be 
displayed as either a vertical bar or a cross hair depending on graph type. In all 
cases, the pointer ‘snaps’ to the closest station and this station is then 
highlighted purple in the spreadsheet.
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Display Modulation

The graph can be also be Colour and/or Size Modulated by any field in the 
dataset. Select the required fields from the drop lists at the base of the graph. To 
cancel colour or size modulation, select <None>. A simple pseudocolour look-up 
table is used and a linear colour stretch is employed.

Subsetting

Univariate

The univariate view examines a single field in the input data and presents basic 
summary statistics and histogram analysis. It incorporates three property pages:

• A Scattergram graph of the data point index verses key field.

• Statistical information for the key field.

• A Histogram of the key field. When this is displayed, the spreadsheet will 
show a detailed breakdown of the histogram data.

Data can also be selected using Rectangle or Polygon selection, although the 
polygon selection is not available in all graphs. Selected stations are coloured 
red unless colour modulation is enabled in which case they are coloured black. 
Each selection operation can either select the enclosed stations (include option) 
or unselect the enclosed stations (exclude); this is toggled using the Include/
Exclude button.

Each selection operation is placed onto a stack which allows you to Undo and 
Redo operations. Buttons are also provides to Unselect All and Select All. The 
selection can also be Inverted.

Making a selection within a graph (which supports selections) or the spreadsheet 
view will activate the Collapse button at the top of the Statistics Explorer 
window.

This button extracts the selected data points from the dataset to create a new 
subset. The spreadsheet and graph views will be redrawn to focus on this 
subset. Only the subset will be considered in any statistical computations or 
graphs. Further selections can be made to examine the data in greater detail. 
The Expand button allows a previous level/subset to be redisplayed. If this 
button is disabled then the view has returned to the original dataset.
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The univariate view requires a key field to be defined. This field is selected from 
the second drop list at the top of the dialog. The key field can be changed at any 
time to examine any field in the dataset.

Univariate graph display

The Graph page plots the key field versus station index. Graph controls are 
detailed in Zoom, Selection and Display Controls.

The properties of the graph can be obtained by double clicking on an appropriate 
area of the graph. For example, click in the bottom and left margins to obtain 
properties of the X and Y axes. This property page enables you to change the axis 
extents and change the axis mapping between linear and logarithmic. When 
using logarithmic axes, you must elect to leave some data space surrounding 
zero as linear.

Note These axes property pages are not available for univariate or spatial graphs.
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Specifying an axis range

The Statistics page presents basic summary statistics for the key field, as detailed 
below:

Sample Count The total number of samples in the dataset.

Valid Sample Count The total number of valid (non-null/selected) 
samples in the dataset.

Invalid Sample Count The total number of invalid (null/unselected) 
samples in the dataset.

Minimum The minimum value of all valid samples.

Maximum The maximum value of all valid samples

Mean The mean (average) value of all valid samples.

Variance The variance of all valid samples.

Standard Deviation The standard deviation of all valid samples.

S/N Ratio The signal to noise ratio of all valid samples.

Coefficient of skewness The skewness of all valid samples.

Skew direction The skew direction (positive/negative) of all valid 
samples.

Median The value of the centre value in the sorted dataset.
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Histogram distribution of the selected field

The Histogram page presents an ‘equal width’ histogram of the key field. An 
equal width histogram is one built by dividing the valid data range into a large 
number of equal width bins and then computing the frequency of occurrence of 
key field values in each bin.

To be effective a large number of bins are used and these are grouped together 
depending on the scale at which the histogram is viewed. When multiple bins are 
being grouped together each consolidated bin is drawn with a back border. When 
zoomed in sufficiently to see individual bins, no black border is drawn. Also, the 
thickness of the bin is no longer equal to the assigned min/max values of the bin; 
it now relates to the actual min/max values of the data assigned to the bin.

The cumulative histogram is also displayed as a heavy green line. This indicates 
the percentage of data that is below the current value at any point. The upper and 
lower quartiles are displayed against the X and Y axes as dotted lines.

Mode The most frequently occurring valid value in the 
dataset.

Lower quartile The value of the dataset at the 25 percent quartile.

Upper quartile The value of the dataset at the 75 percent quartile.

Interquartile range The range of the data between the lower and upper 
quartiles.
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The spreadsheet displays the bin information including the bin data range, 
number of samples in each bin and the range of the actual data assigned to the 
bin. It also displays the cumulative histogram values.

The Selection Tools work normally in this graph. The selections are indicated as 
a percentage of stations selected in each bin. This is displayed as a red base. 
Note that no selections can be made from the spreadsheet in this mode.

Bivariate

Display of Bivariate data distribution with Key and Ancillary selection fields indicated 

The Bivariate view requires the user to define two input fields – the key 
(horizontal) field and the ancillary (vertical) field. Make these selections from the 
drop lists at the top of the explorer (indicated in screenshot above).
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Two property pages are presented. The Graph page shows a  scattergram of the 
ancillary field plotted against the key field. The Statistics page presents summary 
statistics for the bivariate distribution as well as a spreadsheet of the conditional 
expectation. You can copy and paste from this spreadsheet into Microsoft Excel.

The Graph page displays a linear regression as a blue line. A conditional 
expectation curve is also displayed as a green line. It also displays a quantile vs. 
quantile (q-q) curve as a purple line from 5% to 95% at steps of 5%.

For both pages, the Spreadsheet displays the complete dataset. A full range of 
selection tools are available both graphically and in the spreadsheet.

The following statistical definitions are used:

below:

Sample Count The total number of samples in both fields.

Valid Sample Count The total number of valid (non-null/
selected)samples in one or both fields.

Invalid Sample Count The total number of invalid (null/unselected) 
samples in one or both fields.

Minimum The minimum value of all valid samples.

Maximum The maximum value of all valid samples

Mean The mean (average) value of all valid samples.

Covariance Sum of squares of product of the difference 
between the field mean and each sample.

Standard Deviation The standard deviation of all valid samples.

S/N Ratio The signal to noise ratio of all valid samples.

Coefficient of skewness The skewness of all valid samples.

Skew direction The skew direction (positive/negative) of all valid 
samples.

Median The value of the centre value in the sorted dataset.
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Bivariate statistical data ranges and distribution

Spatial

The Spatial view does not require the user to define any fields (unless the View 
Extraction option on the Statistics page is used; see below). The data will be 
automatically plotted using its spatial coordinates in an isotropic view. If the data 
has less than two spatial dimensions no spatial view will be available.

A Graph page showing the spatial plot is presented. All Zoom, Selection and 
Display Controls are available. Data points can be colour or size modulated.

Mode The most frequently occurring valid value in the 
dataset.

Lower quartile The value of the dataset at the 25 percent quartile.

Upper quartile The value of the dataset at the 75 percent quartile.

Interquartile range The range of the data between the lower and upper 
quartiles.
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Displaying the Spatial distribution of the data
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The Spatial Statistics pages

The Statistics page displays basic summary statistics for the spatial fields. It also 
has a Regular spatial extraction export option. This creates a new dataset using 
multiple regular sized cells covering the entire spatial extents of the existing 
dataset. The size of these cells are defined using the X and Y Extent windows.  
The Region Overlap control allows cells to overlap adjacent cells by up to 50%. 
Regular spatial extraction requires the prior specification of a Key field in order 
to calculate summary statistics for each new output cell. The output dataset can 
be viewed using the View extraction button, which opens it in a new instance of 
the Statistics Explorer. The Save extraction button allows this output dataset to 
be saved as a multi-banded ERMapper grid file.

Variogram

The Variogram view requires the user to define a key field which will be used in 
tandem with the spatial coordinates to compute a sample variogram. If the data 
has less than two spatial dimensions no variogram view will be available. 

A variogram shows the degree of correlation between data in a spatial dataset in 
different directions and at different distances.

It can take a long time to compute a variogram and in most cases it will not be 
possible to compute the complete variogram for the entire data set unless it is 
relatively small (< 10,000 samples). Variogram computations are restricted by:
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• Capping the maximum range (distance between points) that will be 
considered.

• Capping the number of input samples that will be considered.

Display of the calculated variogram
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A default spatial variogram is computed using parameters that should ensure that 
the computation time is of the order of a few seconds. Thereafter the range and 
maximum sample number can be modified and the variogram can be recomputed 
by hitting the Recompute Variogram button. Note that if the maximum number 
of samples is set to minus one, then all samples will be computed. It is not advised 
to include all samples in the data set if it exceeds 10,000 samples as the 
computation time required to build the variogram could be extremely long. If the 
number of samples is restricted the algorithm will look at a sub-set of samples that 
are evenly distributed spatially within the dataset. In many cases it is desirable to 
increase the range and increase the maximum number of samples to improve the 
statistical reliability of the variogram. 

This procedure generates a radial variogram grid (lower left). The directional 
variogram can then be quickly extracted from this grid. The directional variogram 
is plotted on the right and the source data is shown in the spreadsheet. Only the 
zoom tools are available in this graph (no data selection is possible).

The plot on the left shows the variogram grid. The red sectors represent the area 
of the grid that was used to extract the directional variogram. This area is 
controlled via Direction (0 to 360 degree clockwise from North) and Width 
(degrees of arc) controls. If the width is 180 degrees then you have obtained the 
omni-directional variogram and direction is irrelevant. Otherwise, you will obtain 
a direction dependent variogram. You can change the direction of the variogram 
from the Direction spin buttons or simply click and drag you mouse across the 
variogram grid plot. The width can only be changed via the Width spin control.

The variogram records several parameters including the moment of inertia 
(semivariogram), covariance and pair count. Both the variogram grid plot and the 
directional variogram plot display the parameter selected in the Display drop list.

Model Variograms

If the Statistics Explorer has been opened via the Variogram button within the 
Kriging wizard of the Gridding Tool, a Model Variogram also can be created, 
edited and displayed. In this case an option is added to the Sample page to show 
the model variogram curve in addition to the sample variogram curve.

A Model property page is also available to manipulate the model variogram. The 
model variogram will be automatically initialised to a reasonable model fitting the 
data. You can press the Initialise Model button at any time to reset the model to 
this default.

The model is plotted to a range controlled via the range edit parameter. By default 
this is equal to the sample variogram range.
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The model variogram is displayed as a grid and also as a directional extraction – 
just like the sample variogram. The sample variogram curve can be plotted for 
comparison. As before, the extraction direction can be controlled via the edit 
buttons or by dragging the cursor across the variogram grid display.

In the upper right the model nests are displayed. Each nest  corresponds to 
semivariogram model. Individual nests can be edited, added, cloned and deleted 
via the buttons on the right. Alternatively double clicking on a nest in the list allows 
editing.

Displaying the sample and model variograms

Editing or adding a nest presents the following dialog; if adding a new nest the 
dialog is presented as a wizard.



Appendix F Statistics Explorer 1221

Select the Model Type from the range available

The Model Type page allows you to change or select an appropriate model for 
the nest. A description of the model is presented. The coordinates displayed for 
the model are not representative of the actual model coordinates.
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Controlling the parameters of the variogram

The Parameters page allows the editing of the model parameters. At the top right 
is a drop-list of model types.

The graph presents the sample variogram, the model variogram excluding the 
current nest you are editing or adding, the current nest and the final model 
variogram including the current nest. The model parameters are presented below 
the graph and can be directly edited. Also, most model parameters can be edited 
graphically by dragging the blue tags that are presented on the graph axes. For 
example, with the spherical model the left vertical axes allows the editing of the 
sill and the bottom horizontal axis allows range to be edited.

The sample variogram grid is displayed in the bottom left. Drag the cursor in this 
graph to edit the direction of the model variogram. This will also change the 
direction for the sample variogram extraction. Note that the width of the extraction 
is equal to the width of the extraction on the main ‘Sample’ page and cannot be 
modified here.



Appendix F Statistics Explorer 1223

Editing the variogram nest

The Anisotropy tab controls the range of the model along two axes – the major 
and minor axes. The direction of the major axis is shown on the nest grid preview 
on the left. The final model preview is shown on the right.

The major axis range will be equal to the range established on the ‘Parameters’ 
page. The minor axis range can be used to introduce anisotropy to the model. If 
the minor axis range is equal to the major axis range then the model is isotropic.

If it is larger than the major axis range then the model will have a smaller 
contribution in the minor axis direction.

The principal parameters of each nest can be altered graphically via the ‘model’ 
page. Select the nest from the model list and manipulate the principal parameters 
via the blue edit tags in the variogram plot.
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G Field Data Conditioning

The Field Data Conditioning dialog

The Field Data Conditioning dialog can be accessed from a number of Encom 
Discover PA tools using the Advanced Settings button (shown left). It allows 
you to remove abnormal or invalid data, such as negative values representing 
missing samples and spurious outliers, as well as providing Null value 
assignment and handling. It can also be utilised to query out and display specific 
portions of a dataset, for example all downhole gold assays between 2g/t and 
5g/t, or only intervals with a QBX or QV lithological code.
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The central part of the Field Data Conditioning dialog allows the specification of 
invalid data and/or data ranges. The first option auto-populates with the dataset’s 
default null value: generally -1.0×1032 or -99999. Invalid data (either user-defined 
or pre-existing null input data) will be handled as a null value internally and not 
displayed.

Specifying individual invalid data values. This is appropriate for removing negative values 
representing BDL (Below Detection Limit), SNR (Sample Not Received), etc.

The Statistics button at the top of the dialog opens the Statistics Explorer. This 
tool provides a powerful means of analysing the dataset for geochemical 
outliers, invalid data ranges, data distribution, etc via Graphical, Statistical and 
Histogram views. This dialog is dynamic: it will reflect any invalid data ranges or 
cap values set in the Field Data Conditioning dialog, allowing the effect of any 
conditioning applied to the data range to be checked.

Within the Graph and Histogram views of the Statistics Explorer, data subsets can 
be selected using the Rectangle Selection tool.

Then viewed using the View Current Selection button.

Return to the previous selection (or entire dataset) using the View Previous 
Selection button.
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Specifying individual invalid data values. This is appropriate for removing negative values 
representing BDL (Below Detection Limit), SNR (Sample Not Received), etc.

The following options allow specification of a list of user-defined invalid data 
values and/or ranges specific to the data field. Enter the invalid value or range at 
the left and then click the green cross to add it to the list at the right.

List entries can be removed using the Delete button. Some examples of use are 
presented below:
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Specifying an invalid data range to remove a range of negative values in the dataset from 
the 3D gridding process. This is a useful way to remove multiple negative values, rather 
than entering each one individually.
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Using the Field Data Conditioning dialog to display only a data range of interest, in this 
case only gold assays between 2 and 5g/t. This is done by specifying all data outside this 
range as a series of invalid ranges.

Setting a Cap values below or values above will cap source data outside the set 
limit to the limiting value. For example, with Cap values above set to 500, a gold 
assay on 725ppm will be handled as a 500ppm value. It is also possible to 
Convert null values to a background value specified by the user, in order to 
constrain the invalid data. For example, if plotting geochemical assays, much of 
the data may not have been sampled for and in these areas the assay result may 
be assumed to be equal to the background value. This helps prevent anomalies 
‘ballooning’ into areas with no source data coverage.
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The Field Data Conditioning dialog when the source data field is a text field

If the data field is a text field (e.g. lithology codes for use in drillhole colour 
modulation, or Discretised 3D gridding), the Field Data Conditioning dialog 
display will be altered accordingly.

This allows individual text strings to be specified. The Get Strings button will 
populate the left list with all Valid unique attributes (default all), allowing a list of 
invalid text strings to be easily created in the right window. The null value for 
invalid data can be set, and a background value to set nulls to.
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Creating a list of invalid lithological codes (so that only the valid codes on the left e.g. rated 
ore grades are displayed when colour modulating drillholes)

Data conditioning parameters (invalid data ranges, cap values, etc) can be 
saved and reused by using the Save and Load buttons at the top of the dialog. 
These create and handle Data conditioning files (.edc) that store the user-
defined parameters.
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H 3D Cursor Keyboard Shortcuts

3D Cursor Keyboard Shortcuts

Using this Card
This card can be used as a quick reference for 

the Encom Discover 3D keyboard and cursor 

shortcut keys. As an  aid to productivity, 

these can be used in conjunction with the 

standard menu items and toolbar icons.

Key

Shortcut keys apply once functions have been activated.

Navigation

Snapping

Cursor Plane Display

Cursor Plane Position and Orientation

Bonding Cursor Plane to Images

Toggles snapping on and off

Note: The position/orientation of the cursor 

plane changes at a slower/faster rate if 

the Shift/Ctrl keys are pressed.

Toggles cursor plane display

Centres the 3D view at the 
current cursor position

Extends the focus box to 
encompass the current 3D 
cursor location (does not 
move the cursor plane)

Switches the cursor plane 
orientation between 
three standard view 
planes: XY, YZ and XZ

(hold the Shift key) 
Decreases and increases 
the cursor plane size

Toggles the cross-hair style 
between none, 2D and 3D

Orientates the cursor plane 
parallel to YZ plane

Orientates the cursor plane 
parallel to XZ plane

Orientates the cursor plane 
parallel to XY plane

Moves the cursor plane 
towards or away from 
the view point

Changes the cursor plane 
inclination/dip

Changes the cursor plane 
azimuth/bearing

Centres the cursor plane 
without changing 
its orientation

Bonds or unbonds the cursor 
plane to the selected image

(numeric keypad) Iterates 
through all selected images

Switches bonding between the 
first and last images in a series

Navigation

Feature Editing

Cursor Plane Position 
and Orientation

Snapping

Bonding Cursor 
Plane to Images

Cursor Plane Display

Clip with Cursor Plane

Left button click

Rotates the view

Right button click

Zooms in and out

Dragging mouse with the 
left button pressed down

Dragging mouse with the 
right button pressed down

Moves the viewing centroid 
horizontally in the XY plane

Pans the view from a fixed 
“look from” position

Moves the viewing centroid 
vertically and parallel 
to the screen plane

Dragging mouse with 
the left and right buttons 
pressed down

Mouse Symbology
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Creating Features

Selecting Features

Selects a feature

Adds a feature to the 
current selection

3D Cursor Keyboard Shortcuts

Feature Operations
With two or more features selected

(minus key) Cuts the first 
selected feature with all 
other selected features

Aggregates the selected 
features, preserving the 
original geometries

Disaggregates or ungroups 
aggregated features into 
individual features

Consolidates the selected 
features by removing identical 
elements (nodes, edges, faces)

Creates the intersection 
of the selected features

Creates the union of the 
selected features

Triangulates the selected 
features (breaks each 
polygonal face into a set 
of triangular faces)

Creates the exclusive union 
of the selected features 
(overlapping areas removed)

When at least one of the 
selected features is a point 
or a line, creates a surface 
by triangulating all nodes 
from all selected features

Toggles edit mode between 
Add, Delete, Break and None

Depends on the current 
edit mode (Add, Delete, 
Break, None) and the type of 
element (node, edge, face)

Node: moves node on 
the cursor plane
Edge: inserts a node

Node: moves node 
perpendicular to the 
cursor plane
Edge: inserts a new node 
and moves it perpendicular 
to the cursor plane

Moves feature on the 
cursor plane

Moves feature perpendicular 
to the cursor plane

Creates a point feature 
or new points of polygon/
polyline (depending on 
the current default)

Creates a polygon/
polyline feature (if it is the 
current default type)

Cancels creating a feature

Removes the last created 
point of a multi-point feature

Editing Features
Applies to a reshapable feature
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Symbols
.ETS file 775
.FLY 461
.FLY animation script 465
.TAB

symbols 833
.WAV format 471

Numerics
1000 Separator 271
3D animation 441, 461
3D Array Data Voxel Gridding 962
3D cursor keyboard shortcuts 1233
3D Cursor toolbar 45
3D display

axes 137
of located images 139

3D displays with bitmaps 140
3D DXF models 430
3D Extrusion Wizard 1046
3D format files 431
3D graph 389
3D Grid Calculator 1021
3D Grid Toolkit

formats 1025
3D Gridding

block kriging 976
capping data 984, 988
classification 1001
Continuously variable method 972
Convert null values to background 984, 988
Default numeric null 1001
Default text null 1001
geology 1001
Inverse Distance Weighting 972
Kriging 973
lithology 1001
Load entire hole length 1000
nugget effects 984, 988
ordinary kriging 976

point kriging 976
Segment break length 1000
simple kriging 976
Variogram creation 976

3D Gridding Toolkit 964
3D Map 681
3D points 411
3D Scaling 392
3D Solid Generator 1029
3D symbols 405
3D TIN surfaces 481
3D Tube

of drillholes 626
3D Tube option 405
3D Tube Styles 405
3D Vector File Properties 433
3D voxel model output 959
3D window navigation 72
3DConnexion SpaceNavigator™ 450
3-dimensional model structures 108
3x3 average filter 918

A
above profile trace 120
Absolute

for animation 473
Absolute position

in Extrusion Wizard 1050
Access 569
access to external grids 336
AcQuire Drillhole menu item 607
AcQuire format 608
acQuire software system 607
active

windows 29
Actual Size option 39
add a new display 59
add axes 59
Add Axis Scale>Y Scale

option example 131

Index
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Add button
for substitute names 247

Add Data>Grid 329
Add Data>Grid Group 340

example 129
Add Data>Located Image option 427
Add Data>Section 307
Add Feature button

used in 3D 440
Add filter button

for 3D 1008
Add Image button 320
Add layers to an image 337
Add Located Bitmap Surface 329
add points to a map 368
Add Surface 340
Add Vector button 431
Add>Curve 118, 119
Add>Section

option example 125
adding drillholes to 2D 1099
Adjust colour scale dynamically 347
Adobe Reader 11
Advanced clipping dialog 906
Advanced Colour Mapping 342
Advanced Settings

3D gridding 983
Advanced Symbol Style Options 407
AGC

filter described 805
air photography

in 3D 143
aircraft characteristics 814
aircraft information 820
aircraft performance database 815
Aircraft Properties 820
aircraft specifications 814
aircraft speed 821
aircraft track 136
Akima

smoothing of contours 353
Akima Spline

drillhole desurvey method 610
Akima spline See bi-directional spline gridding
algebraic operation

in Feature Calculator 512

in Line Calculator 793
Algorithm Options

3D Solid Generator 1041
ALIASNAME variable 247
align

objects 83
alignment

of text 221
All Rates

option of spreadsheets 291
Alphabetic Sort button 784
Altitude

values of wet look 349
altitude of aircraft 822
amplitude spectrum 805
Analytic Signal

filter 1184
analytic signal computation 1176
analytic signal filter 805
Anchor setting 251
angle control

of text 220
animation 461
anisotropy

kriging model variogram 981
ANNCNAME variable 248
annotation

axes 304
Annotation Levels 60
annotation text 265
Annotation Tick tab 261
ANNXNAME variable 248
ANNYNAME variable 248
Anomaly Control toolbar 44
anomaly sharpness 1184
appearance of DXF files 433
appearance of symbols 286
Appearance Property

and borders 79
Appearance tab 653

of drillholes 625
of Profile Collection properties 239

Appearance tab dialog 249
Appearanmce tab

of layers 314
application templates 172
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Apply button 848
in Interactive Gridding 845
of Symbol Generator 835

Apply Major Interval Style 121
Apply to all fields button

in ImportASCII 186
Apply Transform 280
archive data 169
ArcInfo 569
Area filters 1186
arithmetic operations 794

in Line Calculator 794
of grids 909

Arrangement property page 250
Array Channel Builder utility 783
array operations

in Line Calculator 794
ASCII data 75
ASCII file to import 184
ASCII files

import 1147
ASCII import tool

for 3D gridding 1025
ASEG GXF

grid format 1199, 1200
ASEG-GDF2 standard 201
Assign button 1093
Atomic data format 1135
attribute ranges 668
Audio

for animation 473
audio accompaniment 469
Audio entry line 471
audio identification

in animation 461
Auto Apply checkbox 845
Auto Apply option 328, 668, 848
Auto open after save option 918
Auto-Apply

option 647
Auto-Apply option 656
AutoCAD .DXF

to TKM format 1070
AutoCad DXF 431
Automatic Colour Scaling 347
automatic colour scaling 347

Automatic Gain Control
filter described 805

Automatic mode
in Interactive Gridding 845

automatically
saved data 31

Auto-name button 188
average

filters 797, 913
used for line fill 275

Average filters 918
Average mxm filter 918
AVI movie 461
axes

in 3D displays 137
used in profiles 304

axes in a plot object 82
Axes tab 246

of frames 235
axis

plotting options 302
Axis Annotations 236
Axis Data Range 235
Axis Data tab 257
axis labelling 258, 303
Axis position 259
Axis Position tab 259
axis properties 240
axis range global 236
axis ranges 236
Axis Scaling 236
Axis Style 259
Axis Title 260
Azimuth

for animation 471
azimuth

of lines 88
azimuth of the selected lines 299
azimuth tolerance 89
azimuth tolerance controls 300

B
Back calculation

drillhole desurvey method 610
backdrop image 686
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background
setting 249

Background colour 768, 772
background displayed 686
background image 686
band

of data 99
Band Pass Mapping

of images 342
Band Pass mapping button 342
BANDNAME variable 248
band-pass

FFT 802
Bandpass filters 918
Band-pass operations

for colouring 493
bar

of axes 259
barometer/GPS field 316
base of extruded object 1049, 1050
baseline

determination 300
baseline azimuth 88
Batch Hardcopy Wizard 750
Batch Printing 158

Printing to PDF 162
Behaviour of Floating Windows 70
below profile trace 120
Bezier

smoothing of contours 353
Bezier smoothing

for animation 468
Bezier Spline

drillhole desurvey method 611
bi-directional spline gridding 867
bitmap

display in 3D displays 139
bitmap display and manipulation 642
bitmap file

specification 221
bitmap formats 221
bitmap formats supported 151
Bitmap tab 640
bitmap view 149
bitmaps in EnSight 1101
blank grid underneath region 929

Block filter 1186
Block filter group 1184
block kriging

3D gridding 976
Boolean logic operators 517
Borders

of frames 78
boundaries of the plot area 241
boundary

of layers 124
Bounding Box 139
Bounding line colour 769
branch name

of tree 57
broadcast

of window zooming 73
Broadcast option 73
Broadcaster

in options tab 238
buffer of colour 497
Button Usage 46
buttons

of feature Calculator 511
of Line Calculator 793

C
calculator for 3D models 1021
Calculator syntax 512
Camera button 471
Cancel button

for animation 477
capping data

3D Gridding 984, 988
capture a point 469
Capture Point List 469
capturing a raster 687
Cascade

option 41
CDI

Conductivity Depth Image 125, 307
Ceiling

of aircraft 821
cell boundary 230
Cell Colour

of frame 239
Cell Margins
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of frame 239
Cell size parameter

in Interactive Gridding 872
cell thickness

UBC models 1148
cell volumes 643
cell width 1148
CEMI 108, 644
centre of each grid cell 972
Centre the bitmap 642
centred 444
Chair Clipping tab 659
Chair View option 658
Change line prefixes 781
channel

selection 274
channels

of data 99
renaming 1139

characters per record
in ImportASCII 182

CHORDLENGTH 302
classification of grid 927
classification range 927
Classify grid utility 926
Clear Cells button 768
clear colours of images 497
Clear names button 188
clip

grids 928
clip a grid 928
clip grid to region 929
Clip model option 656
clip the output

of profiles 157
clipping

in stacked profiles 370, 836
of prints 154

clipping a grid 923
clipping operation 657
Clipping tab 655
Clone copy 60
Close

item in tree 56
close

survey database 35

Collar file 596
collar positions 593
Collar TAB file 1099
Collar table 1098
Collection Level 59
Colour

option of images 341
colour

filling 120
of 3D vectors 433

Colour Axis
defined 304

Colour Axis modulates 305
Colour axis range 237
Colour Balance level 335
Colour Browse

button 254
Colour cells of a row 767
Colour Editor

button 255
colour fill 653
colour gradients 340
Colour layer 340
Colour mapping 492
colour mapping 660
Colour Mapping dialog 493
Colour Mapping entry 255
Colour Range Global 237
Colour Scale tab 253
colour tab

for vectors 373, 429
colour table 848
Colour Table tab 254
Colour Zoom Fixed 237
colouring

of surfaces in 3D 143
colouring data

displayed in 3D 403, 409
column

slicing 655
Column headers 193
column label 192
column widths 188

for input 186
columns or rows 230
Columns/Rows
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on Appearanmce tab 240
combination of multiple lines

for display 89
combine

grids 934
Combine DXF utility 1067
combine single band grids 930
Comma Delimited 191
command line

in Feature Calculator 511
in Line Calculator 793

Comment lines
in ImportASCII 182

common horizontal scaling 300
Compact/Expand button 390
compare two values 516
comparison of two or more data fields 117
comparisons of data 106
complex data presentations 114
component 4
components of profiles 233
Compress/Expand button

in map dialog 333
Compressed View 390
compressed view

of map dialog 334
Compression

3D Solid Generator 1044
compression

of sections 315
compression factor 282
Compute Best Values button 854
Compute the displayed formula 512, 793
computer

licence transfer 23
Concise

tree display 56
conductivity 308
Conductivity Depth Image 307
Conductivity Depth Images

in 3D 435
Consortium of Electromagnetic Modelling and 
Inversion 108, 644

constant compression 394
Constant Depth Interpolator 785
constant grid compression 393

content of the Profile Document 304
Continuously variable

3D gridding 971, 972
Contour Appearance 353
Contour Dropout 353
Contour Levels 352
contour vector layers 332
contouring 323
Contours 339
contours 101, 687

exported 356
for mapping 355
in 3D displays 134

contours draped
in 3D 144

control a surface in 3D 389
control for colour bars 684
control the range and scaling 235
Controlling a Colour Layer 341
conversion of BT2 file 1088
convert a MapInfo .MIF or .TAB 1088
Convert axis 265
convert grid format 929
convert grid formats 923
Convert null values to background

3D Gridding 984, 988
converting downhole data 605
Convolution filtering option

for 3D 1008
Convolution filters 916
convolution filters 799
coordinate system 264, 268
Coordinate Transform of ASCII data 762
Coordinate Transform tool 787
Copy 230
core mesh 1148
correlation of anomalies 300
Cosinus kernel function

density grid 869, 901, 1008
create a map 357
Create a movie 474
create a Profile 688
Create AVI button 477
Create Explorer View at startup 69
Create Eye and Look Path DXF Files 469
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Create Grid button 924
Create new grid dialog 818
Creating Flight Path Map 357
Creating Grid Map 325
curvature utility 930
Curve 5

described 304
properties 272

Curve data tab 272
Curve Group button

used in 3D 403
Curve objects 272
Curve Profile button 303
Custom option 767
Customize dialog 1091
Cut 230
Cut, Copy and Delete or Save 59
Cut, Paste, Delete and Clone

from Workspace 55
Cut-off rate 802
Cycle unique colours 276
Cycle unique colours option 116
cycled

grids 720

D
dampen change in climb rate 822
data

in spreadsheet 100
selection 212

Data Dependent
axis option 302

Data Dependent setting 257
data displayed in a profile 283
data field 212, 283

in Extrusion Wizard 1048
data fields 99, 274
data fields of a database 510, 792
Data honouring 1008
data layouts 187
data links 238
Data Manager 30, 61
Data Mode 71
Data Object Level 59

Data Objects toolbar 44
data packaging 169
data preview 191
Data Source 352

of images 341
Data Source Level 60
Data Source Name (DSN) entry field 570
data sources 272
Data tab 69, 245, 272, 273, 688
data to expand or contract 237
data values of grids 923
Data Window 67, 69
Data Zoom 72
data zoom in a graph 236
Data Zoom To Extents 74
Data zoom to fit cell option 236
Data Zoom to fit grid cell 237
data zooming 686
database

access unsuccessful 211
Database Coordinate Transform 268
Database Maintenance tool 778
Database menu described 34
databases

supported 74, 175
Dataset

of Symbol Generator 835
dataset specification 245, 273
DATASET variable 248
datasheet icon 288
datum codes 270
DBA Options toolbar 573
DBASENAME variable 247
DBMS Catalog 570
Decay Curve 4
decay Legend 700
Decay tab 697
Decay Tool 694

option 105
Decimal Places 271
decimation

of grids 354
Decimation mode 395
decimation schemes 282



1242 Encom Discover PA User Guide

default clear colour 497
Default Layout

and profiles 234
Default Layout option 59
Default numeric null

3D Gridding 1001
default resolution 690
default templates 706
Default text null

3D Gridding 1001
defining the flight path 464
definition

DFN ASEG2GDF files 201
Delete 230
Delete All bands

option 60
Delete an image layer 337
Delete button

in Grid Filter 914
Delete channels 780
Delete lines 782
Delete rows

legends 774
Delete Surface 338
delimited data file 191
delimited format

input 186
Demonstration

mode 17
Density

3D gridding 972
Density gridding 868
Density method

3D Gridding 1006
Depth Axis 981
Depth layer 143
depth limits 308
Depth Sections 123, 124
Depth surface

of 3D displays 391
depth unit 605
depth-property pair 309
Depths with discrete Properties

of layers 314
Des Fitzgerald and Associates 177
descriptive text entry 773

Design
mode of frames 78

DFN file 202
DFN filename 201
dialog boxes

for configuring 29
difficulties selecting the text item 700
digital elevation model

for surveys 814
digital terrain model 316
dimensions

of 3D grids 990
dip direction 593
direction selected 444
Discover Downhole menu option 1099
Discover drillhole 1100
Discover sections 1100
Discretised

3D gridding 971
Display

option described 33
display area

of screen 54
Display Assistant 1023
display drillhole 105
Display in a New Document option 608
Display list 622
display objects 44
display point data 194
Display Type

spreadsheet option 289
Display Utilities menu described 34
displaying located images 140
displaying sections 1098
distance from the origin

for plotting 300
distance grid 1008
Distance Gridding 870
Distance to data

3D gridding 972
distribution of flight lines 819
Division tab 260
divisions 261, 265
document 3
Document Level 59



Index 1243

Document Wizard 688
dotted line

margin indicator 157
Down Dip is negative 603
downhole data 105
downhole information 427
downhole log 636
downhole menu

acQuire 607
downhole survey data 593
downhole XYZ file 597
downward continuation

FFT 802
Drag and Drop 67, 84
dragged files 84
dragging and dropping 84
Drillhole

Data Formats 593
drillhole

display in 3D 427
drillhole appearances 627
drillhole collar map 1100
drillhole cross-sections 1097
drillhole data 594, 600

from Discover 1098
Drillhole Group 592
Drillhole Project 636
drillhole project 594
drillhole projects 1098
Drillhole Properties 640
drillhole survey data 595
Drillholes 5

Encom Discover Data 604
Import ASCII data 599

drillholes
appearance 625
from Discover 1098

Drillholes entry 620
drillholes in section 611
Dropout Frequency

of contours 354
Dropout Threshold

of contours 354
DSN name 570
DTM grid 817

DTM tab 494
Duplicate an existing surface 337
Duplicate button

of LUT Editor 768
Duplicate Patterns 774
Duplicate Surface 338
Duration

for animation 470, 473
DXF file of a created flight track 461
DXF output file 835
dynamic histogram equalisation 347

E
Easting

in ImportASCII 190
ECW (ERMapper Compressed Wavelet) 331
ECW algorithms 331
edge detection filters 1151
Edge filter 1184
edge interpretation 1184
Edgezone filter 1184
Edit

option described 33
Edit button 492
Edit Existing Fly-through File option 467
edit features in 3D 460
edit grid nodes 923
edit grids 933
Edit LUT button 255
Edit Menu Options 1091
Edit menu options 37
Edit option 37
Edit>Copy View option 38
editing controls 229
editing grid cells 933
EGB Creation Wizard 715
EGB file 141
EGB files 480
EGS

file extension 167
elevation of a topography surface 396
elevation of sections 315
ellipse

orientation 846
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ellipsoidal search radius
of 3D gridding 993

EM channels
in Import tool 196

EM dataset
decays 694

EM Voxel 959
Enable button 21, 22, 26
enable colour filling 653
enable isosurface creation 653
enable thresholding 653
enable wire framing 653
Encom 3D Grid format 1026
Encom Discover 1097
Encom Georeferenced Bitmap file 139, 1100
Encom grids 1199
Encom PA Explorer 3
Encom PA Professional 3
Encom PA Viewer - 3
Encom ZS Filters 1189
End capping style 1030
energy spectrum

description 801
Enhance

option 349
Enhance displays

of drillholes 629
enter formula

in Feature Calculator 511
in Line Calculator 793

Epanechnikov kernel function
density grid 869, 901, 1007

ER Mapper
format 686
grids 1199

ER Mapper algorithm 330
ER Mapper algorithms

and speed 721
ER Mapper look-up tables 1128, 1144
ER Mapper software 329
ER Mapper support 329
ERMapper ECW Files 331
errors

in Feature Calculator 511
in Line Calculator 793

ESRI TIN 1203

Event Details 472
for animation 469

Event type 470
examples

of displays 114
Excel 569
exit EnSight 31
Expanded View dialog 389

Grids 334
experimental variogram

Kriging gridding 974
Explorer tab 68
Explorer Window 67, 68
Exponential

decay fits 694
Exponential weighting

IDW gridding 998
Export Contour button 356
export features 525
export format

of features 527
Export LUT Map 255
external databases 75, 176
extrude regular shapes 1053
Extrusion control

of symbols 407
Eye points 469
Eye Position 473

of animation 463

F
fast

display of sections 435
Fast Fourier Transform

description of 800
Fast Symbol 406
Fast Symbols 408
Feature Calculator

description 510
Feature Database

export 525
labelling 529
querying 533

Feature database
export 525

feature databases 500



Index 1245

feature edit in 3D 460
feature management 500
Feature Set 500
Feature Spreadsheet 558
Features described 33
Features in 3D 440
FFT

see Fast Fourier Transform 800
FFT Band Pass 919
FFT button 800
FFT Component Transform 920
FFT Derivative 920
FFT Filters 916
FFT filters 915
FFT PseudoGravity 920
Field Data

of spreadsheets 290
Field names are in header box 194
Field/Band/Layer Level 60
Fields tab 274

of features 507
File

described 33
file locations 214
File Locations tab 711
File types

.FLY 465

.WAV 471
file types dragged 85
File>Close Datasets 213
File>Close Survey option 176
File>Licensing option 27
File>New menu item 97
File>New>Empty Document 215
File>New>Graph 584

option example 131
File>New>Map 357
File>New>Map>3D Flight Path Map 402
File>New>Map>3D Graph 388
File>New>Map>3D Grid Map 387
File>New>Open from Template option 171
File>New>Scattergram 577
File>Open DBMS Table 574
File>Open Survey option 176

File>Open>Downhole>Geosoft Downhole 605
File>Open>Geosoft Oasis montaj 177
File>Open>MapInfo TAB 1067
File>Page Setup option 70
File>Page Setup... options 153
File>Print option 153
File>Print Preview

option 164
File>Save As Template

menu option 171
File>Save To Package 170
File>Save View As 149
File>Set Project Directory 77
File>Set Project Folder 214
Files of Type entry 916
Fill 491
Fill Holes utility 933
fill internal holes 922, 934
Fill Lines 395
filled profile by colour 275
filling of profile

in stacked profiles 370, 837
filter

band-pass FFT 802
FFT high pass 802
fourth difference 806
upward continuation 802

Filter parameters 920
Filter Properties 915
Filter to preview 1191
filter types 1152
filtered

data 282
filtering

in Grid Filter 796, 913
Filtering of gridded surface data 1151
filters

available - convolution 799
Fix Colour Range

option 253
Fix X Range

axis property 240
Fix Y Range option

example 118, 119
fixed rate of decimation 282
fixed value of height
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Extrusion Wizard 1049
Fixed Width

formatting 186
Fixed width box

in ImportASCII 189
fixed-width data file

in ImportASCII 189
fixed-width file 189
flat grid button 818
Flight Line 689
flight map

selection of lines 89
Flight Parameters 821
Flight Path 5
flight path

simulation 814
flight path angle 814
Flight Path Appearance Tab 363
Flight Path Current Lines 364
Flight Path Fields Tab 362
Flight Path Labels 365
Flight Path Line Style 363
Flight Path Lines Tab 361
Flight Path Map Properties 360
flight path maps 101
flight path settings 817
Flight Path Simulator 814
flight path specified

for animation 461
Flight Path Symbols 366
Flight Rate

option of spreadsheets 291
flip a grid 934
Float menu item 231
Floating Colour Bar

with voxels 683
floating’

an object 232
FLY file type 465
fly-through 389
folder preferences 76
Font button 247, 262
font control 220
Foreground colour 768, 772
format

grids 923

Format button
of annotation 280
text labelling 271

formats 644
formula

specification 511, 793
formula specification 512, 793
forward

line navigation 87
fourth difference

description 806
Frame 4
frame cell 248
Frame Rate 468
Frame snapping 83
frames 78, 230

and their use 77
explained 77

From input
in Extrusion Wizard 1053

From-To Data 599
From-To sampling 1098
From-to segment option 1000
FULLNAME variable 247
Fullscreen mode

3D view 452
Function pull-down list 924

G
Gaussian

filters 797, 913
Gaussian filters 918
Gaussian kernel function

density grid 869, 901, 1007
Gaussian mxm filter 918
Gaussian noise generator 807
Gaussian Smoothing 282
Gaussian weighting

IDW gridding 999
Gemcom .BT2 format 1088
Gemcom file format 1131
General mx n filter 918
General tab 690
General User Defined 800
Geodetic projections 266
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Geodetic tab 267
GeoFilter filters 1183
GeoFilters 1189
geological sections 105, 140, 1100
geological symbols 1194
Geological True Type Font 1194
Geomagnetic Field Declination 1189
geometry of bitmaps 152
Geopak grid 1199
geophysical filters 797, 913
Geosoft compressed 1200
Geosoft conversion utility 1069
Geosoft database import template 187
Geosoft database merge 790
Geosoft drillhole database

modify dip 610
Geosoft IP databases 319, 907
Geosoft templates

in ImportASCII 182
Geosoft uncompressed 1200
Geosoft Wholeplot formats 605
GeoTIFF 1200

format 686
Get field names button 194
Gibbs' Phenomena 1183
GIS software 1097
global

scaling 235
Global Directory 711
global directory 77, 214
Global Range from Unclipped Data 251

option 251
GoCAD TSurf 431
GoCad TSurf surface 1135
Graph 4
Graph defined 100
Graph display 106
graph number 244
graphical objects 78
GRAPHNUMBER variable 248
greyscale

previews 848
grid

import 336

Grid bounds parameters 872
Grid Calculator

description 909
Grid Cell margins 250
grid cell size 873
grid clipping 923, 928
Grid Decimation 354
Grid Design 39
Grid File specification 689
Grid Filter option 913
Grid Filter tool use 916
Grid Flipper 324, 400
Grid Flipper option 720
Grid Flipping 720
grid flipping 934

operation 720
grid format conversion 929
grid function 925
Grid Image 5
Grid Information 328
Grid Information button 346
Grid Loading Columns 690
Grid Management wizard 1023
grid node editing 923
Grid North 225
grid offset 923
Grid Open dialog 910
Grid Properties dialog

Auto-Apply 328
grid resampling 923, 937
grid rotation 923, 939
Grid Section utility 906
Grid to Grid Clip 928
Grid Utility 922
grid value editing 933
gridded value at the location 847
gridding 3D data 959
Gridding menu described 34
gridding operation

in Interactive Gridding 846
gridding sections 905
grids

clipping 928
combine 934
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merge 934
Grids Properties 333
Ground Penetrating Radar 199, 1143
Group Edit 489
Group properties of images 487
guidelines

for operation 29

H
hardcopy

output 156
hardcopy prints 154
header lines 191

in ImportASCII 189
height

continuation filters 802
Help

option described 33
help

sources available 11
help option 42
Hide/Show check boxes 56
High pass filters 918
high resolution

images 690
Highlight Azimuth 349
high-pass filters 1151
Hilbert Transform 805
Histogram

transform 493
Histogram Colour Mapping

of images 342
Histogram Equalisation

in Interactive Gridding 848
Histogram icon 342
hole ID 1098
hole name 622
hole tops 633
Holes tab 622
horizontal axis 302
Horizontal bands 196
horizontal derivative

FFT filter 802
Horizontal Extent

axis property 241

horizontal Scale 641
HSL Interpolation 254, 661, 773
Hue:Saturation:Lightness colour 773
Hue:Saturation:Lightness colour model 254

I
IGRF calculator 1177
IGrid3D 964
image

quality 690
image stretch

for images 497
Image Web Server 331
images 101
Images branch 140
Import button 189

in ImportASCII 192
import external multi-column ASCII data 182
import point data 194
Import SEG2 199
ImportASCII

and point data 193
importing the data 187
Inclination

for animation 471
inclination 1176

reduction to the pole 802
incompatible

data ranges 117
individual reading values 302
induced magnetization 1178
Induced Polarisation data 319, 907
Information

in Grid Filter 920
information

in spreadsheets 100
Input Coordinate System 788
input grids 914
Input tab

in Interactive Gridding 848
Insert

option described 33
Insert Component icon 80
Insert row

legends 774
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Insert>Component menu item 80
Insert>Data Object>Vectors 431
Insert>Grid menu item 230
Insert>Map menu item 357
Insert>Text 219
installation

of the software 15
installation directory 18
integration 682
Intensity layer 340, 348
Interactive Data Conversion 760
Interactive Gridding

description 844
interactive mode

of isosurfaces 673
interactive mode of thresholding 669
internal axes

of 3D displays 137
Internal Axis Geodetic 266
Internal Axis level 263
internal tension 855
Interp Selection button 768
interpolation methods 938
Interpolation Mode of an image 497
interpretational displays 681
interspersed line numbers

in ImportASCII 192
Intrepid 177
Intrepid Data Definition File 1137
Intrepid dataset 179
invalid line combination 89
Inverse Distance Weighted gridding method 846
Inverse Distance Weighting 858

3D Gridding 972
inversion programs 203
invert grids 923
invisible grid 83
Inward

ticks 261
IP databases 319
isosurface

creation 671
using interactive mode 671
using lithologies 671

Isosurface slider bar 672

Isotropic
scaling 252

isotropic
display 685

isotropic in X, Y and Z 236
isotropically displayed 686
Iterator moves 89

J
joining shapes

tie lines 1038

K
Kernel density estimator

density gridding 1006
kernel weights 799
keyboard shortcut 1093, 1233
keyboard tab 1093
Kriging

3D Gridding 973
experimental variogram 974
model variogram 974, 975
nugget 975
range 975
sample variogram 974
semivariance 974
sill 975

kriging
equation 975

L
Label modulation 285
Label properties 279
labelling

displayed in 3D 403, 409
labelling of data points 279
Landmark Seismic grid 1200
Laplacian Filter 919
large number of data points 846
large raster datasets 331
Latitude/Longitude 264
layer

data structures 309
presentation 124
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Layer Construction 314
layer inversion programs 124
layer property 348
layers

defined 308
Layout display 215
Layout Mode 70, 452
Layout Window 216
LEG extension 769
Legend Editor 768
Legend information 769
legend text

of decay curve 700
licence

transfer 23
Licence Manager 27
LIDAR LAS 876, 878, 880
Lighting

of Located Images 491
limits of axis 235
line azimuths 88
Line button

of Symbol Generator 835
Line Calculator

description 792
Line Colour 773
line cursor 933
line direction

in simulation 819
Line field

in ImportASCII 189
line field

on import 192
line filter operations 797
Line Filter Other button 803
Line Iterator

explained 86
tolerance controls 300

line iterator
modes 89

Line Iterator Properties 87
Line Iterator toolbar 44, 86, 87
line list 89
line navigation 86, 686
line navigation tools 685
Line Orientation tab 705

line patterns 275
Line Rate

option of spreadsheets 291
line Selection button

in line filtering 797
Line setting

on Data tab 246, 273
Line Station Displays 278
line style

of decay curves 697
Line Style dialog 275
Line Style tab 275
LINE variable 248
Linear (Decreasing)

transform 493
Linear (Increasing)

transform 493
Linear Colour Mapping

of images 342
linear portion

of scaling 253
Linear weighting

IDW gridding 998
Lines 5

of frames 78
offsets 79

lines
displayed in 3D 403
in frames 80
offsets 79

Lines 2D 367
lines group 403
Lines Properties dialog 404
linked database 569
linked zooming 73
lithology

editing 768
lithology layers 667
Lithology mode

of thresholding 667, 668
Load entire hole length

3D Gridding 1000
Load Format button 187
Load from file

of Symbol Generator 834
Local grid coordinates 266
Local grid transformation 266
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Local North 226
Located Bitmap item 1101
Located Image

in 3D 424
Located Image properties 427
Located Image uses 484
Located Images 320
located images 151, 479
Located Images branch 140
location of labels 262
Log (Decreasing)

transform 493
Log (Increasing)

transform 493
Log Display 636
Logarithmic

axis property 241
scaling of colour 253

logs displayed 641
long range collisions 822
Longitude to UTM zone converter 763
Look At point 463, 473
Look At points 469
Look Position 473
LookAheadClose

factor 821
LookAheadFar

factor 821
Lookup Table/Legend selection 276
look-up tables 1053

editing 763
Loop Style 471

for animation 468
low geomagnetic latitudes 1179
low latitude 1176
Low Latitude filter 1176
low magnetic latitudes 1176
low pass

FFT type 802
Low pass filter 918
lower

layer boundary 308
Lower layer data 309
LUT Colour Map 355
LVL file 353

M
magnetic

pseudo gravity 803
reduction to the pole 802

Magnetic North 226
magnetic susceptibility 308
magnetized lithologies 1184
main

screen of EnSight 32
Main button toolbar 43
main menu 32
Major

tick intervals 260
major

trace highlighting 275
major trace style 121
Manual

transform 494
Manual mode

in Interactive Gridding 846
manually specified views

for animation 461
Map 4
Map Document 325
Map Frame 325
Map Projection information 268
map scaling 155
Map Workspace Tree 325
MapInfo 177, 569
MapInfo .MIF or .TAB files 1088
Mapinfo .TAB file 180, 1067
MapInfo Professional 1097
mapped network drives

and speed 69
margin

offsets 79
margin controls 78
Margins 157

of frames 78
margins

of a page 157
margins within cells 249
Mask check box 355
Match Grid option 991
mathematical operations 516
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Max Climb Rate 821
Max Climb Rate Accel 821
Max Descent Rate Accel 821
maximum number of iterations 855
measured depths of the hole 593
Merge

grids 934
option 59, 230

Merge GDB databases 790
merged texture surfaces 147
mesh

model 1148
UBC model 1148

Mesh properties 496
Mesh properties of images 488
mesh sizes

of Grid Calculator 910
Micromine definition 1140
Microsoft Explorer 68, 84
millimetres

units 84
Minimised 56
Minimum angle factor 1176
Minimum Curvature

drillhole desurvey method 610
Minimum Curvature gridding 855
minimum length parameter 819
minimum safe clearance

for simulation 820
Minor

tick intervals 260
minor data traces 121
Minor divisions 261
model variogram

kriging 978
Kriging gridding 974, 975

Modify Database Properties
Geosoft drillhole database 610

Modulate Colour
of symbols 278

modulate point data 405
Modulate Size

of symbols 278
Modulate the colour 276
modulate the colours

in Extrusion Wizard 1053

Modulated rotation 278, 408
modulation

example 121
Modulus of Horizontal Derivative 1190
Moment of Inertia See Sample Variogram
Move Down

image option 338
Move the selected surface 337
Move Up

image option 338
Moving Average Smoothing 282
MPEG-4 Video codec 477
multi-banded field

in Import tool 196
multi-banded fields 195

in Line Calculator 794
multi-banded grid 941
multi-column format 184
multi-component grids 930
multiple

objects and windows 99
multiple .GDB files 177
multiple band field 283
multiple bands 274
multiple data channels 195
multiple files dropped 85
multiple filter operations 798
multiple isosurfaces 672, 673
multiple Profile windows 298
multiple surfaces

in 3D 146
multiple voxel displays 680
Multiple Z bands

3D gridding 983

N
NAME variable 247
navigation tools

for lines 86
Negative decay 697
negative dips

of drillholes 593
nests

variogram 978
New

project option 167
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New button
for LUTs 767

New display documents 36
New Document Creation wizard 92
New grid origin 939
New menu item 97
new profile

added below 99
Next Line Always 90
Next Valid Line 90
no compression of grids 393
no location transformation 264
Noddy models 1141
Node Centred

layer smoothing 314
noise adding in Grid Filter 796
Noise Generator filter 807
normal

mode 670
Normal View Mode 70, 452
Normal/Design mode

on Appearanmce tab 239
North Arrow

types 225
north arrow 225
north magnetic pole 1177
Northing

in ImportASCII 190
nugget

inverse distance weighting 998
Kriging 975

nugget effects
3D Gridding 984, 988

null filling
in Grid Filter 796, 913

null value
in Import tool 186

nulls 1149
nulls in grids 922, 934
number of cells

of 3D grids 990
UBC model 1149

number of colours 254, 661
Number of entries 767
number of grid passes

of 3D gridding 993

Numeric Sort button 784
numerical display 100

O
OASIS database 177
Oasis montaj 177
Oasis montajTM 178
Object Edit

of Located Images 494
Object Palette toolbar 44

for text 219
Object properties of images 488
object snapping 83
ODBC

links 569
Offset 274
offset

of Located Images 494
offset a grid 923
offset level 315
offset of the flight lines 819
Offset surface 392
Offset switches 248
Offset tab

for voxels 676
Offset to grid maximum

for animation 473
offsetting data

displayed in 3D 403, 409
on-line help 42
Online printers 706
Open

item in tree 56
project option 167

open
survey database 35

Open button 688
of grids 337

Open Drillholes 594
Open Views toolbar 44
operation

rules 29
operations

in Workspace 58
Optimum Orientation

of symbols 407
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Options
menu item 703

Options tab 238
of Sections 313

ordinary kriging
3D gridding 976

orientation
of print output 156

orientation difficulty 705
orientation of the traverses 686, 689
origin of a grid 939
Orthographic view 444
Other field

in ImportASCII 191
output

printing 153
Output File

of Symbol Generator 835
output format

of Grid Calculator 910
Output tab 873
Outward

ticks 261
Overlay utility 935
Overwrite X and Y Fields 788

P
package a dataset 170
packaging operation 170
padding 915

guidelines 1148
in Grid Filter 796

Padding by row and then by column 922
padding controls 921
Padding data lines 801
Padding in 2D using gridding 922
Padding margin 922
Padding value 250
padding zone 1148
PAgdf2Read

import module 201
Page Layout icon 39
Page Layout view 39
Page Setup 59
Page Setup tab 706

Page Zoom 72
Pan Mode

in Interactive Gridding 847
panning

in Grid Filter 915
of data 71

panning control 44
panning of data 72
paper

sizes for printing 156
Paste 230

option 37
Pattern

editing 768
pause

for animation 469
Pause for a specified duration 471
PDF

Portable Document File 10
percentage

used for spacing 84
Perspective view 444
physical property

of layers 308
picture information 221
Pin to Edge setting 251
Plan curvature 930
Plane Orientation button 460
planning flight surveys 814
Plateau filter 1186
Play button 474
playback

animation 469
Plot window 99, 298
point

distance unit 84
point data 192, 368

import 194
point data display 194
Point Data files

downhole 599
point depth:property

layers 310
point displays 368
point displays in 3D 410
point kriging
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3D gridding 976
point symbol 405
Point Symbol Size

for animation 469
Pointer cursor 687
points

displayed in 3D 409
Points button

used in 3D 409
Points Group 368
points group 409
Points Properties dialog 410
polygonal grid clipping 929
polygonal objects 1046
polygonal region

clipping 923
poor

image quality 690
pop-up menu items

described 58
Portable Document File

described 10
Position Controls

of symbols 407
position of the mesh 1149
positioned

titles 248
positioning a cursor 686
Positive decay 697
Power Fits

of decays 694
Power weighting

IDW gridding 999
Presentation Mode 39
preview

for animation 469
Preview panes

for Grid Utility 925
Primary Axis 981
primary coordinate directions 658
Print

File option 153
print

files 153
Print button 164
Print option 153
Print Setup...

File option 156
printable area of a page 157
Printer

setup 156
printer

controls 157
printer settings 153
printer setup 36
printer types 156
Process button

in line filtering 797
processed area 915
Profile 4
profile

line styles 275
trace described 120

Profile Collection
properties 234

Profile controls 298
Profile curvature 930
profile defined 98
Profile display format 298
Profile Document

creating 303
Profile level of the Workspace 244
profile scaling 155
profile scrolls 72
profile tracks 685
program icon 31
progress bar

in Interactive Gridding 846
Progressive Transformation 281
Project

management 167
Project Coordinates 788
Project Directory 76, 711
project directory 76
project session files 36
ProjectedDistance channel 302
Projection 268
projections support 268
Projections, Spheroid and Datums 787
properties

examples 643
of Line Iterator 87
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Properties dialog 646
properties of a Located Images 487
properties of a model

UBC 1149
properties of each band 283
properties of the TrackMap 688
property attribute 643
Property colour controls

of isosurfaces 670
Property dialog 60
Property dialogs

of profiles 234
property multi-band data

of layers 309
Propeties menu item 60
PROPNAME variable 247
proposed survey flight design 815
Protected data fields 778
pseudo gravity

FFT filter 803
Pseudocolour

in Interactive Gridding 848
Pseudocolour image 336, 338
pseudocolour surface

controls 340
pseudo-gravity 915
pull-down line list

of iterator 87

Q
Quad 483
Quad geometry of bitmaps 152
Quad Strip 484
Quad Strip bitmaps 152
quality of the bitmap 642
quality texturing 642
Quartic kernel function

density grid 869, 901, 1007
query

display data subset 985
query data

Field Data Conditioning 988, 989

R
race-tracked lines 819

Radial density estimator
density gridding 1006

randomly distributed
data 192

range
Kriging 975

Range Global 82
Ranking

of Features 561
raster images 686
Rate Filter

of spreadsheets 291
Rate Filter options 289
real time manipulation of imagery 328
real-time filtering 280
rectangular region

clipping 923
Red, Green and Blue

images 686
Red, Green and Blue layers 351
Red:Blue:Green (RGB) imagery 349
Red:Green:Blue

images 339
reduction to the pole 1177

FFT filter 802
Reduction-To-the-Pole 1176
reference level 315
reformat grids 923
region clipping

of grid 923
region to clip a grid 929
rejected transparency 670
Rename a data channel 779
rename tree branches 57
Render thresholded voxel model option 671
Repeat Reverse Look 468
Repeat Reverse replays 468
replay

of animation 461
report

of sessions 168
Reproject option 936
resample grids 923
resamples the

image 689
resampling a grid 937



Index 1257

reserved
words for Line Calculator 794

Reset button
in 3D displays 396

Reset Column widths
option 188

Reset Data Limits 74
Reset to default survey polygon button 818
Reset to Input Extents button 872
resistivity 308
Resizing Mode 240
Resizing Mode See ells
resolution 848

of located images 483
specification 690

Respond to Gobal
in options tab 238

Respond to Local
in options tab 238

restore
sessions 168

Restore button 61
Reverse Line Direction 87
Reverse Progressive Transformation 281
Reverse the Colour Table

option 255
Reversed

axis 252
reverse-sense

plotting 705
RGB

format 686
RGB Bands 689
RGB colour mode 349
RGB image format 687
RGB Interpolation 254, 661, 773
roaming

data 71
root directory 77
rotate a grid 939
Rotate Around button

for animation 471
rotate grids 923
Rotate View button

for animation 471
rotated

image 689

Rotation
controls 285

rotation
for animation 469

rotation of modulated symbols 278, 408
Rotation of the label text 279
row

slicing 655
Rows and Columns

of filters 1152
RTP filter 1176
RTP transform operator 1177

S
Sample Variogram

Kriging 976
sample variogram

Kriging gridding 974
satellite imagery

in 3D 143
Save a formula 512, 793
save as a raster 687
Save As button 917

in Grid Filter 915
Save As Located Image 151
Save as Located Image 482
Save as Raster menu 687
Save As RGB Raster 150
Save button 873
Save Component item 80
Save Format button 187
Save padded grid option 922
scale

definition 155
of horizontal axis 299
of maps 155

Scale and Transform 280
Scale button 397

in 3D displays 396
Scale factor

in Extrusion Wizard 1049, 1050
Scale the Axis

axis property 241
scaled horizontally 686
Scales and Axes 298
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scaling
in Extrusion Wizard 1049, 1050
in stacked profiles 370, 837

scaling and isotopic options 236
Scaling control 155
scaling of the axis 240
scaling the data

in 3D lines 404
in 3D points 410

scanned images 690
scanning maps 686
Scattergram 4
scattergram

compared to graphs 106
Scattergram display 577
Scattergram Document 578
Scope

of Located Images 491
scope of EGB files 1113
screen point

distance unit 84
script file

for animation 464
scroll wheel 72
scrollbar

control of Workspace 56
scrolling of data 71
search distance

of 3D gridding 993
search ellipse 846
search increment

of 3D gridding 993
search radii

of 3D gridding 993
search sectors

of 3D gridding 995
Section 5
section creation 311
section displays 307
Section Grid Group 316
Section Grid Groups 904
Section Gridding 903
Section Group 5

properties 312
Section Groups 308
Section Options tab 313

Section property 312
Section To Map 746, 754

Trouble-shooting 759
sections 686

display in 3D 435
seed model

for inversion 680
SEG2 format 199
Segment break length

3D Gridding 1000
Segments

drillhole desurvey method 610
Select a field 512, 793
Select All bands

option 60
Select Value item

used for X axis plots 258, 303
Select Value setting 258
selected profile 686
selecting a line 87
semivariance

Kriging method 974
send data 169
session 3
session file

packaging 169
restoring 168

session files
last saved 169
usage 167

session report 168
Set Data button 280
Set Default Colours button 254
Setting the Global Directory 214
Settings

button in Grid Filter 914
in Interactive Gridding 848

Settings button 921, 924
setup

of printers 156
SG2 files 199
shade ball

intensity 348
shaded

images 323
shading control 348
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shading to the display 348
Shape Matching

3D Solid Generator 1043
shape of the 3D symbols 835
Sharpen

drillholes 629
shift a grid 924
Shift function 939
Shift key 30
shortcut Key 1093
shortcuts 31
Show 3D Bound Box 139
Show at Axis Limits 262
Show Background 249
Show filtered data 798
Show Graph Title 247
Show Only Valid Lines 90
Show Symbols 406
Show Symbols item

for modulation 279
Show Symbols option 277
Show Value at Cursor

in Interactive Gridding 847
SHP file 1088
sides of the extruded shape 1046
sill

Kriging 975
Simple

axis option 302
simple kriging

3D gridding 976
Simple setting 257
simulation

of surveys 815
single model

only 647
Single Z Band

3D gridding 982
size and colour

of symbols 405
Size Axis

defined 305
Size Controls

of symbols 408
size of the symbols 276
Size Range 256

Size Range Global 237
sized vertically 686
Skip Factor control 359
Skip option

in importing 190
Skip the number of readings

for plotting 276
Skip value

of symbols 278
slice

model 655
slices of the voxel model 675
slider bars

for chair view 658
of Clipping 657

slow
display of sections 435

slow startup 69
smooth scroll 686
smooth scrolling of a profile 72
smoothed

layers 314
Smoothing

for animation 468
of 3D vectors 433

smoothing
in Grid Wizard 972

Snap control 83
snap movement 83
Snap Operation 83
source database

specifying 245, 273
SpaceNavigator

controls 450
device 450

Spatial Neighbour gridding 867
spatial order 90
specify data 282
Specify the data value

of colours 767, 768
specular highlights 349
spheroid and datum 270
Spilt

option 230
Split

option 59
Split operation 941



1260 Encom Discover PA User Guide

Spreadsheet
Close Database 292
Editing Data 294
Export Dataset 292
Modify Dataset 292
Update Views 294

spreadsheet
displays 100
rate filter 291

spreadsheet facility 287
Spreadsheet Window

Statistics Explorer 293
Stack button 396, 397
Stacked Profile 369, 836
Stacked Profile Displays 108, 369
Stall Speed 821
standard

filters 797, 913
standard colours

in Extrusion Wizard 1053
Standard Deviartion

filters 918
standard grid formats 101
Standard mode 88

for Line Iterator 88
standard Windows colour selection 254
Starting at char entry field

in ImportASCII 194
Station Rate

option of spreadsheets 291
Statistical Data

of spreadsheets 290
Status Bar 54
status bar 32
Step Patterns 774
Structural Data

of spreadsheets 290
structure

of a profile 234
of databases 290

Structure Analysis
3D Solid Generator 1042

structured objects 480
Style

of Located Images 491
style

of axes 259

sheets and templates 171
substitute name 247
substituted

text strings 247
Subtract depth from DTM 906
Sun Filter 919
sun-angle filters 797, 913
Sun-Shading

in Interactive Gridding 848
Surface curvature 930
surface grid

in Extrusion Wizard 1049
Surface images 152
Surfer 101
Surfer grid 1200
Surpac 3D Block Model 1144
survey area polygon 814
survey clipping polygon 814
survey data

of drillholes 593
Survey files 596
survey position distance 1098
Survey Rate

option of spreadsheets 291
Survey Speed 821
Survey TAB file 1099
Survey table 1098
SurveyInfo file

of Intrepid 1139
symbol

selection 276
symbol format 407
Symbol Generator utility 833
symbol libraries 277, 406
symbol modulation 121
Symbol options 285
Symbol Selector 277
Symbol Selector dialog 406
Symbols

created 835
symbols

cycling 276
displayed in 3D 403, 409

Symbols dialog 276
Symbols modulation 285
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Symbols tab 405
System size

and decimation 395

T
tab controls 61
TAB files 180, 573, 1067
tabs at the top of each dialog 234
tapering option

of 3D gridding 1000
Template 9
template 3
Template Gallery 9
Template Gallery directory 172
templates

explained 171
usage 171

Tension
of smoothing for animation 468

tension parameter 855
text

preview 247
text content 220
Text Import tool 196
text labels 271
Text Properties dialog 219
text string

entry 219
text values for drillhole 635
texture mapping 144, 397
Texture Quality 397
Texture Size options 398
thickness units

of axes 259
threshold

filter described 807
Threshold by checkbox 670
Threshold Opacity 670
Thresholding 667
thresholds of data

in stacked profiles 370, 837
tick interval 260
ticks 265
Tie Lines

3D Solid Generator 1035

Tilt filters 1184
TIN files 480
Title tab 247, 260
title text content 247
TKM model file 1070
Tool Tip

use 46
toolbar

usage 42
Tools

option described 34
Tools option 703
Tools>Customize 1091
Tools>Grid Flipper 400
Tools>Options>File Locations 77
Top Speed

of aircraft 821
top surface depth 309
Top,Left,Right and Bottom

on Appearanmce tab 239
topography 315, 1149

surfaces in 3D 147
topography offset for voxels 784
Total Colours item 661
total colours item 254
Total Survey Length 290
TrackMap 5, 322
TrackMap display 685
TrackMap option

on pop-up menu 688
TrackMap tracks 686
tracks of different data fields 116
Transfer button 26
transfer the licence 23
transform

data 281
Transform Coordinates 760
Transform parameters tab 372, 428
Transform tab 280
transformation of data

in 3D 404, 410
Transparency

of slices 675
transparency

of images 335
Transparency control
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in 3D 142
transparency of sections 315
Transparent

on Appearanmce tab 239
tree display 56
tree tool 45
Triangle kernel function

density grid 869, 901, 1007
Triangle Mesh 488
triangular mesh 865
Triangulation method 865
trigonometric operators 517
Triweight kernel function

density grid 869, 901, 1007
True North 225
True Type fonts 1193
TSurf 1135
Tube Shape Manager 774
Turn Off

image option 338
Turn On

image option 338
two depth surfaces 144
two dimensional maps 323

U
UBC 2D Mesh 203
UBC 3D model

to Geosoft 205
UBC format 203
UBC model 1147
unable to open a database 211
Undo

not implemented 37
Uniform Cell dimension 240
Uniform Cell Width/Height

on Appearanmce tab 240
Uniform kernel function

density grid 869, 901, 1007
units of distance

within EnSight 84
UNITS variable 247
University of British Columbia 108, 644
University of Utah 108, 644, 1108
Unmodulated rotation 278

Unprotect button 778
Unselected channels list 784
unshaded images 323
Up, Down, Left or Right and Forward/Back

options 59
update data values 69
updating related 238
upper

layer boundary 308
upper and lower boundaries 314
Upper layer data 309
upper layer depth 309
Upper, Lower and Property style

of layers 314
upward continuation

FFT filter 802
Use Global Directory for all file locations 214
Use loaded survey polygon check-box 818
User decimation 395
user defined scale 154
User Guide described 11
User size

and decimation 395
User-defined Colour Mapping 344
USGS DEM grid 1200
USGS grids 1200
USGS SDTS grids 1200
Utilities

in Grid Filter 916
Utils 920
Utils>Fill holes 922

V
valid lines 90
Variable cell size option 991
variable compression 394
Variable compression mode 393
variable grid compression 393
variable strings 247
Variable Substitution 247
variogram

Kriging 976
Variogram creation

3D Gridding 976
Vector Contour layer 333
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Vector File 5
Vector File To Grid Utility 954
vector files 430
Vector item 431
vector layers 333
Vector menu described 34
Vectorise a Grid 944
Vectors layer 431
Verbose

tree display 56
Vertical bands option 195
vertical bars using point data 1048
vertical exaggeration 142
Vertical Extent of the Y axis 252
Vertical Mapper 101
vertical scaling 299
Vertices (Atoms) 1135
Video codec 477
View AVI button 477
View Input Points

in Interactive Gridding 847
View Mode 71
view modes 70

Full screen 452
Normal 452
Orthographic 444
Page Layout 452
Perspective 444

View option 38
View Search Ellipse

in Interactive Gridding 848
View>Datasheet Tool 288
View>Decay Curve Tool 105
View>Toolbars option 39
voxel

defined 643
Voxel Model 5
Voxel Model Gridding tool 959
voxel model offset 676
voxel slices 675
Voxel Toolkit

Compute anisotropic distance 1005
Restrict to maximum distance envelope 1004
Use distance to line solution 1005

Voxels menu described 34

Vulcan Archive
export 1072

Vulcan Archive Import 1072

W
WAV file type 471
wavelength

and FFT 801
weak magnetic anomalies 1184
weight the grid node 1152
weighting schemes 997

of 3D gridding 992
wet look 349
What You See Is What You Get 215
Wholeplot option 605
width

of axes 259
window linking 74
Windows

option described 33
Windows 7 15
Windows menu 41
Windows XP 3, 15
wireframes 674
Wireframing

of 3D vectors 434
wireframing 653
wizard

for documents 92
use 91

wizard button 92
wizard screens 92
wizards 91
Workspace hierarchy 234
Workspace toolbar

described 54
Workspace Tree 33

Editability icon See Feature Editing
Selectability icon 58
Zoom Extents icon 58

Workspace tree
and Scattergram 579
hierarchy 54
levels 233
of Graphs 586
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of Layouts 216
of maps 325

Workspace tree growth 56
Woskpace Tree

Zoom All icon 58

X
X Annotation Global 237
X Range Global 236
X Scale tab properties 240
X Scaled 237
X Zoom Fixed 237
X-Axis

described 304
XY(Z) Axes Isotropic 236, 237
XYZ downhole data 181

Y
Y Annotation Global 237
Y Range Global 237
Y Scale properties 240
Y Scale properties tab 251
Y Zoom Fixed 237
Y-Axis

defined 304
yellow cross 349

Z
Z Axis tab 142
Z data field 76
Z Offset

of 3D displays 392
Z offset 396
Z Scale

of 3D displays 392
Z Zoom Fixed 237
Z Zoom Global 237
Zoom Controls toolbar 44
Zoom Global option 82
zoom level 848
Zoom Mode

in Interactive Gridding 847
Zoom toolbar 72

Zoom Toolbar controls 443
zoomed limits 73
zooming

control 44
in Grid Filter 915

zooms
in Grid Filter 916
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